
CSM 2022.3 Features

CSM 2022.3 Features 1

CSM 2022.3 Features



Legal Notices
© 2023 Cherwell Software, LLC. All Rights Reserved.

Cherwell, the Cherwell logo, and mApp are trademarks owned by Cherwell Software, LLC and are registered
and/or used in the United States and other countries. ITIL® is a registered trademark of AXELOS Limited. All
other product or company names referenced herein are used for identification purposes only and are or may
be trademarks or registered trademarks of their respective owners.

Some or all parts of the mApp product are covered by one or more claims of U.S. Patent No. 9, 612, 825.

The information contained in this documentation is proprietary and confidential. Your use of this information
and Cherwell Software products is subject to the terms and conditions of the applicable End-User License
Agreement and/or Nondisclosure Agreement and the proprietary and restricted rights notices included therein.

You may print, copy, and use the information contained in this documentation for the internal needs of your
user base only. Unless otherwise agreed to by Cherwell and you in writing, you may not otherwise distribute
this documentation or the information contained here outside of your organization without obtaining Cherwell’s
prior written consent for each such distribution.

The Cherwell Software product suite includes:
• Cherwell Service Management
• Cherwell Asset Management

Contact Cherwell Software

CSM 2022.3 Features

http://www.cherwell.com/contact


Contents
CSM Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

◦ Adaptive Layouts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
◦ About Adaptive Layouts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
◦ Use Adaptive Layouts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
◦ Adaptive Forms Scenarios. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39
◦ Adaptive Dashboards Scenarios. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
◦ Managing Adaptive Layouts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
◦ Adaptive Layout Design Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
◦ Design Features for Adaptive Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46
◦ Design Features for Adaptive Dashboards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48
◦ Managing Controls and Widgets in Adaptive Layouts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50
◦ Adaptive Layout Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
◦ Defining Adaptive Layout Properties Using Device-Independent Pixels. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
◦ Create an Adaptive Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55
◦ Edit an Adaptive Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56
◦ Delete an Adaptive Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
◦ Adaptive Layout Preset Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58
◦ Open the Adaptive Layout Preset Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60
◦ Create an Adaptive Layout Preset. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61
◦ Edit an Adaptive Layout Preset. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62
◦ Delete an Adaptive Layout Preset. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

◦ Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64
◦ About Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65
◦ Approvals Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  67
◦ Approval and Denial Threshold Rules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68
◦ Using Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73
◦ Approval Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74
◦ Managing Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75
◦ Approval Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76
◦ Approval Block Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  77
◦ Open the Approval Block Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80
◦ Add an Approval to a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81
◦ Define an Approval Relationship. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82
◦ Define an Approval Block ID Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84
◦ Define Approval Configuration for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85
◦ Define an Approval Email. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87
◦ Create/Edit an Approval Block. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90
◦ Define Approval Block Condition Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91
◦ Define Approver Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93

CSM 2022.3 Features

Contents



◦ Define Approval Block Action Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97
◦ Define Multi-Level Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  99
◦ Configuring Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  101
◦ Configure Customer Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  102

◦ Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108
◦ About Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  109
◦ Use Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110
◦ View an Attachment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  111
◦ View Attachment Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112
◦ Email an Attachment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113
◦ Record Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114
◦ Attach a Record to Another Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  115
◦ Attach (Import) Files to a Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116
◦ Download Files Attached to a Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117
◦ Link a File to a Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  118
◦ Attach a Web Page to a Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
◦ Attach an Image from the Clipboard to a Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
◦ Create a Shortcut to an Attachment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
◦ Remove an Attachment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
◦ Manage Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  123
◦ Open the Attachment Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124
◦ Create a System Attachment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125
◦ Import Attachments from a Directory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  126
◦ Configure Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127

◦ Business Hours. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  128
◦ Business Hours. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  129
◦ Business Hours Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  130
◦ Managing Business Hours. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  131
◦ Open the Business Hours Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  133
◦ View Business Hours. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  134
◦ Create Business Hours. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  135
◦ Configuring Business Hours. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  137

◦ Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  138
◦ About Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  139
◦ Major Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  141
◦ Supporting Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  142
◦ Lookup Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  144
◦ Group Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145
◦ Business Object Views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146
◦ Open the View Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  147

CSM 2022.3 Features

Contents



◦ Create/Edit a Business Object View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  148
◦ Business Objects Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150
◦ Business Object Performance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151
◦ Using Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152
◦ Managing Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153
◦ Object Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154
◦ Open the Object Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  156
◦ Business Object Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  157
◦ Open the Business Object Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158
◦ Open the Business Object Properties Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  159
◦ Create/Edit a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
◦ Define Basic Business Object Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163
◦ Define General Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164
◦ Define Process and Procedure Help Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171
◦ Define Group Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  172
◦ Define Additional Business Object Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174
◦ Define Lifecycle Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  176
◦ Define Search Results Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  178
◦ Define Attachments Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  182
◦ Define Database Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  185
◦ Define History Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  188
◦ Define Record Locking Settings for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  190
◦ Define Localization Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  192
◦ Define Advanced Properties for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193
◦ General Business Object Attributes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196
◦ Delete a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  197
◦ Define Business Object Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  199
◦ Define Menu Actions for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  201
◦ Define Task Pane Actions for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  203
◦ Define Toolbar Actions for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  206
◦ Define Context Menu Actions for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  208
◦ Define Print Options for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  210
◦ Define Automatic Actions for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  211
◦ Troubleshoot Actions for Automation Processes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  213
◦ Problem: The field [BusinessObject].[Fieldname] must be filled in before the record can be saved. . . . . . . . . . .  214
◦ Scan a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215
◦ Undo Business Object Changes within a Blueprint. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  216
◦ Add a Business Object to a Blueprint. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  217
◦ View Blueprint Changes for a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  218
◦ Export a Business Object Schema. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  221
◦ View the Business Object Publish Log. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  223

CSM 2022.3 Features

Contents



◦ Convert to a Group Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  226
◦ Configuring Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  227
◦ Business Object Lifecycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  228
◦ About Business Object Lifecycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  229
◦ About Statuses and Stages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  230
◦ About Transitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  231
◦ Managing Business Object Lifecycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  233
◦ Open the Lifecycle Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  234
◦ Add Statuses and Stages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  235
◦ Manage Transitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  236
◦ Add Branches and Jumps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  238
◦ Add a Post-Transition Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  242
◦ Validate a Lifecycle. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  243
◦ Delete Parts of a Lifecycle. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  245
◦ Delete or Move Jumps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  246
◦ Example: Create a Lifecycle. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  247
◦ Configure Business Object Lifecycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  252
◦ Add Lifecycle Controls to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  253
◦ Report on Business Objects Based on Lifecycle Status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  255
◦ Show Lifecycle Data in a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  257
◦ Migrate a Business Object Lifecycle. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  258
◦ Update Associated Items for Business Object Lifecycle Migration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  260
◦ Multiple Statuses: Use a One-Step Action to Migrate Business Object Lifecycles. . . . . . . . . . . . . . . . . . . . . . . . . .  264
◦ Single Status: Use a One-Step Action to Migrate Business Object Lifecycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  268
◦ Manually Migrate a Business Object Lifecycle. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  271
◦ Perform Transitions using a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  272
◦ Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  274
◦ About Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  275
◦ Fields Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  277
◦ Using Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  278
◦ Managing Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279
◦ Create/Edit a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  280
◦ Open the Field Properties Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  282
◦ Define General Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  283
◦ Define General Properties for a Date/Time Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  286
◦ Define General Properties for a Number Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  287
◦ Define General Properties for a Text Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288
◦ Define Process and Procedure Help Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  290
◦ Define Detailed Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  291
◦ Define General Behaviors for Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  292
◦ Define Field Behaviors Based on Lifecycle State. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  300

CSM 2022.3 Features

Contents



◦ Define Image Path Values for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  305
◦ Define Validation/Auto-Population Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  307
◦ Define Validation Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  308
◦ Define Auto-population Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  312
◦ Group Map Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  315
◦ Open the Group Map Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  317
◦ Create a Group Map. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  318
◦ Storing Foreign Keys for Validated and Auto-populated Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  320
◦ Defining Foreign Key Relationships. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  322
◦ Example: Defining a Foreign Key Relationship for Asset Status Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  324
◦ Configuring Shared Foreign Key Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  327
◦ Blueprint Scan Errors for Foreign Key Relationships. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  331
◦ Define Group Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  332
◦ Define Advanced Properties for a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  333
◦ General Field Attributes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  337
◦ Create Action Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  338
◦ About Encrypted Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  339
◦ Using Encrypted Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  340
◦ Configuring Field-Level Encryption. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  341
◦ Best Practices for Encrypting Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  343
◦ Relationships. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  344
◦ About Relationships. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  345
◦ Relationships Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  346
◦ Managing Relationships. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  347
◦ Open the Relationship Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  348
◦ Relationship Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  349
◦ Relationship Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  351
◦ Create/Edit a Relationship. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  352
◦ Create a Relationship Using the Relationship Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  354
◦ Create a Relationship Using the Relationship Properties Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  357
◦ Define General Properties for a Relationship. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  358
◦ Define Link Properties for a Relationship. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  361
◦ Define Database Properties for a Relationship. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  366
◦ Define Auditing Properties for a Relationship. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  368
◦ Define Advanced Properties for a Relationship. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  369
◦ Entity Relationship Diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  372
◦ Relationships and Performance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  373
◦ Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  374
◦ About Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  375
◦ Tour a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  377
◦ Form Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  379

CSM 2022.3 Features

Contents



◦ Field Form Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  383
◦ Field Form Control Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  385
◦ Standard Form Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  386
◦ Special Form Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  388
◦ Embedded Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  389
◦ Form Arrangements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  390
◦ Presenting Different Views to Users. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  392
◦ OOTB Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  393
◦ Using Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  394
◦ View a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  395
◦ Managing Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  396
◦ Form Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  397
◦ Open the Form Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  399
◦ Form Menu Bar Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  401
◦ Form Editor Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  403
◦ Form Editor Behaviors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  414
◦ Simultaneous Form Editing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  419
◦ Form Design Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  425
◦ Create/Edit a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  426
◦ Select a Form Theme. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  429
◦ Select a Form Background Color. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  431
◦ Add a Form Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  433
◦ Add a Field Form Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  434
◦ Add a Standard Form Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  435
◦ Add a Banner Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  436
◦ Add a Button Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  437
◦ Add a Group Box Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  438
◦ Add an Image Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  439
◦ Add a Label Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  441
◦ Add a Link Label Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  442
◦ Add a List Box Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  443
◦ Add a Radio Button Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  446
◦ Add a Shape Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  448
◦ Add a Special Form Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  449
◦ Add an Embedded Form Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  450
◦ Add a Matrix Selector Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  452
◦ Add a Related Item Picker Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  454
◦ Add a Related Item Viewer Control to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  456
◦ Define How a Control Looks and Behaves on a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  457
◦ Define and Format Control Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  458
◦ Define a Tooltip for a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  460

CSM 2022.3 Features

Contents



◦ Size A Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  462
◦ Select a Background, Foreground, and Border Color for a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  464
◦ Select a Border Style for a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  466
◦ Add an Image to a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  467
◦ Align a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  468
◦ Anchor a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  469
◦ Layer a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  471
◦ Define Visibility for a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  472
◦ Enable/Disable a Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  473
◦ Set Tab Order on a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  474
◦ Make a Form the Default Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  476
◦ Related Item Navigation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  477
◦ Configure Related Item Navigation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  479
◦ Configure Solution Search Workflow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  481
◦ Configure Knowledge Sources for Solution Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  482
◦ Configure Knowledge Mapping for Solution Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  485
◦ Configure Solution Search Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  488
◦ Solution Search Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  490
◦ Configure Slack for the Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  496
◦ Configure a Slack Workspace for the Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  497
◦ Configure Third-party Chat Integration Settings for Slack. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  498
◦ Configure Slack Channel Naming Conventions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  499
◦ Configure Slack Chat History Archiving. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  500
◦ Configure Teams Chat for the Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  502
◦ About Teams Chat. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  503
◦ Create a Microsoft Teams App Registration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  504
◦ Configure Third-party Chat Integration Settings for Microsoft Teams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  506
◦ Configure Third-party Chat Integration Security Rights for Microsoft Teams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  508
◦ Configure Microsoft Teams Channel Naming Conventions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  509
◦ Configure Microsoft Teams Chat History Archiving. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  510
◦ Use Related Item Navigation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  512
◦ Use Solution Search for Internal Solutions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  514
◦ Use Solution Search for External Solutions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  516
◦ Use Communication in Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  518
◦ Use Attachments in Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  519
◦ Use Slack in the Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  520
◦ Create a Slack Channel from the Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  521
◦ Add Users to Slack Channels. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  522
◦ Send Messages to Slack from CSM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  523
◦ Archive Slack Conversations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  524
◦ Use Microsoft Teams in the Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  525

CSM 2022.3 Features

Contents



◦ Create a Microsoft Teams Channel from the Related Items Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  527
◦ Add Users to Microsoft Teams Channels. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  528
◦ Send Messages to Microsoft Teams from CSM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  529
◦ Archive Microsoft Teams Conversations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  530
◦ Managing Form Arrangements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  531
◦ Form Arrangement Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  532
◦ Open the Form Arrangement Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  534
◦ Create/Edit a Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  535
◦ Define General Tab Properties for a Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  537
◦ Define Tab Contents Properties for a Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  539
◦ Define Tab Filter Properties for a Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  542
◦ Define Tab Relationship Options for a Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  545
◦ Define General Splitter Properties for the Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  546
◦ Define Splitter Position Properties for the Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  548
◦ Define Stacked Zone Options for a Portal Form Arrangement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  549
◦ Activity Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  551
◦ Using the Activity Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  552
◦ Configure the Activity Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  553
◦ How to Map Activity Pane Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  556
◦ Activity Pane Troubleshooting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  557

◦ Calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  559
◦ About Calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  560
◦ Tour a Calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  561
◦ Using Calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  562
◦ View a Calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  563
◦ Change the Calendar View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  564
◦ View/Edit a Calendar Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  565
◦ Add a Single Calendar Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  566
◦ Navigate through Calendar Items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  567
◦ Show/Hide a Calendar Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  568
◦ Adjusting Gantt View Time Scales. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  569
◦ Managing Calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  570
◦ Open the Calendar Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  572
◦ Create a Calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  573
◦ Create a Set of Calendar Items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  575
◦ Configuring Calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  577
◦ Setting Default Calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  578
◦ Select a Default Global Calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  579
◦ Select a Default Role Calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  580
◦ Select a Default User Calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  583

CSM 2022.3 Features

Contents



◦ Color Selector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  584
◦ About the Color Selector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  587
◦ Using the Color Selector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  589

◦ Content Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  591
◦ About the Content Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  592
◦ Manage Content Items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  593
◦ Open the Content Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  594
◦ Tour the Content Manager User Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  595
◦ Filter Items by Association. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  598
◦ Filter Business Objects by Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  599
◦ Filter Items by View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  600
◦ Clear Filters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  601
◦ Create Business Object in Content Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  602
◦ Search for a Content Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  603
◦ Clone a Content Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  605
◦ List of Definitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  606
◦ Configure the Content Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  608

◦ Counters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  610
◦ About Counters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  611
◦ Counters Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  612
◦ Using Counters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  613
◦ View a Counter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  614
◦ Add a Counter to a Stored Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  615
◦ Add a Counter to a Custom Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  616
◦ Managing Counters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  617
◦ Open the Counter Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  619
◦ Create, Reset, or Change a Counter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  620
◦ Reset a Record ID Counter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  622
◦ Configuring Counters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  624

◦ Dashboards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  625
◦ Dashboards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  626
◦ Tour a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  628
◦ Dashboards Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  630
◦ Dashboard Filtering. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  631
◦ Heads-Up Display (HUD). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  633
◦ Dashboard Drill-Down. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  634
◦ Dashboard Refresh. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  637
◦ Using Dashboards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  640
◦ View a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  641
◦ Filter a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  642

CSM 2022.3 Features

Contents



◦ Drill Down into Dashboard Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  643
◦ Initiate a One-Step Action/Action from a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  644
◦ Manually Refresh a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  645
◦ Select a User Dashboard Theme. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  646
◦ Set the Current Dashboard to be the Default. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  647
◦ Managing Dashboards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  648
◦ Open the Dashboard Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  649
◦ Dashboard Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  650
◦ Dashboard Editor Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  651
◦ Dashboard Editor Behaviors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  660
◦ Dashboard Editor Keyboard Shortcuts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  663
◦ Open the Dashboard Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  664
◦ Design a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  665
◦ Dashboard Design Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  666
◦ Dashboard Design Tips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  667
◦ Create/Edit a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  668
◦ Select a Dashboard Background Color. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  670
◦ Size a Dashboard Background. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  671
◦ Add a Widget to a Dashboard (General). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  672
◦ Add a Button Widget to a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  673
◦ Add an Image Widget to a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  675
◦ Add a Link Widget to a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  676
◦ Add a Text Widget to a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  677
◦ Add a Shape Widget to a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  678
◦ Define How a Widget Looks and Behaves on a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  679
◦ Define and Format Widget Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  680
◦ Size a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  682
◦ Select a Background, Foreground, and Border Color for a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  683
◦ Select a Background Style and Gloss for a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  685
◦ Select a Border Style for a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  686
◦ Add an Image to a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  687
◦ Align a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  688
◦ Anchor a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  689
◦ Layer a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  691
◦ Define Visibility for a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  692
◦ Managing Dashboard Tab Stops. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  693
◦ Dashboard Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  695
◦ Configuring Dashboards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  697
◦ Select Default Dashboards and Dashboard Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  698
◦ Select Default Global Dashboards and Dashboard Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  699
◦ Select Default Role Dashboards and Dashboard Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  701

CSM 2022.3 Features

Contents



◦ Select Default User Dashboards and Dashboard Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  703
◦ Enable Anonymous View of a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  705
◦ About the Dashboard Viewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  707
◦ Dashboard Viewer Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  708
◦ Using the Dashboard Viewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  709
◦ Dashboard Viewer Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  710
◦ Dashboard Viewer Menu Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  711
◦ Dashboard Viewer Behaviors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  713
◦ Open the Dashboard Viewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  714
◦ View a Dashboard or Slideshow in the Dashboard Viewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  715
◦ Configuring the Dashboard Viewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  716
◦ Define Dashboard Viewer Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  717
◦ About Dashboard Slideshows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  719
◦ Slideshow Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  720
◦ Open the Slideshow Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  721
◦ Create a Slideshow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  722

◦ Document Repositories. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  725
◦ Document Repositories. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  726
◦ Document Repositories Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  727
◦ Using Document Repositories. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  728
◦ View a Document Repository. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  729
◦ Managing Document Repositories. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  730
◦ Open the Document Repository Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  731
◦ Create a Document Repository. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  732
◦ Add a Document (Attachment) to a Document Repository. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  733
◦ Configuring Document Repositories. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  734

◦ Delegation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  735
◦ About Delegation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  736
◦ Managing Delegation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  737
◦ Delegate Work. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  738
◦ Delete a Delegation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  740
◦ Cancel a Delegation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  741
◦ Manage Delegates For Other Users. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  742
◦ View All Delegations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  745
◦ Configure Delegation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  746
◦ Configure Delegation Emails for Approvals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  747

◦ Email. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  748
◦ About CSM Email. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  749
◦ CSM Email Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  751
◦ About CSM Email Accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  752

CSM 2022.3 Features

Contents



◦ Using Email Accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  753
◦ Send an Email from within CSM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  754
◦ Select Email Recipients from the CSM Address Book. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  756
◦ Add Attachments to Email. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  757
◦ Attach Email Messages to Records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  760
◦ Track E-mail Correspondence in Journal - Mail History Records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  762
◦ Email Message Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  763
◦ Configure a Personal Email Account. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  764
◦ Define Personal POP or IMAP Account Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  765
◦ Define Personal Microsoft Exchange Account Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  769
◦ Define Options for a Personal E-mail Account. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  772
◦ About the Cherwell Outlook Add-In. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  773
◦ Outlook Add-In Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  774
◦ Cherwell Outlook Add-In Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  775
◦ Tour the Cherwell Outlook Add-In. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  778
◦ Using the Cherwell Outlook Add-In. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  781
◦ Link Outlook E-mails to Customers and CSM Business Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  782
◦ Interact with CSM Business Object Records from Outlook. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  783
◦ Add Links and Attachments to Outgoing E-mails. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  785
◦ Track Outlook E-mail Correspondence in Journal - Mail History Records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  786

◦ Expressions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  787
◦ Expressions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  788
◦ View an Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  790
◦ Manage Expressions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  791
◦ Open the Expression Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  793
◦ Create an Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  794
◦ Define an Aggregate Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  795
◦ Define a Case Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  796
◦ Define a Counter Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  798
◦ Define a Date/Time Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  799
◦ Define a Duration Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  802
◦ Define a Logical Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  804
◦ Define a Machine Learning Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  806
◦ Define a Numerical Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  807
◦ Define a Sentiment Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  809
◦ Define a Text Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  810
◦ Define a User/Customer Data Expression. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  811
◦ Configure Expressions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  812

◦ Formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  813
◦ About Formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  814

CSM 2022.3 Features

Contents



◦ Formats Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  815
◦ Use Formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  816
◦ View a Format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  817
◦ Add a Format to a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  818
◦ Manage Stored Formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  819
◦ Open the Stored Format Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  820
◦ Create a Stored Format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  821

◦ Grids. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  822
◦ About Grids. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  824
◦ Tour a Grid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  826
◦ Grid Persistence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  829
◦ About Grid Filtering. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  830
◦ Using Grids. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  832
◦ Print a Grid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  835
◦ Export a Grid in the Desktop Client. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  836
◦ Export a Grid in the CSM Browser Client. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  838
◦ Filter a Grid in the Desktop Client. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  839
◦ Filter a Grid in the CSM Browser Client. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  841
◦ Group a Grid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  842
◦ Reset to the System Grid Definition. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  844
◦ Revert to a Personal Grid Definition. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  845
◦ Managing Business Object Grids. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  846
◦ Grid Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  848
◦ Create/Edit a Business Object Grid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  849
◦ Define Business Object Grid Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  851
◦ Make a Grid the Default Grid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  853
◦ Configuring Grids. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  854

◦ HTML Pages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  855
◦ About HTML Pages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  856
◦ HTML Pages Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  857
◦ Manage HTML Pages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  858
◦ Open the HTML Page Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  859
◦ HTML Page Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  860
◦ Create an External HTML Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  861
◦ Create an Internal HTML Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  862
◦ Use HTML Pages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  863

◦ Image Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  864
◦ Item Managers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  866
◦ About CSM Item Managers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  867
◦ CSM Item Manager Main Window (Typical). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  870

CSM 2022.3 Features

Contents



◦ CSM Item Manager Menu Bar (Typical). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  873
◦ CSM Item Manager Toolbar (Typical). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  875
◦ CSM Item Manager Search Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  876
◦ CSM Item Manager Tree. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  877
◦ CSM Item Manager Tree Context Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  878
◦ CSM Item Manager Main Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  879
◦ CSM Item Manager Main Pane Context Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  880
◦ CSM Item Managers Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  882
◦ Using CSM Item Managers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  883
◦ Open a CSM Item Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  884
◦ Search in a CSM Item Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  885
◦ View a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  887
◦ View Items by Scope. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  888
◦ Change the View of the CSM Item Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  889
◦ Sort a CSM Item Manager Grid Column. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  890
◦ Display/Run a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  891
◦ Create a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  892
◦ Edit a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  893
◦ Delete a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  894
◦ Copy a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  895
◦ Import/Export a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  896
◦ Organize CSM Manager Items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  897
◦ Find CSM Item Dependencies. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  898
◦ Add a CSM Item to the Task Pane or Toolbar, Toolbar, or Blueprint. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  899
◦ Pin a CSM Item. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  900
◦ Configuring CSM Item Managers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  902

◦ Knowledge Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  903
◦ About Knowledge Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  904
◦ Knowledge Articles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  907
◦ Knowledge Article Workflow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  908
◦ Knowledge Article Features and Capabilities. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  911
◦ Create a New Knowledge Article. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  913
◦ IT Knowledge Manager Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  914
◦ Knowledge Article Workflow Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  918
◦ Knowledge-IT Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  919
◦ Knowledge-IT Portal Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  929
◦ Knowledge Article Journals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  930
◦ Knowledge Article Workflow One-Step Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  931
◦ Knowledge Article Saved Searches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  939
◦ Knowledge Article Automation Processes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  941
◦ Knowledge Management Teams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  942

CSM 2022.3 Features

Contents



◦ Knowledge Management Security Group Permissions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  945
◦ Search Knowledge. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  950
◦ Search for Knowledge Using the Knowledge Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  951
◦ Search for Knowledge Articles Using Quick Search in the Task Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  952
◦ Search for Knowledge Articles from a Record and Use the Found Solution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  953
◦ Search for Knowledge Articles in the Portal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  955
◦ CSM Desktop Client Knowledge Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  956
◦ Open the Knowledge Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  958
◦ Knowledge Pane Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  959
◦ Knowledge Pane Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  960
◦ Knowledge Pane Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  961
◦ Knowledge Pane Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  962
◦ Manage Knowledge Sources. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  965
◦ Knowledge Source Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  966
◦ Define an Attachment Knowledge Source. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  967
◦ Define a Business Object Knowledge Source. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  969
◦ Define a Web Knowledge Source. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  971
◦ Knowledge Source Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  973
◦ Open the Knowledge Source Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  974
◦ Create a Knowledge Source. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  975
◦ Knowledge Mapping. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  976
◦ Open the Knowledge Mapping Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  977
◦ Define General Knowledge Search Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  978
◦ Define Business Object Knowledge Search Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  979
◦ Import Knowledge. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  980
◦ Configure a Business Object for Knowledge Import. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  981
◦ Import Knowledge Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  984
◦ Configure Knowledge Security Group Permissions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  985
◦ Knowledge Article Workflow Design Ideas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  986

◦ Metrics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  987
◦ About Metrics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  988
◦ Metric Caching. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  990
◦ Metric Example. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  993
◦ Metrics Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1001
◦ Using Metrics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1002
◦ View a Metric. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1003
◦ Use Metrics in Gauge Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1004
◦ Use Metrics in Expressions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1005
◦ Use Metrics in a Query. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1006
◦ Managing Metrics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1007
◦ Open the Metric Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1008

CSM 2022.3 Features

Contents



◦ Create a Metric. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1009
◦ Creating a Query Value Metric. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1010
◦ Creating a Calculated Metric. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1012
◦ Using a Metric Within a Metric. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1014
◦ Configuring Metrics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1015

◦ Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1016
◦ About Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1017
◦ Modify/Format Value Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1019
◦ Modifier Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1020
◦ Text Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1021
◦ Date/Time Modifier. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1030
◦ Date/Time Modifier Formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1032
◦ Numeric Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1034
◦ Numeric Modifier Formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1037
◦ Logical Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1038
◦ XML Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1039
◦ JSON Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1052
◦ Using Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1063
◦ Access Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1064
◦ Apply Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1065
◦ Encryption Modifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1066

◦ One-Step Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1069
◦ About Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1070
◦ Actions Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1072
◦ Managing Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1073
◦ Action Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1074
◦ Actions Available from the Action Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1076
◦ Open the Action Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1078
◦ Actions Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1079
◦ Command Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1080
◦ Open the Command Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1081
◦ Add Actions to CSM Areas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1082
◦ Add an Action to a CSM Desktop Client Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1083
◦ Add an Action to a CSM Task Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1084
◦ Add an Action to a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1085
◦ Add an Action to a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1086
◦ Add an Action to an Automation Process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1087
◦ Add an Action to a Business Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1088
◦ Add an Action to a Customer Portal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1089
◦ About One-Step Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1090

CSM 2022.3 Features

Contents



◦ One-Step Actions Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1093
◦ One-Step Actions and Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1094
◦ Using One-Step Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1095
◦ View a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1096
◦ Run a One-Step Action from the One-Step Action Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1097
◦ Run a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1099
◦ Managing One-Step Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1100
◦ Open the One-Step Action Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1101
◦ One-Step Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1102
◦ One-Step Editor Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1105
◦ Available One-Step Editor Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1106
◦ Open the One-Step Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1110
◦ Create/Edit a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1111
◦ Define General Properties for a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1113
◦ Define the Conditions for a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1114
◦ View a Summary of Trusted Agents for a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1117
◦ Define Pre/Post-Steps for a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1118
◦ Define Actions for a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1120
◦ Define a Copy to Clipboard Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1122
◦ Define a Launch a URL Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1123
◦ Define a Print Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1124
◦ Define a Run a Program Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1126
◦ Define a Run a Report Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1129
◦ Define a Send a Tweet Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1132
◦ Define a Send an E-mail Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1133
◦ Format an E-mail for a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1135
◦ Define a Show a Pop-Up Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1138
◦ Define a Write to a File Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1141
◦ Create a Temporary File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1143
◦ Define a Write to Log Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1144
◦ Define a Create a New Business Object Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1146
◦ Define a Create a New Child Business Object Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1149
◦ Define a Delete a Business Object Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1152
◦ Define a Go to a Record Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1153
◦ Define a Link/Unlink Business Object Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1156
◦ Define a Step Through Children Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1159
◦ Define a Transfer Attachments Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1162
◦ Define a Transition a Business Object Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1166
◦ Define a Transfer Related Business Objects Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1167
◦ Define an Update a Business Object Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1171
◦ Define a Work with a Queue Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1174

CSM 2022.3 Features

Contents



◦ Define a Call a Web Service Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1175
◦ Web Service Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1177
◦ Set Up a Web Service. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1178
◦ Open the Web Service Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1182
◦ Define a Decide Between Multiple Cases Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1183
◦ Define an Excel Merge Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1186
◦ Create an Excel Template. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1188
◦ Excel Merge Template Functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1194
◦ Define an Execute a Command Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1197
◦ Define a Go to a Field Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1198
◦ Define a Go To Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1199
◦ Define an HTTP Request Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1201
◦ Define an Import Data Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1202
◦ Define a Run another One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1203
◦ Define a Step Through Collection Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1204
◦ Define an Update Variables or Stored Values Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1206
◦ Define Actions Using XML Collections and JSON Arrays. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1211
◦ Action Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1216
◦ Define the Annotations for a One-Step Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1217
◦ Update a Business Object with Content from a File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1218
◦ Configuring One-Step Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1219
◦ Troubleshooting One-Step Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1220
◦ Resolving "Session Has Expired" Issues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1221
◦ Action Blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1222
◦ Open the Action Block Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1223
◦ Action Block Email Templates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1224
◦ Create an Action Block. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1225
◦ Using Action Blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1227

◦ Prompts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1228
◦ About Prompts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1229
◦ Prompts Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1231
◦ Using Prompts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1232
◦ View a Prompt. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1233
◦ Enter Data into a Prompt. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1234
◦ Managing Prompts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1236
◦ Open the Prompts Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1237
◦ Create a Prompt. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1238
◦ Define Properties for a Prompt. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1239
◦ Define the Value List for a Prompt (Text Prompts Only). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1242
◦ Define Constraints (Text Prompts Only). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1244
◦ Define List Display Options (Text Prompts Only). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1245

CSM 2022.3 Features

Contents



◦ Configuring Prompts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1247
◦ Web Service Lookup Example. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1248

◦ Queues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1262
◦ About Queues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1263
◦ Queues Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1264
◦ Using Queues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1265
◦ View a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1266
◦ Queue Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1267
◦ Define Queue Pane Preferences. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1270
◦ Add a Record to a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1272
◦ Remove a Record from a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1273
◦ Check Out a Record from a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1274
◦ Manage Queues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1275
◦ Open the Queue Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1277
◦ Create a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1278
◦ Define General Properties for a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1279
◦ Define Behavior Properties for a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1281
◦ Define History Properties for a Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1283
◦ Add a Queue to the Queue Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1285
◦ Open Queue as a Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1286
◦ Open Queue as a Specific Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1287
◦ Configure Queues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1288
◦ About Queue Groups. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1289
◦ Queue Groups Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1290
◦ View Queue Groups. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1291
◦ Manage Queue Groups. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1292
◦ Open the Queue Group Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1294
◦ Create a Queue Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1295

◦ Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1296
◦ About Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1297
◦ Record Locking Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1298
◦ Using Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1300
◦ Manually Lock a Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1301
◦ Manually Unlock a Locked Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1303
◦ Managing Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1304
◦ Use the Record Locking Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1305
◦ View and Manually Unlock All User Locks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1306
◦ View and Manually Unlock All Global Locks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1307
◦ Configuring Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1308
◦ Enable Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1309

CSM 2022.3 Features

Contents



◦ Troubleshooting Record Locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1310

◦ Reporting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1311
◦ About Reporting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1312
◦ Report Alternatives. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1314
◦ Reporting Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1315
◦ Tour the Report Suite. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1316
◦ Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1317
◦ Report Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1318
◦ Report Bands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1321
◦ Report Runner. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1323
◦ Creating Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1324
◦ Opening the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1325
◦ Creating a New Report Using the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1326
◦ Select a Reporting Tool in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1327
◦ Select a Business Object and Saved Search in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1328
◦ Select Fields for the Report in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1329
◦ Create Calculated Fields for Reports in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1330
◦ Select Sort Fields in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1332
◦ Set up Report Grouping in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1333
◦ Pick a Date/Time Format for Grouping Fields in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1334
◦ Set Report Title, Header, and Footer in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1335
◦ Add a Chart to the Report in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1336
◦ Link an External Report to CSM Using the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1337
◦ Specify a Report Location in the Report Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1338
◦ Report on Groups with Relationships with Themselves. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1339
◦ Designing Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1342
◦ Opening the Report Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1343
◦ Working with Bands in Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1344
◦ Adding Fields to a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1345
◦ Formatting a Field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1347
◦ Changing Styles for Bands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1348
◦ Adding Relationships to Reports Using Detail Report Bands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1350
◦ Changing the Visibility of a Band in a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1351
◦ Modifying Page Number Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1352
◦ Working with Groups in Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1354
◦ Adding a Group Using the Report Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1355
◦ Adding a Count to a Report Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1357
◦ Working with Charts in Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1359
◦ Add Scripts to a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1361
◦ Change Field Color Based on Value Script. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1363
◦ Chart Shown on Detail Report - Limit to Detail Report Data Script. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1365

CSM 2022.3 Features

Contents



◦ Chart Shown on Group - Limit to Group Data Script. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1367
◦ Drill Down - Hide/Show Detail Report Script. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1369
◦ Drill Down - Hide/Show Particular Fields Script. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1371
◦ Generating Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1373
◦ Running Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1374
◦ Run a Report from the Report Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1375
◦ Run a Report from a Dashboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1376
◦ Run a Report from a One-Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1377
◦ Previewing Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1380
◦ Printing Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1381
◦ Print a Report from the Report Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1382
◦ Print a Report from the Report Preview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1383
◦ Print a Report from a Business Object Record. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1384
◦ Exporting Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1385
◦ Export a Report from the Report Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1386
◦ Export a Report from the Report Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1387
◦ Scheduling a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1388
◦ Managing Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1389
◦ Editing Report Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1390
◦ Open the Report Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1392
◦ Report Styles Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1393
◦ About Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1395
◦ Report Styles Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1396
◦ Define Report Styles Using the Report Styles Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1397
◦ Define General Options for Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1399
◦ Define Page Options for Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1401
◦ Define Group Options for Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1403
◦ Define Column Headers for Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1405
◦ Define Data Options for Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1407
◦ Define Detail Report Options for Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1409
◦ Define Chart Options for Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1411
◦ Preview a Report Style From the Report Styles Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1413
◦ Apply a Report Style to a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1414
◦ Delete a Report Style. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1415
◦ Configuring Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1416
◦ Defining Calculated Fields for a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1417
◦ Creating Expressions in the Report Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1419
◦ Adding Calculated Fields from the Report Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1420

◦ Rich Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1422
◦ About Rich Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1423
◦ Rich Text Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1424

CSM 2022.3 Features

Contents



◦ Using Rich Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1425
◦ Use Rich Text in Business Object Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1426
◦ Use Rich Text in Knowledge Articles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1429
◦ Create One-Step Actions that Use Rich Text Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1430
◦ Use Rich Text in E-mails. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1432
◦ Configuring Rich Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1433
◦ Enable Rich Text on Business Object Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1434
◦ Define Rich Text Settings for E-mails. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1437

◦ Searching. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1438
◦ Searching. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1439
◦ Hierarchy of Default Settings for Search Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1441
◦ Search Queries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1443
◦ Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1445
◦ Operators. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1446
◦ Use All Words/Any Words. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1447
◦ Query Clauses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1448
◦ Define a Comparison Clause. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1449
◦ Define a Group Clause. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1451
◦ Define an Ownership Clause. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1452
◦ Define a Related Clause. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1454
◦ Define a Queue Clause. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1456
◦ Define a Specific Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1457
◦ Define a User Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1458
◦ Define a Queue Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1459
◦ Define an Any Queue. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1460
◦ Query Builders. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1461
◦ Stored Query Builder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1464
◦ Quick Search Query Builder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1466
◦ Custom Query Builder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1468
◦ Query Builder Behaviors and Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1469
◦ About Quick Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1471
◦ Quick Searches Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1472
◦ Quick Search in the Task Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1473
◦ Quick Search Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1475
◦ Using Quick Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1476
◦ Run a Quick Search Against a Specific Business Object from the Quick Search Widget. . . . . . . . . . . . . . . . . . .  1477
◦ Run a Quick Search Against All Business Objects in the Quick Search Widget. . . . . . . . . . . . . . . . . . . . . . . . . . .  1478
◦ Run a Quick Search from the Task Pane Quick Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1479
◦ Quick Search Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1480
◦ About Saved Searches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1481
◦ Saved Searches Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1482

CSM 2022.3 Features

Contents



◦ Using Saved Searches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1483
◦ View a Saved Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1484
◦ Run a Saved Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1485
◦ Create a Saved Search Using Only Child Object Criteria. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1486
◦ Using Search Data with Third-Party Reporting Tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1492
◦ Using Power BI and the Data Connector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1494
◦ Using Tableau and the Web Data Connector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1502
◦ API URL for a Saved Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1503
◦ Guidelines for Using Third-Party Reporting Tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1504
◦ Grid Options for Third-Party Reporting Tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1505
◦ Saved Search Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1507
◦ Navigate Search Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1508
◦ Managing Saved Searches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1509
◦ Open the Search Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1511
◦ Create a Saved Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1512
◦ Change the Sort Order of a Saved Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1514
◦ Configuring Search Defaults. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1515
◦ Customizing Search Results Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1517
◦ Hiding the All Words/Any Words Search Option. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1518

◦ Stored Values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1519
◦ About Stored Values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1520
◦ Stored Values Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1522
◦ Using Stored Values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1523
◦ View a Stored Value. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1524
◦ Assign a Value to a Stored Value. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1525
◦ Managing Stored Values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1526
◦ Open the Stored Value Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1528
◦ Create a Stored Value. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1529
◦ Configuring Stored Values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1531

◦ System Functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1532
◦ About System Functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1533
◦ About the CurrentCulture System Function. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1537
◦ Restrict Anonymous User Visibility for a Dashboard Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1539
◦ Restrict Anonymous User Visibility for a Form Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1541

◦ Table Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1543
◦ About Table Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1544
◦ Table Management Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1545
◦ Open the Table Management Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1546
◦ Table Management Interface Behaviors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1547
◦ Table Management Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1548

CSM 2022.3 Features

Contents



◦ Using Table Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1549
◦ View Values in a Lookup Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1550
◦ Search for a Value in a Lookup Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1551
◦ Add a Value to a Lookup Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1552
◦ Edit a Value in a Lookup Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1553
◦ Delete a Value from a Lookup Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1554
◦ Configuring Table Management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1555

◦ Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1556
◦ About Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1557
◦ Dashboard Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1558
◦ Dashboard Universal Theme Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1559
◦ Form Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1561
◦ Form Universal Theme Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1562
◦ Portal Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1564
◦ Portal Universal Theme Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1565
◦ Action Catalog Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1568
◦ Action Catalog Universal Theme Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1569
◦ Themes Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1571
◦ Using Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1572
◦ Open the Theme Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1573
◦ Chart Widget Color Palette Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1574
◦ Chart Widget Color Palette Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1575
◦ Configure Chart Widget Color Palette Security Groups. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1576
◦ Create Custom Chart Widget Color Palettes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1577
◦ Assign a Color Palette to a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1579
◦ Managing Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1581
◦ Theme Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1582
◦ Open the Theme Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1584
◦ Preview a Theme. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1585
◦ Working with Theme Editor Palette Colors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1586
◦ Working with Theme Editor Fonts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1590
◦ Working with Theme Editor State Override. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1592
◦ Design a Theme. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1594
◦ Create a Theme. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1596
◦ Bulk Apply Classic Theme. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1598
◦ Configuring Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1599

◦ Tokens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1600
◦ About Tokens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1601
◦ Token Selector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1603
◦ Open the Token Selector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1604

CSM 2022.3 Features

Contents



◦ Token Context Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1607
◦ Constraints and Operators. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1608
◦ Constraints. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1609
◦ Tokens Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1610
◦ Using Tokens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1611
◦ View a Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1612
◦ Add an Existing Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1613
◦ Format a Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1614
◦ Use a Content from File Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1616
◦ Use a Counter Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1617
◦ Use a Prompt Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1618
◦ Use a Stored Value Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1619
◦ Use a System Function Token. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1620
◦ Manage Tokens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1621
◦ Create a Token Using the Token Selector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1622

◦ Twitter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1623
◦ Integrating CSM with Twitter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1624
◦ Managing Twitter Accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1625
◦ Twitter Account Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1626
◦ Open the Twitter Account Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1628
◦ Create a CSM Twitter Account. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1629

◦ Visualizations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1632
◦ About Visualizations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1633
◦ Primary Object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1635
◦ Link Chains. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1637
◦ Tour a Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1638
◦ Visualizations Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1640
◦ Using Visualizations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1641
◦ View a Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1642
◦ Change the Visualization Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1643
◦ View Information about a Visualization Node. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1644
◦ Search for a Specific Record in the Visualization Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1645
◦ Go to a Record from the Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1646
◦ Show/Hide Visualization Links and Nodes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1647
◦ Managing Visualizations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1648
◦ Open the Visualization Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1650
◦ Create a Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1651
◦ Define General Visualization Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1652
◦ Define a Visualization Link Chain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1654
◦ Define a Visualization Alert. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1657

CSM 2022.3 Features

Contents



◦ Configuring Visualizations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1659
◦ Select a Default Global Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1660
◦ Select a Default Role Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1661
◦ Configuring Visualization Tooltips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1662

◦ Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1663
◦ About Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1664
◦ Action Catalog Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1666
◦ Browser Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1669
◦ Chart Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1671
◦ Stacked Bar/Column Charts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1675
◦ Command Palette Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1677
◦ Filter Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1678
◦ Flyout Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1679
◦ Gauge Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1680
◦ Matrix Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1682
◦ RSS Feed Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1684
◦ Search Results List Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1686
◦ Search Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1687
◦ Twitter Feed Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1688
◦ Tab Group Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1690
◦ Standard Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1691
◦ Widgets Good to Know. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1693
◦ Using Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1694
◦ View a Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1695
◦ Managing Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1696
◦ Open the Widget Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1698
◦ Create a Widget (General). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1699
◦ Create an Action Catalog Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1700
◦ Define General Properties for an Action Catalog Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1701
◦ Define Actions for an Action Catalog Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1704
◦ Define Display Properties for an Action Catalog Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1708
◦ Define Grouping Properties for an Action Catalog Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1711
◦ Define Display Properties for an Action Catalog Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1713
◦ Create a Browser Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1715
◦ Browser Widget Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1716
◦ Create a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1718
◦ Define General Properties for a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1721
◦ Define a Series for a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1723
◦ Define Options for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1726
◦ Define Criteria (Data) for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1727
◦ Define the X-Axis Values for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1730

CSM 2022.3 Features

Contents



◦ Define the Y-Axis Values for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1732
◦ Define How Values are Grouped for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . .  1734
◦ Define a Custom Color for an X-Value in a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . .  1736
◦ Define How Values are Combined for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . .  1738
◦ Define Analysis for a Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1739
◦ Define Drill-Down for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1741
◦ Define Point Label Formats for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . .  1743
◦ Define Display Properties for a Bar, Column, Line, or Scatter Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1744
◦ Define Options for a Doughnut/Pie Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1745
◦ Define Criteria (Data) for a Doughnut/Pie Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1746
◦ Define Slices for a Doughnut/Pie Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1748
◦ Define the Size of Slices for a Doughnut/Pie Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1750
◦ Define a Custom Color for a Slice in a Doughnut/Pie Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1751
◦ Define How Values are Combined for a Doughnut/Pie Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1753
◦ Define Drill-Down for a Doughnut/Pie Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1754
◦ Define Criteria (Data) for a Pipeline Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1756
◦ Define Slices for a Pipeline Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1758
◦ Define Options for a Pipeline Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1760
◦ Define the Size of Slices for a Pipeline Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1761
◦ Define a Custom Color for a Slice in a Pipeline Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1762
◦ Define Drill-Down for a Pipeline Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1764
◦ Define an X-Axis for a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1766
◦ Define X-Axis Sorting Options for a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1772
◦ Define Y-Axes for a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1773
◦ Define a Legend for a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1775
◦ Define Display Properties for a Chart Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1777
◦ Create a Command Palette Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1779
◦ Create a Filter Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1780
◦ Create a Flyout Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1783
◦ Flyout Widget Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1784
◦ Create a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1788
◦ Define Criteria (Data) for a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1792
◦ Define a Value for a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1793
◦ Define a Scale for a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1797
◦ Define Thresholds for a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1798
◦ Define Number Properties for a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1800
◦ Define Drill-Down for a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1801
◦ Define Display Properties for a Gauge Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1803
◦ Create a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1805
◦ Define Rows for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1807
◦ Define Columns for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1810

CSM 2022.3 Features

Contents



◦ Define a Numeric Column for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1811
◦ Define a Calculate Column for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1813
◦ Define an Image Column for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1815
◦ Define a Text Column for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1816
◦ Define a Value Bar Column for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1818
◦ Define a Ratings Column for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1822
◦ Define Appearance for a Matrix Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1824
◦ Create an RSS Feed Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1827
◦ Create a Search Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1829
◦ Create a Search Results List Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1832
◦ Create a Twitter Feed Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1834
◦ Create a Shape Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1836
◦ Create a Tab Group Widget. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1837
◦ Configuring Widgets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1838

CSM 2022.3 Features

Contents



CSM Features
CSM provides a large set of configurable features, including Dashboards, Reports, One-Step Actions, and
more.
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Adaptive Layouts
An Adaptive Layout is a design feature that allows a Form or Dashboard to adapt to different dimensions. Use
Adaptive Layouts to design Forms and Dashboards that provide optimal user experiences across a range of
devices.
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About Adaptive Layouts
Understand how adaptive layouts equip you with the power of adaptive design so that your forms and
dashboards can be easily viewed from any device or client window.

Adaptive Design
An adaptive layout is a design feature that allows a form or dashboard to adapt to different dimensions.
Use adaptive layouts to provide optimal user experiences across a range of devices.

Adaptive forms and dashboards snap to the width of the screen or client window at specific breakpoints,
which are defined in the adaptive layout properties. You can design many adaptive layouts for a single
form or dashboard so that it adapts to multiple screens and client windows of various sizes. For example,
if your users often submit Incident forms from laptops and tablets, you may design your Incident form with
two adaptive layouts: one with the dimensions of a laptop screen and another with tablet dimensions.
Refer to the adaptive forms and dashboards scenarios for detailed examples of the benefits of adaptive
design.

The adaptive layout feature is automatically enabled. When you open the Form Editor or Dashboard
Editor, the system generates a base layout. You can then create, edit, or delete layouts within the editor
using the adaptive layout design features. Each form or dashboard must contain at least one layout to
define its dimensions. If you do not wish to configure adaptive design, you can work within the base layout
without creating additional layouts.

Adaptive Layout Presets
If you plan to implement an adaptive layout with the same dimensions across many views, forms, or
dashboards, consider using an adaptive layout Preset to save design time. An adaptive layout Preset is a
pre-defined set of layout properties that is saved in the Adaptive Layout Preset Manager. When you
create or edit a layout, you can optionally select an adaptive layout preset to populate the new layout's
properties with the pre-defined preset properties. Refer to the adaptive forms and dashboards scenarios
or the procedures to create or edit an adaptive layout for details.

Adaptive Layout Structure
The adaptive layout structure builds upon the current structure of Business Object views to forms.

For each Business Object View there is a default form. For example, the Portal view for Incident utilizes
the Incident Portal form. You can create as many forms as you need for a given Business Object View, but
there is always one default form.

For each form or dashboard, there is a base layout. The base layout is added automatically when you
create a new form or dashboard. You can change the name or other properties of the base layout by
following the procedure to edit an adaptive layout.

Note: Adaptive layout functionality is available for forms in CSM 9.3.0 and later and for
dashboards in CSM 9.4.0 and later. When you upgrade beyond these versions, your existing
forms and dashboards are preserved and become the base layouts.
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The base layout can be deleted by following the procedure to delete an adaptive layout. Remember that
each form and dashboard must have a at least one layout, so a layout cannot be deleted if it is the only
one.

Related concepts
Adaptive Dashboards Scenarios
Adaptive Forms Scenarios
Dashboard Editor
Form Editor
Related tasks
Create an Adaptive Layout
Delete an Adaptive Layout
Edit an Adaptive Layout
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Use Adaptive Layouts
Use Adaptive Layouts to enhance the user experience and streamline your design process for forms and
dashboards.

When you work with Adaptive Layouts, you can manually define a layout or select an Adaptive Layout
Preset to use pre-defined dimensions. Use presets to create Adaptive Layouts with the same properties
across different forms or dashboards.

When you determine the number of Adaptive Layouts to design and the properties for each layout,
consider the use cases. Which devices do your users commonly use to interact with the form or
dashboard? If your company issues devices to your users, look up the dimensions for the device model
before you begin designing.

OOTB Adaptive Layouts
CSM provides OOTB Adaptive Layouts for most CSM Portal forms and dashboards that target the screen
dimensions of handheld devices and tablets. CSM Portal forms and dashboards that include the OOTB
layouts switch to the appropriate layout at the defined breakpoints. Use the layouts as-is, edit them,
delete them, or create your own Adaptive Layouts within the Form Editor or Dashboard Editor. The default
properties for the OOTB Adaptive Layouts are:

Forms

Property Value

Name Mobile

Width 414

Height 142

Minimum Width 375

Color Blue

Property Value

Name Tablet Form Header

Description This layout is optimized for portrait orientation.

Width 1024

Height 142

Minimum Width 768

Color Red

Property Value

Name Base Layout
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Property Value

Description Layout generated by the system during upgrade or
validation processing.

Width 1440

Height 142

Minimum Width 1025

Color Green

Dashboards

Property Value

Name Mobile View

Width 414

Height 2200

Minimum Width 375

Color Orange

Property Value

Name Tablet View

Description This layout is optimized for portrait orientation.

Width 1024

Height 1800

Minimum Width 768

Color Red

Property Value

Name Base Layout

Description Layout generated by the system during upgrade or
validation processing.

Width 1600

Height 982

Minimum Width 1600

Color Green
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OOTB Adaptive Layout Presets
CSM provides the following OOTB Adaptive Layout Presets, available in the Adaptive Layout Preset
Manager. Use these OOTB presets as-is, edit them, delete them, or create your own using the Form
Editor or the Dashboard Editor.

Property Value

Name Base Layout

Description Layout generated by the system during upgrade or
validation processing.

Width 390

Height 800

Minimum Width 0

Color Green

Property Value

Name Embedded

Description
Embedded form size for the Small parent layout.
See Managing Controls and Widgets in Adaptive
Layouts.

Width 361

Height 425

Minimum Width 0

Color Red

Property Value

Name Small

Description Portal form size for handheld devices.

Width 414

Height 1052

Minimum Width 0

Color Red

Property Value

Name Small Embedded

Description See Managing Controls and Widgets in Adaptive
Layouts.
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Property Value

Width 361

Height 240

Minimum Width 0

Color Red

Property Value

Name Tablet

Description This layout is optimized for portrait orientation.

Width 767

Height 1000

Minimum Width 0

Color Cornflower Blue

Property Value

Name Tablet Form

Width 1024

Height 900

Minimum Width 0

Color Red

Related concepts
About Adaptive Layouts
Form Design Considerations
Related tasks
Edit an Adaptive Layout
Edit an Adaptive Layout Preset
Related reference
Adaptive Layout Properties
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Adaptive Forms Scenarios
Adaptive Forms leverage adaptive design so that your Users can quickly view and submit Forms from any
device or client window. Use these fictional scenarios to learn how adaptive Forms can improve your user
experience and streamline your design process.

Scenario: Optimizing the Incident Portal Form for Tablets
Curtis and Christine work at the River T Corp. organization:

• Christine is the Design Team Lead who is responsible for visualizing and implementing the overall
design of the River T. Corp Portal. She assigns design tasks to her team members.

• Curtis is a Content Designer who reports to Christine.

River T Corp. recently rolled out 500 tablets for their sales team. In the weekly design team meeting,
Christine discusses feedback she received regarding the Incident Portal Form. When accessing the Form
on the tablet in portrait orientation, the Customer is required to scroll vertically and horizontally in order to
complete all of the required Fields and submit the Incident. To improve the user experience, Christine
assigns a task to Curtis to design a new Adaptive Layout for the Incident Portal Form.

Curtis starts by converting the tablet's screen resolution to device-independent pixels (DIP). The screen
resolution is 1200 x 1920 physical pixels with approximately 283 dots-per-inch (DPI). Using the DIP
conversion formula, Curtis determines that the tablet's screen resolution is 600 x 960 device-independent
pixels.

Note: Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels for details
about converting between DPI and DIP.

With these measurements confirmed Curtis is ready to begin designing the layout so that it is optimized
for the tablet screen. Other Forms may also need to be optimized for the 600 x 960 screen size, so
Christine directs Curtis to save the new layout as an Adaptive Layout Preset. As the design team
optimizes other Forms for tablets, they can use the Adaptive Layout Preset to automatically populate the
properties for each layout.

Curtis opens CSM Administrator and creates a new Blueprint. He selects the Incident Business Object
and changes the current View to Portal Default. He clicks Edit Form to open the Form Editor.

To create a new Adaptive Layout, Curtis clicks the Create New button  and defines the following
Adaptive Layout properties:

Property Value

Name Tablet Layout

Description Use this Layout to design Forms that are optimized
for the tablet screen in portrait orientation.

Width 600

Height 960
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Property Value

Icon

Guide Color Yellow

With the dialog window still open, Curtis clicks Save As Preset. The set of properties is saved in the
Adaptive Layout Preset Manager so that it can be reused for other Forms.

Curtis selects OK and then makes design changes in the Form Editor so that all fields fit within the Tablet
layout boundaries. The changes that Curtis makes to the Tablet layout do not affect the other adaptive
layouts that already exist for the form. Christine confirms the changes and gives Curtis permission to
publish the Blueprint. When a member of the sales team brings up the form, CSM recognizes the display
size and automatically renders the Tablet layout for an optimal user experience.

Scenario: Optimizing Additional Forms for Tablets Using an Adaptive Layout Preset
The River T. Corp sales team is impressed with the Incident Portal Form as it is displayed on their tablets,
so they ask Christine to similarly optimize the Knowledge Article Portal Form.

Christine assigns a task to Curtis to design a new Adaptive Layout for the Knowledge Article Portal Form
with identical dimensions to the Tablet Layout that he created for the Incident Portal Form. Curtis can save
time on this task by using the Adaptive Layout Preset that he defined earlier.

To start, Curtis creates a new Blueprint. He opens the Knowledge Article Form using the Portal Default
View in the Form Editor. Then, he clicks the Create New button  to create a new layout. The Create
Layout dialog opens.

In the dialog, Curtis clicks the Ellipses button  to select an Adaptive Layout Preset. The Adaptive
Layout Preset Manager opens. He navigates to the folder where he saved the Tablet Layout, selects it,
and clicks OK. The Create Layout dialog is automatically populated with the Preset properties, which
were defined to match the tablet screen dimensions in portrait orientation.

Curtis selects OK and then makes design changes in the Form Editor so that all fields fit within the Tablet
layout boundaries. The changes that Curtis makes to the Tablet layout do not affect the other adaptive
layouts that already exist for the form. Christine confirms the changes and gives Curtis permission to
publish the Blueprint. When a member of the sales team brings up the form, CSM recognizes the display
size and automatically renders the Tablet layout for an optimal user experience.

Related concepts
About Adaptive Layouts
Defining Adaptive Layout Properties Using Device-Independent Pixels
Standard Form Sizes
Related tasks
Create an Adaptive Layout
Create an Adaptive Layout Preset
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Adaptive Dashboards Scenarios
Adaptive dashboards leverage adaptive design so that your Users can view key metrics in real time from
any device or browser window. Use these fictional scenarios to learn how adaptive dashboards can
improve your user experience and streamline your design process.

Scenario: Optimizing a Portal Dashboard for Smartphones
Curtis and Christine work at the River T Corp. organization:

• Christine is the Design Team Lead who is responsible for visualizing and implementing the overall
design of the River T. Corp Portal. She assigns design tasks to her team members.

• Curtis is a Content Designer who reports to Christine.

In the weekly design team meeting, Christine discusses feedback she received regarding the Facilities
dashboard.

The Facilities dashboard is a Portal dashboard that was designed for the facilities department. It uses
Widgets to present department-specific information in real time to the facilities team. Members of the
facilities team are often on their feet as they move around River T. Corp fulfilling requests and providing
general maintenance, so they usually access the Facilities dashboard from their smartphones. The team
is required to scroll vertically and horizontally in order to view all of the Widgets on the Facilities
dashboard, which makes using the dashboard cumbersome. To improve the user experience, Christine
assigns a task to Curtis to design a new adaptive layout for the Facilities dashboard.

The smartphones that the Facilities team uses were issued by River T. Corp, and the device model has a
screen resolution of 1440 x 2560 physical pixels with approximately 570 dots-per-inch (DPI). Curtis starts
by converting the smartphone's screen resolution to device-independent pixels (DIP). Using the DIP
conversion formula, Curtis determines that the screen resolution is 360 x 640 device-independent pixels.

Note: Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels for details
about converting between DPI and DIP.

With these measurements in mind, Curtis is ready to begin designing the layout so that it is optimized for
the smartphone screen. Other Portal dashboards may also need to be optimized for the 360 x 640 screen
size, so Christine directs Curtis to save the new layout as an adaptive layout preset. As the design team
optimizes other Portal dashboards for smartphones, they can use the adaptive layout preset to
automatically populate the properties for each layout.

Curtis starts by opening the CSM Desktop Client and then opening the Dashboard Editor. He selects the

Facilities dashboard and selects the Edit button  to open the Dashboard Editor.

To create a new adaptive layout, Curtis selects the Create New button  and defines the following
adaptive layout properties:

Property Value

Name Smartphone Layout
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Property Value

Description
Use this Layout to design dashboards that are
optimized for a smartphone screen in portrait
orientation.

Width 360

Height 640

Icon

Guide Color Orange

With the dialog window still open, Curtis selects Save As Preset. The set of properties is saved in the
Adaptive Layout Preset Manager so that it can be reused for other dashboards.

Curtis selects OK and then makes design changes in the Dashboard Editor so that all widgets fit within
the Smartphone Layout boundaries. The changes that Curtis makes to the Smartphone Layout do not
affect the other adaptive layouts that already exist for the dashboard. Christine confirms the changes and
gives Curtis permission to publish the Blueprint.

When a member of the facilities team opens the Facilities dashboard on a smartphone, CSM recognizes
the display size and automatically renders the Smartphone Layout for an optimal user experience.

Scenario: Optimizing Additional Dashboards for Smartphones Using an Adaptive
Layout Preset
The River T. Corp facilities team is impressed with the Facilities dashboard as it is displayed on their
smartphones, so Christine decides to similarly optimize the HR dashboard.

Christine assigns a task to Curtis to design a new adaptive layout for the HR dashboard with identical
dimensions to the Smartphone Layout that he created for the Facilities dashboard. Curtis can save time
on this task by using the adaptive layout preset that he defined earlier.

Curtis starts by opening the CSM Desktop Client and then opening the Dashboard Manager. He selects

the HR dashboard and clicks the Edit button  to open the Dashboard Editor. Then, he clicks the
Create New button  to create a new layout.

In the Create Layout dialog, Curtis clicks the Ellipses button  to select an adaptive layout preset. The
Adaptive Layout Preset Manager opens. He navigates to the folder where he saved the Smartphone
Layout, selects it, and clicks OK. The Create Layout dialog is automatically populated with the preset
properties, which were defined to match the smartphone screen dimensions in portrait orientation.

Curtis selects OK and then makes design changes in the Dashboard Editor so that all widgets fit within
the Smartphone Layout boundaries. The changes that Curtis makes to the Smartphone Layout do not
affect the other adaptive layouts that already exist for the dashboard. Christine confirms the changes and
gives Curtis permission to publish the Blueprint.

When a member of the HR team brings up the HR dashboard on a smartphone, CSM recognizes the
display size and automatically renders the Smartphone Layout for an optimal user experience.
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Related concepts
About Adaptive Layouts
Defining Adaptive Layout Properties Using Device-Independent Pixels
Related tasks
Create an Adaptive Layout
Create an Adaptive Layout Preset
Related reference
Adaptive Layout Properties
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Managing Adaptive Layouts
Manage multiple Adaptive Layouts for a single Form or Dashboard, and utilize the Adaptive Layout Preset
Manager to reuse the same properties across multiple Forms and Dashboards.

Adaptive Layouts are managed using the Adaptive Layout design features in the Form Editor and
Dashboard Editor. Adaptive Layout Presets are managed using the Adaptive Layout Preset Manager.
Define Adaptive Layouts and Adaptive Layout Presets by setting the Adaptive Layout properties.

Related concepts
About Adaptive Layouts
Dashboard Editor
Form Editor
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Adaptive Layout Design Features
Use the Adaptive Layout design features to view Adaptive Layouts in the Form Editor or Dashboard
Editor. You can also use these features to create, edit, and delete Adaptive Layouts.

The Adaptive Layout design features are immediately visible when you open the Form Editor or
Dashboard Editor. The design features vary slightly depending on which editor you are using. You may
hide certain features if you only want to work with the base layout and do not plan to create or edit
additional layouts.
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Design Features for Adaptive Forms
Tour the Adaptive Layout design features in the Form Editor.

1. Layout selector: Toggles to the specified layout when you select it from the drop-down of available1.
layouts.

2. Create, Edit, and Delete buttons: Opens the Create Layout dialog box when you select the2.

Create New button . Opens the Edit Layout dialog box when you select the Edit button .
Opens the Delete Layout dialog box when you select the Delete button .

3. Visual guide bar: Shows the display name and the width for each of the configured layouts.3.
Toggles to the selected layout when you click anywhere in the guide color for the layout. A triangle
appears next the name of the layout that is currently selected. Right-click anywhere in the guide
color to edit the layout's properties or to delete it. Define the guide color for a layout by editing its
properties.

4. Horizontal ruler: Indicates width in device-independent pixels. Use this ruler to measure the point4.
where a horizontal scroll bar will appear. For example, for a layout with a width of 1200 DPI, a
horizontal scroll bar will appear on devices with screen widths that are 1199 DPI or smaller unless
you create additional layouts.
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5. Vertical ruler: Indicates height in device-independent pixels. Use this ruler to measure the point5.
where a vertical scroll bar will appear. For example, for a layout with a height of 800 DPI, a vertical
scroll bar will appear on devices with screen heights that are 799 DPI or smaller unless you create
additional layouts.

6. Layout boundaries: The width boundary indicates the width of the layout. The height boundary
indicates the height of the layout. The space beyond the layout boundaries is grey to indicate that
Fields in that space will not render on the layout.

7. Status bar: Shows the properties for the selected layout, including display name, icon, guide color,7.
and size.
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Design Features for Adaptive Dashboards
Tour the Adaptive Layout design features in the Dashboard Editor.

1. Layout selector: Toggles to the specified layout when you select it from the drop-down of available1.
layouts.

2. Create, Edit, and Delete buttons: Opens the Create Layout dialog box when you select the2.

Create New button . Opens the Edit Layout dialog box when you select the Edit button .
Opens the Delete Layout dialog box when you select the Delete button .

3. Visual guide bar: Shows the display name and the width for each of the configured layouts.3.
Toggles to the selected layout when you click anywhere in the guide color for the layout. A triangle
appears next the name of the layout that is currently selected. Right-click anywhere in the guide
color to edit the layout's properties or to delete it. Define the guide color for a layout by editing its
properties.

4. Horizontal ruler: Indicates width in device-independent pixels. Use this ruler to measure the point4.
where a horizontal scroll bar will appear. For example, for a layout with a width of 1200 DPI, a
horizontal scroll bar will appear on devices with screen widths that are 1199 DPI or smaller unless
you create additional layouts.

5. Vertical ruler: Indicates height in device-independent pixels. Use this ruler to measure the point5.
where a vertical scroll bar will appear. For example, for a layout with a height of 800 DPI, a vertical
scroll bar will appear on devices with screen heights that are 799 DPI or smaller unless you create
additional layouts.
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6. Layout boundaries: The width boundary indicates the width of the layout. The height boundary6.
indicates the height of the layout. The space beyond the layout boundaries is grey to indicate that
fields in that space will not render on the layout.

7. Status bar: Shows the properties for the selected layout, including display name, icon, guide color,7.
and size.

8. Zoom toolbar: Allows you to zoom in and out on the design space and show or hide the rulers.

CSM 2022.3 Features 49

CSM 2022.3 Features



Managing Controls and Widgets in Adaptive
Layouts

Understand how controls and widgets behave within and between adaptive layouts.

Placement and Sizing of Controls and Widgets
When you create a new layout, the controls and widgets from the currently selected layout are copied to
the new layout.

Controls and widgets are added and removed exclusively in existing layouts. When you add a new control
or widget to a layout, it is not added to the form's other layouts. Similarly, when you remove a control or
widget from one layout, it isn't removed from the others. The same behavior applies to size and position.
You can resize or reposition a control or widget in one layout without affecting the size and position of the
same control or widget in another layout.

You can copy and paste controls and widgets between layouts. A pasted control or widget is placed at the
same position as in the original layout, so it may be placed outside of the layout boundaries.

CAUTION: The entire control or widget must be positioned within the layout boundaries to render.
Controls or widgets that overlap layout boundaries do not display for users.

Embedded Form Controls
Embedded forms can leverage adaptive design if you have created adaptive layouts for the embedded
form. For example, if multiple layouts have been created for the Task form, and then that form is
embedded in an Incident form, the embedded Task form switches to the appropriate Task layout when the
Incident form switches to a different Incident layout.

The layout for the embedded form is determined by the size of the embedded form control.

Tab Order
Tab order is unique to each form layout. If you set the tab order on one layout, it won't affect the tab order
for the form's other layouts.

Z-Order
Z-order describes the relative positioning of form controls when they overlap. For example, if you add two
controls in the Form Editor, control A can be on top of control B or B can be on top of A. The order of
overlapping upon insertion depends on the relative Z order of the two controls; you can modify this order
in the Form Editor using Bring to front or Send to Back options. See Form Editor Toolbar.

Z-order is unique to each layout. If you set the z-order in one layout, it won't affect the z-order for the
form's or dashboard's other layouts.

Related concepts
About Widgets
Form Controls
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Adaptive Layout Properties
Specify Adaptive Layout properties to define the size and descriptive elements of the Layout.

Property Description Notes

Use Preset
Layout

For an Adaptive Layout, you may optionally
select a Preset to populate the layout's
properties with the Preset properties.

Use the Adaptive Layout Preset
Manager to select an existing
Preset.

Name
For an Adaptive Layout or a Preset, this is the
name of the layout that will be displayed in the
guide bar, status bar, and Preset Manager.

This property is required.

Description
For an Adaptive Layout or a Preset, this is a
description of the layout. This field is blank by default.

Minimum
Width

For an Adaptive Layout or a Preset, this is the
breakpoint at which a horizontal scroll bar will
appear for Users.

Define using device-independent
pixels.

Width
For an Adaptive Layout or a Preset, this is the
breakpoint at which the Form will snap to
another Layout (when one exists).

Define using device-independent
pixels.

You must define the width property
at least 20 device-independent
pixels larger or smaller than any
existing layout within a Form or
Dashboard.

Height
For an Adaptive Layout or a Preset, this is the
height at which a vertical scroll bar will appear
for Users.

Define using device-independent
pixels.

Icon
For an Adaptive Layout or a Preset, this is the
image that will be displayed in the status bar
and Preset Manager.

Use the Image Manager to select an
existing image or import a new one.

Guide color
For an Adaptive Layout or a Preset, this is the
color that will represent the layout in the guide
bar.
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Property Description Notes

Save as
Preset

For an Adaptive Layout, after specifying the
properties, click this button to save the layout
as a Preset.

The new Preset will be saved in the
Adaptive Layout Preset Manager.

The Save as Preset button is
disabled until you give the Preset a
unique name.

After saving the layout as a Preset,
you cannot edit the Preset
properties from the Create Layout
dialog. Refer to Edit an Adaptive
Layout Preset.

Related concepts
Adaptive Layout Preset Manager
Standard Form Sizes
Related tasks
Create an Adaptive Layout
Create an Adaptive Layout Preset
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Defining Adaptive Layout Properties Using Device-
Independent Pixels

Understand the role of device-independent pixels in designing adaptive Forms and Dashboards that look
the same across different devices and screen resolutions, and learn how to convert between physical
pixels and device-independent pixels.

Device-independent pixels (DIP) is an artificial unit of measurement that measures the logical space
consumed by content on a display. Cherwell utilizes device-independent pixels to define UI elements for
Dashboards and Forms. When the Dashboard or Form is rendered on a specific device, the browser
gathers information about its DIP dimensions and renders the Dashboard or Form appropriately for the
device's pixel density. This ensures that the visual elements retain their logical sizes across many devices
with different densities.

When designing Adaptive Layouts you must define the height and width of a layout using device-
independent pixels. Screen resolution specifications are usually given in physical pixels, so you may need
to look up the DIP measurements for your device or perform the conversion to DIP yourself before you
begin designing. With some basic device specifications you can easily convert between physical pixels
and device-independent pixels. The conversion formula is slightly different for Android and iOS operating
systems. To start, understand the following terms:

• A physical pixel (px) is defined as a single point of programmable color on a display. Physical
pixels have different sizes depending on the display's resolution: high-resolution screens have a
greater number of relatively small physical pixels while low-resolution screens have a smaller
number of relatively large physical pixels.

• Dots-per-inch (DPI) is also called pixels-per-inch. This measurement indicates the number of
physical pixels that fit in one logical inch on a display. High-resolution screens have smaller physical
pixels, so they will contain more pixels per logical inch than low-resolution screens.

• Density measures the magnitude of pixel density on a display. This measurement is usually
rounded to the nearest half or whole number. One density-independent pixel is equivalent to one
physical pixel on a device with the density 1.0 (also called medium-density or MDPI). Density-
independent pixels are scaled proportionally on higher- or lower-density screens so that one DIP on
a screen with the density 2.0 (XHDPI) encompasses four physical pixels (two across and two down).

The following table shows the measurements for a sample device:

Screen resolution
(physical pixels) Dots-per-inch Density Screen resolution (device-

independent pixels)

1080 x 1920 424 3.0 (XXHDPI) 360 x 640

Convert to DIP for Android Devices
Follow the steps below to convert a device's screen resolution from physical pixels to device-independent
pixels:

1. Verify that you know the screen resolution (in physical pixels) and the DPI measurement for the
device. This information can usually be found in the device specifications.
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2. Use the following conversion formula for Android devices:
px = DIP * (DPI / 160)
For example, using the measurements for the sample device, above:

px = 1 DIP * (424 DPI / 160)

3. Find the result.
In the example, one DIP on a 424 DPI device is equivalent to 2.65 physical pixels.

4. Round this result to the nearest half or whole number to get the density of the device.
For the sample device, the density is 3.0.

5. Divide the screen resolution measurements by the density to convert the measurements to device-
independent pixels.
For example, 1080 becomes 360 and 1920 becomes 640. The sample device's screen resolution is
360 x 640 device-independent pixels.

Convert to DIP for iOS Devices
iOS devices also utilize device-independent pixels, but you may see them referred to as points.
Remember that points and DIP both refer to device-independent pixels. For iOS devices, follow the same
procedure as above using the following conversion formula:

px = points * (DPI / 163)
Related concepts
About Adaptive Layouts
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Create an Adaptive Layout
Design Forms or Dashboards to adapt to different screen sizes by creating Adaptive Layouts in the Form
Editor or the Dashboard Editor.

1. Open the Form Editor or the Dashboard Editor.

2. In the editor toolbar, click the Create New button .
The Create Layout dialog opens.

3. Define the layout properties.

Tip: Click the Ellipses button to select an Adaptive Layout Preset for the layout. This will
populate the layout's properties with pre-defined properties.

Remember: The height and width properties must be defined in device-independent pixels.
Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels for more
information. You must define the width property at least 20 device-independent pixels larger
or smaller than any existing layout.

4. Optional: Click Save as Preset to save the layout properties as a Preset in the Adaptive Layout
Preset Manager.
Perform this step if you plan to create layouts for other Forms or Dashboards that utilize the same
properties.

5. Click Save.
The layout appears in the Editor as the currently selected layout.

Related concepts
Form Editor
Managing Controls and Widgets in Adaptive Layouts
Standard Form Sizes
Related reference
Adaptive Layout Properties
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Edit an Adaptive Layout
Change the properties of an existing Adaptive Layout.

To edit an Adaptive Layout:

1. Open the Form Editor or the Dashboard Editor.
2. Select a layout to edit from the guide bar or the layout selector.

3. Click the Edit button .
The Edit Layout dialog opens.

4. Edit the layout properties.
◦ Click the Ellipses button to select an Adaptive Layout Preset for the layout. This will populate

the layout's properties with pre-defined properties.

Remember: The height and width properties must be defined in device-independent
pixels. Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels
for more information. You must define the width property at least 20 device-
independent pixels larger or smaller than any existing layout.

◦ The Save button is activated when you edit one or more properties.
◦ You can also drag one of the handles to resize the layout.

5. Optional: (Optional): Click Save as Preset to save the layout properties as a Preset in the Adaptive
Layout Preset Manager.
Perform this step if you plan to create layouts for other Forms or Dashboards that utilize the same
properties.

6. Click Save.
The layout is displayed as the currently selected layout with the new properties.

Related concepts
Form Editor
Open the Form Editor
Related reference
Adaptive Layout Properties
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Delete an Adaptive Layout
Delete an Adaptive Layout to remove it from the Form Editor or the Dashboard Editor.

Note: If the Form or the Dashboard utilizes only one layout, that layout cannot be deleted.

1. Open the Form Editor or the Dashboard Editor.
2. Select a layout to delete from the guide bar or the layout selector.

3. Click the Delete button .
The Delete Layout dialog opens.

4. Click OK.
The selected layout is deleted and no longer appears in the Editor.

Related concepts
Form Editor
Open the Form Editor
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Adaptive Layout Preset Manager
Use the Adaptive Layout Preset Manager to create, edit, and delete Adaptive Layout Presets.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
searches run during the session.
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5. Main Pane:

Displays items by view (icon, list, or details [grid]) and lists search results when a search is run.

Related concepts
About Adaptive Layouts
Adaptive Forms Scenarios
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Open the Adaptive Layout Preset Manager
Open the Adaptive Layout Preset Manager from a Blueprint or mApp® Solution.

To open the Adaptive Layout Preset Manager:

From the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > Adaptive Layout
Presets.
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Create an Adaptive Layout Preset
Create an Adaptive Layout Preset to save a set of properties that can be re-used to define new layouts.

1. Open the Adaptive Layout Preset Manager.

2. Click the Create New icon .
The Create Preset dialog opens.

3. Define the Preset properties.

Remember: The height and width properties must be defined in device-independent pixels.
Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels for more
information.

4. Click Save.
The Preset appears in the list of configured Presets.

Related concepts
Adaptive Layout Preset Manager
Related reference
Adaptive Layout Properties
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Edit an Adaptive Layout Preset
Edit an Adaptive Layout Preset to change the Preset's saved properties.

1. Open the Adaptive Layout Preset Manager.
2. From the list of Presets, select the Preset to edit.

3. Click the Edit icon 
The Edit Preset dialog box appears.

4. Edit one or more properties.
5. Click Save.

The Preset appears with the new properties in the list of configured Presets.

Related concepts
Adaptive Layout Preset Manager
Related reference
Adaptive Layout Properties
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Delete an Adaptive Layout Preset
Delete an Adaptive Layout Preset to erase its saved properties and remove it from the Adaptive Layout
Preset Manager.

1. Open the Adaptive Layout Preset Manager.
2. From the list of Presets, select the Preset to delete.

3. Click the Delete icon .
The Delete Preset dialog box appears.

4. Click Yes.
The Preset is removed from the list of configured presets.

Related concepts
Adaptive Layout Preset Manager
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Approvals
An approval is a defined process that automates, regulates, and tracks approving/denying/abstaining
content by one or more designated users, customers, teams or workgroups.
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About Approvals
Use approvals to request approval for items within a Major Business Object and automatically perform
actions based on whether designated approvers approve, deny, or abstain.

For example, use an approval to approve:

• A Knowledge Article before it can be published.

• A service request for new hardware.

• An expense.

An approval is a Supporting Business Object that can be used in conjunction with a Major Business
Object (example: When a Knowledge Article reaches the approval phase, an Approval tab is displayed in
the form arrangement of the record). Approvals can be added to any Major Business Object and are
made up of one or more Approval Blocks.

Each Approval Block consists of:

• Trigger Condition: Condition that initiates an approval (example: Record reached a specific status).

• Approvers: One or more users, customers, teams, or workgroups that provide approval, and the
number/percentage of approvers who must approve a request.

• Actions: One or more actions that take place when an approval is approved, denied, or expired
(example: Change a record status, put a record in a queue, initiate a One-Step Action that sends an
email notification).

You can use multiple dependent Approval Blocks to define multi-level approvals using different triggers,
approvers, and actions for different situations within the same Business Object. For example, an
Emergency Change Request might require that all Emergency Change Board members approve the
change, whereas a regular server change might require only the approval of a hardware team member.

Important: If you are working with approvals after a Protected mApp™ Solution has been applied
to your system, note the following:

• If an approval was added as part of a Protected mApp Solution, then you can only edit the
approvers and email details.

• You cannot delete a content-protected approval but you can copy it.

• If you add a new approval after a Protected mApp Solution has been applied, you can edit,
copy and delete it as normal.

• See Protected mApp Solutions.

Note: There are Cherwell REST API endpoints available for approvals. See Operations List.

Approvals are also processed by the Automation Process Service.
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Related concepts
Major Business Objects
Form Arrangements
Add an Approval to a Business Object
Define Approver Properties
Approval Editor
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Approvals Good to Know
Use these tips for helpful information on approvals.

• Approvers can provide approval in the CSM Desktop Client or CSM Browser Client by accessing the
approval form in the form arrangement of a Business Object record. See Approval Form and Form
Arrangements.

• Approvals can be configured to allow customers to approve items using a portal. See Configure
Customer Approvals.

Important: This does not consume a license.

• Approvals are Supporting Business Objects that are configured in a Blueprint in CSM Administrator.
Approvals are used in conjunction with Major Business Objects.

• Create your own custom Approver Workgroups in CSM by adding users, customers, teams, and
other workgroups. See Create an Approver Workgroup.

• Use the Approval Editor in CSM Administrator to add approvals to a Major Business Object.

• Use the Approval Block Editor to create and edit Approval Blocks. An approval consists of one or
more Approval Blocks.

• The Approval Editor is opened from the Object Manager (within a Blueprint in CSM Administrator )

• The Approval Block Editor is opened from within the Approval Editor.

• You can use multiple dependent Approval Blocks to define multi-level approvals using different
triggers, approvers, and actions for different situations within the same Business Object. For
example, an Emergency Change Request might require that all Emergency Change Board
members approve the change, whereas a regular server change might require only the approval of
a hardware team member. For more information, see Define Multi-Level Approvals.

• Configure denials as well as approvals. See Approval and Denial Threshold Rules.

• Delegate some or all of your work, not just approvals, to colleagues when you are unavailable. See
About Delegation.

• Security rights control access to Business Object data and are configured in the Security Group
Manager in (Security > Edit Security Groups). For more information, see Security Features
Security Rights and Define Business Object Rights (Access to Data).

• There are Cherwell REST API endpoints available for approvals. See Operations List.

• Approvals that are part of a Protected mApp™ Solution can have their approvers and email
changed but nothing else. See Protected mApp™ Solutions.

Related concepts
About Business Objects
About Blueprints
Approval Editor
Add an Approval to a Business Object
Create/Edit an Approval Block
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Approval and Denial Threshold Rules
CSM follows a set process to determine whether an approval or a denial can be actioned. You can
configure approvals for any Major Business Object.

Prerequisite: For information on setting thresholds, see Define Approver Properties.

Important information

• Primary Settings is the main setting for the threshold for that Approval Block and it applies to all the
approvers in that block, regardless of whether they are individual users or teams/workgroups.

• The Primary Settings entry is present by default when you create an Approval Block and it cannot
be deleted.

• Threshold settings for approvals and denials are not available when you select a single approver in
the list, but they are available for teams and workgroups.

• No workgroup, team, user, or manual approval takes precedence over another.

• Teams and workgroups are treated identically within the approval process when processing votes.

• Approvals and denials work on the basis that the approval/denial that fulfils the rules first completes
the request. The system doesn't wait for everyone to respond to an approval request.

• If Count Block and Manual is selected, the timing of manual approvals may change the predicted
behavior of your Approval Blocks. For more information, see Configure Customer Approvals.

• The teams/users/workgroups in the list of approvers all contribute towards fulfillment of the Primary
Settings threshold. Think of each entry in the list as an entity or separate vote towards fulfillment of
the Primary Settings threshold, so a team represents one vote and a user represents one vote. Look
at the examples below to understand how this works.

• It isn't possible to select All Approvers and Enable Denials at the same time.

Examples
Table 1. Approvals (Count Block and Manual selected)

Scenario
Description

Approver list
contents Example Action Outcome

Primary Settings
with all
approvers

Primary Settings
Jane

John

Primary Settings set to
All Approvers to
approve.

Jane and John approve
the request.

Request completed because
all approvers have approved.
Each user counted as an
entity with respect to the
Primary Settings; users have
no individual thresholds.

Primary Settings
with a
percentage.

Primary Settings
Jane

John

Primary Settings set to
Approvers 50%

Either Jane OR John
approve the request.

Request completed - 50% of
approvers have approved. 1
of the 2 entities in the list of
approvers has approved.
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Scenario
Description

Approver list
contents Example Action Outcome

Team with a
percentage.

Primary Settings
Team A with 6
members

Primary Settings set to
All Approvers
Team set to Approvers
50%

Three team members
approve.

3 team members in total need
to approve to fulfill the team
50% setting. For Primary
Settings, the team is the only
entity in the list so All
Approvers fulfilled.

Workgroup with a
percentage and
a user.

Primary Settings
Amanda

Workgroup B with
6 members

Primary Settings set to
All Approvers.
Workgroup set to
Approvers 50%.

Amanda approves plus 3
other workgroup
members.

When Amanda approves, it
fulfills half of the Primary
Settings as she represents 1
of the 2 entities in the list of
approvers in the Approval
block.
3 workgroup members in total
need to approve to fulfill the
team 50% setting and also
complete the conditions to
fulfill the Primary Setting.

Workgroup with a
specific number
and a user.

Primary Settings
Claire

Workgroup B with
6 members

Primary Settings set to
Specific number 4.
Workgroup set to All
Approvers.

Whatever happens, this
request can never be
fulfilled.

You cannot have a specific
number of 4 when there are
only 2 entities in the list of
approvers. The specific
number cannot exceed the
number of approval entities in
the list.

Workgroup with a
specific number
and a user.

Primary Settings
Claire

Workgroup B with
6 members

Primary Settings set to
Specific number 1.
Workgroup set to All
Approvers.

Claire approves.
3 members of the
workgroup approve.

If Claire approves first, she
negates the need for anyone
else to approve and the
request is complete.
If all 6 workgroup members
approve first then that
negates the need for Claire to
approve.
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Scenario
Description

Approver list
contents Example Action Outcome

Two teams

Primary Settings
Luke

Team 1 with 2
members

Team 2 with 6
members

Primary Settings set to
All Approvers.
Team 1 set to All
Approvers.

Team 2 set to
Approvers 50%.

Luke approves.
All team members from
team 1 approve.

3 team members from
team 2 approve.

All 3 entities need to respond
to fulfill the All Approvers
setting for Primary Settings.

When Luke approves, it fulfills
a third of the Primary Settings
as he represents a third of the
list of approvers in the
Approval block.

All team members from team
1 approve; this fulfills the team
1 setting and another third of
the Primary Setting.

3 team members from team 2
in total need to approve to
fulfill the team 50% setting
and also complete the
conditions to fulfill the final
third need for the Primary
Settings.

Table 2. Approvals and Denials (Count Block and Manual selected)

Scenario
Description

Approver list
contents Example Action Outcome

Primary settings
with a percentage. Primary Settings

Primary Settings set to
Approvers 50%, Denials
50%

This request can never be
fulfilled unless there are
manual approvals.

This is because there are no
approvers or voting entities in
the list.

If Count Block and Manual is
selected, you have no
approvers in the list and don't
use manual approvals, this
scenario can never work.
However it is valid if you have a
system where all approvals are
going to be manual.

Users and
percentages.

Primary Settings
Tim

Lisa

Primary Settings set to
Approvers 50%
Primary Settings set to
Denials 50%

Either Tim or Lisa needs to
approve or deny in order to
complete the request.

Request fulfilled because 1 user
is 50% of the list of approval
entities.

Users with specific
numbers.

Primary Settings
5 individual users

Primary Settings set to
Approvers Specific
Number of 2, Denials
Specific Number of 2

2 users deny the approval
request.

Denial request completed
because Primary Settings are
fulfilled.

Team with
percentages.

Primary Settings
Team with 10
members

Primary Settings set to
Approvers Specific
Number of 1, Denials
Specific Number of 1
Team set to Approvers
20% & Denials 30%

3 team members deny the
approval request.

A third of denials is achieved (3
of 10 team members) and 3 is
greater that the 1 entity needed
to fulfill the Primary Settings.
Request complete.
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Scenario
Description

Approver list
contents Example Action Outcome

Primary settings
with denials
disabled

Primary Settings
Team A with 6
members

Primary Settings set to
Approvers 50% Denials
NOT enabled.
Team set to Approvers
50% & Denials 50%

3 team members deny the
approval request.

At least 3 members of the team
needs to approve/deny to fulfill
the Primary Setting AND
3 team members in total need
to approve or deny to fulfill the
team 50% setting.

Two teams

Primary Settings

Team A with 4
members

Team B with 3
members

Primary Settings set to
Approvers Specific
Number of 2, Denials
Specific Number of 1
Both Teams set to
Approvers Specific
Number of 2, Denials
Specific Number of 3

3 members of team B deny
the approval request.

The Team B denials threshold
has been met so the request is
completed. The Primary
Settings of 2 to approve can
also no longer be met anyway.

Workgroup, users
and specific
numbers.

Primary Settings

Approver
Workgroup with 5
members

Josie

Jack

Primary Settings set to
Approvers Specific
Number of 1, Denials
Specific Number of 1
Workgroup set to
Approvers Specific
Number of 3, Denials
Specific Number of 3

3 members of the workgroup
deny the approval request.

Both workgroup and Primary
Settings thresholds are met at
the same time and the request
is completed..

Workgroup, users
and specific
numbers.

Primary Settings

Approver
Workgroup with 5
members

Josie

Jack

Primary Settings set to
Approvers Specific
Number of 2, Denials
Specific Number of 2
Workgroup set to
Approvers Specific
Number of 3, Denials
Specific Number of 3

3 members of the workgroup
deny the approval request.

In this case, Josie or Jack
needs to deny an approval as
well in order to meet the
Primary Settings threshold of 2.

Workgroup, users
and different
percentages.

Primary Settings

Approver
Workgroup of 10

Mitch

Anna

Primary Settings set to
Approvers 30%, Denials
30%
Workgroup set to
Approvers 50%, Denials
50%

5 members of the workgroup
deny the approval request.

There are 3 voting entities in the
list for Primary Settings and the
workgroup alone represents
30% so 5 workgroup denials
fulfills both thresholds at the
same time.

Workgroup, users
and identical
percentages.

Primary Settings

Approver
Workgroup of 10

Katherine

Andy

Primary Settings set to
Approvers 50%, Denials
50%
Workgroup set to
Approvers 50%, Denials
50%

3 members of the workgroup
deny the approval request,
along with Katherine.

There are 3 voting entities in the
list for Primary Settings and the
workgroup plus Katherine
represents approximately 60%
so this fulfills the Primary
Settings. 5 of 10 workgroup
approvals fufills the Workgroup
setting.
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Scenario
Description

Approver list
contents Example Action Outcome

Combination of
Approval Block and
Manual Approvals.

Primary Settings

5 individual users

Primary Settings set to
Approvers Specific
Number of 2, Denials set
to a Specific Number of 3

3 denials are manually carried
out in a CSM Client using the
Form Arrangement tab.

3 manually created denials
completes the request because
Primary Settings requires 3 from
the approval block OR from
manual approvals.

Table 3. Approvals and Denials (Count Block only selected)

Scenario
Description

Approver list
contents Example Action Outcome

Primary settings
with a
percentage.

Primary Settings
Primary Settings set to
Approvers 50%,
Denials 50%

Whatever happens, this
request can never be
fulfilled.

This is because there
are no approvers or
voting entities in the list.

With Count Block only
selected and no
approvers in the list, this
scenario can never
work. Equally, if Count
Block and Manual is
selected and you have
no approvers in the list
and don't use manual
approvals. it can never
work.

Primary settings
with users.

Primary Settings
10 individual
users

Primary Settings:
Approvers 20%,
Denials 30%

3 approvals are manually
carried out in a CSM
Client using the Form
Arrangement tab.

Nothing happens as only
approvals coming from
the Approval block are
being counted.

Note: Ordering Approval Blocks within the Approval Block Editor changes the order in which
approvals are triggered but changing the order of approvers within an Approval Block has no
effect.

Related concepts
Define Approval Block Action Properties
Define Approval Block Condition Properties
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Using Approvals
When working with Approvals, users use the approval form in one of the CSM clients to approve or deny
an approval request.

CSM typically supplies the OOTB Approvals. Use these supplied Approvals as-is, edit them, or create
your own using the Approval Editor (accessed from within a Blueprint in CSM Administrator).

Related concepts
Approval Form
Add an Approval to a Business Object
Approval Editor
About Blueprints
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Approval Form
Approvals require approvers to decide how to respond to a request.

In the CSM Desktop Client or Browser Client, approvals are responded to using an approval form in the
form arrangement of a record.

OOTB approval forms may be provided with your system. They typically can be opened several ways in
the CSM Desktop Client or Browser Client:

• From an approval email, select the link to the approval form.

• In the Approvals tab of a Major Business Object's form arrangement, open the approvals form:
◦ Double-click an existing Approval in the grid.

◦ On the Form Arrangement toolbar, select View > Form View.

◦ On the Form Arrangement toolbar, select New Approval to open a new approval form.

1. Approver: Name of the required approval user(s) or customer(s).

2. Approval Team: Name of the required approval team(s) or workgroup(s).

3. Due Date: Date/time by which the approval must be submitted. If approvers do not respond by the
deadline, they are considered to have abstained.

4. Details: Additional information about the approval (example: Approve Emergency Change Request
to begin implementing).

5. Approver Notes: Additional information/explanation regarding the approval.

6. Response:
◦ Approve: Approve the request.

◦ Deny: Deny the request.

◦ Abstain: Refrain from approving/denying the request.
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Managing Approvals
Approvals are managed using the Approval Editor and the Approval Block Editor.

Use the Approval Editor to:

• Add an approval to a Business Object.

• Open the Approval Block Editor.

• Copy an Approval Block.

• Delete an Approval Block.

• Define approval email settings.

Use the Approval Block Editor to:

• Create/edit an Approval Block.

Use the Delete Approvals task in the Structure area of the Object Manager to delete all approvals from a
Business Object. For more information, see Object Manager.

Related concepts
Approval Editor
Add an Approval to a Business Object
Open the Approval Block Editor
Define an Approval Email
Create/Edit an Approval Block
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Approval Editor
The Approval Editor is a tool within a Blueprint in CSM Administrator that allows you to manage (create,
edit, and delete) Approvals.

Use the Approval Editor to perform the following Approval operations:

• View: View a list of defined Approvals.

• Add: Use to access the Approval Block Editor, and then create an Approval Block. Approval Blocks
are listed in the Approvals section of the Approval Editor. For more information, see Create/Edit an
Approval Block.

• Edit/Delete: Use to configure Approval Blocks to meet your requirements.

• Copy: Use an existing Approval Block as a starting point or "template" for a similar Approval.

• Organize: Use the up/down arrows to change the order of selected Approval Blocks.

• Enable Email Notifications: Use to define Approval Email Settings.

• Define Advanced Options: Use to define an Approval configuration for a Business Object.

There are several ways to open the Approval Editor and Approval Block Editor:

• In the CSM Administrator main window, select the Blueprints category, and then select the Create
a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects. For more information, see Blueprint Editor and Object Manager.

• In the Object Manager, select a Major Business Object in the Object tree, and then select the Add
Approval Support task in the Structure area.

Related concepts
About Blueprints
Define an Approval Email
Define Approval Configuration for a Business Object
Open an Existing Blueprint
Related tasks
Create a Blueprint
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Approval Block Editor
The Approval Block Editor is a tool accessed from within the Approval Editor (in a Blueprint in CSM
Administrator) that allows you to create and edit Approval Blocks.

An Approval Block is a defined set of trigger conditions, approvers, and actions for an approval. An
approval for a Business Object contains one or more Approval Blocks.

You can use multiple dependent Approval Blocks to define multi-level approvals using different triggers,
approvers, and actions for different situations within the same Business Object. For example, an
Emergency Change Request might require that all Emergency Change Board members approve the
change, whereas a regular server change might require only the approval of a hardware team member.
For more information, see Define Multi-Level Approvals.

Use the Approval Block Editor to define the components of an Approval Block. For more information, see
Define Approval Block Condition Properties and Define Approval Block Action Properties.
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Each Approval Block contains the following components:

1. Name: Display name to use within CSM.

2. Trigger Condition: Event that initiates the Approval Block.

3. Approver(s): User(s), customer(s), team(s), or workgroup(s) that provides approval/denial and the
number/percentage of approvers who must approve or deny a request.

4. Action(s): Operation that takes place when an approval is approved, denied, or expired.

Related concepts
Approval Editor
Blueprints
Create/Edit an Approval Block
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Object Manager
Define Approver Properties
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Open the Approval Block Editor
The Approval Block Editor is a tool accessed from within the Approval Editor that allows you to create and
edit Approval Blocks.

There are several ways to open the Approval Block Editor:

• In the CSM Administrator, select the Blueprints category, and then select Create a New Blueprint.

Note: If you are working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

• In the Object Manager, select a Major Business Object in the Object tree, and then select Add
Approval Support in the Structure area.

• In the Approval Editor, select the Approvals page, and then select Add.

Related concepts
Open an Existing Blueprint
Blueprint Editor
Object Manager
Related tasks
Create a Blueprint
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Add an Approval to a Business Object
Use the Object Manager and Approval Editor to add approvals to a Major Business Object.

When you add Approvals, you define:

• A relationship between the Major Business Object and the Approval Business Object
(Supporting Object): Allows data to be shared between the Major Business Object and Approval
Business Object (typically, an approval is displayed as a tab in the form arrangement of a Major
Business Object).

• An Approval Block ID field: Holds the ID of the Approval Block that should be used.

• An Approval configuration: Associates an Approval Relationship and Approval Block ID field with
a Major Business Object, and allows you to define options that determine when approvals are
generated.

After adding approvals to a Business Object, use the Approval Editor and the Approval Block Editor to:

• Define Approval Email Settings: An optional email that is automatically sent to approver(s) when
approval is needed.

• Create an Approval Block: A set of trigger conditions, approvers, and actions for an approval.

• Define Multi-Level Approvals: You can optionally set up multiple dependent Approval Blocks that
allow you to define different triggers, approvers, and actions for different situations within the same
Business Object.

Here is an overview of how to add an approval to a Business Object:

1. Define a relationship between the Major Business Object and the Supporting Approval Business
Object (using the Relationship Editor).

2. Define an Approval Block ID field (using the Business Object Editor).

3. Define approval configuration for a Business Object (using the Approval Editor).

4. Optional: Define an approval email (using the Approval Editor).

5. Create an Approval Block (using the Approval Block Editor).

6. Optional: Define multi-level approvals (using the Approval Block Editor).

Related concepts
Define an Approval Relationship
Define an Approval Block ID Field
Define an Approval Email
Create/Edit an Approval Block
Define Multi-Level Approvals
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Define an Approval Relationship
Use the Relationship Wizard to define a relationship between a Major Business Object and the Approval
Object (Supporting Object).

A relationship is required to add an approval to a Business Object. An Approval Relationship allows the
Major Business Object and Approval Object to share data (typically, an approval is displayed as a tab in
the form arrangement of a Major Business Object). For more information, see Form Arrangements.

To define an Approval Relationship:

1. Open the Relationship Editor.

2. Select Wizard.

3. Select Approval as the Child Business Object.

4. Select the Many Approvals option to allow the Major Business Object to have multiple approvals.

5. Select whether approvals should have a relationship back to the parent object:
◦ Select Yes (Recommended) to create a reverse relationship from approvals to the parent

object.

◦ Select No to not create a reverse relationship from approvals to the parent object.

6. Select the Many [Major Business Objects] option to allow approvals to belong to multiple Major
Business Objects.

7. Select Full-Text Search options for the relationship:
a. Select whether to search approvals when the Major Business Object and its related items are

searched:
◦ Select Yes to search approvals when the Major Business Object and its related items are

searched.

◦ Select No to not search approvals when the Major Business Object and its related items
are searched.

b. Select whether to search the Major Business Object when approvals and its related items are
searched.

◦ Select Yes to search the Major Business Object when approvals and its related items are
searched.

◦ Select No to not search the Major Business Object when approvals and its related items
are searched.

8. Provide a name and description for the relationship and the reverse relationship.

9. Review the Summary page.

10. Select Finish.10.

The relationship is added to the Business Object and can be accessed in the Relationship Editor.

11. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes. For more information, see Publish a Blueprint
or Save a Blueprint.
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Related concepts
Relationship Wizard
Create a Relationship Using the Relationship Wizard
Define Approval Configuration for a Business Object
Relationship Editor
Define Link Properties for a Relationship
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Define an Approval Block ID Field
Use the Business Object Editor to define an Approval Block ID field to indicate which Approval Block to
use for a Business Object.

This field is stored in the Major Business Object that owns the approvals, and holds an internal ID that the
system associates with an Approval Block. An approval process can contain multiple Approval Blocks,
and this field contains the information the system needs in order to know which set of approvals to use
(example: A hardware change might require one set of approvers and a software change might require a
different set of approvers).

To define an Approval Block ID field:

1. Open the Business Object Editor for the Business Object to which you are adding approvals.

2. Select New Field .

3. Define general information for the Approval ID field:
◦ Name: Provide a name for the field (example: Approval Block ID).

◦ Type: In the drop-down list, select Text.
◦ Size: In the drop-down list, select 42. This is the exact length of the internal ID.

4. (Optional) Select Field Properties to open the Field Properties window, and then edit general
information and define additional properties for the field.

5. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Business Object Editor
Create/Edit a Field
Publish a Blueprint
Save a Blueprint
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Define Approval Configuration for a Business
Object

Use the Advanced page of the Approval Editor to define the Approval configuration for a Business Object.

Defining the approval configuration is typically done after defining an Approval Relationship and Approval
Block ID field, but before creating Approval Blocks. For more information, see Define an Approval
Relationship and Create/Edit an Approval Block.

When you define an approval configuration for a Business Object, you select:

• An approval relationship.

• Fields in the Major Business Object to hold the approval description and approval ID.

• Options to determine when approvals are generated.

To define the approval Configuration for a Business Object:

1. Open the Approval Editor.

2. Select the Advanced page.

3. Define the approval configuration for the Business Object:

a. Relationship holding approvals: Select the approval relationship you created from the drop-a.
down list.

b. Field holding description: Select the field in the Major Business Object that will contain theb.
description of the approval.

c. Field holding ID of selected approval: Select the Approval Block ID field you created fromc.
the drop-down list.

d. Generate approvals: Select an option for initiating the approval to be created:d.
◦ When trigger condition is true: Select this option to generate approvals based on the

trigger condition.

◦ When record is saved: Select this option to generate approvals when the Major
Business Object record is saved and the trigger condition occurs.

4. Select OK.4.

5. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Approval Editor
Open the Approval Editor
Define an Approval Block ID Field
Publish a Blueprint
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Save a Blueprint
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Define an Approval Email
Use the Approvals page of the Approval Editor to define an email that is sent to approver(s) when needed
(using a One-Step Action).

To define an approval email:

1. Open the Approval Editor.

2. Select the Approvals page.

3. Select the Notify Approver by Email check box below the Approvals list, and then select Edit.

4. From: Double-click on System State E-mail in the From field. The default expression in this field
uses a stored value called Current System Production E-mail. This stores the production email
account for your company (example: support@company.com). It is also the email address
configured as the default for the Inbound Email Monitor, so that if a reply is sent to it, it is processed
and attached to the corresponding record in CSM.

If not already done during system setup, change the stored values for Current System Production
Email and Current System DEV Email. See: Configure Test and Production Accounts.

5. To: Select To to open the address book and select email recipients. You can choose users,
customer, teams, Approver Workgroups, or their aliases. Choose a name and then select To, Cc or
Bcc. The Bcc line is only available in the CSM Desktop Client.

6. Edit the email contents:
◦ Provide text for an approval message (example: An approval request has been made.)

CSM 2022.3 Features 87

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_test_and_production_accounts


◦ Select  (or right-click in the contents area) to insert Tokens (fields, expressions, system
functions, stored values, and variables) directly into the text.

7. Define additional email properties:
◦ Attach to current <Business Object>: Select this icon to attach the email to the current

record (example: Current Incident, current Problem) as a Journal - Mail History record.
Specifically, when the approval is responded to using email, the Journal-Mail History record is
attached to the parent record.

◦ Attach to recipients: Select this icon to attach the email to the customer records associated
with recipients in the To, Cc, or Bcc lines. You can also attach the email to customer records
that they originated from (parents of recipients) to provide more context for users. For
example, if an e-mail recipient is a contact that works for a particular company, the e-mail can
be attached to the company record as well as the customer record.

For more information, see Attach E-mail Messages to Records.

8. Select OK.8.

9. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Note: You can also edit the approval email template by creating an Automation Process Blueprint.
Use the One-Step Editor to edit the Email Change Request Approval as shown below.

Related concepts
Open the Approval Editor
Fields
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Expressions
About System Functions
About Stored Values
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Create/Edit an Approval Block
Use the Approval Block Editor (accessed from within the Approval Editor) to create Approval Blocks.

An Approval Block is a defined set of trigger conditions, approvers, and actions for an approval. An
approval for a Business Object contains one or more Approval Blocks. When you create an Approval
Block, you define:

• A trigger condition that determines when the block is used.

• List of approvers.

• Voting thresholds.

• Action that takes place when the appropriate people have approved or denied the request.

To create an Approval Block:

1. Open the Approval Block Editor. For more information, see Open the Approval Block Editor.

2. Define a Name.

3. Define Approval Block properties:
a. Trigger Conditions: Specify under what conditions the approvals are required.

b. Approvers: Specify the list of approvers.

c. Actions: Specify what to do when the approval has taken place.

4. Select OK.4.

5. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes. For more information, see Publish a Blueprint
or Save a Blueprint.

Note: Use the arrows to order your approvals in the order you want them to be triggered. Ordering
approvals doesn't determine the order that approval emails are received. Also if you have auto-
populated fields set, ordering may not be respected.

Related concepts
Approval Block Editor
Approval Editor
Define Approval Block Condition Properties
Define Approver Properties
Define Approval Block Action Properties
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Define Approval Block Condition Properties
Use the Trigger Condition page in the Approval Block Editor (accessed from within the Approval Editor)
to define a condition that initiates the approval process for an approval Block.

One example is to send an approval request when the Emergency Change field is checked on the
Change Request form. When you define trigger condition properties for an Approval Block, you define:

• Trigger Condition: A comparison clause that determines when the approval process is initiated.

• Additional Behaviors: An action that occurs when a condition is no longer true (example: When a
user clears the Emergency Change field on the Change Request form).

To define Approval Block Condition properties:

1. Open the Approval Block Editor.

2. Select the Trigger Condition page.

3. Define a Trigger Condition by creating a comparison clause. See Define a Comparison Clause.

4. Behavior when condition is no longer true: Define the action that takes place when the trigger
condition is no longer true:

◦ Clear Approvals from block

Select this option to remove approvals created by this Approval Block when the trigger
condition is no longer true.

◦ Leave Approvals

Select this option to leave approvals created by this Approval Block when the trigger condition
is no longer true.

◦ Leave Approvals if condition was changed by block action

Select this option to leave the approvals in place if the defined approval action causes the
trigger condition to no longer be true. However, if the trigger condition is no longer true
because of a change outside of the approval process, then the approvals will be removed. It is
recommended to tie approvals to the lifecycle of a Business Object when creating multi-level
approvals because it prevents approvals from being deleted when it advances to the second-
level approval.

5. Select OK.5.

6. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes. For more information, see Publish a Blueprint
or Save a Blueprint.

Related concepts
Approval Editor
Define a Comparison Clause
Open the Approval Block Editor
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Define Approval Block Action Properties
Approval and Denial Threshold Rules
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Define Approver Properties
Use the Approvers page in the Approval Block Editor (accessed from within the Approval Editor) to
define the approver properties.

The following properties can be defined:

• Number or percentage of votes required for an approval, including which votes to count from which
source.

• A mixed list of users, customers, and/or teams to designate as approvers, including users within
teams and workgroups.

• Text to display in the details field of the approval.

• Number or percentage of votes required for a denial, including which votes to count from which
source.

To define approver properties:

1. Open the Approval Block Editor. For more information, see Approval Editor and Open the Approval
Block Editor.

2. Select the Approvers page.

3. Define approvers for the Approval Block:
a. Select Add.

b. In the drop-down list in the Choose Approvers dialog, select a type of approver to add to your
list of approvers:

Note:
◦ When adding users, you can use search. Enter a search term, consisting of case

insensitive partial or multiple words, and select Enter or the magnifying glass
icon. Select one or more approvers from the results and select the right-arrow.
Select X to remove a search filter and return to the complete list of potential
approvers.

◦ To search for individual team members in a workgroup or team, select Users in◦
the drop-down list and then enter your search term.

◦ When selecting approvers, they are shown as a tree that loads team and
workgroup members upon expansion. You can expand and collapse the tree by
selecting the arrow >. Using the tree, you can select users, teams, or workgroups
to add to your list of approvers.

◦ Add Users

Select this option to add a specific CSM user to the list of approvers.

Tip: Select Ctrl + A to select all users, or Ctrl + click to select a
contiguous list of users and then select the left or right arrow to move them from
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selected to deselected or vice versa. Double-click an approver to add them to the
list and close the window at the same time.

◦ Add Teams

Select this option to add a CSM team (example: 1st Level Support, IT Management) to
the list of approvers.

◦ Add Customer Workgroup

Select this option to add a CSM customer workgroup (example: Accounting, Human

Resources) to the list of approvers. Select the Contact Manager icon  to select
individual customers to add to your list of approvers.

◦ Add Approver Workgroup
Select this option to add a CSM approver workgroup (example: Executive Management,
Team Leaders) to the list of approvers.

Tip: Approver workgroups can be added to multiple Approval Blocks.

Note: When teams and customer workgroups are part of an approver workgroup,
the values set for votes required for approval is for all the users and customers
within those teams. Voting thresholds cannot be set per team. See Define
Approver Properties.

◦ Add User Based on Expression

Select this option to add a user based on a selected Business Object field, system
function, expression, stored value, or metric value that contains the ID of the user
(example: An approver based on the Expression Change Request.Owned By field will
be approved by the owner of the Change Request).

◦ Add Users Based on Relationship

Select this option to add an approval for each user associated with a selected
relationship.

The Add Approvers Based on Relationship window opens, where you can select a
relationship, limit records further based on the relationship by using an expression, and
select a Business Object field, system function, expression, stored value, or metric value
that contains the ID of the users in the relationship.

c. Select OK when you have finished selecting your approvers.
Your chosen approvers are shown as a tree that you can expand and collapse by selecting the
arrow >. To add and remove approvers in your tree, use the buttons on the right-hand side.
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Tip: Edit is only available when users have been added based on expression or
relationship.

Note: Ordering Approval Blocks within the Approval Block Editor changes the order in
which approvals are triggered but changing the order of approvers within an Approval
Block has no effect.

4. Define the number of votes required for approval:
◦ All approvers

Select this option to require the approval of all designated approvers.

◦ Percentage

Select this option to require the approval of a defined percentage of votes. Then, provide a
percentage or use the Up/Down arrows to increase/decrease the percentage.

◦ Specific number

Select this option to require the approval of a defined number of votes. Then, provide a
number or use the Up/Down arrows to increase/decrease the number.

Important: For information on Primary Settings and details of how approval and denial
thresholds work, see Approval and Denial Threshold Rules.

5. Define the number of votes required for denial:
◦ Enable Denial Threshold

This check box is only when the All approvers option is cleared. Select this option to enable
denials for an approval request.

◦ Percentage

Select this option to require the denial of a defined percentage of votes. Then, provide a
percentage or use the Up/Down arrows to increase/decrease the percentage.

◦ Specific number

Select this option to require the denial of a defined number of votes. Then, provide a number
or use the Up/Down arrows to increase/decrease the number.

Important: For information on Primary Settings and details of how approval and denial
thresholds work, see Approval and Denial Threshold Rules.
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6. Define which approvals and denials to count during the voting process. In the drop-down list, select
one of the following options:

◦ Count this block only

Select this option to only count the approval and denial votes generated as a part of this block.
This selection is recommended for multi-level approvals. Manually created approval and denial
votes are ignored.

◦ Count block and manual

Select this option to only count the approval and denial votes generated as part of this block
and those manually created by users. Approval and denial votes created by other blocks are
ignored.

7. Define default properties for approvals (if not overidden by individual approvers):
◦ Approval Text

Provide text to include in the email sent to each approver.

◦ Append [Major Business Object] Description

Select this check box to add the custom approval text to the Major Business Object's
description.

◦ Deadline

Select this check box to define a default amount of time to allow for the approvers to respond.
Then, define a number and unit of time (hours, days, or months). If the approvers don't
respond within this timeframe, they are considered to have abstained.

8. Select OK.8.

9. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Fields
About System Functions
Expressions
About Stored Values
About Metrics
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Define Approval Block Action Properties
Use the Actions page in the Approval Block Editor (accessed from within the Approval Editor) to define
actions for an Approval Block.

When you define actions, you define what is done based on the state of the approval (approved, denied,
or when time runs out).

To define approval or denial or time out actions:

1. Open the Approval Block Editor.

2. Select the Actions page.

3. Define an action to take place when an approval is approved:
◦ Set a field

Select this check box to populate a field with a defined value. Then, select a Field and provide
a specific value or select the Token Selector to select a Token for the value that will be used
for the field.

Note: Tokens for Business Object lifecycle status and stage are only shown if the
Business Object has a lifecycle associated with it. See Migrate a Business Object
Lifecycle.

◦ Put on a Queue

Select this check box to put the record in a queue. Then, select a most recently used (MRU)
Queue in the drop-down list, or select the ellipsis to open the Queue Manager, where you can
select an existing queue or create a new one.

◦ Run a One-Step

Select this check box to run a One-Step Action. Then, select a most recently used (MRU)
One-Step Action in the drop-down list, or select the ellipsis to open the One-Step Action
Manager, where you can select an existing One-Step Action or create a new one.

◦ Executing the Action completes the approval process

Select this check box to end the approval process when the defined action takes place. Do not
select this option when defining multi-level approvals.

4. Select OK.4.

5. Define an action to take place when an approval is denied, or when time runs out (for example, the
approval deadline passes with insufficient approval to indicate that a record has been approved or
denied). See above for descriptions of options.
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6. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes. For more information, see Publish a Blueprint
or Save a Blueprint.

Related concepts
Approval Editor
Open the Approval Block Editor
Create a Queue
Create/Edit a One-Step Action
Approval and Denial Threshold Rules
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Define Multi-Level Approvals
Use the Approval Block Editor (accessed from within the Approval Editor) to create multi-level approvals.

You can use multiple dependent Approval Blocks to define multi-level approvals (different triggers,
approvers, and actions for different situations within the same Business Object). For example, an
Emergency Change Request might require that all Emergency Change Board members approve the
change, whereas a regular server change might require only the approval of a hardware team member.

Multi-level approvals are also used for requests that require multiple individuals or teams to provide
approval during each stage of an approval process. For example, the Networking Team might need to
approve a Change Request before it is sent to the CAB (Change Advisory Board) for approval.

When you define multi-level approvals, you create multiple Approval Blocks that depend on each other.
Specifically, the action that occurs as a result of the first Approval Block is the trigger condition for the
second Approval Block.

To define a multi-level approval:

1. Open the Approval Block Editor.

2. Define the trigger condition for the first approval:
a. Create a condition using a comparison clause and/or a grouping clause. See Define a Group

Clause.

b. Select the Leave Approvals if condition was changed by a block action option.

This option must be selected because it prevents the first-level approvals from being deleted
when the approval advances to the second-level approval.

3. Define the approvers for the first approval.

Select either Count block and manual or Count this block only to include approvals related to the
first Approval Block.

4. Define the action for the first approval.

Clear the Executing the action completes the approval process check box so that the second
level of approvals can occur (this action serves as the trigger condition for the second level of
approvals).

5. Select OK.5.

6. Select Add on the Approvals page.

7. Define the trigger condition for the second approval:

The trigger condition of the second approval should be made true by the action of the first approval.

a. Create a condition using a comparison clause and/or a grouping clause.

You also have the option to select Advanced to define a more complex condition.
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b. Select the Leave Approvals option.

This option is recommended for the second level of approvals, so that the approval remains
connected to the Business Object after the condition is no longer true.

8. Define the approvers for the second approval.

Select Count this block only in the drop-down list so that the results from the first approval are not
counted in the results for the second approval.

9. Define the action for the second approval.

Select the Executing the action completes the approval process check box so that the second
level of approvals completes the approval process.

10. Define additional Approval Blocks as needed.

11. Select OK.11.

Related concepts
Approval Editor
Open the Approval Block Editor
Define Approver Properties
Define Approval Block Action Properties
Define Approval Block Condition Properties
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Configuring Approvals
Approvals must be configured before this feature can be used. This is also applies to delegates.

To configure approvals in CSM Administrator, configure Business Object rights for the Approval Business
Object for a security group.

Important: General View rights must be given to the Approval Business Object to allow approvals
to be displayed.

To configure users' ability to manage delegates, select Manage delegates from the Users category as
described in Users Security Rights. Then select your choice of check boxes from View, Add, Edit,
Delete.

Related concepts
Define Business Object Rights (Access to Data)
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Configure Customer Approvals
Users and customers can be configured to carry out approvals.

Prerequisites

• Important: Only customers who upgrade to CSM 10.2.0 and later and want to use new•
approvals need to follow these steps. Those who install CSM 10.2.0 and later as new
customers already have these changes in the OOTB content.

• Remove any existing validation of Approval.Approver Name field against the User Info table.

• Remove any existing autopopulation of RecID for the Approval.Approver ID field when there is a
change in the Approval table.

• Remove any existing validation of the Approval.TeamName field against Other validation types for
all user teams.

• Create an approval block that triggers when a field is updated on the Incident Business Object. See
Create/Edit an Approval Block.
Make the approval button visible on the approval tab of the Incident form arrangement. See
Configure Customers Approvals for the CSM Portal.

Related concepts
Create/Edit an Approval Block
Related tasks
Configure Customers Approvals for the CSM PortalAdd an Attribute to Capture Email Address for Block-Created
Approvals

This step can be skipped if manual customer approvals are being configured, but it does ensure that the
Email Address field is populated for block-created user and customer approvals.

As customers are supported when creating approvals from the Approval Block, as part of the mechanism
that generates the Approval records, it retrieves the Email Address of the User/Customer and populates
the Email Address field in the Approval record. In order for this to work, we need to add a new General
Attribute of ApprovalApproverEmail to the field as follows:

1. In CSM Administrator, select Create a New Blueprint.
2. Select the Approval Business Object.
3. Select Edit Business Object.
4. Select the Approver Email field.
5. Right-click and select Edit Approver Email field.
6. Select Advanced.

7. Select the drop-down arrow  to expand the General Attributes section.
8. Select an empty row and enter the attribute name of ApprovalApproverEmail.
9. Select OK.
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Add Field to Hold Approval Type Name

An approver type name field needs to be added so that the system can distinguish between user and
customer approvals.

1. In CSM Administrator, select Create a New Blueprint.
2. Select the Approval Business Object.
3. Select Edit Business Object.
4. Add a new field and enter ApproverTypeName for the name.
5. Leave the rest of the options as default and select OK.

Tip: You may also want to set the default value of the ApproverTypeName field to User.
See Define General Behaviors for Fields
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Add Radio Buttons to Approval Form

New radio buttons are needed on the approval form so that user or customer can be selected. They are
each configured to store a value for ApproverTypeName (see above).

1. In CSM Administrator, select Create a New Blueprint.
2. Select the Approval Business Object.
3. Select Edit form.
4. Double-click to open the existing Approval form.
5. Create enough space for the two new radio buttons, then drag them onto the form and rename them

to User and Customer using the Label text box in the toolbar.
6. Right-click on each radio button and select Control properties.
7. Select ApproverTypeName from the Associated Field drop-down list and then set the value to

User or Customer respectively.
8. Select Save.
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Configure Approver Type ID Field

Next you need to configure an expression to use the correct System Function dependent on the Approver
Type Name. The expression looks at the value in the ApproverTypeName field and uses the System
Function to assign the result to the ApproverTypeID field

1. In CSM Administrator, open an existing Blueprint.
2. Select the Approval Business Object.
3. Select Edit Business Object.
4. Select the ApproverTypeID field and then select Field Properties.

The Field Properties window opens.
5. Select Properties.
6. Select the Calculated Value check box and then select the ellipsis alongside.

The Expression window opens.

7. Select Add  to add a new expression and name it AssignApproverType.
8. Configure the expression as follows:

a. Select Case from the Editor drop-down list.
b. In the If condition is true section, select the Simple type of If statement, and then define its

properties:
i. Select Approval.ApproverTypeName from the far left Value drop-down list.
ii. Select Equals from the Operator drop-down list.
iii. Select User from the far right Value drop-down list.

c. In the Then assign this value section, define the Then value:
Select UserInfoBusObId() from System Functions in the Token Selector.

d. Repeat step 8 by selecting  to add another line to your expression. Replace User with
Customer and UserBusObId() with CustomerBusObId().

Your finished expression should look like this:
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9. Select Save and then OK.

Configure Validation on Approval Name

Use Validate From User/Customer on the Approver Name field.

1. Open CSM Administrator and open an existing Blueprint.
2. Select the Approval Business Object.
3. Select Edit Business Object.
4. Select the ApproverName field and then right-click to select Edit Approver Name field.
5. Select Validation/Auto-Population and then enter the following values:

a. Select Validate from User/Customer.
b. Select By User Type.
c. Select Full Name from the Attribute Name drop-down list.
d. Select Approval.Approver Type ID from the User Type ID drop-down list.

6. Select OK.
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Configure Auto-Population on ApproverID and ApproverEmail

Use the auto-population type Attribute to auto-populate the ApproverID and ApproverEmail fields.

1. In CSM Administrator, open an existing Blueprint.
2. Select the Approval Business Object.
3. Select Edit Business Object.
4. Select the ApproverEmail field and then right-click and select Edit Approver Email field.
5. Select Validation/Auto-Population and then enter the following values:

a. Select Autopopulate.
b. Select the Approver Name field for Populate when there is a change in table: Approval.
c. Select Populate with: Attribute.
d. Select Email from the Attribute drop-down list.

6. Select OK.
7. Select ApproverID field and then right-click and select Edit Approver ID field.

a. Select Autopopulate.
b. Select the Approver Name field for Populate when there is a change in table: Approval.
c. Select Populate with: Attribute.
d. Select RecID from the Attribute drop-down list.

8. Select OK.

Configure Validation for Team Name and Autopopulation for Team ID

Use the validation type All Teams and Workgroups to validate the Approval TeamName field against all
available teams and workgroups. Use the Autopopulation type of Team ID for the Team ID field.

1. In CSM Administrator, open an existing Blueprint.
2. Select the Approval Business Object.
3. Select Edit Business Object.
4. Select the Team Name field and then right-click and select Edit Team Name field.
5. Select Validation/Auto-Population and then enter the following values:

a. Select Other Validation Types.
b. Select All teams and workgroups from the Valid team/workgroup drop-down list.

6. Select OK.
7. Select the Team ID field and then right-click and select Edit Team ID field.

a. Select Autopopulate.
b. Select the Team Name field for Populate when there is a change in table: Approval.
c. Select Populate with: Team ID.

8. Select OK.

For information on configuring customer approvals in the portal, see Configure Customers Approvals for
the CSM Portal.
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Attachments
An attachment is an entity that can be imported and/or linked to for supplemental information. Examples
include a document, an image, a record, a web page, and a document repository.
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About Attachments
Attachments include any files that require a separate program to open, including documents, PDFs,
pictures, and websites. For example, you might attach a Service Improvement Plan or Service Quality
Plan to a record.

Attachments can either be imported into the CSM database (accessible from anywhere) or linked. In
CSM, record attachments also include Business Objects, such as Knowledge Articles or Incidents.

There are three primary types of attachments in CSM:

• System Attachments: Files associated with the system that can be referenced directly, used as
knowledge, and used in emails.

• Record Attachments: Attachments connected directly to a specific Business Object record (example:
Incident) that can only be accessed when working with that specific record. Unlike other
attachments, record attachments can include Business Object attachments (links to other Business
Objects without a relationship).

• Document Repositories: Customer accessible collections of documents designed to be accessed
using the CSM Portal. Users can also access document repositories using the Document Repository
Manager.

System and record attachments are created, edited, deleted, or organized using the Attachment
Manager.

Good to Know

• Attachments that are imported into CSM are searchable within the database. The search returns
results that match the text within .txt, .doc, and .xls files and returns any file type with a matching file
name.

• Attachments that are linked to CSM are not searchable and are only accessible to users who have
the defined file path on their computer.

• To open, remove, email, or view the properties of an attachment, right-click the attachment in the
Attachment Bar, and select an action from the drop-down list.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Configuring Attachments.

Related concepts
Record Attachments
Document Repositories
Attach (Import) Files to a Record
Security Rights
Related tasks
Link a File to a Record
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Use Attachments
You can add attachments to emails, as a knowledge source, records, or document repositories.

In CSM, attachments can be used with:

• Email: Add an attachment to an email sent from CSM.

• Knowledge: Add an attachment as an Attachment Knowledge Source that can be accessed
through a knowledge search. For more information, see Search Knowledge.

• Records: Add an attachment to a Business Object record.

• Attachment Manager: Add an attachment directly to the Attachment Manager.

• Document Repository: Add an attachment to a document repository within the Attachment
Manager.

When working with attachments, users can:

• View an Attachment.

• Attach a record to another record.

• Attach a file (imported). See Attach (Import) Files to a Record.

• Attach a file (linked). See Link a File to a Record.

• Attach a web page. See Attach a Web Page to a Record.

• Attach an image from the clipboard. See Attach an Image from the Clipboard to a Record.

• Create a shortcut to an attachment. See Create a Shortcut to an Attachment.

Related concepts
Add Attachments to Email
Define an Attachment Knowledge Source
Record Attachments
Document Repositories
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View an Attachment
View an attachment using the Attachment Manager or from the attachment bar.

An attachment can be viewed in the following ways:

• Use the Attachment Manager to view available attachments (based on security rights).

• From the attachment bar on a Business Object record:
◦ Select the attachment.

◦ Right-click the attachment, and then select Open.

For a Business Object attachment, right-click the attachment, and then select Go to record,
Go to record in new window, or Quick-view record.

• From a CSM email attachment bar, select the attachment.
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View Attachment Properties
You can view details of an attachment such as the date of creation, attachment type, associated
comments, and where the attachment originated from.

To view attachment properties:

1. From the CSM Desktop Client, open a record with an attachment.
2. Right-click the attachment link in the attachment bar.
3. Select Properties.

The Properties window opens.
4. Select OK or Cancel.
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Email an Attachment
Use the attachment link to email an attachment from a record.

To email an attachment from a record:

1. In the CSM Desktop Client, open a record with an attachment.
2. Right-click the attachment link in the attachment bar, and then select E-mail Attachment .
3. Provide information in the email message window.

If your system does not have default email addresses configured, contact your system administrator.
4. Select Send.

Related tasks
Send an Email from within CSM
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Record Attachments
Users can import and use attachments to supplement information in a record. For example, if a Knowledge
Article (KA) mentions a specific internal document in the solution field, the creator can attach the document to
the KA for other employees to reference. Examples of attachments are documents, images, videos, and web
pages.

Related concepts
Knowledge Articles
Knowledge-IT Forms
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Attach a Record to Another Record
Use the Attachment button to link a record to another record as an additional reference. For example,
link a Knowledge Article record to an Incident record. Business Object attachments are linked and cannot
be searched in connection with the Business Object.

To attach a record to another record:

1. In the CSM Desktop Client, open a record.

2. Select Attachment , and then select Objects.
3. Select a Business Object (example: Knowledge Article) and then select the record to link (example:

Knowledge Article 10006).
You can search records using the Search Control located below the toolbar of the Selector.

4. Select OK.
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Attach (Import) Files to a Record
When you attach files to a record, the files are imported directly into CSM. The attached files are available
anywhere in CSM and some of the file types are searchable (example: Word, Excel, Text, RTF, PDF). You
can attach documents, images, videos, and web pages.

Note: Imported documents increase the size of the CSM database and must be re-imported if a
change is made to the document.

In the CSM Browser Client and CSM Portal, you can attach one or more files to a record using multi-
select and drag functionality.

To attach file(s) to a record in the Browser Client and CSM Portal:

1. Open a record.

2. In the toolbar, select Attach > Attach files.

3. In the File Upload window, select Select Files.

4. Navigate to the file(s) and select or multi-select (CTRL+Shift) the file(s) you want to attach.

5. Select Open or drag the file(s) into the File Upload window.

6. After the file(s) have finished uploading, select Submit.
7. Select Save.

The attachment(s) must be saved to the record to be eligible for download.

To attach file(s) to a record in the CSM Desktop Client:

1. Open a record.

2. Next to the attachment bar, select Attach > Attach a file (import).

You can also select the Attachment button, and then select Attach a file (import).

3. Navigate to the file(s), select or multi-select (CTRL+Shift) the files you want to attach, and select
Open.

Related concepts
Download Files Attached to a Record
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Download Files Attached to a Record
In the CSM Browser Client and CSM Portal, you can download all files attached to a Business Object
record. Use the Attach button in the record toolbar to download all files. You can also download each file
separately.

To download all files attached to a record:

1. In the Browser Client or Portal, open a record with an attachment.

2. Select Attach > Download files in the record toolbar. The attachments must be saved to the record
to be eligible for download.

3. A zip file automatically downloads to your hard drive containing all files attached to the record.

Note: To view the files individually, extract them from the zip file.

To download an individual file attached to a record:

1. In the Browser Client or Portal, open a record with an attachment.

2. Select Attach > [specific file] > Open in the record toolbar. The attachment must be saved to the
record to be eligible for download.

3. The file automatically downloads to your hard drive.

Related concepts
Attach (Import) Files to a Record
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Link a File to a Record
Use the Attachment button to link a file directly to CSM and attach it to a record as an additional
reference. Linked documents cannot be searched using CSM, and do not increase the size of the
database. Users must have access to the network where the file is located to view the document.

To link a file to a record:

1. In the CSM Desktop Client or CSM Browser Client, open a record.
2. Select the Attachment button, and then select Attach a file or Attach a file (link).
3. Select a file, and then select Open.
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Attach a Web Page to a Record
Use the Attachment button to link a website directly to CSM and attach it to a record as an additional
reference.

To link a website to a record:

1. In the CSM Desktop Client, open a record.
2. Select the Attachment button, and then select Attach a web page.

The Browse window opens displaying the web page browser.
3. Browse to the website that you want to attach, and then select OK.
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Attach an Image from the Clipboard to a Record
Use the Attachment button to attach an image to a record as an additional reference. Attached images
from the clipboard are not imported into the Image Manager and are not searchable.

Note: This function is only available in the CSM Desktop Client, you cannot attach an image from
the clipboard to a record in the CSM Browser Client.

To attach an image from the clipboard:

1. Copy the image to the clipboard (right-click the image and select Copy).
2. In the CSM Desktop Client, open a record.
3. Select the Attachment button, and then select Attach image from clipboard.
4. Name the image, and then select OK.
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Create a Shortcut to an Attachment
Use the Attachment button to add a reference to an existing system attachment to a record.

• This process uses the Attachment Manager to select an attachment that has already been imported
into CSM.

• A quick search won't find records based on words or phrases in these attachments.

To create a shortcut to an attachment:

1. In the CSM Desktop Client, open a record with an attachment.
2. Select the Attachment button, and then select Shortcut to an Attachment.
3. Select an attachment, and then select OK.

Related concepts
About Quick Search
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Remove an Attachment
Remove an attachment from a record if it no longer applies or if you want to update an attachment.

To remove an attachment from a record:

1. In the CSM Desktop Client, open a record with an attachment.
2. Right-click the attachment link in the attachment bar.
3. Select Remove Attachment.
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Manage Attachments
System attachments are managed using the Attachment Manager.

Use the Attachment Manager to:

• Create an attachment.

• Edit an attachment.

• Delete an attachment.

• Search for an attachment.

• Organize attachments.

• Copy an attachment.

• Import/export an attachment.

• Find attachment dependencies.

• Pin an attachment.

Related concepts
About Attachments
Open the Attachment Manager
Item Managers
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Open the Attachment Manager
Open the Attachment Manager to add new attachments or edit or delete existing attachments. There are
several ways to open the Attachment Manager.

To open the Attachment Manager:

• From the CSM Desktop Client menu bar, select Tools > Attachments.

• From the CSM Desktop Client toolbar, select the Attachments button.

• From an email, select the Attachments button, and then select Attachment Manager.
• From the Blueprint Editor menu bar, select Managers > Attachment Manager.
• From the mApp Editor menu bar, select Managers > Attachment Manager.

Related concepts
CSM Desktop Client Menu Bar
CSM Desktop Client Toolbar
About CSM Email Accounts
Blueprint Editor Menu Bar
mApp Editor Menu Bar
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Create a System Attachment
Use the Attachment window (accessed from within the Attachment Manager) to create (import or link) a
system attachment.

To create a system attachment:

1. Open the Attachment Manager.
2. (Optional) Select a scope and subfolder.
3. Select Create New, and then define general properties:

◦ Name and description: Provide a display name and description to use within CSM (search
these properties in CSM Item Managers).

4. Select the attachment type:
◦ Imported: Import a document into CSM.

Select Import to choose a file.

◦ Linked to: Link to a document in a program outside of CSM.

Fill in the file path or select Browse to find the file.

Select View to open the selected attachment to ensure that you selected the correct one.
5. Select OK.

Related concepts
Open the Attachment Manager

CSM 2022.3 Features 125

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fattachments%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fattachments%2Fopen_the_attachment_manager.html


Import Attachments from a Directory
Use the Import Attachment from Directory window (accessed from within the Attachment Manager) to
simultaneously import multiple attachments by importing an entire directory of files into CSM.

To import attachments from a directory:

1. Open the Attachment Manager.
2. (Optional) Select a scope and subfolder.

Attachments will be imported into this folder.
3. From the Attachment menu bar, select Attachments>Import Directory.
4. Select Browse, and navigate to the directory to import.

Tip: Use a Universal Naming Convention (UNC) path because the directory must be
accessible from the server. The format is: \
\<servername>\<sharename>\<directory>.

5. Include subdirectories: Select this check box to include all of the sub-folders associated with the
selected folder.

6. Replace existing Attachments: Select this check box to replace all of the current attachments in
the folder with the imported attachments.

7. Select OK.

Related concepts
Open the Attachment Manager
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Configure Attachments
Configure attachments to define settings and rights. Configuration procedures are completed in CSM
Administrator.

To configure attachments:

1. Configure global file attachments settings: Define global attachment settings/rights (example:
Maximum allowable attachment size and allowable file types) for CSM.

2. Define file attachment rights for a specific security group: Define attachments settings/rights on a
per security group basis (these override the global attachment settings on a per security group
basis).

3. Define file attachment rights for a specific Business Object: Define view, add, edit, and delete
attachment rights on a per Business Object basis.

4. Configure attachment security rights: Define view, add, edit, and delete rights by scope (Blueprint,
global, role, site, team, and user). Attachment rights are grouped with application security rights.

Related concepts
Configure Global File Attachment Settings
Define File Attachment Rights for a Security Group
Define Business Object Rights (Access to Data)
Application Security Rights
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Business Hours
Business Hours are defined hours of operation for a service desk (example: Monday-Friday from 8:00 AM to
5:00 PM). In CSM, Business Hours are used to drive Automation Processes and confine Target Times.
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Business Hours
In CSM, Business Hours are used to drive Automation Processes and confine Target Times. Users can
define numerous Business Hours based on the needs of their company. For example, you might want a
regular Business Hours calendar and a separate maintenance Business Hours calendar.

CSM provides several OOTB Business Hours, designed to reflect common Business Hour time frames.
Use these OOTB Business Hours as-is, edit them, or create your own using the Business Hours Manager.
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Business Hours Good to Know
Use these tips for helpful information on Business Hours.

• There are several ways to view Business Hours in CSM.

• Pin items to a Pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM. For more information, see Pin a CSM Item and CSM Desktop
Client Menu Bar.

• When you create new Business Hours, you must update the Created During What Business Hours
Expression to reflect the new hours. If Business Hours overlap, move the preferred hours above the
other hours in the list.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights or Configure Business Hours Security Rights.
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Managing Business Hours
Business Hours are managed in CSM using the Business Hours Manager.

Use this tool to:

• View Business Hours.

• Create Business Hours.

• Edit Business Hours.

• Delete Business Hours.

• Search for Business Hours.

• Organize Business Hours.

• Copy Business Hours.

• Import/export Business Hours.

• Find Business Hour dependencies.

• Pin Business Hours.
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There are several ways to open the Business Hours Manager.

For more information about working in CSM Item Managers, refer to the Item Managers documentation.
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Open the Business Hours Manager
Open the Business Hours Manager from CSM Administrator, the CSM Desktop Client, or the CSM
Browser Client.

To open the Business Hours Manager:

• In the CSM Administrator main window, select Automation Processes > Business Hours.

• In the Visual Workflow Process Designer (when creating a Visual Workflow Process) select the
Work Hours page. For more information, see Automation Process Visual Workflow Process
Designer and Define Automation Process Visual Workflow Properties.

• In the Work Hours Field of the Target Times form, select Legal Values. For more information, see
Target Times Form.

• In the Blueprint or mApp Editor menu bar in CSM Administrator, select Managers > Business
Hours.
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View Business Hours
To view Business Hours:

1. Business Hours can be viewed several ways:
◦ Available Business Hours (based on security rights): Use the Business Hours Manager.

◦ From the Visual Workflow Process Designer when creating a Visual Workflow Process, click
the Business Hours page.

◦ From the SLA Target Times form, select the ellipsis button.
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Create Business Hours
Use the Business Hours window (accessed from within the Business Hours Manager) to create
Business Hours. Business Hours are the times that your service desk is operational. When you create
Business Hours, you define:

• General properties: Name and description.

• Time zone: Time zone to use for the date and time definitions.

• Default Hours:
◦ Days: Weekdays and weekends.

◦ Hours: Ranges for each day (from-to).

• (Optional) Exceptions: Month/day/hours that are exceptions (example: For a holiday).

Note: If a Business Hours Manager was installed as part of a Protected mApp™ Solution, you can
edit all fields except for Name and Description and then save the item. If a new version of the
same content-protected mApp Solution is installed at a later date, your changes are retained.

To create Business Hours:

1. Open the Business Hours Manager.

2. Select a scope and subfolder (if needed).

3. Select Create New .

The Business Hours Properties window opens.

4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. Time zone:

Select a time zone to use for the date and time definitions.

Note: You have the option to select Server Time Zone to set the time based on the server
that is using the Business Hours (Cherwell Application Server, Automation Process Service,
Scheduling Service, etc.). The Time Zone feature should only be used with a three-tier
connection. A two-tier connection causes undesired results.
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5. Define Default Hours:
a. Days: Select the days for which the Business Hours apply.

◦ Weekdays (Monday-Friday)

◦ Weekend (Saturday, Sunday)

b. Hours: Select the hours for which the Business Hours apply.

Note: You can divide the daily hours into multiple sections (example: To include a lunch break,
you can define the hours as 8:00AM-12:00PM and 1:00PM-5:00PM).

c. Show all days: View and define each day of the week separately.

d. Closed: Define range of days in which the business is closed.

6. (Optional) Define Exceptions:
a. Select the day/month/year to define.

b. Select an Action:
◦ No exception: The business is open during the default Business Hours.

◦ Closed: The business is closed for the entire day (example: Holiday).

◦ Custom: The business is open for a specific period of time that differs from the default
Business Hours.

7. Select Save or Save As.
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Configuring Business Hours
To configure Business Hours in CSM Administrator, configure Business Hours security rights.
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Business Objects
A Business Object is a definition-powered business entity that stores data to help organizations manage
their various workflows and business processes. For example, the Incident Business Object embodies
everything about an Incident (example: Who initiated it, how it is categorized, to whom it is assigned, etc.).
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About Business Objects
Use Business Objects to manage data and workflows for business processes (example: Incident
Management). A Business Object can be complex (example: Incident) or simple (example:
IncidentCategory that holds the list of categories that can be used within an Incident).

Business Objects are the heart of CSM and are extremely versatile. You can define various options to
determine what data they contain, how they behave, and how they can be used. For example, you can
define a lifecycle, define what information is tracked, and/or require values to be entered into certain fields
(example: Priority) before records can be saved. Business Object records are represented as Forms and
Grids in CSM.

Business Objects are categorized as:

• Major

A Major Business Object is a standalone Business Object that represents a major component of a
business. It can exist by itself and have child objects that are part of its composition (using
Relationships) (examples: Incident, Problem, Change, Knowledge Article, Customer, Configuration
Item, and Service).

• Supporting

A Supporting Business Object is a Business Object that exists solely to complement, or support, a
Major Business Object. Examples include Task, Journal, and Approval.

• Lookup

A Lookup Business Object is a Business Object that supplies valid values to other Business
Objects. More precisely, it stores values for Fields that require constrained selections (example: The
Incident Cause Lookup Object holds values such as Hardware Malfunction, Outage, Permissions,
etc.).

• Group

A Group Business Object is a set of Business Objects that share common Fields. For example, the
Configuration Item Group has Group Members named Computer, Printer, and Telephony
Equipment. A Group Leader (example: Configuration Item) is the Business Object that is the root of
a Group. It stores common Fields that all Group Members share. All Group Members are descended
from the Group Leader.

All Business Objects belong to one or more Business Object Views, which allow you to have multiple
instances of a Business Object with different behaviors and appearance for different Users (example: A
Default View for Business Objects accessed from the CSM Desktop Client and a Portal View for Business
Objects accessed from the Portal). Although the rules, behavior, and appearance can differ among Views,
the structure of the Business Object is always the same.

Within the Object Manager are several Business Object-specific tools, including:

• Business Object Editor: Edit various aspects of a Business Object (properties and Fields).
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• Relationship Editor: Add, edit, and delete Relationships for a Business Object.

• Form Editor: Edit the various aspects of a Business Object Form.

• Grid Editor: Edit the various aspects of a Business Object Grid.

Note: Business Objects and their associated Fields, Relationships, Forms, Grids, Form
Arrangements, and Activity Panes are created, edited, and deleted within a Blueprint. To
commit changes to your system, you must publish the Blueprint.

Related concepts
Major Business Objects
Supporting Business Objects
Lookup Business Objects
Group Business Objects
Business Object Views
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Major Business Objects
Major Business Objects are standalone objects representing a major component of your business.

Major Business Objects are the only Objects that can have the following properties:

• Have records created from the New menu on the CSM Desktop Client toolbar.

• Be assigned keyboard shortcuts for creating new records and running Quick Searches.

• Have Form Arrangements with tabs and splitters.

• Participate in record locking.

Related concepts
Supporting Business Objects
Lookup Business Objects
Group Business Objects
Business Object Views
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Supporting Business Objects
Supporting Objects can be displayed on a Major Object's Form Arrangement or as an embedded Form
(example: Specifics Form within an Incident).

In order for Supporting Objects to appear as tabs or embedded Forms, they must have a Relationship
with the Major Object they support (typically, the Major Object owns the Supporting Object).

1. Parent record.

2. Form Arrangement.

Note: You can also display a Major Object as a tab on a Form Arrangement (example:
Problem might "support" Incident) or in a drop-down (such as Service) if you configure a
Relationship (example: Incident Links Problem). When you use a Major Object as a tab, it is
read-only. For example, a Problem tab appears on the Incident record to quickly reference
associated Problems, but the Problem records cannot be edited from the tab. To edit the
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Problem, click the GoTo button  to navigate to the Problem record, or the Quick View

button  to open the record in a second window for a quick look at the details.

3. Embedded Form.

Related concepts
Major Business Objects
Lookup Business Objects
Group Business Objects
Business Object Views
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Lookup Business Objects
Lookup Objects are used to validate or auto-populate fields in other Business Objects.

Example: The Incident Category Lookup Object holds all of the valid categories for an Incident. You can
then use the Lookup Object to validate the Category Field in the Incident Object. When logging an
Incident in the CSM Desktop Client, users can press F3 to view all the valid values for the Category Field
(valid values are based on the selected service). If validation is enforced, users receive an error if they try
to provide a value that is not included in the Incident Category Lookup Object.

Lookup Objects are typically edited using Table Management either in the CSM Desktop Client or from the
Settings category in CSM Administrator (Settings > Table Management). You can also manage Lookup
Object data as part of a Blueprint or mApp® Solution using the Edit Data operation, in which case
changes are not committed to your system until the Blueprint is published.

See the Creating a Lookup Table free Video Learning Library course.

Related concepts
Define Validation/Auto-Population Properties for a Field
About Table Management
Manage Business Object Data
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Group Business Objects
Use Group Business Objects to create a set of common items that can be used by other Business
Objects. Each Group Object has a Group Leader Object and a set of Group Member Objects that inherit
certain properties from the Group Leader.

Group Members can inherit:

• Fields

• Relationships

• Actions

• Default Grid

In most cases, inheritance from the Group Leader Object only occurs when Group Members are created.
After that, you can customize Group Members to create Fields, Relationships, and Actions that are unique
to that Business Object. You can also customize the Grid for the Group Member.

For example, Configuration Items all have Fields in common, such as Manufacturer and Serial Number.
However, a Config-Mobile Device Object might have a SIM Card field, while a Config-Printer Object might
have a Printer Drive Space field.

Group Objects can also be used to organize similar types of Business Objects. For example, Users can
search for a specific Group Member (example: Computer) or for any member of the group (example:
Configuration Item), in which case the results will include matching records from any Group Member
(example: Computer, Printer, etc.).

Any type of object (Major, Supporting, or Lookup) can be a Group Leader or Group Member. You define
Group properties when you create a Business Object.

You can also convert an existing Major or Supporting object into a Group Object.

Related concepts
Convert to a Group Business Object
Define Group Properties for a Business Object
Define Group Properties for a Field
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Business Object Views
A Business Object view is an entity that contains an instance of a Business Object so that data can be
exposed from the same Business Object in different ways, allowing the representation to be more secure
and more personal.

For example, use a Portal View to create an instance of a Business Object for customers accessing the
data from the Portal. Then, create a simpler Portal form and/or Portal grid specifically for customers.

Business Objects in a view can have their own behavior (properties, rules, actions, approvals) and
appearance (forms, grids, and form arrangements). CSM provides OOTB Business Object views for the
CSM Desktop Client (Default) and the Portal (Portal Default). You can use these views as-is, edit them, or
create a new view. To help manage (create, edit, delete, etc.) Business Object views, CSM provides the
View Manager, accessed from within a Blueprint in CSM Administrator.
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Open the View Manager
Use the View Manager to add a View to a Blueprint and to complete general CSM Item Manager
operations for Business Object Views.

To open the View Manager:

1. In the CSM Administrator main window, select Blueprints > Create a New Blueprint.
2. Select the ellipsis next to the Current View drop-down list.

Good to know:

• Copying a View does not copy the Business Objects and related definitions contained in the View.

• Adding a View to a Blueprint does not add Business Objects and related definitions to the Blueprint.
However, deleting a View in a Blueprint deletes the Business Objects and related definitions
contained in the View when the Blueprint is published.

• System is the only available scope. Create subfolders underneath this scope to organize items.•
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Create/Edit a Business Object View
Use the View Manager to create and edit a Business Object View, and to add Business Objects to a View.

Creating a Business Object View
To create a Business Object View:

1. Open the View Manager.

2. Click the Create New button.

3. Define properties for the Business Object View.

Property Description

Name Provide a display name to use within CSM
(search this property in CSM Item Managers).

Description Provide a description to use within CSM (search
this property in CSM Item Managers).

Device

Select a CSM Client where the Business Objects
in the View are exposed:

◦ Smart Client: Makes the Business Objects
in the View available in the Desktop Client.

◦ Browser: Makes the Business Objects in the
View available in the Browser Client.

◦ For Portal: Makes the Business
Objects in the View available for the
Portal.
Note: If a custom Browser View is not
available for a User, the system
defaults to displaying the most
appropriate Desktop Client View.
Typically, creating a custom Browser
View for technicians is not necessary
unless Browser Users need specific
behavioral or look-and-feel
differences. However, creating custom
Views for Portal Users is common
because the behavior and look is
usually completely different.

4. Select OK.4.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Adding Business Objects to the View
To add Business Objects to a View:
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1. Select the View from the View Manager.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Add to View
task in the Structure area.

3. Select the Create Business Object with empty Forms and Grids option to create an instance of
the Business Object with empty Forms and Grids. This allows you to create new Forms and Grids
for the Business Object instance.

4. Select the Copy Forms and Grids from an existing View option to copy the Forms and Grids from
another Business Object View. Then, in the View drop-down, select an existing View. You can then
modify the copied Forms and Grids as necessary.

5. Select the Only copy default Forms and Grid check box to copy only the default Forms and Grids
from the selected Business Object View. Any secondary Forms or Grids created in View are not
copied. If any secondary Forms are referenced in sub-Forms or on tabs in a Form Arrangement,
then the versions from the Default View are used instead.

6. Select OK.6.

7. Define/edit Business Object properties for the view, such as Relationships or external data
connections.

8. Add additional Business Objects to the View as needed.

Edit a Business Object View
To edit a Business Object View:

1. Open a Business Object View in the View Manager

2. Edit the View properties, and then click OK.

3. Click OK in the View Manager.

4. Make changes (add/edit/delete) to Business Objects within the View.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Related concepts
Open the View Manager
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Business Objects Good to Know
Use these tips for helpful information on Business Objects.

• Every Business Object must have at least one form and one grid defined, even if the object is not
exposed in the interface (example: Lookup Objects are often not exposed in the primary interface,
but they are edited in Table Management, which uses forms). For more information, see About Table
Management.

• Usually, only Major Objects have Form Arrangements.

• Not all Business Objects can or do have Relationships. For more information, refer to the
Relationships Documentation.

• All Business Objects belong to one or more Business Object Views, which allow for multiple
instances of a Business Object with different behaviors and appearance for different users
(example: a Default View for Business Objects accessed from the CSM Desktop Client and a
simpler Portal View for Business Objects accessed from the Portal). Although the rules, behavior,
and appearance can differ between views, the structure of the Business Object is always the same.
For more information, see Business Object Views.

• CSM provides several OOTB Business Objects. Use these Business Objects as-is, edit them, or
create your own using the Object Manager (accessed from within a Blueprint in CSM Administrator).
For more information, see Create/Edit a Business Object, Object Manager, and About Blueprints.

• Security rights control access to Business Object data and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, refer to
Security rights and Define Business Object Rights.
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Business Object Performance
An example of poor Business Object performance is a page of Business Objects that takes some time to
load. Alternatively, there might be a noticeable time difference when loading Business Object records of
the same type.

Note: Performance might be different when comparing the Browser Client and Desktop Client.

To ensure optimal Business Object performance:

• Close any open calendars. Calendars can use a large amount of memory when open.

• Review configuration for the individual One-Step™ Action which changes the Owned By property
and handles the re-assignment of the Incident. Data may be loading in the back end, or a
Relationship may be reloaded based on constraints.

• Verify memory or CPU use.•

You can address high memory/CPU usage by ending some processes or purchasing additional
memory.

Note: If you are a hosted customer, check with Cherwell Support before trying either of
these solutions.

• Review any automatic actions. These are set in the Business Object Actions window (for more•
information, see Define Automatic Actions for a Business Object).

For example, selecting the Execute before saving record check box may be the cause of a time
lag. In this situation, you could optionally clear the check box and set an Expression to run this
action based on a true/false condition.

For more information on other simple action/event automation processes, see Define Actions for a
Simple Action/Event Automation Process.

• Review relevant Relationship properties. These are set in the Relationship Properties window (for•
more information, see Define Advanced Properties for a Relationship).

For example, you can set your Incident Relationships to load keys only if the Relationship is one to
many instead of loading everything. For more information on this specific scenario, see Run the
System Analyzer to Evaluate Business Object Structure.
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Using Business Objects
Use Business Objects to manage data and workflow for your business processes. Business Object
records are represented as forms and grids in the interface.

CSM provides multiple OOTB business processes that allow you to effectively solve issues and manage
information. Use these as-is, edit them, or create your own.

CSM 2022.3 Features 152

CSM 2022.3 Features



Managing Business Objects
Business Objects are managed in CSM Administrator using the Object Manager and the Business Object
Editor.

Related concepts
Business Object Editor
Object Manager
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Object Manager
The Object Manager is the interface within a Blueprint in CSM Administrator that allows you to manage
the various aspects of a Business Object and perform various Business Object operations.

Use the Object Manager to:

• Create, edit, and delete Business Objects.

• Manage Business Object structure:
◦ Relationships

◦ Actions

◦ Approvals

◦ Mapping options (to external data)

• Manage Business Object appearance:
◦ Forms

◦ Grids

◦ Form Arrangements (Major Objects only)

• Perform various Business Object operations:
◦ Scan a Business Object for potential problems

◦ Undo Business Object changes within a Blueprint

◦ Add a Business Object to a Blueprint

◦ View Blueprint Changes for a Business Object

◦ Export the Business Object as a Schema

◦ View the Business Object's Publish Log

◦ Manage culture fields for Lookup Objects when Globalization is enabled for your system.

There are several ways to open the Object Manager.
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1. View: Displays the currently selected Business Object View and shows which Business Objects in
the Object Tree are included in the View.

Note: Business Object Views allow different Users to see different instances of a Business
Object. The Default View is the view that all Users will see if a custom view has not been
created. The Business Objects that are not available for a particular View are still listed but
are grayed out and cannot be selected.

2. Object Types: Filters Business Objects by type.

3. Business Object Filter: Use the search field to limit the list of Business Objects shown in the Object
Tree.

4. Object Tree: Displays Business Objects in alphabetical order of the selected type and included in
the selected View.

5. Business Object Tasks: Displays a list of available operations that allow you to edit the structure and
appearance of a Business Object, and perform other operations as necessary such as scanning for
problems or exporting a Schema.
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Open the Object Manager
The Object Manager is opened from within a Blueprint or mApp Solution in CSM Administrator.

Use one of these methods to open the Object Manager:

• When you open a Blueprint or mApp Solution (by creating a new one or editing an existing one):
◦ In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

◦ In the CSM Administrator main window, click the mApps category, and then click the Create a
New mApp task.

Note: If working on a saved mApp Solution, open the existing mApp Solution.

• When working in a Blueprint or mApp Solution, return to the Object Manager by doing one of the
following:

◦ From the menu bar, click View>Object Manager.

◦ On the toolbar, click the Home button .

◦ In the Task Pane, click Object Manager.
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Business Object Editor
The Business Object Editor is the interface within a Blueprint, in CSM Administrator or a mApp® Solution,
where you can manage (create, edit, and delete) the various aspects of a Business Object.

Use the Business Object Editor to:

• Select Bus Ob Properties, and then define basic properties for a Business Object, as well as some
additional options and behaviors.

• Create, edit, or delete fields for a Business Object. See About Fields. The grid columns display the
name, type, size, mApp action, details, and storage name of each field.

• Select Field Properties, and then define properties for a field.

Related concepts
Open the Business Object Editor
Object Manager
Define Basic Business Object Properties
Define Additional Business Object Properties
Related tasks
Create a Blueprint
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Open the Business Object Editor
Open the Business Object Editor from the Object Manager (within a Blueprint or mApp Solution in CSM
Administrator).

Use one of these methods to open the Business Object Editor:

1. In the CSM Administrator main window, create or open an existing Blueprint or mApp Solution.

The Blueprint Editor or mApp Editor opens, showing the Object Manager in its Main Pane. The
Object Manager lists the existing Business Objects.

2. In the Object Manager, select a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area (or double-click a Business Object in the Object tree).

Tip: You can also click the Edit Business Object button  on the toolbar to open the Business
Object Editor.

Related concepts
Open an Existing Blueprint
Business Object Editor
Object Manager
Related tasks
Create a Blueprint
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Open the Business Object Properties Window
Open the Business Object Properties window from the Object Manager (within a Blueprint or mApp
Solution in CSM Administrator).

Use one of these methods to open the Business Object Properties window:

1. In the CSM Administrator main window, create or open an existing Blueprint or mApp Solution.

The Blueprint Editor or mApp Editor opens, showing the Object Manager in its Main Pane. The
Object Manager lists the existing Business Objects.

2. In the Object Manager, select a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area (or double-click a Business Object in the Object tree).

Tip: You can also click the Edit Business Object button  on the toolbar to open the Business
Object Editor.

3. Click the Bus Ob Properties button.
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Create/Edit a Business Object
Use the Business Object operations within the Object Manager to create a Business Object. In the Object
tree, click New Object.

In the tasks list, select one of the following operations:

• New Business Object

Opens the Business Object Properties window, and then define basic properties for a new CSM
Business Object.

• New External Business Object

Opens the External Data Wizard, and then establish a connection to an external database and
create a new external Business Object for sharing data with the external database.

• New Directory Service-mapped Business Object (only available if the directory service is
configured):

Opens the User Mapping Wizard to establish a directory service connection and create a CSM
Business Object that is mapped to a directory service Object.

Good to know:

• You can add a new Group Member to a Group Object by clicking a Group Leader in the Object
tree, and then clicking the New Group Member task in the Structure area.

• When you select an operation that creates a new Business Object, the basic properties of the new
object are based on the currently selected object type. For example, if Major is selected as the
object type, the new Business Object starts as a Major Object; however, this can be changed when
you edit the object's properties.

Creating a Business Object
To create a CSM Business Object:

1. Open the Object Manager.

2. Select a Business Object View, either:
◦ In the drop-down, select an existing View.

◦ Click the Ellipses button to open the View Manager, and then select an existing Business
Object View or create a new Business Object View.

3. Select an Object type (Major, Supporting, or Lookup).

Note: Selecting an Object type filters the list of Objects in the Object Manager, and also
automatically selects this type on the General page of the Business Object Properties
window when creating a new Object. Select (or change) the Object type when defining
general properties for the Business Object.
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4. Click (New Object) in the Object tree, and then click the New Business Object task from the
Structure area.

5. Define basic Business Object properties:
a. Define general properties for the Business Object.

b. Define process and procedure help.

c. Define Group properties.

6. Define additional Business Object properties:
a. Define lifecycle properties.

b. Define search results properties.

c. Define Attachment options.

d. Define database options.

e. Define history options.

f. Define record locking settings when record locking is enabled for your system.

g. Define Localization options for Lookup Objects when Globalization is enabled for your system.

h. Define advanced properties.

7. Create Fields.

8. Create Relationships for the Business Object.

9. Define Business Object Actions.

10. Add Approval support to the Business Object.

11. Define mapping options for sharing data with external databases:
◦ Map an Existing External Business Object to Import External Data.

◦ Map the Customer Object to a Directory Service.

12. Create Forms for the Business Object (including Summary Forms, Mini-Summary Forms, Mobile
Forms (if applicable), and Portal View Forms (View Only and Edit Existing)).

13. Define Grids for the Business Object.

14. (Major Objects only) Define a Form Arrangement for the Business Object.

15. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Editing a Business Object
To edit a Business Object:

1. Open a Business Object in the Object Manager.

2. Make changes.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Related concepts
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Find CSM Item Dependencies
About Business Objects
Related tasks
Delete a Business Object
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Define Basic Business Object Properties
Use the Business Object Properties window to define basic properties for a CSM Business Object.

Good to know:

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

To define basic Business Object properties:

1. Open the Business Object Properties window.

2. Define basic properties for the Business Object:
a. Define general properties.

b. Define process and procedure help.

c. Define Group properties.

3. Select OK.3.

The Business Object Editor opens, where you can add, edit, and delete Fields, or define additional
Business Object properties.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.

CSM 2022.3 Features 163

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=publish_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_open_business_objects_properties_window
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=publish_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=save_a_blueprint
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2Fgrids%2Fcreate-edit_a_business_object_grid.html


Define General Properties for a Business Object
Use the General page in the Business Object Properties window to define general properties for a
Business Object.

For example:

• Provide general information. For more information, see Provide General Information for the
Business Object.

• Define a Public ID. For more information, see Define a Public ID for the Business Object.

• Select a Business Object Type. For more information, see details for the relevant type:
◦ Major Business Objects.

◦ Supporting Business Objects.

◦ Lookup Business Objects.

• Set tracking options. For more information, see Define General Properties for a Business Object.

• Choose Business Object behaviour options. For more information, see Define Business Object
Behaviors.

• (For Major Business Objects) Define menus and shortcut keys. For more information, see Define
Menu and Shortcut Keys.

Provide General Information for the Business Object

1. Open the Business Object Properties window. For more information, see Open the Business
Object Properties Window.

2. Select the General page.

3. Define the following general information for the Business Object:

Option Description

Name

Enter a display name.

Note: Ampersands (&) are not supported in
Business Object names.

Plural Name

When you provide a display name, the plural name
is automatically completed (an "s" is added to the
end of the display name; you might need to edit
this).

The plural name is used when the Business Object
is displayed in text that needs a plural form.
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Option Description

Internal Name

When you provide a display name, the internal
name is automatically completed with the Business
Object display name, but with spaces and
punctuation removed.

In most places in the interface, the display name is
used; however, the internal name is used when
accessing the Business Object using APIs.

By default, the internal name is also used as the
custom storage name on the Database page
(except for Group Objects, which use the Group
Leader's storage name). For information on the
Database page, see Define Database Properties for
a Business Object.

Note:
The storage name can be overridden in the
database properties for a Business Object
(for more information, see Define Database
Properties for a Business Object).

However, it must adhere to SQL Table
naming conventions (example:
Automatically be derived from the display
name, not use invalid values such as
spaces, and so on).

(Optional) Description Provide a description.

Define a Public ID for the Business Object
CSM uses a unique identifier (usually RecID) for each Business Object instance, but this is not user-
friendly. A Public ID lets you define your own ID that is displayed to users. This is a single Field that best
represents the Business Object (example: Incident ID for the Incident object, customer's full name for the
customer object, and so on).

Important:

• A Public ID is required for Major Business Objects.

• Although it is not mandatory for Public IDs to have unique values, we recommend you
complete Public ID fields with values that uniquely identify a single record within a Business
Object. You can use a Counter to achieve this. For more information, see the Use Counter
description below.

To define a Public ID for a Business Object:

1. Select the Use Public ID check box to use a Public ID for the Business Object.
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2. Choose one of these options:
◦ Use Existing Field◦

In the drop-down, select a Field containing the value that best describes the Business Object
(example: IncidentID for Incident or Full Name for Customer).

◦ Create New Field◦

Select New to create a new Public ID field, and then provide the following properties:

Option Description

Display Name Enter a display name for the field.

Internal Name

Enter an internal name for the field (what the
system uses internally).

This is automatically completed with the field
name (without spaces and punctuation), but
can be changed if needed.

Field Size
Use the up/down arrows to increase or
decrease the number of characters the Field
can hold. The default is 10.

Use Counter

Select to use a Counter in the Field. For more
information, see About Counters.

Then, select the Ellipses button to open the
Counter Manager, where you can select an
existing Counter or create a new Counter. For
more information, see Create, Reset, or
Change a Counter.

Tip: You can create a new Counter if
you want each new record to have a
new and unique, ever-increasing
Public ID.

Note:
Multi-tab browsing support in the CSM Browser Client and CSM Portal uses a unique tab
display name, which allows users to easily identify on what they are working in each tab.

Major Business Objects (Incident, Problem, and so on) use the Public ID field to complete
the tab name. We recommend using a consistent Public ID naming convention to promote
enhanced usability throughout the tabs.

3. Select the Prefix with Business Object Name check box to display the Business Object name and3.
the Public ID. This is useful if the Public ID is numeric (example: An Incident ID of 12345 is
displayed as "Incident 12345" rather than just "12345").
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Note: When you define a Public ID, a window opens asking if you want to create an index.
We recommend selecting Yes so the Public ID can be used in CSMsearches. For more
information, see Searching .

Define Tracking Options
You can define tracking options to create fields to track information in the Business Object (example:
Ownership, who created or last modified a record, creation and modification dates). If you clear one of the
tracking check boxes, the selected track field is deleted from the Business Object.

Tracking options are:

Option Description

Track Creation

Track when records are created. Selecting this check box
automatically adds the following Fields to the Business Object:

• Created Date Time

• Created By

• Created By ID

Track Modified

Track when records are modified. Selecting this check box
automatically adds the following Fields to the Business Object:

• Last Mod Date Time

• Last Mod By

• Last Mod By ID

Track Owner

Track who owns a record. Selecting this check box
automatically adds the following Fields to the Business Object:

• Owned By

• Owner ID

The initial record owner is the person who creates the record.

Track Team Owner

Track which Team owns a record. Selecting this check box
automatically adds the following Fields to the Business Object:

• Owned By Team

• Owner Team ID
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Option Description

Track Delegate

Select this check box to activate the delegation feature. When
you select this check box and publish the Blueprint, the
Business Object appears in the drop-down list of Business
Objects you can assign delegates for when managing
delegates. Any new instances of this Business Object that are
created or edited will then check to see if the assignee has an
active delegate. If there is an active delegate, the item is re-
assigned to the specified delegate user. When a reassignment
occurs, a Journal -History record is created stating [Business
Object Name] hasbeen automatically reassigned
to [Delegate Full Name] due to active
delegation rule for [User Full Name]. This option is
only available for Major and Supporting Business Objects. and
not Lookup Objects. For more information, see Delegate Work.

Note: For more information about the Track Owner and Track Team Owner options, see Record
Ownership.

Define Business Object Behaviors
You can set various behaviors, including where the Business Object is shown in CSM (example: In saved
searches, One-Step Actions, expressions, and so on).

Option Description

Image
Select the image to open the Image Manager, and then
select an existing image or import a new image to
represent the item in the UI.

Uses Queues

(Major and Supporting Objects only) Select to allow users
to add this Business Object to Queues.

For more information, see About Queues.

Show in Search Manager

(Major and Supporting Objects only) Select to allow saved
searches to be associated with the Business Object.

The Business Object option is available in the
Association drop-down list in the Search Manager.

Show in One-Step Actions

Select to allow One-Step Actions to be associated with the
Business Object (for more information, see About One-
Step Actions) and to define Actions and One-Step Actions
for the Business Object (for more information, see Define
Business Object Actions).

The Business Object option is available in the
Association drop-down list in the One-Step Action
Manager.
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Option Description

Show in Expression Manager

Select to allow Expressions to be associated with the
Business Object. For more information, see Expressions.

The Business Object option is available in the
Association drop-down list in the Expression Manager.

Show in Table Management

(Supporting and Lookup Objects only) Select to allow
values to be provided for the Business Object via Table
Management. By default, this is selected for Lookup
Business Objects so that users can easily add new values.

For more information, see About Table Management.

Show in E-mail Address Book

Select to show the Business Object in the CSM Address
Book > Show Names From drop-down list (for more
information, see Select Email Recipients from the CSM
Address Book).

Then, select the Field that holds the email address value
(you might need to create this Field). Typically, this is used
for Customer and UserInfo Objects.

Note: When first creating a Business Object, there
is no appropriate Field to hold the email address.
Consequently, you must create the field (for more
information, see Create/Edit a Field) and then edit
the Business Object to set this option.

Show in Contact Manager

Select to show the Business Object in the Contact Manager
(in the Customer Type to Show drop-down list). Then,
select the Field to use to alphabetize records.

This is selected by default for the customer Business
Object / Group Members. Typically, it is only selected for
other objects if they represent external customer data.

Show required field identifiers in labels

Select to display an asterisk (*) next to required field label
controls in Forms. Enabled by default on new Business
Objects.

Note:

• Fields that are conditionally required for save
will not show an asterisk in the Form Editor.

• This functionality is not available for Related
Item Picker fields.
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Option Description

Allow spell-checking

Select to enable spell-checking for Fields in the Business
Object. This checks for spelling errors in content that is
provided in Business Object records. You can specify which
Fields should be selected on a field-by-field basis.

Define Menu and Shortcut Keys
For Major Objects, you can define menus and shortcut keys.

Option Description

New Record

Select a keyboard command to use as a shortcut to
create a new Business Object record in CSM
(example: CTRL+SHIFT+I creates a new Incident
record).

Quick Search

Select a keyboard command that is used to change
the Search Control to this object in the CSM Desktop
Client Task Pane.

Set the focus to the Search Control so that the user
can provide search terms to run a Quick Search of
the Business Object. For more information, see About
Quick Search .

Note:
To enable the Quick Search keyboard
shortcut, you must select Show in Quick
Search on the Search Results page.

When this shortcut key is used in CSM, the
Quick Search selector automatically changes
to the appropriate Object, and the cursor is
placed in the Search Control ready for the
user to provide a keyword to search.

Show on New Menu
Select to show the New Record keyboard shortcut on
the New menu on the CSM Desktop Client menu bar
and toolbar.
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Define Process and Procedure Help Properties for
a Business Object

Use the Process and Procedure Help page in the Business Object Properties window to provide
additional information to Users who work with a Business Object.

Good to know:

• If you cannot see the Process and Procedure Help page, save and close the Blueprint and go to
Settings > Edit System Settings. Select the Help page, and then select Show Process and
Terminology Help. For more information, refer to Configure Global Help Settings.

• If the Process and Terminology section does not appear on the CSM Desktop Client Task Pane,
ensure it is enabled in the User Task Pane and Search Control Settings.

To define process and procedure help:

1. Open the Business Object Properties window.

2. Select the Process and Procedure Help page.

3. Define process and procedure help:

Option Description

Process and Procedure Text
Provide text to display in the Process and
Terminology section of the CSM Desktop Client
Task Pane.

Additional Help URL

(Optional.) Provide a URL to display to navigate
to additional information. Then, select the
Ellipses button to navigate to the URL and
ensure it is correct.

4. Select OK.4.

5. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define Group Properties for a Business Object
Use the Group page in the Business Object Properties window to define whether a Business Object is:

• Not a member of a Group: Does not belong to a Group.

• Group Leader: Is the leader (root) of a Group, and stores common Fields that all Group Members
share.

• Member of Group: Belongs to an existing Group, which means it descends from a Group Leader
and shares common Fields with other Group Members. However, each Group Member has some
unique information associated with it.

Good to know:

• Add a Group Member directly to a Group Object by clicking a Group Leader in the Object tree, and
then clicking the New Group Member task in the Structure area.

• Newly created Group Members are assigned the default Business Object rights.•

To define Group properties for a Business Object:

1. Open the Business Object Properties window.

2. Click the Group page.

3. Define Group properties:
◦ Not a Member of a Group: Select this radio button if the Business Object will not be a Group

Leader or Group Member.

Note: If you select this option, the Group page will no longer be available in the
Business Object Properties window after the Business Object is created and its basic
properties are defined.

◦ Group Leader: Select this radio button to make the Business Object a Group Leader (the root
of a Group). When you create Business Objects to be Group Members under this Group
Leader, they will be listed in the Group Members section.

◦ Member of _____ Group: Select this radio button to make the Business Object a member of
an existing Group. Then, select the Group Leader in the drop-down (the existing Group
Members will be listed in the Group Members section).

4. Select OK.4.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.

Related concepts
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Group Business Objects
Convert to a Group Business Object
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Define Additional Business Object Properties
After you define the basic properties for a Business Object, you can define some additional options and
behaviors. Use the Business Object Properties window to define the following additional properties:

• Lifecycle: Workflow states and behaviors (if applicable).

• Search Results: Options for including the Business Object in CSM Searches (ex: Quick Search)
and how to display a list of records in search results.

• Attachment properties: What types of Attachments are allowed for the Business Object.

• Database properties: Options for setting up a database table that represents the Business Object.

• History properties: How to keep history records (ex: Track e-mail communication, lifecycle state
changes, etc.).

• Record Locking: Override Global Record Locking settings for the Business Object and define
settings specifically for the Business Object.

• Localization: For Lookup Business Objects, enable support for translation of Lookup values. See
Enable Localization Support for a Lookup Table and Define Localization Properties for a Business
Object.

• Advanced properties: Advanced options and attributes for the Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

Good to know:

• The pages that are available in the Business Object Properties window vary depending on the type
of Business Object (Major, Supporting, Lookup, or Group).

• The Record Locking page only appears in the Business Object Properties window if record locking
is enabled for your system.

• You might see additional pages in the Business Object Properties window depending upon options
you have configured. For example, if LDAP is configured, you will see a page for LDAP attributes
that are mapped to a Business Object’s Fields. If you are sharing data with an external database,
you will see an External Data page and possibly an External Search page. If you are creating or
editing a Business Object within a mApp Solution, you will see a mApp Solutions page.

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

To define additional Business Object properties:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.
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The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Define additional properties for the Business Object:

Note: You can also return to the basic properties you defined and edit them, if needed.

a. Define lifecycle properties.

b. Define search results properties.

c. Define Attachments properties.

d. Define database properties.

e. Define history properties.

f. Define record locking settings.

g. Define advanced options.

h. Define localization support (Lookup Business Objects only)

3. Select OK.3.

The Business Object Editor opens, where you can add, edit, and delete Fields.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Lifecycle Properties for a Business Object
Use the Lifecycle page in the Business Object Properties window to define which Field holds the lifecycle
state value, the list of lifecycle states, and whether records are automatically added to or removed from
Queues based on lifecycle states.

Note for new Business Object lifecycle (CSM 10.2.0 or later)

Important: For CSM 10.2.0 or later versions, use the Business Object Lifecycle Editor to add a
lifecycle to a Business Object. See: Open the Lifecycle Editor.

Lifecycle states can be used throughout the system to determine behaviors. For example, you can define
automatic Actions that are executed when a record changes states, require a Field to contain a value
before a record can change states, or order the lifecycle states in a Lookup Object and then use it to
validate Status fields.

To define lifecycle properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task. If you are working on a saved Blueprint, open the existing
Blueprint.
The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

c. Click the Bus Ob Properties button.

2. Select the Lifecycle page.

3. Select the Has Lifecycle check box.

4. Define lifecycle states for the Business Object:
◦ State Field: In the drop-down, select a Field (example: Status) to hold the value (example:

New, In Progress, Closed, etc.) of the lifecycle state.

◦ States: Lists the lifecycle states that have been defined for the Business Object. You can add,
edit, or delete lifecycle states.

◦ Final State: Click this button to designate a selected lifecycle state that generally indicates
that a Business Object record has completed its lifecycle. Common values include Closed,
Retired, or Completed.

◦ Recall State: Click this button to designate a selected lifecycle state that indicates that a
Business Object record that was in a final state has been reopened. This allows for special
behavior and security to limit who can recall a record and what can be done with a recalled
record.

◦ Clear State: Click this button to clear the final or recall designation from a selected lifecycle
state. The Clear State button is only active if you have a final or recall state selected.
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◦ Not in Final State Text: Provide text that describes Business Object records that are not in a
final state (example: Open). This is useful for Search Groups (example: A search for Open
Incidents will return all Incident records in a state other than Closed, which is the final state). If
a specific value is not provided, the system will build a string based on the final state
(example: Not closed).

◦ Show Goto Final State Option in Application (the gavel): Select this check box to display
the Gavel button on the CSM Desktop Client toolbar. Users can click this button as a shortcut
option to put Business Object records in a final state.

5. Define Queue options based on the defined lifecycle states. This allows Business Object records to
be automatically added to or removed from Queues when their states change. These options are
only available if Uses Queues is selected on the General page in the Business Object Properties
window.

◦ Auto-add to User Queue: Select this check box to automatically add a Business Object
record to the User’s Queue when it enters its initial lifecycle state and the record is associated
with a particular User.

◦ Remove from User Queue when put in Final State: Select this check box to automatically
remove a Business Object record from the User’s Queue when it reaches a final state.

◦ Field with User ID: In the drop-down, select the Business Object Field that holds the ID
of the User.

◦ Auto-add to Team Queue: Select this check box to automatically add a Business Object
record to a Team’s Queue when it enters its initial lifecycle state and the record is associated
with a particular User.

◦ Remove from Team Queue when put in Final State: Select this check box to automatically
remove a Business Object record from the Team’s Queue when it reaches its final state.

◦ Field with Team ID: In the drop-down, select the Business Object Field that holds the ID
of the Team.

◦ Remove from All Queues when put in Final State: Select this check box to automatically
remove a Business Object record from all Queues when it reaches its final state.

6. Select OK.6.

7. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
About Business Object Lifecycles
Open the Lifecycle Editor
Define Automatic Actions for a Business Object
Define Auto-population Properties for a Field
About Queues
Related tasks
Create a Blueprint
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Define Search Results Properties for a Business
Object

Use the Search Results page in the Business Object Properties window to define the following:

• Full-Text and Quick Search: Whether to enable Full-Text and/or Quick Search for a Business Object.

Note: Both Quick Search and Knowledge Search use Full-Text Search. If you enable Full-
Text Search, the list of Fields is indexed for fast lookup.

• Card view: Search results appear in a more web-like interface, as a list or as large or medium cards.

• Link text: The text that appears as links in a search results list of records (using either an Expression
or Field values).

• Body text: The text that appears underneath the link text in a search results list of records (using
Field values).

• Image: An image to accompany the search results.

The options defined on the Search Results page determine how a Search Results list of records appears
in CSM. The following figure shows an example of a Search Results list of records with link text and body
text, as well as labels and subtitles included.
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Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

To define search results properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Click the Search Results page.

3. Define general search results properties:
◦ Include in Full-Text Search: Select this check box to enable Full-Text searching for the

Business Object.

◦ Show in Quick Search: Select this check box to make the Business Object available in Quick
Search.

Note: You can only select Show in Quick Search if Include in Full-Text Search is also selected.

4. Enable card view: Select this check box to display search results in a card view format. Then, select
a default view (how the results list is displayed when it first opens; Users can change the view):

◦ Results list: Select this radio button to display search results in a web-like search results list.

◦ Large: Select this radio button to display search results as large cards (ideally, 310x155).

◦ Medium: Select this radio button to display search results as medium cards (ideally, 150x150).

5. Define link text options. This is what will be displayed as a link in a search results list:
◦ Expression: Select this radio button to use an Expression to determine the link text. Then,

select a most recently used (MRU) Expression in the drop-down, or define one using either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.
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◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ List of Fields: Select this radio button to use the values from a list of Fields as the link text in a
search results list.

◦ Add: Click this button to add Fields to the list (you can add multiple Fields at the same
time).

◦ Delete: Click this button to delete a selected Field from the list (you can only delete one
Field at a time).

Tip: Use the Up/Down arrows   to change the order of the selected Fields. The
Field values will be displayed in this order in the search results list.

◦ Includes Label: Click a Field, and then select this check box to include the Field name in
the search results list along with the Field's value. Fields that include labels are indicated
by an icon .

◦ Show Last Modified Subtitle: Select this check box to display a subtitle underneath the link
with information regarding when and by whom the Business Object record was last modified.

6. Define body text options. This is what will be displayed under the link text in a search results list.
◦ List of Fields: Select which Fields contain the values to be displayed under the link text in a

search results list.
◦ Add: Click this button to add Fields to the list (you can add multiple Fields at the same

time).

◦ Delete: Click this button to delete a selected Field from the list (you can only delete one
Field at a time).

Tip: Use the Up/Down arrows   to change the order of the selected Fields. The
Field values will be displayed in this order in the search results list.

◦ Includes Label: Click a Field, and then select this check box to include the Field name in the
search results list along with the Field's value. Fields that include labels are indicated by an
icon .

7. Define conditions for displaying an image in a search results list of records:
◦ Show Result Image: Select this check box to define an Expression that determines when a

search results image is displayed. Then, select a most recently used (MRU) Expression in the
drop-down, or define one using either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Results List Image Size: In the drop-down, select a size for the image to show in the results list
view (48x48, 32x32, or 16x16).
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◦ Card View Image Size: Select a size for the image to show in card view, either:
◦ Zoom to fill: Select this radio button to have the image zoom to fill the width of the picture

area, and crop as necessary.

◦ Best Fit: Select this radio button to have the image centered or resized to best fit the
available image space. If the image is smaller than the available image space, it is
centered in the picture area. If it is larger than the available image space, it shrinks to fit
the picture area.

Example: Images can be used for a Group Object (example: Journal), with a specific
image for each Group Member in the search results list (example: An envelope icon for
Journal - Mail History, a notepad icon for Journal - Note, etc.). You can use Expressions
to show different images for each Group Member based on status or other conditions
(example: A closed envelope if a Journal - Mail History record is flagged as Unread, and
an open envelope if it is flagged Read). Images are also useful for Search Results List
Widgets (example: Customer's picture next to their posted announcement topics in the
Portal). If card view is enabled and no image is used, a gray area will show where the
image would be.

8. Select OK.8.

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Attachments Properties for a Business
Object

Use the Attachments page in the Business Object Properties window to define which types of
Attachments Users can attach to a Business Object (ex: Imported files, Attachment Manager
Attachments, etc.).

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

To define Attachment properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

c. Click the Bus Ob Properties button.

2. Click the Attachments page.

3. Define Attachment options:
◦ Allow Imported File Attachments: Select this check box to allow Users to import files directly

into CSM and attach them to the Business Object. In CSM, Attach a file (import) will be
available from the Attachment menu on a record.

◦ Allow Linked File Attachments: Select this check box to allow Users to link files that are on a
network drive directly to CSM and attach them to the Business Object. In CSM, Attach a file
(link) will be available from the Attachment menu on a record.

◦ Allow Linked URLs: Select this check box to allow Users to link websites to CSM and attach
them to the Business Object. In CSM, Attach a web page will be available from the Attachment
menu on a record.

◦ Allow Attachment Manager Attachments: Select this check box to allow Users to select
Attachments from the Attachment Manager and reference them from the Business Object. In
CSM, Shortcut to an Attachment will be available from the Attachment menu on a record.
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◦ Allow Arbitrary Business Object Attachments: Select this check box to allow Users to
reference other Business Objects as Attachments. In CSM, Objects will be available from the
Attachment menu on a record, with a list of available Business Objects:

◦ Allow Any Major Business Objects: Select this radio button to allow any Major Business
Object to be referenced as an Attachment. In CSM, all Major Business Objects will be
listed when Users select Objects from the Attachment menu.

◦ Allow the Following Business Objects: Select this radio button to select specific Business
Objects that can be referenced as Attachments. Then, select one or more Business
Objects in the list. In CSM, only the selected Business Objects will be listed when Users
select Objects from the Attachment menu.

Note: An Arbitrary Business Object Attachment can be accessed from the
Attachment Bar on its associated record, but it is not related to the Business
Object. Since it is not related to the Business Object it is not available for
searching or navigation.

4. Define options for showing Relationships on the Attachment Bar. This allows you to display related
Business Objects in the Attachment Bar.

◦ Relationships Shown on Attachment Bar: Select which Relationships to show on the
Attachment Bar for the Business Object. This allows Users to reference related Objects as
Attachments.

◦ Attachment Menu Text: Provide text to display on the Attachment menu, or leave it blank to
use the default menu text (Choose a <child Business Object name here>).

Note: This is typically used for related items that are either rarely used or are not
important enough to warrant creating a tab in the Form Arrangement to show related
data. It also allows the User to select a record to display on a tab without exposing the
toolbar on the tab. We recommend adding only one-to-one Relationships to the
Attachment Bar, unless you expect only a few items from a one-to-many Relationship
to be attached.
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5. Track Changes: Select this check box to create an audit log for Attachments. This creates a Journal-
Note in the Form Arrangement to show the addition, removal, or update/change of Attachments.

6. Select OK.6.

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.

Related concepts
Activity Pane
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Define Database Properties for a Business Object
Use the Database page in the Business Object Properties window to define how to set up the database
table that represents a Business Object. This includes record update options, indexing, and setting a
primary key.

Good to know:

• All Business Objects are stored as database tables in SQL Server. Group Objects are stored in one
table (example: The Customer table also includes all of its Group Members), except for linked
External Business Objects.

• Encrypted Fields are not stored in database tables, and cannot be indexed.

To define database properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, select the Blueprints category, and then select the

Create a New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, select a Business Object in the Object tree, and then select the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

c. Select Bus Ob Properties.

2. Select the Database page.

3. Define general database properties:
◦ Custom Storage Name: This is the name that will be used for the database table that

represents the Business Object. The Custom Storage Name is automatically populated with
the Business Object's Internal Name defined in general properties (modified as necessary to
be a legal SQL table name).

Note: For best results, do not change the Custom Storage Name unless you have a
specific reason. If the name is changed, it must adhere to SQL Table naming
conventions (example: Automatically be derived from the display name, not use invalid
values such as spaces, etc.).

◦ Pessimistic Updates: Select this check box to enable pessimistic updates when Business
Object records are saved. This prevents Users from simultaneously editing records and
overwriting each other's updates.

Note: Normally, the system uses optimistic updates for saving Business Object
records. With optimistic updates, if two Users edit the same record, and then both save
the record, the changes from the last User to save the record will overwrite the
changes made by the first User. If pessimistic updates are enabled, the last User to
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save a record will receive a message that the record cannot be saved because another
User has just edited the record. In most cases, using record locking is a better option.

4. Create indexes for Fields that you expect Users to search frequently to speed up searching and
record retrieval. The system automatically creates indexes for values that it typically looks for
(example: RecID), but it is recommended that you create indexes for the Field that holds the Public
ID of an Object and for any other Fields you expect Users to search. The system automatically
creates an index for the Public ID field if you selected to create one when you defined the Field (on
the General page).

◦ Add Index: Select this button to add an index.

To add an index:

◦ Select Add Index.

An expanded view of the new index opens.

◦ Define index attributes:
◦ Name: Provide a name for the index.

◦ Primary Key: Select this box to make the index the table key. This is automatically
selected for the index on RecID (which is automatically created when you create a
Business Object).

◦ Clustered Index: Select this box to use the index to physically order the rows in the
database table. This is automatically selected for the index on RecID (which is
automatically created when you create a Business Object).

Note: Each Business Object (table) can have only one primary key and one
clustered index. If you designate more than one index as the primary key or
clustered index, you will receive an error when you select OK in the Business
Object Properties window. By default, the index for the RecID field is designated as
the primary key and the clustered index. If you assigned a RecID attribute to a
different field, then the index for the field with the RecID attribute should be the
primary key and clustered index.

◦ Unique Index: Select this box if each of the columns in the index must have a
unique set of values so that multiple rows in the database cannot be identical. For
example, if the columns in the index are First Name and Last Name, there cannot
be two rows in the table with the values John Smith.

◦ Define the Business Object Fields that contain the values for the index in the database
table:

◦ Select Add to select Fields to include in the database index.

The Add Field to Index window opens.

◦ Select a Field.

◦ Define a sort order for the Field values:
◦ Select the Ascending radio button to sort the values for the Field in

ascending order.
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◦ Select the Descending radio button to sort the values for the Field in
descending order.

◦ Select Include Column to include the Field value in the index. This is an advanced
optimization feature that can be used to include additional columns needed by
queries without pulling the data from the actual table, while keeping the index key
small and efficient.

Note: Click the Delete button to delete a selected Field from the index. Use
the arrows to change the order of the Fields in the index. When building
indexes, the order of columns is important. Typically, the column that most
limits the results should be the first column in the index. However, following
this guideline might require many additional indexes to achieve required
performance from the database, as each index requires SQL to perform
additional work for each insert, update, and delete. In such cases, it is
advisable to put columns used by many different queries first in an index.

Note: Include columns do not have to be ordered.

◦ Select OK.◦

◦ Select the down arrows to expand an existing index. From an expanded index, you can:
◦ Edit the index.

◦ Delete the index.

5. Select OK.5.

6. Publish the Blueprint (File > Publish) to commit the changes, or save the Blueprint (File > Save) to
continue making other changes.

Related concepts
Defining Foreign Key Relationships
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Define History Properties for a Business Object
History options enable you to track historical information for a Business Object. You can define the
Business Object's relationship to the History Object, which of the Group Object's members to use to track
each type of history, and which field changes should be tracked.

In the supplied system, the Journal Object is used to track Business Object history.

To define history properties for a Business Object:

1. In the CSM Administrator main window, select the Blueprints category and then select Create a
New Blueprint.

2. In the Object Manager, select a Business Object in the Object tree, and then select the Edit
Business Object task in the Structure area. You can also select the Edit Business Object button
on the Blueprint Editor toolbar to open the Business Object Editor.

3. Select the Bus Ob Properties button.
4. Select the History page.
5. From the History Relationship drop-down list, select the Relationship of the primary Business

Object to the History Object (example: Incident Owns Journals). If a Relationship does not already
exist, you must create one. See Create/Edit a Relationship.

6. Select which of the History Object's Group Members to use for each type of history:
◦ Manual History: Select the Business Object to use for tracking history records that are

manually added by users.
◦ Lifecycle History: Select the Business Object to use for tracking changes to the primary

Object's lifecycle. This is only applicable if the primary Object has a lifecycle. For more
information, see Define Lifecycle Properties for a Business Object (legacy lifecycle method) or
Open the Lifecycle Editor (recommended lifecycle method).

◦ Customer Request: Select the Business Object to use for tracking customer requests. This is
used in the Browser Client and Portal to track requests against a record (example: Withdraw a
record, close it, etc.).

◦ Mail History: Select the Business Object to use for tracking email correspondence. See Track
E-mail Correspondence in Journal - Mail History Records.

◦ Queue History: Select the Business Object to use for tracking when records are added to or
removed from a queue (Uses Queues must be selected on the General page).

◦ Knowledge History: Select the Business Object to use for associated Knowledge. If a
Knowledge source is configured to transfer its contents into a Journal - History object when the
Knowledge item is used, then a Journal - Knowledge History record is created.

◦ Change/Audit History: Select the Business Object to use for tracking change/audit logs.
◦ Chat History: Select the Business Object to use for tracking remote support session details.

See Configure CSM Remote Support Settings.
7. Select one of the following options from the Track Field Changes drop-down list:

◦ No Tracking: Select this option to disable field changes tracking.
◦ Record per Change: Select this option to have one history record created for each field that is

changed.
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◦ Combine Changes: Select this option to have one history record created for all changes
made to a Business Object before it is saved.

◦ All Fields: Select this checkbox to track changes for all fields in the Business Object.
Otherwise, tracking is done on a field-by-field basis. See Define General Properties for a Field.

8. Select Display Activity Pane to enable the Activity Pane for the Business Object. See Activity
Pane.

9. Select Enable user mentions to enable users to mention other users in Activity Pane notes created
in the Browser Client. A type-ahead list of valid users is presented after users type the @ symbol.
Users must have an email address set in their CSM account.

10. Select the Enable notifications checkbox to send an email message to mentioned users. The
Cherwell Service Host must be configured and running before email messages can be sent.

11. Select OK.
12. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File

> Save Blueprint) to continue making other changes.

Related concepts
About Business Object Lifecycles
Open the Lifecycle Editor
Define Lifecycle Properties for a Business Object
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Define Record Locking Settings for a Business
Object

You can override Global Record Locking settings for any Major Object using the Record Locking page in a
Major Business Object's Business Object Properties window if record locking is enabled for your system.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

Each Business Object can have one and only one record locking configuration; you cannot configure
different record locking configurations per View (ex: One for default View and one for Portal View). We
recommend configuring record locking on the default Business Object View.

To configure Record Locking settings for a Business Object:

1. Open the Business Object Properties window for a Major Business Object:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Major Business Object in the Object tree, and then click the
Edit Business Object task in the Structure area.

c. Click the Bus Ob Properties button.

2. Click the Record Locking page.

3. Select the Override the Global Locking Defaults check box.

4. Define record locking settings for the selected Major Business Objects:
a. Lock Type: Select one lock type from the following:

◦ None: Select this radio button to not enforce or inform record locking even though it is
enabled for the system.

◦ Enforced: Select this radio button to prevent Users from editing a record when it is
locked by another User (the lock holder).

◦ Informational: Select this radio button to warn Users when a record is currently locked by
another User so that Users do not attempt to edit the same record. If two Users do edit
the same record, CSM gives Users the option to merge the edits.

b. Lock Record Upon Editing: Select this check box to automatically lock the record when a User
attempts to edit the record. If not selected, Users must manually lock records.

c. Unlock Record Upon Saving: Select this check box to automatically unlock the record when a
User saves the record. If not selected, the record remains locked until the User ends his

CSM 2022.3 Features 190

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2Fsuite_features%2Frecord_locking%2Fenable_record_locking.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2Fsuite_features%2Fbusiness_objects%2Fbusiness_object_editor.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2Fsuite_features%2Fbusiness_objects%2Fobject_manager.html
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=about_blueprints
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=open_an_existing_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=blueprint_editor
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2Fsuite_features%2Fbusiness_objects%2Fobject_manager.html


session (if configured), until the lock expires (if configured), or until the record is manually
unlocked.

d. Lock Expires After: Select this check box to enable lock expiration. Then, specify the time
limit in minutes (ex: 30). If not selected, the record remains locked until the User ends his
session (if configured), until the record is saved (if configured), or until the record is manually
unlocked.

e. Minutes Before Lock Expiration to Notify Users: If locks expire after a certain amount of time,
select this check box to notify Users of impending expiration and allow renewal. Then, specify
the number of minutes before expiration to notify Users (ex: 3 minutes). This only works in
the CSM Desktop Client.

f. Maximum Number of Records a User Can Have Locked at One Time (Per Business Object
Type): Specify the maximum number of records a User can have locked at one time, per
Business Object (ex: Each User can lock only 10 Incidents at a time).

5. (Optional) Restore Global Lock Settings: Click this button to revert to the default Global Record
Locking settings.

6. Select OK.6.

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Localization Properties for a Business
Object

You can enable localization support in Business Objects. You can also select which Text Fields within
those objects can show translated values to Users.

This enables you to have multiple versions of the same Field (one for each culture).

Note: If translated Lookup Table values are not appearing as expected, verify that validated
specific culture Fields are validated against the correct culture field. For example, the German
version of the validated Status Field should validate to a German field. For more information, see
Define Validation Properties for a Field.
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Define Advanced Properties for a Business Object
Advanced users can use the Advanced page in the Business Object Properties window to define
advanced properties for a Business Object.

Define the following Business Object properties:

• Advanced Options: Whether the Business Object is read-only or cacheable, enable View Counter
functionality, or to associate a color with the Business Object.

• Attributes: Additional pieces of information (or meta-data) that can be associated with the Business
Object. Some attributes are automatically set, but others must be provided manually.

• Only advanced users should define attributes. For more information about attributes, please contact
Cherwell Support.

To define advanced properties for a Business Object:

1. Open the Business Object Properties window.
2. Select the Advanced page and define the following options:

◦ Read-only: Select this check box to protect the data in the Business Object from being edited.
In CSM, users will only be able to view the data but will not be allowed to make changes to it.

◦ View Counter: Select this check box to enable View Counter functionality for a Major
Business Object. The View Counter functionality applies to only the Business Object View
selected in the Object Manager (for more information, see Business Object Views). The View
Counter adds two read-only fields to the Object (Portal View Count and Technician View
Count), which can be added to features such as dashboard Widgets, reports, and forms. The
Portal View Count field incrementally tracks the number of times a record is viewed in the
Customer Portal. The Technician View Count field incrementally tracks the number of times
the record is viewed in the CSM Desktop Client or CSM Browser Client. The View Counter
must be enabled for each Business Object View that you want counted. The count only
increments when a user or customer opens a record by:

◦ Selecting a Quick Search result.
◦ Selecting a Saved Search result.
◦ Selecting a result from the Knowledge Pane.
◦ Selecting the GoTo button in the form arrangement.
◦ Selecting the Quick View button in the form arrangement.
◦ Using a deep link.
◦ Using the Command Line.

◦ Note: The count does not increment when a record is viewed in the form arrangement,◦
refreshed from the toolbar, updated with a status change, or accessed using the
Cherwell REST API.

View Counter data is automatically captured and stored until the record or Major Business
Object is deleted. When a record is deleted, View Counter data for the specific record is
deleted, and when a Major Business Object is deleted, all View Counter data related to the
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Business Object is deleted. If you clear the View Counter option for a Business Object, the
fields are removed from the object, but the View Counter data is saved.

◦ Cacheable: Select this check box to have the Business Object cached for use as a validation
table. This allows the values from the Business Object to be cached instead of retrieved from
the database each time they are needed, which can improve system performance.

Note: This is the default setting for Lookup Business Objects. You may not want to
cache a Lookup Object if you expect it to change frequently or if it is very large (3MB or
more). Even if a Business Object is marked for caching, the system might not cache it
if it contains too much data.

◦ Include Large Text Fields in Cache: Select this check box to also cache large text fields
(Max Allowed and Max Searchable are checked in field properties) and rich text fields.

Note: Large text fields and rich text fields are rarely used for validation/auto-fill. To
reserve memory space, selecting this check box is not recommended. Select this
check box only if there is a need to cache these fields.

◦ Associated Color: Select the Color Selector button  to select a color to associate with the
Business Object (example: For use in Visualizations). For more information, see About
Visualizations.

3. Define attributes for the Business Object:
◦ General Attributes: Select the down arrow to expand the General Attributes section. Then,

select an empty row and provide the attribute name and associated value (if applicable).
◦ Database Attributes: Select the down arrow to expand the Database Attributes section.

Then, select an empty row and provide the attribute name and associated value (if applicable).

Database attributes are used to indicate special attributes used for a Business Object’s
database table. Most of these are set by the system.

4. View additional advanced information for the Business Object:
◦ Business Object ID: Select this button to open a window that displays the internal ID that is

used for the Business Object. This ID can be used instead of the Business Object’s name in
many places in the system (this is particularly useful when accessing the system via the
Cherwell REST API). The ID is used internally so that Business Objects can be renamed
without breaking any relationships.

◦ Find Dependencies: Select this button to scan the Business Object for a list of other
definitions in the system that use this Business Object. When the scan is finished, the
Definition Dependencies window opens, listing the dependent definitions.

5. Select OK.
6. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes. For more information, see Publish a Blueprint or Save a Blueprint.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one form and one grid defined and that all of the appropriate
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fields have been created. For more information, see Create/Edit a Form and Create/Edit a
Business Object Grid.

Related concepts
Business Object Editor
Object Manager
Open the Business Object Properties Window
Create/Edit a Field
Define List Display Options (Text Prompts Only)
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General Business Object Attributes
Business Object attributes provide additional capabilities. Attributes are set on the Advanced page of the
Business Object Properties dialog.

General attributes are additional pieces of information (or meta-data) that can be associated with a
Business Object. Some attributes are automatically set, but others must be provided manually.

Attribute Description Notes

BarcodeScan Used to allow users to scan barcodes from within
the Browser Client.

See Configure the Browser Client
to Scan Barcodes.

CustomerInfo Used with Relationships to represent customer
information.

Knowledge
Designates a Business Object to be used for
Knowledge. Limited to one Business Object per
CSM system.

See Configure a Business Object
for Knowledge Import.

LocationAware Sets a Business Object as location aware. See Set the Location of a
Business Object.

PublishToApi Enables Cherwell REST API Named Objection
Operations for a Business Object.

See Add Operations for Named
Objects.

SAMLImport Determines which Business Object stores user
data for automatic imports from SAML.

See Add SAMLImport Attribute
for User Business Object.
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Delete a Business Object
Use the Object Manager in CSM Administrator to delete a Business Object from your system.

Important: Business Objects are system-level objects so be very careful when considering
deletion and search for dependencies as explained below first.

Note: If you delete a Business Object from the Default View, it is automatically deleted from any
other views in which it appears. If you delete a Business Object from a view other than the Default
View, there is no automatic deletion from all other views.

To check the implications of deleting a Business Object:

1. In CSM Administrator, open a new or existing Blueprint.
2. In the Object Manager, select a Business Object in the Object tree, and then select the Delete

Business Object task in the Structure area.
3. Select Dependencies.

The Definition Dependencies window opens showing all the items that used by or relied upon by
the Business Object that is currently selected for deletion.
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For more information, see Find CSM Item Dependencies.
4. Select Close.

To delete a Business Object:

5. In CSM Administrator, open a new or existing blueprint.
6. In the Object Manager, select a Business Object in the Object tree, and then select Delete

Business Object in the Structure area.
7. Select Yes.

The Business Object is deleted but is only permanently deleted from your system once the Blueprint
is published.

8. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.

Related concepts
Find CSM Item Dependencies
About Business Objects
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Define Business Object Actions
Use the Business Object Actions window (accessed from the Object Manager within the Blueprint Editor)
to define Actions/One-Step Actions that can be launched from various areas within a Business Object,
including:

• Menu Actions: Actions available from an Actions menu on the menu bar for a Business Object.

• Task Pane Actions: Actions available in the Task Pane for a Business Object.

• Action Toolbar: Actions available on a Business Object's toolbar.

• Context Menu Actions: Actions available in an Actions context menu when a User right-clicks a
Business Object in a Grid or search results list.

• Print Options: One-Step Actions or Reports available from the File>Print menu in a Business
Object.

• Automatic Actions: Actions that are automatically performed when a Business Object is created or
saved, or when it changes status.

Good to know:

• To define Actions/One-Step Actions for a Business Object, you must select the Show in One-Step
Actions check box on the General page of the Business Object Properties window.

• Automatic Actions can be defined for Supporting Objects, but they are only executed if the object is
used stand-alone. For example, if an Approval has a save Action and is edited as part of a Change
Request, the Action will not be executed. However, if the Approval is edited stand-alone, the Action
will be executed.

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

To define Business Object Actions:

1. Open the Business Object Actions window for a Business Object:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If you are working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Define menu Actions.

3. Define Task Pane Actions.

4. Define toolbar Actions.
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5. Define context menu Actions.

6. Define print options.

7. Define automatic Actions.

8. Select OK.8.

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Menu Actions for a Business Object
Use the Menu page in the Business Object Actions window (accessed from the Object Manager within the
Blueprint Editor) to create a Business Object-specific Actions menu. Users can select these Actions from
the CSM Desktop Client Menu Bar (ex: Incident Actions menu) when working with records for a particular
Business Object.

To create an Actions menu:

1. Open the Business Object Actions window for a Business Object:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Menu page.

3. Add Actions to the Business Object Actions menu:
a. Click the Add Action button.

Tip: Click the Delete button to remove a selected Action from the list. Use the Up/Down
arrowsto change the order of the selected Actions.

b. Select Actions to add to the menu:
◦ Add One-Step Action Action: Opens the One-Step Action Manager, where you can select

an existing One-Step Action or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing Dashboard or create a new one.

◦ Add Report Action: Opens the Report Manager, where you can select an existing Report
or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
Calendar or create a new one.

◦ Add Search Action: Opens the Search Manager, where you can select an existing Saved
Search or create a new one.

◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing Visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an existing
Action Catalog Widget or create a new one.

◦ Add Folder: Adds a folder so that you can organize Actions into subcategories.
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4. Define general properties for each new Action:
◦ Action: Displays the name of the Action as it is recognized by CSM (ex: Name of a

Dashboard).

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Display text: Provide text to display on the Action.

◦ Image button:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the Action.

5. (Optional) Define Expressions for conditionally displaying and enabling the Action:
◦ Visible: Select this check box to show/hide the Action based on an Expression. Then, select or

define an Expression, using either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the Action based on an Expression. Then,
select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

6. Define additional options for the Action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the User's

selected style) before the toolbar item, separating it from other Actions on the toolbar.

7. Select OK.7.

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Task Pane Actions for a Business Object
Use the Task Pane page in the Business Object Actions window (accessed from the Object Manager
within the Blueprint Editor) to define actions that appear in the CSMDesktop Client Task pane for a
particular Business Object (ex: Incident). Users can select these actions from a Business Object-specific
Actions section in the CSM Desktop Client Task pane (example: Incident Actions) when working with
records for a particular Business Object.

Good to Know:

• If you are configuring a Business Object that was previously applied as part of a Protected mApp™
Solution:

◦ You see a shield icon  next to each content-protected action.

◦ You can add new actions and new print options and you can reorder actions in the list.

◦ Some actions are not available to users in the Structure area when a Business Object is
content-protected: Delete Business Object, Delete Approvals, Convert to Group Object
and Delete Group.

To add actions to a Business Object Task pane:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, select the Blueprints category, and then select the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, select a Business Object in the Object tree, and then select the Edit
Actions task in the Structure area.

2. Select the Task Pane page.

3. Add actions to the Business Object Task pane:

Tip: Select Delete to remove a selected action from the list. Use the Up/Down arrows to
change the order of the selected actions.

a. Select Add Action.

b. Select actions to add to the menu:
◦ Add One-Step Action Action: Opens the One-Step Action Manager, where you can

select an existing One-Step Action or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing dashboard or create a new one.
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◦ Add Report Action: Opens the Report Manager, where you can select an existing
report or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
calendar or create a new one.

◦ Add Search Action: Opens the Search Manager, where you can select an existing
saved search or create a new one.

◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an
existing Action Catalog Widget or create a new one.

◦ Add Folder: Adds a folder so that you can organize actions into subcategories.

4. Define general properties for each new action:
◦ Action: Displays the name of the action as it is recognized by CSM (example: Name of a

dashboard).

Tip: Select the ellipsis to open the Action Manager and select a different action.

◦ Display text: Provide text to display on the action.

◦ Image button:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the action.

5. (Optional) Define expressions for conditionally displaying and enabling the action:
◦ Visible: Select this check box to show/hide the action based on an expression. Then, select or

define an expression, using either:
◦ Stored Expression: Select the ellipsis to open the Expression Manager, and then select

an existing stored expression or create a new stored expression. Stored expressions can
be reused in numerous places in CSM.

◦ Custom Expression: Select Custom Expression  to open the Custom Expression
Builder, and then create a custom expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the action based on an expression. Then,
select or define an expression, using either:

◦ Stored Expression: Select ellipsis button to open the Expression Manager, and then
select an existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select Custom Expression  to open the Custom Expression
Builder, and then create a custom expression specifically for this scenario.

6. Define additional options for the action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the

user's selected style) before the toolbar item, separating it from other actions on the toolbar.
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7. Select OK.7.

8. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define Toolbar Actions for a Business Object
Use the Toolbar page in the Business Object Actions window (accessed from the Object Manager within
the Blueprint Editor) to create a special Actions toolbar for a Business Object. Users can display the
Actions toolbar as part of the CSM Desktop Client toolbar and select Actions on it when working with
records for a particular Business Object.

To create an Actions toolbar:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Toolbar page.

3. Add Actions to the Actions toolbar:
a. Click the Add Action button.

Tip: Click the Delete button  to remove a selected Action from the list. Use the Up/Down
arrows to change the order of the selected Actions.

b. Select Actions to add to the toolbar:
◦ Add One-Step Action Action: Opens the One-Step Action Manager, where you can select

an existing One-Step Action or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing Dashboard or create a new one.

◦ Add Report Action: Opens the Report Manager, where you can select an existing Report
or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
Calendar or create a new one.

◦ Add Search Action: Opens the Search Manager, where you can select an existing Saved
Search or create a new one.

◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing Visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an existing
Action Catalog Widget or create a new one.

◦ Add Folder: Adds a folder so that you can organize Actions into subcategories.
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4. Define general properties for each new Action:
◦ Action: Displays the name of the Action as it is recognized by CSM (ex: Name of a

Dashboard).

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Display text: Provide text to display on the Action.

◦ Image button:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the Action.

5. (Optional) Define Expressions for conditionally displaying and enabling the Action:
◦ Visible: Select this check box to show/hide the Action based on an Expression. Then, select or

define an Expression, using either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the Action based on an Expression. Then,
select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

6. Define additional options for the Action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the User's

selected style) before the toolbar item, separating it from other Actions on the toolbar.

◦ Show Text on Button: Select this check box to show the display text on the button along with
the image. Clear this check box to only show the image.

7. Select OK.7.

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Context Menu Actions for a Business Object
Use the Context Menu page in the Business Object Actions window (accessed from the Object Manager
within the Blueprint Editor) to define context menu Actions for a Business Object. Users can right-click on
a Business Object record in a Grid or search results list (including Grids/search results shown on a
Dashboard) to access a context menu with the defined Actions.

Note: The way in which context menu Actions are made available differs in the Browser Client.
For more information, refer to the Browser Client Documentation.

To create a context menu for a Business Object:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Context Menu page.

3. Add Actions to the Business Object Actions context menu:
a. Click the Add Action button.

Tip: Click the Delete button  to remove a selected Action from the list. Use the Up/Down
arrows to change the order of the selected Actions.

b. Select Actions to add to the context menu:
◦ Add One-Step Action Action: Opens the One-Step Action Manager, where you can select

an existing One-Step Action or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing Dashboard or create a new one.

◦ Add Report Action: Opens the Report Manager, where you can select an existing Report
or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
Calendar or create a new one.

◦ Add Search Action: Opens the Search Manager, where you can select an existing Saved
Search or create a new one.
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◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing Visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an existing
Action Catalog Widget or create a new one.

◦ Add Folder: Adds a folder so that you can organize Actions into subcategories.

4. Define general properties for each new Action:
◦ Action: Displays the name of the Action as it is recognized by CSM (ex: Name of a

Dashboard).

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Display text: Provide text to display on the Action.

◦ Image button:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the Action.

5. (Optional) Define Expressions for conditionally displaying and enabling the Action:
◦ Visible: Select this check box to show/hide the Action based on an Expression. Then, select or

define an Expression, using either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the Action based on an Expression. Then,
select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

6. Define additional options for the Action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the User's

selected style) before the toolbar item, separating it from other Actions on the toolbar.

7. Select OK.7.

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Print Options for a Business Object
Use the Print Options page in the Business Object Actions window (accessed from the Object Manager
within the Blueprint Editor) to define One-Step Actions or Reports that can be run from a Business
Object's Print menu. Users can select these Actions from the CSM Desktop Client menu bar (File>Print)
when working with records for a particular Business Object.

To define print options:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Print Options page.

3. Add Actions to the Business Object's Print menu:
◦ Click the Add button to open the Action Manager. Then, select a One-Step Action or Report,

or create a new one.

◦ Click the Remove button to remove a selected Action from the list.

◦ Click the Make Default button to make the selected One-Step Action or Report the option the
default selection when a User clicks Print from a Business Object's file menu. This is also the
print option that will run (without prompting) when a User clicks the Print button on the toolbar.

◦ Use the Up/Down arrows to change the order of the selected options.

4. Select OK.4.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Automatic Actions for a Business Object
Use the Automatic Actions page in the Business Object Actions window (accessed from the Object
Manager within the Blueprint Editor) to set up One-Step Actions that automatically run when a Business
Object is created, saved, or changes status.

Good to know:

• Although any One-Step Action can be executed as part of an automatic Action, we recommend
using only One-Step Actions that do not require User feedback because Business Objects can be
created and saved without User interaction. For example, the E-mail and Event Monitor can
automatically create and save records.

To create a list of Automatic Actions:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If you are working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Automatic Actions page.

3. Add Actions to the list of the Automatic Actions:
a. Select a category (Create Actions, Save Actions, or State Change Actions).

b. Click the Add button  to open the One-Step Action Manager, and then select an existing
One-Step Action or create a new one.

c. Select OK.c.

4. Define general properties for each new Action:
◦ Action: Displays the name of the One-Step Action as it is recognized by CSM.

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Notes: Provide information that further describes or clarifies the Automatic Action. If the One-
Step Action has a description, it is displayed here.

◦ Condition: Select this check box to have the Automatic Action executed based on a condition,
and then select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.
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◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Show Progress: Select this check box to have CSM display a progress indicator while the
One-Step Action is running.

5. Define when the Automatic Action will be executed:

Note: Create Actions do not have additional options for determining when they are
executed. They are always executed when a new Business Object record is created.

◦ For Save Actions:
◦ Execute on First Save: Select this check box to have the Action automatically executed

for newly created records.

◦ Execute on Additional Saves: Select this check box to have the Action automatically
executed when saving existing records.

◦ Execute Before Saving Record: Select this check box to have the Action automatically
executed immediately before the Business Object record is saved.

Note: Certain options within a One-Step Action will not occur when it is used as an
automatic Action. For example, if a One-Step Action is run before the record is saved
and includes the option to save the current record, the record will not be saved twice.
Also, if the One-Step Action initiates a save, the Actions will not be rerun a second (and
possibly recursive) time.

◦ For State Change Actions:
◦ State: In the drop-down, select the status that will trigger the Automatic Action.

◦ Execute Before Saving Record: Select this check box to have the Action automatically
executed when the Business Object record changes to the selected status. Clear this
check box to have the Action automatically executed when the Business Object record is
saved after reaching the selected status.

6. Select OK.6.

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Related information
Problem: The field [BusinessObject].[Fieldname] must be filled in before the record can be saved
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Troubleshoot Actions for Automation Processes
Learn about potential issues that may occur while using actions in Automation Processes and how to fix
them. If you have an issue that is not listed, contact Cherwell Support for assistance.
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Problem: The field [BusinessObject].[Fieldname]
must be filled in before the record can be saved

When using an Automatic Action in the CSM Portal that is set up to run before save, the action won't run
before saving the record and you get an error.

Summary of error scenario:

1. A new field has been added to a Business Object and Required for Save selected in Field
Properties.

2. An automatic Save action was added to the Business Object and Execute before saving record
was selected.

3. A One-Step™ Action was created with an Update Business Object step where the newly created
field was updated.

4. In the CSM Portal, an Incident was submitted. You see this error: The field
[Business.Object].[Field] must be filled in before the record can be
saved

Solution: Put validation inside the Automatic Action or ensure that users can
complete required fields before saving

Here, the system is configured to require that a field be saved, so that implies that the field must be filled
out by the user before they select the Save button. This is protection that CSM provides to prevent the
entry of bad data.

Validation for required fields happens when the Save button is selected (or the Save command is
triggered). This happens before any Automatic Actions have the chance to run. Automatic Actions do not
occur prior to this validation, even if the Execute before saving record check box is selected. So the
flow of events is as follows:

User selects Save -> Validation occurs -> Automatic Action runs -> Record is saved.

If you have a field that is not accessible by the user, and it is being populated in some other way
(example: by using an Automatic Action), then by making this field required you are risking a poor user
experience. So, best practice in this case, would be to handle that inside the automatic action by checking
if the field's value is what is expected, and going back to the user if it isn't.

Solutions Summary

• If a field is inaccessible to the user, making it required may result in a poor user experience. It will•
also limit their ability to fill in the required field, and as a result prevent them from saving the record.
To prevent this happening, perform any validation inside of the Automatic Action.

• If a field is required for save, it is best practice to have the field accessible to the user so they can fill•
it in before saving the record.
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Scan a Business Object
Use the Business Object Scan operation in the Object Manager to periodically check for potential errors in
a Business Object that you are creating or editing. The scan will look for missing items and alert you to
any changes you need to make.

To scan a Business Object:

1. Open the Object Manager.

2. Click a Business Object in the Object tree, and then click the Scan for Problems task in the
Structure area.

If the scan is successful, a success window opens.

If the scan detects errors, an error window opens.

Examples: You will receive warnings if you create a Business Object without also creating a Form
and Grid, if the Business Object does not contain the necessary Fields (ex: It must have an E-mail
Address field to be included in the CSM Address Book), a Form references a Field that has been
deleted, the Business Object does not have any database indexes, etc.
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Undo Business Object Changes within a Blueprint
Use the Undo Changes Made in Blueprint operation in the Object Manager to undo any changes you
have made to a Business Object within a work in progress Blueprint. This removes all Business Object
changes (within a particular Business Object View) from a Blueprint file before it has been published.

Good to know:

• The Undo Changes Made in Blueprint operation is available only for Business Objects that have
been edited within the open Blueprint.

• Undoing changes to a Business Object only removes the changes from a working Blueprint file. If
you have published the Blueprint, the changes have already been applied to your system and can
only be removed using a rollback Blueprint (created when you publish a Blueprint). Publish a
Rollback Blueprint file to undo changes made after the Blueprint has been published.

• An Edit icon, along with italicized text and an asterisk, indicates which Business Objects have been
changed within the open Blueprint (in the selected View). For example,  indicates that
the Incident Business Object has been edited.

To undo Business Object changes:

1. Open the Object Manager

2. Select the Business Object View in which the Business Object changes were made.

3. Click a Business Object in the Object tree, and then click the Undo Changes Made in Blueprint
task in the Structure area.

4. Click Yes to remove the Business Object changes from the working Blueprint file. This also removes
any changes to Forms, Grids, Form Arrangements, Relationships, and Actions within the Blueprint.
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Add a Business Object to a Blueprint
Use the Add to Blueprint operation in the Object Manager to add a Business Object and its associated
Forms, Grids, and Form Arrangements to a Blueprint. Items added to a Blueprint will completely overwrite
the existing ones in your system when the Blueprint is published.

To add a Business Object to a Blueprint:

1. Open the Object Manager.

2. Click a Business Object in the Object tree, and then click the Add to Blueprint task in the
Structure area.

3. Define which Business Object definitions to include in the Blueprint:
◦ Add Business Object: This check box is read-only. It indicates that the Business Object is

included in the Blueprint.

◦ Add Associated Relationships: Select this check box to add the Business Object's
Relationships to the Blueprint.

◦ Add Associated Forms: Select this check box to add the Business Object's Forms to the
Blueprint.

◦ Add Associated Grids: Select this check box to add the Business Object's Grids to the
Blueprint.

◦ Add Associated Arrangements: Select this check box to add the Business Object's Form
Arrangements to the Blueprint.

◦ Add to Associated Views: Select this check box to add the Business Object to associated
views (example: Portal view) when adding to the Blueprint.

4. Select OK.4.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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View Blueprint Changes for a Business Object
View Blueprint changes for a Business Object to see which definitions associated with a particular
Business Object will be changed by the active Blueprint when it is published. When you view Blueprint
changes for a Business Object, you can:

• Select how to display changes (group by Business Object, Definition Type, or View).

• Search for specific Business Object changes.

• Remove Business Object changes from the Blueprint.

• Compare the Business Object changes with the original system definitions.

Note: The Blueprint Changes window for a particular Business Object is similar to the
Blueprint Changes window, except that it only shows changes that were made to a particular
Business Object within a Blueprint.

The Blueprint Changes window for a Business Object can be opened from the Object Manager within an
existing Blueprint.

To open the Blueprint Changes window for a Business Object:

1. In CSM Administrator, open an existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. Click a Business Object in the Object tree, and then click the View Blueprint Changes for
<Business Object> task in the Structure area.

Note: The View Blueprint Changes for <Business Object> operation is only available if
changes have been made to the selected Business Object within the open Blueprint.
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1. Display: Groups changes in the tree by Business Object, Definition, or View.
◦ By Business Object: Groups changes by the Business Object.

◦ By Definition Type: Groups changes by the types of definitions associated with the Business
Object (ex: Forms).

◦ By View and then Business Object: Groups changes by View (ex: Default, Portal Default) and
then by Business Object.

◦ By View and then Definition Type: Groups changes by View (ex: Default, Portal Default) and
then by the types of definitions associated with the Business Object (ex: Forms).

2. Search: Searches for changes by keyword or phrase.
a. In the Search Box, provide a word or phrase to search for. The drop-down displays the most

recently used (MRU) searches.

b. Click Go to run the search. The items containing the specified word or phrase are displayed
within their hierarchical structure.

3. Business Object Changes Tree: Displays changes in a hierarchical tree grouped by the selected
display option.

◦ Click the arrow next to a category (Business Object, Definition Type, or View) to expand it and
view its changes. Click the arrow again to collapse it.

Tip: Right-click a category or change to open a context menu, and then select options to
expand/collapse the tree, remove changes, or compare definitions.

4. Remove/Compare:
◦ Click Remove to remove a selected item from the Blueprint (it is not removed from the

system).

◦ Click Compare to compare the Business Object change with the existing system definition.
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Note: Remove and Compare are only enabled when an individual change is selected.
Changes cannot be removed or compared by selecting display categories (Business
Object, Definition Type, or View). A change can only be compared if an existing
definition is edited or updated in the Blueprint; newly added definitions cannot be
compared (there is nothing to compare them to).
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Export a Business Object Schema
A Business Object Schema is a collection of meta-data that is exported from your system as a single
document (.html, .rtf, .txt, or .xml) to textually expose definitions associated with a particular Business
Object. Use a Business Object Schema to quickly and easily scan the characteristics of a Business
Object.

Note: To export a Schema that contains meta-data for multiple Business Objects within a
Blueprint, refer to Export a Blueprint Schema.

You can export the following meta-data for a Major, Supporting, or Lookup Object:

• Properties

• Lifecycle

• Fields (and Field Properties)

• Relationships (and Relationship properties)

• One-Step Actions

• Approvals

• Automation Processes

To export a Business Object Schema:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Export
Business Object Schema task in the Structure area.

CSM 2022.3 Features 221

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=export_a_blueprint_schema
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=open_an_existing_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=blueprint_editor


3. Select the items (meta-data) to export in the Schema:
◦ Business Object Properties

◦ Business Object Lifecycle

◦ Fields

◦ Relationships

◦ One-Step Actions

◦ Approvals

◦ Automation Processes

4. Select OK.4.

5. Provide a location, filename, and file type (.html, .rtf, .txt, or .xml) for the Schema, and then click
Save.

The selected meta-data is exported to a Schema file. You can then open and view the Business
Object Schema in a viewing tool, such as Microsoft Word.
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View the Business Object Publish Log
Use the Business Object Publish Log to view detailed information about definitions associated with a
particular Business Object that have been published to your system (using a Blueprint).

Note: The Business Object Publish Log is similar to the Blueprint Publish Log, except that it only
shows changes that were made to a particular Business Object within one or more Blueprints.

The log tracks the following details in a Grid:

• A short description of the change made to a Business Object's definitions when the Blueprint was
published.

• Type (ex: Form) and name (ex: Incident) of the Business Object definitions that were changed.

• User Name of the person who published the Blueprint.

• Dates/times that the Blueprint publish was initiated and completed.

• Scope of the Business Object definition, as well as the scope owner (if applicable).

• User-defined name of the Blueprint file (.bp) in which the Business Object changes were published.

• Business Object association (the name of the Business Object for which you are viewing the Publish
Log).

• The view (ex: Portal Default) that the Business Object changes apply to (if applicable).

• The path where the Blueprint files were saved (if applicable).

The Business Object Publish Log can be opened from the Object Manager within a Blueprint.

To open the Business Object Publish Log:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. Click a Business Object in the Object tree, and then click the View Publish Log task in the
Structure area.

The Publish Log opens for the selected Business Object.
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1. Menu Bar. Click the File menu to perform the following operations:
◦ Clear Log: Select this option to clear all entries in the log, or to clear all entries prior to a

specified date.

◦ Export: Select this option to export the Grid of Publish Log data to a file.

◦ Print: Select this option to print the Grid of Publish Log data.

◦ Close: Select this option to close the Publish Log window.

Tip: You can also select Clear Log, Export, and Print in a context menu by right-clicking an
item in the Publish Log.

2. Toolbar: Shows the View drop-down, which is how the Publish Log is filtered.
◦ All Records: Shows everything related to a Business Object that was published in a Blueprint.

◦ Definition Type: Shows all Business Object definitions of a particular type (ex: Form). When
selecting this option, a Definition drop-down is displayed on the toolbar, and then select a
definition type.

◦ Only Definition Changes: Shows only the Business Object definitions that were changed by
a published Blueprint.
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◦ Particular User: Shows the Business Object definitions that were published by a particular
User. When selecting this option, a User drop-down is displayed on the toolbar, and then
select a User.

◦ View: Shows the Business Object definitions that apply to a particular View (ex: Default).
When selecting this option, a View drop-down is displayed on the toolbar, and then select a
View.

3. Refresh: Click this button to refresh the data in the Publish Log.

4. Main Pane: Displays the Grid of Publish Log data, filtered by View.
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Convert to a Group Business Object
Share a set of common items (Fields, Relationships, Actions, and a default Grid) with other Business
Objects by converting any Major or Supporting Business Object into a Group Object.

Convert a Business Object to a Group Object from a Blueprint or from a mApp Solution.

After the conversion:

• The converted Business Object becomes a Group Member of a newly created Group Object.

• All relevant properties of the converted Business Object are applied to the Group Leader. This
includes items such as Fields, stored Expressions, and Relationships.

• Security settings for the converted Business Object, including rights, are applied to the newly
created Group Leader. You may receive warnings about security changes when you publish the
Blueprint. You can ignore these warnings.

• All existing records in the converted Business Object are associated with the new Group Member.

• The newly created Group Leader is given the name of the converted Business Object and a new
Business Object ID. "Default" is appended to the name of the converted Business Object, which
retains its Business Object ID. You can change these default names as needed.

Converting a Business Object to a Group Object

Tip: Before you convert, modify the security rights for the Business Object you plan to convert so
that all records, even closed records, can be updated. If you do not, you will receive a warning
indicating that some records could not be converted due to an issue with security rights.

To convert a Business Object to a Group Object:

1. Create a Blueprint or mApp Solution.

2. Open a Business Object in the Object Manager.

3. Select the Major Business Object or Supporting Business Object that you want to convert.

4. Verify that the Business Object you want to convert includes the items you want to be inherited by
Group Members.

5. From the tasks pane, select Convert to Group Object.
6. Click Yes to confirm that you want to convert the Business Object.

Related concepts
Group Business Objects
Open the Object Manager
Define Group Properties for a Business Object
Related tasks
Create a Blueprint
Report on Groups with Relationships with Themselves
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Configuring Business Objects
To use Business Objects for managing data and to use features like delegation, you need to configure
Business Objects using CSM Administrator.

To configure Business Objects in CSM Administrator, use the Business Objects tab in the Security
Group Manager to define access to data for a Security Group. See Define Business Object Rights
(Access to Data).

To configure users' ability to manage delegates, select Manage delegates from the Users category as
described in Users Security Rights. Then select your choice of check boxes from View, Add, Edit,
Delete.
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Business Object Lifecycles
A Business Object lifecycle controls how work flows through your business processes. For example, what
actions a technician needs to take to fix an Incident, or what actions an HR staff member needs to take to
grant a sabbatical to an employee. Lifecycles can be associated with any Major or Supporting Business Object
and some Group Business Objects.
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About Business Object Lifecycles
Use Business Object lifecycles to manage workflows for business processes (example: Incident
Management, HRSM).

When you define a lifecycle for a Business Object, you determine what statuses and stages an item
passes through when a user works with it. For example, you could set up a lifecycle for the Change
Request Business Object that has stages such as Assessment and Authorization, and statuses such as
Draft, Risk Analysis, and Planning.

You can set up a lifecycle for any Major or Supporting Business Object and some Group Business
Objects. Lifecycles comprise statuses and stages, jumps and transitions.

Note: Only Administrators can see and change Business Object Lifecycles.

Example lifecycles include:

• Incident Resolution (IT Services Management).

• Change Request Resolution (IT Services Management).

• Onboarding Process (Human Resources Services Management).

Note: Business Objects and their associated lifecycles and form changes, are all managed within
a Blueprint. To commit changes to your system, you must publish the Blueprint.

Related concepts
About Statuses and Stages
About Transitions
Migrate a Business Object Lifecycle
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About Statuses and Stages
A Business Object lifecycle comprises statuses, stages, and transitions.

At a minimum, you need two statuses and one stage to make up a lifecycle. One of the stages must be
marked as the final stage.

Statuses
Use statuses to describe each step that an item has to go through in a lifecycle in order to complete a
business process. For example, an Incident could have multiple statuses including: Open, In Progress, In
Test, and Closed. After adding a status, you see a default status name (example: Status 2) inside the box
that you can then change to fit your lifecycle. It can be useful to think about statuses as being adjectives
that describe the current state of a record.

• A status can only be associated with one stage.

• You cannot have duplicate status names (example: Open, OPEN and open are duplicates).

• Status names can be 1 - 32 characters in length.

Stages
Use stages to group statuses together (example: statuses Approval and Rejected could be part of stage
Authorization). After adding a status to a lifecycle, the stage or grouping is the name shown across the
top of the box.

Within each box/stage, you associate a status.

• A stage can be associated with one or more statuses.

• You cannot have duplicate stage names (example: Authorization, AUTHORIZATION and
authorization are duplicates).

• Stage names can be 1 - 32 characters in length.

Tip: In both the CSM Desktop and Browser clients, use the Column Selector to add either status
and/or stage columns, and then filter on those lifecycle columns to show selected data (example:
All the records in status In Test).

Related concepts
Open the Lifecycle Editor
About Transitions
Filter a Grid in the CSM Browser Client
Related tasks
Add and Remove Columns from a Grid in the Browser Client
Filter a Grid in the Desktop Client
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About Transitions
Use a transition to define the task that changes the status of the Business Object within a Business
Object lifecycle.

When you add a status using the Lifecycle Editor, a transition is added linking the current and previous
statuses. The list of created transitions you see in the Transitions area matches the representation on
the designer board (example: four statuses results in three transitions 1 -> 2 -> 3 -> 4).

Think about statuses being adjectives that describe the current state of a record (example: Closed, In
Progress, Awaiting Approval) and transitions as verbs that act on the record resulting in the state being
changed (example: Close, Begin Work, Approve).

Transition Rules
Use transition rules to add expressions to a transition.

• You can have no rules or multiple rules associated with a transition.

• When you create a transition rule, it has to have a name and a logical outcome defined by one
expression (stored or custom).

• For a transition rule to be fulfilled, all conditions must be true in the expression.

• No two rules within the same transition can have the same name assigned.

• Transition name length is restricted to a maximum of 32 characters.

• Important: How you name your transition rule is very important for users. This is because•
the name of the transition rule is shown in the Transition Status Control on the form if a
transition is invalid. When a user hovers over an unavailable transition, the name of the rule
can give them information on what they need to update so the transition can succeed (“Risk
Assessment Incomplete” or “Planning Fields Incomplete").

Transitions and Approvals
You can add approvals to your Business Object lifecycle. This means that an object cannot be
transitioned between specified states without being approved or denied by a specified user or user group.
For example, your transition, between statuses Pending Approval and Approved, could be named
Approve.

The approved/denied selections can be optionally linked to specific paths in the lifecycle. A successful
approval must be linked to at least one specified status and only allowed to transition when the approval
is provided. If an approval is denied, the object can move to any status that is not linked to the 'successful'
approval.

• For example, you can create an expression for Approval.Status Equals Approved OR .Approved
Date and Time Not Empty.

• Denial of an approval forces the Business Object down a path that doesn't require a successful
approval.
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• The form control for approvals must be on the Business Object form.

Note: When a Business Object is created that has a lifecycle, a journal entry records that fact.
The initial status is recorded along with changes in status, user details, and time stamps.

Related concepts
Migrate a Business Object Lifecycle
Managing Business Object Lifecycles
Configure Business Object Lifecycles
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Managing Business Object Lifecycles
Business Object lifecycles are managed using the Business Object Lifecycle Editor.

Use the Business Object Lifecycle Editor to create and manage lifecycles for your business processes
(example: ITSM processes, HRSM processes).
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Open the Lifecycle Editor
Open the Lifecycle Editor from the Object Manager (within a Blueprint in CSM Administrator).

1. In the CSM Administrator main window, select the Blueprints category, and then select the Create
a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, select a Major or Supporting Business Object in the Object tree, and then
select the Edit Lifecycle task in the Structure area.

The Lifecycle Editor opens showing the designer board.

Related concepts
Open an Existing Blueprint
Blueprint Editor
Object Manager
Related tasks
Create a Blueprint
Related information
Add Statuses and Stages
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Add Statuses and Stages
Add statuses and stages to your Business Object lifecycle to represent your business process.

Use the Lifecycle Editor (accessed from within a Blueprint in CSM Administrator) to add stages and
statuses. At a minimum, you need one stage and two statuses to make up a lifecycle. One of the statuses
must be marked as the final stage.

Tip: You can have multiple final statuses (example: Closed Done, Closed Won't Do, Closed
Duplicate) but you cannot have multiple final stages.

1. Drag a status on to the yellow cross on the designer board.
A box appears with default status and stage names.

2. In the Status section of the Properties area, select Status 1 in the Status Name field and rename
the status to your choice of name (example: Emergency Change). Select Tab or Enter to apply your
name change to the box.

3. Select the New Stage button and change the name of the stage to your chosen name (example:
Classification). Select Tab or Enter to apply your name change to the box.
The stage name displays in the box and the stage changes color. The stage name is also added to
the drop-down list.

4. Optional: Repeat steps 1-3 until you have all the statuses and stages you need to complete your
lifecycle.

Note: When a status is dropped between stages, it adopts the name & color of the previous
stage.

When choosing stage names from the drop-down list, you see a logically available list depending on
the location of the status in the lifecycle.

5. Highlight the stage that you want to be the final one and select Set Final Stage.
The banner across the box changes color to show that the stage is the final one in the lifecycle.

6. Select Save on the toolbar (or select Ctrl+S) to save your lifecycle while working. Select OK at the
end when editing is complete and you want to save your lifecycle and close the Lifecycle Editor.
If not valid, you are not allowed to save and are asked to fix the issues. See Validate a Lifecycle.

7. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Open the Lifecycle Editor
About Blueprints
Related information
Manage Transitions
Add Branches and Jumps
Add a Post-Transition Action
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Manage Transitions
Transitions between statuses in a Business Object lifecycle can be used to carry out simple or complex
actions.

Use the Lifecycle Editor (accessed from within a Blueprint in CSM Administrator) to add or edit transitions.
Default transitions are automatically added when you connect a status to another status on the designer
board. If you define a transition from one status to multiple statuses, you are asking users to make a
choice at that point in a business process (example: Accept or reject a Change Request).

To add/edit a transition:

1. Open an existing lifecycle in the Business Object Lifecycle Editor.
2. Select the status for which you want to edit the transition.
3. Select the transition in the Transitions area and then select Edit.
4. On the Properties tab, change the name of the transition (example: Send for Approval).

Think of statuses as being adjectives that describe the current state of a record (example: Closed, In
Progress, Awaiting Approval) and transitions as verbs that act on the record resulting in the state
being changed (example: Close, Begin Work, Approve).

Tip: The transition name is the text that is displayed to the user on the Transition Status
control so make it as clear as possible.

5. On the Rules tab, select  to add a new transition rule using expressions. Select  to edit an
existing transition rule.

6. Enter a name for your transition rule (example: ECAB Approval is required).

Important: How you name your transition rule is very important for users. This is because
the name of the transition rule is shown in the Transition Status Control on the form if a
transition is invalid. When a user hovers over an unavailable transition, the name of the rule
can give them information on what they need to update so the transition can succeed (“Risk
Assessment Incomplete” or “Planning Fields Incomplete").

7. Select the ellipsis to choose an existing expression from the Expressions Manager or select  to
create a custom expression. See Create an Expression.
Any logical expression can be used as a valid transition rule but you cannot use stored expressions
which don't have a logical return type.

8. Select Hide transition on failure if necessary.
Select this option to hide the transition from the user if it fails. Use this option when the rule detects
a record that is not targeted for that branch of the lifecycle and so it will always fail.
For example, use this option in the following situation: You are creating a lifecycle for users to create
change request tickets. The ticket has paths or "routes", one for each priority level (example:
Emergency, Normal, Standard). If the transition relies on a ticket of a certain priority to pass, all
tickets that don't fulfill this rule will always fail; and, therefore you wouldn't want to display that
transition.

9. Select OK twice.
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10. Select Save on the toolbar (or select Ctrl+S) to save your lifecycle while working. Select OK at the
end when editing is complete and you want to save your lifecycle and close the Lifecycle Editor.
If not valid, you are not allowed to save and are asked to fix the issues. See Validate a Lifecycle.

11. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Open the Lifecycle Editor
About Blueprints
Related tasks
Define a Logical Expression
Related information
Add Branches and Jumps
Add a Post-Transition Action
Validate a Lifecycle
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Add Branches and Jumps
Use branches and jumps to customize your Business Object lifecycle.

Use branches to add divergent routes to your lifecycle. For example, for a Change Request lifecycle, you
could have a branch for a Normal Change, another for an Emergency Change, and another for a
Standard Change. Jumps allow you to go backwards through your lifecycle (example: if something is
rejected or to reopen a Closed ticket.), skip ahead, jump to another, or to close off a lifecycle. In practice,
branches give the users a choice of where to go next when using the Transition Status Control (example:
Reject or Approve).

Note: All branches need to be in one workflow. For example, if you want your users to choose
between the three types of Change Request when they create a new Change Request, you
cannot have three separate lifecycles for Normal Change Requests, Standard Change Requests,
and Emergency Change Requests.

The following steps refer to example statuses from the image below. To see all the steps to replicate the
section of this lifecycle marked by the red line, see Example: Create a Lifecycle.

To add a branch to a lifecycle:

1. Open an existing lifecycle in the Lifecycle Editor.
2. Drag a status on top of an existing status (example: Risk Analysis).

A branch appears as shown below. Here, it has been named as status On hold.
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Note: When you add branches, the transition information is added for you. In this example,
there are transitions added for Risk Analysis -> Planning and Risk Analysis -> On hold.

To replicate the two-way arrows shown on the workflow above, for example, between statuses Risk
Analysis and On hold, you need to use a jump.

To add a jump to a lifecycle:

3. Drag a jump on to your lifecycle and drop it on to your source status (example: Planning).
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4. Then drag the brown cross onto your destination status, in this case, On hold.

There is now a jump or two way arrow between the statuses Planning and On hold. You can tell
which statuses are joined together by a jump by matching up the pairs of jump numbers.

Tip: If you add multiple jumps which go to the same destination they all have the same jump
number.
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5. Select Save on the toolbar (or select Ctrl+S) to save your lifecycle while working. Select OK at the
end when editing is complete and you want to save your lifecycle and close the Lifecycle Editor.
If not valid, you are not allowed to save and are asked to fix the issues. See Validate a Lifecycle.

6. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related information
Add a Post-Transition Action
Validate a Lifecycle
Delete Parts of a Lifecycle
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Add a Post-Transition Action
Add One-Step™ Actions and other actions to execute after transitions in your Business Object lifecycle.

Use the Lifecycle Editor (accessed from within a Blueprint in CSM Administrator) to add post-transition
actions to your lifecycle.

1. Open an existing Business Object lifecycle in the Business Object Lifecycle Editor.
2. Select the status on the designer board that you want to add the post-transition action to.

The Transitions area is shown below the designer board.
3. Select the transition that you want to add the action after, and select Edit.

The Edit Transition window opens.

4. Select the Post Actions tab, ensure the rule is selected, and then select Edit .
5. Add a One-Step Action or select Execute Action and choose from the expanding list.

When you select Execute Action, you can select a "Direct Action" (as opposed to a One-Step
Action ), that should be executed automatically, when some event takes place. For more
information, see Define Actions for a Simple Action/Event Automation Process.

6. Select the Run in background check box if you are using actions that don't modify the Business
Object itself (example: sending emails, adding to queues). When the check box is selected, the
Service Host performs the actions in a queue, whereas when the check box is cleared, the action is
performed instantly (example: automatically populate a field).

Important: To execute post-transition actions successfully in the background, the Cherwell
Service Host must be running.

7. Select OK twice.
8. Select Save on the toolbar (or select Ctrl+S) to save your lifecycle while working. Select OK at the

end when editing is complete and you want to save your lifecycle and close the Lifecycle Editor.
If not valid, you are not allowed to save and are asked to fix the issues. See Validate a Lifecycle.

9. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related information
Validate a Lifecycle
Delete Parts of a Lifecycle
Delete or Move Jumps
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Validate a Lifecycle
Validation ensures that your lifecycle works correctly and doesn't create errors for your users.

Validation automatically checks the following for you every time you change your selection in the designer
board, select Save or select OK:

• That duplicate names for stages and statuses are not allowed - this is checked in real time and not
on save.

• That the lifecycle has no missing or invalid transitions.

• That all routes allow transition to a final stage which has been defined.

• That the final stage contains at least one status.

• That the lifecycle has an initial status defined.

• That all statuses are accessible in the lifecycle from one or more statuses.

Typical error messages include:

• Incomplete Transition - You have a transition that doesn't have a destination.

• Jump transition is not complete: [transition name] - There is no target set for a
jump.

• No final stage has been set - You need to mark a stage as final.

• Status has no route to final stage: [status name] - A branch does not a route
through to the final stage.

• No status exists in the final stage - The final stage is set, but it doesn't have a status.

• Transition [transition name] rule [rule name] expression is not logical -
The transition rule has an expression associated with it that is not logical.

• Transition [transition name] rule [rule name] expression does not exist -
There is no expression in the transition rule.

• Transition Status Control/Lifecycle Progress Indicator cannot be used
with this Business Object - Error message occurring during Blueprint scanning when a
form has one of the lifecycle controls on it but there is no lifecycle associated with that Business
Object.

Note: If you select OK and then select Yes to leave the Lifecycle Editor without saving the
lifecycle, unsaved changes are abandoned and the lifecycle returns to the point where it was last
successfully saved. This can be useful when you are building a big workflow that you are saving in
stages and you realize you made a mistake; you can discard the most recent set of changes and
carry on from a previously saved point.

Note: When the Lifecycle Editor is closed, unassigned stages are automatically deleted.

Related information
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Delete Parts of a Lifecycle
Delete or Move Jumps
Example: Create a Lifecycle
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Delete Parts of a Lifecycle
Remove one or more statuses from your lifecycle or delete the entire lifecycle.

To delete a status from a lifecycle:

1. Open an existing lifecycle in the Business Objects Lifecycle Editor.
2. Select the status that you want to delete.
3. Right-click and select Delete status or use the menu in the toolbar.
4. Select Yes or No when prompted for confirmation.

The status is deleted together with the associated transition.

Tip: If the initial status is deleted, the next status in the cycle becomes the initial one by
default.

To delete a status with its children:

5. As above but right-click and select Delete status and children or use the menu in the toolbar.
6. Select Yes or No when prompted for confirmation.

The stage/status and children are deleted.

To delete an entire lifecycle:

7. Select any stage or status in the lifecycle.
8. In the toolbar menu, select Clear entire lifecycle.
9. Select Yes or No when prompted for confirmation.

The entire lifecycle is deleted.
10. Select Save on the toolbar (or select Ctrl+S) to save your lifecycle while working. Select OK at the

end when editing is complete and you want to save your lifecycle and close the Lifecycle Editor.
If not valid, you are not allowed to save and are asked to fix the issues. See Validate a Lifecycle.

11. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Configure Business Object Lifecycles
Related information
Delete or Move Jumps
Example: Create a Lifecycle
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Delete or Move Jumps
Delete or move jumps to reconfigure your Business Object lifecycle.

To delete a jump from a lifecycle:

1. Open the lifecycle in the Business Object Lifecycle Editor.
2. Select the jump that you want to delete.
3. Right-click and select Delete jump.
4. Optional: Select Yes or No when prompted.

The jump is deleted.

Note: If you delete a status with a jump, the jump is also deleted.

To move a jump:

5. As above but right-click and select Move jump.
6. Drag the jump to a different starting status and then drop it.

The corresponding "end" jump number moves to the new destination status.
7. Select Save on the toolbar (or select Ctrl+S) to save your lifecycle while working. Select OK at the

end when editing is complete and you want to save your lifecycle and close the Lifecycle Editor.
If not valid, you are not allowed to save and are asked to fix the issues. See Validate a Lifecycle.

8. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Configure Business Object Lifecycles
Related information
Example: Create a Lifecycle
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Example: Create a Lifecycle
Here is an example to show you how to create part of a big lifecycle using the Business Object Lifecycle
Editor.

Use branches to add divergent routes to your lifecycle. Jumps allow you to go backwards through your
lifecycle (example: if something is rejected or to reopen a Closed ticket), to visit a status more than once,
and to close off a lifecycle.

To replicate this section of this lifecycle you need to use the following statuses, stages, branches,
jumps and transitions:

1. Open the Lifecycle Editor.
2. Drag a status on to the board to form an initial stage (not shown) and then drag another onto the

board to the right of that one.
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3. With the second stage still selected, go to the Properties area. Change the Status Name to Draft
and the Stage Name to Classification. Select Tab or Enter or click away to see the name
changes reflected on the designer board.

4. Drag another status on to the board to the right of Draft. Change the Status Name to Risk
Analysis and the Stage Name to Assessment.

Note: Select the New Stage button to name stages.

5. Now you need to add a branch to replicate the section shown in the image for the statuses
Planning and On Hold. Drag a status and add it to the right of Risk Analysis. Then drag and drop
another on top of Risk Analysis.
You see a branch as per step 6 but with default status names.

6. Change the Status Names to Planning and On hold. You don't need to change the stage name
because it was inherited from the previous stage.
Your branch should now look like this:

7. Now, add the statuses for Approval, Scheduled and Rejected using the same methods. These
three statuses are all part of stage Authorization.
Your lifecycle should now look like this:
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8. To clear the red warnings, you need to add a stage and mark it as final. Drag a status to the right of
Scheduled, select it and then select Set Final Stage in the Properties area.
Two of the red warnings disappear. If you hover over On Hold, you see a tool tip saying Status
has no route to final stage: On Hold. That warning can be fixed in a minute by adding
our jumps.

9. In the original image of the lifecycle you can see double-headed arrows and also a route from
Rejected all the way back to Draft. You need to recreate these in the Lifecycle Editor using jumps,
so the first jump will be between Planning and On Hold. Drag a jump onto the board and drop it on
to Planning.
You see this on your screen:

10. Then drag the brown cross onto your destination status, in this case, On Hold.
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There is now a jump or two-way arrow between the statuses Planning and On Hold. You can tell
which statuses are joined by a jump by looking for the matching pairs of jump numbers.

11. Add the final two jumps: from Rejected to Draft, and from On Hold to Risk Analysis.
When you are finished, your lifecycle should look like the one shown at the top of this page. Take a
moment to reflect on the visual differences and similarities between the two images, in particular
how jumps represent arrows.

12. Lastly you need to name the transitions. Think about statuses being adjectives that describe the
current state of a record (example: Closed, In Progress, Awaiting Approval) and transitions as verbs
that act on the record resulting in the state being changed (example: Close, Begin Work, Approve).
For our example lifecycle above, suggested transition names could be as follows:

Selected Status Transition Name (shown on Control) To Status

Draft Submit ticket Risk Analysis

Risk Analysis
Pass risk check Planning

Fail risk check On Hold

Planning
Submit plans for approval Approval

Put on hold On Hold

Approval
Pass approval checks Scheduled

Fail approval checks Rejected

On Hold Give go ahead Risk Analysis

13. Select Save on the toolbar (or select Ctrl+S) to save your lifecycle while working. Select OK at the
end when editing is complete and you want to save your lifecycle and close the Lifecycle Editor.
If not valid, you are not allowed to save and are asked to fix the issues. See Validate a Lifecycle.

CSM 2022.3 Features 250

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=validate_lifecycle


14. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Configure Business Object Lifecycles
Migrate a Business Object Lifecycle
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Configure Business Object Lifecycles
Lifecycle configuration tasks include adding controls to your forms and setting up reports to identify items
in specific statuses.

To configure Business Object lifecycles:

1. Decide whether users can edit items when in the final stages of a lifecycle or not. See Define
Business Object Rights (Access to Data).

2. Configure your forms so that users can access lifecycle functionality. See Add Lifecycle Controls to
a Form.

3. Set up any reports you require. An example of how to produce a report showing the number of open
Incidents within the Incident lifecycle and a breakdown of the current status of each record. See
Report on Business Objects Based on Lifecycle Status.
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Add Lifecycle Controls to a Form
Use the Form Editor to add lifecycle controls to your forms. This enables a user to move their Business
Object (example: Incident, Change Request, HR request) through its business process.

Important: You need to add form controls to ALL the forms for the Business Object so that the
controls display. This is due to a sizing restriction.

Note: If you add a lifecycle control to more than one place on a form, or you add them to several
forms in a form arrangement, they all update simultaneously with the same lifecycle information
when you change one of the form controls.

There are two lifecycle controls:

• Lifecycle Progress Indicator: This control is read-only and reflects where the user is, in terms of
the lifecycle status and stage, and as a result, also shows the user which branch of a lifecycle they
are in. It shows the user where they are now as well as the statuses ahead of them. If the workflow
is a long one, the lifecycle progress indicator control shows only the previous status, the current
status, and the next two future statuses. This "mini-view" of these four stages moves forward as the
user moves through the lifecycle. The uppermost branch is shown until the user makes a decision
that takes them on to a different branch, after which the progression forward for that branch is
shown.

• Transition Status Control: Use the Transition Status Control to move between statuses. It shows
the very next status available. The user selects the drop-down arrow and selects, for example, In
Review as the next stage. Selecting a transition from the control saves the record automatically.
Users can move both forwards and backwards in the lifecycle depending on the business process
that has been set up in the lifecycle and assuming transition rules are met.

• The outcome of the transition rule combined with the Hide transition on failure check box setting•
determines what the user sees:

Transition rule outcome Hide transition on failure
check box What the user sees

The transition has an invalid rule
or an expression that returns as
false.

Selected The transition control doesn't show
the transition.

The transition has a valid but
failed rule. Cleared

The transition control is shown but a
tool tip explains why the transition is
unavailable.
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The transition is invalid regardless
of the results from the expression. Cleared

The transition control is available and
the user sees a warning saying Not
all rules evaluated -
contact sys admin to resolve
transition rule error.

The Transition Status text changes if you edit the transition name in the lifecycle.

Important: To help users by changing the text shown when a rule fails, edit the name of the
transition rule.

To add a Lifecycle Progress Indicator or Transition Status Control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Lifecycle Progress Indicator/Transition Status Control from the Special

Control tree onto the form.
3. Right-click the control to change any of the properties. See Form Editor Toolbar.

Note: If the two lifecycle controls are close together on your form, use Bring to Front or
Send to Back on the Form Editor Toolbar to prevent overlapping of the two controls when in
use.

4. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Open the Lifecycle Editor
Related tasks
Manage Transitions
Related information
Report on Business Objects Based on Lifecycle Status
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Report on Business Objects Based on Lifecycle
Status

You can produce a report showing, for example, the number of open Incidents within the Incident lifecycle
and a breakdown of the current status of each record.

This is an end-to-end example of the steps required to produce such a report using either calculated fields
or a search group.

Prerequisites: Ensure a lifecycle that was created using the Business Object Lifecycle Editor is
associated with the Business Object. See Open the Lifecycle Editor. Ensure some records are at
(example: Stage 2).

1. Log in to the CSM Desktop Client.
2. Select Tools > Reports > Report Manager.
3. In the Object Manager, select the Major or Supporting Business Object in the Object tree, and then

select the Edit Lifecycle task in the Structure area.
The Lifecycle Editor opens showing the lifecycle.

4. Select Create New .
The Report Wizard opens.

5. Select Next. Accept the default for Cherwell Report Writer, and then select Next.
The Business Object and Search Group page is shown.

6. Select the Business Object you want to report on from the Business Object drop-down list if not
already selected.

7. Select the Search Group option and select the ellipsis.
The Search Manager window opens.

8. In the Association drop-down list, select your Business Object if it isn't already selected.

9. Select  to create a new stored search query.
10. Enter a name and description and set the Search Type to your Business Object.
11. Complete the Comparison Clause so that Lifecycle Stage Equals Stage 2 , select Save, and then

OK.
12. Select Next.

The Select Fields for Report window opens.
13. Select and add fields for [Name of Lifecycle] Status and [Name of Lifecycle] Stage.
14. Select Next.
15. Leave Calculated Fields blank, and select Next.
16. Select and add any fields for sorting.
17. Select Next.
18. Leave Report Grouping blank, and select Next.
19. Name your report, provide an optional header and/or footer and select Finish.

Your new report is created and opens in the Report Designer where you can make layout changes.
20. To run the report, log in to a CSM Client.
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21. In the CSM Desktop Client, select Tools > Reports > Report Manager.
In the CSM Browser Client, select Reports> Report Manager.

22. Select the new report query and select Run from the toolbar or right-click context menu.
Your report shows you the records currently at Stage 2.

Note: If the Business Object has no status or no lifecycle associated with it, the expression
returns no records.

Tip: You can also report on lifecycle status using calculated fields. See Defining Calculated Fields
for a Report . When you reach step 15, add a calculated field and populate it with a valid
expression using the lifecycle status or stage.

Related concepts
Migrate a Business Object Lifecycle
Managing Business Object Lifecycles
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
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Show Lifecycle Data in a Field
There may be occasions when you need to show lifecycle data in a field (example: when interacting with a
third party API).

To show lifecycle data in a field, there must be a lifecycle associated with the Business Object and then
you need to create a calculated field.

To create a calculated field for lifecycle data:

1. Create a Blueprint.
2. Open the Business Object Editor.

3. Select  to add a new field.
The Field Properties window opens.

4. Select the Advanced page and clear the Stored in Database check box.
5. Select the Properties page and select the Read-only check box.

The Always read-only option is then selected by default.
6. Select the Properties page and then select the Calculated value check box.
7. Select the down arrow to expand the Calculated value section and select the Expression option.

8. Select Custom Expression .
The Custom Expression dialog opens.

9. Select the down arrow and then select a lifecycle token (example: Stage) from the Token Selector to
use in your expression.

10. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Open the Lifecycle Editor
Migrate a Business Object Lifecycle
Define General Behaviors for Fields
Define Advanced Properties for a Field
Related tasks
Create a Blueprint
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Migrate a Business Object Lifecycle
Migrate your Business Objects from the legacy lifecycle method to get all the benefits of using the
Business Object Lifecycle Editor.

A new and recommended method for adding a lifecycle to a Business Object was added to CSM 10.2.0.
This method uses a visual lifecycle editor. See Open the Lifecycle Editor. The now legacy method added
a lifecycle to a Business Object using Business Object Properties. For more information see Define
Lifecycle Properties for a Business Object.

Important: Given the complexity and customizable nature of CSM, updating any associated
content to use the new Business Object Lifecycle must be achieved manually. Also we
recommend that, if you want to try migration, you do so on a non-production database and you
fully consider what is involved by reading this topic beforehand Update Associated Items for
Business Object Lifecycle Migration.

Benefits of the Business Object Lifecycle Editor

• New form controls display and control progression through the lifecycle. Customers can see the
progress of their ticket and users can see what requirements need to be met to allow their work to
be progressed.

• The visual editor gives administrators a view of the complete workflow or business process during
design and editing. It saves time by removing the need to change many different areas of CSM
when updating a lifecycle.

• Rules and post-transition actions are all added using the Editor, removing the need for
administrators to create One-Steps and additional processes to move items between states.

Note: If you are migrating a legacy Business Object lifecycle to a new one that uses the Lifecycle
Editor, you may find it useful to draw your existing business process on paper first. This can make
it faster when recreating your lifecycle using the visual editor.

If you have lifecycles already attached to Business Objects and you upgrade your system to CSM 10.2.0
or later, be aware of the following:

• If the Has Lifecycle check box is cleared and then your system is upgraded to CSM 10.2.0 or later,
the Lifecycle tab in Business Object properties disappears.

• If you manually clear the Has Lifecycle check box, then publish a Blueprint, the Lifecycle tab in
Business Object properties disappears.

• You can continue to use the legacy method for existing Business Objects that have lifecycles but
lifecycles added to all new Business Objects must be carried out using the Lifecycle Editor. As a
result, there is no time pressure to move your Business Objects to the Lifecycle Editor, though you
see benefits when you do so.

• Important: It is possible to use both legacy and new lifecycles in parallel on the same•
Business Object but this is not recommended and is not supported by Cherwell. If you have
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both legacy and new lifecycles setup on the same Business Object in error, the user will be
using the one for which you have form controls set up.

Migration methods:

• Multiple Statuses: Use a One-Step Action to Migrate Business Object Lifecycles: Use the
Transition a Business Object One-Step™ Action combined with a Decide Between Multiple Cases
One-Step Action to migrate all records with any status in a legacy lifecycle to the Business Object
Lifecycle Editor all at the same time. See Multiple Statuses: Use a One-Step Action to Migrate
Business Object Lifecycles.

• Single Status: Use a One-Step Action to Migrate Business Object Lifecycles: Use the
Transition a Business Object One-Step Action to migrate all records of the same status in a legacy
lifecycle to the Business Object Lifecycle Editor at the same time. See Single Status: Use a One-
Step Action to Migrate Business Object Lifecycles.

• Manually Migrate a Business Object Lifecycle: If you have only a small number of Business
Objects associated to legacy lifecycles, you can migrate them manually. See Manually Migrate a
Business Object Lifecycle .

• Perform Transitions using One-Step Action: Use a One-Step Action to change the status for
multiple Business Object records that are already using the Business Object Lifecycle Editor. See
Perform Transitions using a One-Step Action :.
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Update Associated Items for Business Object
Lifecycle Migration

Update the items associated with a Business Object so that they use the new Business Object Lifecycle
Editor.

Important: Given the complexity and customizable nature of CSM, updating any associated
content to use the new Business Object Lifecycle must be achieved manually. Also we
recommend that, if you want to try migration, you do so on a non-production database and you
fully consider what is involved by reading this topic beforehand.

The Status Field
The new Business Object Lifecycle Editor is configured for each Business Object and its use is optional.

If you migrate a Business Object to use the Lifecycle Editor and publish your Blueprint, you then need to
update any expressions, One-Step™ Actions or searches associated with that Business Object so that
they point to the new lifecycle.

The legacy lifecycle implementation uses the Status field by default within the Business Object. For the
new lifecycle, this is no longer the case, instead the lifecycle is its own, independent object associated to
the Business Object via an assumed relationship. This means that once the new lifecycle has been
configured and deployed, the existing peripherals such as searches won't automatically associate with the
new lifecycle.

The changes required are simple, however there may be a large quantity of required changes depending
on your configuration and usage of the CSM system.

Identify Items to be Updated
To find out which items need to be updated, run a dependency scan against the field that contains the
legacy lifecycle data, typically the Status field, in a Business Object. See Find CSM Item Dependencies.

The results of this scan display all the items that use this field. From this results list, you can locate and
update the required items to reflect the new lifecycle changes.

Note: As there may be a large number of results depending on your system usage and setup, it is
beneficial to review these items and determine whether they are necessary to your business.

Example - How to Update a Stored Query
Let's assume you want to update an existing stored query for the Incident Business Object called All In
Progress Incidents which currently looks like this:
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As you can see in the above image, the stored query has a criteria of Incident.Status equals In
Progress which is validating against the Status field of the Incident Business Object.

To make the change, we need to replace this criteria with the equivalent status value or with a stage that
represents In Progress, based on the replacement lifecycle created in the new Lifecycle Editor.
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After a lifecycle has been created, the Status and Stage fields are available for selection from the left-
hand drop-down list in the comparison clause for all expressions and searches of the associated object or
related objects. You can then select values for the Status and Stage fields in the right-hand field of the
comparison clause.
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In the lifecycle we've created, the Development stage is equivalent to the old In Progress status from
the legacy lifecycle.

Summary
Updating of the lifecycle field, as explained above, is required for any searches or expressions that
formerly used the legacy lifecycle after the lifecycle has been migrated. While this may take time to
achieve, it does allow for some streamlining of the number of required items by using and grouping
statuses into defined, logical stages.

The same logical change is required for One-Step Actions and Dashboard Widgets, which use
expressions and searches to power them.

Related information
Multiple Statuses: Use a One-Step Action to Migrate Business Object Lifecycles
Single Status: Use a One-Step Action to Migrate Business Object Lifecycles
Manually Migrate a Business Object Lifecycle
Perform Transitions using a One-Step Action
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Multiple Statuses: Use a One-Step Action to
Migrate Business Object Lifecycles

Use a One-Step™ Action to migrate multiple Business Objects to use the Business Object Lifecycle
Editor. Using this method, you can migrate records with several different statuses at once.

These steps use an Incident as an example but you can use this One-Step Action to transition any Major
or Supporting Business Object from the legacy lifecycle to the new lifecycle. You can also use the One-
Step Action to migrate records forwards or backwards in a lifecycle, between branches in a lifecycle, or to
assign a status to an object that has never had a lifecycle.

To use a One-Step Action to migrate a legacy Business Object lifecycle for several statuses at a
time:

1. Log in to CSM Administrator.
2. Create a new Blueprint.
3. In the Object Manager, select a Business Object in the Object tree (example: Incident), and then

select the Edit Business Object task in the Structure area (or double-click a Business Object in
the Object tree).

4. Select Bus Ob Properties.
5. Clear the Has lifecycle check box on the Lifecycle page. See Define Lifecycle Properties for a

Business Object.
6. Create a new lifecycle for that Business Object. See Business Object Lifecycle Editor.
7. Edit your existing forms for the affected Business Objects to remove the old form controls and add

the new form controls. See Add Lifecycle Controls to a Form.
8. Publish the Blueprint.
9. Log in to the CSM Desktop Client.

10. Open an existing record and note that the Transition Status Control currently allows access to any
status in the drop-down list. Also note that the record is showing as not having a state on the
Lifecycle Progress Indicator.

11. In the CSM Desktop Client, select One-Step > One-Step Manager.
12. Set the Business Object Association field to the Business Object that you want to migrate to the

new lifecycle (example: Incident).
13. Select Create New.
14. Provide a name and description (example: Move many statuses).
15. Select OK.
16. Select the Conditions page and then select Specific group from the Allow One-step to run

against drop-down list.
17. Select a Specific search group (example: All Incidents).

This finds all the records using the legacy lifecycle.
18. Add the Advanced Action Decide between Multiple Cases to the designer board.
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19. Add a Transition a Business Object Action to the designer board for each status you need to
upgrade.

20. Select each case for the One-Step Action Decide Between Multiple Cases and select Edit Case.
21. In the Edit Case Action condition window, name each case (example: Records in New state,

Records in In Progress state). Then define the expression (example: Incident.Status Equals New,
Incident.Status equals In Progress).

22. For each corresponding Transition a Business Object One-Step Action, select it on the designer
board and enter a name (example: Transition to New).

23. Select No Status Assigned from the From Status drop-down list.
24. Select your chosen target status from the Target Status drop-down list (example: New).
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25. Select Ignore status mismatch. If this option is selected, when the From Status of a record
doesn't match those specified in the One-Step Action, the record gets ignored and the One-Step
Action continues. If you want the One-Step Action to stop if it finds a status mismatch, then clear the
check box, at which point you get an error message and the One-Step Action stops immediately.

26. Save the One-Step Action and return to your Desktop Client dashboard.
27. Run your One-Step Action (example: Move many statuses).
28. Review some existing Incidents that were using the legacy lifecycle and they should now be

migrated.
The Lifecycle Progress Indicator now shows the records with their new statuses and all the records
that were using the legacy lifecycle have been migrated to the new Business Object Lifecycle Editor.
A journal entry is created for each Business Object transitioned as a result of the action.

Note: If you migrate only one status first using the Single Status method, it doesn't matter if
you then change your mind and use this approach afterwards. See Single Status: Use a
One-Step Action to Migrate Business Object Lifecycles.

Related tasks
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Log in to the CSM Desktop Client or CSM Administrator
Related information
Single Status: Use a One-Step Action to Migrate Business Object Lifecycles
Manually Migrate a Business Object Lifecycle
Perform Transitions using a One-Step Action
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Single Status: Use a One-Step Action to Migrate
Business Object Lifecycles

Use a One-Step™ Action to migrate multiple Business Objects to use the Business Object Lifecycle
Editor. Using this method, you can migrate records of one status at a time.

These steps use an Incident as an example but you can use this One-Step Action to transition any Major
or Supporting Business Object from the legacy lifecycle to the new lifecycle. You can also use the One-
Step Action to migrate records forwards or backwards in a lifecycle, between branches in a lifecycle, or to
assign a status to an object that has never had a lifecycle.

To use a One-Step Action to migrate a legacy Business Object lifecycle one status at a time:

1. Log in to CSM Administrator.
2. Create a new Blueprint.
3. In the Object Manager, select a Business Object in the Object tree (example: Incident), and then

select the Edit Business Object task in the Structure area (or double-click a Business Object in
the Object tree).

4. Select Bus Ob Properties.
5. Clear the Has lifecycle check box on the Lifecycle page. See Define Lifecycle Properties for a

Business Object.
6. Create a new lifecycle for that Business Object. See Business Object Lifecycle Editor.
7. Edit your existing forms for the affected Business Objects to remove the old form controls and add

the new form controls. See Add Lifecycle Controls to a Form.
8. Publish the Blueprint.
9. Log in to the CSM Desktop Client.

10. Open an existing record and note that the Transition Status Control currently allows access to any
status in the drop-down list. Also note that the record is showing as not having a state on the
Lifecycle Progress Indicator.

11. In the CSM Desktop Client, select One-Step > One-Step Manager.
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12. Set the Business Object Association field to the Business Object that you want migrate to the new
lifecycle (example: Incident).

13. Select Create New.
14. Provide a name and description.
15. Select OK.
16. Select the Conditions page and then select Specific group from the Allow One-step to run

against drop-down list.
17. Select a Specific search group (example: All New Incidents).

This finds all the records using the legacy lifecycle with a current status of New.
18. Add a Transition a Business Object Action to the Designer Board.
19. Select No Status Assigned from the From Status drop-down list.

20. Select your chosen target status from the Target Status drop-down list (example: New).
21. Select Ignore status mismatch. If this option is selected, when the From Status of a record

doesn't match those specified in One-Step Action, the record gets ignored and the One-Step Action
continues. If you want the One-Step Action to stop if it finds a status mismatch, then clear the check
box, at which point you get an error message and the One-Step Action stops immediately.

22. Save the One-Step Action and return to your Desktop Client dashboard.
23. Run your One-Step Action.
24. Open an existing Incident that was using the legacy lifecycle.

The Lifecycle Progress Indicator now shows the record at status New.
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All the records that had New status set in the legacy lifecycle have been migrated to the new
Business Object Lifecycle Editor. A journal entry is created for each Business Object transitioned as
a result of the action.

25. To migrate all the Business Objects that have a legacy lifecycle associated with them, edit your One-
Step Action to change the Specific search group and Target Status and keep re-running it until all
your records use the Lifecycle Editor. Alternatively, see Multiple Statuses: Use a One-Step Action to
Migrate Business Object Lifecycles.

Related concepts
Managing Business Object Lifecycles
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
Related information
Manually Migrate a Business Object Lifecycle
Perform Transitions using a One-Step Action
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Manually Migrate a Business Object Lifecycle
If you have a small number of Business Object records, you can manually migrate them in to the Business
Object Lifecycle Editor.

These steps use an Incident as an example but you can use this method to transition any Major or
Supporting Business Object to the new lifecycle.

To manually migrate a legacy Business Object lifecycle:

1. Log in to CSM Administrator.
2. Create a new Blueprint.
3. In the Object Manager, select a Business Object in the Object tree (example: Incident), and then

select the Edit Business Object task in the Structure area (or double-click a Business Object in
the Object tree).

4. Select Bus Ob Properties.
5. Clear the Has lifecycle check box on the Lifecycle page. See Define Lifecycle Properties for a

Business Object.
6. Create a replacement lifecycle using the Business Object Lifecycle Editor.

Tip: If you are migrating a legacy Business Object lifecycle to a new one that uses the
Lifecycle Editor, you may find it useful to draw your existing business process on paper first.
This can make it faster when recreating your lifecycle using the visual editor.

7. Edit your existing forms for the affected Business Objects to remove the old form controls and add
the new form controls. See Add Lifecycle Controls to a Form.

8. Remove any old One-Step Actions that are no longer required for your legacy lifecycles.
9. For each Business Object record, open a form and use the Transition Status control to migrate the

object to your desired status in the new lifecycle. Select your chosen status from the drop-down list.
See Add Lifecycle Controls to a Form
The record is migrated to the new Business Object Lifecycle Editor. A journal entry is created for
each Business Object transitioned as a result of your action.

Related concepts
Managing Business Object Lifecycles
Configure Business Object Lifecycles
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
Related information
Perform Transitions using a One-Step Action
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Perform Transitions using a One-Step Action
Use a One-Step™ Action to perform transitions for multiple Business Objects records that are already
using the Business Object Lifecycle Editor.

These steps use an Incident as an example but you can use this One-Step Action to perform transitions
for any Major or Supporting Business Object already using the Business Object Lifecycle Editor.

Tip: You can also use the One-Step Action to move records forwards or backwards in a lifecycle
or between branches in a lifecycle or to assign a status to an object that has never had a lifecycle.

To use a One-Step Action to perform a transition for multiple records:

1. Log in to the CSM Desktop Client.
2. In the CSM Desktop Client, select One-Step > One-Step Manager.
3. Set the Business Object Association field to the Business Object that you want to perform the

transition for (example: Incident).
4. Select Create New.
5. Provide a name and description.
6. Select OK.
7. Add a Transition a Business Object Action to the designer board.
8. Select No Status Assigned from the From Status drop-down list.

Important: The From Status in this One-Step Action is the status in the new lifecycle not
the legacy one.

9. Select your chosen target status from the Target Status drop-down list (example: Draft).
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10. Save the One-Step Action and return to the Desktop Client home page.
11. Open an existing Incident that has no status set.
12. Run your One-Step Action.

All the records that previously had no status set in the Business Object lifecycle Editor are
transitioned to their new status. A journal entry is created for each Business Object transitioned as a
result of the action.

Related concepts
Managing Business Object Lifecycles
Configure Business Object Lifecycles
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
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Fields
A Field is a basic unit of information (example: ID, last name, address, etc.) that is specific to a Business
Object (example: Incident, Problem, Service, Customer, etc.). Each Field holds a single piece of data and
has a unique name and properties to define the types of values it can contain and how it behaves. Fields
can be stored in the database along with the Business Object, or calculated on the fly.
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About Fields
Use fields to store and/or display information that is relevant to a Business Object. Fields can be exposed
in CSM using field controls on a form to display relevant information (example: Status), or to allow users
to provide or select data (example: Description, Priority, Category, and Sub-category.).

Each field can hold one of the following types of information:

• Text: Letters, numbers, and/or special characters. Text fields are the most versatile type of field, and
are usually the main fields displayed in a form (example: Name, Description, and Status). They can
be either plain text (no special formatting) or Rich Text (special formatting and embedded images).

• Number: Digits, including whole numbers and decimals, negative numbers, and currency. Number
fields can be used to record statistics (example: How many times an Incident has been escalated),
calculate numbers (example: Total tasks associated with an Incident), and track time (example: How
long it takes to complete a task) and costs (example: Actual cost of an emergency change).
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• Date/Time: Dates and/or times. Date/time fields can be used to track deadlines (example: SLA
Respond By Deadline, Review By Deadline), when records are created, modified, or change status,
and when certain events are scheduled (example: Service blackouts, and CI downtimes).

• Logical: True or false. Logical fields can be used to track activities (example: Responded to the
customer) and items of interest to management (example: Resolved on first call), and to flag
important records (example: VIP customer, has an SLA).

Fields can have any of the following properties:

• Required: Must contain a value before a Business Object can be saved, or before it enters the next
lifecycle state.

• Read-Only: Value cannot be edited or updated.

• Calculated: Value is calculated by evaluating an Expression.

• Validated: Must contain a value from a defined set of values (example: Validation table, list, and
range.).

• Auto-populated: Automatically filled in based on defined conditions (example: When another field's
value changes and using a Group Map.).

You can also define when certain properties apply (example: Always, never, based on lifecycle states or
on another field, system function, stored value, or expression).

CSM provides many fields for its OOTB Business Objects. Use these as-is, edit them, or create your own
using the Business Object Editor (accessed from within a Blueprint in CSM Administrator).
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Fields Good to Know
Use these tips for helpful information on fields.

• Use the Business Object Editor (accessed from within a Blueprint in CSM Administrator) to define
and edit the various aspects of a field. In the Business Object Editor, you can:

◦ Create, edit, or delete fields for a Business Object.

◦ Access the Field Properties window, where you can define and edit properties for a field.

For more information, see Business Object Editor and About Blueprints.

• Fields in major Business Objects can be encrypted to prevent unauthorized access to sensitive
information (example: identity information, financial data). For more information, see Configuring
Field Encryption.

• Business Objects and their associated fields, relationships, forms, grids, and form arrangements are
created, edited, and deleted within a Blueprint. To commit changes to your system, you must publish
the Blueprint. For more information, see Publish a Blueprint.

• Security rights control access to Business Object data and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights and Define Business Object Rights.
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Using Fields
Use Fields to view and provide the basic units of information (ex: Name, date, descriptions, etc.) that are
relevant to a Business Object. When working with Fields, Users can:

• Provide data in Business Object Forms. For example:
◦ Log an Incident

◦ Create a Service Catalog

◦ Log a Problem

◦ Create a Configuration Item

◦ Create a Change Request

◦ Log a Knowledge Article

• Display a Stored Value in a Field on a Form (ex: Company Name).

• View Field values from Grids and Search Results Lists.

• Insert Fields as Tokens in One-Step Actions, Expressions, Searches, etc. that have a Business
Object association.
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Managing Fields
Fields are managed in CSM Administrator using the Business Object Editor, accessed from within a
Blueprint in CSM Administrator. Use this tool to:

• Create, edit, or delete Fields for a Business Object.

• Access the Field Properties window, where you can define and edit properties for a Field.
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Create/Edit a Field
Use the Business Object Editor and/or the Field Properties window to create and edit Fields for a
Business Object.

To create a Field for a Business Object:

1. Open the Business Object Editor.

2. In an empty row (marked by a Create New icon) in the Business Object Editor Grid, provide general
information for the new Field:

Option Description

Name Provide a display name for the field.

Type Select a field type (Text, Number, Date/Time, or
Logical).

Size Select a Field size, which can vary by Field type.

Tip: You can edit general information for an existing Field directly in the Business Object
Editor Grid. Or, click the Field Properties button to open the Field Properties window, where
you can edit general information as well as detailed properties for a selected Field. Use the
Up/Down arrows in the Business Object Editor to change the order of selected Fields.

3. Click the Field Properties button.

4. Define or edit Field properties:
a. Define general properties for a Field.

b. Define process and procedure help for a Field.

c. Define detailed properties for a Field.

d. Define validation/auto-populate properties for a Field.

e. Define Group Properties for a Field (only applicable if Field belongs to a Group Object).

f. Define advanced properties for a Field.

g. Select OK.g.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Editing a Field
To edit a Field:
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1. Select a Field in the Business Object Editor.

2. Make changes:
◦ Edit general Field properties directly in the Business Object Editor Grid.

◦ Click the Field Properties button to open the Field Properties window and edit additional
properties. Then, click OK.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Open the Field Properties Window
To open the Field Properties window:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task or open an existing Blueprint..

2. The Blueprint Editor opens, showing the Object Manager in its Main Pane.
3. Click a Business Object in the Object tree, and then click the Edit Business Object task in the

Structure area.
4. Click a new or existing Field, and then click the Field Properties button.
5. You can then:

◦ Define Detailed Properties for a Field.
◦ Define Process and Procedure Help Properties for a Field
◦ Define Detailed Properties for a Field
◦ Define Validation/Auto-Population Properties for a Field
◦ Define Advanced Properties for a Field

CSM 2022.3 Features 282

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=blueprint_editor
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_detailed_properties_for_a_field
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_process_and_procedure_help_properties_for_a_field
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_detailed_properties_for_a_field
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_validation-auto-population_properties_for_a_field
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_advanced_properties_for_a_field


Define General Properties for a Field
Use the General page in the Field Properties window to define general properties for a field.

To define general properties for a field:

1. Open the Field Properties window. For more information, see Open the Field Properties Window.

2. Select the General page.

3. Define general information for the field:

Option Description

Name Provide a display name for the field.

Internal Name

When you provide a display name, the internal
name is automatically populated with the field
display name (you can change this, if necessary).

The internal name is the name given to the field in
the Business Object's database table. An internal
name can only have letters, digits, and underscore
characters.

(Optional) Description Provide a description.

CSM 2022.3 Features 283

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_open_field_properties_editor


Option Description

Field Type

Select a field type (Text, Number, Date/Time, or
Logical).

Warning:

When you change the field type for a field,
a warning is displayed. By confirming the
change of field type, you accept that
existing content might be overwritten.

Example: A description field with a Field
Type of Text is displayed on multiple
Incident Forms. You update the Field Type
for that description field to Number.
Consequently, the description on each
affected Incident is updated to a default
number of 0. Any existing descriptions are
overwritten.

If you change the Field Type for a field,
you must ensure the correct Control is
used for any Forms on which the field is
displayed. Failing to do so may cause
Form errors.

Some Field Type changes may not result
in content being overwritten. For example,
if you create a Blueprint in an environment
with no data and subsequently apply it to
your production site. Regardless, we
recommend you investigate the impact of
changing Field Type before acting.
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Option Description

Track Changes to Field

Select to track changes made to the field in the
Business Object's history.

Note:

For field changes to be tracked, the
Business Object must have a history
Relationship and Track Field Changes
defined on the History page of the
Business Object Properties window. For
more information, see Define History
Properties for a Business Object.

You must select the Track Field Changes
check box if the field will be encrypted
(enabled in Advanced properties. For more
information, see Define Advanced
Properties for a Field); decrypting fields is
tracked in Journal-History records.

4. Based on the field type, define general field properties. For more information, see the relevant
details:

◦ Define General Properties for a Date/Time Field.

◦ Define General Properties for a Number Field.

◦ Define General Properties for a Text Field.

Note: Logical Fields do not have any additional user-defined general properties. They can
hold only one of two values: True or False, and Yes or No.

5. Select OK.5.

6. To publish the Blueprint and commit the changes, select File > Publish Blueprint (for more6.
information, see Publish a Blueprint).

Alternatively, to save the Blueprint and continue making other changes, select File > Save
Blueprint (for more information, see Save a Blueprint).

Related concepts
Create/Edit a Field
Standard Text Field Lengths
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Define General Properties for a Date/Time Field
Select the Date/Time Field type from the General page of the Field Properties window to define a Field
that contains date and/or time information.

To define general properties for a Date/Time Field:

1. Open the Field Properties Window.

2. On the General page of the Field Properties window, select Date/Time in the Field Type drop-down.

3. Define general Date/Time Field properties:

Option Description

Date and Time Select to allow the Field to hold both a date and a
time.

Date only Select to allow the Field to hold a date only.

Time only Select to allow the Field to hold a time only.

Timestamp Select to have the Field hold a system timestamp.

4. Select the Adjust for time zones check box to have the Field automatically adjust the date and/or
time based on your computer's time zone settings.

5. Select OK.5.

6. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define General Properties for a Number Field
Select the Number Field type from the General page of the Field Properties window to define a Field that
contains numeric information.

To define general properties for a Number Field:

1. Open the Field Properties Window.

2. On the General page of the Field Properties window, select Number from the Field Type drop-down.

3. Define the digit and decimal properties for the Field.

Option Description

Whole Digits Provide the number of whole digits the Field is
allowed to hold.

Decimal Digits Provide the number of digits that can appear after
the decimal point in the Field.

Note: Whole digits cannot contain more than 9 digits if you do not include decimals and
cannot contain more than 27 digits if you use decimals. The combined number of whole
digits plus the number of decimal digits cannot be greater than 38.

4. Select the Allow negative numbers check box to allow the Field to contain negative numbers.

5. Select the Holds Currency check box to make the Field a Field that holds currency values. Then,
select a Currency Culture in the drop-down to show the appropriate currency symbol in the Field
(example: English (United States) shows the dollar sign in front of the currency value). The system
default is based on your computer's region and language settings.

6. Select OK.6.

7. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define General Properties for a Text Field
Select the text field type from the General page of the Field Properties window to define a field that
contains text. The properties vary depending on whether the field is plain text or rich text.

Note: Rich text fields cannot be encrypted.

To define general properties for a text field:

1. Open the Field Properties Window.

2. On the general page of the Field Properties window, select Text from the Field Type drop-down
list.

3. Define whether the field is plain text or rich text:
◦ Plain Text: Select this option to store plain text with no formatting or images in the field.

◦ Rich Text: Select this option allow rich text formatting in the field.

4. If you selected Plain Text, define these properties:

Option Description

Length
Select to define a specific length for the field. Then,
provide the maximum number of characters the field
can contain.

Max Allowed Select to allow the maximum number of characters
in the field (creates a "text" field type in SQL Server).

Max Searchable
Select to allow the maximum number of characters
for searchable text fields (creates a "varchar 4000"
field in SQL Server).

Allow Multiple Lines Select to allow the field to contain two or more lines
of text.

Allow Spell-Check

Select this check box to turn on spell-checking for
the field. This will check for spelling errors in content
that is provided in the field.

This option is only available if spell-checking is
enabled in the Business Object's general properties.
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Option Description

Format

Select to use a format to enforce how characters and
digits are displayed in the field (example: Phone
number format). You can use either:

◦ Stored Format: Select the ellipsis  to open
the Stored Format Manager, where you can
select an existing format or create a new one.

◦ Custom Format: Select the Custom Format

button  to open the Custom Format
Builder, where you can create a custom format
to use only for this scenario.

5. If you selected Rich Text, define properties described in Enable Rich Text on Business Object
Fields.

6. Define additional field properties:
◦ Include in Full-Text Search: Select this check box if the field should be indexed for Full-Text

Search (used by CSM Quick Search and Knowledge Search).

◦ Holds: Select a hold property that identifies the type of data contained in the field. For
example, set a record ownership "Holds" property on an Owned By field to identify the name
in the field as a record owner.

7. Select OK.7.

8. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define Process and Procedure Help Properties for
a Field

Use the Process and Procedure Help page in the Field Properties window to provide additional
information to Users.

Good to know:

• If you cannot see the Process and Procedure Help page, verify that the Show Process and
Terminology Help setting is enabled. For more information, see Configure Global Help Settings.

• If the Process and Terminology section does not appear on the CSM Desktop Client Task Pane,
verify that it is enabled in the User Task Pane and Search Control Settings.

To define process and procedure help for a Field:

1. Open the Field Properties window.

2. Select the Process and Procedure Help page.

3. In the Process and Procedure Text box, provide text that includes important information for Users
who work with the Field. The text you provide is shown in the CSM Desktop Client Task Pane when
the Field is selected.

4. Optionally, in the Additional Help URL box, provide a URL to an external site. Then, select the
Ellipses button to navigate to the URL and ensure it is correct.

5. Select OK.5.

6. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define Detailed Properties for a Field
Use the Properties page in the Field Properties window to:

• Define General Behaviors for Fields

• Define Field Behaviors Based on Lifecycle State

Note: Encrypted Fields cannot have default or calculated values, or set values based on lifecycle
state.

1. Open the Field Properties window.

2. Click the Properties page.

3. Define general behaviors for the Field.

4. Define behaviors based on lifecycle state.

5. Select OK.5.

6. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define General Behaviors for Fields

Setting Required Fields
Select the Required for Save check box to always require the field to contain a value before the
Business Object can be saved. If you enable the Show required field identifiers in labels option at the
Business Object level, fields marked Always required for save automatically display an asterisk next to
the field label control.

Note: This functionality is not available for Related Item Picker fields.

Note: Fields that are conditionally required for save display the asterisk if the condition is met
when the form loads, or a change to the form triggers a condition to be re-evaluated.

You can also select the down arrow to expand the section and select another option.

Option Description

Always required for save
Select to always require the field to contain a value
before the Business Object can be saved. This is the
same as selecting Required for Save.

Never required for save Select to never require the field to contain a value before
the Business Object can be saved.

Field
Select to use a logical field to determine whether the
field is required before the Business Object can be
saved. Then, select a field in the drop-down list.

Custom Error

Select to display a custom error message when the field
does not contain a value, before the Business Object
can be saved. You can use either:

• A most recently used message from the drop-down
list.

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression to
open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Function

Select to use a System Function to determine whether
the field is required before the Business Object can be
saved. Then, select a System Function in the drop-down
list.
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Option Description

Stored Value

Select to use a stored value to determine whether the
field is required. Then, select a most recently used
(MRU) stored value in the drop-down list, or select the
ellipsis to open the Stored Value Manager, where you
can select an existing stored value or create a new one.

Expression

Select to use an expression to determine whether the
field is required before the Business Object can be
saved. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression to
open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Setting Read-only Properties
Select the Read-only check box to prevent users from adding data to the field.

You can also select the down arrow to expand the section and define additional read-only options.

Option Description

Always read-only Select to make the field always read-only.

Never read-only Select to prevent the field from ever being read-only.

Field Select to use a logical field to determine whether the field
is read-only. Then, select a field in the drop-down list.

Function
Select to use a System Function to determine whether the
field is read-only. Then, select a System Function in the
drop-down list.

Stored Value

Select to use a stored value to determine whether the field
is read-only. Then, select a most recently used (MRU)
stored value in the drop-down list, or select the ellipsis to
open the Stored Value Manager, where you can select an
existing stored value or create a new one.
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Option Description

Expression

Select this option to use an expression to determine
whether the field is read-only. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored expression.
Stored expressions can be reused in numerous
places in CSM.

• Custom Expression: Select Custom Expression to
open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Property changes based on lifecycle

Select to make the field read-only when the Business
Object is in a selected lifecycle state. Then, select a
lifecycle state in the drop-down list.

Note: Options based on lifecycle state only
appear if the Business Object has defined lifecycle
states.

Important: This field property is only available if
your Business Object is associated with a legacy
lifecycle. If you are using the Business Object
Lifecycle Editor, you can accomplish the same end
results by using validation rules and post-transition
actions. See Validate a Lifecycle and Add a Post-
Transition Action.

Use default setting

Select to use the default options for the selected lifecycle
state. Clear the check box to select another option for
determining whether the Field is read-only when the
Business Object is in the selected lifecycle state.

Important: This field property is only available if
your Business Object is associated with a legacy
lifecycle. If you are using the Business Object
Lifecycle Editor, you can accomplish the same end
results by using validation rules and post-transition
actions. See Validate a Lifecycle and Add a Post-
Transition Action.

Setting Default Values
Provide a default value to use as the initial value of the field until a user changes the value.

Select the down arrow to expand the section and select an additional option.
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Option Description

Legal Values 

Select Legal Values to open the Quick Selector for the
field and select a valid value to use as the default.

Note: If the field is validated, Legal Values is
activated. Select it to open the Quick Selector for
the field and select a valid value.

Value

Select to define your own default value. If the field is
validated, Legal Values is activated. Select it to open the
Quick Selector for the field and select a valid value to use
as the default value.

Function
Select this option to use a System Function to determine
the field's default value. Then, select a System Function in
the drop-down list.

Stored Value

Select to use a stored value to determine the field's
default value. Then, select a most recently used (MRU)
stored value in the drop-down list, or select the ellipsis to
open the Stored Value Manager, where you can select an
existing stored value or create a new one.

Expression

Select this option to use an expression to determine the
field's default value. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression to
open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.
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Option Description

Property changes based on lifecycle

Select to use the default value when the Business Object
is in a selected lifecycle state. Then, select a lifecycle
state in the drop-down list.

Note: Options based on lifecycle state only
appear if the Business Object has defined
lifecycle states.

Important: This field property is only available if
your Business Object is associated with a legacy
lifecycle. If you are using the Business Object
Lifecycle Editor, you can accomplish the same
end results by using validation rules and post-
transition actions. See Validate a Lifecycle and
Add a Post-Transition Action.

Use default setting

Select to use the (default) options for the selected lifecycle
state. Clear the check box to select another option for
determining the Field's default value when the Business
Object is in the selected lifecycle state.

Important: This field property is only available if
your Business Object is associated with a legacy
lifecycle. If you are using the Business Object
Lifecycle Editor, you can accomplish the same
end results by using validation rules and post-
transition actions. See Validate a Lifecycle and
Add a Post-Transition Action.

Setting Calculated Values
Select the Calculated Value check box to use an expression to calculate a value for the field. Then,
select the ellipsis to open the Expression Manager, where you can select an existing stored expression or
create a new stored expression to calculate the field's value.

You can also select the down arrow to expand the section and select an option for defining a calculated
value.

Option Description

None
Select to not use a calculated value for the field.
Selecting this option will clear the Calculated Value
box.
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Option Description

Expression

Select this option to use an expression to calculate a
value for the field. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression
to open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Property changes based on lifecycle

Select to have the field's value calculated when the
Business Object is in a selected lifecycle state. Then,
select a lifecycle state in the drop-down list.

Note: Options based on lifecycle state only
appear if the Business Object has defined
lifecycle states.

Important: For CSM 10.2.0 or later versions,
use the Business Object Lifecycle Editor to
add a lifecycle to a Business Object. See:
Open the Lifecycle Editor.

Important: This field property is only available
if your Business Object is associated with a
legacy lifecycle. If you are using the Business
Object Lifecycle Editor, you can accomplish
the same end results by using validation rules
and post-transition actions. See Validate a
Lifecycle and Add a Post-Transition Action.

Use default setting

Select to use the (default) options for the selected
lifecycle state. Clear the check box to select another
option for calculating the Field's value when the
Business Object is in the selected lifecycle state.

Important: This field property is only available
if your Business Object is associated with a
legacy lifecycle. If you are using the Business
Object Lifecycle Editor, you can accomplish
the same end results by using validation rules
and post-transition actions. See Validate a
Lifecycle and Add a Post-Transition Action.
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Setting Values Before Saving
Provide a value in the Value to set before save box to set in the field before the Business Object is
saved.

You can also select the down arrow to expand the section and define additional value options.

Option Description

Legal Values 

Select Legal Values to open the Quick Selector for the
field and select a valid value to use.

Note: If the field is validated, Legal Values is
activated. Select it to open the Quick Selector
for the field and select a valid value.

Set to blank Select to clear the field of any values when the
Business Object is saved.

Value

Select to define a value to set for the field when the
Business Object enters its final state. Then, type a
value.

Note: If you provided a value in the section
heading (next to Value to set before save), this
option is automatically selected and the value
you provided is displayed here.

Field Select this option to set the value with another field's
value. Then, select a field in the drop-down list.

Function
Select this option to use a System Function to
determine the field's value. Then, select a System
Function in the drop-down list.

Stored Value

Select to use a stored value to determine the field's
value. Then, select a most recently used (MRU) stored
value in the drop-down list, or select the ellipsis to open
the Stored Value Manager, where you can select an
existing stored value or create a new one.
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Option Description

Expression

Select this option to use an expression to determine the
field's value. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression
to open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Related concepts
Define General Properties for a Business Object
Define Lifecycle Properties for a Business Object
About Business Object Lifecycles
Open the Lifecycle Editor
About System Functions
About Stored Values
Expressions
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Define Field Behaviors Based on Lifecycle State

Note for new Business Object lifecycle (CSM 10.2.0 or later)

Important: For CSM 10.2.0 or later versions, use the Business Object Lifecycle Editor to add a
lifecycle to a Business Object. See: Open the Lifecycle Editor.

Setting Final State Behaviors
Options based on lifecycle state only appear if the Business Object has defined lifecycle states.

Important: These field properties are only available if your Business Object is associated with a
legacy lifecycle. If you are using the Business Object Lifecycle Editor, you can accomplish the
same end results by using validation rules and post-transition actions. See Validate a Lifecycle
and Add a Post-Transition Action.

Select the Required for <final state> check box to require the field to contain a value before the
Business Object can enter its final state (example: Closed).

You can also click the down arrow to expand the section and select another option.

Option Description

Always required for <final state> Select to always require the field to contain a value
before the Business Object can enter its final state.

Never required for save Select to never require the field to contain a value before
the Business Object can enter its final state.

Field
Select to use a logical field to determine whether the
field is required before the Business Object can enter its
final state. Then, select a field in the drop-down list.

Function

Select to use a System Function to determine whether
the field is required before the Business Object can enter
its final state. Then, select a System Function in the
drop-down list.

Stored Value

Select to use a stored value to determine whether the
field is required before the Business Object can enter its
final state. Then, select a most recently used (MRU)
stored value in the drop-down list, or select the ellipsis to
open the Stored Value Manager, where you can select
an existing stored value or create a new one.

CSM 2022.3 Features 300

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=open_the_lifecycle_editor
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=validate_lifecycle
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=add_post_transition_action
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2Fsystem_functions%2Fabout_system_functions.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2Fstored_values%2Fabout_stored_values.html


Option Description

Expression

Select this option to use an expression to determine
whether the field is required before the Business Object
can enter its final state. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression to
open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Setting Values for Final States
Provide a value to set when the Business Object enters its final state.

You can also click the down arrow to expand the section and define additional options.

Option Description

Set to blank

Select to clear the field of any values when the
Business Object enters its final state.

Note: If the field is validated, Legal Values is
activated. Select it to open the Quick Selector
for the field and select a valid value.

Value

Select to define a value to set for the field when the
Business Object enters its final state. Then, provide a
value.

Note: If you provided a value in the section
heading (next to Value to set for <final state>),
this option is automatically selected and the
value you provided appears here.

Field Select to set the value with another field's value. Then,
select a field in the drop-down list.

Function
Select this option to use a System Function to
determine the field's value. Then, select a System
Function in the drop-down list.

Stored Value

Select to use a stored value to determine the field's
value. Then, select a most recently used (MRU) stored
value in the drop-down list, or select the ellipsis button
to open the Stored Value Manager, where you can
select an existing stored value or create a new one.
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Option Description

Expression

Select to use an expression to determine the field's
value. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression
to open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Setting Required for State Change Properties
Select the down arrow to expand the "Required for state change" changes based on lifecycle section,
and then select an option for requiring the field to contain a value before the Business Object's state can
be changed.

Option Description

State

Select a lifecycle state. You can select a different option
for each lifecycle state to determine whether the field
requires a value before the Business Object is changed
from the selected lifecycle state.

Note: Select (default) to define default options for
requiring the field to contain a value before the
Business Object's state can be changed. These
default options can be used for any (or all)
selected lifecycle states.

Use default setting Select to use the (default) options for the selected
lifecycle state.

Always required for state change Select to always require the field to contain a value before
the Business Object's state can be changed.

Never required for save Select to never require the field to contain a value before
the Business Object's state can be changed.

Field
Select to use a logical field to determine whether the field
is required before the Business Object's state can be
changed. Then, select a field in the drop-down list.

Function

Select to use a System Function to determine whether the
field is required before the Business Object's state can be
changed. Then, select a System Function in the drop-
down list.
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Option Description

Stored Value

Select to use a stored value to determine whether the
field is required before the Business Object's state can be
changed. Then, select a most recently used (MRU) stored
value in the drop-down list, or select the ellipsis to open
the Stored Value Manager, where you can select an
existing stored value or create a new one.

Expression

Select to use an expression to determine whether the field
is required before the Business Object's state can be
changed. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored
expression. Stored expressions can be reused in
numerous places in CSM.

• Custom Expression: Select Custom Expression to
open the Custom Expression Builder, and then
create a custom expression specifically for this
scenario.

Setting Values Before State Changes
Select the down arrow to expand the "Value to set before state change" changes based on lifecycle
section and define options for setting a value in the field when the Business Object's lifecycle state
changes.

Option Description

State

Select a lifecycle state. You can select a different option for
each lifecycle state to determine the field's value before
the Business Object is changed from the selected lifecycle
state.

Note: Select (default) to define default options for
requiring the field to contain a value before the
Business Object's state can be changed. These
default options can be used for any (or all)
selected lifecycle states.

Use default setting Select to use the (default) options for the selected lifecycle
state.

Set to blank Select to clear the field of any values when the Business
Object's state changes.
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Option Description

Value

Select to define a value to set for the field when the
Business Object enters its final state. Then, provide a
value.

Note: If the field is validated, Legal Values is
activated. Select it to open the Quick Selector for
the field and select a valid value.

Field Select to set the value with another field's value. Then,
select a field in the drop-down list.

Function
Select to use a System Function to determine the field's
value. Then, select a System Function in the drop-down
list.

Stored Value

Select this option to use a stored value to determine the
field's value. Then, select a most recently used (MRU)
stored value in the drop-down list, or select the ellipsis to
open the Stored Value Manager, where you can select an
existing stored value or create a new one.

Expression

Select this option to use an expression to determine the
field's value. You can use either:

• Stored Expression: Select the ellipsis to open the
Expression Manager, and then select an existing
stored expression or create a new stored expression.
Stored expressions can be reused in numerous
places in CSM.

• Custom Expression: Select Custom Expression to
open the Custom Expression Builder, and then create
a custom expression specifically for this scenario.

Related concepts
About Business Object Lifecycles
Open the Lifecycle Editor
Define Lifecycle Properties for a Business Object
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Define Image Path Values for a Field
Define an image path value to add an image to a Field on a Form. Import or link an image to show a
photo, avatar, or other image on the Form (example: Import an customer's picture to display when their
name is selected).

Define the Image Path Value
Use the Image Manager to import or link new images to a Form.

Supported image file paths are:

• Imported
• PlugIn
• URL
• File
• Theme

Use the Image Path from a Field Value on a Form
Create or edit a Text Field to add an image path:

1. Create a new Field or edit an existing Field.

2. Select Text for the Field type and provide a value of at least 260 in the Size field. A Text Field must
be used and the length of the field needs to be adjusted to support the length of the path to the
image. 260 characters may be required for a URL image path.

3. Define Detailed Properties for a Field and select the Calculated value drop-down.

4. Select the Expression option button.

5. Set the Expression value to an image path value (example: [IMPORTED], [PlugIn], [URL], [FILE], or
[Theme]). Field tokens can also be used to populate the image paths, where the name of the image
matches a value from another field on the record or related records (example:
[FILE]C:\Images\Customer.FullName.png).

6. Click OK to close the Custom Expression window.

7. Click the Advanced page.

8. Select the Recalculate after load check box.

9. Click OK to close the Field Properties window.

10. Publish the Blueprint to commit the changes.

Add the Field to the Form
Edit the form that the image value Expression was created for:

1. Open the Object Manager.
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2. Select the appropriate Business Object in the Object Tree and click the Edit form task in the
Structure area.

3. Add an Image Control to a Form and set it to use a custom or stored Case Expression.

4. Define a Case Expression to set the Expression to work as a group of if-then-else Expressions.

5. Publish the Blueprint to commit the changes or Save the Blueprint to continue making other
changes. Once the Field is populated with a valid image path, the Image Control should show that
image.

Note: [URL] and [FILE] based images may drastically increase the Form's loading time
because external data must be retrieved and loaded. Some methods may not be available
through the Browser Applications.
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Define Validation/Auto-Population Properties for a
Field

Use the Validation/Auto-Population page in the Field Properties window to configure validation, auto-
population, and foreign key settings for a Field.

Note: Encrypted Fields cannot be validated or auto-populated.

To define validation and auto-population properties for a Field:

1. Open the Field Properties window.

2. Select Validation/Auto-Populate.

3. Perform these tasks as they apply:
◦ Define Validation Properties for a Field

◦ Define Auto-population Properties for a Field

◦ Storing Foreign Keys for Validated and Auto-populated Fields

4. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

5. If you enabled security for Lookup Tables, review and modify Lookup Object security rights to
ensure that Users can access values for validated Fields.
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Define Validation Properties for a Field
Validation ensures that a defined set of values from Validation table, list, or range is used for field
selections.

There are multiple ways to validate fields:

• Validate a Field From a Table

• Validate With Range

• Validate from a List

• Validate from User/Customer

• Use Other Validation Types

Note: If a Group Object (example: Configuration Item) is used to validate a field, the legal values
for the field will include all group members. If the Group Object has full-text search enabled, users
can use wildcard characters to search for a legal value when populating the field.

Validate a Field From a Table
You can validate using values from a field in a selected Business Object. To see values, users can press
F3 or select the Legal Values button.

Tip: When you create Forms, use a drop-down list for the Field Form Control to present valid
values in a list.

To validate a field from a table:

1. From the Validation/Auto-Populate page, select the Validate from Table check box.

2. In the Table drop-down list, select a Business Object to use to validate the field:
◦ Lookup Tables: Select this option to show only Lookup Objects in the drop-down list.

◦ All Tables: Select this option to show all Business Objects in the drop-down list.

3. Select Edit Table Data to open the Data Editor, where you can edit the data contained in the
selected Business Object.

4. In the Field drop-down list, select another field to use to validate the field.

5. Select Sync to synchronize the validation settings for matching tables for a set of shared foreign key
fields. For example, settings applied for the OLA Supplier field would be made to the Supplier field
for all members for the Agreements group.

6. Select the Validation is enforced check box to enforce validation (users can only select from
values in the validation table). Clearing this check box allows users to enter values that are not in
the validation table.

7. Select the Selecting values triggers fill check box to use this field as a trigger for auto-populating
another field (the other field is auto-populated when the value for this field changes).
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8. Select the On conflict use first match check box to automatically use the first value in the
validation table if multiple rows contain the same value. Otherwise, the user is prompted to select
which row to use.

9. In the Limit Values area, add constraints to limit the list of values that are available to the user. For
example, you can limit the list of Sub-Categories that are displayed on an Incident based on the
value selected for the Category field.

a. Select Add to add a constraint or filter.

b. Define the constraint:
◦ Field: Select a field in the Business Object you are currently working with.

◦ Operator: Select an operator (example: Equals).

◦ Value: Select a value for the field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

c. Select OK.c.

d. Add additional constraints as necessary.

10. Add additional constraints as necessary. When limiting values change, clear field's value (normal):
Select this check box to clear the field's value when any of the constraint values change.

11. In the Custom Error box, provide an error message that is displayed to the user when an invalid
value is selected for a field.

Validate With Range
You can define a Range expression that ensures the field's value is between two values (example: Priority
between 1 and 5, percent between 1 and 100, date within a specified time period).

Applicable values include:

• Fields

• Expressions

• Metric Values

• Stored Values

• System Functions

To validate with range:

1. From the Validation/Auto-Populate page, select the Validate with range check box.

2. From the Left of Range list, provide a value to use as the left boundary for the range. Or, select a
value for the field in the drop-down list.
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3. From the Left Operator list, select an operator for the left value in the range.

4. The Field to Check shows the field that is being validated.

5. From the Right Operator list, select an operator for the right value in the range.

6. From the Right of Range list, provide a value to use as the right boundary for the range. Or, select
a value for the field in the drop-down list.

Note: Right operators and values are only available if the left operator is Less Than or Less
or Equal. For example, 50 <= 70 <= 90; select values which are less than or equal to each
other as you read the values from left to right.

7. The Expression property shows the range expression using the selected range values and
operators.

8. In the Custom Error box, provide an error message that is displayed to the user when an invalid
value is selected for a field.

Validate from a List
You can create a list of valid values for the field. This is useful if you have a handful of values that are
unlikely to change, and you do not want to define a Lookup Business Object to hold the values.

To validate from a list:

1. From the Validation/Auto-Populate page, select the Validate from list check box.

2. Provide a value in the New box, and then select Add.

Tip: You can also add values to the list by selecting an empty row and entering the value.
Use the Up/Down arrows to change the order of selected values.

3. In the Custom Error box, provide an error message that is displayed to the User when an invalid
value is selected for a field.

Validate from User/Customer
You can validate a Business Object field against attributes from users or customers. This is also useful if
you want to auto-populate user or customer information when a field changes its value.

Note: This option is a key part of Configure Manual Customer Approvals.

To validate from a user or customer:

1. From the Validation/Auto-Populate page, select the Validate from User/Customer check box.

2. Select the User option to validate against a user attribute.

3. Select the Customer option to validation against a customer attribute.

4. Select the Current User/Customer option to validate against an attribute for a user or customer
that must be logged in to CSM.
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5. Select the By User Type option to validate against a table defined by its ID in another field on the
current Business Object. The User Type is based on the Type Id field, which corresponds to the
Business Object Definition ID of either user or customer

6. Select an Attribute Name from the drop-down list. This list of available attributes is the same as the
one for the Holds option on the General tab and applies to both the Customer and User Business
Objects.

Use Other Validation Types
To use other validation types:

1. From the Validation/Auto-Populate page, select the Other Validation Types check box to use
another type of validation for the field.

2. Select one of these options:
◦ Select the Expression option to use an expression to determine whether the field is valid. You

can use either a stored expression or a custom expression.

◦ Select the Valid Team or Workgroup option to use all, current or currently logged in teams or
workgroups as valid values for the field.

◦ Select the Valid Bus Ob Nameoption to use the names of specific Business Object types as
valid values for the field. You can use:

◦ All Business Objects

◦ Major Business Objects

◦ Supporting Business Objects

◦ Lookup Business Objects

◦ Group Business Objects

◦ Members of a Group.

Note: Select the Include Group Leaders check box to include the names of
Group Leaders in the valid values for the field.

3. In the Custom Error box, provide an error message that is displayed to the user when an invalid
value is selected for a field.

Related concepts
Define Auto-population Properties for a Field
Managing Fields
Add an Approval to a Business Object
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Define Auto-population Properties for a Field
You can use auto-population properties to automatically fill in a field value based on defined conditions.

For example, when a user selects a value for the Status field, another field can be automatically
populated with the descriptive text of the Status. Or, when a value is provided in one field (Approve
Reason), another field (example: Approve Date Time) can be automatically populated with the date/time
and the name of the user who made the change.

Use these methods to auto-populate a field:

• Auto-populate Based on Changes Made to a Table

• Auto-populate Using a Group Map

Auto-populate Based on Changes Made to a Table
You can automatically fill in the field's value when another field's value changes. This allows additional
values to be retrieved from a validation table when a value is selected for one field.

To auto-populate when a change is made to a table:

1. From the Validation/Auto-Populate page, select the Auto-populate check box.

2. From the Populate when there is a change in table drop-down list, select a Business Object that,
when changed, will trigger auto-populating the field.

3. From the Fielddrop-down list, select a field from the selected Business Object that, when changed,
will trigger auto-populating the field (the trigger field).

Note: Typically, the selected Business Object is the same as the one containing the field
being auto-populated, but it can also be a Business Object that has a 1-1 relationship with
the Business Object containing the field being auto-populated.

4. Select one of these Populate with options:

Option Description

Field from <validation table> lookup table

Select this option to populate the field with a value
from a field in the table used to validate the selected
trigger field. Then, select a Field in the drop-down
list.

Note: This option is only available if the
selected trigger field is validated from a
table.

Value

Select this option to auto-populate the field with a
defined value. Then, provide a value. Select the
Legal Values button for a list of valid values (only
available if the field is validated).
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Option Description

Field
Select this option to auto-populate the field with a
value from another field in the Business Object.
Then, select a field in the drop-down list.

Function
Select this option to auto-populate the field using a
System Function. Then, select a System Function in
the drop-down list.

Stored Value

Select this roption to auto-populate the field using a
Stored Value. Then, select a most recently used
(MRU) Stored Value in the drop-down list, or select
the ellipses to open the Stored Value Manager, where
you can select an existing Stored Value or create a
new one.

Expression
Select this option to auto-populate the field using an
Expression. You can use either a stored expression
or a custom expression.

Business Object ID

Select this option to auto-populate the field using the
Business Object ID. This option is only available if the
selected trigger field is validated using a Business
Object name.

Action Name

Select this option to auto-populate the field using the
Action Name. This option is only available if the field
holds an Action Name (the hold property is set to
Action Name in the field's general properties).

Attribute

Select this option to auto-populate the field using the
selected attribute. This option is only available if the
trigger field is set up to Validate against User/
Customer.

5. Select the Only populate if Field is empty check box to only populate the field if it does not contain
a value.

Auto-populate Using a Group Map
You can use group maps to map values in fields to members of a group object. This allows the system to
select the appropriate group member within a relationship. For example, a Specifics ID Field could use a
Specifics group map that would populate the field with the ID of a Specifics group member (example:
Hardware Specifics or Software Specifics), and then show the appropriate Specifics form in the Business
Object.

To auto-populate using a group map:

1. From the Validation/Auto-Populate page, select the Populate Using Map check box.

2. From the Group Map drop-down list, select an existing Group Map. Or, select the Group Map
button to open the Group Map Manager, where you can select an existing group map or create a
new one.
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Related concepts
Define Validation Properties for a Field
Managing Fields
Add an Approval to a Business Object
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Group Map Manager
Use the Group Map Manager to complete general CSM Item Manager operations for Group Maps.

There are several ways to open the Group Map Manager:

• In the Blueprint or mApp Editor menu bar, select Managers > Group Maps. For more information,
see Blueprint Editor menu bar or mApp Editor menu bar.

• In the Field Properties window (Validation/Auto-Populate page), select the Populate Using Map
check box, and then select the Group Map button. For more information, see Define Validation/
Auto-Population Properties for a Field .

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.
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3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Culture selector:

Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
searches run during the session.

5. Main Pane:

Displays items by view (icon, list, or details [grid]) and lists search results when a search is run.

Good to know:

• For more information about working in CSM Item Managers, refer to the Item Managers
documentation.
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Open the Group Map Manager
Open the Group Map Manager from CSM Administrator.

There are several ways to open the Group Map Manager:

• In the Blueprint or mApp Editor menu bar, select Managers > Group Maps. For more information,
see Blueprint Editor menu bar or mApp Editor menu bar.

• In the Field Properties window (Validation/Auto-Populate page), select the Populate Using Map
check box, and then select the Group Map button. For more information, see Define Validation/
Auto-Population Properties for a Field .
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Create a Group Map
Use the Group Map Editor (accessed through the Group Map Manager) to create Group Maps. When you
create a Group Map, you define:

• Name and description of the Group Map.

• The Group Object to which Field values are mapped.

• The Business Object, Fields, and values to use for the map.

To create a Group Map:

1. Open the Group Map Manager.

2. Select a Business Object association.

Note: If you opened the Group Map Manager from the Field Properties window, the
Association is automatically set to the Business Object associated with the Field.

3. Select Create New.

4. Define general properties for the Group Map.

Option Description

Name Provide a display name to use within CSM
(search this property in CSM Item Managers).

Description (Optional) Provide a description to use within CSM (search
this property in CSM Item Managers).

5. Define the Business Objects and Fields to use for the Group Map.

Option Description

Map to Group Select a Group Leader to which values are
mapped.

Starting Business Object

Select the Business Object that contains the Field
to be autopopulated. If you opened the Group
Map Manager from the Field Properties window,
the starting Business Object is automatically set
to the Business Object associated with the Field.

First map Field
Select a Field from the starting Business Object
that will be the primary Field whose values
determine which Group Member to map to.

Second map Field (Optional)
Select a Field from the starting Business Object
that will be the primary Field whose values
determine which Group Member to map to.
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6. Map rows to define the Group Member to which Fields are mapped based on the values they
contain.

Tip: To add the first map row, select values in the drop-down lists. To add new rows after
that, select New Row.

Option Description

Value in Field 1

Select a value from the Group Object for the first
mapped Field. The Field is mapped to the
appropriate Group Member based on the value in
this Field.

Value in Field 2

Select a value from the Group Object for the
second mapped Field. The Field is mapped to the
appropriate Group Member based on the value in
this Field as well as the value in Field 1.

Tip: Select Valid Values to open the
Quick Selector for the mapped Field(s),
where you can select valid values.

Group Member
Select a Group Member to which the selected
Field(s) will be mapped when they contain the
defined the values.

7. Select the Map should use all Group Members check box if the map should use all of the
members in a Group Object.

8. Select Save.8.
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Storing Foreign Keys for Validated and Auto-
populated Fields

Store foreign keys for fields that are validated from tables and that enforce validation. This ensures that
changes to table values are updated in existing records because record IDs are used rather than text
values.

Foreign keys support globalization efforts because they ensure that Users see correct values after they
have been translated.

Good to know:

• When you enable foreign keys for a field, the keys also apply to values that are auto-populated from
that field.

• Foreign keys are propagated to one level. For example, foreign keys enabled for a Supporting
Business Object will not propagate to a parent Business Object.

• Users cannot manually enter values for Comparison Clauses for a field after foreign keys are
enabled.

• The "like" and "not like" operators used for queries are not supported with foreign-key-enabled
fields.

• Foreign keys are automatically updated when you publish a Blueprint that contains changes made
to foreign key settings for validated fields. The update only occurs for modified foreign key fields and
foreign key fields referenced by those fields. For example, foreign keys for the Sub-Category field
would be updated if changes are made to the Category field.

• Indexes for foreign key fields reference a special internal validation sub-field that is created
automatically. This is an internal reference only, however; on the Business Object Database
Properties page in CSM Administrator, the index is shown for the main foreign key field.

• Foreign key fields shared across Group Members and/or Views must validate from the same table
and field. You may receive validation warnings when shared foreign key fields are not configured
correctly. For steps to correctly configure shared foreign key fields, refer to Configuring Shared
Foreign Key Fields. To automatically configure shared foreign key fields, refer to Foreign Key
Administration.

To store foreign keys for a field:

1. On the Validation/Auto-Populate page, verify that the field validates from a table and that
validation is enforced.

2. Select the Store foreign key check box.
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3. For complex validation scenarios, you may need to define a foreign key relationship. For more
information, see Defining Foreign Key Relationships.

4. Click OK.

Related concepts
Define Auto-population Properties for a Field
Defining Foreign Key Relationships
Example: Defining a Foreign Key Relationship for Asset Status Field
Publish a Blueprint
Configuring Shared Foreign Key Fields
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Defining Foreign Key Relationships
Complex validation scenarios may require you to define a foreign key relationship that correctly links
values in a table to the validated Field. This ensures that values that were identified by name before you
enabled foreign keys are correctly identified by ID in existing search conditions and Expressions after you
enable foreign keys.

This is particularly important if duplicate values with the same name exist.

For example, the Asset Status Field is validated using the Status Field in the CI Status Lookup Table and
uses CI Type as a constraint. As CIs are created, the CI Status values are assigned for each CI Type and
searches are evaluated against the CI Status and CI Type values. Since the values are referenced by
name, the duplicate values do not negatively impact Searches or Expressions.

Once you enable foreign keys, however, values are searched by ID rather than name, and you may have
unexpected results when you use Searches and Expressions created before you enabled foreign keys.

To solve this problem, create a relationship between the CI and CI Status tables. Once the relationship is
configured, Searches and Expressions evaluate against the CI Status value only, rather than the CI
Status and CI Type values.

Process for Defining a Foreign Key Relationship
The general process for defining a foreign key relationship is:

1. Create a Blueprint.

2. Define a foreign key relationship for a Field that:
◦ Is validated from a Lookup Table that may contain duplicate values referenced by name.

◦ Has values limited by a constraint.

3. Create or update validation settings for the Field where you defined the foreign key relationship.

4. Publish the Blueprint.

Related concepts
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Example: Defining a Foreign Key Relationship for Asset Status Field
Storing Foreign Keys for Validated and Auto-populated Fields
Define Auto-population Properties for a Field
Blueprint Scan Errors for Foreign Key Relationships
Define Database Properties for a Business Object
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Example: Defining a Foreign Key Relationship for
Asset Status Field

This example explains how to configure a foreign key relationship for the Asset Status Field in the
Configuration Item Group Leader.

The example assumes that the Asset Status Field is validated using the Status Field in the CI Status
Lookup Table and uses CI Type as a constraint. By adding a foreign key relationship to the Asset Status
Field, you ensure that values are correctly stored for the Field when it is used by Group Members.

Example: Defining the Foreign Key Relationship
To define a foreign key relationship for the Asset Status Field:

1. Create a Blueprint.

2. From the Object Manager, select the Configuration Item (CI) Group Leader, and then click Edit
Group.

3. Open the Status Field to the Validation/Auto-populate page.

4. Select the Store foreign key check box.

5. Click Create.
The foreign key relationship that links Configuration Item to the Lookup Table CI Status is created.
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6. Click OK.

Example: Creating Unique Lookup Values
In some cases, duplicate values may exist in the Lookup Table used in your foreign key relationship. You
must create a new table to store unique values that can be correctly referenced as foreign keys.

In this example, you will create a new Lookup Table to consolidate duplicate Status Field values in the CI
Statuses Lookup Table.

To consolidate duplicate CI Status Field values:

1. From the Object Manager, select Lookup Tables, and then select the CI Status Lookup Table.

2. Select Edit Data.

3. Make note of the duplicate values in the Status Field. In this example, you may see these values:
◦ Active

◦ Down

◦ Expired

◦ In Repair

◦ In Stock

◦ In Testing

◦ New

◦ Ordered

◦ Planned

◦ Etc.

4. Close the Data Editor, and then create a new Lookup Table. For this example, use the name Status
Value.

5. Click OK.

6. Add a Status Field to the new table, and then add the Status Field to the table's Default Form.

7. Return to the Object Manager, and then open the Data Editor.

8. Add a single value for each duplicate value found in step 4.
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9. Close the Data Editor.

Example: Setting Validation for the Foreign Key Relationship
After you create a Lookup Table that stores unique values for your foreign key relationship, you must
enable validation on the Field used as part of the relationship.

In this example, you would set the Status Field in the CI Status Lookup Table to validate from the Status
Field in the newly created Status Value Lookup Table.

Important: The Field used in the foreign key relationship must also store foreign keys.

Related concepts
Defining Foreign Key Relationships
Storing Foreign Keys for Validated and Auto-populated Fields
Define Auto-population Properties for a Field
Configuring Shared Foreign Key Fields
Blueprint Scan Errors for Foreign Key Relationships
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Configuring Shared Foreign Key Fields
Foreign key fields shared across group members and/or views must validate from the same table and
field to ensure that queries retrieve correct data. You can manually configure validation for shared foreign
keys in a Blueprint or mApp Solution.

If shared foreign key fields are not configured correctly, you receive validation warnings when you edit a
foreign key field in a Blueprint or when you run the Foreign Key Configuration Health Check rule.

An example validation warning is:

Foreign key field: Agreement.Supplier in view: (Default) requires field: OL
A.Supplier in view: (Default) to be validated from a table

Good to Know

• You can use the Foreign Key Configuration Health Check rule to return a list of all shared foreign
key fields that are not configured correctly. See About Performance Health Check.

• You can use the Foreign Key Administration dialog to automatically configure shared foreign keys.
See Foreign Key Administration.

• Standard foreign key rules also apply: shared foreign key fields must be validated from a table and
validation must be enforced.

• Constraints for shared foreign key fields can differ between group members and views.

To manually configure share foreign key fields:

1. Create a Blueprint.

2. Examine the validation settings for the first field referenced in the warning. For the warning above,
for example, examine the Supplier field in the Agreement table. Note that the field is validated from
the Supplier Name field in the Supplier table.
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3. For the warning above, examine the Supplier field in the OLA group member table. In this case, the
Supplier field in the OLA table is not validated by a table. (In other cases, the validation tables and
fields may not be identical for the shared foreign key fields, and they must be.)
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4. Select the Validate from Table check box, and then:
a. From the Table list, select Supplier.
b. From the Field list, select Supplier Name.

c. Select the Validation is Enforced check box.

Important: If you are configuring foreign key fields that were previously applied as part
of a Protected mApp™ Solution:

◦ When you upgrade the Business Object, the foreign key is overwritten by the
value from the Protected mApp Solution.

◦ You see a message saying Before applying a foreign key, ensure
'Validate from table' is selected and enforced. Fields that
store foreign keys may need a Relationship defined to
search if duplicate values exist. Use an existing
Relationship or create a new one.

◦ If you don't select Validation is enforced, you cannot make changes to foreign
key settings.
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d. Select Sync to synchronize the validation settings for matching tables for a set of shared
foreign key fields. For example, the settings applied for the OLA Supplier field would be made
to the Supplier field for all members for the Agreements group.

5. Select OK.

6. Publish the Blueprint.

Important: Verify changes before publishing the Blueprint to a production environment.

Related concepts
Storing Foreign Keys for Validated and Auto-populated Fields
Define Auto-population Properties for a Field
Protected mApp™ Solutions
Protected mApp™ Solution FAQs
Related tasks
Create a Blueprint

CSM 2022.3 Features 330

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fbusiness_objects%2Fusing_foreign_keys_with_fields.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fbusiness_objects%2Fdefine_auto-population_properties_for_a_field.html
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=upgradable_mapps_overview
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=upgradable_mapps_faq
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_blueprint


Blueprint Scan Errors for Foreign Key
Relationships

You may receive errors and warnings when you scan a Blueprint that contains foreign key fields.

Error/Warning Symptom Solution

Fields using table validation
that store foreign keys, have
constraints, and for which there
are multiple legal values,
should have a foreign key
relationship defined.

You defined foreign keys for a field without
defining a foreign key relationship.

Define a foreign key
relationship for the field
referenced in the error.

When a foreign key relationship
is specified, the field being
validated against must also
store foreign keys.

You are using a field to validate values for
the foreign key field, but the validation field
does not store foreign keys.

Select the Store Foreign Key
check box for the validation
field.

Related concepts
Storing Foreign Keys for Validated and Auto-populated Fields
Defining Foreign Key Relationships
Example: Defining a Foreign Key Relationship for Asset Status Field
Configuring Shared Foreign Key Fields
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Define Group Properties for a Field
Use the Group page in the Field Properties window to define the Group Members for which a Field is
available. The Group page is only available if the Field is part of a Group Object.

For best results, define all Field properties before defining Group Members.

To define Group properties for a Field:

1. Open the Field Properties window.

2. Click the Group page.

3. Define Group properties.

Option Description

Just this Group Member
Select this radio button to make the Field
available only to the Business Object being
edited.

All Group Members Select this radio button to make the Field
available to all members in the group.

These Group Members

Select this radio button to make the Field
available only to select Group Members. Then,
select the Group Members where the Field will
be available.

4. Select OK.4.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Advanced Properties for a Field
Use the Advanced page in the Field Properties window to define database options, attributes, and more.

To define advanced properties for a field:

1. Open the Field Properties window.

2. Select the Advanced page.

3. Define database options for the Field.

4. Define attributes for the Field.

5. Define presentation options for the Field.

6. Define localization options for the Field.

7. Set value splitting options.

8. View advanced Field information.

9. Enable encryption for the Field.

10. Set Activity Pane mappings.

11. Select OK.11.

12. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Define Database Options
Use database options to store the field in the database, allows nulls, and recalculate field values when a
Business Object is loaded.

To set database options for a field:

1. Select the Stored in database check box to store the field's value in the database table that
represents the Business Object. Clear this check box only if this is a calculated field that gets its
value from other fields stored in the database.

2. Select the Allow nulls check box to allow the field to be stored in the database even if it does not
contain a value.

Note: The Allow Nulls option is not selected by default when a user creates a new logical
field.

3. Select the Recalculate after load check box to recalculate the field’s value each time the Business
Object is loaded.

4. Provide a Custom storage name to use for the database column that represents the field. If the
custom storage name is populated by default, it is recommended that you do not change it.
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Define Attributes
General attributes are additional pieces of information (or meta-data) that can be associated with a field.
Some attributes are automatically set, but others must be provided manually. For example, a Knowledge
Category general attribute indicates that a field contains a category that should be submitted for
Knowledge review.

Database attributes are used to indicate special attributes used for a field’s database table. Most of these
are set by the system. Only advanced users should define database attributes.

For more information about attributes, please contact Support.

To define attributes for a field:

1. Click the down arrow  to expand the General Attributes section or the Database Attributes
section.

2. Click an empty row and provide the attribute name and associated value (if applicable).

Define Localization Options
Use these options to enable localization support for fields and to view current and specific culture
information for the field.

• Supports Localization
For a Current Culture field, you can select or clear this check box to enable localization for the field.

• Current Culture Field
For a Specific Culture Field, you can see the Current Culture Field.

• Culture
For a Specific Culture field, you can see the culture for the field you are editing.

Note: For more information about Localization settings for Lookup objects, see About
Globalization and Lookup Tables.

Define Presentation Options
Presentation options enable you to define how and where the field is exposed to users.

You can:

• Exclude from Form
Select this check box to exclude the field from being displayed in all forms (including summary forms
and mini-summary forms). In addition, the field will not be available in the Form Editor.

• Exclude from Grid
Select this check box to exclude the field from being displayed in all grids. In addition, the field will
not be available in the Grid Editor.

• Category
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Select this check box to separate the field into a folder based on category. Then, select a category
in the drop-down, or provide a new category in the field. When the field is displayed (example: In the
Form Editor, anywhere you can select a field as a token, etc.), it is categorized by folder (example:
Common, System, etc.).

Set Value Splitting Options
Use value splitting to split a name field into various components. For example, you can split a Full Name
field into last name, first name, middle initial, and suffix into separate fields in the Business Object.

You can also view and add values for the title and suffix name components.

View Advanced Information
View additional advanced information for the field:

• Field ID
Click this button to see the field's internal ID. This ID can be used instead of the field name in many
places in the system. For example, the ID is used internally so that fields can be renamed without
breaking any Relationships.

• Find Dependencies
Click this button to scan the field for a list of other definitions in the system that use this field. When
the scan is finished, the Definition Dependencies window opens, listing the dependent definitions.

Enable Encryption for the Field
You can enable encryption for fields in Major Business Objects. Minor objects cannot be promoted to
major objects to enable encryption.

Field encryption requires:

• Encryption keys

• The Business Object's history properties and the Field's General Properties must be set to track
field changes.

Before encrypting fields, review the best practices.

To enable encryption for the field:

1. Select the Enable Field Encryption check box.

2. In the drop-down, select an encryption key (encryption keys are managed using the Server
Manager).

Note: Once a field is encrypted (encryption is enabled and the Blueprint published), it cannot be
reverted to an unencrypted field. To revert it an unencrypted field, it must be deleted and re-
created, resulting in the loss of any data stored in the field.
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Set Activity Mapping
You can map certain Business Object fields to appear in the Activity Pane. First enable Activity Pane for a
major Business Object, then map individual fields to display in the Activity Pane. For more information,
see How to Map Activity Pane Fields.
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General Field Attributes
Field attributes provide additional capabilities. Attributes are set on the Advanced page of the Field
Properties dialog.

General attributes are additional pieces of information (or meta-data) that can be associated with a field.
Some attributes are automatically set, but others must be provided manually. For example, a Knowledge
Category general attribute indicates that a field contains a category that should be submitted for
Knowledge review.

For more information about attributes, please contact Support.

Attribute Description Notes

BarcodeScan
Used to store barcodes from in a field for a
Business Object that has barcode
scanning enabled.

See Configure the Browser
Client to Scan Barcodes.

ChatChannelIdentifier
Used to determine which text field in a
Business Object is used to name channels
in third-party chat integrations.

See Configure Slack
Channel Naming
Conventions.

ChatConversation Used by third-party chat integrations to
store conversations.

See Configure Slack Chat
History Archiving.

ChatConversationWithTime Used by third-party chat integrations to
store JSON from the third-party tool.

See Configure Slack Chat
History Archiving.

HistoryDetails
Used by third-party chat integrations to
store date/time information with
conversations.

See Configure Slack Chat
History Archiving.

Knowledge

Used to associate a field with the
Knowledge attribute and to associate
different fields in the Business Object with
different pieces of Knowledge data. For
example, to retrieve the Title of a
Knowledge article into the Title field of the
Knowledge Business Object, add the
attribute to the Knoweldge Article.Title
field.

See Configure a Business
Object for Knowledge
Import.

LocAltitude Stores the location's altitude. See Set the Location of a
Business Object.

LocLatitude Stores the location's latitude. See Set the Location of a
Business Object.

LocLongitude Stores the location's longitude. See Set the Location of a
Business Object.

TreatAsCacheableForPrompt Displays the list of cached values for the
Business Object field.

See Define List Display
Options (Text Prompts
Only)
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Create Action Fields
Action Fields are configured to hold Actions. You define Action Fields by setting the Action Command"
and "Action Name" Hold properties on two Text Fields.

Use Action Fields to perform Actions based on Field Values. Each Action value can execute the same
default Action (example: "Create Incident and set prioritization") or each value can have its own unique
Action.

Examples for using Action Fields include Action Catalog Widgets and for limiting the Run Another One-
Step Action by scope and Field value.

To create Action Fields:

1. Create a Blueprint.
2. Select the Business Object that will contain the Action Fields.
3. Create or modify a Text Field as the Action Command, and then set these properties on the General

page:
◦ Name/Internal Name: Include "Command" at the end of the Field Name. Example: Next

Status Command.
◦ Length: Minimum of 2,048 characters.
◦ Holds: Select Action command.

4. Create or modify a Text Field as the Action Command Name, and then set these properties on the
General page:

◦ Name/Internal Name: Include "Command Name" at the end of the Field Name. Example:
Next Status Command Name.

◦ Holds: Select Action name.
5. For the Action Command Name Field, select the Validation/Auto-populate page, and then set

these properties:
◦ Auto populate: Select the check box.
◦ Populate when there is a change in Table: Select the table that contains the Action

Command Field, and then select the Action Command Field (example: select the Incident
Status table and the Next Status Command Field).

◦ Action Command: Select this option.
6. Click OK.
7. Publish the Blueprint.
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About Encrypted Fields
An encrypted field can contain encoded data to prevent unauthorized access to sensitive information
(example: Identity information, financial data, etc.).

Encrypted fields can be exposed in CSM using field controls on a form. When an encrypted field is added

to a form, it is accompanied by a button control with a decrypt command . In new records, encrypted
fields are enabled and blank. Data entered into an encrypted field is masked when the decrypt/encrypt
button is selected or when the record is saved (in the Browser Client, tabbing out of an encrypted field
also masks the data). The values are encrypted when the record is saved. In existing records, encrypted
fields appear as read-only masked text boxes. Users with viewing rights can select the decrypt button

 to view data in encrypted fields. All encryption/decryption attempts are tracked in Journal-History
records (enforced) and Splunk server logs (optional). Entering and viewing data in an encrypted field
requires Define Business Object Rights (Access to Data).

Encrypted fields are more restricted than regular fields. Encrypted fields:

• Cannot be searched, displayed in grids, or used in many of the areas where regular fields can
(examples: One-Step Actions, expressions, widgets, etc.).

• Cannot be used in reports as parameters or results.

• Are stored in a database table separate from Business Objects, and cannot be indexed.

• Cannot have default or calculated values, or set values based on lifecycle state.

• Cannot use validation or auto-population.

• Are limited to a maximum of 255 characters.

• Cannot be permanently decrypted or converted back to unencrypted fields.

• The following cannot be encrypted:
◦ Rich Text fields

◦ Attachments

◦ Email messages

◦ Stored values

◦ Public IDs

Configure your system to enable field-level encryption and follow these best practices for encrypting
fields.
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Using Encrypted Fields
Use encrypted Fields to include and protect sensitive data relevant to a Business Object (ex: Identity
information, financial data, etc.). When working with encrypted Fields, Users can:

• Provide sensitive, plain text data in new Business Object records.

• Decrypt encrypted Fields in existing Business Object records.

Good to know:

• Working with encrypted Fields requires Business Object rights.

• When a new record is created, encrypted Fields are blank and editable. However, when the record
is saved, the Field is converted to read-only to prevent unauthorized editing of encrypted data.

• Data entered into encrypted Fields appears as plain text. Data is masked when the encrypt/decrypt
button is clicked or when the record is saved. In the Browser Client, tabbing out of an encrypted
Field also masks the data. Data is not actually encrypted until the record is saved.

• Data in an encrypted Field must be explicitly decrypted by clicking the encrypt/decrypt button. All
decryption attempts are recorded in Journal-History records and in Splunk logs (if configured).
Decrypted data appears as plain text, but is masked again as soon as the User saves the record or
navigates away.

• Encrypted Fields:
◦ Cannot be searched, displayed in grids, or used in many of the areas where regular fields can

(examples: One-Step Actions, expressions, widgets, etc.).

◦ Cannot be used in reports as parameters or results.

◦ Are stored in a database table separate from Business Objects, and cannot be indexed.

◦ Cannot have default or calculated values, or set values based on lifecycle state.

◦ Cannot use validation or auto-population.

◦ Are limited to a maximum of 255 characters.

◦ Cannot be permanently decrypted or converted back to unencrypted fields.
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Configuring Field-Level Encryption
Complete the following procedures in the Cherwell Server Manager and in CSM Administrator to
configure field-level encryption.

Important: To work with encryption keys, you must be an administrator with access to the
Cherwell Server Manager. If you have a hosted environment, please contact Cherwell Support for
assistance with encryption keys. SaaS customers must review and sign a field-level encryption
addendum before working with Support to create encryption keys.

Good to Know:

• Creating encryption keys does not create a backup. You must still export the key files (.ckf) and
store them in a secure location.

• You can only enable encryption on fields where the Business Object's history properties and the
field's general properties are set to track field changes.

• View-level auditing is enforced, and CSM records all attempts to decrypt encrypted fields in Journal-
History records. Business Objects that contain encrypted fields must have a history relationship to
Journals, which can be displayed in the form arrangement.

• Optionally, you can enable compliance logging to track decryption attempts in Splunk server logs.
The Splunk Integration is included in hosted environments by default.

• CSM does not currently support encryption of Attachments.

• The Web API does not have access to view any encrypted fields. Encryptions are not available in
the Public API.

• Field-Level Encryption is supported in multi-lingual environments (all localized versions of CSM).

• Before encrypting fields, review the best practices.

To configure field-level encryption:

1. Configure encryption keys: In the Server Manager, create encryption keys. We recommend creating
a separate key for each Major Business Object in which you plan to use field-level encryption.

2. Enable field-level encryption: In a Blueprint in CSM Administrator, enable encryption for Business
Object fields using encryption keys.

3. Add encrypted fields to the appropriate forms: Open a form in the Form Editor, and add the
encrypted field in the desired location. CSM automatically adds a button control with the Decrypt

Field command . The button is not tied to the field control, and should be treated as a separate
control.

4. Publish the Blueprint.

5. Define security rights for encrypted fields: Use the Business Objects tab in the Security Group
Manager to define who has access to view and/or edit encrypted fields on forms. Encrypted fields do
not have any rights selected by default.
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6. Add a Journal tab: Add Journals to the form arrangements of the appropriate Business Objects so
that users can view the history records for all encryption/decryption attempts on encrypted fields.
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Best Practices for Encrypting Fields
Encrypted fields are more restricted than regular fields and require special handling.

Encrypted fields:

• Cannot be searched, displayed in grids, or used in many of the areas where regular fields can
(examples: One-Step Actions, expressions, widgets, etc.).

• Cannot be used in reports as parameters or results.

• Are stored in a database table separate from Business Objects, and cannot be indexed.

• Cannot have default or calculated values, or set values based on lifecycle state.

• Cannot use validation or auto-population.

• Are limited to a maximum of 255 characters.

• Cannot be permanently decrypted or converted back to unencrypted fields.

For best results, use the following guidelines and considerations when encrypting fields:

• Back up your CSM database prior to encrypting fields so that you can restore your system if you
experience unexpected results.

• Create multiple encryption keys, one for each Major Business Object in which you plan to use field-
level encryption.

• To avoid confusion and potential data loss, use different encryption keys for test and production
environments.

• Ensure encryption keys are backed up.

• Do not store data (.czar files) and encryption keys in the same location.

• For best results, create a new field and encrypt it.

• If it is necessary to encrypt an existing field, keep the following in mind:
◦ The following fields cannot be encrypted: RecID, PublicID, automatically created fields

(examples: Owned By, Owned By ID, Created Culture, etc.), and state fields (example:
Incident.Status).

◦ Check for dependencies to understand the impact of encrypting an existing field. If the field is
used in areas where encrypted fields cannot be used or displayed, encrypting it could have
unfavorable consequences.

◦ Encrypted fields are limited to 255 characters. If you encrypt a field that exceeds this limit, it
will be truncated.

◦ Only text fields can be encrypted. To encrypt a field of a different type, convert it to text,
publish the Blueprint, and then encrypt the field. Ensure the converted text field is long enough
to avoid truncating values.
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Relationships
A Relationship is an association between two Business Objects and allows data to be pulled together in
meaningful ways. When Business Objects are in a Relationship, one object is known as the parent and
the other is the child.

For example, the Incident Business Object is often in a Relationship with the Customer Business Object
so that Incidents can be associated with the appropriate Customers.
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About Relationships
Use Relationships to connect Business Objects to each other so that they can share data.

For example:

• Track Business Object history (example: Notes, emails, record changes, etc.) in a Supporting Object
such as a Journal.

• Show related Business Objects in a Form Arrangement on a record (example: Show a related
Problem on an Incident record).

• Add Approval support to a Business Object.

Major Business Objects can have two types of Relationships:

• Owns: A Major Business Object (the parent) owns another Business Object (the child, typically a
Supporting Object). The child object belongs to the parent object and exists only as long as the
parent object exists (example: Incident Owns Journals, Change Request Owns Tasks).

• Link: A Major Business Object (the parent) is linked to another Business Object (the child, typically
another Major Object). One is a parent and one is a child, but the child can exist without the parent
(example: Customer Links SLA, Problem Links Knowledge Articles).

Supporting Business Objects can have one type of Relationship:

• Owned By: A Supporting Object (the child) is owned by a Major Object (the parent). The child object
belongs to the parent object and exists only as long as the parent object exists.

Relationships cannot be created for Lookup Objects, but Lookup Objects can be selected as children or
parents in Relationships created for Major and Supporting Objects.

A Relationship can be:

• One-to-one: The parent object can link to one instance of a child object (example: Incident Links
Problem).

• One-to-many: The parent object can link to multiple instances of the child object (example: Incident
Owns Journals).

The Relationship Wizard is the most convenient way to create new Relationships. You can use the
Relationship Properties window to define more detailed properties for a Relationship. Both of these
tools are accessed from the Relationship Editor.

Related concepts
About Business Objects
Define Approval Configuration for a Business Object
Best Practices for Performance
Related tasks
Define History Properties for a Business Object
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Relationships Good to Know

Relationships and the "Rule of Two"
You can only view or query a parent object and its children at any given time. While CSM allows you to
violate this rule by building Relationship chains in certain cases, doing so may cause display and
performance issues.

For example, if an Incident is related to a Change and the Change Business Object determines which
form displays based on a third Business Object, such as a Change Details object, Users may encounter
display issues if you embed the Change Details form into the Incident form.

The rule of two also impacts field value selection. Using the example above, when you are working with
Incidents, you cannot traverse the relationship from Change to Change Details to retrieve a value from the
Change Details object.

Finding Relationships in Your System
A full list of Relationships is beyond the scope of this document. From CSM Administrator, export a
schema document in a Blueprint (Blueprint > Tools > Export Schema) to view a full list of Relationships
associated with a particular type of Business Object (example: Major).

To view a list of Relationships associated with one particular Business Object (example: Incident), you can
export a Business Object schema.

Use Visualizations to view graphical representations of Relationships.

Form/Record Editing Guidelines
If a Form/record in the Form Arrangement is in an owned-by Relationship with the parent Form/record
(example: Incident Owns Journals), then it can by edited; however, Forms/records in linked Relationships
(example: Incident Links Problem) are read-only.

Related concepts
About Visualizations
Export a Blueprint Schema
Export a Business Object Schema
Best Practices for Performance
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Managing Relationships
Relationships are managed using the Relationship Editor, accessed from within a Blueprint in CSM
Administrator.

Use the Relationship Manager to:

• Create a Relationship.

• Edit a Relationship.

• Delete a Relationship.

Related concepts
Create/Edit a Relationship
Relationship Editor
Relationship Wizard
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Open the Relationship Editor
Open the Relationship Editor from the Object Manager (within a Blueprint in CSM Administrator).

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to open the
Relationship Editor.
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Relationship Editor
The Relationship Editor within a Blueprint in CSM Administrator allows you to manage Business Object
Relationships.

Use the Relationship Editor to:

• Create Relationships, using either the Relationship Wizard or the Relationship Properties window.

• Edit Relationships

• Delete Relationships

1. Business Object Properties: View the Business Object that the Relationships are associated with.
Select the Bus Ob Properties button to open the Business Object Properties window and easily
make changes to the associated Business Object.

2. Diagram View Tab: Displays an Entity Relationship Diagram view of first-level Relationships
associated with the selected Business Object.

3. Relationship Editor Table: By default, associated Relationships are displayed alphabetically by
name in the Grid View tab. The following details can also be viewed in the Editor Table:

a. Type: Displays whether the Business Object Relationship is a Linked or Owned Relationship.
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b. Child: Displays the type of Child Business Object that is associated with the Relationship. For
more information about Child Business Objects and Relationships, see Define General
Properties for a Relationship.

c. Loads: Displays the Load settings for each Relationship. Customizing Load settings may
impact system speed. For more information on customizing Load settings, see Define
Advanced Properties for a Relationship.

d. Size: Displays whether the Relationship is a one-to-one or a one-to-many Relationship. A one-
to-one Relationship means that the Business Object links to only one instance of a Child
Business Object. A one-to-many Relationship allows the Business Object to be linked to
multiple instances of a Child Business Object. For more information, see Create a Relationship
Using the Relationship Wizard.

e. Description: Displays the description added to a Relationship.

4. Relationship Editor Buttons: Use the following buttons to easily edit existing Relationships or
create a new Relationship from the Grid View Tab:

a. Wizard: Opens the Relationship Wizard with the selected Business Object properties pre-
populated (example: Incident). Use the Wizard to create a new Relationship.

b. Add: Opens the Relationship Properties window. Use the Window to create a new
Relationship.

c. Edit: Opens the Relationship Properties window for the selected Relationship so that
settings can easily be edited.

d. Delete: Deletes selected Relationship.

Note: The Relationship Editor buttons are disabled in the Diagram View tab.

Related concepts
Open the Relationship Editor
Relationship Wizard
Relationships Good to Know
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Relationship Wizard
The Relationship Wizard (accessed from within the Relationship Editor in a Blueprint) is a specialized
tool that automatically creates a new Relationship with all the appropriate properties.

Use the Relationship Wizard to initially and quickly create a new Relationship. Afterwards, you can refine
the properties as needed using the Relationship Properties window (accessed from the Relationship
Editor in a Blueprint). When you create a Relationship using the Relationship Wizard, the wizard:

• Prompts you to define:
◦ General properties (Related Business Object, Relationship type (example: 1-1, 1-Many),

name, description, etc.).

◦ Link Properties: How to connect parent and child Business Objects to each other.

• Creates a Relationship (and a reverse Relationship, if applicable) with all of the appropriate
properties.

Related concepts
Relationship Editor
Create/Edit a Relationship
Relationships Good to Know
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Create/Edit a Relationship
Use the Relationship Wizard or the Relationship Properties window to create Relationships. The
Relationship Wizard is the most convenient way to create new Relationships.

When you create a Relationship, you define:

• General Properties: Related Business Object, Relationship type (example: 1-1, 1-Many), name,
description, etc.

• Link Properties: How to connect parent and child Business Objects to each other.

When you create or edit a Relationship using the Relationship Properties window, you can select some
additional options, including:

• Auditing Options: What to track for the Relationship (example: When related Business Objects are
added, edited, or deleted).

• Advanced Properties: How to handle child objects in a Relationship, define attributes, etc.

Note: The Relationship Wizard and Relationship Properties window are available in the
Relationship Editor (accessed from within the Object Manager in the Blueprint Editor).

To create a Relationship:

1. Open the Relationship Editor.

2. Create a Relationship in one of the following ways:
◦ Using the Relationship Wizard.

◦ Using the Relationship Properties window:
◦ Define general properties for a Relationship.

◦ Define link properties for a Relationship.

◦ Define database options for a Relationship.

◦ Define auditing properties for a Relationship.

◦ Define advanced properties for a Relationship.

3. Publish the Blueprint (File > Publish Blueprint to commit the changes, or save the Blueprint (File >
Save Blueprint) to continue making other changes.

To edit a Relationship:

1. Open a Relationship in the Relationship Editor.

2. Make changes.

3. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Relationship Editor
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Relationship Wizard
Related tasks
Report on Groups with Relationships with Themselves
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Create a Relationship Using the Relationship
Wizard

The Relationship Wizard is the most convenient way to create new Relationships. When you create a
Relationship using the Relationship Wizard, you define the related Business Object, Relationship type
(example: 1-1,1-many), and how to connect parent and child Business Objects to each other.

To create a Relationship using the Relationship Wizard:

1. Open the Relationship Editor.

2. Click the Wizard button.

3. Select a child Business Object:
◦ If you are creating a Relationship for a Major Object:

◦ Select a Supporting Object to automatically create an Owns Relationship.

◦ Select a Major Object to automatically create a Link Relationship.

◦ If you are creating a Relationship for a Supporting Object:
◦ Select a Major Object to automatically create an Owned By Relationship (the

Supporting Object is owned by the selected Major Object).

4. Define Relationship cardinality (how the parent object relates to the child):
◦ One-to-one: Select this radio button to allow the parent object to link to only one instance of

the child object (ex: Incident Links Problem).

◦ One-to-many: Select this radio button to allow the parent object to link to multiple instances of
the child object (ex: Incident Owns Journals).

5. Select whether the child object should have a Relationship back to the parent.
◦ Yes: Select this radio button to create a reverse Relationship from the child object to the

parent object.

Note: Selecting Yes on this page will create two Relationships (after you finish the
wizard): one from the parent to the child, and one from the child to the parent. The
reverse Relationship can be viewed and edited from the Relationship Editor in the child
object.

◦ No: Select this radio button to not create a reverse Relationship from the child object to the
parent object.

6. Select how the child object relates back to the parent:

Note: The Reverse Relationship Cardinality page only appears if you selected Yes on the
Reverse Relationship page.

◦ One parent: Select this radio button to allow the child object to belong to only one instance of
the parent object.

◦ Many parents: Select this radio button to allow the child object to belong to multiple instances
of the parent object.
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Note: If you select Many Parents, and the primary Relationship is one-to-many, the child
Relationship will also be one-to-many. In effect, a many-to-many Relationship exists between
the two objects. Many-to-many Relationships use join tables to link Business Objects together.

7. Select how to link the parent object to the child object. This is done by having one object hold the
RecID of the related object.

Note: This page will not appear if you created a many-to-many Relationship. Many-to-many
Relationships are linked using join tables.

◦ For one-to-one Relationships, select one of the following options:
◦ Child holds the RecID of the parent: Select this radio button to have the child object hold

the ID of the parent object. This is the recommended option because it works for both
one-to-one and one-to-many Relationships.

◦ Parent holds the RecID of the child: Select this radio button to have the parent object
hold the ID of the child object (only works for one-to-one Relationships because the
parent can only hold the ID of one child). Then, select an existing Field in the drop-down,
or click New to add a new Relationship Link field in the parent object.

◦ For one-to-many Relationships:
◦ Select the Field in the child objects to hold the RecID of the parent. You can either select

an existing Field in the drop-down, or click New to add a new Relationship Link field in
the child objects.

Note: These are the default link options and are sufficient for the majority of
Relationships. However, for special cases, you can use the Link page in the
Relationship Properties window for additional link options.

8. Define whether to create a particular Group Member record by default when the Relationship
creates a new child object record.

Note: The Group Leader page only appears if you selected a Group Leader as the child
object.

◦ Yes: Select this radio button to create a particular Group Member record by default when the
Relationship creates a new child object record. Then, select a Group Member in the drop-
down.

◦ No: Select this radio button to not create a a particular Group Member record by default when
the Relationship creates a new child object record. This means that Users must select the
Group Member to use when a child record is added.

9. Select whether to search the child object when a Full-Text search is run on the parent object and its
related items:

Note: This page only appears if you selected to create a reverse Relationship, and if the
child object has Full-Text search enabled in its Search Results properties.

◦ Yes: Select this radio button to have the child object searched when a Full-Text search on the
parent object includes related items.
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◦ No: Select this radio button to not run a Full-Text search on the child object when a Full-Text
search for the parent object includes related items.

If you created a reverse Relationship, and the child object has Full-Text search enabled in its Search
Results properties, you will also be asked whether to search the parent object when a Full-Text
search is run on the child object and its related items:

◦ Yes: Select this radio button to have the parent object searched when a Full-Text search on
the child object includes related items.

◦ No: Select this radio button to not run a Full-Text search on the parent object when the child
object includes related items.

10. Provide a name and description for the Relationship. This is how the Relationship is identified in
the Relationship Editor and throughout the system.

Note: You will also be asked to provide a name and description for the reverse Relationship
if you selected to create one.

11. Review the Summary page.

12. Select Finish.12.

The Relationship is added to the Business Object and is displayed in the Relationship Editor.

13. Publish the Blueprint (File > Publish Blueprint to commit the changes, or save the Blueprint (File >
Save Blueprint) to continue making other changes.
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Create a Relationship Using the Relationship
Properties Window

The Relationship Properties window allows you to define and edit detailed properties for a Relationship.

When you create or edit a Relationship using the Relationship Properties window, you define:

• General properties: Name, description, Relationship type, and cardinality.

• Link properties: How to connect parent and child objects.

• (Advanced Users) Database properties: Options for using a foreign key for the Relationship.

• Auditing properties: Options for tracking records within the Relationship.

• (Advanced Users) Advanced properties: How to handle objects that are children in a
Relationship, define attributes, etc.

Note: The Relationship Properties window is available in the Relationship Editor
(accessed from within a Blueprint in CSM Administrator).

To create a Relationship using the Relationship Properties window:

1. Open the Relationship Editor.

2. Click the Add button.

3. Define properties for the Relationship:
a. Define general properties.

b. Define link properties.

c. Define database properties.

d. Define auditing properties.

e. Define advanced properties.

4. Select OK.4.

The Relationship is added to the Business Object and is available in the Relationship Editor.

5. Publish the Blueprint (File > Publish Blueprint to commit the changes, or save the Blueprint (File >
Save Blueprint) to continue making other changes.
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Define General Properties for a Relationship
Use the General page in the Relationship Properties window to define the following general properties for
a Relationship:

• Name and description.

• Relationship type.

• Relationship cardinality: Whether an object can be related to one or many items.

• Child/parent object in the Relationship.

• Additional options: Relationship uses, reverse Relationships, and Full-Text searching options.

Note: The Relationship Properties window is available in the Relationship Editor (accessed
from within a Blueprint in CSM Administrator).

To define general properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the General page.

3. Define general information for the Relationship:
a. Name: Provide a display name to use within CSM.

b. (Optional) Description: Provide a description to use within CSM.

4. Select a Relationship Type:
◦ For Major Objects:

◦ Link: Select this radio button to make the Relationship a Link Relationship. A Link
Relationship means that the child Business Object can exist without the parent. Typically,
Major Objects are the child objects in Link Relationships (ex: Incident Links Customer,
Change Request Links Problem).
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◦ Owns: Select this radio button to make the Relationship an Owns Relationship. An Owns
Relationship means that the parent object owns the child object (the child object exists
only as long as the parent does). Typically, Major Objects are the parent objects and
Supporting Objects are the child objects (ex: Incident Owns Journals, Knowledge Article
Owns Approvals).

◦ For Supporting Objects:
◦ Owned By: This is automatically selected when you create a Relationship for a

Supporting Object. An Owned By Relationship means that the Supporting Object (the
child) is owned by a Major Object (the parent), and the child object exists only as long as
the parent does.

5. Select the Number of Related Items:
◦ One: Select this radio button to allow the parent object to be related to only one instance of the

child object (ex: Incident Links Customer).

◦ Many: Select this radio button to allow the parent object to be related to multiple instances of
the child object (ex: Incident Owns Journals).

6. Select the child/parent of the Relationship:
◦ Child/parent: In the drop-down, select a child/parent object:

◦ For a Link Relationship: Select a Major, Supporting, or Lookup Object to be the child
object. Typically, Major Objects are the children in Link Relationships.

◦ For an Owns Relationship: Select a Supporting or Lookup Object to be the child
object.

◦ For an Owned By Relationship: Select a Major, Supporting, or Lookup Object to be
the parent object. Typically, Major Objects are the parents in Owned By Relationships.

◦ Default Group Member: If you selected a Group Leader as the child object, select a Group
Member to create by default when the Relationship creates a new child object record.

7. Define additional options for the Relationship:
◦ Relationship Has Different Uses: Select this check box to qualify the way the Relationship can

be used. Then, select the Field that holds the uses. For example, a Relationship could be
used to associate multiple addresses with a Customer (using a field that holds the multiple
addresses, or uses: home, business, etc.).

◦ Reverse Relationship: Select this check box to select a reverse Relationship (from the child
object back to the parent object).

Note: The reverse Relationship must already exist in order for you to select it here. The
easiest way to create a reverse Relationships is through the Relationship Wizard, which allows
you to create the primary (parent to child) as well as the reverse (child to parent) Relationship.
You can also create a reverse Relationship using the Relationship Properties window for the
child object.

◦ When searching (parent) include (child) in Full-Text search: Select this check box to have the
child object searched when a Full-Text search on the parent object includes related items.

Note: This check box is available only if the parent and child objects have Full-Text search
enabled in their search results properties (defined on the Search Results page of the Business
Object Properties window). If you select this check box, the CSM Desktop Client Quick Search
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Pane for the parent object will display a button  that allows the child to be searched as
well.

8. Select OK.8.

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Link Properties for a Relationship
Use the Links page in the Relationship Properties window (accessed from the Relationship Editor) to
define how Business Objects in a Relationship are linked together. When you define link options, you
determine how the underlying database tables for the Business Objects are joined.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within a Blueprint in CSM Administrator).

To define link properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the Links page.

3. Define how to link the parent and child Business Objects:
◦ Default Link, Storing Parent Key in Child Object: Select this radio button to have the child

object hold the RecID of the parent object. This is the recommended option because it works
for both one-to-one and one-to-many Relationships.

Then, in the Default Link section, select or create a new Field (ex: Parent RecID) in the child
object where the parent object's RecID will be stored.

◦ Default Link, Storing Child Key in Parent Object: Select this radio button to have the parent
object hold the RecID of the child object. This option is only available for one-to-one
Relationships (the parent can only hold the ID of one child).

Then, in the Default Link section, select or create a new Field (ex: Child RecID) in the parent
object where the child object's RecID will be stored.

◦ Use Join Table: Select this radio button to use a third database table to join the database
tables that represent the parent and child objects. The join table will hold the IDs of both the
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parent and child objects. This is how many-to-many Relationships are linked (ex: Multiple
Incidents can link to multiple Configuration Items).

Then, define the type of join table to use:

◦ Standard: Select this radio button to use the standard join table. All joins that use the
standard join table will be stored in the same database table.

◦ Custom: Select this radio button to use a custom join table. Then select an existing table,
or create a new table that is used specifically for the Business Objects in the
Relationship.

To create a custom join table:

◦ Click New.

The Create New Join Table window opens.

◦ Provide a name for the join table.

◦ Define custom join table fields:
◦ Field with Parent ID: Provide the name of the Field in the join table that will

hold the parent object's RecID (by default, ParentID is the name for this
Field).

◦ Field with Parent Type: Provide the name of the Field in the join table that will
hold the parent object's type (ex: Incident, Customer, etc.). By default, Parent
Type is the name for this Field.

◦ Field with Child ID: Provide the name of the Field in the join table that will
hold the child object's RecID (by default, ChildID is the name for this Field).

◦ Field with Child Type: Provide the name of the Field in the join table that will
hold the child object's type (ex: Journal, Approval, etc.). By default, Child
Type is the name for this Field.

◦ Field with Join Reason: Provide the name of the Field in the join table that
will hold the join reason, if applicable (by default, Join Reason is the name for
this Field).

◦ Field with Child Join Reason: Select this check box to create a Field in the
join table to hold the join reason for the reverse Relationship. Then, provide a
name for the Field (by default, Child Join Reason is the name for this Field).

◦ Select OK.◦

The custom join table is created with the defined Fields.

Use a custom join table to:

◦ Enhance performance. If you expect to join an extremely large number of records,
having a custom join table allows the join to be stored separately, rather than in a
standard table with all other joins.
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◦ Store additional information related to the join. For example, if you are linking an
Incident to a Vendor, you can build the link through a work order.

Note: The join tables in the drop-down were created for other Relationships. If you select
an existing table, this Relationship will share a database table with the other
Relationships that use the selected table.

◦ Acts as child in join table: Select this check box to store the parent object's type
and ID in the child type and ID fields. For example, in an Incident Links
Configuration Items Relationship, the reverse Relationship (Configuration Items
Link Incident) would have Acts as child in join table selected, allowing both
Relationships to use the same row in the database table.

(Optional) Define a join reason. Join reasons allow you to provide brief information about why
two objects are joined together.

◦ Join Has Reason: Select this check box to enable join reasons for the table. The
subsequent options are available only if this check box is selected.

◦ Prompt User for Join Reason after Add/Link: Select this check box to prompt Users for a
join reason when records are added or linked in a tab in a Form Arrangement.

◦ Join Reason: Provide a reason for the join. This is displayed as the join reason column
header in the Grid view of the Form Arrangement tab. The Grid can be filtered based on
the join reason field.

◦ Join Reason Prompt: Provide custom text to display in the Prompt window that asks
Users for a join reason when records are added or linked in a tab in a Form
Arrangement. If no custom text is provided, the join reason is used.

◦ Provide List of Values: In the drop-downs, select a Business Object and Field to use as
the join reason.

◦ Auto-Populate Join Reason for Reverse Relationship: Select this check box to auto-
populate the join reason for the reverse Relationship.

Note: This option is only available if Provide List of Values is selected and the standard
join table is used. If a custom join table is used, it must have a Child Join Reason field
with a ChildJoinReason attribute. When you create a new custom join table, you can
select the option to create this Field with the appropriate attribute. If you use an existing
custom join table, you might have to manually add the Field (including the attribute) to
the join table (within a Blueprint).

Select an option for auto-populating the join reason for the reverse Relationship, either:

◦ From Field: Select this radio button to the use a value from a Field as the join
reason for the reverse Relationship. Then, in the drop-down, select a Field from the
Business Object selected in the Provide List of Values drop-down.

◦ Use Same Join Reason for Reverse Relationship: Select this radio button to use
the same join reason for the reverse Relationship as is used for the primary
Relationship.
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◦ Set up custom link: Select this radio button to create custom criteria for linking the parent and
child objects.

◦ Use Constraints: Select this check box to define constraints that limit when a new child is
added to the Relationship.

◦ Define constraints that limit when a new child is added to the Relationship:
◦ Select Add to add a constraint or filter.

◦ Select a field in the Business Object you are currently working with.

◦ Select an operator (example: Equals).

◦ Value: Select a value for the field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

◦ Select OK.

◦ Add additional constraints as necessary.

◦ Auto-populate: Select this check box to define fields and values that are auto-populated
when a new child is added to the Relationship.

◦ Define a list of Fields and values that are auto-populated when a child is added to a
Relationship:

◦ Click Add to add a Field that is auto-populated with a defined value.

Tip: Click Edit to edit a selected auto-populated Field. Click Delete to
remove a Field from the list of auto-populated Fields.

◦ Define a Field to auto-populate and the value to use to auto-populate the
Field:

◦ Field: In the drop-down, select a Field from the parent or child object.

◦ Value: In the drop-down, select a value to use to auto-populate the
Field. Applicable values include:

◦ Fields (from the parent or child object)

◦ Expressions

◦ Metric Values

◦ Stored Values

◦ System Functions

◦ Select OK.◦

4. Select OK.4.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Database Properties for a Relationship
Use the Database page in the Relationship Properties window to create and enable foreign keys for the
Relationship. Foreign keys establish and enforce a link between tables in a relational database, and are
required by SQL Reporting Services.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within a Blueprint in CSM Administrator).

Important: It is recommended that you do not use foreign keys unless you have a specific need to
do so.

To define database properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the Database page.

3. Define database options:
◦ Use Blueprint Defaults for Foreign Key: Select this check box to use the global database

options defined for Blueprints.

◦ Create Foreign Key for Relationship: Select this check box to create a foreign key for the
Relationship.

◦ Not Enforced/Enforced: Select whether or not to enforce foreign keys.

◦ If enforced, define whether to cascade updates and/or deletes:
◦ Cascading Update: Select this check box to cascade updates. This means that if

row in a related Business Object table containing a key referenced by the foreign
key is updated, all rows that contain the Foreign Keys are also updated with the
new value.
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◦ Cascading Delete: Select this check box to cascade deletes. This means that if row
in a related Business Object table containing a key referenced by the foreign key is
deleted, all rows that contain the foreign keys are also deleted.

4. Select OK.4.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Auditing Properties for a Relationship
When you enable auditing on a relationship, you define which changes to child object records are tracked
in the parent object's history records. Use the Auditing page in the Relationship Properties window to
define auditing options for records in the relationship.

Auditing options are not available for "owned by" relationships.

To define auditing properties for a relationship:

1. Open the Relationship Editor. See Open the Relationship Editor.
2. Select Add to add a new relationship or select Edit to edit an existing relationship.
3. Select the Auditing page.
4. Select Enable Auditing to enable auditing for the records within the relationship.
5. Define auditing options, which differ depending on the type of relationship.

◦ For an "owns" relationship, choose to create audit records when a child object is added,
edited, or deleted, and then select:

◦ Combine Child Changes: Creates a single audit record indicating that a linked record
was updated, but does not provide field-level details.

◦ Separate Field Edit Records: Creates separate audit records for each field changed in
a linked record. This option is only available if you select Audit Edits.

◦ For a "linked" relationship:
◦ Audit Deletes: Select to track when a linked object is deleted.
◦ Audit Linked Records: Select to track when a linked object is added.
◦ Audit Unlinked Records: Select to track when a linked object is unlinked from the

parent.
6. Select OK.
7. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File

> Save Blueprint) to continue making other changes.

Related concepts
About Relationships
Relationships Good to Know
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Define Advanced Properties for a Relationship
Use the Advanced page in the Relationship Properties window to define advanced properties for a
relationship.

Define the following relationship properties:

• Advanced Options: Options for deleting child objects when parent objects are deleted, making
records in the relationship read-only, reloading the relationship when constraints change.

• Load Options: Options for loading relationship data (load all data, load only keys, or load based on
size).

• Groups: Options for defining group member type when child records are added (only applicable if
the child object is a Group Object).

• Attributes: Additional pieces of information (or meta-data) that can be associated with the
relationship. Some attributes are automatically set, but others must be provided manually.

Many of the settings on this page can impact performance. For guidance, see Relationships and
Performance.

To define advanced properties for a relationship:

1. Open the Relationship Editor. See Open the Relationship Editor.
2. Select the Advanced page, and then define the following options:

◦ Delete children with parent (Owns Relationships only): Select this option to delete child
objects when the parent object is deleted.

◦ Read-only: Select this option to make records in the relationship read-only. Users can view
records for the relationship, but cannot add or remove records.

◦ Load immediately: Select this option to load the child object when the parent is loaded. If this
option is cleared, the child object may not be loaded until it is needed.

Note: This check box can affect system performance. Only change this setting if
absolutely necessary.

◦ Automatically create record (Owns Relationships only): Select this option to automatically
create a child object when the parent is created.

◦ Children must be in final state before owner can go into final state: Select this option to
ensure that child objects are in a final state before the parent object can be set to its final
state. For this setting to be effective, both the objects in the relationship must have lifecycles
defined with a status designated as the final state.

Tip: If one or both objects in the relationship has no associated lifecycle, this option is
not visible.

◦ Reload Relationship when constraint Fields change: Select this option to reload the
relationship data when a field that defines one of its constraints changes values.
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Normally, relationships are loaded and updated based on specialized controls (tabs, related
item selectors). However, if you have relationship constraints based on fields whose values
can change for other reasons, the data in the relationship will not be up to date if the values in
those fields change. For example, the SLA related to an Incident might change based on the
selected Incident category and priority, which are relationship constraints. When the Priority
or Category fields change, the relationship should be reloaded to show the relevant SLA.

◦ Don't load when constraints are blank: Select this option to not load the relationship if the
fields that define its constraints do not contain any values.

◦ Exclude Relationship from Grid customization (Link Relationships only): Select this option
to prevent users from personalizing the Tab Grid for linked records that appear in the parent
object's form arrangement.

3. Define load options for the relationship:
◦ Load everything (default): Select this option to load the entire table of related data into

memory.
◦ Load keys only: Select this option to load only the keys for the relationship, along with pages

of records as needed. Keys are the primary key for a record row and are usually the RecID
column. If loading from a grid, the number of fields is limited to those on the grid.

◦ Load based on size: Select this option to have the system decide how to load data. If the
estimated dataset exceeds 3 MB, only keys are loaded. If the estimated dataset does not
exceed 3 MB, the entire dataset is loaded. The dataset estimate is based on the definition
type, such as the number of fields and their type, as well as the amount of text stored in the
fields.

◦ Default Sort Field When Loading Keys: If loading keys or loading based on size, select a
field from the related Business Object to determine the order in which the keys are loaded.

◦ Ascending: Select this option to sort the data in ascending order (example: 0-10, A-Z)
based on the selected field.

4. Define advanced Group options for the relationship:

Note: The Groups section is only available if the child object is part of a group.

a. Select the down arrow to expand the Groups section.
b. Define options for determining the type of group member that is created when a child object is

added to the relationship:
◦ Type is set manually (when added): Select this option to allow users to select the group

member that is used as the child in the relationship. No member is used until a user
selects it.

◦ Type automatically changes based on:
◦ Field: Select to use the value from a field in the parent object to determine which

group member to use. Then, select a field in the drop-down list. For example, in an
Incident Links Customer Relationship, Incident might have a Customer Type field
that can hold the values External or Internal.

◦ Expression: Select this option to use an expression that returns the group member
type. Then, select the ellipsis to open the Expression Manager, where you can
select an existing expression or create a new one; or select the Custom

Expression button  to create a custom expression.
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c. Define additional options for determining when a group member is added to the relationship:
◦ Only auto-create when Group Member type can be determined: Select to

automatically create a group member only after the group member type is determined. If
the group member type is based on a field or an expression, the system will not
necessarily know which group member to create until the field has been populated or the
expression has been evaluated. If you check this option, the system will wait until there is
a value in the field or until the expression is evaluated before it creates a group member.

◦ Set Group Member ID in parent: Select this option to populate the group member type
field in the parent object with the Group Member's RecID when the group member is
created.

Note: This option is only available if you selected to determine the group
member type based on a field in the parent object.

◦ Transfer fields when Group type changes: Select this option to transfer fields from
one group member to another when the group member type changes.

5. Define attributes for the relationship. Database attributes are used to indicate special attributes used
for a Business Object’s database table. Most of these are set by the system.

◦ General Attributes: Select the down arrow to expand the General Attributes section. Then,
select an empty row and provide the attribute name and associated value (if applicable).

◦ Database Attributes: Select the down arrow to expand the Database Attributes section.
Then, select an empty row and provide the attribute name and associated value (if applicable).

Note: Only advanced users should define attributes. For more information about
attributes, please contact Cherwell Support.

6. View additional advanced information for the relationship:
◦ Relationship ID: Select to open a window that displays the internal ID that is used for the

relationship. This ID can be used instead of the relationship's name in many places in the
system.

◦ Find Dependencies: Select to scan the relationship for a list of other definitions in the system
that use this relationship. When the scan is finished, the Definition Dependencies window
opens, listing the dependent definitions.

7. Select OK.
8. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Open the Relationship Editor
Open an Existing Blueprint
Define Lifecycle Properties for a Business Object
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Entity Relationship Diagrams
Generate an Entity Relationship Diagram (ERD) to create a visual representation of first level
Relationships associated with a Major or Supporting Business Object.

View an Entity Relationship Diagram
To view a Entity Relationship Diagram:

1. In CSM Administrator, create a new Blueprint or open an existing Blueprint.

2. Select a Business Object type from the Blueprint Editor task pane (example: Incident).

3. Select Edit Relationships from the Structure section. The Relationship Editor opens.

4. Select the Diagram View tab. One-to-one Relationships are displayed with a single line, and one-to-
many Relationships are connected with three lines. Hover over a connecting line for information on
whether the Relationship is linked or owned by.

5. (Optional): To export the diagram, right-click anywhere in the Diagram pane and select Export.
Export the diagram to Visio, as a PDF, or as a .svg file.

Edit Business Object Colors
To edit the color that represents each Business Object in an ERD:

1. In CSM Administrator, create a new Blueprint or open an existing Blueprint.

2. Select a Business Object type from the Blueprint Editor task pane (example: Incident).

3. Select Edit Business Object.
4. Right-click in the Business Object Properties Grid and select Properties (example: Incident

Properties). The Business Object Properties Manager opens.

5. Select the Advanced tab.

6. Click the Color Selector icon in the Associated Color field.

7. Choose a color to represent the selected Business Object in an Entity Relationship Diagram.

8. Select OK to close the Business Object Properties Manager.

9. Select Save.
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Relationships and Performance
Relationships provide a powerful way to pull record data together in meaningful ways. To ensure your
relationships meet the needs of your users without impacting performance, follow these best practices.

Limit the Number of Record Loads
You can change load settings on the Advanced page of the Relationship Properties dialog. See Define
Advanced Properties for a Relationship.

There are several options for limiting the number of records that load for one-to-many relationships:

• Load only child objects that are referenced by the parent object.
For example, when an incident loads, the related Journal tab references all journal records that exist
in a one-to-many relationship between the Incident and Journal Business Objects; by default, all of
these journal records are loaded, even if they are not referenced by the incident.

To address this issue, clear the Load immediately check box, and then select the Don't load when
constraints are blank check box.

• Load only necessary data for child records.
You can choose to provide data from the primary key for child records rather than a large set of
fields. The primary key is usually the RecID column and only this row for each record is returned.

To do so, select the Load keys only option when defining load options for the relationship.

Any performance improvement made by setting the Load keys only option depends on the number
of records in that relationship. Good candidates for this setting include Journals and tabs that
include Related Incidents and Customer's Other Incidents, if they exist.

For tabs using an expression to show the number of records in a relationship, the records on that
tab are loaded regardless of the Load keys only setting. We recommend avoiding this scenario.

• Prevent tabs from loading immediately.
If records are loading slowly, some tabs might be loading a large number of records from the
relationship. Address this issue by clearing the Select the tab when it becomes visible check box
on the Tab page of the Tab Properties dialog.

Expressions and One-to-Many Relationships
Expressions that use one-to-many relationships may cause performance issues because only the first
record in a relationship is evaluated by an expression, even if thousands of records are returned. You
should replace expressions that use one-to-many relationships with expressions that use one-to-one
relationships.

Note that it is acceptable to use one-to-many relationships for aggregate expressions.

Related concepts
Best Practices for Performance
Related tasks
Define Advanced Properties for a Relationship
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Forms
A CSM form is a graphical representation of a CSM Business Object that is used to view and input data
directly into the Business Object's fields using configurable form controls (text boxes, combo boxes, links,
buttons, and so on) and an optional form arrangement (a special tabbed area that displays related data).

For example, when you view an Incident record in CSM , you are viewing the Incident Business Object
form; each form control represents an Incident field.
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About Forms
Forms usually include several different types of form controls and a form arrangement at the bottom.

In a Blueprint, a form is typically identified by the form icon . A form arrangement is typically identified
by the form arrangement icon .

A theme controls the colors and styles of the form and its controls and gives the form a cohesive look. To
see a sample form, see Tour a Form.

The following types of forms are available for each Business Object:

• Standard form: By default, each Business Object has one designated default standard form;
however, you can create as many standard forms as you need. For example, create one form for an
internal support team and another for an external support team to show different data, or create
smaller forms to embed in one larger default form (example: Toggle between a detailed and
summary view of a Knowledge Article).

• Summary form: A summary form is a smaller form with a subset of information. Typically, a
summary form is used on a form arrangement tab where only a subset of information is required
(example: Customer summary, such as name, department, title, and contact information).

• Mini-summary form: A mini-summary form is a much smaller form with a very small subset of
information. Typically, a mini-summary form is used as an embedded form when only a very specific
subset of information is required (example: Very brief customer summary, such as name and contact
information).

• View-only form: An uneditable view of a form. A view-only form is used to review (not edit) form
details in a CSM Portal view.

• Edit-existing form: An editable version of a view-only form. An edit-existing form is used to edit
form details in a CSM Portal view.

Note: The view-only and edit-existing form types are only available in a CSM Portal view. You can
switch to a CSM Portal view in the Blueprint Editor in CSM Administrator using the Current view
drop-down list. See Open the Form Editor.

For each Business Object, the following are also available:

• Form arrangement: A form arrangement is a tabbed collection of child forms and records that can
be dynamically displayed on a parent form/record to convey related information (example: Journals
or tasks related to the parent record, or an additional form for the same record that displays fields in
a different way).

• Form view: A form that is always created implicitly within the context of a Business Object View so
that data from a Business Object can be exposed in a more secure and more personal way. For
example, create an Incident form for a CSM Portal view so that customers can access a simpler
Incident form and grid. See Presenting Different Views to Users.
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To help manage (create, edit, and delete) forms, CSM provides the Form Editor; to help manage form
arrangements, CSM provides the Form Arrangement Editor. Both tools are accessed from within a
Blueprint in CSM Administrator.

Managing Content-Protected Forms
If you are working with forms that were previously applied as part of a Protected mApp™ Solution:

• You see a shield icon  alongside content-protected forms.

• If you open a content-protected form in CSM Administrator, you see a large transparent shield
watermark in the Form Editor.

• You can't edit or delete a content-protected form, but you can copy a form, then edit or delete it.

• The copied form contains all protected definitions from the original form. The copied form itself isn't
content-protected, but everything within the form is. For example, One-Step™ Actions and
expressions are protected because they are not copies.

• Toolbars are disabled in both the Definition Reviewer and Form Editor.

• If you install a new Protected mApp Solution containing a form with a name that already exists, the
form in the target system has an underscore prefix (_) added to avoid naming conflicts.

Related concepts
Form Editor
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Tour a Form
Forms are highly configurable so no two forms necessarily look or behave alike.

The following figure shows an example Incident form. The individual components are the different kinds of
form controls: Field form controls display and store field data, standard form controls enhance design and
data entry, and special form controls provide advanced CSM functionality. The form arrangement at the
bottom provides access to related information, organized by tabs.

1. Label: Identifies the record as an Incident.

2. Link Label: Runs a One-Step Action to change the status of the record.

3. Form Arrangement: Displays related information, organized by tabs. Some tabs display content
from relationships; other tabs display additional Incident forms.

4. Related Item Pickers: Special controls that allow you to quickly view related information for
customers, CMDB, or a configurable list of values.

5. Field Label: Identifies the field to which it is tied.

6. Matrix Selector: Special control that displays a configurable matrix.
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7. Field Controls (Text Box, Combo Box, Check Box): Enables you to input/select values for a field
(data is saved to the record). Numerous other field controls are also available (example: Spinner,
radio button, etc.).

Note: The field type (example: Text, number, date/time, and logical) determines which
control is used by default to represent the field (example: Text fields use a text box; validated
text fields use a combo box; number fields use a text box but can use a spinner; rich text
fields use a rich text box; date/time fields use a text box with calendar; and logical fields use
a check box).
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Form Controls
A form control is a mechanism that allows you to interact with data on a form.

CSM provides the following types of form controls:

• Field form controls: Displays/stores data from a Business Object field (example: Text box, Combo
box, Rich Text box, Text box with calendar, and check box).

• Standard form controls: Enhances design and data entry.

Buttons and link labels can execute a single Action when selected (example: Run an Action). Labels
may or may not be tied to a field control. Radio buttons are associated with a field.

• Special form controls: Built-in CSM controls with enhanced functionality (example: Embedded form,
matrix selector, and related item picker).

The following table describes the different form controls:

Icon Form Control Description

Field Controls

Text Box

Rectangular frame into which you can type text.
This can be a single-line text box or a multi-line
text box (field property determines the number of
lines).

Use for: Text fields and Number fields.

Combo Box

Rectangular frame into which you can either
type a value or select a validated value from a
list.

If validation is enforced on the field, you can only
enter valid values into the control.

Use for validated: Text fields and Number fields.

Rich Text Box

Rectangular frame into which you can type/paste
rich text (formatted text and/or images). Use this
control for access to formatting options the use
the Rich Text Zoom window (F8). See About
Rich Text.

Use for rich text: Text fields.
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Icon Form Control Description

Text Box with Calendar

Rectangular frame with a pop-up calendar. Type
a date or select a date from the calendar pop-up
window.

Use for: Date/Time fields.

Number Box with Spinner

Rectangular frame that you can either type a
number or select an incremental number from a
list.

Use for: Number fields.

Check Box

Square box that you select or clear to indicate a
logical decision (example: Enabled/disabled, on/
off, yes/no).

Use for: Logical fields.

Standard Controls

Banner Title and image (example: Company name and
logo).

Button Capable of executing a single action when
selected (example: Run an Action).

 Group Box/Tabbed Group Box
"Container" shape around other controls you use
to organize other controls and enhance the
appearance/usability of the form.

Image Custom image you use to enhance the
appearance/usability of the form.

Label

Text that identifies or enhances other form
elements (example: The form itself, area,
control, group of controls, and such like). Often,
a label is tied to and identifies a field control.

Link Label
Underlined text that is capable of executing a
single action when you select it (example: Run
an Action).

List Box Rectangular box with multiple values.

Radio Button List of choices; stores a value for the selection.

  Shape
Various shapes (ellipses, lines, and rectangles)
that organize other controls and enhance the
appearance/usability of the form.

Special Controls
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Icon Form Control Description

Embedded Form

Provides a "container" frame for one or more
embedded forms. The control's properties define
when and how the embedded forms are
displayed. See Embedded Forms.

Lifecycle Progress Indicator

Shows users where their Business Object
(example: Incident) is in its lifecycle. Current
status and stage is shown; this is a read-only
control.

Matrix Selector Displays a configurable matrix.

Related Item Picker

Allows you to quickly access related information
to view or populate a field with a value. In CSM,
you can access the following related information:

• Customer (example: Contact Manager 

and Customer Record )

• CMDB (example: CI database  and CI

Record )

• Configurable list of values (example:
Incident categorization)

Related Item Viewer
Allows you to see a list of related items that you
can select and open in a new window (example:
Similar Incidents or Knowledge Articles).

Transition Status Control

Allows you to transition a Business Object from
one status to another in its lifecycle. A tooltip is
present to explain why a particular transition may
not be possible.

The following figures show some of the different form controls.
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Related concepts
Field Form Controls
Standard Form Controls
Special Form Controls
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Field Form Controls
A field form control is a form control that displays and stores data from a Business Object field.

Use a field form control to:

• Provide data to a Business Object field (empty record).

• View a stored value from a Business Object field (completed record).

The field type determines which control is used by default to represent the field (example: Text fields use
a text box). If the field properties of an existing field control change after the control has been added to a
form, you should remove and re-add the control to the form in order to get the correctly associated control
to display (example: If you change a text field to be a rich text field, you should remove and re-add the
control so that the field is represented by a rich text control).

CSM supports the following types of field form controls:

• Text Box: Rectangular frame into which you can type text. A text box control is used with text and
number fields.

• Combo Box: Rectangular frame into which you can either type a value or select a validated value
from a list. A combo box is used with validated text and number fields.

• Rich Text Box: Rectangular frame into which you can type/paste rich text (formatted text and/or
images). This control allows access to formatting options using the rich text Zoom window (F8).

• Text Box with Calendar: Rectangular frame with a popup calendar, into which you can type a date
or select a date from the calendar popup window.

• Number Box with Spinner: Rectangular frame into which you can either type a number or select
an incremental number from a list.

• Check Box: Square box that is checked or cleared (unchecked) to indicate a binary decision
(example: Enabled/disabled, on/off, yes/no).

 Text,  number,  date/time, and  logical field.

The following figure shows the field form controls on a form.
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Related concepts
Configuring Field-Level Encryption
Form Theme Properties
Related tasks
Add a Field Form Control to a Form
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Field Form Control Properties
Field form control properties can be set for text fields in the Text Control Properties dialog box, and for
number fields in the Number Control Properties dialog box.

Text Field Control Properties
Right-click a text field control and select Control Properties to set the following properties.

Note: Encrypted fields cannot be validated, so these control properties do not apply.

Property Description

Show drop-down Select this check box to display a drop-down of values. Clear the check box to
display a plain text box.

Sort by Select the Field to use to sort the search results (example: Name).

Ascending Select this check box to list the values in ascending (A-Z, 1-10) order.

Hide entry
(password) Select this check box to hide the values in the control with dots.

Show placeholder
text

Select this check box to add placeholder text. This option is also available for
rich text and multi-line text boxes. Use this option to add help/starter text that
disappears after a user enters data.

Number Field Control Properties
Right-click a number field control and select Control Properties to set the following properties.

Property Description

Show spinner Select this check box to display spinner arrows in the control . Clear the check box
to display a plain text box.

Spinner
increment

Provide or select the number by which to increase the counter each time it
increments (example: 1).

Show group
separator

Select an option for displaying number characters (example: Commas, decimals,
etc.). Select True to display characters, False to hide characters, and System to
follow your system's defined rule.
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Standard Form Controls
A standard control is a form control that enhances form design and data entry.

CSM provides the following standard controls:

• Banner: Displays a title (text) and image (example: Company name and logo, title and icon,
permanent contact information, etc.).

• Button: Executes a single Action when clicked (example: Open a rich text Zoom window, launch a
Visualization, view related Knowledge Articles, move to the next form in a multi-form process, etc.).

• Group Box/Tabbed Group Box: Organizes other controls in containers to enhance a form's
appearance and usability.

• Image: Displays a custom image (example: Company logo, team icon, personal photo, etc.).

• Label: Textually identifies or enhances other form elements. Often, a label is tied to and identifies a
field control.

• Link Label: Executes a single Action when clicked (example: Move a record through a workflow,
send a customer e-mail, submit resolution details to the Knowledge Base, etc.).

• List Box: Displays multiple values from which a user can select (example: Call sources, list of
services, distribution list, etc.).

• Radio Button: Presents a list of choices and stores a value for the selection (example: Show all
tabs or just related tabs in a form arrangement, toggle between embedded forms, etc.).

• Shapes (Ellipse, Line, and Rectangle): Organizes other controls to enhance a form's appearance
and usability.

The following figure shows the standard form controls on a form.

Good to know:

• By default, a standard control's font, colors (background, foreground, and border), border style, and
background style properties come from the defined form theme; however you can define your own
properties, if needed.
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• Image controls do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• To include an ampersand character (&) in a label or link label control, enter two ampersands (&&).
One ampersand is used to designate a keyboard accelerator, so entering a double ampersand
escapes the accelerator and ensures that a single ampersand is displayed.

• After a standard form control is added to a form, you can define how the control looks and behaves
on the form (example: Size, alignment, visibility, etc.).
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Special Form Controls
Special controls are built-in CSM form controls with enhanced functionality.

CSM provides the following special controls:

• Embedded Form: Displays one or more embedded forms using either a relationship or an
expression.

• Lifecycle Progress Indicator: Shows the user where they are, in terms of status and stage, and what
is coming next in a Business Object lifecycle.

• Matrix Selector: Displays a configurable matrix (example: A priority matrix). Select one value from
the column header, one from the row header, and the final value from the point where the row and
column intersect.

• Related Item Picker: Allows quick access to critical related information to populate a field with a
value and/or view the related items (example: Customer or configuration item information).

• Related Item Viewer: Allows you to see a list of related items that you can select and open in a new
window.

• Transition Status Control: Allows you to move between statuses in a Business Object lifecycle.

Related concepts
Form Controls
Add a Special Form Control to a Form
Embedded Forms
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Embedded Forms
This type of form that can be embedded into another form as a separate entity.

Use embedded forms to maintain and reuse smaller chunks of data, and to conditionally display the right
data at the right time.

For example:

• Show troubleshooting questions on your Incident form, then replace them with resolution details
when you are ready to close.

• Display your standard embedded survey form in the last step of a portal form to solicit customer
feedback.

• Allow users/customers to toggle between simple and detailed forms so that they can view more
details only when needed.

Embedded forms are created the same way as any CSM form, but are then added to another form using
the Embedded Form control.
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Form Arrangements
A form arrangement is a tabbed collection of child forms and records that can be dynamically displayed
on a parent form/record to convey related information.

A form arrangement can display:

• A form from any configured relationship: For example, the Incident Business Object is often in a
relationship with the Journal, Configuration Item, and Problem Business Objects, so any of those
forms/records can be displayed in the Incident's Form Arrangement. If a form/record in the form
arrangement is in an owned by relationship with the parent form/record (example: Incident Owns
Journals), then it can by edited; however, forms/records in linked relationships (example: Incident
Links Problem) are read-only.

• Any form created for the same Business Object: For example, Incident has several forms that
display Incident fields in different ways (example: Resolution Details, Incident Details, etc.), so any
of these Incident forms can be displayed on the main (default) Incident form.

Tip: This is useful for displaying summary information, a subset of information, or
information that is not always visible (example: Details from an embedded form).

A typical form arrangement might include:

• Journals: Track what occurs during the lifecycle of a record (example: Notes and history).

• Approvals: Track approving/denying/abstaining content by one or more designated users or teams.

• Configuration Items: Track managed assets that make up the CMDB.

• Knowledge Articles: Track records that share knowledge (example: FAQs, how-tos, workarounds/
solutions, tutorials, processes, reference, etc.) among users and customers.

• Announcements: Track announcements with customers and/or other users.

The following figure shows an example Incident form with its form arrangement (1). The Incident Form
Arrangement contains important data related to an Incident (example: Journals, Tasks, Resolution Details,
Problems, etc.).
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Managing Content-Protected Form Arrangements
If you are working with form arrangements that were previously applied as part of a Protected mApp™
Solution:

• You see a shield icon  next to all content-protected relationships.

• You cannot edit or delete a content-protected form arrangement.

• You can create and edit new Form Tab relationships on content-protected Forms using the Form
Arrangement Editor.

• You cannot edit or delete content-protected relationships but you can create new relationships that
you can edit and delete.
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Presenting Different Views to Users
Forms can be created to present different views on a Business Object's data to users.

A Business Object view is an entity that contains an instance of a Business Object for which a form can
be used to expose data from it in different ways. These forms can be used to expose the data to a user in
ways that are more secure and more personal via a role.

You can create multiple forms for a Business Object view. A typical example is:

• Create an Incident form for an internal help desk and create a different Incident form, with a different
view, for an external help desk. For example, create an Incident form for a Portal view so customers
can access a simpler Incident form and grid. This form might display only required fields, and field
labels may be changed so that they make sense to a customer.

After a Business Object view is created, you can select it and then create forms for the view.

Tip: When creating a form for a Business Object view consider the application where the
Business Object in the view is exposed. Typically, forms created for a Business Object view used
in the CSM Portal should be simpler and less complex than forms created for a Business Object
view used in the CSM Desktop Client.
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OOTB Forms
CSM provides a set of OOTB forms to get you started.

The following OOTB forms are available:

• Default Regular Form for each OOTB Business Object. In some cases, multiple regular forms are
provided.

• Summary and Mini-Summary Form for most Major and Supporting Objects (although not all are
used).

• Form Arrangement for each OOTB Major Object.

• Form Views of most Major Objects for the OOTB Portal View.
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Using Forms
Using forms and form arrangements varies by Business Object.
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View a Form
To view a form:

• In the CSM Desktop Client main window: When you log or view a record.

• In the CSM Browser Client main window: When you log or view a record.

• In the CSM Portal: When you log or view a record.

• In Cherwell Mobile (simplified mobile form): When you view a record.

• In CSM Administrator: When you create/edit a form.
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Managing Forms
Use the Classic Form Editor, or the Dynamic Form Manager and Dynamic Form Editor to manage
forms from within a Blueprint in CSM Administrator.

Use the Classic Form Editor to:

• Create a classic form.

• Edit a classic form.

• Convert a classic form to a dynamic form.

• Delete a form.

Note: You can use the Form Wizard from within the Classic Form Editor. The Form
Wizard is a specialized tool that automatically creates a new form with all the appropriate
fields and control properties.

Use the Dynamic Form Manager and Dynamic Form Editor to:

• Create a new dynamic form.

• Edit a dynamic form.

• Clone a dynamic form to a classic form.

• Delete a dynamic form.

Note: Selecting to create or edit a dynamic form in the Dynamic Form Manager opens the
Dynamic Form Editor.

Managing Content-Protected Forms
If you are working with classic forms that were previously applied as part of a Protected mApp™ Solution:

• You see a shield icon  alongside content-protected forms.

• If you open a content-protected form in CSM Administrator, you see a large transparent shield
watermark in the Form Editor.

• You can't edit or delete a content-protected form, but you can copy a form, then edit or delete it.

• The copied form contains all protected definitions from the original form. The copied form itself isn't
content-protected, but everything within the form is. For example, One-Step™ Actions and
expressions are protected because they are not copies.

• Toolbars are disabled in both the Definition Reviewer and Form Editor.

• If you install a new Protected mApp Solution containing a form with a name that already exists, the
form in the target system has an underscore prefix (_) added to avoid naming conflicts.
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Form Editor
The Form Editor is a tool within a Blueprint in CSM Administrator that lets you manage (create, edit,
clone, and delete) forms. You can define how a form and its controls look and behave.

When you make changes in the Form Editor, the changes are immediately reflected in the preview.
Publish a Blueprint to commit the changes. The Form Editor contains:

1 Form Menu Bar item: Displays form-specific commands. This menu is displayed on the Blueprint
Editor menu bar only when a form is active.

2

Blueprint Editor Toolbar: Displays common Blueprint operations.

Note: When using the Form Editor, the cut, copy, paste and delete options are removed
from the Blueprint Editor toolbar and displayed on the Form Editor toolbar instead.

3

Forms list: Lists the forms defined for the selected Business Object. To open a form in a tab,
double-click the form in the Forms list. The default form for each form type (if one exists) is
underlined.

Tip: To widen or narrow the forms list, drag the horizontal margin. If the Show in folders
button is selected (default), you can collapse or expand the tree list of form types.

4

Tab group: When you double-click a form in the Forms list, the form is opened on a tab. You can
reorder and float/dock tabs. For more information, see Simultaneous Form Editing.

The selected tab shows the active form. The active form is not determined by the form selected in
the Forms list.
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5

Form Editor Toolbar: Displays commands for formatting the appearance and behaviors of a form
and its form controls.

Note: The Form Editor toolbar commands differ slightly for forms with classic or universal
themes applied.

6

Search Control / Show in folders button: Use to quickly locate and display fields. See Form Editor
Behaviors.

Note: You can also use the separate Search Control / Show in folders button for the
Forms list.

7 Adaptive Layout Guide Bar: Shows the breakpoints for the Adaptive Layouts that are configured for
the form. A triangle indicates the layout that is currently selected.

8

Fields tree: Lists the Business Object fields you can add to the form (as controls). Fields are
organized alphabetically and by folder. To add a field to a form, select it in the Fields tree and drag it
onto the form.

Tip: Create, edit, and delete a field directly from the Form Editor by right-clicking in the
Fields tree. See Create/Edit a Field.

9 Controls tree: Lists the form controls you can add to the form. To add a control to a form, select it in
the Controls tree and drag it onto the form.

10 Form preview: Displays a dynamic preview of the form.

Related concepts
Simultaneous Form Editing
Form Editor Toolbar
Publish a Blueprint
Blueprint Editor Menu Bar
Expressions
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Open the Form Editor
To create, edit, clone and delete forms, open the Form Editor within a Blueprint in CSM Administrator.

You can open the Form Editor from the Blueprint Editor and, depending on the type of form, the relevant
form may be opened in a tab automatically.

Regardless of the type of form for which you open the Form Editor, you can open and edit multiple forms
in tabs. For more information, see Simultaneous Form Editing.

Open the Form Editor for a Standard Form

1. In the CSM Administrator main window, select the Blueprints category, and then select the Create1.
a New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its main pane. The Object Manager lists
the existing Business Objects.

2. In the Current view drop-down list, select the Business Object View whose forms you want to2.
access.

3. In the Business Object tree, select the Business Object whose forms you want to access.3.

Tip: Filter the Business Objects by selecting the Major, Supporting, Lookup tables, or All
radio button.

4. From the Appearance list in the Object Manager, select the Edit form link.4.

Tip: You can also select View > View Form on the Blueprint Editor menu bar or select the

Form toolbar button  on the Blueprint Editor toolbar.

The Form Editor opens, displaying the available forms for the Business Object.

5. To open a form, double-click it in the Forms list. Alternatively, you can select the Create a new form5.
link to create a new form.

Open the Form Editor for a Summary Form or Mini-Summary Form

1. Complete steps 1-3 for standard forms above.

2. From the Appearance list in the Object Manager, select either the Edit summary form or Edit2.
mini-summary form link.

The Form Editor opens, displaying the available forms for the Business Object. The default
summary form or mini-summary form is automatically opened in a tab.

Note: If no default summary form or mini-summary form exists, you are prompted to create a
new form of the relevant type. Selecting:

◦ No stops the Form Editor from opening. No new default form is created.
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◦ Yes opens the Form Editor, creates a new default form of the relevant type and opens
the new form in a tab.

Open the Form Editor for a View-Only Form or Edit-Existing Form

1. Complete steps 1-3 for standard forms above.

Note: View-only and Edit-existing forms are only available via a Portal View. Accordingly, in
the Current view drop-down list, select the appropriate Business Object View.

2. In the Appearance area of the Object Manager, select either the Edit view-only form or Edit "edit2.
existing" form link.

The Form Editor opens, displaying the available forms for the Business Object. The default View-
only form or Edit-existing form is automatically opened in a tab.

Note: If no default View-only form or Edit-existing form exists, you are prompted to create a
new form of the relevant type. Selecting:

◦ No stops the Form Editor from opening. No new default form is created.

◦ Yes opens the Form Editor, creates a new default form of the relevant type and opens
the new form in a tab.
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Form Menu Bar Item
The Form menu bar item appears on the Blueprint Editor menu bar anytime a form is active. Use the
Form menu bar item to access form-specific commands.

Action Description

New form Opens the Form Properties dialog box to create a new named form.

Clone this form Opens the Form Properties dialog box to clone an existing form.

Delete this form
Deletes the active form.

Disabled if the active form is set as the default form of its type.

Make this the default
standard form

Make this the default
mini-summary form

Make this the default
summary form

Make this the default
edit-existing form

Make this the default
view-only form

Makes the active form the default form of its type for the Business Object.

Disabled if the active form is already set as the default.

Note:

This menu option is dynamic. The displayed option changes
depending on the type of active form. For more information on form
types, see About Forms.

Form properties Opens the Form Properties dialog box to access defined form properties,
such as name, form type, and description.

Change theme Opens the Select a Theme dialog box to select a defined theme.

Web controls corner
style

Select a visual style for web control corners when viewing the active form in
a web browser; either rounded or right-angled.

Alternatively, you can use the system default style for all forms configured in
system settings.

Form wizard Launches the Form Wizard, which automatically creates a form with all the
appropriate fields and control properties.

Adaptive Layouts

Opens a new menu of options for managing the form's adaptive layouts. Use
this menu to toggle between adaptive layouts, edit properties for the selected
adaptive layout, create a new adaptive layout, delete the selected adaptive
layout, or manage adaptive layout presets.
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Action Description

View/set tab order
Displays the currently defined tab order (order in which the cursor moves to
the next field control when the tab key is pressed). Change the tab order, if
needed.

Clear tab order
Clears the currently defined tab order.

Disabled if no tab order is set.

Auto-select labels with
controls

When selected, automatically selects both the field label and control when
they are tied together. This is useful for moving controls together.

Auto-move contained
controls

When selected, automatically moves all controls contained within the
boundary box of another control (example: Moves all controls within a Group
Box, or Rectangle, etc.). This is useful for moving controls together.

New control label
placement, horizontal Places the control label to the left of a new control.

New control label
placement, vertical Places the control label above a new control.

Show Rulers Shows the vertical and horizontal rulers in the Form Editor.

CSM 2022.3 Features 402

CSM 2022.3 Features



Form Editor Toolbar
Use the Form Editor toolbar to quickly access common commands for formatting the appearance and
behaviors of a form and its form controls. The toolbar is made up of smaller toolbars:

Form Editor toolbar displayed when using a classic theme.

Form Editor toolbar displayed when using a universal theme.

1

Clipboard Controls Toolbar

Options to cut, copy, paste and delete form controls. When using the Form Editor, these options are
only displayed in the Form Editor toolbar and not the Blueprint Editor toolbar.

Note: These options are also available from the Edit menu bar item on the Blueprint Editor
toolbar.

2

Formatting Toolbar

Options for formatting form control text/label (font, style, size, and alignment), colors/styles
(foreground, background, and border), and behaviors (visibility, anchoring, and image). Also displays
options for accessing a form background color.

3
Label Toolbar

Options for defining form control labels and wrapping.

4
Desgin Toolbar

Options for aligning and placing form controls.

5
Snapping Settings Toolbar

Options for enabling a grid to which you can snap form controls.
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6
Adaptive Layouts Toolbar

Options for managing a form's adaptive layouts.

Good to know:

• Move a toolbar by grabbing the grab bar  and dragging the toolbar to a new location.

• Many of the toolbar options are also available from the Form Editor context (right-click) menu.

Clipboard Controls Toolbar

Button Action Description

Cut

Moves the selected item to the
clipboard, so you can then
paste the item elsewhere.

Disabled until you make a
selection in the Form Editor.

Copy

Copies the selected item to the
clipboard, so you can then
paste the item elsewhere.

Disabled until you make a
selection in the Form Editor.

Paste

Inserts an item from the
clipboard.

When pasting to the same form,
the item is pasted in an offset
position (slightly overlaid on the
original item). When pasting to a
different form, the item is pasted
in the original item's position.

The pasted item's properties are
the same as the copied item.
You can name and customize
the pasted item.

Disabled until you cut or copy a
selection in the Form Editor.

Delete

Deletes the current selection.

Disabled until you make a
selection in the Form Editor.
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Formatting Toolbar
The Formatting toolbar offers multiple options for text, color/style, and behaviors. Specifically:

• Form control text/label

• Control color/style

• Control behavior

• Form background color

Form Control Text/Label:

Button Action Description

Form control text (classic themes toolbar)
Form control text (universal themes toolbar)

Classic theme: For forms using a
classic theme there are two different
font modes for form control text:

• Theme Font: Uses the default
theme control font.

• Explicit Font: Allows you to
set an explicit font and other
font details on a control-by-
control basis.

To switch to theme mode, select
Theme Font from the top of the list.

To switch to explicit mode, select a
font in the drop-down.

Universal theme: For forms using a
universal theme, the theme
association fonts are listed. Select a
theme association font to apply the
selected form control text (example:
Label, banner, list text, etc).

Font size (classic themes toolbar only)

Explicitly sets the form control font
size (example: 10 points).

Note: This option is only
available when using
explicit font mode and
classic themes.
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Button Action Description

Font selection and style (universal themes
toolbar only)

Opens the Font Settings dialog.

Associates the form control with the
theme font, or an explicit font you
select in the Font drop-down list.

Additional text formatting selections
are available (example: size, bold,
underline and alignment).

Selecting an explicit font changes
the entry in the Form Control Text
drop-down list to (Custom),
indicating that the font selected is
not a theme font.

Note: This option is only
available when using
universal themes.

Font style (classic themes toolbar only)

Adds style to the form control font
(bold, underlined, or italics).

Note: This option is only
available when using
explicit font mode and for
classic themes only.

Horizontally align text (classic themes toolbar
only)

Aligns text left, center, or right on a
horizontal axis within the form
control bounding box.

Vertically align text (classic themes toolbar
only)

Aligns text top, middle, or bottom on
a vertical axis within the form control
bounding box.
Select the drop-down arrow to
define the alignment option.

Control Color/Style
For further information on expressions, see Expressions
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Button Action Description

Background color

Classic theme: Select the button to
use the most recently used color
(assuming you have set a color). To
explicitly apply a color, select the drop-
down arrow, and then select a solid
color or a gradient. You can use an
expression to conditionally change the
color.

Universal theme: Select the button to
open the Color Selector dialog, and
then select a color association as
defined in your theme color palette. To
use a custom color, select (Custom) in
the drop-down list, and then select a
Web color, or create a custom color.

Text color

Classic theme: Select the button to
use the most recently used color
(assuming you have set a color). To
explicitly apply a color, select the drop-
down arrow, and then select a solid
color or a gradient. You can use an
expression to conditionally change the
color.

Universal theme: Select the button to
open the Color Selector dialog, and
then select a color association as
defined in your theme color palette. To
use a custom color, select (Custom) in
the drop-down list, and then select a
Web color, or create a Custom color.

Border color

Classic theme: Select the button to
use the most recently used color
(assuming you have set a color). To
explicitly apply a color, select the drop-
down arrow, and then select a solid
color or a gradient. You can use an
expression to conditionally change the
color.

Universal theme: Select the button to
open the Color Selector dialog, and
then select a color association as
defined in your theme color palette. To
use a custom color, select (Custom) in
the drop-down list, and then select a
Web color, or create a Custom color.
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Button Action Description

Border style

Sets the style of the border around the
form control (No Border, 3D, or Pixel
width), if there is a border.

Select the button to use the most
recently set style (assuming you have
set a style). To explicitly apply a style,
select the drop-down arrow, and then
select a style.

Note: While you can select 3D
borders for any form control,
rounded shapes do not allow
3D settings.

Control Behavior
For further information on expressions, see Expressions

Button Action Description

Visibility

Conditionally controls when the
form control appears and
disappears. The visibility is based
on an expression.

Select the drop-down button to
define a custom expression. Select
the drop-down arrow to access
options for creating a custom
expression, selecting a stored
expression, or clearing the
expression.

Visibility by Expression

Conditionally controls when the
form control is available. The
visibility is based on an expression.

Select the drop-down button to
define a custom expression. Select
the drop-down arrow to access
options for creating a custom
expression, selecting a stored
expression, or clearing the
expression.
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Button Action Description

Localization options

Enables you to:

• Copy control size and position
from one culture to another.
See Managing Translated
Content on Forms.

• View translations for form
control text. See Viewing
Translations for Definitions.

• Apply language packs to one
or more controls. See
Applying Language Pack
Bundles to Definitions or Form
Controls.

Control anchor

Sets the anchoring behavior of the
form control.

Select the button to use the most
recently set anchoring options
(assuming you have set an option).
To explicitly apply an anchoring
option, select the drop-down arrow
next to the button to open the
Anchoring window, and then select
an anchoring option.

Control image

Defines the image to display on the
form control, as well as alignment.

Select the button to open the Image
Manager, and then select an image
to show on the form control. Select
the drop-down arrow to access
options for creating a custom
expression, selecting a stored
expression, clearing the expression,
or aligning the image.

Form Background Color
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Button Action Description

Form background

Sets the form background
color.

Select the button to use the
most recently set color
(assuming you have set a
color). To explicitly apply a
color, select the drop-down
arrow, and then select a
single color or a gradient
(gradients are available for
classic themes only). With
classic themes, you can use
an expression to conditionally
change the color.

Note: The drop-down
is available for
classic themes only.
For universal themes
you select a color
association as
defined in your theme
color palette, or
create a custom
color.

Label Toolbar

Button Action Description

Label Text
Box

Defines the text/label that appears on the currently selected form control.

Type the text into the Label text box.

Note: This value only affects the primary selected form control.

Expression

Conditionally defines the text that appears on the currently selected form
control. You can use either:

• Expression Manager: Select this option to open the Expression
Manager, and then select an existing stored Expression or create a
new stored Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Select this option to open the Custom
Expression Builder, and then create a custom Expression to use only
for the active scenario.
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Button Action Description

Tooltip Defines the tooltip that appears when a user hovers over the form control.

Design Toolbar
The Alignment toolbar controls alignment, size, and order.

For most alignment operations, you must select at least two form controls. The last selected control is the
controlling control (the control against which all other selected controls are sized and aligned). The
controlling control is identified by black handles. All other selected controls are identified by white handles.

Button Action Description

Line up
horizontally

Lines up all the selected form controls against the left, center, or right
edge of the controlling form control.

Line up
vertically

Lines up all the selected form controls against the top, middle, or bottom
edge of the controlling form control.

Sizing
Sizes all the selected form controls to be the same width, the same
height, or both the same height and same width as the controlling form
control.

Auto-size Sizes a text form control to be exactly the right size to hold all its
contained text. Sizes an image to be its original size.

Bring to Front

Moves a form control in front of other form controls. Use this if creating
various layering effects.

Note: Not all form controls are allowed to be in front or behind all
other form controls (example: Most shapes cannot be on top of
most fields).

Send to Back

Moves a form control behind other form controls. Use this if you are
creating various layering effects.

Note: Not all form controls are allowed to be in front of or behind
all other controls (example: Most shapes cannot be on top of
most fields).
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Snapping Settings Toolbar

Button Action Description

Snap to a grid

Select to display a grid in the
form preview.

If enabled, when you move
form controls, they
automatically align with the
grid. When disabled (default),
you can move form controls
anywhere. Enabling the grid
does not affect existing form
controls on the form preview.

To update the grid width,
select the drop-down arrow
and enter a grid snap width in
pixels, then Select.

Use guide snaps

Select to activate guide
snapping.

If enabled, a red guideline is
displayed when you move form
controls. The guideline
suggests the optimal locations
on the form to maintain
alignment with other form
controls.

You can use guide snapping
with single or multiple form
controls.

Adaptive Layouts Toolbar
For further information, see Managing Adaptive Layouts

Button Action Description

Select an Adaptive Layout

Activates the selected
Adaptive Layout in the Form
Editor so that you can change
its design, edit its properties,
or delete it.

Edit an Adaptive Layout Edit the properties of the
selected Adaptive Layout.

Create an Adaptive Layout Create a new Adaptive Layout
for the form.
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Button Action Description

Delete an Adaptive Layout Delete the selected Adaptive
Layout.

Related concepts
Blueprint Editor Toolbar
Expressions
Managing Adaptive Layouts
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Form Editor Behaviors
The Form Editor has built-in behaviors and functions that are useful when creating or editing a form.

Search for Fields

• Field Search control : Use to search for a field by name or description
(example: "Incident" or "Status"). You can search using a specific word or phrase (example:
OwnedBy).

• Show in folders button : Use to hide/display all folders in the Fields tree. Hiding folders displays
all fields directly under the root node, regardless of how they are stored in the tree.

Note: The Search Control and Show in folders button  are displayed on both the Blueprint
Editor and each tab in the Form Editor.

Select a Control

• Select a control or click-and-drag (rubber-band) over the control. This deselects all other controls.

• A selected control is identified by black handles (boxes) around the bounding box. The bounding
box represents the control's vertical and horizontal dimensions.

Select Multiple Controls

• To select multiple controls:
◦ Hold down the Ctrl or Shift keys while you select each control in turn.

◦ Click-and-drag (rubber-band) over the controls you want to select. Any control that is included
(even partially) in the rubber-band box is selected.

◦ Press Ctrl+A to select all controls.

• When multiple controls are selected:
◦ The controlling control is the last selected control, and the control against which all other

selected controls are sized and aligned.

◦ The controlling control is identified by black handles. All other selected controls are identified
by white handles.
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◦ To change the controlling control, hold down the Ctrl or Shift keys and select a different
selected control. The control is removed from the selection. Repeat the action to re-add the
control as the controlling control.

Edit Controls

• To delete a control, select it, and then press the Delete key.

• To edit the detailed properties of a selected control, right-click>Control Properties.

• To edit the field properties of a selected field form control, right-click > Field Properties.

• To duplicate a control, press Ctrl+Drag.

• To move a control, drag the control.

• To maintain aspect ratio when resizing, hold down Shift while sizing.

• To move/nudge a selected control:
◦ One (1) pixel, press an Arrow key.

◦ Ten (10) pixels, hold down Shift and press an Arrow key.

Container Controls

• Group Box, Tabbed Group Box, and Rectangle controls serve as containers for other controls,
including other container controls.

• When a container control is completely nested inside another container control (example: A Group
Box is placed inside another Group Box), a parent-child relationship is formed between the two
controls. When this relationship exists, the parent control carries the child control along with it when
it is dragged across the Form Editor.

• To break the parent-child relationship between nested controls, either drag the child control so that it
partially overlaps the parent control or move it completely outside of the boundaries of the parent
control.

• If a third control is placed inside two nested container controls or within an area of overlap between
two container controls, the third control is a child of both container controls and can be can be
repositioned with either control independently.
For example, in the following image, a Button has been placed inside two nested Group Box
controls. When you drag each Group Box on the Form Editor, the Button will move independently
with the Group Box that is currently in focus.
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When you move one of the nested Group Box controls so that it only partially overlaps with the other
Group Box, as shown in the following example, the Button is a child of both Group Box controls and
can be repositioned with either control independently, even though the two Group Box controls do
not share a parent-child relationship.

Reposition and Resize Controls
To reposition and resize the selected control(s), right-click and choose Position and Size (or press
Ctrl+Shift+P). The window opens. For example:

CSM 2022.3 Features 416

CSM 2022.3 Features



• In the Position field group, enter the left and top pixel location.

• In the Size field group, enter the width and height in pixels.

Note:
The position of the selected control (or, if multiple controls are selected, the entire group's
position) is displayed by default.

Size information is only displayed if a single control is selected, or if multiple selected controls
share the same width and/or height.

When resizing multiple controls, if:

• All selected controls support the Auto-size property (for more information, see Size A Control), an•
Auto-Size Dynamically check box is displayed. The check box is selected if all selected controls
have Auto-size enabled. For example:

If you don't want to use auto-sizing, you can clear the check box and set a width and height for all
selected controls.

• Some (not all) selected controls have Auto-size enabled, the check box is displayed in a mixed-state

. You can select or clear the check box to enable or disable Auto-size for all
selected controls.

• All selected controls are Tabbed Group Boxes, a Tab Width field group is displayed. You can clear•
the check box and specify a new width for the Tabbed Group Boxes.
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Simultaneous Form Editing
Using the Form Editor, you can edit multiple forms simultaneously. This lets you copy and paste controls
between forms, for example. Forms are displayed on tabs. You can float/dock tabs to view forms side by
side or in separate windows.

Simultaneous form editing is useful for working with multiple forms, cloning existing forms and making
different versions of an existing form. You can copy and paste single or multiple controls between forms,
maintaining all control properties (color, font, tooltip, etc.).

• You can open up to nine forms simultaneously.

• Simultaneous form editing is available for all form types.

• Form Editor preferences (example: Show Rulers, snapping settings) are consistent across all tabs.

Note: Simultaneous form editing works best with standard desktop scaling.

Open Multiple Forms in Tabs
If no forms are currently open, you can select the link in the empty form preview to create a new form.
When you create the new form, it is opened in a tab.

Note: To create a new form, you can also select Form > New Form.

To open an existing form in another tab, double-click a form in the forms list. When displaying multiple
tabs, the Form Editor Toolbar is displayed on the active tab and the corresponding form is selected in the
Forms list.

If multiple tab groups are displayed, when you open an existing form, it is added to the same tab group as
the active tab. For more information on docking tabs in multiple tab groups, see Dock Tabs.
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Note: If you open an existing form when the active tab is in a floated window, the new tab is
added to the tab group of the previously active tab in the main window. For more information on
floating tabs to separate windows, see Float Tabs.

When you edit a form, an * (asterisk) is displayed on the form's tab and in the Forms list. This means the
form has changes not yet applied to the Blueprint. You can update the Blueprint or abandon the changes
using the options on the Form Menu Bar Item.

When you edit a form and close its tab without updating the Blueprint, you are prompted to apply the
form's changes to the Blueprint. You can optionally abandon the changes (close the form without saving).

When you edit several forms in multiple tabs and close the Blueprint without updating, you are prompted
to select the forms whose changes should be applied to the Blueprint. Select or clear the check boxes for
each form. For example:

Option Description

Select all
Select all form check boxes.

All check boxes are selected by default.

Clear all Clear all form check boxes.

Apply selected changes

Apply changes for the selected forms to the
Blueprint.

Note: If you clear a check box, changes for
that form are abandoned and are not
applied to the Blueprint.

Abandon all Close the Blueprint without applying changes for any
forms. Changes to the forms are not saved.
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Option Description

Cancel Close the prompt and return to the Form Editor. The
Blueprint and form tabs remain open and unsaved.

Note: The multiple form prompt is also displayed when you close a floated window, regardless of
how many forms are displayed. For more information, see Float Tabs.

Float Tabs
You can drag and reorder the displayed tabs. You can also drag and float a tab to display that form in a
separate window.

To return the tab, drag the window back to the tab list.

Note:

• You can drag multiple tabs to the same floated window. In this situation, docking options are
available for the floated window. For more information, see Dock Tabs.

• You can also float and dock tabs using the appropriate tab menu option. For more
information, see Use the Tab Menu.

Dock Tabs
You can drag and dock a tab. The docking widget is displayed when you drag a tab and point to any area
in which it can be docked (including floated windows).

To use the docking widget, drag a tab to a docking widget option.
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1 Dock to the area's tab group.

2
Dock in a new tab group at the top of the area.

The area is split horizontally. Any existing tabs are moved below the docked tab.

3
Dock in a new tag group at the right of the area.

The area is split vertically. Any existing tabs are moved to the left of the docked tab.

4
Dock in a new tab group at the bottom of the area.

The area is split horizontally. Any existing tabs are moved above the docked tab.

5
Dock in a new tab group at the left of the area.

The area is split vertically. Any existing tabs are moved to the right of the docked tab.

Note: You can also dock tabs using the appropriate tab menu option. For more information, see
Use the Tab Menu.

You can only split an area horizontally or vertically. Consequently, after docking a tab to the:

• Top or bottom, you can only dock subsequent tabs to the top or bottom of that area.

• Left or right, you can only dock subsequent tabs to the left or right of that area.

For example, after docking two tabs to the top of an area, when you dock another tab to that area:

To re-enable all docking widget options for an area, you must re-dock all forms as tabs in that area by:
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• Using the docking widget tab option .

• Dragging the docked tab back to a tab group.

• Using the appropriate tab menu option. For more information, see Use the Tab Menu.

For vertical tab groups, if there is not enough space to display all tabs in the tab group, arrows are
displayed. Click an arrow to scroll left or right in the tab group. For example:

If you reach the end of a tab group and can no longer scroll left or right, the relevant arrow is disabled.

Use the Tab Menu
You can right-click a tab to perform the following actions.

Note:

• The tab menu is dynamic. Some options are displayed or hidden under certain
circumstances.

• Many options let you float or dock tabs. For more information, see Float Tabs or Dock Tabs.

Option Description

Close

Close the tab.

Note: If the form is floated to a separate
window and is the only tab displayed, the
floated window is also closed.

Close All But This

Close all tabs except the right-clicked tab.

Note:
Selecting this option in a floated window
displaying multiple tabs closes all tabs (except
the right-clicked tab) in the floated window.
Tabs open in the main window are unaffected.

Similarly, selecting this option in the main
window closes all tabs (except the right-clicked
tab) in the main window. Tabs open in floated
windows are unaffected.

Float Float the tab to a separate window.
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Option Description

Float All

Float all tabs in the tab group to a separate window.
Other tab groups in the main window are unaffected.

Note: Hidden for tabs in floated windows.

New Horizontal Tab Group

Dock the tab in a new tab group beneath the current
tab group.

Note: Hidden if vertical tab groups exist for the
area.

New Vertical Tab Group

Dock the tab in a new tab group to the right of the
current tab group.

Note: Hidden if horizontal tab groups exist for
the area.

Move to Main Window

Dock the tab to the tab group of the previously active
tab in the main window.

Note: Displayed only for tabs in floated
windows.

Move to Next Tab Group

Dock the tab to the tab group beneath or to the right of
the current tab group, depending on whether horizontal
or vertical tab groups exist, respectively.

Note: Displayed only if tab groups exist
beneath or to the right of the current tab group,
as applicable.

Move to Previous Tab Group

Dock the tab to the tab group above or to the left of the
current tab group, depending on whether horizontal or
vertical tab groups exist, respectively.

Note: Displayed only if tab groups exist above
or to the left of the current tab group, as
applicable.
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Form Design Considerations
Take advantage of important design considerations and tips before creating or editing a form

Before creating a form, consider the following:

• Audience: Who is the form for? (example: User or customer? Technician or executive? etc.)

• Purpose: For what purpose will the form be used?(example: For detailed call logging, for self-
service activities, for read-only purposes, etc.)

• Client access: From where will the form be accessed? (example: CSM Desktop Client, CSM
Browser Client, CSM Portal, or Cherwell Mobile)

• Layout: What types of controls will be on the form (example: Field controls, standard controls,
special controls) and what will it look like? (example: colors, font, alignments, etc.)

• Security: Who can access the form?

• Devices: What devices will be used to access the form?

Review the following tips for designing an effective form:

• Make it useful: Consider the audience and what they need most. Technicians may need very
detailed information, CSM Portal customers may need more simplified and colorful forms, with more
user-friendly labels, casual contributors (example: Knowledge Article contributor) may need
abbreviated details, etc.

• Make it pretty: Do not underestimate the visual experience. Employ visual elements, such as
images, colors, styles, alignment, and layering to convey information and embellish the aesthetic.
Use consistent, browser-friendly fonts and colors (or themes) to ensure stability and cohesion.

• Make it conditional: Use expression-driven colors, text, images, and visibility to dynamically
change the way a control looks and behaves based on a defined condition.

CSM 2022.3 Features 425

CSM 2022.3 Features



Create/Edit a Form
There are several ways to create a new form. You can use any of the following methods:

• Create a new form and add fields and controls manually.

• Create a new form and add fields and controls using the Form Wizard.

• Clone a form from an existing one and edit the fields and controls manually.

To create a new form and add fields and controls manually:

1. Open the Form Editor.
2. From the Blueprint Editor menu bar, select Form > New Form.

The Form Properties - New dialog box is displayed.

3. Enter a name for the form.

4. Select a form type.

5. (Optional) Enter a description of the form.

6. Select OK.

An empty form opens.

7. To create your form Design:
◦ Select a form background color.

◦ (Optional) Edit the Adaptive Layout properties for your form to change its dimensions.

Note: Each form consists of at least one adaptive layout that defines the form's
targeted dimensions. This is the base layout that is generated automatically when you
upgrade an existing form or create a new form.

◦ Add one or more form controls to the form: Field, standard, and special controls.

◦ Define how each form control looks and behaves on the form: text, tooltip, color, image, size,
alignment, anchoring, layering, visibility, enabling/disabling, tab order.

◦ (Optional) Make the form the default form.

◦ (Optional) Create additional Adaptive Layouts for your form so that it can be viewed on
different devices.

8. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

To create a new form using the Form Wizard:

The Form Wizard, accessed from within the Form Editor in a Blueprint, is a specialized tool that
automatically creates a new form with all the appropriate fields and control properties. Afterwards, you
can tweak the controls and properties as needed.
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Note: Fields that are 42 characters long cannot be added to a Business Object when using the
Grid Wizard or Form Wizard. You can, however, add 42-character fields manually.

When you create a form using the Form Wizard, the wizard does the following:

• Prompts you to select a form theme.

• Adds all the appropriate fields from the Business Object, assigning a field form control and label
control.

Warning: If you run the Form Wizard on a form that has two or more adaptive layouts, all of the
layouts are removed and the base layout's dimensions are reset.

1. Complete steps 1–6 as described in the above procedure for creating a new form manually.

2. Select Form > Form Wizard.

3. Select a Theme to use on the form, and then select OK.

The Form Wizard automatically adds all the fields from the Business Object to the form and applies
the theme colors, fonts, and styles.

4. Choose from the following:
◦ Select a Form background color.

◦ (Optional) Edit the Adaptive Layout properties for your form to change its dimensions.

Note: Each form consists of at least one adaptive layout that defines the form's
targeted dimensions. This is the base layout that is generated automatically when you
upgrade an existing form or create a new form.

◦ Add one or more Form Controls to the Form: Field, standard, and special controls.

◦ Define how each Form Control looks and behaves on the Form: Text, tooltip, color, image,
size, alignment, anchoring, layering, visibility, enabling/disabling, tab order.

◦ (Optional) Make the Form the default Form: Applicable only for standard and mini-summary
forms.

◦ (Optional) Create additional Adaptive Layouts for your form so that it can be viewed on
different devices.

5. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

To create a new form by cloning an existing form:

1. Open the Form Editor.
2. From the Blueprint Editor menu bar, select Form > Clone this form.
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The Form Properties - Clone dialog box is displayed.

3. Enter a name for the form.

4. Select a form type.

5. (Optional) Enter a description of the form.

6. Select OK.

The cloned form opens.

7. Make changes to the cloned form as required by changing the existing fields and controls.

8. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

To edit a form:

1. Open a form in the Form Editor.
2. Make your changes.

Note: To access the form properties, from the Form Menu Bar Item, select Form > Form
properties.

3. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Select a Form Theme
Change a form theme in CSM Administrator by selecting another theme and applying it in the Form Editor.

Note: Be aware of the following when selecting a theme:

• Both classic and universal themes are available for selection when a form is currently using a
classic theme.

• When a universal theme is applied to a form, classic themes are no longer available for that form,
you cannot revert to a classic theme.

Select a Classic Theme
Apply a classic theme to a form currently using another classic theme.

1. Open the form in the Form Editor. See Open the Form Editor.

2. On the form background, right-click and select Change theme.

3. Select a classic theme from the Theme drop-down list, and then select OK.

Select a Universal Theme
Apply a universal theme to a form currently using a classic theme.

1. Open the form in the Form Editor. See Open the Form Editor.

2. On the form background, right-click and select Change theme.

3. Select a universal theme from the Theme drop-down list.
The Theme Change dialog opens and displays the following message - "To apply this Universal
Theme, you must upgrade the Form. All controls will be set to the Theme defaults".

Note: When a universal theme is applied, classic theme selection is no longer available.

4. Select Continue to apply the selected universal theme.

Change a Universal Theme to Another Universal Theme
Apply a universal theme to a form currently using another universal theme.

1. Open the form in the Form Editor. See Open the Form Editor.

2. On the form background, right-click and select Change theme.
The Select a theme dialog opens.

3. Select a theme from the Theme drop-down list, and then select OK.
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Note: If the current theme associations are compatible with the selected theme, the theme is
applied to the form and the Select a theme dialog closes. If a custom association is present
in the current theme, but not present in the selected theme, then you need to update the
theme by following the next steps.

The Theme Change dialog opens and displays the following message - "To apply this Universal
Theme, you must upgrade the existing Universal Theme to add custom associations. You can
review these custom associations before updating".

4. Select one of the following:
◦ Accept Update: Any custom associations in the current theme that are associated to controls

on your form are applied to the selected theme.

◦ Review Theme: Opens the Theme Editor with the selected theme displayed. Any custom
color or font associations that were present in the previous theme are added and highlighted in
the selected theme. The image below displays a highlighted custom color association.

5. If you selected Review Theme, select one of the following in the Theme Editor:
◦ Save to save the change to the selected theme and apply the theme to the form.

◦ Cancel to return to the Form Editor, and then select Cancel in the Select a theme dialog to
abort the theme change.

Note: Alternatively, you can cancel the theme change in the Theme Editor, and then
repeat steps 3 - 5 to select and apply another theme.

Related concepts
Create a Theme
Save a Blueprint
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Select a Form Background Color
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to select a background color
for the form.

Note: This topic describes defining a background color on a form with a universal theme. If you
are editing a form with a classic theme, use this link to open the previous version of Select a Form
Background Color.

Good to Know:

• If you are using dashboard themes, use a theme association color for the form background
(example: Form Background). You can select a Web color, or create a custom color; however, if you
use a non-theme color, the background will not change to another theme color when you apply a
different theme.

• Theme colors are defined as part of a theme's definition. Use the Theme Manager to create a
theme.

• Colors can be solid or transparent only, gradients can not be applied.

• State override (conditional) colors can not be applied to a form background.

To select a form background color:

1. Open a form in the Form Editor.

2. On the Form Editor toolbar, select the Background Color button .
3. Select a background color from one of the following color categories:

◦ (Recommended) Theme Association drop-down list:

All color associations defined for the selected CSM theme.

◦ Web: Select (Custom) in the Theme Association drop-down list to display the set of name
web-safe colors, and then select a color.

◦ Custom: Select (Custom) in the Theme Association drop-down list to display the Custom
color selector, and then define a customized red, green, blue (RGB) or Hex value color.

For more information, see Using the Color Selector in a Designer

4. Do one of the following:
◦ Select File > Publish Blueprint to commit the changes.
◦ Select File > Save Blueprint to continue making other changes.

Related concepts
Create a Theme
Form Themes
Publish a Blueprint
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Save a Blueprint
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Add a Form Control to a Form
You can add a variety of controls to forms.
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Add a Field Form Control to a Form
Add field form controls to a form to display and store data from a Business Object field on a form.

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to complete this task.

To add a field control to a form:

1. Open a form in the Form Editor.
2. Do one of the following:

◦ From the Form Editor menu bar, select Form > Form Wizard, and then select Yes to confirm
that you want to automatically add all applicable fields from the Business Object to the form,
overwriting the existing form.

Note: Fields that are 42 characters long cannot be added to a Business Object when
using the Grid Wizard or Form Wizard. You can, however, add 42-character fields
manually.

◦ Drag-and-drop a field from the Field tree to the form.

Tip: If the field you need does not yet exist, create the field directly from the Form
Editor by right-clicking in the Field tree. You can also edit and delete an existing field
by right-clicking in the Field tree.

Remember: If a field is intentionally excluded from forms, it does not appear in the
Field tree and cannot be added to the form. For more information about excluding
fields from forms and grids, refer to Define Advanced Properties for a Field.

◦ Right-click a field in the Field tree, and then select Add to Form.

Tip: By default, the label and control are tied together (that is, they are grouped and move
together). To untie the label from the control, right-click the Label/Control group, and then
clear the Label Tied to Control check box.

3. Optional: Set the control properties.
4. Optional: Define how the Field Control looks and behaves on the form.
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Form Theme Properties
Related tasks
Size A Control
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Add a Standard Form Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a standard form
control to a form.

Good to Know:

• Standard form controls are highly configurable. You can add endless combinations to a form, then
define how the controls look and behave on the form (example: Text, tooltip, size, color, border style,
image, alignment, anchoring, layering, visibility, enabling/disabling, and tab order).

• Button, link label, list box, and radio button controls have additional control properties (right-click and
select Control Properties) that must be configured.

• By default, most form controls acquire their text, color, border style, and background style properties
from the defined Form Theme; however you can define your own properties, if needed.

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a standard form control to a form (general):

1. Open a form in the Form Editor
2. Drag-and-drop a standard control from the Standard control tree onto the form.
3. Define properties for the control, if needed (Button, Link label, List Box, and Radio Button).
4. (Optional) Define how the form control looks and behaves on the form
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Banner Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Banner control to a
form.

Good to Know:

• A Banner control is highly configurable; you can add one or many to a form, then define how the
banner looks and behaves on the form (example: Text, size, color, border style, image, alignment,
anchoring, layering, and visibility).

• By default, the Banner control font, color (background, foreground, and border), border style, and
background style properties come from the defined Form Theme.

• Text, image, and colors can be conditional (expression-driven).

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a Banner control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Banner control from the Standard Controls tree onto the form.
3. Define the text to display on the banner:

a. In the Label text box on the Form Editor toolbar, enter the text to display on the Banner
control.

b. (Optional) Change the font, font size, font style, and font alignment if needed.
4. Define how the banner looks and behaves on the Form (ex: Size, alignment, etc.).
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Button Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Button control to a
form.

A Button control is capable of executing a single Action when selected (example: Run an Action/One-Step
Action).

Good to Know:

• A Button control is highly configurable; you can add one or many to a form, then define the Action to
execute when the button is clicked, and how the button looks and behaves on the form (example:
Text, tooltip, size, color, border style, image, alignment, anchoring, layering, visibility, and enabling/
disabling).

• Text, image, and colors can be conditional (expression-driven).

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a Button control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Button control from the Standard Control tree onto the form.
3. Define the Action to execute when the button is clicked:

a. Right-click the Button control, and then select Control Properties.

b. In the Choose Action window, select the ellipsis  to open the Action Manager, and then
select the Action to execute.

4. Define the text to display on the button:
a. In the Label text box on the Form Editor toolbar, enter the text to display on the Button

control.
b. (Optional) Change the font, font size, font style, and font alignment if needed.

5. Define how the button looks and behaves on the Form (example: Size, alignment, etc.).
6. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Group Box Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Group Box control
to a form.

Good to Know:

• A Group Box control is highly configurable; you can add one or many to a form, then define how the
group box looks and behaves on the form (example: Text, size, color, border style, image,
alignment, anchoring, layering, and visibility).

• By default, the Group Box control text, color, border style, and background style properties come
from the defined Form Theme.

• Text, image, and colors can be conditional (expression-driven).

• Controls added within the boundaries of a Group Box can all be moved together by simply dragging
the Group Box control around.

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a Group Box control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Group Box control from the Control tree onto the form.
3. Define the text to display in the group box:

a. In the Label text box on the Form Editor toolbar, provide the text to display on the Group Box
control.

b. (Optional) Change the font, font size, font style, and font alignment if needed.
4. Define how the group box looks and behaves on the Form (example: Size, alignment, etc.).
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add an Image Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add an Image control to a
form.

Good to Know:

• An Image control is highly configurable; you can add one or many to a form, then define the Action
to execute when the image is selected, and how the image looks and behaves on the form
(example: Tooltip, size, color, border style, image, alignment, anchoring, layering, visibility, and
enabling/disabling).

• Image controls do not support text, background, or foreground; therefore no colors, styles, or fonts
can be applied.

• Images can be conditional (expression-driven).

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add an Image control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Image control from the Control tree onto the form.
3. Define the Action to execute when the image is selected:

a. Right-click the Image control, and then select Control Properties.

b. In the Choose Action window, select the ellipsis  to open the Action Manager, then
select the Action to execute.

4. Define the image to display:

◦ On the Form Editor toolbar, select the drop-down arrow on the Image button , and then
select one of the following options:

◦ Browse: Opens the Image Manager, where you can select an existing image or import
a new image to display on the widget.

◦ From Stored Value: Opens the Stored Value Manager, where you can select an
existing stored value or create a new Stored Value to use.

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a
custom expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an
existing expression or create a new stored expression to use. Stored expressions can be
reused in numerous places in CSM.

◦ None: Does not use an image.
5. Align the image:

◦ Select the drop-down arrow on the Image button, select Image Alignment, and then select an
alignment option within the control (example: Top-right).

6. Define how the Image Control looks and behaves on the Form.
7. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Label Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Label control to a
form.

Good to Know:

• A Label control is highly configurable; you can add one or many to a form, then define how the label
looks and behaves on the form (example: Text, tooltip, size, color, border style, image, alignment,
anchoring, layering, and visibility).

• By default, Label control text, colors, and border style come from the defined Form Theme.

• Text, image, and colors can be conditional (expression-driven).

• To include an ampersand character (&) in a Label control, enter two ampersands (&&). One
ampersand is used to designate a keyboard accelerator, so entering a double ampersand escapes
the accelerator and ensures that a single ampersand is displayed.

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a Label control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Label control from the Standard Control tree onto the form.
3. Define the text to display on the label:

a. In the Label text box on the Form Editor toolbar, provide the text to display on the button.
b. (Optional) Change the font, font size, font style, and font alignment if needed.

4. Define how the form control looks and behaves on the form (example: Size, alignment, etc.).
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Link Label Control to a Form
A Link Label control is capable of executing a single Action when clicked (example: Run an Action/One-
Step Action). You can also enter a simple URL.

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Link Label control
to a form.

To add a Link Label control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Link Label control from the Control tree onto the form.
3. Right-click the Link Label control, and then select Control Properties.
4. In the Choose Action window, define what happens when the link is selected:

◦ Select Action, and then select the ellipsis  to open the Action Manager, and then select
the Action to execute. If you select a One-Step Action, you can optionally select the Show
Progress check box to provide a visual indicator to users that the One-Step Action is
executing when the link is selected.

◦ Select Web Link, and then type the URL of the web page to open.
5. Optionally, select the Don't disable control when form is disabled check box to enable users to

select the Link Label when the form cannot be edited.
6. Select OK.
7. Define the text to display on the Link Label control:

a. In the Label text box on the Form Editor toolbar, provide the text to display on the button.
b. (Optional) Change the font, font size, font style, and font alignment if needed.

8. Define how the control looks and behaves on the form (example: size, alignment, etc.).
9. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Action Manager
Add a Link Widget to a Dashboard
Define How a Control Looks and Behaves on a Form
Form Editor Behaviors
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Add a List Box Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a List Box control to
a form.

Good to Know:

• A List Box control is highly configurable. You can add or many to a form, then define the associated
field, how to order the values in the list, and whether or not to use images and colors next to each
value to help identify them. You can also define how the list box looks and behaves on the form
(example: Text, tooltip, size, color, border style, image, alignment, anchoring, layering, visibility,
enabling/disabling, and tab order).

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a List Box control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the List Box control from the Standard Controls tree onto the form.
3. Define what will be listed in the List Box control:
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a. Right-click the List Box control, and then select Control Properties.

b. Define List Box properties:
◦ Associated field:

Select the field whose values to display in the List Box control.

◦ Sort by:

Select the field to use to order the values, as well as an ascending or descending order. Rarely
will the alphabetical order match the order in which the values should appear in your item,
unless you prefix the values with numbers or letters (example: For status, you would likely
want lifecycle order, not alphabetical order); therefore, it is common to define a field that
contains a sequence number purely for controlling the order (example: Status Order).

◦ (Optional) Show image for each item:

Select this check box to display an image next to each item, and then define an expression to
determine which image to display and when to display it.
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◦ (Optional) Set color for each item:

Select this check box to display an image next to each item, and then define an expression to
determine which color to display and when to display it.

4. Define how the form control looks and behaves on the form (example: Size, alignment, etc.).
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Radio Button Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Radio Button
control to a form.

Good to Know:

• A Radio Button control is highly configurable. You can add one or many to a form, then define the
associated field (field that stores the value) and the value to store, and how the radio button looks
and behaves on the form (example: Text, tooltip, size, color, border style, image, alignment,
anchoring, layering, visibility, enabling/disabling, and tab order).

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a Radio Button control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Radio Button control from the Standard Controls tree onto the form.
3. Define what the Radio Button control will do:

a. Right-click the Radio Button control, and then select Control Properties.
b. In the Radio Button Properties window, define the following:

Associated Field:

Select the field in the drop-down list that will store the radio button's selected ("checked")
value.

Value:

Provide the value to store in the field you selected in the Associated field drop-down list
(when the radio button is selected).
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Example: Add radio button to Show all Tabs. When selected, a Show all Tabs value is stored
in a Tab Visibility field. A form arrangement could then use an expression to conditionally
show/hide tabs based on the value in the Tab Visibility field.

4. Define the text to display for the Radio Button control:
a. In the Label text box on the Form Editor toolbar, provide the text to display.
b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

5. Define how the form control looks and behaves on the form (example: Size, alignment, etc.).
6. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Shape Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Shape control to a
form.

Good to Know:

• Shape controls are highly configurable; you can add one or many to a form, then define how the
shape looks and behaves on the form (example: Text, size, color, border style, image, alignment,
anchoring, layering, and visibility).

• By default, the Shape control color, border style, and background style properties come from the
defined Form Theme.

• Text, images, and colors can be conditional (expression-driven).For example, define an expression
to conditionally change the background color of a control to red to indicate a priority 1 record.

• Rounded shapes do not allow 3D borders.

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add a Shape control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop a Shape from the Standard Control tree onto the form.
3. (Optional) Define the text to display on the shape:

a. In the Label text box on the Form Editor toolbar, provide the text to display.
b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

4. Define how the form control looks and behaves on the form (example: Size, alignment, etc.).
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Add a Special Form Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add Special Form
Controls to a form:
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Add an Embedded Form Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add an Embedded Form
control to a form.

When you add an Embedded Form control to a form, you define:

• Which form to embed inside the Embedded control frame: You can embed a form using a/an:
◦ Relationship: Display a form from a related Business Object. You can display the related

default Regular form, Mini-Summary form, or Summary form.

◦ Expression: To determine the form to display.

• Default display text: Message to display in the Embedded control frame when no embedded forms
are available.

• Allow Scroll Bars: Whether or not to add scroll bars to the embedded form when it extends past
the Embedded Form control's borders, or just truncate the form.

• Form is Read-Only: Whether or not to make the embedded form read-only (un-editable), or allow
users to input values.

To add an Embedded Form control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Embedded Form control from the Special Controls tree to the form.
3. Right-click the control, and then select Control Properties.
4. Define which form to embed inside the embedded control frame using either a/an:

◦ Relationship: Select this radio button to display a form from a related Business Object. Then,
select the Relationship and the related form type to display (example: Regular form, Mini-
Summary form, or Summary form).

◦ Expression: Select this radio button to use an expression to determine which form to display.
Then, define the expression using either:

◦ Stored expression: Select the ellipse button  to open the Expression Manager, and then
select an existing stored expression or create a new stored expression. Stored expressions
can be reused in numerous places in CSM.

◦ Custom expression: Select the Custom Expression button  to open the Custom
Expression Builder, and then create a custom expression specifically for this scenario.

5. Define additional options for the embedded form:
a. Display text when no current form: Provide the message to display in the Embedded Form

control when no embedded forms are available.
b. Allow scroll bars: Select this check box to display scroll bars when the embedded form

extends past the control's frame. Clear this check box to truncate the embedded form if it
extends past the control border.

c. Form is read-only: Select this check box to make the form read-only (un-editable by the
user). Clear this check box to allow users to input values into the embedded form.

6. Select OK.
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7. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Add a Matrix Selector Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Matrix Selector
control to a form.

When you add a Matrix Selector control to a form, you define:

• Validation instructions:
◦ Validation Table: Business Object that supplies all the possible values to the matrix (example:

Priority Matrix Element). Typically, this is a Lookup Object.

◦ Value Field: Lookup field (field in the Lookup Object) that supplies the values (example:
Priority).

◦ Order By: Field to use to order the values in the matrix, as well as an ascending or
descending order.

◦ Field to Populate: Field in the Business Object to populate with the final value from the
matrix.

• Column properties: Values and order to display in the column header.

• Row properties: Values and order to display in the row.

• Constraints: Expressions that limit when the field on the form is populated with the final value from
the matrix.

To add a Matrix Selector control to a form:

1. Open a form in the Form Editor.
2. Drag-and-drop the Matrix Selector control from the Special Control tree onto the form.
3. Right-click the control, and then select Control Properties.
4. Define the validation:

a. Validation table / Validation field: Select the Lookup table and field that supply all the
possible values (example: For Incident, it might be the Status field in the Incident Status
Lookup table, with status values like New, In Progress, Assigned, etc.).

b. Order by field: Select the field to use to order the values, as well as an ascending or
descending order. Rarely will the alphabetical order match the order in which the values
should appear in your item, unless you prefix the values with numbers or letters (example: For
status, you would likely want lifecycle order, not alphabetical order); therefore, it is common to
define a field that contains a sequence number purely for controlling the order (example:
Status Order).

c. Field to populate: Select the field to populate with the final value from the matrix.
5. Define column properties:

a. Column header: Select the field from the Lookup Object that supplies the value for the
column header in the matrix.

b. Save column to: Select the field in the primary Business Object to populate with the column
value selected from the matrix.

6. Define row properties:
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a. Row header: Select the field from the Lookup Object that supplies the value for the row
header in the matrix.

b. Save row to: Select the field in the primary Business Object to populate with the row value
selected from the matrix.

7. Define constraints that limit when the field on the form is populated with the final value from the
matrix:

a. Select Add to add a constraint or filter.
b. Select a field in the Business Object you are currently working with.
c. Select an operator (example: Equals).
d. Value: Select a value for the field. Applicable values include:

◦ Fields
◦ Expressions
◦ Metric Values
◦ Prompts
◦ Stored Values
◦ System Functions

e. Select OK.
f. Add additional constraints as necessary.

8. Select OK.
9. After the control or controls are on the form, use the Form Editor to define how each control looks

and behaves on the form (example: Size, image, alignment, anchoring, layering, visibility, and tab
order).

10. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Add a Related Item Picker Control to a Form
Create a new Blueprint and use the Form Editor to add a Related Item Picker control to a form.

Note: Users may have to disable the pop-up blocker in their browser when searching for related
items in the CSM Portal.

To add a Related Item Picker control to a form:

1. Open a form in the Form Editor.
2. Drag the Related Item Picker control from the Special Control tree onto the form.
3. Right-click the control field in the Form Editor.
4. Select Control Properties. The Related Item Picker Properties window opens.
5. In the Selector type drop-down list select a type:

◦ Customer: Provides access to the Contact Manager and customer records.
◦ CMDB Selector: Provides access to the CI database and CI Records.
◦ List of Values: Provides access to a configurable list of values (example: Incident

Categorization).
6. Optional: Select an option to define default configuration item order for the CMDB window:

◦ Show Config Items for Customer: If selected, the CMDB window displays configuration
items for a single customer by default. This selection only shows if CMDB Selector is chosen
from the Selector type drop-down list.

◦ Show Config Items for All Customers: If selected, the CMDB window displays Configuration
Items for all customers. This selection only shows if CMDB Selector is chosen from the
Selector type drop-down list.

7. Select a relationship in the Relationship drop-down list to attach to the Related Item Picker
control. This relationship determines which related values display in the control.

The Customer control on an Incident form automatically uses the IncidentLinksCustomer
relationship because it displays customer information. The CMDB Control automatically uses
IncidentLinksConfiguration item relationship because it displays CI information. The Customer and
CMDB pickers are only available if the Business Object has a relationship to the customer and
Configuration Item group leaders.

8. Optional: Define the display text:
◦ Store Display Text in Field: Defaults to the public ID. Select the field in the main Business

Object where you will store the related Business Object public ID. This option provides the
option to store the displayed public ID from the related Business Object in a field in the main
Business Object. If you wish to display/store something besides the public ID, choose a field to
store the value and set up the auto-populate in the Business Object properties.

◦ Default Type Hint Field: Select the field in the main Business Object that points to the
appropriate list of values. This option provides the option to provide a list of values when
multiple values are available (example: The Related Item Picker control points to a Group
Business Object and you want to specify a different list of values for each group member).
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9. Grid to Display: Select a custom Business Object grid for users to display when setting properties
for the Related Item Picker within a Business Object form.

Note: If a relationship points to a group leader then users can only select grids associated
with the leader and not those associated with group member objects.

10. Optional: Define one or more filters to constrain the values displayed in the Related Item Picker
control (example: The control field only displays customers from a particular office).

a. Select Add.
b. Select a field in the Business Object you are currently working with.
c. Select an operator (example: Equals).
d. Select a value for the field.
e. Select OK.
f. Repeat for all desired constraints.

11. Optional: Show Placeholder Text: Select this check box to add placeholder text. Use this option to
add help/starter text that disappears after a user enters data.

12. Use the Form Editor to define how each control looks and behaves on the form (example: Size,
image, alignment, anchoring, layering, visibility, and tab order).

13. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

CSM 2022.3 Features 455

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=publish_a_blueprint
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=save_a_blueprint


Add a Related Item Viewer Control to a Form
Add a Related Item Viewer control to a form to see a list of related items.

To add a Related Item Viewer control to a form:

1. Open a form in the Form Editor.
2. Drag the Related Item Picker control from the Special Control tree onto the form.
3. Right-click the control, and then select Control Properties.

The Related Item Viewer Properties window opens.
4. From the Relationship drop-down list, select a relationship to attach to the Related Item Viewer

control (example: Incident Has Knowledge).
This relationship determines which related values display in the control.

5. Select OK.
6. Use the Form Editor to define how the control looks and behaves on the form (example: Size,

image, alignment, anchoring, layering, visibility, and tab order).
7. Publish or save the Blueprint.

Related concepts
Open the Form Editor
Form Editor
Publish a Blueprint
Save a Blueprint
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Define How a Control Looks and Behaves on a
Form

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define how a form control
looks and behaves on a form.
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Define and Format Control Text
Use the Form Editor to define static or conditional label and control text, and font format for the controls
on a form.

Note: This topic describes defining and formatting control text on a form with a universal theme. If
you are editing a form with a classic theme, use this link to open the previous version of Define
and Format Control Text.

A form control has two different kinds of text, both of which are automatically formatted by a form theme:

To add a Related Item Picker control to a form:

• Label: Text to display beside the control to identify the control on the form. By default, the label text
comes from the field name. The label text format (font/size/style) comes from the form theme font
(Label font association).

• Control: Text to display inside the control, either provided by a user (example: Text field) or listed
(example: Drop-down). By default, the control text format (font/size/style) comes from the form
theme font (control font association).

You can manually change any label and apply different text formats, if needed. Use the Form Editor
(accessed from within a Blueprint in CSM Administrator) to define the label and text format for a control.

Good to Know:

• Label text can be conditional (expression-driven). For example, define an expression to change a
label when the status changes.

• Text formatting options include:
◦ Font: Theme or explicit font.

◦ Font size: Point size for font (explicit fonts only).

◦ Font style: Bold, underline, or italics (explicit fonts only).

◦ Alignment: Horizontal (left, center, right) and vertical (top, middle, bottom) alignment of text.

Note: Text color is defined as a foreground color. See Select a Background,
Foreground, and Border Color for a Control.

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To define and format control text:

1. Open a form in the Form Editor.
2. Select a control.
3. Define a label, either static or conditional text:

◦ Static: In the label text box, provide the label to display next to the control.
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◦ Expression-driven text (conditional): Select the Expression button , and then define
the expression (condition) to determine the label, using either:

◦ Stored expression: Select the ellipsis  to open the Expression Manager, and then
select an existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button  to open the Custom
Expression Builder, and then create a custom expression specifically for this scenario.

4. Define text formatting:

a. Font: Select the Edit Font  drop-down list on the Form Editor toolbar, and then select a

font in the Font dialog drop-down list .
◦ Explicit font: The font selected by you is applied.
◦ Theme font: The associated theme font is applied.

b. Font Style: Select Bold, Underline, or Italics .

c. Font size: In the Font Size drop-down list , select a point size (example: 12px).
d. Horizontal alignment: Select one of the horizontal alignment buttons (Left, Center, or Right)

 to align the text on a horizontal axis within the control box.
e. Vertical alignment: Select one of the vertical alignment buttons (Top, Middle, or Bottom)

 to align the text on a vertical axis within the control box.
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Form Editor
Form Themes
About Blueprints
Related tasks
Create an Expression
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Define a Tooltip for a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define a tooltip for a form
control.

A tooltip uses an expression to determine the tooltip text. For example:

• Enter the text and/or Tokens to display in the Expression text box.
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• Display text from a Business Object field.

• Create a Tooltip field to store the tooltip text, and then use an expression key to display it.

Good to Know:

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To define a tooltip for a control:

1. Open a form in the Form Editor.
2. Select a control.

3. On the Form Editor toolbar, select the drop-down arrow on the Tooltip button , and then
define the expression (condition) to determine the tooltip text, using either:

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
stored expression or create a new stored expression to use. Stored expressions can be
reused in numerous places in CSM.

◦ Custom expression: Opens the Custom Expression Builder, where you can create a
custom expression to use only for this scenario.

4. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Size A Control
Change the size of a form control to a specific size or to match the size of other controls.

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define a control's size.
For more information on Blueprints, see About Blueprints.

To size a control:

1. Open a form in the Form Editor.
2. Select a control.

Tip: Hold down Shift while sizing a control to maintain the proper aspect ratio.

CAUTION: If the Auto-select labels with controls (form menu bar item) and Label tied to
control (right-click the label) options are enabled, both the control and label are selected
when either item is selected (the control and label are grouped). Use caution when sizing
"grouped" controls.

3. Do one of the following:

Sizing Method Instructions

Manually size a control.

Drag a handle (white or black boxes) and release
when you reach the desired size.

Auto-size a text control to be exactly the right size
to hold all its contained text.

Select the Auto-size button  on the Form
Editor toolbar.

Note: Auto-size is automatically set on the
following controls: Check box, Label, Link
Label, and Radio button.

Tip: Auto-size is useful for expression-
driven labels because it automatically
resizes the label's bounding box to
accommodate dynamic text.
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Sizing Method Instructions

Explicitly size a control to a specified pixel height
and width.

Right-click the control and select Position and Size
(or press Ctrl+Shift+P) to open the Position and
Size window. For more information, see Form Editor
Behaviors.

Size several Controls to the same width, height, or
width and height.

Select at least two controls (the last selected control
is the controlling control, identified by black handles),
and then select a button on the Form Editor toolbar:

◦ Make Same Width

◦ Make Same Height 

◦ Make Same Size

Resize an Image control to be its original size.
Select the control, and then select the Auto-size

button .

4. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.

Related concepts
Form Editor Behaviors
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Select a Background, Foreground, and Border
Color for a Control

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to select a background,
foreground and border color for the controls on a form.

Note: This topic describes defining and formatting control colors on a form with a universal theme.
If you are editing a form with a classic theme, use this link to open the previous version of Select a
Background, Foreground, and Border Color for a Control.

By default, defined theme colors are applied to a control when the control is added to a form. You can
manually apply different colors, if needed. We recommend always using theme colors.

Good to Know:

• Form theme colors are defined as part of a theme's definition. Use the Theme Manager to create a
theme.

• Each theme property is named and intended for a specific element on a dashboard, form, portal or
action catalog. When the element is added, the item's defined colors, styles, and fonts are applied
by default (example: Form control colors, border style, and fonts are automatically applied to a
control when the control is added to a form). Manually apply a different color or style to most
elements, if needed. The key is to use theme colors, and to apply colors and styles consistently. If a
non-theme color is applied, the element does not change to another theme color when applying a
different theme.

• Background, foreground, and border color options are available on the Form Editor toolbar and
context (right-click) menu.

• CSM Desktop Client and CSM Administrator, transparent colors are displayed white and opaque
colors are displayed as a solid color when applied to a background for the following form control
types:

◦ Text

◦ Number

◦ Date/Time

◦ List

◦ Matrix Selector

◦ Related Item Picker

◦ Combo Box

• State override (conditional) theme colors can be applied to functional controls on a form to
conditionally change the background, border or text color of a control (example: Save button, a
disabled button, a disabled feature or controls containing read-only text).

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To select a background, foreground, or border color for a control:
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1. Open a form in the Form Editor.
2. Select one or more controls.

3. On the Form Editor toolbar, select the Background Color button , the Foreground Color

button , or the Border Color button .

You can also use the context (right-click) menu to select these functions.

The Color Selector dialog opens. For more information, see Color Selector

4. Select a color, either:
◦ Select a theme color: Select a pre-defined theme association color property from the Theme

Association drop-down list (example: Primary Button Background).
◦ Select or define a custom color: Select Custom from the Theme Association drop down

list, and then either:
◦ Select the Web tab, and then select a color from the list.
◦ Select the Custom tab, and then define a color using the Color Selector controls.

5. Select Apply.
6. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Form Editor
Create a Theme
Form Themes
About Blueprints
Color Selector
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Select a Border Style for a Control
Use the Form Editor to select a border style for a form control.

Good to Know:

• See Form Editor Behaviors for tips on working with controls and the Form Editor.
• Border styles options are also available from the context (right-click) menu.

To select a border style for a control:

1. Open a form in the Form Editor.
2. Select one or more controls (to select two or more controls, hold down Shift during selection).
3. On the Form Editor toolbar, select the drop-down arrow on the Border Style button, and then

select a style from the following:
◦ No Border: No border is added.
◦ 3D Border: Adds a three dimensional border around the control.
◦ <n>-Pixel Border: Adds a fixed pixel width <n> border around the control.

4. To add a rounded corner to Rectangle, GroupBox, and Tabbed GroupBox controls, right-click the
control and select Rounded corners from the context menu.

5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Add an Image to a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add an image to a
control.

Images can be:

• Imported: Any image stored in the Image Manager.
• Stored Values: An image stored as a Stored Value (example: Company logo).

• Conditional (expression-driven): For example, define an expression to conditionally display a VIP
icon to indicate a Very Important Customer (example: a CEO).

• None: Control does not use an image.

• Aligned: To the top/middle/bottom and left/right/center of the control.

Good to Know:

• Banner, Button, and Link Label controls support images.

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To add an image to a control:

1. Open a form in the Form Editor.
2. Select a Control.

3. On the Form Editor toolbar, select the drop-down arrow on the Image button , and then
select one of the following options:

◦ Browse: Opens the Image Manager to select an image to show on the control.
◦ From Stored Value: Opens the Stored Value Manager to select an existing/create a new

Stored Value to use.
◦ Custom Expression: Opens the Custom Expression Builder to create a custom expression

to use only for this scenario.
◦ Expression Manager: Opens the Expression Manager to select an existing stored

expression or create a new stored expression to use. Stored expressions can be reused in
numerous places in CSM.

◦ None: Does not use an image.
4. Align the image:

a. Select the drop-down arrow on the Image button, select Image Alignment, and then select
an alignment option within the control (example: Top-right).

5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Align a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to align controls on a form.

Good to Know:

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To align a control to other controls:

1. Open a form in the Form Editor.
2. Select at least two controls (the last selected control is the controlling control and is identified by

black boxes around it).
3. Do one of the following:

◦ To align several controls against a horizontal axis (either left, middle, or right), select one of the

Line Up Horizontally buttons  on the Form Editor toolbar.
◦ To align several controls against a vertical axis (either top, middle, or bottom), select one of the

Line Up Vertically buttons  on the Form Editor toolbar.
◦ To explicitly position a control to a specified location:

◦ Right-click the control and select Position and Size (or press Ctrl+Shift+P) to open the
Position and Size dialog box.

◦ Specify the Left and Top location.
◦ Select OK.

4. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Anchor a Control
You can anchor controls on a form to make your controls grow or shrink to use available space.

Warning:
Although you can anchor form controls, Cherwell recommends using adaptive layouts to
determine how forms adapt to changes in screen size. Adaptive layouts are effective across CSM
Browser Client, CSM Desktop Client, and CSM Portal. For more information on adaptive layouts,
see Adaptive Layouts.

If you use anchoring, form rendering may vary across the CSM Clients.

To anchor controls on a form, use the Form Editor. You can access the Form Editor from within a
Blueprint in CSM Administrator. To select anchoring options, choose the sides of the form to which the
control should be anchored (you can use combinations). Options include:

• Left: Control keeps the same distance to the left edge and moves farther away from the right edge
when the form gets bigger.

• Top: Control keeps the same distance to the top edge and moves farther away from the bottom
edge when the form gets bigger.

• Right: Control keeps the same distance to the right edge and moves farther away from the left edge
when the form gets bigger.

• Bottom: Control keeps the same distance to the bottom edge and moves farther away from the top
edge when the form gets bigger.

• Left and Right: Distance between both horizontal edges remains the same, and the control
stretches to fill the horizontal space when the form gets bigger.

• Top and Bottom: Distance between both vertical edges remains the same, and the control
stretches to fill the vertical space when the form gets bigger.

• All (Left, Right, Top, and Bottom): Distance between all edges remains the same and the control
proportionally stretches to fill both the horizontal and vertical space when the form gets bigger.

Good to Know:

• Top and Left is the default.

• If the control is not anchored to any edge, it floats between the two edges.

• Anchoring options are available on the Form Editor toolbar and context (right-click) menu.

• For tips on working with controls and the Form Editor, see Form Editor Behaviors.

To anchor a control:

1. Open a form in the Form Editor.
2. Select a control.
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3. On the Form Editor toolbar, select the drop-down arrow on the Anchor controls to edges button

.
4. Select an anchoring option (you can use combinations).
5. To save your changes, select Select.

Warning: If you do not select Select, your changes are abandoned.

6. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.

Related concepts
Adaptive Layouts
Form Editor
About Blueprints
Publish a Blueprint
Save a Blueprint
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Layer a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to layer controls on a form
(that is, position a control in front of or behind other controls).

Good to Know:

• Not all controls can be layered in front of or behind other controls (example: Most shapes controls
cannot be on top of fields).

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To layer a control:

1. Open a form in the Form Editor.
2. Select one or more controls (to select two or more controls, hold down Shift during selection).
3. To position a control in front of other controls, select the control, and then select the Bring to Front

button  on the Form Editor toolbar.
4. To position a control behind other controls, select the control, and then select the Send to Back

button  on the Form Editor toolbar.
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Define Visibility for a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator to define when to display or
hide a control (visibility) on a form.

By default, a control is always visible, unless defined (through an expression) to be hidden.

Good to Know:

• See the Controlling Visibility on a Field on a Form free Video Learning Library course.

To define visibility for a control:

1. Open a form in the Form Editor.
2. Select a control.

3. On the Form Editor toolbar, select the drop-down arrow on the Visibility button , and then
select one of the following options:

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a
custom expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
stored expression or create a new stored expression to use. Stored expressions can be
reused in numerous places in CSM.

◦ Clear Visibility Expression: Clears any visibility expression so the control is always visible.
4. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Form Editor Behaviors
Open the Form Editor
Publish a Blueprint
Save a Blueprint
Related tasks
Create an Expression
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Enable/Disable a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define when a form
control is enabled/disabled.

By default, a control is always enabled, unless defined (through an expression) to be disabled.

Good to Know:

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To enable/disable a control.

1. Open a form in the Form Editor.
2. Select a control.

3. On the Form Editor toolbar, click the drop-down arrow on the Enable/Disable button , and
then select one of the following options:

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a
custom expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
stored expression or create a new stored expression to use. Stored expressions can be
reused in numerous places in CSM.

◦ Clear Disabled Expression: Clears any disabling expression so that the control is always
enabled.

4. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Set Tab Order on a Form
Use the Form Editor to establish a tab order, or tab stops, for fields on a form. Tab order is the order in
which the cursor moves to the next field or button control when the tab key is pressed. The Form Editor
can also be used to remove a field from the tab order sequence or to clear all tab stops.

Define Tab Order of Fields
To set the tab order of fields on a form:

1. Open a form in the Form Editor.
2. From the Form Editor menu bar, select Form > View/Set Tab Order. Numbers display in the upper

left corner of each field to reflect the current order that the cursor moves through the fields. If a field
has not been assigned a tab stop, a question mark displays in the upper left corner instead.

3. Select each field or button control in the order you want the cursor to move through the fields.

4. When you are done, select Form > View/Set Tab Order again to save the tab ordering.

5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.

Remove Tab Stop from Fields
Remove the tab stop from a field to remove it from the tab order sequence.

To remove the tab stop from a field:

1. Open a form in the Form Editor.
2. Right-click on the desired field. If included in the tab order sequence, the Tab Stop item in the

context menu is selected (has a grey background and lined border).

3. Select the Tab Stop option to remove the selection. The field is no longer included in the tab order
sequence. A question mark displays in the upper left corner instead of a number to denote that the
field is no longer part of the tab order and does not have a tab stop attached to it.

4. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.

Clear Tab Order
To remove all tab stops from fields on a form:

1. Open a form in the Form Editor.
2. Select Form > Clear Tab Order.
3. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Open the Form Editor
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Managing Controls on Translated Forms
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Make a Form the Default Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to make a form the default
form for the Business Object.

Good to Know:

• You can select a default form for each form type.

• See Form Editor Behaviors for tips on working with controls and the Form Editor.

To make a form the default form:

1. Open a form in the Form Editor.
2. From the Form Menu Bar Item, select the appropriate option. For example, Form > Make this the

default standard form (the option changes depending on the active form type).
3. Select Yes to confirm.

In the Forms list, the form is now underlined to signify it is the default.

4. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Related Item Navigation
Related Item Navigation is a CSM feature for viewing a Major Business Object's related items directly
from an integrated Related Item pane in the current record.

You can configure and enable Related Item Navigation for any Major Business Object in the Business
Object's Form Arrangement Editor. By default, Related Item Navigation is already enabled for the
Incident and Problem Business Objects. CSM supports Adaptive Layouts for Related Item Navigation to
provide an optimal user experience across a range of devices.

Note: Enabling Related Item Navigation may cause the layout of your form arrangement to
change. The form splitter is also not configurable in the Related Item Navigation form
arrangements, a predefined and fixed splitter configuration is applied automatically. The Form
Arrangement Editor allows you to preview the layout of the form arrangement after enabling
Related Item Navigation, and to confirm the impact of the new layout on your content. Once
Related Item Navigation is enabled it cannot be undone without discarding the Blueprint.

The Related Item Navigation feature provides the following related items as individual tabs in the Related
Item pane:

Note: In addition to the default tabs of related items, you can also add custom tabs of related
Business Objects to the Related Items pane.

Table 1. Default Related Item Navigation Tabs

Tab Description

Communication

Send email messages from the current Business
Object record. Features include integration with the
CSM Address Book, formatting options, and file
attachments.

Solution Search (CSM Browser Client only)

Run a search for an existing solution in knowledge
sources (examples: Known errors, open incidents,
Knowledge Articles). The search results display
matching knowledge sources by relevancy.

Attachments (CSM Browser Client only)

Import files into the current Business Object record.
After files are imported, you can preview images and
download or delete files. Supported file types are
configured in CSM Administrator.

Chat

Create Slack channels directly from the current
Business Object record, enabling users to view and
participate in discussions in Slack without leaving
CSM.

Good to Know

The Related Item Navigation feature is enabled for the Incident and Problem Business Objects if they are
included in the OOTB content for CSM 10.0.x and later. If you have a mApp® Solution that was created
on a content version earlier than 10.0.0, and it overwrites or merges with Incident or Problem (such as the
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Managed Service Provider mApp Solution), review the Related Item Navigation within these Business
Objects before you publish the mApp Solution Blueprint. Verify that you need all items within the Related
Item Navigation and remove any tabs that are not for reference purposes. Thoroughly test functionality,
especially in the CSM Browser Client.
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Configure Related Item Navigation
Configure Related Item Navigation with CSM Administrator.

To enable Related Item Navigation on a Business Object:

1. Open a Blueprint.
2. Select a Business Object, then select Edit Form Arrangement.

The Form Arrangement Editor opens.
3. Select the link in the yellow banner to activate Related Item Navigation.

Warning: Once activated, you can't revert from Related Item Navigation unless you discard
or roll back the Blueprint.

4. Once Related Item Navigation is enabled, a new set of controls appears at the top left corner of the
Form Arrangement Editor.

◦ Choose the form you want to appear in the Status Area by selecting from the drop-down list.
◦ Select Show Related Item Navigation to see the Related Items pane.
◦ Select Hide single tab if you have a single Related Items tab and don't want to display the

tab styling.
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5. Attachments and Communication are the system-provided related items. The Browser Client also
includes Solution Search. Control visibility of system tabs by selecting/deselecting the eye icon.

6. Drag related Business Objects from the relationship tree into the Related Items pane (or use the
context menu) to create supporting Related Items tabs. You can edit the tab's name, image (only
visible in the Browser Client mobile view), and visibility with an expression.

Note: When you add a new record to a Business Object where the Related Item Navigation
has a custom label expression for an aggregate count of related records on a tab or related
item, the count value is updated to reflect the number of records found in that relationship
query. In the CSM Portal and Browser Client, the count value is correct, but the records
themselves do not appear in the Related Items pane. Once you save the record, the
Related Items pane displays the records as expected.

7. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Configure Solution Search Workflow
Administrators follow the tasks defined in this workflow to configure the Related Item Navigation Solution
Search feature in CSM Administrator.

To configure Solution Search workflow:

1. Create a Blueprint.
2. Configure Knowledge Sources for Solution Search.
3. Configure Knowledge Mapping for Solution Search.
4. Configure Solution Search Properties.
5. Publish the Blueprint.

When you have completed the configuration workflow, you can use the Solution Search tab in the
Related Items pane in the CSM Browser Client. See Use Solution Search for Internal Solutions.

Related concepts
Related Item Navigation
Solution Search Properties
Related tasks
Use Solution Search for Internal Solutions
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Configure Knowledge Sources for Solution Search
Administrators use this task to configure knowledge sources for Solution Search in CSM Administrator for
Related Item Navigation. Although there are various ways to configure knowledge sources, the
recommended best practice is to configure them within the same Blueprint used to configure related
knowledge mapping and Solution Search Properties.

This task is part of a larger workflow: Configure Solution Search Workflow.

To configure knowledge sources for Solution Search:

1. Within the Blueprint (created in the first task of this workflow), select Managers > Knowledge >
Knowledge Sources.
The Knowledge Source Manager window appears.

2. Right-click the knowledge source you want to configure for Solution Search (example: Knowledge
Articles) and select Edit.
The Knowledge Source window appears.
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3. Configure the knowledge source settings that will apply to the Related Item Navigation Solution
Search.

◦ Name: The value of this field is what displays as the name of the Knowledge Source in the
Related Item Navigation Solution Search.
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◦ Items to Search: These fields are only applicable to the Knowledge Pane in the CSM
Desktop Client. Regardless of which items are selected here, the Related Item Navigation
Solution Search is designed to search the Business Object records only (not child records or
attachments).

◦ Additional search criteria: Select the ellipse button , and then select a saved search.
This enables you to include additional search criteria filters for the Related Item Navigation
Solution Search.

◦ The rest of the fields on this window are only applicable to the Knowledge Pane in the CSM
Desktop Client. They do not apply to the Related Item Navigation Solution Search.

4. Select OK.

Next task: Configure Knowledge Mapping for Solution Search.

Related concepts
Related Item Navigation
Solution Search Properties
Related tasks
Configure Solution Search Workflow
Use Solution Search for Internal Solutions
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Configure Knowledge Mapping for Solution Search
Administrators use this task to configure knowledge mapping for Solution Search in CSM Administrator for
Related Item Navigation. Although there are various ways to configure knowledge mapping, the
recommended best practice is to configure them within the same Blueprint used to configure related
knowledge sources and Solution Search Properties.

This task is part of a larger workflow: Configure Solution Search Workflow.

Previous Task: Configure Knowledge Sources for Solution Search.

To configure knowledge mapping for Solution Search:

1. Within the Blueprint created in the first task in this workflow, select Managers > Knowledge >
Knowledge Mapping.
The Knowledge Mapping window appears.

CSM 2022.3 Features 485

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=rin_solution_search_config_workflow
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=rin_solution_search_config_knowledge_sources


2. In the Search from drop-down list, select the Business Object (example: Incident).

Note: For the purposes of configuring the Related Item Navigation Solution Search
functionality in the CSM Browser Client, you only need to configure the list of Knowledge
Sources. All other fields on this window are applicable to the Knowledge Pane functionality
in the CSM Desktop Client only.

3. In the Knowledge Sources section of the window, Add or Remove items from the list (example:
Known Errors, Knowledge Articles).

4. Select OK.
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These knowledge sources are now available for use when configuring Solution Search Properties.
See Configure Solution Search Properties.

Note: When configuring internal Solution Search Properties, only the internal knowledge
sources will appear (example: Known Errors, Knowledge Articles, Open Incidents).

Next task: Configure Solution Search Properties.

Related concepts
Related Item Navigation
Solution Search Properties
Related tasks
Configure Solution Search Workflow
Use Solution Search for Internal Solutions
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Configure Solution Search Properties
Administrators use this task to configure Solution Search Properties in a Blueprint in CSM Administrator
for Related Item Navigation for each applicable Business Object (example: Incident, Knowledge Article,
etc.). The recommended best practice is to configure Solution Search Properties within the same
Blueprint used to configure related knowledge sources and knowledge mapping.

This task is part of a larger workflow: Configure Solution Search Workflow.

Previous Task: Configure Knowledge Mapping for Solution Search.

To configure Solution Search Properties:

1. Within the Blueprint (created in the first task in this workflow), select the Business Object (example:
Incident).

2. In the [Business Object] Tasks section, select Edit Form Arrangement.
3. If the Related Items pane does not display to the right of the Form Arrangement window, enable it

by following these steps: Configure Related Item Navigation.

4. When the Related Items pane displays, select the Solution Search Properties  button.
The Solution Search Properties window opens.

5. Configure the display and action properties for the Solution Search tab. For specific information
about each property, see Solution Search Properties.

◦ Example Configuration for Known Issues:

Knowledge Source: Select Known Errors on the Internal Sources tab.

Display Fields for Source: Select Add and then select Known Error and Description from
the Select Fields list.

Note: When configuring Internal Solution Search Properties, only the Internal
Knowledge Sources will appear in the drop-down list (example: Known Errors,
Knowledge Articles, Open Incidents).

Select Actions Available to Users: Select all of the check boxes on the General tab.

◦ Example Configuration for Open Incidents:

Knowledge Source: Select Open Incidents on the Internal Sources tab.

Display Fields for Source: Select Add and then select Incident ID, Customer Display
Name, Call Source, and Description from the Select Fields list.

Includes Label: Select Incident ID and select this check box. Select Customer Display
Name and select this check box on the Internal Sources tab.

Select Actions Available to Users: Select all of the check boxes on the General tab.

◦ Example Configuration for Knowledge Articles:
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Knowledge Source: Select Knowledge Articles on the Internal Sources tab.

Display Fields for Source: Select Add and then select Knowledge Article ID, Category, and
Body Text from the Select Fields list..

Select Actions Available to Users: Select all of the check boxes on the General tab.

6. Select OK to save your changes to the Solution Search Properties.

7. Enable Visibility  in the Related Items pane to enable tab visibility for Solution Search.

Note: If tab visibility is disabled , the Solution Search tab will not display to the user for
that Business Object form. If tab visibility is enabled but not configured, a message will
display for the user to contact the system administrator.

8. Select Save to save your changes to the Form Arrangement.

Next task: Configure Solution Search Workflow.

Related concepts
Related Item Navigation
Related tasks
Configure Solution Search Workflow
Use Solution Search for Internal Solutions
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Solution Search Properties
Administrators use the Solution Search Properties window in CSM Administrator to configure the
properties for the Solution Search tab in Related Item Navigation for technicians. These properties
include the fields displayed in the search results and the actions available in relation to the search results.

For steps on how to access the Solution Search Properties window, see Configure Solution Search
Properties.

Note: Verify that the Include in Full-Text Search check box is selected on the Properties
window for all Business Objects and fields configured to display in Solution Search. See Define
Search Results Properties for a Business Object and Configuring Search Defaults.
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Page Property Description

General
These properties define the display and actions available in the
display and actions available to a Technician in the Solutions Search
tab of the Related Item Navigation pane.

Open in New Tab
Select if the Open in a New Tab option should display for the user in
the Action Menu. The knowledge source opens in a new tab when
the user selects this option in the Action Menu.

Copy Link Select if the link to the knowledge source should be copied to the
clipboard when the user selects this option in the Action Menu.

Share with Customer

Select if the result of a Solution Search should populate an email
template on the Communication tab when this option is selected in
the Action Menu. The Share with Customer action creates an email
to the customer that includes a link to the knowledge source.

Save Result / Remove
Saved Result

Select if you want the knowledge source to be saved as a search
result when the user selects this option in the Action Menu. When a
user saves or removes a saved result, a Journal record is created.

Note: If the Business Object Properties - History settings
have been modified from the default settings, users might see
different behavior when using this feature.

Use as Solution /
Remove from Solution

Select to use the knowledge source as a solution when the user
selects this option in the Action Menu.

Select Action for Use as
Solution

Select to specify a One-Step™ Action if you have selected the Use as

Solution check box. Select the ellipsis  and choose an action
from the One-Step Action manager.

Select Action for External
Sources

Select to specify a One-Step Action to include in the Action menu for
external sources. Select the ellipsis and choose an action from the
One-Step Action manager.

Internal Sources
These properties define the display and actions available to a
technician in the Solutions Search tab of the Related Item
Navigation pane.

Knowledge Source

Select the knowledge source in the drop-down list for which you want
to set display properties (examples: Known Errors, Open Incidents,
Knowledge Articles). This drop-down list is populated based on the
knowledge sources defined in Knowledge Mapping for the Business
Object (example: Incident). See Configure Knowledge Sources for
Solution Search.

Note: When configuring Internal Solution Search
Properties, only the Internal knowledge sources will appear
in the drop-down list (example: Known Errors, Knowledge
Articles, Open Incidents).
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Page Property Description

Display Fields for Source

For the selected knowledge source, the values of the fields in this list
are the data elements displayed to the user in the Solution Search >
Internal Sources search results.

Note: When configuring these fields, it is important to
consider whether or not the field will have a value in all
records. Using required fields or ID fields for at least the first
field displayed is recommended. Fields without a value will
display as a blank row in the search results.

The search results display is limited to three rows maximum. The rows
can be defined by the first three fields in the list or by using the
Includes Label check box.

Note: Any additional fields in this list are displayed when you
click the link to the knowledge source.

First three fields in list: If the Includes Label check box is NOT
selected for any of the fields in this list, the first three fields display
(from top to bottom) as rows in the search result:

Example Field Display Row,
Value, Style

Example Search
Result (Field Value)
Displayed

Knowledge Article
ID

Row 1, field value,
Title linked to
knowledge source

10095

Body Text Row 2, field value,
normal text

To connect to a
PC...

Category Row 3, field value,
normal text
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Add Select this button to add fields to the list for the selected knowledge
source.

Remove Select an existing field in the list and select this button to remove it
from the list for the selected knowledge source.

Up/Down

Select an existing field in the list and select the Up or Down arrow to
move the item up or down in the list for the selected knowledge
source.
If the Includes Label check box is NOT selected for any of the field in
this list, the fields display as rows in the search result in the following
manner: top to bottom (in list) = top to bottom (as rows in the search
result) with a maximum of three rows displayed.

Note: Any additional fields in this list are displayed when you
click the link to the knowledge source.
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Page Property Description

Includes Label

Select a field in the Display Fields for Source list and select this
check box to include the associated Field Value in Row 1 (Title linked
to knowledge source) of the search result.

When this option is selected for a field, an abc displays to the left of
field. You can select as many fields as you'd like to display on Row 1
of the search result (field values display comma separated), but only a
single row will display. If the comma separated field values exceed the
space available to display Row 1, an ellipsis (...) will display at the end
of the row.

The next two fields in the Display Fields for Source list (from top to
bottom) display as Row 2 and Row 3 of the search result.

Note: Any additional fields in this list are displayed when you
click the link to the knowledge source.

Example Field Display Row,
Value, Style

Example Search
Result (Field
Values) Displayed

Incident ID

Customer Display
Name

Row 1, field values
(comma separated),
Title linked to
knowledge source

102205, Clair
Wu

Call Source Row 2, field value,
normal text

Portal

Description Row 3, field value,
normal text

Emily Johnson
has joined...
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Related concepts
Related Item Navigation
Related tasks
Configure Solution Search Workflow
Use Solution Search for Internal Solutions
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Configure Slack for the Related Items Pane
Steps to configure the Slack integration with Related Item Navigation include setting a Slack OAuth token
in CSM, configuring security rights in CSM Administrator, and verifying Public ID settings for the Major
Business Object that will integrate with Slack.

To integrate Slack with the Related Items pane:

1. Configure your Slack workspace for the Related Item Navigation integration.
See Configure a Slack Workspace for the Related Items Pane.

2. In CSM Administrator, grant third-party chat integrations security rights to:
◦ Users who will configure third-party chat integrations.
◦ Users who will create, view, and participate in chat channels and conversations.

See Third-party Chat Security Rights.
3. In CSM Administrator, enable third-party chat integrations and add the Slack OAuth app token.

See Configure Third-party Chat Integration Settings for Slack.
4. In CSM Administrator, create a Blueprint, and then enable Related Item Navigation for Business

Objects that will integrate with Slack. Be sure to enable Chat visibility.
See Configure Related Item Navigation.

5. In CSM Administrator, verify Public ID settings for the Business Object that will integrate with Slack.
See Configure Slack Channel Naming Conventions.

Related concepts
Use Slack in the Related Items Pane
Related tasks
Configure Related Item Navigation
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Configure a Slack Workspace for the Related Items
Pane

Before you configure the Related Item Navigation integration in CSM, you must configure your Slack
workspace.

This task is part of a larger workflow: Configure Slack for the Related Items Pane.

To configure Slack for the Related Item Navigation integration:

1. Verify that you have administrative rights to the Slack workspace.
2. Create a Slack application.

See https://api.slack.com/start/overview#apps.
3. Grant the following permissions (scopes) to the bot user:

◦ users:read
◦ users:read:email
◦ channels:history
◦ channels:read
◦ channels:manage
◦ chat:write
◦ groups:history
◦ groups:read
◦ groups:write
◦ im:history
◦ im:read
◦ im:write
◦ mpim:history
◦ mpim:read
◦ mpim:write

4. Copy the Bot User OAuth Access Token. You'll add this to CSM.
See Configure Third-party Chat Integration Settings for Slack.

Next task: Configure Third-party Chat Integration Settings for Slack.
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Configure Third-party Chat Integration Settings for
Slack

Third-party chat integrations, such as adding Slack to the Related Items pane, must be enabled at a
global level before they are available to users. Access third-party chat integrations settings from CSM
Administrator.

This task is part of a larger workflow: Configure Slack for the Related Items Pane.

To enable Slack integration:

To enable a third-party chat integration:

1. From CSM Administrator, go to Settings > Edit Third-party Chat Integration Settings.
2. On the General page, select Enable Chat Integration, and then from the Provider Type drop-

down list, select Slack.
3. On the General page, select Enable Chat Integration, and then from the Provider Type drop-

down list, select Slack.
4. Select the Slack page.
5. Provide settings as required for your integration by setting these options:

Option Description

OAuth Token Provide an OAuth token provided by Slack.
See https://api.slack.com/start/
overview#auth.

Test Select Test to verify the OAuth token.

6. Select OK.

Note: If the OAuth token is changed, you must stop and start the Cherwell Application Server.

Next task: Configure Slack Channel Naming Conventions.
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Configure Slack Channel Naming Conventions
By default, names for Slack channels created from within the Related Items pane use the internal name
of a Business Object and its public ID in this format: businessobjectinternalname-id. You cannot
modify the use of the internal name, but you can use a custom field instead of the public ID.

This task is part of a larger workflow: Configure Slack for the Related Items Pane.

The following guidelines apply to Slack channel naming conventions:

• Users cannot modify channel names.

• The entire name of a Slack channel cannot exceed 80 characters.

• Channel names must be unique.

To change default naming conventions for Slack channels:

1. Create a Blueprint.
2. From the Object Manager, select the Business Object that is configured to integrate with Slack. For

example, select Incident.
3. Create or modify a field with the following settings on the Field Properties window:

Option Description

Field Type (General page) Text

Length (General page) No more than 19 characters.

Calculated Value (Properties page) For best results, add an expression that
automatically calculates a unique value for
the field, such as a counter.

General attributes (Advanced page) Add this atttribute: ChatChannelIdentifier.

4. Save your changes.
5. Publish the Blueprint.

Next task: Configure Slack Chat History Archiving.

Related concepts
Define General Properties for a Text Field
Define General Behaviors for Fields
Define Advanced Properties for a Field
Related tasks
Configure Slack for the Related Items Pane
Related reference
General Field Attributes
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Configure Slack Chat History Archiving
Configure archiving for a Slack integration to store conversation history with the Business Object record
once it reaches the end of its Lifecycle. When the Business Object record reaches the end of its Lifecycle,
the Slack channel is automatically archived.

Prerequisites:

• The third-party chat integration must be configured. See Configure Slack for the Related Items
Pane.

• The Business Object used by the chat integration must have a lifecycle and final state set. See
Define Lifecycle Properties for a Business Object.

Important: For CSM 10.2.0 or later versions, use the Business Object Lifecycle Editor to
add a life cycle to a Business Object. See: Open the Lifecycle Editor.

• Users who will save the Business Object record in its final state must have privileges to save chat
history. See Third-party Chat Integration Security Rights.

The Business Object used with the Slack integration must be configured to store history and chat-related
attributes must be applied to the Group Member used to store history.

To create chat history archiving:

1. Create a Blueprint.
2. From the Object Manager, select the Business Object that is configured to integrate with Slack. For

example, select Incident.
3. Edit the Business Object, and then select the Bus Ob Properties button.
4. Select the History page.
5. From the Chat history drop-down list, select the Group Member that will store Slack conversations.

For example, select Journal - Remote Support History.
6. Select OK.
7. From the Object Manager, edit the Group Member that will store Slack conversations. For example,

edit Journal - Remote Support History from the Supporting objects tree.
8. Create or modify three text fields that will store data from Slack with the following field settings.

(General attributes are stored on the Advanced page for each field. See Define Advanced
Properties for a Field.)

◦ Chat Conversation
◦ Description: Stores formatted conversations.
◦ Field Length: Max allowed
◦ General attribute: ChatConversation.

◦ Chat History
◦ Description: Stores JSON from Slack.
◦ Field Length: Max allowed
◦ General attribute: HistoryDetails.
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◦ Chat Timestamp
◦ Description: Adds date/time information to conversations.
◦ Field Length: Max allowed
◦ General attribute: ChatConversationWithTime

Note: The Chat Timestamp field is optional.

9. Publish the Blueprint.

Related concepts
About Business Object Lifecycles
Open the Lifecycle Editor
Related tasks
Archive Slack Conversations
Configure Slack for the Related Items Pane
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Configure Teams Chat for the Related Items Pane
Steps to configure the Microsoft Teams integration with Related Item Navigation include configuring
security rights in CSM Administrator and verifying Teams integration settings.

Follow these general steps to integrate Teams with the Related Items pane.

Related tasks
Create a Microsoft Teams App Registration
Configure Third-party Chat Integration Settings for Microsoft Teams
Configure Microsoft Teams Channel Naming Conventions
Configure Microsoft Teams Chat History Archiving
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About Teams Chat
Teams chat enables a user to send messages to, and receive messages from a Microsoft Teams channel
directly from CSM.

Teams chat is available when Related Item Navigation is enabled for a Business Object.

It is important to understand the concept of the delegated user. The delegated user is a member of the
Azure Active Directory where the Microsoft Teams app registration resides, and where the required
certificates/secrets and API permissions can be accessed and applied. The delegated user does not need
to be the owner of the Microsoft Azure Portal account, only a member of the Active Directory. It is
recommended that you set up a special user for this role:

• The delegated user must be a member of the Azure Active Directory in which the Microsoft Teams
app registration resides.

• The delegated user Active Directory credentials (username and password) are configured in CSM
Administrator when configuring the Teams chat integration.

• The delegated user must have an active Microsoft Teams license or subscription.

When the Teams integration is configured, chat conversations created from CSM creates a Team with the
delegated user as the owner.

Chat messages sent from CSM come from the delegated user account.

CSM utilizes the General channel of the created team for communications. Any other channels created
under the Team are not visible within CSM.
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Create a Microsoft Teams App Registration
Before you configure the Related Item Navigation integration in CSM, you must create a Microsoft Teams
app registration in Azure Active Directory.

This task is part of a larger workflow: Configure Teams Chat for the Related Items Pane.

Important: The user account you use to create the app registration must have permission to
manage applications in Azure Active Directory.

To create an app registration for the Related Item Navigation Teams chat integration:

1. Login to the Microsoft Azure Portal and select Azure Active Directory.

Note: The delegated user must be a member of the Azure Active Directory. See About
Teams Chat.

2. Create a Microsoft Teams app registration in the Azure Active Directory.
See https://docs.microsoft.com/en-us/azure/active-directory/develop/quickstart-register-app.

3. In the Certificates & Secrets section, do either one or both of the following:
◦ Upload a certificate.
◦ Create a client secret.

Note: If you create a client secret, you must take a note (or copy) the secret value. The
secret value is only shown one time after which it is obfuscated. You need this value
when setting up the third-party chat integration in the next task. If you lose this value
you can create a new secret.

4. Add the following (minimal) Microsoft Graph API permissions for the app registration taking note of
the "Type" and "Admin consent required".

5. In the Authentication section, enable Allow public client flows under Advanced settings.
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6. When completed successfully, move to the next task.

Next task: Configure Third-party Chat Integration Settings for Microsoft Teams.
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Configure Third-party Chat Integration Settings for
Microsoft Teams

Third-party chat integrations, such as adding Microsoft Teams to the Related Items pane, must be
enabled at a global level before they are available to users. Access third-party chat integrations settings
from CSM Administrator.

This task is part of a larger workflow: Configure Teams Chat for the Related Items Pane.

To enable Microsoft Teams integration:

1. From CSM Administrator, go to Settings > Edit Third-party Chat Integration Settings.
2. On the General page, select Enable Chat Integration, and then from the Provider Type drop-

down list, select Teams.
If Enable Chat Integration is not selected the Chat tab is hidden in the CSM Desktop Client and
the CSM Browser Client.

3. Select the Teams page.
4. Provide settings as required for your integration by setting these options:

Option Description

Client ID Your Application (client) ID. This can be found in
Azure Active Directory. Select App
Registrations, and then select the app in the
registrations list to view the details. You may
need to select All Applications to view the app
registration if you are not the owner.

Tenant ID Your Directory (tenant) ID. This can be found in
Azure Active Directory. Select App
Registrations, and then select the app in the
registrations list to view the details. You may
need to select All Applications to view the app
registration if you are not the owner.

Client Secret or Private Certificate Select either the Use Secret or Use Certificate
option, depending on which method you want to
use for authentication. Client secrets or private
certificates can be generated in Azure Active
Directory.

Username The dedicated user name. The dedicated user
must be a member of Azure Active Directory
where the app registration resides and a
member in the Teams workspace in CSM.

Password The dedicated user password.
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Option Description

Test Select Test to verify the Teams settings.

Note: If this test fails, an error message
displays in the dialog.

Cloud Instance Change the cloud instance against which you
authenticate by selecting a choice from the drop-
down list. In most situations, you should not
change this from the default.

5. Select OK.

Next task:Configure Third-party Chat Integration Security Rights for Microsoft Teams .
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Configure Third-party Chat Integration Security
Rights for Microsoft Teams

Third-party chat security rights for Microsoft Teams need to be configured to set appropriate security for
groups within CSM and to ensure each group can create/update channels as necessary. Access third-
party chat integration security settings from CSM Administrator.

This task is part of a larger workflow: Configure Teams Chat for the Related Items Pane.

To configure Microsoft Teams chat integration security rights:

1. From CSM Administrator, go to Security > Edit security groups.
The Security Group Manager opens.

2. From the Group drop-down list, select the security group that you are configuring the security rights
for.

Note: If the group is not listed you need to create a new security group, see Create a
Security Group.

3. Select the Rights tab.
4. From the Category drop-down list, select Chat Service Integration Features.

A list of integration feature rights displays.
5. For each feature right, select it and then select Allow / Edit to enable the it, or deselect Allow / Edit

to disable it.
For information on the integration feature rights, see Chat Service Integration Features Security
Rights.

6. Select Save to save the security settings.

Next task: Configure Microsoft Teams Channel Naming Conventions.
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Configure Microsoft Teams Channel Naming
Conventions

By default, names for Microsoft Teams channels created from within the Related Items pane use the
internal name of a Business Object and its public ID in this format: businessobjectinternalname-
id. You cannot modify the use of the internal name, but you can use a custom field instead of the public
ID.

This task is part of a larger workflow: Configure Teams Chat for the Related Items Pane.

The following guidelines apply to Microsoft Teams channel naming conventions:

• Users cannot modify channel names.

• The entire name of a Teams channel cannot exceed 80 characters.

• Channel names must be unique.

To change default naming conventions for Teams channels:

1. Create a Blueprint.
2. From the Object Manager, select the Business Object that is configured to integrate with Microsoft

Teams (example: Select Incident).
3. Create or modify a field with the following settings on the Field Properties window:

Option Description

Field Type (General page) Text.

Length (General page) No more than 19 characters.

Calculated Value (Properties page) For best results, add an expression that
automatically calculates a unique value for
the field, such as a counter.

General attributes (Advanced page) Add this atttribute: ChatChannelIdentifier.

4. Save your changes.
5. Publish the Blueprint.

Next task: Configure Microsoft Teams Chat History Archiving.

CSM 2022.3 Features 509

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=rin_teams_chat_process
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=rin_teams_chat_integration_archive


Configure Microsoft Teams Chat History Archiving
Configure archiving for a Microsoft Teams integration to store conversation history with the Business
Object record once it reaches the end of its Lifecycle. When the Business Object record reaches the end
of its Lifecycle, the Teams channel is automatically archived.

Prerequisites:

• The third-party chat integration must be configured. See Configure Teams Chat for the Related
Items Pane.

• The Business Object used by the chat integration must have a Lifecycle and final state set. See
Define Lifecycle Properties for a Business Object.

Important: For CSM 10.2.0 or later versions, use the Business Object Lifecycle Editor to
add a Lifecycle to a Business Object. See: Open the Lifecycle Editor.

• Users who save the Business Object record in its final state must have privileges to save chat
history. See Third-party Chat Integration Security Rights.

The Business Object used with the Microsoft Teams integration must be configured to store history, and
chat-related attributes must be applied to the Group Member used to store history.

To create chat history archiving:

1. Create a Blueprint.
2. From the Object Manager, select the Business Object that is configured to integrate with Microsoft

Teams (example: Select Incident).
3. Edit the Business Object, and then select Bus Ob Properties.
4. Select the History page.
5. From the Chat history drop-down list, select the Group Member that will store Teams conversations

(example: Select Journal - Remote Support History).
6. Select OK.
7. From the Object Manager, edit the Group Member that will store Teams conversations (example:

Edit Journal - Remote Support History from the Supporting objects tree).
8. Create or modify three text fields that will store data from Microsoft Teams with the following field

settings. (General attributes are stored on the Advanced page for each field. See Define Advanced
Properties for a Field.)

◦ Chat Conversation
◦ Description: Stores formatted conversations.
◦ Field Length: Max allowed.
◦ General attribute: ChatConversation.

◦ Chat History
◦ Description: Stores JSON from Microsoft Teams.
◦ Field Length: Max allowed.
◦ General attribute: HistoryDetails.
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◦ Chat Timestamp
◦ Description: Adds date/time information to conversations.
◦ Field Length: Max allowed.
◦ General attribute: ChatConversationWithTime.

Note: The Chat Timestamp field is optional.

9. Publish the Blueprint.
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Use Related Item Navigation
The Related Items pane has two views: collapsed and expanded. In the Browser Client, use the tab key
or select the arrow in the blue side tab (the View Selector) to toggle between the views.

When the Related Items pane is collapsed, the related items are stacked. Select a related item to see
details and select the Related Items link to return to the stacked view. When the Related Items pane is
expanded, the related items are shown in a row at the top of the pane.

CSM remembers your View Selector choice and the last related item you viewed from session to session
and client to client. The views are persisted per Business Object.

Note: In mobile view, the choices do not persist. This is because the expanded view for mobile
layouts covers the Business Object form.

Collapsed View:
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Note: To open a related item in this view, right-click the item to show a contextual menu, where
you can select to open the record in a quick view window, go to the record directly in the same
window, or open the record in a new application window by pressing Shift and selecting Go to
record.

Expanded View:
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Use Solution Search for Internal Solutions
Technicians use the Related Item Navigation Solution Search tab in the CSM Browser Client to run a
search for an existing solution to an issue without leaving the current record.

To run an internal solution search:

1. In CSM Browser Client, open an existing record.
2. Select the Solution Search tab in the Related Items pane. If you do not see this tab or you see a

message within the tab to contact your system administrator, it has not yet been configured for use.
3. Select the Internal tab. This tab displays internal Knowledge sources and search results.
4. By default, none of the Sources check boxes (examples: Known Errors, Open Incidents,

Knowledge Articles) are selected and all matching sources display in the search results. The
sources available will vary depending on how they were configured to display by your Administrator.
To filter the search results, select one or more Sources check boxes. The search results filter to
display only your selection(s).

5. Enter your search term(s) in the Search field.
When using the Search field, the most recent searches that have been run against the current
record will display in a list below the field, with the most recent searches at the top of the list. This
allows a technician to easily see or select terms that have already been searched for the current
record.

6. Select Search to run your search. When you execute a search, a Journal entry is logged in the
Activity pane.
The search results display matching Knowledge sources sorted by relevancy.

7. Select a search result link or select an option in the vertical ellipsis Action Menu to the right of the
link. The search results display is limited to three rows maximum.

To see any additional fields configured for view, select the link for the search result. All of the fields
configured for view will display.

To perform an Action, select an option in the vertical ellipsis Action Menu to the right of the link. If
no Actions were configured for the Knowledge source, this menu will not appear.
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Depending on your specific configuration, any of the following Actions may be available in the
vertical ellipses Action Menu.

Action Description

Open in New Tab Select to open the Knowledge source in a new tab
in the browser.

Copy Link Select to copy the link to the Knowledge source to
the clipboard.

Share with Customer

Select to open an email to the customer with fields
populated based on the Knowledge source. If the
Communication tab in the Related Item Navigator
is configured, the email will open in the
Communication tab. Otherwise, the E-mail window
opens.

Save Result / Remove Saved Result

Select Save Result to save the Knowledge source
to the Saved tab. A Journal record is created
stating that the Knowledge source was saved.

Select Remove Saved Result to remove the
Knowledge source from the Saved tab. A Journal
record is created stating that the Knowledge source
was removed from saved.

Use as Solution / Remove from Solution

Select Use as Solution to save the Knowledge
source to the Solution tab. A Journal record is
created stating that the Knowledge source was used
as a solution.

Select Remove from Solution to remove the
Knowledge source from the Solution tab. A Journal
record is created stating that the Knowledge source
was removed from solution.

Run (One-Step Action)

Select to run the One-Step Action that has been
configured for the solution. See Solution Search
Properties.

Note: This option is only available if the
Knowledge source is being used as a
solution.

Related concepts
Related Item Navigation
Solution Search Properties
Related tasks
Configure Solution Search Workflow
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Use Solution Search for External Solutions
Use the External tab of the Related Item Navigation Solution Search tab in the CSM Browser Client to
retrieve information from a website that can provide a solution to an issue without leaving the current
record.

To run an external solution search:

1. In CSM Browser Client, open an existing record.
2. Select the Solution Search tab in the Related Items pane. If you do not see this tab or you see a

message within the tab to contact your system administrator, it has not yet been configured for use.
3. Select the External tab. This tab displays information retrieved from a website that the user enters.
4. Enter the URL for the website that will be used as a solution in the Search field.
5. Select Import to retrieve information.

The External tab displays information about the website.
6. Select an option in the vertical ellipsis Action Menu.

To see any additional fields configured for view, select the link for the search result. All of the fields
configured for view will display.

To perform an Action, select an option in the vertical ellipsis Action Menu.

Depending on your specific configuration, any of the following Actions may be available in the
vertical ellipsis Action Menu.

Action Description

Open in New Window Select to open the knowledge source in a new
window in the browser.

Copy Link Select to copy the knowledge source link to the
clipboard.

Share with Customer

Select to open an email to the customer with
fields populated based on the knowledge source.
If the Communication tab in the Related Item
Navigator is configured, the email will open in the
Communication tab. See Use Communication in
Related Items Pane. Otherwise, the E-mail
window opens.

Remove Linked Article Select to remove the knowledge source from the
External tab.
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Action Description

Run (One-Step Action)

Select to run the One-Step Action that has been
configured for the solution. See Solution Search
Properties.

Note: This option is only available if the
knowledge source is being used as a
solution.
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Use Communication in Related Items Pane
Use the Communication tab in the Related Items pane of the CSM Browser Client and CSM Desktop
Client to send email messages directly from the current Business Object record.

If Related Item Navigation is enabled for the Business Object, and the Communication tab is made
visible in the Related Items pane, users can compose and send email messages using the same options
that are available in the Email Message window, which can be launched from either the Desktop Client or
Browser Client.

In the Communication tab, you can:

• Manually enter email addresses or select recipients from the CSM Address Book.

• Select Contact Customer to add the requestor's name to the To field.

Note: This feature is enabled only for Business Object records that have a Requestor field
that is populated with a person with a valid email address.

• Select New Thread to clear the To, Bcc, and Cc fields in the current email message. The subject
and body remain populated.

• Select an email account from the Send Via drop-down list. By default, the account is set to the
default account that is configured in CSM Administrator (or by the user, if that user has the
appropriate security rights).

• Use rich text toolbar options such as lists, colors, fonts, spacing, and alignment. You can also use
plain text to remove formatting from the message.

• Attach files and add links to email messages.

• Designate email messages as low or high importance.

• View the email thread history in the Journal - Mail History Record tab.

Related concepts
Select Email Recipients from the CSM Address Book
Add Attachments to Email
Attach Email Messages to Records
Related tasks
Send an Email from within CSM
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Use Attachments in Related Items Pane
Use the Attachments tab in the Related Items pane of the CSM Browser Client to import and access
files that are related to the current Business Object record.

In the Attachments tab, you can:

• Browse to files for uploading, or drag and drop them directly into the pane.

• Use the paging feature to navigate through the attachments (by default, six files are shown at one
time).

• Click image files to preview them in a pop-up window.

• Set properties for the tab, including name, image, and visibility.

• Easily identify file types by viewing thumbnail images, including full file names (example: MyFile.pdf)
and file sizes (example: 5.73 KB).

Note: Attachments that are connected directly to a specific Business Object record (example:
Incident) can only be accessed when working with that record.

Related concepts
Record Attachments
Attach (Import) Files to a Record
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Use Slack in the Related Items Pane
If the Slack integration is configured for a Major Business Object, you can use it from the Related Items
pane of a saved record to view and participate in Slack conversations without leaving CSM.

Use the Slack integration to:

• Create a Slack channel from a Major Business Object record.

• Invite other CSM users to the channel.

• Send messages to the Slack channel from a CSM Business Object record.

• View the most-recent messages, up to 100, in a conversation. Newer messages are added to the
bottom of the list.

• Refresh the message list to view the most recent 100 messages.

• View archived chat history once a Business Object record is completed.

Related tasks
Create a Slack Channel from the Related Items Pane
Add Users to Slack Channels
Send Messages to Slack from CSM
Archive Slack Conversations
Configure Slack for the Related Items Pane

CSM 2022.3 Features 520

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fbusiness_objects%2Frin_creating_slack_channel.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fbusiness_objects%2Frin_add_users_to_slack_channel.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fbusiness_objects%2Frin_send_messages_to_slack.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fbusiness_objects%2Frin_archive_slack_conversations.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fbusiness_objects%2Frin_slack_chat_process.html


Create a Slack Channel from the Related Items
Pane

Once the Slack integration is configured for the Related Items pane, you can start a conversation with
CSM users who have accounts in the configured Slack workspace.

Good to Know:

• CSM users who have the security right to create a new chat conversation can create a private Slack
channel from the Related Items pane. Only users who belong to the Slack workspace can be
invited to the channel, however.

• Channel names are determined by administrative settings. You cannot rename channels.

To create a Slack channel from a saved Business Object record:

1. Expand the Related Items pane.
2. Select the Chat page.
3. Select Start Slack Conversation.

The Channel Properties dialog opens.
4. In the Invite User box, select the Address Book icon.
5. Select a user who belongs to your Slack workspace.

You will receive a message if you select a user who is not a member of your Slack workspace.
6. Select OK.

Related concepts
Use Slack in the Related Items Pane
Related tasks
Add Users to Slack Channels
Send Messages to Slack from CSM
Archive Slack Conversations
Configure Slack Channel Naming Conventions
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Add Users to Slack Channels
You can add CSM users to Slack channels if they belong to the Slack workspace configured for CSM and
their Slack email address is identical to the one in the CSM address book. You can add users when you
create the Slack channel or add them to the conversation later.

You can add one user to the channel at a time.

To add users to a Slack channel from CSM:

1. From a saved Business Object record, expand the Related Items pane.
2. Select the Chat page, and then:

◦ Select Start Slack Conversation.
◦ Select the Invite Users icon.

3. On the Channel Properties dialog:
◦ Type the email address of the user.
◦ Select the Address Book icon, and then search for or select the user to add.

Tip: To select multiple users, hold down the Ctrl key and select each user to add from the
list.

4. Select OK.

Related concepts
Use Slack in the Related Items Pane
Related tasks
Create a Slack Channel from the Related Items Pane
Send Messages to Slack from CSM
Archive Slack Conversations
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Send Messages to Slack from CSM
Use a Slack channel added to the Related Items pane of a saved Business Object record to send and
receive conversations. Messages from CSM are sent to Slack as the Cherwell application bot instead of
the CSM user.

To send messages to and from Slack:

1. From a saved Business Object record, expand the Related Items pane.
2. Select the Chat page.
3. Create a channel, if one is not already available. See Create a Slack Channel from the Related

Items Pane.
4. Type messages at the bottom of the Chat page, and then press Enter.
5. Select the Refresh icon to update the channel with messages from Slack.

Related tasks
Create a Slack Channel from the Related Items Pane
Add Users to Slack Channels
Send Messages to Slack from CSM
Archive Slack Conversations
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Archive Slack Conversations
When archiving is configured for the Slack integration, channels are automatically archived once their
associated Business Object records reaches their final life cycle state. Conversation history is stored with
the configured Journal tab of the CSM Business Object record.

Good to Know:

• Messages cannot be sent to or received from archived channels.

• Channels are not archived if users who move Business Object records to their final stage do not
have the Store Chat History security right.

• Slack channels cannot be manually archived from CSM.

• Slack channels can only be un-archived from Slack. If a channel associated with a completed
Business Object record is un-archived from Slack, messages can be sent and received from the
associated CSM Business Object record.

• Users may see a delayed status for archived channels due to possible caching between Slack and
CSM. They should receive warning messages if they attempt to send messages to an archived
channel or when they try to create a channel for a reopened Business Object that is associated with
an archived channel.

To automatically archive Slack channels:

1. Verify with your CSM administrator that archiving has been configured for the Slack integration.
2. Move a CSM Business Object record to its final stage.
3. In Slack, verify that the channel associated with the completed CSM record has been archived.
4. In CSM, verify the archived conversation on the configured Journal tab of the Business Object

record. For example, view archived conversations on the Journal - Remote Support History tab.

Related tasks
Configure Slack Chat History Archiving
Send Messages to Slack from CSM
Configure Slack for the Related Items Pane
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Use Microsoft Teams in the Related Items Pane
If the Microsoft Teams integration is configured for a Major Business Object, you can use it from the
Related Items pane of a saved record to view and participate in Teams conversations without leaving
CSM.

To access the Chat function in the Related Items Pane, you must ensure that it is made visible. To do this
you must enable the eye icon next to Chat in the Form Arrangement Editor. See Configure Related
Item Navigation.

Use the Teams integration to:

• Create a team or channel from a Major Business Object record.

• Invite other CSM users to the channel.

• Send messages to the Teams channel from a CSM Business Object record.

• View the most recent conversations, up to 25. Newer conversations are added to the bottom of the
list.

• Refresh the chat history to view the most recent 25 conversations.

Note: Only basic formatted items are visible in the Related Items pane Teams chat, items that
have special formatting (example: Images, embedded videos) are not visible.

If the Microsoft Teams integration is configured for a Major Business Object, you can use it from the
Related Items pane of a saved record to view and participate in Teams conversations without leaving
CSM.

To access the Chat function in the Related Items pane, you must ensure that it is made visible. To do this
you must enable the eye icon next to Chat in the Form Arrangement Editor. See Configure Related
Item Navigation.

Use the Teams integration to:

• Create a team or channel from a Major Business Object record.

• Invite other CSM users to the channel.

• Send messages to the Teams channel from a CSM Business Object record.

• View the most recent conversations, up to 25. Newer conversations are added to the bottom of the
list.

• Refresh the chat history to view the most recent 25 conversations.

Note: Only plain text is visible in the Related Items pane Teams chat; items that have special
formatting (example: Images, embedded videos) are not visible.

Related tasks
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Create a Microsoft Teams Channel from the Related Items Pane
Add Users to Microsoft Teams Channels
Send Messages to Microsoft Teams from CSM
Archive Microsoft Teams Conversations
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Create a Microsoft Teams Channel from the
Related Items Pane

Once the Microsoft Teams integration is configured for the Related Items pane, you can start a
conversation with CSM users who have accounts in the configured Teams workspace.

Good to Know

• CSM users who have the security right to create a new chat conversation can create a private
Teams channel from the Related Items pane. Only users who belong to the Teams workspace can
be invited to the channel.

• Channel names are determined by administrative settings. You cannot rename channels.

To create a Teams channel from a saved Business Object record:

1. Expand the Related Items pane.
2. Select the Chat page.
3. Select Start Teams Conversation.

The Channel Properties dialog opens.
4. In the Invite User box, select the Address Book icon.
5. Select a user who belongs to your Teams workspace.

A message displays if you select a user who is not a member of your Teams workspace.
6. Select OK.
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Add Users to Microsoft Teams Channels
You can add CSM users to Microsoft Teams channels if they belong to the Teams workspace configured
for CSM and their email address is identical to the one in the CSM address book. You can add users
when you create the Teams channel or add them to the conversation later.

To add users to a Teams channel from CSM:

1. From a saved Business Object record, expand the Related Items pane.

2. Select the Chat page, and then select the Invite Users  icon.

Note: The Invite Users icon only displays if you have edit security rights.

3. On the Channel Properties dialog do one of the following:
◦ Type the email address of the user.
◦ Select the Address Book icon, and then search for or select the users to add.

Tip: To select multiple users, hold down the Ctrl key and select each user to add from the
list.

4. Select OK.
If a selected user is not within your workspace you receive an error message.
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Send Messages to Microsoft Teams from CSM
Use a Microsoft Teams channel added to the Related Items pane of a saved Business Object record to
send and receive conversations. Messages from CSM are sent to Microsoft Teams as the Cherwell
application bot instead of the CSM user.

To send messages to and from Microsoft Teams:

1. From a saved Business Object record, expand the Related Items pane.
2. Select the Chat page.
3. Create a channel, if one is not already available. See Create a Microsoft Teams Channel from the

Related Items Pane.
4. Type messages at the bottom of the Chat page, and then press Enter.
5. Select the Refresh icon to update the channel with messages from Microsoft Teams.
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Archive Microsoft Teams Conversations
When archiving is configured for the Microsoft Teams integration, channels are automatically archived
once their associated Business Object records reach their final Lifecycle state. Conversation history is
stored with the configured Journal tab of the CSM Business Object record.

Good to Know

• Messages cannot be sent to or received from archived channels.

• Attempts to send messages to an archived Teams channel causes an error message to be
displayed.

• Channels are not archived if users who move Business Object records to their final stage do not
have the Store Chat History security right.

• Teams channels cannot be manually archived from CSM.

• Teams channels can only be un-archived from Microsoft Teams. If a channel associated with a
completed Business Object record is un-archived from Microsoft Teams, messages can be sent and
received from the associated CSM Business Object record.

• Users may see a delayed status for archived channels due to possible caching between Microsoft
Teams and CSM. They receive warning messages if they attempt to send messages to an archived
channel or when they try to create a channel for a reopened Business Object that is associated with
an archived channel.

To automatically archive Microsoft Teams channels:

1. Verify with your CSM administrator that archiving has been configured for the Microsoft Teams
integration.

2. Move a CSM Business Object record to its final stage.
3. In Microsoft Teams, verify that the channel associated with the completed CSM record has been

archived.
4. In CSM, verify the archived conversation on the configured Journal tab of the Business Object

record. For example, view archived conversations on the Journal - Remote Support History tab.
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Managing Form Arrangements
Form arrangements are managed using the Form Arrangement Editor, accessed from within a Blueprint in
CSM Administrator. Use this tool to:

• Create a form arrangement.

• Edit a form arrangement.

• Delete a form arrangement.

Managing Content-Protected Form Arrangements
If you are working with form arrangements that were previously applied as part of a Protected mApp™
Solution:

• You see a shield icon  next to all content-protected relationships.

• You cannot edit or delete a content-protected form arrangement.

• You can create and edit new form tab relationships on content-protected forms using the Form
Arrangement Editor.

• You cannot edit or delete content-protected relationships but you can create new relationships that
you can edit and delete.
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Form Arrangement Editor
The Form Arrangement Editor is a tool within a Blueprint in CSM Administrator that allows you to
manage (create, edit, delete, etc.) form arrangements.

The Form Arrangement Editor is dynamic; when you make changes, the changes are immediately
reflected in the preview. Publish the Blueprint to commit the changes.

1. Relationship tree: Lists the defined relationships whose child form/records you can add to the form
arrangement. If a child form/record is in an owned by relationship with the parent form/record
(example: Incident Owns Journals), then it can be edited; however, child forms/records in linked
relationships (example: Incident Links Problem) are read-only.

Tip: Create, edit, and delete a relationship directly from the Form Arrangement Editor by
right-clicking it in the Relationship tree.

2. Additional Forms tree: Lists additional forms defined for the Business Object that you can add to
the form arrangement.

Tip: Access Business Object properties directly from the Form Arrangement Editor by
right-clicking in the Additional Forms tree.

3. Tab Arrangement context menu: Displays tab operations so that you can define tab properties:
◦ Tab position: Define where to display the tab labels (above or below the tabs).

◦ Remove tab: Removes the selected tab from the form arrangement.
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◦ Properties: Opens the Tab Properties window to define general, contents, and filter
properties for the tab.

4. Form Arrangement preview: Displays a dynamic preview of the form arrangement, including how
each tab looks (toolbar, split view, etc.).

5. Tabs: Displays the tabs currently displayed on the form arrangement. To add a new tab, drag-and-
drop a relationship or additional form from the tree onto the form arrangement.

CSM 2022.3 Features 533

CSM 2022.3 Features



Open the Form Arrangement Editor
Open the Form Arrangement Editor to create, edit and delete form arrangements.

To open the Form Arrangement Editor:

1. In the CSM Administrator main window, select the Blueprints category, and then select Create a
New Blueprint in the Common Tasks
The Blueprint Editor opens, showing the Object Manager in its Main pane. The Object Manager
lists the existing Business Objects.

2. In the Current View drop-down menu, select the Business Object View for the form arrangement
you want to access.

3. In the Business Object tree, select the Business Object for the form arrangement you want to
access. Tip: Filter the Business Objects by selecting the Major, Supporting, Lookup tables, and
All radio buttons.

4. In the Appearance area of the Object Manager, select Edit Form Arrangement. Tip: You can also
select View > View Arrangement on the Blueprint Editor menu bar.
The Form Arrangement Editor opens displaying the Business Object's default form arrangement
(there is only one form arrangement per Business Object).
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Create/Edit a Form Arrangement
Use the Form Arrangement Editor (accessed from within a Blueprint in CSM Administrator) to create or
edit a Business Object form arrangement. When you create a form arrangement, you:

• Add/delete tabs: Define which tabs appear in the form arrangement. Tabs can come from a defined
relationship or from an additional form defined for the same Business Object.

• Define tab positions: Define where to display the tab labels (above or below the tabs).

• Define tab properties:
◦ General: Name, image, and visibility.

◦ Tab contents: Content to display on the tab, and how (example: Which form/grid, default text,
an optional toolbar, split screen options, and record behaviors).

◦ Filters: Create a filter to limit content from one-to-many Relationships (example: Filter
Journals based on type). Filters can be pre-applied (example: Define an expression to pre-
filter the content on the tab) or user-applied (example: Define and display a filter button/drop-
down on the tab's toolbar so that users can filter their own content).

• Define splitter properties:
◦ General: Sizing properties (initial size and auto-size) for the form arrangement.

◦ Splitter position: Where to display the form arrangement (on top of/below, or to the right/left)
of the form.

Good to Know:

• Only a major object can have a form arrangement, and only one form arrangement exists for each
Business Object in a Business Object View.

• A major object can be included in another major object's form arrangement; however, the data from
a major object is read-only.

• Often, Summary forms are used on a form arrangement because they are smaller and typically
show the most important data.

• If the relationship you need does not yet exist, create the relationship directly from the Form
Arrangement Editor by right-clicking in the Relationship tree. You can also edit and delete an
existing relationship by right-clicking in the Relationship tree.

• You can create stacked zone arrangements for the Portal view of Business Objects.

To create a form arrangement:

1. Open a form arrangement in the Form Arrangement Editor.
2. Add/delete a tab:

◦ To add a new tab, drag-and-drop a defined relationship or additional form from the
Arrangement tree onto the arrangement.

Tip: You can also right-click a defined relationship or additional form, and select Add
Tab.

◦ To delete a tab, right-click the tab, and then select Remove tab.
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3. Define where to display the tab labels, either above or below the tab content:
a. Right-click a tab, and then select Tab Position > Top or Bottom.

Note: Browser Client and Portal form arrangements support Top only.

4. Define tab properties:
◦ General: Name, image, and visibility.

◦ Tab contents: What content to display on the tab, and how.

◦ Tab Filters: How to filter content.

5. Define splitter properties:
◦ General: Sizing properties (initial size and auto-size) for the form arrangement.

◦ Splitter position: Where to display the form arrangement (on top of/below, or to the right/left) of
the form.

6. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.

To edit a form arrangement:

1. Open a form arrangement in the Form Arrangement Editor.
2. Make changes.

3. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Define General Tab Properties for a Form
Arrangement

Use the Tab page in the Tab Properties window to define the general properties for a form arrangement
tab.

Form arrangement general tab properties are:

• Name: Name to display on the tab. By default, the name either comes from the defined name of the
child object in the relationship (example: Journals) or from the name of the additional form being
displayed (example: Resolution Details); however, you can provide a name or define an expression
to conditionally change the name.

• Image: Image, if any, to display on the tab. By default, the image comes either from the defined

image for the child object in the relationship (example: Journals icon ) or, in the case of
additional forms, from the Business Object itself (example: Resolution Details); however, you can
select any image or define an expression to conditionally change the image. Hide the image by
clearing the Tab Image check box.

• Visibility: When to display or hide the tab (example: Always, only after resolution details are logged,
etc.). By default, a tab is always visible unless you define an expression to hide the tab.

Note: The Tab Properties window is available in the Form Arrangement Editor (within a
Blueprint in CSM Administrator).

To define general tab properties for a form arrangement:

1. Open a form arrangement in the Form Arrangement Editor.
2. On a tab, right-click > Properties.
3. Select the Tab page.
4. Define a tab name, using either:

◦ Text: Select this radio button to accept the default name or provide a new name.
◦ Expression: Select this radio button to use an expression to conditionally provide the name.

Then, define the expression using one of the following options:

◦ Stored Expression: Select the ellipsis  to open the Expression Manager, and then
select an existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button  to open the Custom
Expression Builder, and then create a custom expression specifically for this scenario.

5. Define the image:
a. Tab Image: Select this check box to display an image on the tab. Clear the check box to hide

an image.
b. Select an image, using either:

◦ Image: Select this radio button to accept the default image or select a new image.
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Select the image to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Expression: Select this radio button to use an expression to conditionally provide the
image. Then, define the expression using one of the following options:

◦ Stored Expression: Select the ellipsis  to open the Expression Manager, and
then select an existing stored expression or create a new stored expression.
Stored expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button  to open the
Custom Expression Builder, and then create a custom expression specifically for
this scenario.

6. Define the visibility:
a. Tab Visibility: Select this check box to conditionally display/hide the tab. Clear the check box

to always display the tab.
b. Expression: Select this radio button to use an expression to conditionally display/hide the tab.

Then, define the expression using one of the following options:

◦ Stored Expression: Select the ellipsis  to open the Expression Manager, and then
select an existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button  to open the Custom
Expression Builder, and then create a custom expression specifically for this scenario.

c. Select the Tab When It Becomes Visible: Select this check box to have the tab selected
when it becomes visible (based on the defined expression) so that its contents appear in the
form arrangement.

7. Select OK.
8. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Define Tab Contents Properties for a Form
Arrangement

Use the Tab Content page in the Tab Properties window to define what content to display on the form
arrangement tab.

Options include:

• Form/Grid: Which form and grid to display if multiple forms/grids are defined for a Business Object.
Grids are not applicable when displaying additional forms on a tab.

• Default display text: Message to display when no records are available.

• Toolbar: Whether or not to display a configurable toolbar with options to create, delete, link, unlink,
go to, view, and navigate between records; filter content (if filters are defined), print/export a grid (if
viewing a grid), and change the splitter display (depending on supported views). Options vary by
relationship.

• Supported Views: Display tab contents as a form, as a grid, or both. Horizontal and vertical split
options, as well as grid grouping options, are available.

• Default Views: Supported view to display by default on the tab.

• New record behaviors: Where to add new records in a grid (example: Bottom, Top, or Current
Row), and whether or not to allow users to create new records for members in a Group Business
Object (if the tab represents a Group Business Object).

Note: The Tab Properties window is available in the Form Arrangement Editor (within a
Blueprint in CSM Administrator).

Good to Know:

• For more information about grids, see Grids.

• For more information about the Form Arrangement/Relationship toolbar, see CSM Desktop Client
toolbar.

To define tab contents properties for a form arrangement:

1. Open a form arrangement in the Form Arrangement Editor.
2. On a tab, right-click > Properties.
3. Select the Tab Contents page.
4. Define which form/grid to display on the tab:

a. Relationship: By default, this shows the relationship being represented on the tab. If the tab
shows an additional form, None is displayed.

b. Default Form: Select the form to display on the tab. Some Business Objects have only one
defined form.
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◦ To select a Group Member's form, select Specific Form from the drop-down. Select the

ellipsis , and then select the custom form from the drop-down. Select OK.
c. Grid: Select the grid to display on the tab. Some Business Objects have only one defined grid.

Grids are not applicable when displaying additional forms on a tab.
d. Text to Display When No Record is Loaded: provide the text to display in a tab when no

records are available to display.
5. Define toolbar options for the tab:

a. Show toolbar: Select this check box to show a toolbar on the tab.
b. Show Buttons: Select the buttons to display on the toolbar. Options vary by Business Object

but can include:
◦ New: Select this check box to display a New button on the toolbar, allowing a user to

create a new record directly from the tab.
◦ Delete: Select this check box to display a Delete button on the toolbar, allowing a user to

delete a record directly from the tab.
◦ Link: Select this check box to display a Link button on the toolbar, allowing a user to link

to an existing record.
◦ Unlink: Select this check box to display a Link button on the toolbar, allowing a user to

unlink from an existing record.
◦ Quick View: Select this check box to display a Quick View button on the toolbar,

allowing a user to open a related record in a second window to view details.
◦ Change State: Select this check box to display a Change State button on the toolbar,

allowing a user to directly change the Lifecycle value of the related child record
(example: Change a Task to In Progress/Closed/Acknowledged, change an Approval to
Approve/Denied/Abstained, etc.).

6. Define a supported view (example: Display tab contents as a form, grid, or both):
◦ Grid: Select this radio button to display tab contents as a grid.
◦ Grid and Form (Horizontal Split): Select this radio button to display tab contents in a split

view, with the grid on top and the form on the bottom.
◦ Form: Select this radio button to display tab contents as a form.
◦ Grid and Form (Vertical Split): Select this radio button to display tab contents in a split view,

with the grid on the left and the form on the right.
7. Define Grid grouping options:

◦ Yes: Select this radio button to display grid grouping functionality on the tab.
◦ No: Select this radio button to hide grid grouping functionality on the tab.
◦ Based on Grid Setting (Yes or No): Select this check box to display/hide grid grouping

functionality based on the global grid display settings.
◦ Allow User to Show/Hide Grouping Options: Select this check box to allow users to display

or hide grid grouping options.
8. Define default view: This is the supported view that is automatically displayed when the tab is first

selected.
◦ Grid: Select this check box to display tab contents as a grid by default.
◦ Grid and Form (Horizontal Split): Check this box to display tab contents in a split view by

default, with the grid on top and the form on the bottom.

CSM 2022.3 Features 540

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fbusiness_objects%2F..%2Fgrids%2Fgroup_a_grid.html
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_global_grid_and_form_control_display_settings


◦ Form: Check this box to display tab contents as a form by default.
◦ Grid and Form (Vertical Split): Check this box to display tab contents in a split view by

default, with the grid on the left and the form on the right.
9. Define new record behaviors:

a. Where to Add New Records in Grid: Select where to add new records in a grid (example:
Bottom, Top, or Current Row).

b. Group Members on New Button: Select which members of a Business Object Group can be
created from the New button on the tab's toolbar (this option is only available if the tab
represents a Group Object):

◦ All Group Members: Select this option to display all group members in a drop-down
next to the New button.

◦ Default Only: Select this option to display only the default group member on the New
button.

◦ Specific List: Select this option to display only specific group members in a drop-down

next to the New button. Select the ellipsis  to open the Group Members window, and
then select which members to display in the drop-down.

c. New Button Adds Default Group Member: Select this check box to add the default group
member as a new record to the tab contents when the New button is selected. This option is
only available if you select All Group Members or Specific List as options for the New
button.

10. Select OK.
11. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Define Tab Filter Properties for a Form
Arrangement

Use the Filters page in the Tab Properties window to define how content from a one-to-many
Relationship is filtered on the form arrangement tab (example: Filter Journals based on type).

Filters can be:

• Pre-applied: Define an expression to pre-filter the content on the tab.

• User-applied: Define and display a Filter button/drop-down on the tab's toolbar so that users can
filter their own content. You can also define a default behavior for the Filter button, and include a
Search option so that users can search for specific data.

• Applied when linking records: Define and display a Filter button/drop-down in the Record
Selector window when adding records to a tab.

Note: The Tab Properties window is available in the Form Arrangement Editor (within a
Blueprint in CSM Administrator). The Filters page is only available for tabs that display child
objects in one-to-many relationships (example: Journals, Configuration items, etc.). Defining
filters when linking records is only available for one-to-many links relationships (example:
Change Requests).

To define a pre-applied filter for a form arrangement:

1. Open a form arrangement in the Form Arrangement Editor.
2. On a tab, right-click and select Properties.

3. Select the Filters page.

4. Define a pre-applied filter:
a. Limit the rows that appear: Select this check box to use an expression to pre-filter the

content on the tab. Then, define the expression using one of the following options:

◦ Stored Expression: Select the ellipsis  to open the Expression Manager, and then
select an existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button  to open the Custom
Expression Builder, and then create a custom expression specifically for this scenario.

5. Select OK.5.

To define a custom user-applied filter for a form arrangement:

1. Open the Form Arrangement Editor.
2. On a tab, right-click and select Properties.

3. Select the Filters page.
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4. Define and display a custom Filter button/drop-down on the tab's toolbar so that users can filter
their own content:

a. In the Custom Filters area, create/edit/delete/order custom filters (each custom filter is
displayed in the Filter drop-down):

◦ Add: Select this button to open the Filter window, and then create a new custom filter
(name the filter and define the expression).

◦ Edit: Select this button to open the Filter window, and then edit an existing custom filter.

◦ Delete: Select this button to delete an existing custom filter.

◦ Up/Down Arrows: Select to change the order in which the custom filters are displayed in
the Filter drop-down.

b. Default Button Behavior: Select a default behavior for when a user selects the Filter button
(rather than the Filter drop-down arrow).

◦ Show Drop-down List: Select this option to display a drop-down of available filters.

◦ Search Dialog: Select this option to open the Search window, where users can search
for specific data. This option is only available if the Display Search Option (below) is
checked.

◦ Custom Filter: Select a custom filter to apply.

c. Display Search Option: Select this check box to include a Search option in the Filter drop-
down. The Search option opens a window, where users can search for specific data.

5. Select OK.5.

To define filters for a record selector (when adding records to a tab):

1. Open a form arrangement in the Form Arrangement Editor.
2. On a tab, right-click and select Properties.

The Tab Properties window opens.

3. Select the Filters page.

4. In the Filter List when Linking Records area, define a list of filters that users can select when adding
records to a tab.

a. Select Add to add a constraint or filter.

b. Define the constraint:
◦ Field: Select a field in the Business Object you are currently working with.

◦ Operator: Select an operator (example: Equals).

◦ Value: Select a value for the field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values
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◦ System Functions

c. Select OK.c.

d. Add additional constraints as necessary.

5. Define additional properties for the filter:
◦ Filter Display Name: Type a name to display next to the Filter button in the record selector

window.

◦ Allow User to Choose Records that Don't Meet the Limiting Filter: Select this check box to
allow users to select records outside of the defined list of filters.

6. Select OK.6.

7. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Define Tab Relationship Options for a Form
Arrangement

Use the Relationship Options page in the Tab Properties window to define options for showing a menu
of join reasons that users can select when adding child records to a tab in a form arrangement.

Note: The Tab Properties window is available in the Form Arrangement Editor (within a Blueprint
in CSM Administrator). The Relationship Properties page is only available for tabs that display
child objects in many-to-many relationships that are linked with a join table and use a list of values
for the join reason.

When linking a record on a one-to-many relationship with a Group Member on a form arrangement tab,
you can select multiple records in the selector window using Shift+Ctrl. Multi-select is not available when
the relationship is with a Group Leader.

To define tab relationship options for a form arrangement:

1. Open a form arrangement in the Form Arrangement Editor.
2. On a tab, right-click and select Properties.
3. Select the Relationship Options page.
4. Define relationship options:

◦ Show Join Reason Sub-menu for Linking: Select this check box to display an arrow next to

the link button  in the tab. Users can click the arrow to open a sub-menu and select a join
reason for a child record that is added to the tab.

◦ Custom Field for Menu Text: Select this check box to display values from a selected field as
options in the join reason sub-menu. Otherwise, the list of values defined in the relationship's
link properties will be used.

◦ Limit Items for Menu: Select this check box to limit the items that are displayed in the join
reason sub-menu. Then, define an expression that limits the items, either:

◦ Stored expression: Select the Ellipsis button to open the Expression Manager, and
then select an existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM.

◦ Custom expression: Select the Custom Expression button to open the Custom
Expression Builder, and then create a custom expression specifically for this scenario.

5. Select OK.
6. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Define General Splitter Properties for the Form
Arrangement

Use the Splitter Properties window (accessed from within the Form Arrangement Editor) to define how to
size the form arrangement, with respect to its parent form.

Note: The splitter is the boundary between the form and the form arrangement. CSM considers
the first zone to be top or left of the splitter; the second zone is considered bottom or right of the
splitter. Typically, the parent form is displayed in the first zone (and typically on top), and the form
arrangement is displayed in the second zone (and typically on the bottom); however, you can
change the positions.

Sizing properties include:

• Initial sizing styles: Define the Initial size of the first and second zones when displayed within the
CSM main window (Desktop Client or Browser). Options include:

◦ Percentage: Sizes the first zone to a specified percentage of the available space (example:
75%), then sizes the second zone to the remainder of the available space (example: If first
zone is 75%, the second zone would get 25%).

◦ First: Determines the amount of space required by the first zone, and then attempts to give
the second zone as much space as is required for the content to be displayed without scroll
bars (within some limits described below).

◦ Second: Determines the amount of space required by the second zone, and then attempts to
give the first zone as much space as is required for the content to be displayed without scroll
bars (within some limits described below). If the content is dynamic, the first item is used for
sizing (example: A tab, which is typical in the second zone, is used to determine the size). If
the tab displays a grid, the size is not necessarily fixed.

◦ Specific size, in pixels: Sizes the first zone to a specific number of pixels, and then gives the
rest of the available space to the second zone.

• Auto resize splitter: Auto-resizes the zones when the application is resized. If the initial size is set
to a percentage, the zones resize relative to that percentage. If the initial size is set to First or
Second, the zones resize to handle the content within the zones.

• Limit splitter size: Defines a hard limit (percentage of pixels) to how much space the first zone can
take up, regardless of any other sizing factors (example: If the maximum percentage is set to 85%, a
900 pixel high form displayed within a 1000 pixel high window will be limited to 850, and the second
zone will have the remainder. Even if no maximum is set, CSM does not allow the main zone to take
up so much space that the second zone is pushed off the window.

Note: The Form Arrangement Editor is accessed from within a Blueprint (in CSM
Administrator).

• Disable user's ability to move splitter: Prevent the user from resizing panes using the splitter.

To define general splitter properties for the form arrangement:
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1. Open a form arrangement in the Form Arrangement Editor.

2. Hover over the form arrangement splitter until a two arrow splitter appears , and then right-click
and select Properties.

3. Define splitter properties:
a. Initial sizing style: In the drop-down, select an initial sizing style for the first and second

zones when displayed within the CSM main window (Desktop Client or Browser). Options
include:

◦ Percentage: Select this option to size the first zone to a specified percentage, giving the
rest of the available space to the second zone. Then, specify the percentage of available
space to give to the first zone.

◦ First: Select this option to allow CSM to determine the amount of space required by the
first zone, and then attempt to give the second zone as much space as it needs be
displayed without scroll bars (within some limits described below).

◦ Second: Select this option to allow CSM to determine the amount of space required by
the second zone, and then attempt to give the first zone as much space as it needs to be
displayed without scroll bars (within some limits described below).

◦ Specific size, in pixels: Select this option to provide a specific number of pixels to size
the first zone, giving the rest of the available space to the second zone. Then, specify the
number of pixels to give to the first zone.

b. Allow auto-resize: Select this check box to auto-resize the zones when the application
window is resized.

c. Allow auto-resize: Select this check box to auto-resize the zones when the application
window is resized.

◦ Max percentage: Select this option to limit the first zone to a percentage of the available
space. Then, specify the percentage.

◦ Max pixels: Select this option to limit the first zone to a specified pixel threshold. Then,
specify the number of pixels.

Note: This feature is not supported in the Browser Client or Portal.

d. Disable User's ability to move splitter: Select this check box to disable repositioning of the
splitter.

4. Select OK.
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Define Splitter Position Properties for the Form
Arrangement

Use the Splitter Position property to define where to display the form arrangement, relative to its parent
form.

The Form Arrangement Editor is accessed from within a Blueprint in CSM Administrator.

To define splitter position properties for the form arrangement:

1. Open the Form Arrangement Editor.

2. Hover over the form arrangement splitter until a two arrow splitter appears , then right-click and
select Splitter Position, and then select a position from the drop-down. Options include:

◦ Top-Bottom: Display form arrangement below the parent form.
◦ Left-Right: Display form arrangement to the right of the parent form.
◦ Bottom-Top: Display form arrangement above the parent form.
◦ Right-Left: Display form arrangement to the left of the parent form.

3. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Define Stacked Zone Options for a Portal Form
Arrangement

Use Stacked Zone options to define properties for a simple form arrangement with stacked zones.

These include:

• Mode: Define different form arrangements based on which form is displayed.

• Name: Name to use within CSM for the stacked zone.

• Location of Data: Where the data to display in the stacked zone is retrieved (Business Object or
relationship).

• Display Mode: How to display the data in the stacked zone (view-only form, editable form, or
results list).

• Visibility: When to display or hide the stacked zone. By default, a zone is always visible unless you
define an expression to hide it.

• Title: Name to display on the stacked zone. By default, the name either comes from the primary
Business Object or from the relationship; however, you can provide a custom name.

To define Stacked Zone options for a form arrangement:

1. Open the Portal View for a Business Object.
2. Open a form arrangement in the Form Arrangement Editor.

3. Select the Stacked Zone button .
The Business Object is listed as a stacked zone by default and cannot be edited or deleted.

4. Select a Mode. This allows you to define different form arrangements depending on the form being
displayed:

◦ Create New: Select this option to define a form arrangement for the Business Object's default
form.

◦ Display: Select this option to define a form arrangement for a view-only form.

Note: Select the Same as Edit Mode check box for the Create New and/or Display
modes to use the same form arrangement as defined for the Edit mode.

◦ Edit: Select this option to define a form arrangement for an editable form.
5. Select Add to add a stacked zone to the form arrangement.
6. Provide a name for the stacked zone.
7. Define where the data displayed in the stacked zone comes from:

◦ Business Object: Select this radio button to have data from the Business Object displayed
(example: Resolution Details for an Incident).

◦ Relationship: Select this radio button to have data from a relationship displayed. In the drop-
down, select a Relationship.

8. Define the display mode:
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◦ View-only Form: Select this radio button to display one of the available Business Object
forms (either from the primary Business Object, or a related Business Object, if applicable) as
a view-only form in the stacked zone. Then, in the drop-down, select the form to display.

◦ Editable Form: Select this radio button to display one of the available Business Object forms
(either from the primary Business Object, or a related Business Object, if applicable) as an
editable form in the stacked zone. Then, in the drop-down, select the form to display.

◦ Result List (Relationships only): Select this radio button to display data from a relationship
in a results list. Select the field to use to order the values in the list, as well as an ascending or
descending order.

9. Define the visibility:
a. Always Visible: Select this radio button to always display the zone.
b. Expression: Select this radio button to use an expression to conditionally display/hide the

zone. Then, define the expression using one of the following options:

◦ Stored Expression: Select the ellipsis  to open the Expression Manager, and then select
an existing stored expression or create a new stored expression. Stored expressions can be
reused in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button  to open the Custom
Expression Builder, and then create a custom expression specifically for this scenario.

10. (Optional) Define whether to show a title for the zone:
a. Select the Show Title check box.
b. Provide a title for the zone (the name of the Business Object or relationship is there by

default).
c. Select the image to open the Image Manager, and then select an existing image or import a

new image to represent the item in the UI.
11. Select OK.
12. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.
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Activity Pane
Use the Activity Pane to view the activity and communications for a Major Business Object in one easy-to-
navigate area.

The Incident Business Object already has the Activity Pane set up.
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Using the Activity Pane

Create a Note
Click Create Note to add a note. Notes appear in the Internal Notes tab.

Pin a Note
You can pin records for easy access. When a record is pinned, a pin icon appears by the header and the
record is duplicated in the Pinned tab.

To pin a record:

1. In the CSM Desktop Client, right-click the Header/Title area of the record.

2. From the context menu, select Pin.

3. In the CSM Browser Client, click the vertical dots button and select Pin.

To unpin a record:

1. In the CSM Desktop Client, right-click the Header/Title area of the record.

2. From the context menu, select Unpin.

3. In the CSM Browser Client, click the vertical dots button and select Unpin.

Sort
Activities are sorted by the Created Date/Time. You can reverse the sort order of the activities. Records
displayed on the Activity tab can be sorted by Created Date. If the Activity type of Created is not mapped,
the sorting control will be hidden.

Search
Use the search field on each Activity Pane tab to search only that particular tab. Search results are
cleared when you switch to another tab.
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Configure the Activity Pane
You can map the Activity Pane fields to any Business Object.

To display the Activity Pane:

1. In the Business Object Properties dialog, navigate to the History page and select the Display Activity
Pane checkbox.

2. The Activity Pane will initially show up as the first tab in the Form Arrangement. You can change the
order using the Form Designer.

The History relationship for a major Business Object determines the data that will display on each Activity
Pane tab. The Create Note button is enabled when the Manual History relationship is enabled on a major
Business Object.

You can map seven Activity Property Types in a Business Object:

Activity Property Field Type Suggested Mapping for Journal - Note
Business Object

Created Date/Time Created Date Time

Modified Date/Time Last Modified Date

Created By Text (Plain) Created By

Modified By Text (Plain) Modified By
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Activity Property Field Type Suggested Mapping for Journal - Note
Business Object

Body Text (Plain or Rich) Details

Title Text (Plain) Note: This is currently a placeholder
field.

Pinned Logical

You can see the Activity Group mappings for a Business Object in the area below the Display Activity
Pane checkbox. If a relationship is not mapped, "No Mapping" is displayed. This means the data captured
in the supporting Business Object will not display the record data on the Activity Pane tab.
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How to Map Activity Pane Fields
You can map logical, text, or date/time fields to the Activity Pane to view the activity and communications
for a Major Business Object in one easy-to-navigate area.

To map Activity Pane fields:

1. In CSM Administrator, create a new Blueprint.
2. In the Manage objects pane, select the Supporting radio button under Show object types.
3. Expand Journal, and then select the Supporting Business Object you want to edit (example:

Journal - History).
4. Select Edit Business Object
5. Choose a field to map to. You can map to logical, text, or date/time fields. Right-click the field name,

and then select Edit.
6. In the Field Properties dialog, select the Advanced page.
7. In the Activity Mapping section, choose an option in the Maps To drop-down. If a field on the Activity

Pane is already mapped, the mapping will appear in parentheses after the field name in the drop-
down. Different selections are shown depending on the field type (i.e., Text fields can only be
mapped to text fields on the Activity Pane, and date/time fields can only be mapped to date/time
fields on the Activity Pane). Invalid mappings are grayed out.
You can overwrite existing mappings by selecting a new field to map to. To clear a mapping, select
None.

8. Repeat steps 5-7 to map any additional fields you would like to see in the Activity Pane.

Changing activity mappings on a group leader does not propagate down to group members. However, if
you have a group leader that has activity mappings and then create the group members, the parent's
mappings will exist on the new children. If you create a new Business Object group to track history, create
the group leader and configure the activity mappings before creating the children.
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Activity Pane Troubleshooting

General Activity Pane Troubleshooting

• If you are seeing slow response times in the Activity Pane, check your indexing.

• If you have History options for the Incident Business Object set up so multiple Group members hold
the same History, you will see duplication of information in the Activity Pane.

• If the Create Note button is disabled:
◦ Make sure you saved the parent record.

◦ Mappings may be incorrect; contact your Cherwell administrator.

• The Create Note button is disabled if the supporting Business Object has more than one required
field that is not the mapped Activity type of Body.

• If the Created property is not mapped for a history Business Object, but other history objects related
to the same Activity tab are mapped correctly, then the sort control will still be visible. However, this
can result in unexpected sort behavior due to any null values within the Created Date Time field. If a
Business Object does not have Created Date/Time field mapped but the other Business Objects for
the history relationship do, the All tab and Pinned tab will still have the sort option but the records
without the date/time field mapped will appear at the end of the list

User Permission Issues
When Users have problems interacting with the Activity Pane, it is often helpful to check the User's
security settings.

• Problem: I can add a Note but can't see any notes in the Desktop Client.
◦ Solution: Ask your Cherwell administrator to grant you View Rights on the Journal - Note

Business Object.

• Problem: I can add a note until the record is refreshed in the Browser Client.
◦ Solution: Ask your Cherwell administrator to grant you View Rights on the Journal - Note

Business Object.

• Problem: The Create Note button is disabled.
◦ Solution: Ask your Cherwell administrator to grant you Edit Rights on the Journal - Note

Business Object.

◦ Solution: Ask your Cherwell administrator to grant you Add Rights on the Journal - Note
Business Object.

• Problem: I see an error message that says "You do not have rights to view one or more mapped
fields."

◦ Solution: Ask your Cherwell administrator to grant you View Rights on the Journal - Note
Business Object Details Field.

◦ Solution: Ask your Cherwell administrator to grant you Edit Rights on the Journal - Note
Business Object Pinned Field.

• Problem: I can add a note and see the Details field for the added note until I refresh the record -
then I get an error message that says "You do not have rights to view one or more mapped fields."
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◦ Solution: Ask your Cherwell administrator to grant you View Rights on the Journal - Note
Business Object Details Field.
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Calendars
A Calendar allows you to view time-sensitive Business Object data in a natural format that can be shared with
Teams or an organization.
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About Calendars
Use a CSM Calendar to view:

• All scheduled Changes/Releases for a particular month.

• Your assigned Tasks due on a specific date.

• IT Project schedules.

• Service schedules.

• Note: Calendars display a maximum of 10,000 records.•

Each User has a designated default Calendar, which opens when the User clicks the Calendar button on
the CSM Desktop Client toolbar (in the Browser Client, click Calendars from the Browser Client menu
bar). The default Calendar is initially selected in CSM Administrator, Globally or by Role. Users with
appropriate security rights can select their own default Calendar in the CSM Desktop Client. Access
available Calendars using the Calendar Manager.

CSM 2022.3 Features 560

CSM 2022.3 Features



Tour a Calendar
Use the Calendar interface to quickly browse and view scheduled items for a particular day, week, or
month. Depending on security rights, you can even edit existing Calendar Items, change times and
durations, and add new Calendar Items.

1. Main Pane: Displays Calendar Items (ex: My Tasks, Team Tasks, etc.).
◦ Hover over a Calendar Item to view more details.

◦ Double-click a Calendar Item to view and update the record.

◦ Right-click in the Main Pane to open a context menu so you can perform various tasks.

2. Calendar View Pane: Displays the view by Day, Work Week, Week, Month, or Timeline. Right-click
inside the calendar to set Time Scales and Time Scale Captions.

3. Dates Pane: Controls which dates are currently displayed on the Calendar.

4. Legend: Controls which Calendar Items are displayed in the Main Pane. Each legend is unique for
the Calendar and is part of creating a Calendar.
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Using Calendars
When working with Calendars, Users can:
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View a Calendar
A Calendar can be viewed several ways:

• Default Calendar:

◦ On the Desktop Client toolbar, click the Calendar button .

◦ From the Desktop Client menu bar click Tools>Calendar>Main Calendar.
◦ From the Browser Client menu bar, click Calendars.

• Available Calendars (based on security rights):

Use the Calendar Manager.

• MRU Calendars:
◦ From the Desktop Client menu bar, click Tools>Calendars, and then select a Calendar from

the MRU list (listed below the line in the menu).

◦ From the Browser Client menu bar, click Calendars, and then select a Calendar from the
MRU list (listed below the line in the menu).
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Change the Calendar View
View Calendar information by:

• Day View: Displays items for a single day.

• Work Week View: Displays items for the defined work week.

Tip: In the Day View and Work Week View, you can also increase or decrease the time increments
displayed in the Calendar (in the column to the left of the main pane where the times are displayed,
right-click>select time increment).

• Week View: Displays items for a single week.

• Month View: Displays items for a single month.

• Timeline View: Displays items for a specified period of time (timeline). You define the timescales
(timescale options only appear when in Timeline View).

• Gantt View: Displays items for an entire project schedule.

Good to know:

• Regardless of the view, the current day (Today) is highlighted.

• Each Calendar has a default view, which is determined when the Calendar is created. If you have
security rights, you can change the default view of an existing Calendar.

• Changing the Calendar view only temporarily changes the view. The next time you view the
Calendar, it displays in the default view.

To change the calendar view:

1. View a Calendar.

2. On the Calendar, right-click>Change View To>select a format to change from the current view.
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View/Edit a Calendar Item
View and edit Calendar Items directly from a Calendar.

Good to know:

• Dates that have Calendar Items to display show up bold in the Dates pane.

To view/edit a Calendar item:

1. View a Calendar.

2. Do one of the following:
◦ Click the arrows at the top of the Dates pane to browse Calendar Items by month/year.

◦ Click a date in the Dates pane to display it (and its Calendar Items) in the main pane.

◦ Click the Today button in the Dates pane to display the current date (and its Calendar Items).

◦ Right-click>Go to Today to display the current date and its items.

◦ Right-click>Go to Date to select a date to display.
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Add a Single Calendar Item
Add any Calendar Item listed in the Legends area to a Calendar directly from the Calendar window.

Good to know:

• Calendar Items that can be added to the Main Pane are displayed in the Legends area and are
determined when the Calendar is created.

• If you have security rights, you can add, edit, or delete the Calendar Items that appear in the
Legends area.

• If you edit the time components that control where the Calendar Item is displayed, the item
automatically moves on the Calendar, and the Calendar display changes to keep the item visible.

To add a Calendar Item:

1. View a Calendar.

2. On the Calendar, right-click>New [Calendar Item].

The New window opens where you can enter the Calendar Item details.

Note: The name of the Calendar Items available for selection will vary depending on what
was defined during Calendar creation.

3. Select OK.3.

4. Depending on the Calendar Item and security settings, you might be able to perform the following
operations:

◦ To change the date, drag the Calendar Item to a new date/time.

◦ To change the duration, resize the Calendar Item to accommodate the new time.

◦ To change editable details, double-click the Calendar Item (or right-click>Open). The Quick-
View window opens where you can change editable details.

Select OK.
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Navigate through Calendar Items
Navigate through Calendar Items on a Calendar quickly and easily.

Good to know:

• Regardless of the Calendar view (Day, Work Week, Week, Month, or Timeline), the current day is
always highlighted.

• Dates that have Calendar Items to display show up bold in the Dates pane.

To navigate through Calendar Items:

1. View a Calendar.

2. Do one of the following:
◦ Click the arrows at the top of the Dates pane to browse Calendar Items by month/year.

◦ Click a date in the Dates pane to display it (and its Calendar Items) in the main pane.

◦ Click the Today button in the Dates pane to display the current date (and its Calendar Items).

◦ In the main pane, Right-click>Go to Today to display the current date and its items.

◦ In the main pane, Right-click>Go to Date to select a date to display.

◦ Mouse over a Calendar Item to display a description.

◦ Double-click a Calendar Item to open it for viewing/editing.

◦ Use the check boxes in the Legend to show or hide Calendar Items.
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Show/Hide a Calendar Item
Use the check boxes in the Legends area of the Calendar window to hide/show Calendar Items on a
Calendar.

Good to know:

• Each Calendar has a default list of items that can appear, which is determined when the Calendar is
created. If you have security rights, you can add, edit, or delete the Calendar Items that appear in
the Legends area.

To show/hide Calendar Items:

1. View a Calendar.

2. Do the following:
◦ To show a Calendar Item, select the check box next to the item in the Calendar Legends area.

◦ To hide a Calendar Item, clear the check box next to the item in the Calendar Legends area.
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Adjusting Gantt View Time Scales
Gantt View enables you to see items for an entire project schedule. You can adjust the time scales and
captions for Gantt View.

To adjust Gantt View time scales:

1. On the Calendar, right-click>Change View to>Gantt View.

2. Right-click>Adjust Time Scales, and then select from these options:
◦ Year.

◦ Quarter (ex: Q3).

◦ Month.

◦ Week.

◦ Day.

◦ Hour.

◦ 15 Minutes.

3. Right-click>Adjust Time Scale Captions to adjust the frame of the Time Scales (ex: Tuesday,
August 12, 2015 - Tuesday August 12, 2015).
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Managing Calendars
CSM Calendars are managed using the Calendar Manager.

There are several ways to open the Calendar Manager.

Use the Calendar Manager to complete general CSM Item Manager operations for Calendars, including:

• View a Calendar.

• Create a Calendar

• Create a Calendar Item.

• Edit a Calendar.

• Delete a Calendar.

• Search for a Calendar.

• Organize Calendars.

• Copy a Calendar.

• Import/export a Calendar.
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• Find Calendar dependencies.

• Add a Calendar to the Desktop Client Task Pane/toolbar.

• Pin a Calendar.
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Open the Calendar Manager
Open the Calendar Manager from CSM Administrator, the CSM Desktop Client, or the CSM Browser
Client.

• In the CSM Desktop Client or Browser Client menu bar, select Tools > Calendars > Calendar
Manager. For more information, see CSM Desktop Client menu bar or Browser Client menu bar.

• In the Blueprint or mApp Editor menu bar in CSM Administrator, select Managers > Calendar
Manager. For more information, see Blueprint Editor menu bar or mApp Editor menu bar.

• In Calendar selectors throughout CSM.
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Create a Calendar
Use the Calendar Properties window (accessed from within the Calendar Manager) to create or edit a
Calendar.

To create a Calendar:

1. Open the Calendar Manager.1.

2. Select a scope and subfolder (if needed).2.

3. Select Create New .

4. Define general properties:
a. Name:

Provide a display name to use within CSM (search for this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search for this property in CSM Item Managers).

c. Title Text:

Provide a title to display in the banner above the Calendar. If blank, no title is displayed.

5. Define date and time options for the Calendar:
a. Default view: Select the default date format to display. Options are:

◦ Day.

◦ Work Week.

◦ Week.

◦ Month.

◦ Timeline.

b. Work Day Start/End: Select the work hours to display.

c. Include Weekends in week view (Optional): Select this check box to include Saturdays and
Sundays on the Calendar; otherwise, only Monday through Friday is displayed.

6. Select one or more Calendar Items to display on the Calendar (Legend area):

Notes: A Calendar must have at least one Calendar Item. The color displayed to the left of
each Calendar Item is the color the item displays on the Calendar:

a. Select Add  to open the Calendar Item window, where you can create a Calendar Item to
display.

b. Complete the Calendar Item details.

c. Select Save.

d. The new Calendar Item is added to the list of Calendar Items.
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Note: Select Edit to edit a selected Calendar Item; Se;lect Delete to remove a selected
Calendar Item from the list; Use the Up/Down arrows to change the order of the Calendar
Items in the Legend area.

7. (Optional) Define additional options:
a. Select Options.

b. Availability:

In the drop-down list, select a scope.

Note: If you already selected a scope at the beginning, this is auto-filled with your selection.

c. Association:

If applicable, select a more filtered scope (example: A particular team). <Automatic> applies
scope based on login. If not applicable, this option is disabled.

d. Custom Image:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

e. Select OK.e.

8. Select Save.8.
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Create a Set of Calendar Items
Use the Calendar Item window to create a Calendar Item. Calender Items populate Calendars with a set
of records based on the Query and duration parameters.

To create a Calendar Item:

1. Open the Calendar Item window:
a. Open the Calendar Manager.

b. In the Manager, click a Calendar, and then click Edit  to open the Calendar Properties
window.

c. Click the Add button .

2. Define general information:
a. Business Object: Select the Business Object to show on the Calendar. You can select any

Major Object or any Business Object that allows Saved Searches to be defined against it.

b. Item Name: Specify a name for the Calendar Item. This is the way the item will be displayed
on the legend. The default value is based on the selected Business Object, but can be
changed.

c. Query: Select the search to be executed to determine which items should be displayed on the
Calendar. For example, you can limit the search to only open records. For best results, do not
put any date criteria into the query because the Calendar will automatically search for items
based on the currently displayed date range. If you do not specify a query, then all records of
the selected Business Object type that fit into the currently displayed date range will be
displayed.

d. Item color: Select the color to display for the Calendar Item. The system does not enforce the
choice of different colors for different items, but for best results, select distinctive colors for
each item, but avoid very dark colors as the text may be hard to read.

3. Select Fields to determine how items are found and how they are displayed:
a. Start date: This is the date/time Field that controls where items are displayed on the Calendar.

This Field is used when searching only read items that fall within the currently displayed time
range.

b. End date: If set, this controls the length (duration) of the item.

Note: Users may experience performance issues when Calendar Items span across
several weeks or months, particularly in the CSM Browser Client. For best results, use
the Business Object's end date field (example: Scheduled End Date for Change
Requests) or use (None) and instead, use the Default date/time options.

c. Header text: The Field that shows up in the title for the Calendar Item.

d. Prefix with object name: If the header text is not clear (example: If it is a number like the ID
of the Change), then selecting this option will add the name of the object in front of the item in
the title. For a Change Request, that would change 12345 into Change Request 12345.

e. Display text: This is the Field used to fill in the body of the item; it is usually a large text Field
that describes the item.
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4. Define default date/time options to use if appropriate information cannot be found:
a. Duration: If there is no End date, or the End date is empty, this specifies the size of items on

the Calendar. For example, if a task has a start time, but no end, it might make sense to show
it as taking up two (2) hours on the calendar.

b. Start Time: If the Start date does not have a time component, or the time has not been set,
this specifies the default time to use to display the items on the Calendar, rather than having
all of the items show up as starting at midnight.

5. Define display/editing options:
a. Allow edit: Select this check box to allow Users to edit the item directly from the Calendar.

The User must also have appropriate edit rights for the Business Object.

b. Allow dragging: Select this check box to allow Users to move the item (change its time) on
the Calendar. The User must also have appropriate edit rights for the Business Object. Note
that, if you use a system-managed Field for the Start date, such as Created Date/Time, you
should disable this option because you rarely want to allow Users to change this value.

c. Allow resizing: Select this check box to allow Users to resize the item (change its duration)
on the Calendar. The User must also have edit rights for the Business Object and an End date
Field must be specified. Otherwise the item does not have a duration.

d. Allow caching: Select this check box to allow the Calendar to cache Business Object
information in order to make dragging and resizing more efficient.

Note: Caching improves performance but it can cause problems if objects depend on
each other for live values. For example, the Calendar might display multiple objects
that depend on one another to control their legal times.

e. Items shown by default: Select this check box to display the item by default on the Calendar.
If you clear this option, the item still appears on the Calendar Legend, but no data is retrieved
until the User explicitly selects the check box next to it.

6. Select OK.6.
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Configuring Calendars
Calendar configuration procedures are completed in CSM Administrator.

To configure Calendars:

• Configure Calendar security rights.

• Set Default Calendars.
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Setting Default Calendars
The default Calendar is initially selected in CSM Administrator, Globally or by Role. Users with
appropriate privileges can choose their own default calendar.
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Select a Default Global Calendar
Use the System Settings window in CSM Administrator to select the default Global Calendar.

Good to know:

• If a default Role or User Calendar is selected, it will override the Global default.

• Users with appropriate security rights can select their own default Calendar in the CSM Desktop
Client.

• Customers have limited options and cannot override defaults in the Portal.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default Global Calendar:

1. Open the System Settings window (CSM Administrator>Settings>Edit System Settings).

2. Click Dashboards, etc.

The Dashboards, Calendars, and Visualizations window opens.

3. Click the My Tasks button  to the right of the default Calendar.

The Calendar Manager opens.

4. Select a Calendar to be the default.

Tips: Be sure to select a Calendar that everyone can access (global scope). Create a new
Calendar, if needed.

5. Select OK.5.
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Select a Default Role Calendar
Use the Role Manager in CSM Administrator to select the default Role Calendar.

Good to know:

• If no default Role Calendar is selected, the Global default will be used.

• Users with appropriate security rights can select their own default Calendar in the CSM Desktop
Client.

• Customers have limited options and cannot override defaults in the Portal.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default Role Calendar:

1. Open the Role Manager.
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2. Click the Role for which you want to select a default Calendar.

The Role Profile opens in the Manager window.

3. Select the default Role Calendar, either:
◦ Use default: Select this radio button to use the default Global Calendar.
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◦ Calendar: Select this radio button to use a default Role Calendar. Then, click the Calendar

button  to open the Calendar Manager, where you can select an existing Calendar or
create a new Calendar to use as the default. Be sure to select a Calendar that everyone in that
Role can access.

4. Click Save .
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Select a Default User Calendar
Use the CSM options window (Dashboards & Calendars page) in the CSM Desktop Client to select a
User default Calendar.

Good to know:

• Users must have security rights to override the Global defaults and select a User default.

• If a User default is not selected, either the Global or Role default will be used.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default User Calendar:

1. From the CSM Desktop Client toolbar, click Tools>Options.

2. Click the Dashboards & Calendars page.

3. Select a default User Calendar, either:
a. Use default: Select this radio button to use the default Global or Role Calendar (depends on

which one the system administrator has selected).

b. Calendar: Select this radio button to use a default User Calendar instead of the default Global/

Role Calendar. Then, click the Calendar button  to open the Calendar Manager, where
you can select an existing Calendar or create a new Calendar to use as the default.

4. Select OK.4.
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Color Selector
A Color Selector is a tool that enables users to select from a set of colors and apply them to various
elements within CSM (example: dashboards, form controls, reports). The available sets of colors (palette,
reference, system, web, and/or custom) depend on the location in CSM from where the Color Selector is
accessed.

The Color Selector that opens when you are editing a feature depends on its theme (forms, dashboards),
or where you are within CSM.

If you are editing a form associated with a classic theme, the classic version of the Color Selector opens.
Use this link About the Color Selector for information on the classic version.

If you are editing a form using a Universal theme, the Universal version of the Color Selector opens. The
controls and features presented in the Universal Color Selector vary depending on where it is opened
from within CSM. See About the Color Selector.
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Universal Color Selector as displayed in the Theme Editor.

Universal Color Selector as displayed in a design editor with (Custom) theme association selected.
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Universal Color Selector as displayed in a design editor with a theme association color property selected.
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About the Color Selector
Use the Color Selector to:

• Define a set of colors for a theme.

• Apply colors to design elements within CSM (example: dashboards, portal sites, forms, etc).

Note: This topic describes the color selector provided with the Universal features. If you are using
the classic version of the color selector, see About the Color Selector in the 10.2 version of the
help documentation.

In general, the Color Selector can be used to select colors for:

• Themes: Defined set of colors that can be applied to elements on a Dashboard, Form, Portal site, or
Action Catalog.

• Backgrounds, foregrounds, borders, and/or text for various CSM elements, including:
◦ Background colors for Dashboards, Forms, Portal sites and Action Catalogs.

◦ General, example: Widget appearance.

◦ General appearance of Form Controls.

Colors can be solid or transparent and are categorized as follows (represented as tabs in the Color
Selector):

• Reference:
All colors defined for the default CSM Theme. The different elements on a dashboard, form, portal
site or action catalog (example: dashboard background color, form control text colors, portal banner
colors, etc) have defined colors based on the default Theme. We recommend always using default
theme colors when available to give a cohesive look. However, you can apply non-theme colors
(system, web, or custom) if needed. If you apply non-theme colors to elements within CSM, they will
not change to another theme color if you apply a different theme.

Note: Custom colors added to a theme are not listed in this category.

• Web:

Set of named web-safe colors.

• Custom:

Customized red, green, blue (RGB) colors.

• Palette:

Set of colors that are present in the palette section of the Theme Editor for the current theme. This is
similar to Reference colors but lists all of the colors defined in the current theme open in the Theme
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Editor, including any custom colors that have been added. This category is only available when
editing a state override color for a form theme.

Note: Depending where the Color Selector is opened determines which of the tabs described
above are displayed, not all tabs may be displayed (example: If opened in the Form Editor, tabs
are only displayed when (Custom) is selected in the Theme Association drop-down. In addition
only the Web and Custom tabs are displayed).
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Using the Color Selector
The Color Selector enables you to select or create colors to apply to themes, forms and dashboards.

The Color Selector opens when you:

• Select the Add Color button in the Theme Editor.

• Select a color to edit in a theme color swatch.

• Select a color to edit in a theme state override swatch.

• Select one of the following in a designer:
◦ Form or dashboard Background Color.
◦ Background Color.
◦ Foreground Color.
◦ Border Color.

You can use an existing color or create a new color by selecting one of the following:

• Reference: Select an existing reference color from the list.

• Web: Select and existing web-safe color from the list.

• Palette: This list is shown when editing a state override color only. Select an existing palette color
from the list.

• Custom: Use the controls and fields in this section to create a new color.

Using the Color Selector in the Theme Editor
To use the Color Selector when creating or editing a theme.

1. Open the Theme Editor.
2. Hover the mouse pointer over a color on a color swatch and select Edit.
3. Select a color from the available color lists, or create a new color using the controls in the Custom

section.

4. Select Apply.

Using the Color Selector in a Designer
To use the Color Selector when creating or editing a form or dashboard.

1. Open the designer (form or dashboard).

2. Select an element or background.

3. The Color Selector can be opened in several ways:

◦ Select the form / dashboard Background Color  to change the background color.
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◦ Select an element, then select the element Background Color  to change an element's
background color.

◦ Select an element, then select the element Foreground Color  to change an element's
foreground color.

◦ Select an element, then select the element Border Color  to change an element's border
color.

4. Select a color to apply from the Theme Association drop-down list:
◦ Select an existing color from the list.

◦ Select (Custom) to display the custom color controls:
◦ Select a color from the available lists (example: Web).

◦ Select Custom and use the color controls to create a custom color.

5. Select Apply.
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Content Manager
The Content Manager is an administrator's tool used to manage all items within CSM. This includes the
creation of Business Objects and the identification of changes and dependencies during the creation and
management of Blueprints.
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About the Content Manager
Use the Content Manager to manage all items and their dependencies, especially during the creation and
management of Blueprints.

Gather all of your required content for a business process using the Content Manager. For example, you
could gather all items for the HRSM Onboarding process. This could involve gathering Business Objects
for Employee, Financial data, Location, and Emergency Contact.

In contrast to the Object Manager, the Content Manager provides you with a comprehensive view of all
your system's contents in a single area, as well as the ability to review any changes that have been made
prior to creating a mApp® Solution or Blueprint.

Related concepts
Object Manager
Related tasks
Open the Content Manager
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Manage Content Items
Use the Content Manager to manage content items for your business processes (example: ITSM
processes, HRSM processes) and their dependencies.
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Open the Content Manager
Open the Content Manager from within a Blueprint in the CSM Administrator.

To open the Content Manager:

1. In the CSM Administrator main window, select the Blueprints category, and then select the Create
a New Blueprint task.
The Blueprint Editor opens, with the Object Manager open in the main pane.

Note: If working on a saved Blueprint, open the existing Blueprint.

2. Select Content Manager.
The Content Manager opens.

To switch between Content Manager and Object Manager:

3. Select the appropriate link on the View menu or select the icon in the toolbar.

Note: The Quick Task Pane disappears when you open the Content Manager.

The Content Manager does not save your last view when you switch away from it.

Related concepts
Tour the Content Manager User Interface
Related tasks
Filter Items by Association
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Tour the Content Manager User Interface
Use the Content Manager to manage all items and their dependencies, especially during the creation of
mApp® Solutions.

The following image shows the Content Manager User Interface (UI):

1. Menu items: Switches from Content Manager to Object Manager and back again. You can also
access these options using the View menu.

2. Definition list: A list of all content items grouped by type within your CSM system. The lower list is
grouped by item type.

3. Search or Filter: Toggles between a search input field and the filter drop-down list.

4. Filter drop-down list: Filters content by Business Object type or association (relationship).

5. Counter: Displays the number of results (items in your system) in the main pane when you make a
selection from the definition list and/or use the filters.

6. Clear: Clears any filters that are in use.

7. Columns: The columns displayed vary depending on your item selection. You can sort on any
column apart from Actions. If you hover over a column heading, you can see the current sort
direction (ascending/descending) and a tooltip if one is applicable.

a. Edited: In the column with a pencil icon, green dots appear when the contents of the active
Blueprint have changed.
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b. Name: Name of the CSM item.

c. View: The view in which the CSM item appears.

d. Association: Business Object with which the CSM item is associated. You can filter your
results using this column. Associations can be viewed for manager items, relationships, forms,
grids, and arrangements.

e. Date Modified: Date the item was last modified.

f. Scope: Read only information about who has access rights to this CSM item. When the
Definition Type supports Scope, then the column is visible. All Manager Items support Scope.

g. Protected status: A black dot is shown in this column if the item is part of a Protected
mApp™ Solution.

h. Actions: There are different actions available depending on whether your selected item is a
Business Object or not.

Table 1. Actions for Business Objects

Action Description

Edit your selected Business Object. This action takes you to the Object Manager.

Edit the relationships for your selected Business Object. This action takes you to
the Relationship Editor.

Edit a form for your select item. This action takes you to the Form Editor.

Edit a grid for your selected Business Object. This action takes you to the Grid
Editor.

Edit a form arrangement for your selected Business Object. This action takes you
to the Form Arrangement Editor.

Note: All these actions work exactly the same as if using them from the
Object Manager.

Business Object Properties

Add Approval Support or Edit/Delete Approvals

Convert to Group Object

Edit Lifecycle

Version Info

Delete Group
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Table 2. Actions for Other CSM Items

Action Description

Version Info

Clone

Edit

Delete

8. Group Leaders: Group Business Objects are expanded by default under the group leader to show
the group members.

Related concepts
Scope
Group Business Objects
Object Manager
Relationship Editor
Form Editor
Protected mApp™ Solutions
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Filter Items by Association
Use the Content Manager to filter your items by association and quickly locate the ones you want to work
with.

To filter by association for an item:

1. If you've previously been searching, select  to return to the filter drop-down list.
2. Select, for example, Expressions in the Definition list.

All expressions in the system are shown in alphabetical order.
3. To filter further so you can see, for example, all expressions related to the Problem Business Object,

select Problem in the Association column or select Problem from the drop-down list.
You see all expressions associated with the Problem Business Object in your system.

Note: If you see a numeric item in the Association column, this is an unnamed association
created for a Business Object that no longer exists in the system. If you see these in your
own system, you can use this as a method to identify associations that need cleaning up.

Tip: To find all items in your system with no association, filter on (None). This may be useful
to identifying old or unused Business Objects for deletion.

Related tasks
Filter Business Objects by Type
Filter Items by View
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Filter Business Objects by Type
Use the Content Manager to filter your Business Objects by type and quickly locate the ones you want to
work with.

To filter by type for a Business Object:

1. If you've previously been searching, select  to return to the filter drop-down list.
2. Select Business Objects in the Definition list.

All Business Objects in the system are shown in alphabetical order.
3. Select a Business Object type (example: Supporting) from the drop-down list above the Name

column.
All Supporting Business Objects in the system are shown.

The number of results is also shown next to the drop-down list.
4. To filter further so you can see, for example, all Supporting Business Objects in the Portal Default

view, select Portal Default in the Association column.

Related tasks
Filter Items by View
Clear Filters
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Filter Items by View
Filter your items by view using the Content Manager to quickly locate the ones you want to work with.

To filter by view:

1. If you've previously been searching, select  to return to the filter drop-down list.
2. Select one of the top categories in the left pane (example: Business Objects, Form

Arrangements, Forms, Grids, Relationships).
The View drop-down list is now visible.

3. Select a view from the View drop-down list.
The results are filtered to show, for example, all Business Objects in the Default view.

Tip: The Default view relates to the CSM Desktop Client and the Portal Default view is for
the CSM Portal.

Related concepts
Business Object Views
Related tasks
Clear Filters
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Clear Filters
Clear the filter in the Content Manager to go back to the default settings.

To clear all filters:

In the Content Manager, select clear (above the Name column).

• If you were filtering by Business Object type, the filter for All, Supporting or Lookup Tables
Business Objects is cleared and you are returned to the default list of Major Business Objects.

• If you were filtering by association for an item, the filter is reset to All in the drop-down list.

.
Related tasks
Filter Items by Association
Filter Business Objects by Type
Filter Items by View
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Create Business Object in Content Manager
Use the Content Manager to create a new Business Object.

The Business Object is created in the view that is currently selected within Content Manager. If All Views
is selected, the object is created in Default View. Similarly, if you have a specific object type selected
(example: Lookup Table), your new object will be of the same type.

To create a new Business Object:

1. Hover over Business Objects in the Definition list.

2. Select the plus (+) sign.
The Business Objects Properties window opens.

3. See Define Basic Business Object Properties to continue.

Related concepts
About Business Objects
Define Basic Business Object Properties
Related tasks
Search for a Content Item
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Search for a Content Item
Use the Content Manager to search for an item of content using the name of the item.

Good to Know

• When searching for a Business Object, the search covers all types of Business Objects (Major,
Supporting, Lookup Tables).

• All results are returned with no filters applied (example: No Major Objects or Default View).

• Searching for the names of content items is case insensitive.

To search for a content item:

1. If you've previously been using the filters, select  to return to the search field.
2. Select the definition type you want to search for from the Definition List (example: Dashboard).

Your search results are then restricted to items of the same definition type as shown by the hint in
the search field.

3. Start typing the name of the item you are searching for (example: Knowledge Article).

Results start to reduce in number as soon as you type as little as one character. This character can
appear anywhere in the name of the item (example: Searching for a returns both Account or
Customer - Internal).
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4. Select your chosen content item from the results.

Related concepts
Searches Security Rights
Searching

CSM 2022.3 Features 604

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_searches_security_rights
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fcontent_manager%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fsearching%2Fabout_searching.html


Clone a Content Item
Use the Content Manager to clone a content item and save time.

Cloning creates a duplicate of an item with the same scope and association.

Good to Know

• You need Add and Edit rights for a manager item in order to be able to see the Clone action on the
menu.

• If you don't have Other Add and Other Edit rights for a manager item in Other Scope, you can't
see the Clone action on the menu. See Managing Security Groups.

To clone a content item:

1. Use search in the Content Manager to locate the content item you want to clone.
2. Select the item, right-click, and then select Clone from the Action menu.
3. Enter a name for your cloned item, and then select OK.

Your cloned item appears in the list along with a green dot showing that it is new since the active
Blueprint was last saved.

Tip: The Date Modified for your cloned item is shown as a pending date of 01/01/0001 until
the Blueprint has been published. It then updates to the actual date that you cloned the item.

Related concepts
Managing Security Groups
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List of Definitions
Manage all your definitions using the Content Manager.

The supported objects that you can manage in the Content Manager.

• Business Objects

• Form arrangements

• Forms

• Grids

• Relationships

• Adaptive Layout Presets

• Attachments

• Automation Processes

• Business Hours

• Calendars

• Canonical Definitions

• Counters

• Color Palettes

• Dashboards

• Metrics

• Widgets

• Database Server Objects

• Document Repositories

• Email Event Monitors

• Expressions

• External Connections

• Formats

• Group maps

• HTML pages

• Images

• Import data

• Knowledge maps

• Knowledge Sources

• Language Packs

• Locked Strings
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• Machine Learning Models

• One-Step™ Action Blocks

• One-Steps

• Prompts

• Queues

• Reports

• Scheduled Items

• Searches

• Sites

• Stored Values

• Teams

• Themes

• Twitter Accounts

• Visualizations

• Web Services

• Webhooks

Related concepts
About the Content Manager
Related tasks
Configure the Content Manager
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Configure the Content Manager
Content Manager configuration tasks consist of checking or setting rights to view, edit, or delete content
items.

When setting security rights for CSM items for security groups, access to functionality can be limited by
scope. Scope is the intended audience for a CSM item. Scopes are used by most CSM items (Calendars,
Dashboards, Attachments, One-Step™ Actions) to apply a range of use; access to content items in the
Content Manager is controlled in exactly the same way as for access to Manager items, that is by using
scope.
For example, if the Admin Group doesn't have View rights for Calendars with Blueprint Scope, then no
Calendar items with Blueprint Scope are shown in the Content Manager Definition Results for Admin
Group users when viewing Calendar Definition Types.
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To configure the Content Manager:

1. Look at the list of definitions and decide if users need to be prohibited from viewing, editing, or
deleting any of them. See List of Definitions.

2. When you have your short list of definitions for which rights need to be checked, from the CSM
Administrator main window, select Security > Edit Security Groups.

3. In the Rights tab, set View, Add, Edit, and Delete rights for Role as desired for each content item
on your shortlist.

Related concepts
About CSM Item Managers
Managing Security Groups
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Counters
A Counter is a Token that automatically increases a defined initial value (number) by a defined increment.
Counters can be used while designing Forms, Dashboards, Automation Processes, Expressions, and One-
Step™ Actions.
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About Counters
Use a Counter to increment:

• Record IDs (example: Incident, Problem, Change, etc.)

• Purchase Orders

• Asset Tags

• Announcement counts

In CSM, Counters can be used by Expressions to increment values in:

• Fields (ex: Record ID values).

• One-Step Actions (ex: On a Purchase Order to generate a new tracking number).

CSM provides several OOTB Counters. Use these OOTB Counters as-is, edit them, or create new
Counters using the Counter Manager.
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Counters Good to Know
• A Counter is typically identified by the Counter icon .

• Pin items to a Pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM.

Always consider the following:

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Counter Security Rights.
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Using Counters
When working with Counters, Users can:
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View a Counter
A Counter can be viewed several ways:

• Available Counters (based on security rights): Use the Counter Manager.

• From an Expression or Query that uses the Counter Metric.

• From the Token Selector.
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Add a Counter to a Stored Expression
To add a Counter to a Stored Expression:

1. Open a Stored Expression:
◦ Using the Expression Manager.

◦ By clicking the Ellipses button, when available.

2. In the Editor drop-down menu, select Counter.
3. In the Counter area, click the Ellipses button to open the Counter Manager, and then select an

existing Counter or create a new Counter.

4. Select OK.4.
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Add a Counter to a Custom Expression
To add a Counter to a Custom Expression:

1. Open the Custom Expression Builder:

a. Click the Custom Expression button , when available (ex: When setting a value in a One-
Step Action or Field).

The Custom Expression window opens.

2. In the Expression area, click the down arrow, then expand Counters, and then select a Counter to
add to the Expression.

3. Select OK.3.
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Managing Counters
Counters are managed using the Counter Manager.

There are several ways to open the Counter Manager.

Use the Counter Manager to complete general CSM Item Manager operations for Counters, including:

• View a Counter.

• Create, Reset, or Change a Counter.

• Edit a Counter.

• Delete a Counter.

• Search for a Counter.

• Organize Counters.

• Copy a Counter.

• Import/export a Counter.

• Find Counter dependencies.
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• Pin a Counter.
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Open the Counter Manager
Open the Counter Manager from CSM Administrator, the CSM Desktop Client, or the CSM Browser
Client.

The Counter Manager can be opened in several ways:

• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > Counters. For
more information, see Blueprint Editor menu bar or mApp Editor menu bar.

• In the Token Selector in Queries and Expressions. For more information, see Query Builders and
About Expressions.
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Create, Reset, or Change a Counter
Use the Counter window (accessed from within the Counter Manager) to create, reset, or change a
Counter. When creating a Counter, define the following:

• Name and description.

• Initial value.

• Increment.

• Reset options (value, frequency, and timeframe) (optional): Schedule a reset (example: Reset every
month).

• Change value (optional): Defines a manual, one-time Counter value change (example: Change
record IDs to start at 100,000 when migrating from a test to a production system). This reset occurs
as soon as the Blueprint is published and is a one-time only reset.

Note: If a Counter Manager was installed as part of a Protected mApp™ Solution, you can edit all
fields except for Name and Description and then save the item. If a new version of the same
content-protected mApp Solution is installed at a later date, your changes are retained.

To create, reset, or change a Counter:

1. Open the Counter Manager.1.

2. Select a scope and subfolder (if needed).2.

3. Select Create New .

The Counter window opens.

4. Define general properties:
a. Name:

Provide a display name to use within CSM (search for this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search for this property in CSM Item Managers).

5. Define the initial value and increment:
a. Initial Value: Specify the number to use as the starting value (example: 1).

b. Increment: Specify the number by which to increase the Counter each time it increments
(example: 1).

6. (Optional) Define Counter reset options (Reset Counter section):
a. Select the Reset Value check box.

b. Reset value: Specify the new value.
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c. Frequency: Select a reset frequency from the following:
◦ Daily: Resets each day.

◦ End of Month: Resets on the last day of each month.

◦ Hourly: Resets at the beginning of each hour.

◦ Weekly: Resets every week on a specified day of the week (Monday-Sunday).

◦ Monthly: Resets every month on a specified day (1-31). Select the day in the Day of
Month drop-down list.

◦ Yearly: Resets every year on a specified date. Select Calendar  to select the date.

Note: The Counter is checked for reset only when it is requested. The reset occurs 1 second into
the new day/week/month/year/etc.

7. (Optional) Define a manual, one-time Counter value change:

Note: This reset occurs as soon as the Blueprint is published, and is a one-time only reset.

a. Select the Change Counter Value check box.

b. Specify the value to which you want to manually reset the Counter (example: 100,000).

8. Select Save or Save As.8.
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Reset a Record ID Counter
Reset the Record ID number for each Business Object to ensure that new records begin with the
appropriate value.

The following procedure must be completed for the following Business Object Record IDs:

• Incident ID

• Problem ID

• Change ID

• Knowledge Article ID

To reset the Record ID for Business Objects:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

2. From the Blueprint Editor menu bar, click Managers>Counters.

The Counter Manager opens.

3. In the Manager tree, click the Blueprint folder.

A list of Blueprint-only items opens in the Manager main pane.

4. Right-click the <Business Object> ID (ex: IncidentID) and select Edit.

The Counter opens.

5. Select the Change Counter Value check box.
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6. In the Change Value To field, specify 100000.

Note: We recommend changing this value to 100000 for each Business Object ID, but Users
can select any value to fit the needs of their company.

7. Select OK.7.

8. Publish the Blueprint to commit the changes (File>Publish Blueprint).
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Configuring Counters
Configuration procedures are completed in CSM Administrator.

To configure Counters:

1. Configure Counter security rights: Configure who can access Counter functionality.

2. Reset or change a default Counter: CSM ships with several default Counters, including Record
Identifier Counters on each default Form. Ensure that Record ID Counters are appropriate on
specific Forms.
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Dashboards
A dashboard is a configurable, interactive, and insightful console capable of initiating commands and
Actions. Dashboards provide real-time, at-a-glance information through the use of filterable, configurable
widgets (Action Catalogs, websites, buttons and links, command palettes, gauges, matrixes, search
controls, search results, Twitter feeds, RSS feeds, and shapes).
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Dashboards
Use a dashboard to monitor critical metrics, analyze and predict trends, drill-down into data, initiate
commands and actions, or display information that might be relevant to a group of users or customers.

Example dashboards include:

• Global IT Dashboard: Presents critical Business Object data and analytics (example: Open
Incidents and Tasks, team workloads, and closure rates).

• Business Object Dashboards: Intuitively organize critical Business Object data and analytics into
real-time, at-a-glance control panels.

• Personal Dashboard: Presents personal data and analytics (examples: Incidents and Tasks owned
by you or your team).

• Portal Dashboards: Designed specifically for the CSM Portal to provide customer-specific at-a-
glance information and navigation functionality, such as links to helpful self-service Actions
(example: Report an Incident and Search Knowledge Articles and FAQs), a community
announcement board, a list of open records (example: (Incidents and Problems). For more
information, refer to Portal Dashboards.

The following figure shows an example dashboard with several different types of widgets. A theme
controls the fonts, colors, and styles of the dashboard and its widgets, and gives the dashboard a
cohesive look. Configurable filtering, drill-down, and refresh capabilities allow you to view information
when and how you want.

Each user has a designated default:

• Home Dashboard: Opens when you first log in or when the Home button  is clicked on the CSM
Desktop Client toolbar or Browser Client menu bar.
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• Heads-Up Display (HUD): Pops up a transparent dashboard that can be accessed from anywhere in
the application when you press F4.

• Dashboard Theme: Colors, styles, and fonts to give the dashboard a cohesive look and feel.

The default dashboards (Home and HUD) and dashboard theme are initially selected in CSM
Administrator, either globally or by role. Users with security rights can select their own user default
dashboards and dashboard theme in the CSM Desktop Client. Access available dashboards using the
Dashboard Manager.

CSM provides several OOTB dashboards, designed to help facilitate common service desk operations.
Use these OOTB dashboards as-is, edit them, or create your own using the Dashboard Manager and the
Dashboard Editor.

Note: CSM also provides a variety of configurable Widgets to empower your dashboards. For
more informatio, see the Widgets documentation.

CSM also provides a stand-alone Dashboard Viewer that allows non-CSM users to view dashboards
without consuming a license.
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Tour a Dashboard
Dashboards are highly configurable so no two Dashboards necessarily look or behave alike.

The following figure shows an example Dashboard. The individual components are different kinds of
Widgets.

1. Text Widget (Expression-driven): Displays the current day and date.

2. Link Widget: Opens another Dashboard (ex: Global IT Dashboard).

3. Gauge Widget with Text: Displays the current number of open records (ex: Open Incidents) by
type.

4. Gauge Widget with Text (Expression-driven, text, and visibility): Displays alert when a threshold is
passed (ex: SLA warnings and breaches).

5. Image Widget: Displays a custom image (ex: company logo).

6. Chart Widget (Stacked Bar): Displays workloads by department.

7. Filter Widget: Filters all Widgets by time (ex: Today, Yesterday, Within last week, etc.).

8. Chart Widget (Doughnut): Displays Incident workloads by department.

9. Matrix Widget: Displays daily record closure rates.

The following types of Widgets are also available for use on Dashboards:

• Action Catalog Widget: Embeds a service catalog within a Dashboard.

• Browser Widget: Serves as an embedded iFrame to display other HTML Pages or websites. (ex:
Your company's website).
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• Command Palette Widget: Displays a list of one or more executable Actions (run a command or
display a CSM Item).

• RSS Feed Widget: Displays frequently updated information, such as news or blog entries, from a
particular feed.

• Search Widget: Displays a Search Control that can be used to run Quick Searches or specific
searches.

• Search Results List Widget: Displays a list of records that meets search criteria.

• Twitter Feed Widget: Displays entries from a Twitter account or search.

Tip: In the Desktop Client, use the Dashboard context (right-click) menu to quickly access
common Dashboard operations.
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Dashboards Good to Know
Use these tips for helpful information on Dashboards.

• A Dashboard can be viewed several ways (example: Toolbar, Dashboard Manager) and from all
CSM clients.

• Filter the data on a Dashboard to show only a subset of data by selecting options in the
Dashboard's filter (example: Show only today's data). Filtering is configurable, so behaviors vary.

• Each Dashboard is assigned a Theme.

• Manually refresh a Dashboard by pressing F5 on your keyboard. Refresh is configurable, so
behaviors vary. For more information, see Dashboard Refresh.

• Dashboards might behave differently in the CSM Browser Client.

• The Dashboard Viewer (standalone application) allows you to view a Dashboard without consuming
a license, so you can give one to every manager in your company. For more information, see About
the Dashboard Viewer.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Configure Dashboard Security Rights.

Related concepts
Dashboard Themes
Dashboard Filtering
About Themes
CSM Browser Client
Security Rights
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Dashboard Filtering
Chart, Gauge, and Matrix Widgets can be filtered at the Dashboard level or individually:

• Dashboard filtering: A Filter Widget can be added to a Dashboard to filter all Widgets on the
Dashboard by the same criteria (ex: Have all Widgets on the Dashboard display only Today's data).

When a Filter Widget is used on a Dashboard, the Filter Widget's properties define how the filter
looks and behaves. The Dashboard's Filter properties define filtering persistence.

• Widget filtering: A Widget can also have its own defined date range filter (ex: Widget shows only
data within the last year).

Filtering Persistence
A Dashboard's Filter properties define whether or not filtering is persistent (that is, whether or not the
Dashboard remembers the last filter you used and automatically displays it the next time you view the
Dashboard, even between sessions). If persistence is not defined, the Widget's default filtering criteria is
used each time the Dashboard is accessed.
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Drill-Down Filtering
Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering (Filter
Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to show only
Today's data and then drill down into another Dashboard, then the drill-down Dashboard will also be
filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard displays any filtering
criteria. Users can remove the filter by clearing the filters.
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Heads-Up Display (HUD)
The Heads-Up Display (HUD) is a transparent, pop-up Dashboard. Because the HUD is transparent, you
can see your work page behind the display. The contents of the HUD are created the same way as any
other Dashboard.

The HUD can be accessed in the following ways:

• From the CSM Desktop Client, press F4 on your keyboard. Pressing F4 a second time closes the
HUD.

• From the CSM Browser Client, click Dashboards > Dashboard Manager.

Each User has a default HUD. This default (either Global or Role) is initially selected in CSM
Administrator; however, if Users have security rights, they can select their own default HUD in the CSM
Desktop Client. Other Dashboards are accessed using the Dashboard Manager.

Tip: Select your default Home Dashboard as your default HUD so that you can keep it active
while you work.
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Dashboard Drill-Down
Drill down on a Chart, Gauge, and Matrix Widget to see more detailed data by double-clicking a Widget.
Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command (ex: Display an Action Catalog, Calendar,
Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-Step
Action, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (ex: A Dashboard dedicated to the
Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (ex: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Examples include:

• Configure each series line on an MTTR by Priority Chart Widget to drill down into a list of records by
priority (ex: All P1s, all P5s).

• Configure a Planned/Unplanned Changes Chart Widget to run/display a report (command) that
shows all Planned Changes in an organized format.

• Configure an Incident Gauge to drill down into a more detailed Incident Dashboard.
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• Configure a Customer Satisfaction Gauge Widget to drill down into a more detailed Survey
Dashboard.

Dashboard drill-down is configured as part of a Widget's Drill-Down properties.
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Note: Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors
filtering (Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a
Dashboard to show only Today's data and then drill down into another Dashboard, then the drill-
down Dashboard will also be filtered to show only Today's data. A Filter bar at the top of a drill-
down Dashboard displays any filtering criteria. Users can remove the filter by clearing the filters.
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Dashboard Refresh
You can refresh Dashboards and Widgets automatically or manually, refreshing Widgets individually or all
at once. CSM refresh capabilities include:

• Scheduled Dashboard refresh.

• Scheduled Widget refresh.

• Manual refresh.

Scheduled Dashboard Refresh
A scheduled Dashboard refresh is an automatic refresh that occurs at a defined rate (ex: Every 5
minutes). The refresh rate is defined as part of the Dashboard Refresh properties, and can refresh:

• All Metrics: Reloads the current Metric value every time the Dashboard is refreshed. If not selected,
each Metric is refreshed according to its own refresh rate. For more information, refer to the Metrics
documentation, specifically Metric Caching.

• All Widgets Every X minutes: Refreshes all Widgets on a scheduled basis. If not selected, each
Widget is refreshed only according to its own refresh rate.

• Individual Widgets on their Own Schedules (only available if the Refresh All Widgets Every X
Minutes check box is selected): Refreshes each Widget according to its defined refresh rate, in
addition to the Dashboard's refresh rate.
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Scheduled Widget Refresh
Most Widgets on a Dashboard can have their own scheduled refresh that is defined as part of the
Widget's properties (ex: Every 5 minutes).
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A Dashboard's Refresh properties determine whether or not to:

• Refresh the Widgets on a different schedule: Use the Dashboard's scheduled refresh instead.

• Allow the Widgets to refresh themselves: In addition to the Dashboard's scheduled refresh.

Manual Refresh
Users can manually refresh a Dashboard at any time (right-click>Refresh or F5). A manual refresh obeys
the Dashboard's defined refresh properties.

Note: Metrics are updated only when their values are no longer considered fresh. This means that
a Dashboard/Widget refresh does not necessarily update a Metric value. For more information,
refer to the Metrics documentation, specifically Metric Caching.
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Using Dashboards
When working with Dashboards, Users can filter the data shown on the Dashboard, drill down into data,
initiate a One-Step, refresh the Dashboard, select a User Dashboard Theme, and set the currently viewed
Dashboard as the default.

CSM 2022.3 Features 640

CSM 2022.3 Features



View a Dashboard
A Dashboard can be viewed several ways:

• Default Dashboard:

◦ On the Desktop Client toolbar, click the Home button .

◦ On the Browser Client menu bar, click the Home button .

• Default Heads-Up Display (HUD):
◦ Press F4 on your keyboard.

◦ From the Desktop Client menu bar, click Dashboards>Heads-Up Display.

• Available Dashboards (based on security rights): Use the Dashboard Manager.

• MRU Dashboards:
◦ From the Desktop Client menu bar, click Dashboards, and then select a Dashboard from the

MRU list (listed below the line in the menu).

◦ From the Browser Client menu bar, click Dashboards, and then select a Dashboard from the
MRU list (listed below the line in the menu).

• Available Dashboards without logging in to CSM (and without consuming a license): Use the
Dashboard Viewer (select Start > All Programs > Cherwell Service Management > Tools >
Dashboard Viewer).
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Filter a Dashboard
Filter the data on a Dashboard to show only a subset of data (ex: Show only today's data).

Good to know:

• Dashboard filtering is configurable, so behaviors can vary. For more information, see Dashboard
Filtering.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

.

To filter a Dashboard:

1. View a Dashboard.

2. On the Dashboard, click the drop-down arrow on the Filter, and then select a filtering option (ex:
Today).
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Drill Down into Dashboard Data
Drill down on a Chart, Gauge, and Matrix Widget to see more detailed data. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command (ex: Display an Action Catalog, Calendar,
Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-Step
Action, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (ex: A Dashboard dedicated to the
Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (ex: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To drill down into Dashboard data:

1. View a Dashboard

2. On the Dashboard, double-click a Widget to drill down into the data.

3. Click the Back button  on the toolbar to navigate back to the Dashboard.
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Initiate a One-Step Action/Action from a Dashboard
Initiate a One-Step Action/Action by clicking a Widget on a Dashboard. Typically, One-Step Actions/
Actions are configured to work with buttons and links; however, they can be also be initiated as drill-down
behaviors.

To initiate a One-Step Action/Action from a Dashboard:

1. View a Dashboard

2. On the Dashboard, click the Widget. Drill-down Actions require a double-click.
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Manually Refresh a Dashboard
Dashboards and Widgets might be defined to refresh on their own schedules; however, you can manually
refresh a Dashboard at any time.

Good to know:

• Dashboard refresh is configurable, so behaviors can vary. For more information, see Dashboard
Refresh.

• Metrics are updated only when their values are no longer considered fresh. For more information,
refer to the Metrics documentation, specifically Metric Caching.

To manually refresh a Dashboard:

1. View a Dashboard

2. On the Dashboard, right-click>Refresh or press F5.

Note: In the CSM Browser Client, click the Refresh button .
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Select a User Dashboard Theme
A dashboard theme is a set of set of colors, styles, and fonts that can be applied to a dashboard to give
the dashboard and its widgets a cohesive look.

Good to know:

• The ability to select a user dashboard theme in the CSM Desktop Client and CSM Browser Client is
based on two things: Security rights and permission from the dashboard (that is, the Allow User's
Chosen Theme to Override the Dashboard Theme check box is selected on the dashboard's
display page).

• Dashboard theme behaviors can vary. See Dashboard Themes.

• If no suitable theme is available for selection, you can create a new theme in the CSM
Administrator. See Create a Theme.

Select a User Dashboard Theme in a CSM Client

1. Open a dashboard in either the CSM Desktop or Browser Client.

2. Open the User Theme Preferences dialog:
◦ In the CSM Desktop Client: Right-click on the dashboard and select User Theme in the

context menu.

◦ In the CSM Browser Client: Select the Theme button  on the toolbar.

Note: The theme types available for selection in the User Theme Preferences dialog are
dependent on the current theme type applied to the dashboard (classic or universal theme).
If a classic theme is currently applied, you can only select a classic theme. If a universal
theme is currently applied, you can only select a universal theme.

3. Select a theme from the User Theme Preferences drop-down list:
◦ Use system default (theme name): Theme defined for the default global dashboard

(available for classic theme selection only).

◦ Use role default (theme name): Theme defined for the default role dashboard (available for
classic theme selection only).

◦ Use dashboard theme: Theme defined for the dashboard in the Dashboard Editor (available
for classic and universal theme selection).

◦ Specifically selected theme: Any other theme available for selection in the drop-down list.

4. Select OK.

Related concepts
Dashboard Security Rights
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Set the Current Dashboard to be the Default
Each user has a default home dashboard, which is displayed when the user first logs in or when the
Home button is selected. You can change the default dashboard to the current dashboard.

Good to know:

• The Home and Heads-Up Display (HUD) default dashboards are initially selected in CSM
Administrator, globally, or by role. For more information, see Select Default Global Dashboard and
Dashboard Themes, and Select Default Role Dashboards and Dashboard Themes.

• You can also select a default dashboard in the CSM Desktop Client Options window (Tools >
Options > Dashboards & Calendars).

• The ability to select default user dashboards is based on security rights. See Dashboard Security
Rights .

To set the current dashboard to be the default:

1. View a dashboard.
2. In the CSM Desktop Client, right-click on the current dashboard and select Set as default or select

Dashboards > Set as default.
3. In the CSM Browser Client, select Dashboards > Set [dashboard name] dashboard as default

from the drop-down menu.

Note: When you select the current dashboard to be default in the CSM Desktop Client, that
setting is mirrored in the CSM Browser Client and vice versa.
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Managing Dashboards
CSM Dashboards are managed using the Dashboard Manager and the Dashboard Editor.

Use the Dashboard Manager to complete general CSM Item Manager operations for Dashboard,
including:

• View a Dashboard.

• Create a Dashboard.

• Edit a Dashboard.

• Delete a Dashboard.

• Search for a Dashboard.

• Organize Dashboards.

• Copy a Dashboard.

• Import/export a Dashboard.

• Find Dashboard dependencies.

• Add a Dashboard to the Desktop Client Task Pane/toolbar.

• Pin a Dashboard.

Use the Dashboard Editor to:

• Select a Dashboard background color.

• Size the Dashboard background.

• Add one or more Widgets to the Dashboard.

• Define how each Widget looks and behaves on the Dashboard: Text, size, color, style and gloss,
image, alignment, anchoring, layering, and visibility.

Good to know:

• Good design is important. Before creating a Dashboard, see Design a Dashboard.

• See Dashboard Editor Behaviors for tips on working with Widgets.
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Open the Dashboard Manager
Open the Dashboard Manager from the CSM Desktop Client, the CSM Browser Client, or CSM
Administrator.

Use these methods to open the Dashboard Manager:

• In the CSM Desktop Client or Browser Client menu bar, select Dashboards > Dashboard
Manager.

• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > Dashboard
Manager.

• In Settings in the CSM Desktop Client (Tools > Options > Dashboards & Calendars ).
• In the Site Manager in CSM Administrator. For more information, see Site Manager.

• In Dashboard selectors throughout CSM.

• In the Dashboard Viewer menu bar, select Dashboards > Dashboard Manager.
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Dashboard Editor
The Dashboard Editor is a tool within the Dashboard Manager that helps you define how a dashboard and
its widgets look and behave.

The Dashboard Editor preview is dynamic; when you make changes, the changes are immediately
reflected in the preview. Select OK to commit the changes. Also accessible from the Dashboard Editor are
the Widget Manager and widget properties.

The Dashboard Editor can be opened in several ways.

1. Toolbar: Displays common commands for formatting the appearance and behaviors of a dashboard
and its widgets.

2. Widget list: Lists the existing Widgets that you can add to the dashboard. Use the Search Control
and Hide Folder options to locate widgets. Tips: You can create a new Widget or open the Widget
Manager by right-clicking a widget in the list.

3. Dashboard preview: Displays a dynamic preview of the dashboard. Changes are committed to the
published dashboard when you click OK.

4. Main Pane: Displays a workspace for designing a dashboard.
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Dashboard Editor Toolbar
Use the Dashboard Editor toolbar to quickly access common operations for formatting the appearance
and behaviors of a dashboard and its widgets.

The toolbar is made up of four smaller toolbars:

1. Label toolbar: Displays options for defining widget labels and wrapping.

2. Formatting toolbar: Displays options for formatting widget text (font, style, size, and alignment),
widget colors/styles (foreground, background, and border), and widget behaviors (visibility,
anchoring, and image). Also displays options for accessing dashboard properties, selecting a
dashboard background color and accessing editing buttons (Cut/Copy/Paste, Undo/Redo, Grid/
Guide snaps, and Zoom).

3. Adaptive Layout toolbar: Displays options for Adaptive Layouts. Choose the specified layout from
the drop-down list or create, edit, or delete an Adaptive Layout.

4. Layout toolbar: Displays options for aligning and placing widgets.

The Dashboard Editor toolbar displayed for a classic theme.

The Dashboard Editor toolbar displayed for a universal theme.

Good to know:

• Move a toolbar by double-clicking the Grab bar , or by grabbing the Grab bar and then dragging
the toolbar to a new location.

• Re-dock a toolbar to its default location by double-clicking the header banner of an undocked
toolbar.

• Hide a toolbar by right-clicking anywhere in the toolbar area, and then clearing the check box for the
toolbar.

• Many of the toolbar options are also available from the Dashboard Editor context (right-click) menu.

• See Dashboard Editor Behaviors for tips on working with widgets on dashboards.
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Label Toolbar (Label Text, Wrap, Style, and Gloss)

Button Action Description

Label Text Box

Defines the text that appears on
the currently selected widget.

Type the text into the Text toolbar.

Note: This value only
affects the primary
selected widget.

Expression

Conditionally defines the text that
appears on the currently selected
widget. You can use either:

• Expression Manager: Select
this option to open the
Expression Manager, and
then select an existing stored
expression or create a new
stored expression. Stored
expressions can be reused in
numerous places in CSM.

• Custom Expression: Select
this option to open the
Custom Expression Builder,
where you can create a
custom expression to use
only for the active scenario.

Wrap Toggles text wrap On and Off.

Formatting Toolbar (Text, Color/Style, and Behaviors)

Button Action Description

Widget Text
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Button Action Description

Font (classic themes toolbar only)

There are two different font modes for widget text:

• Theme Font: Uses the default system font.

• Explicit Font: Sets an explicit font and other
font details on a widget-by-widget basis.

To switch to Theme mode, select Theme Font from
the top of the list.

To switch to Explicit mode, select a font in the drop-
down list.

Font Size (classic themes toolbar
only)

Explicitly sets the widget font size (example: 10
points).

Note: This option is available when using
explicit font mode and classic themes only.

Font selection and style (universal
themes toolbar only)

Opens the Font settings dialog.

Associates the dashboard control with the theme
font, or an explicit font you select in the Font drop-
down list.

Additional text formatting selections are available
(example: Size, bold, underline and alignment).

Font Style (classic themes toolbar
only)

Adds style to the widget font (bold, underlined, or
italics).

Note: This option is available only when
using Theme Font mode.

Font Size (classic themes toolbar
only)

Relatively sets the widget font size to be small,
medium, or large.

Note: This option is available only when
using Theme Font mode.

Horizontally Align Text (classic
themes toolbar only)

Aligns text left, center, or right on a horizontal axis
within the widget bounding box.

Note: Applicable for link, button, and text
widgets.
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Button Action Description

Vertically Align Text (classic themes
toolbar only)

Aligns text top, middle, or bottom on a vertical axis
within the widget bounding box.

Note: Applicable for link, button, and text
widgets.

Widget Color/Style

Background color

Sets the background color of the widget.

Classic theme: Select the button to use the most
recently used color (assuming you have set a color).
To explicitly apply a color, select the drop-down
arrow, and then select a solid color or a gradient.
You can use an expression to conditionally change
the color.

Universal theme: Select the button to open the
Color Selector dialog, and then select a color
association as defined in your theme color palette.
To use a custom color, select (Custom) in the drop-
down list, and then select a Web color, or create a
Custom color.

Foreground color

Sets the text color for the widget.

Classic theme: Select the button to use the most
recently used color (assuming you have set a color).
To explicitly apply a color, select the drop-down
arrow, and then select a solid color or a gradient.
You can use an expression to conditionally change
the color.

Universal theme: Select the button to open the
Color Selector dialog, and then select a color
association as defined in your theme color palette.
To use a custom color, select (Custom) in the drop-
down list, and then select a Web color, or create a
Custom color.
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Button Action Description

Border color

Sets the color of the border around the widget, if
there is a border.

Classic theme: Select the button to use the most
recently used color (assuming you have set a color).
To explicitly apply a color, select the drop-down
arrow, and then select a solid color or a gradient.
You can use an expression to conditionally change
the color.

Universal theme: Select the button to open the
Color Selector dialog, and then select a color
association as defined in your theme color palette.
To use a custom color, select (Custom) in the drop-
down list, and then select a Web color, or create a
Custom color.

Border style

Sets the style of the border around the widget (No
Border, 3D, or Pixel width), if there is a border.

Select the button to use the most recently set style
(assuming you have set a style). To explicitly apply a
style, select the drop-down arrow, and then select a
style.

Note: While you can select 3D borders for
any dashboard control, rounded shapes do
not allow 3D settings.

Style (available from context menu
only). Background style

Changes the background shape of the widget.

Select options such as square, rounded corner, tab
and rounded tab.

Note: Not all styles are compatible with all
types of widgets.

Glossy (available from context menu
only). Background gloss Makes a widget background glossy (adds a slightly

glowing and reflective background).

Widget Behavior

Show or hide tab index
Shows or hides the display of the tab index values
for all selected widgets.
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Button Action Description

Tab stop on or off

Turns the tab stop on or off for all selected widgets.

Select the button to enable tab stops, or clear it
when you want to disable tab stops.

Note: The tab stop property for all selected
widgets changes based on the state of the
primary selected widget. The primary
selected widget is the last one selected
when selecting multiple widgets.

Clear tab stops Clears all tab index values from the dashboard.

Tab index order

Sets the number for the tab order sequence for all
selected widgets.

Note: The tab index order for all selected
widgets changes based on the order of the
primary selected widget. The primary
selected widget is the last one selected
when selecting multiple widgets.

Visibility

Conditionally controls when the widget appears and
disappears. The visibility is based on an expression.

Select the button to define a custom expression.
Select the drop-down arrow to access options for
creating a custom expression, selecting a stored
expression, or clearing the expression.

Anchoring

Sets the anchoring behavior of the widget.

Select the button to use the most recently set
anchoring options (assuming you have set an
option). To explicitly select anchoring options, select
the drop-down arrow to open the Anchoring
window, and then select your preferred anchoring
options (Left, Right, Top and Bottom). You can select
multiple options (example: Top and Left).

Image

Defines the image to display on the widget, as well
as alignment.

Select the button to open the Image Manager, and
then select an image to show on the dashboard
control. Select the drop-down arrow to access
options for creating a custom expression, selecting a
stored expression, clearing the expression, aligning
the image, or removing the image (None).

Dashboard Properties
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Button Action Description

Dashboard Properties

Opens the Dashboard Properties window. Change
the name, description, title text, Business Object
association, scope, image, Display options, Filter
options, and Refresh options.

Dashboard Background Color

Sets the dashboard background color.

Classic theme: Select the button to use the most
recently used color (assuming you have set a color).
To explicitly apply a color, select the drop-down
arrow, and then select a solid color or a gradient.
You can use an expression to conditionally change
the color.

Universal theme: Select the button to open the
Color Selector dialog, and then select a color
association as defined in your theme color palette.
To use a custom color, select (Custom) in the drop-
down list, and then select a Web color, or create a
Custom color.

Editing Buttons

Cut

Moves the selected item to the clipboard, and then
paste the item into a new location.

Note: Ctrl+X also works. Multiple widgets
can be cut at one time. Select multiple
widgets by rubber-banding or by holding
down the Shift key while selecting.

Copy

Creates a new item whose properties are the same
as the copied item. The new item can then be
named and customized.

Note: Ctrl+C also works. Multiple widgets
can be copied at one time. Select multiple
widgets by clicking and dragging (rubber-
banding) or by holding down the Shift key
while selecting.

Paste

Inserts an item from the clipboard to a new location.

Note: Ctrl+V also works. Multiple widgets
can be copied at one time. Select multiple
widgets by clicking and dragging (rubber-
banding) or by holding down the Shift key
while selecting.
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Button Action Description

Undo Undoes the last operation. Unlimited per session.

Redo Repeats the last operation. Unlimited per session.

Snap to Grid Precisely aligns a widget on a grid. Select the drop-
down arrow to define the grid snap width.

Snap to Guide

Precisely aligns a widget to other items.

Note: Select Shift+Drag to ignore snapping.

Adaptive Layout Toolbar

Button Action Description

Adaptive Layout Selector Selects the specific Adaptive
Layout being edited.

Edit, Add, or Delete

• Edit the current Adaptive
Layout.

• Add a new Adaptive Layout.

• Delete the current Adaptive
Layout.

Layout Toolbar (Alignment, Size, and Order)
For most of the alignment operations, you must select at least two widgets. The last selected widget is the
controlling widget, and the widget against which all other selected widgets are sized and aligned. The
controlling widget is identified by black boxes around its border when selected. All other selected widgets
are identified by white boxes around their borders when selected.

Button Action Description

Line up horizontally
Lines up all the selected widgets
against the left, center, or right edge
of the controlling widget.

Line up vertically
Lines up all the selected widgets
against the top, middle, or bottom
edge of the controlling widget.

Size width

Size height

Sizes all the selected widgets to be
the same width or height as the
controlling widget.
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Button Action Description

Make same size
Sizes all the selected widgets to be
the same size (width and height) as
the controlling widget.

Auto-size

Sizes a text widget to be exactly the
right size to hold all its contained text.
Sizes an Image widget to be its
original size.

Bring to Front

Moves a widget in front of other
widgets. You can use this if you are
creating various layering effects.

Note: Not all widgets are
allowed to be in front or
behind all other widgets
(example: Most shapes
cannot be on top of most
graphical widgets, such as
charts and gauges).

Send to Back

Moves a widget behind other widgets.
Use this if creating various layering
effects.

Note: Not all widgets are
allowed to be in front of or
behind all other widgets
(example: Most shapes
cannot be on top of most
graphical widgets, such as
charts and gauges).

Related concepts
Color Selector
Expressions
Dashboard Editor Behaviors
Define and Format Widget Text
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Dashboard Editor Behaviors
The Dashboard Editor has built-in behaviors and functions that are useful when creating or editing a
dashboard.

Dashboard Editor Context Menu
Use the Dashboard Editor context (right-click) menu to quickly access common Dashboard Editor
operations.

Search for Widgets

• Widget Search control : Use to search for a widget by name
(example: Incident or My), description, or type (example: Gauge).

• View option : Use to view/hide folders in the widget tree or show widgets from other
folders (Roles/Users/Teams/Customer Workgroups). If hiding folders in the Widgets tree, all widgets
can be displayed at the root node, regardless of how they are organized/stored in the tree.

Select a Widget
Select a widget or click-and-drag (rubber-band) over the widget. This deselects all other widgets.

A selected widget is identified by black boxes around the bounding box. The bounding box represents the
widget's vertical and horizontal dimensions.

.

Select Multiple Widgets

• To select multiple widgets, you can either:
◦ Hold down the Ctrl key while you select each widget in turn.

◦ Click-and-drag (rubber-band) over the widgets you want to select. Any widget that is included
(even partially) in the rubber-band box is selected.

◦ Press Ctrl+A to select all widgets.

• When multiple widgets are selected:
◦ The controlling widget is the last selected widget, and the widget against which all other

selected widgets are sized and aligned.

◦ The controlling widget is identified by black boxes. All other selected widgets are identified by
white boxes.
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◦ To change the controlling widget, hold down the Shift key and select a different selected
widget.

Edit Widgets

• To delete a widget, select it, and then select the Delete key.

• To edit the detailed properties of a selected widget, right-click and select Widget Properties.

• To undo/redo the previous operation, select the Undo  or Redo  button. Unlimited per
session.

• To cut, copy, or paste in a dashboard or between dashboards, select the Cut , Copy , or

Paste  button. Ctrl+X, Ctrl+C, and Ctrl+V also work. Multiple widgets can be copied and
pasted at one time. Select multiple widgets by rubber-banding or by holding down the Shift key
while selecting.

• To duplicate a widget, select Ctrl+Drag.

• To move a widget, drag the widget.

• To move a widget 1 pixel (nudge), select an Arrow key.

• To move a widget exactly 10 pixels, select the Shift+Arrow key.

• To precisely align a widget on a grid, toggle Snap to Grid  to ON. You can also set the grid
snap width (drop-down). Select Shift+Drag to ignore snapping.

• To precisely align a widget to other items, toggle Snap to Guide  to ON. Select Shift+Drag to
ignore snapping.

• To pan across a dashboard, select Spacebar+Mouse.

• To maintain aspect ratio when resizing, hold down the Shift while sizing.

• To wrap text in a text widget bounding box, select the Text Wrap button .

Dashboard Theme Behaviors
When adding controls to a dashboard, controls inherit their properties (border color, background color,
font, etc) in line with the following behaviors:

• New dashboard with no theme applied: New controls use existing system default values.

• New or edited dashboards with a universal theme applied: New controls use universal theme
values.

• New or edited dashboards with a classic theme applied: New controls use classic property keys with
values from the classic theme.
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• Exception: When widgets are added to a dashboard, these retain the keys and values from the
widget theme, not that of the host dashboard.
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Dashboard Editor Keyboard Shortcuts

Key Action

CTRL+A Select All

CTRL+C Copy

CTRL+V Paste

CTRL+X Cut

CTRL+Y Redo

CTRL+Z Undo

CTRL+SHIFT+P Opens the Position and Size window, and then specify an exact location
(left and top) and size (width and height)

CTRL+SCROLL Zoom in/out

CTRL+DRAG Duplicate

SHIFT+DRAG Ignore grid and guideline snapping

SHIFT+SIZE Maintain aspect ratio

SPACE+MOUSE Pan window

Mouse Left Button

or

Double-click selected Widget

Edit Widget properties

ARROW keys Move selected items 1 pixel at a time

SHIFT+ARROW keys Move selected items 10 pixels at a time

CTRL+ARROW keys Resize selected items 1 pixel at a time
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Open the Dashboard Editor
The Dashboard Editor can be opened from the Dashboard Manager.

The Dashboard Editor can be opened several ways:

• From within the Dashboard Manager, click the New button. The Dashboard Editor is automatically
opened after you define Dashboard properties.

• From within the Dashboard Manager, click the Dashboard to edit, and then do one of the following:
◦ Right-click>Edit.
◦ Click File>Edit.
◦ Click the Edit button.

• On a Dashboard, right-click>Edit [Dashboard].
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Design a Dashboard
Dashboard design is important. Before creating a Dashboard, you should consider the audience, purpose,
client access, scope, layout, and security.
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Dashboard Design Considerations
Consider the following before creating a Dashboard:

• Audience: Who is it for (User or Customer? Technician or Executive? Etc.)?

• Purpose: How will it be used (For at-a-glance statistics? For trending? For navigation? Etc.)?

• Client access: From where will it be accessed (Desktop Client? Browser Client? Portal? Cherwell
Mobile?)?

• Scope: Global, Role, Team, User?

• Layout: Which Widgets will be on it (Charts? Gauges? Twitter Feeds?) and what will it look like
(colors, font, alignments, etc.)?

• Security: Who can access each Widget?
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Dashboard Design Tips
Following are some tips to help you design an effective Dashboard:

• Make it useful: Consider the audience and what they need most. Executives might want at-a-
glance statistics and trending, a manager might want quick access to reports, and a Technician
might want a list of relevant records.

• Make it pretty: Do not underestimate the visual experience. Employ visual elements, such as
images, colors, styles, alignment, and layering to convey information and embellish the aesthetic.
Use consistent, browser-friendly fonts and colors (or Themes) to ensure stability and cohesion.

• Make it conditional: Use Expression-driven colors, text, images, and visibility to dynamically
change the way a Widget looks and behaves based on a defined condition. For example, display an
SLA Widget on a Dashboard. When an SLA is in jeopardy of being breached, change the label to
indicate a surpassed threshold (expression-driven text), change the background color to red
(expression-driven color), display a warning icon (expression-driven image), and then display a
warning message (expression-driven visibility).
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Create/Edit a Dashboard
Create or edit a dashboard to define its properties and save it in the Dashboard Manager.

Create a Dashboard

1. Open the Dashboard Manager, and select a scope and subfolder (if needed). For more information,
see scope.

2. Select the Create New button .
The Dashboard Properties dialog opens.

3. Select Display to define the display options.

4. Select Filter to define the filter options.

5. Select Refresh to define the refresh options.

6. (Optional) Select the Options button to define additional options.

7. Select OK.7.

The Dashboard Editor opens, where you can then:

◦ Size the dashboard background.

◦ Select a dashboard background color.

◦ Add one or more widgets to the dashboard.

◦ Define how each widget looks and behaves on the dashboard: Text, size, color, image,
alignment, anchoring, layering, and visibility.

For more information, see Dashboard Editor.

Edit a Dashboard

1. Open a dashboard in the Dashboard Editor.

2. Make changes.

Tip: To access dashboard properties, select the Dashboard Properties button  on the
Dashboard Editor toolbar.

3. Select OK.3.

Related concepts
Size a Dashboard Background
Select a Dashboard Background Color
Add a Widget to a Dashboard (General)
Define How a Widget Looks and Behaves on a Dashboard
Related reference
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Dashboard Properties
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Select a Dashboard Background Color
Use the Dashboard Editor to select a background color for the dashboard.

Note: This topic describes defining a background color on a form with a universal theme. If you
are editing a form with a classic theme, use this link to open the previous version of Select a
Dashboard Background Color.

Good to know:

• If you are using dashboard themes, use a theme association color for the dashboard background
(example: Dashboard Background). You can select a Web color, or create a Custom color; however,
if you use a non-theme color, the background will not change to another theme color when you
apply a different theme.

• Theme association colors are defined as part of a theme's definition. Use the Theme Manager to
create a theme.

• Colors can be solid or transparent only.

To Select a Dashboard Background Color

1. Open a dashboard in the Dashboard Editor.

2. On the Dashboard Editor toolbar, select the Background Color button .

3. Select a background color from one of the following color categories:
◦ (Recommended) Theme Association drop-down list:

All color associations defined for the selected CSM theme.

◦ Web: Select (Custom) in the Theme Association drop-down list to display the set of name
web-safe colors, and then select a color.

◦ Custom: Select (Custom) in the Theme Association drop-down list to display the Custom
color selector, and then define a customized red, green, blue (RGB) or Hex value color.
For more information, see Using the Color Selector in a Designer

4. Continue making changes, or select OK to save and close the editor.4.

Related concepts
Dashboard Editor
Dashboard Themes
Create a Theme
Expressions
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Size a Dashboard Background
Use the Dashboard Editor to size a dashboard background to a target dimension.

Good to know:

• Build a dashboard to target dimensions (example: a standard laptop screen, large landscape
monitor); otherwise, your dashboard might be too small or too large for the resolution of the screen
on which it is most often displayed.

• Use the grid points to precisely size the background.

• To increase the size of the dashboard without moving any anchored Widgets, hold down the SHIFT
key while resizing the dashboard. The Widgets maintain their current locations.

To size a dashboard background:

1. Open a dashboard in the Dashboard Editor

2. Drag the sizing border around the dashboard to adjust its height and width.

3. Continue making changes, or select OK to save and close the editor.3.
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Add a Widget to a Dashboard (General)
Use the Dashboard Editor to add one or many Widgets to a Dashboard by dragging them onto your
Dashboard.

Good to know:

• For tips on working with Widgets on Dashboards, see Dashboard Editor Behaviors.

• Many Widgets have their own properties (example: Refresh and filter properties). When a Widget is
added to a Dashboard, the Dashboard can either honor the Widget's properties or override them.

• Button and Link Widgets have additional Widgets properties (right-click and select Control
Properties) that must be configured after being added to a Dashboard (example: You have to
define the Action to execute).

• By default, most Widgets acquire their text properties (font family, size, and style), color
(background, foreground, and border), border style, and background style properties from the
defined Dashboard Theme; however, you can define your own properties, if needed.

• To maintain optimal Dashboard performance, we recommend:
◦ Limiting the number of displayed Widgets.

◦ Applying additional constraints on the data imported into the Dashboard.

◦ Adjusting the maximum simultaneous Widget refreshes to add more threads.

Note: For general advice on system performance, see Best Practices for Performance.

To add a Widget to a Dashboard (general):

1. Open a Dashboard in the Dashboard Editor

2. Drag a Widget from the Widget pane onto the Dashboard.

3. (Optional) Configure/edit the Widget properties:
a. Right-click the Widget and select Widget Properties.

4. (Optional) After the Widget(s) are on the Dashboard, use the Dashboard Editor to define how each4.
Widget looks and behaves on the Dashboard.

For example, text properties (font, font size, font style, text wrap), size, color (background,
foreground, and border), background style and gloss, border style, alignment, anchoring, layering,
and visibility. For more information, see Define How a Widget Looks and Behaves on a Dashboard.

5. Continue making changes, or select OK to save and close the editor.5.

Related concepts
Dashboard Editor
Dashboard Editor Behaviors
Dashboard Themes
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Add a Button Widget to a Dashboard
Use the Dashboard Editor to add a button widget to a dashboard.

A button widget is capable of executing a single Action when selected.

Note: This topic describes defining a background color on a form with a universal theme. If you
are editing a form with a classic theme, use this link to open the previous version of Add a Button
Widget to a Dashboard.

Good to know:

• A button widget is highly configurable. Add one or many to a dashboard, then define the Action to
execute when the button is selected, and how the button looks and behaves on the dashboard
(example: text, size, color, background style and gloss, border style, image, alignment, anchoring,
layering, and visibility). See Define How a Widget Looks and Behaves on a Dashboard.

• Text, image, and colors can be conditional (expression-driven).

• See Dashboard Editor Behaviors for tips on working with widgets on dashboards.

To Add a Button Widget to a Dashboard

1. Open a dashboard in the Dashboard Editor.

2. Drag the Button Widget from the Shapes, etc tree onto the dashboard.

3. Define the Action to execute when the button is selected:
a. Right-click the Button Widget, and then select Widget Properties > Widget Properties.

b. Select the ellipsis  to open the Action Manager, and then select the Action to execute.

c. If you selected a One-Step Action™, you can either select or clear the Show Progress check
box to control whether the progress dialog for the One-Step Action appears while it runs.

4. Define the text to display on the button:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display on the button.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

5. Define the background color for the button widget:
a. Right-click the Button Widget, and then select Widget Properties.

b. Select Button color to launch the Color Selector. You can select a theme color, or define a
custom color for the button background.

Note: Color gradients are not available for dashboards using universal themes.

6. Define how the button widget looks and behaves (example: Size, alignment, etc.).

7. Continue making changes, or select OK to save and close the editor.7.
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Related concepts
Dashboard Editor
Color Selector
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Add an Image Widget to a Dashboard
Use the Dashboard Editor to add an Image Widget to a Dashboard.

Good to know:

• An Image Widget is highly configurable. Add one or many to a Dashboard, then define the image,
and how the image looks and behaves on the Dashboard (ex: Text, size, alignment, anchoring,
layering, and visibility).

• Image Widgets do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• Images can be conditional (Expression-driven). For example, display a warning icon when an SLA is
in jeopardy of being breached and a clock icon after an SLA has been breached.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add an Image Widget to a Dashboard:

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Image Widget from the Shapes, Etc. tree onto the Dashboard.

3. Define the image to display:

a. On the Dashboard Editor toolbar, click the drop-down arrow on the Image button , and
then select one of the following options:

◦ Browse: Opens the Image Manager, where you can select an existing image or import a
new image to display on the Widget.

◦ From Stored Value: Opens the Stored Value Manager, where you can select an existing
Stored Value or create a new Stored Value to use.

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a
custom Expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
Expression or create a new stored Expression to use. Stored Expressions can be reused
in numerous places in CSM.

◦ None: Does not use an image.

4. Align the image:
a. Click the drop-down arrow on the Image button, select Image Alignment, and then select an

alignment option within the Widget (ex: Top-right).

5. Define how the Image Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

6. Continue making changes, or select OK to save and close the editor.6.
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Add a Link Widget to a Dashboard
A Link Widget is capable of executing a single Action when selected (example: Run an Action/One-Step
Action). You can also enter a simple URL.

Use the Dashboard Editor to add a Link Widget to a dashboard.

Good to know:

• A Link Widget is highly configurable. Add one or many to a dashboard, then define the Action to run
when the link is selected, and how the link looks and behaves on the dashboard (example: text,
size, color, background style and gloss, border style, image, alignment, anchoring, layering, and
visibility). See Define How a Widget Looks and Behaves on a Dashboard.

• Text, image, and colors can be conditional (Expression-driven).

• See Dashboard Editor Behaviors for tips on working with widgets on dashboards.

To add a Link Widget to a dashboard:

1. Open a dashboard in the Dashboard Editor.

2. Drag the Link Widget from the Shapes, Etc. tree onto the dashboard.

3. Right-click the Link Widget, and then select Widget Properties. Either define the Action to execute
when the link is selected, or enter a URL:

a. Select Action, and then select the ellipsis button  to open the Action Manager, then select
the Action to execute.

i. If you select a One-Step™ Action, you can either select or clear the Show Progress
check box to control whether the progress dialog for the One-Step Action appears while
it runs.

b. Select Web Link, and then type the URL of the web page that should open.

4. Define the text to display on the link:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display in the link.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

5. Define how the Link Widget looks and behaves on the Dashboard (example: Size, alignment, etc.).

6. Continue making changes, or select OK to save and close the editor.6.

Related concepts
Action Manager
Dashboard Editor
Related tasks
Add a Link Label Control to a Form
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Add a Text Widget to a Dashboard
Use the Dashboard Editor to add a Text Widget to a Dashboard.

Good to know:

• A Text Widget is highly configurable. Add one or many to a Dashboard, then define the text, and
how the text looks and behaves on the Dashboard (ex: Size, color, background style and gloss,
border style, image, alignment, anchoring, layering, and visibility).

• By default, Text Widget text, color, and border style properties come from the defined Dashboard
Theme.

• Text and colors can be conditional (Expression-driven). For example, use an Expression to display
the current date and time.

• A Text Widget is technically a simple Gauge Widget.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add a Text Widget to a Dashboard

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Text Widget from the Shapes, Etc. tree onto the Dashboard.

3. Define the text to display in the Widget:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

4. Define how the Text Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

5. Continue making changes, or select OK to save and close the editor.5.

CSM 2022.3 Features 677

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fdashboards%2F..%2F..%2Fshared%2Fdashboard_themes.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fdashboards%2F..%2F..%2Fshared%2Fdashboard_themes.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fdashboards%2F..%2Fwidgets%2Fgauge_widgets.html


Add a Shape Widget to a Dashboard
Use the Dashboard Editor to add a Shape Widget (ex: Ellipses, Rectangles, and Tabs) to a Dashboard.

Good to know:

• A Shape Widget is highly configurable. Add one or many to a Dashboard, then define how the
shape looks and behaves on the Dashboard (ex: Text, size, color, style and gloss, image, alignment,
anchoring, layering, and visibility).

• By default, most Shape Widgets acquire their text (font, size, and style), color (background,
foreground, and border), border style, and background style properties from the defined Dashboard
Theme; however, you can define your own properties, if needed.

• Text, image, and colors can be conditional (Expression-driven).

• Rounded shapes do not allow 3D borders.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add a Shape Widget to a Dashboard

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Shape Widget from the Shapes, Etc. tree onto the Dashboard.

3. (Optional) Define the text to display on the shape:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

4. Define how the Shape Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

5. Continue making changes, or select OK to save and close the editor.5.
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Define How a Widget Looks and Behaves on a
Dashboard

Use the Dashboard Editor to define how a Widget looks and behaves on a Dashboard.
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Define and Format Widget Text
Use the Dashboard Editor to define and format widget text.

Note: This topic describes defining and formatting widget text on a dashboard with a universal
theme. If you are editing a dashboard with a classic theme, use this link to open the previous
version of Define and Format Widget Text.

A widget has different kinds of text:

• Label: Text to display in the widget header to identify the widget. By default, the widget label comes
from the widget title.

• Data: Data to display inside the widget (example: Numbers, charts, etc.).

You can manually change any label and apply different fonts, if needed.

Good to know:

• Label text can be conditional (expression-driven). For example, define an expression to change a
label when a threshold is surpassed ("Too Many Open Incidents!").

• Text wrapping in labels can be turned On or Off.

• Text formatting options include:
◦ Font: Theme or explicit font.

◦ Font size: Point size for font.

◦ Font style: Bold, underline, or italics.

◦ Font alignment: Horizontal (left, center, right) and vertical (top, middle, bottom) alignment of
text only on a text, button, or link shape widget.

Note: Text color is defined as a foreground color. See Select a Background,
Foreground, and Border Color for a Widget.

• See Dashboard Editor Behaviors for tips on working with widgets on dashboards.

To Define and Format Widget Text

1. Open a dashboard in the Dashboard Editor.

2. Select a widget.

3. Define a label, either static or conditional text:

◦ Static: In the Label text box , provide the label text to display in the widget.

◦ Expression-driven text (conditional): Select the Expression button , and then define the
expression (condition) to determine the label, using either:
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◦ Custom expression: Select this option to open the Custom Expression Builder, and
then create a custom expression specifically for this scenario.

◦ Expression Manager: Select this option to open the Expression Manager, and then
select an existing stored expression or create a new stored expression. Stored
expressions can be re-used in numerous places in CSM.

4. Define text formatting:

a. Font: Select the Edit Font  drop-down list on the Dashboard Editor toolbar, and then
select a font in the Font dialog drop-down list

.
◦ Theme Font: The associated theme font is applied.

◦ Explicit font: The font selected by you is applied.

b. Font style: Select Bold, Underline, or Italics .

c. Font size: In the Font Size drop-down list , select a point size (example: 12px).

d. Horizontal alignment: Select one of the horizontal alignment buttons (Left, Center, or Right)

 to align the text on a horizontal axis within the widget.

e. Vertical alignment: Select one of the vertical alignment buttons (Top, Middle, or Bottom)

 to align the text on a vertical axis within the widget.

Note: Horizontal and vertical text alignment functions are not available for some widget
types (example: Tab and rectangle widgets).

5. Continue making changes, or select OK to save and close the editor.5.

Related concepts
Dashboard Editor
Expressions
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Size a Widget
Use the Dashboard Editor to define a Widget's size. Widgets can be:

• Manually sized.

• Auto-sized.

• Explicitly sized.

• Sized the same as other Widgets.

Good to know:

• Hold down the SHIFT key while sizing a Widget to maintain the proper aspect ratio.

• Press the CTRL+ARROW keys to resize a Widget one (1) pixel at a time.

• To resize an Image Widget to be its original size, click the Widget, and then click the Auto-size

button .

• Auto-size is useful for Expression-driven labels because it automatically resizes the label's bounding
box to accommodate dynamic text.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To size a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click a Widget.
3. Size the Widget using one of the following options:

◦ To manually size a Widget, click-and-drag one of the handles (white or black box) to the size
you want.

◦ To auto-size a text Widget to be exactly the right size to hold all its contained text, click the

Auto-size button  on the Dashboard Editor toolbar.

◦ To explicitly size a Widget to a specified pixel height and width, right-click>Position (or press
CTRL+SHIFT+P) to open the Control Position and Size window, then specify the pixel sizes
and click OK.

◦ To size several Widgets to the same width, height, or width and height, select at least two
Widgets (the last selected Widget is the Controlling Widget and is identified by black boxes),

and then click the Make Same Width button , Make Same Height button , or Make

Same Size button  on the Dashboard Editor toolbar.

4. Continue making changes, or select OK to save and close the editor.4.
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Select a Background, Foreground, and Border
Color for a Widget

Use the Dashboard Editor to select a background, foreground and border color for the widgets on a
dashboard.

Note: This topic describes defining and formatting widget colors on a form with a universal theme.
If you are editing a dashboard with a classic theme, use this link to open the previous version of
Select a Background, Foreground, and Border Color for a Widget.

By default, defined theme colors are applied to a widget when the widget is added to a dashboard. You
can manually apply different colors, if needed; however, if you apply non-theme colors, widgets will not
change to another theme color when you apply a different theme.

Good to know:

• Dashboard theme colors are defined as part of a theme's definition. Use the Theme Manager to
create a theme.

• Each theme property is named and intended for a specific element on a dashboard, form, portal, or
action catalog. When the element is added, the item's defined colors, styles, and fonts are applied
by default. You can manually apply a different color or style to most widgets, if needed. For example,
it is possible to use Dashboard Background color for text, but note that this may make the text
invisible against the widget background. The key is to use theme colors, and to apply colors and
styles consistently. If a non-theme color is applied, the element does not change to another theme
color when applying a different theme.

• Chart, Gauge, and Matrix widgets can have their own colors and styles and can be defined to
override theme colors.

• Image, Filter, and Search widgets do not support backgrounds; therefore, no background color or
style can be applied.

• Image widgets do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• By default, some widgets have a transparent background (example: Text widget). To manually add a
background, right-click the widget, select Background Color, and then select a background color.

• Background, foreground, and border color options are available on the Dashboard Editor toolbar
and from the context (right-click) menu.

• Colors can be solid or transparent only, gradients can not be applied.

• See Dashboard Editor Behaviors for tips on working with widgets on dashboards.

To Select a Background, Foreground, or Border Color for a Widget

1. Open a dashboard in the Dashboard Editor.

2. Select one or more widgets .
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3. On the Dashboard Editor toolbar, select the Background Color button , the Foreground Color

button , or the Border color button .
You can also use the context (right-click) menu to select the above and additional functions.

To access the background color selector for a button widget, right-click on the button and select
Widget Properties > Button color.
The Color Selector dialog opens. For more information, see Color Selector.

4. Select a color, either:
◦ Select a theme color: Select a pre-defined theme association color property from the Theme

Association drop-down list (example: Widget Background).

◦ Select or define a custom color: Select Custom from the Theme Association drop down list,
and then either:

◦ Select the Web tab, and then select a color from the list.

◦ Select the Custom tab, and then define a color using the Color Selector controls.

5. Continue making changes, or select OK to save and close the editor.5.

Related concepts
Dashboard Editor
Dashboard Themes
Create a Theme
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Select a Background Style and Gloss for a Widget
Use the Dashboard Editor context menu (right-click) menu to select a background style/gloss for any
Widget that has a background. Options include:

• Square background.

• Rounded Corner background.

• Tab background.

• Rounded Tab background.

• Ellipse background.

• No background.

• Gloss: Adds a slightly glowing and reflective background to the Widget.

Good to know:

• Image Widgets do not have a background.

• If a Widget is set to No background, style and gloss cannot be seen.

• Widgets with transparent components (ex: Shapes, pipeline charts, text, etc.) show a gloss very
clearly. Gloss on Widgets whose content covers most of the Widget is not as noticeable.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To select a background style and gloss for a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click one or more Widgets.

3. Right-click>style, and then select a style for the background. Options include:
◦ Square background.

◦ Rounded Corner background.

◦ Tab background.

◦ Rounded Tab background.

◦ Ellipse background.

◦ No background.

4. Right-click>Glossy to add a slightly glowing and reflective background to the Widget.

5. Continue making changes, or select OK to save and close the editor.5.
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Select a Border Style for a Widget
Use the Dashboard Editor to select a border style for a Widget. Border style options include:

• No Border

• 3D Border

• 1, 2, 3 and 4 pixel width

Good to know:

• Border style options are available on the Dashboard Editor toolbar and from the context (right-click
menu).

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To select a border style for a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click one or more Widgets.

3. On the Dashboard Editor toolbar, click the drop-down arrow on the Border Style button, and then
select a style from the following:

◦ No Border: No border is added.

◦ 3D Border: Adds a three dimensional border around the Widget.

◦ Pixel Width: Adds a fixed pixel width border around the Widget.

4. Continue making changes, or select OK to save and close the editor.4.
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Add an Image to a Widget
Use the Dashboard Editor to add an image to a Widget. Images can be:

• Imported: Any image stored in the Image Manager.

• Stored Values: Images used as Stored Values (ex: Company logo).

• Conditional (Expression-driven): For example, define an Expression to conditionally display a
warning icon to indicate a surpassed threshold (ex: Open Incidents surpassed 100 count threshold).

• None: Widget does not use an image.

• Aligned: To the Top/middle/bottom and left/right/center of the Widget.

Good to know:

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add an image to a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click a Widget.

3. On the Dashboard Editor toolbar, click the drop-down arrow on the Image button , and then
select one of the following options:

◦ Browse: Opens the Image Manager, where you can select an existing image or import a new
image to display on the Widget.

◦ From Stored Value: Opens the Stored Value Manager, where you can select an existing
Stored Value or create a new Stored Value to use for the image.

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a custom
Expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
Expression or create a new stored Expression to use. Stored Expressions can be reused in
numerous places in CSM.

◦ None: Does not use an image.

4. Align the image:
a. Click the drop-down arrow on the Image button, select Image Alignment, and then select an

alignment option within the Widget (ex: Top-right).

5. Continue making changes, or select OK to save and close the editor.5.
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Align a Widget
Use the Dashboard Editor to align Widgets on a Dashboard. Widgets can be aligned:

• To the Dashboard grid.

• To each other.

Good to know:

• Use Snap to Grid and Snap to Guide to precisely align Widgets. Press SHIFT+DRAG to ignore grid
and guide snapping.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To align a Widget on a Dashboard:

1. Open a Dashboard in the Dashboard Editor.

2. Click a Widget.

3. Click the Snap to Grid button  to enable grid snapping, and then drag the Widget around the
grid to precisely align it to the grid points.

To align a Widget to other Widgets:

1. Open a Dashboard in the Dashboard Editor

2. Select at least two Widgets (the last selected Widget is the controlling Widget and is identified by
black boxes).

3. Do one of the following:
◦ To align several Widgets against a horizontal axis (either Left, Middle, or Right), click one of

the Line Up Horizontally buttons  on the Dashboard Editor toolbar.

◦ To align several Widgets against a vertical axis (either Top, Middle, or Bottom), click one of the

Line Up Vertically buttons  on the Dashboard Editor toolbar.

◦ To enable guide snapping, click the Snap to Guide button  on the Dashboard Editor
toolbar, and then drag the Widget near other items to precisely align it.

◦ To explicitly position a Widget to a specified location, right-click>Position (or press
CTRL+SHIFT+P) to open the Control Position and Size window, then specify the Left and Top
location and click OK.

4. Continue making changes, or select OK to save and close the editor.4.
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Anchor a Widget
You can anchor widgets on a dashboard to make your widgets grow or shrink to use available space.

Warning:

Although you can anchor dashboard widgets, Cherwell recommends using Adaptive Layouts to
determine how dashboards adapt to changes in screen size. Adaptive Layouts are effective
across CSM Browser Client, CSM Desktop Client, and CSM Portal. For more information on
Adaptive Layouts, see Adaptive Layouts.

If you use anchoring, dashboard rendering may vary across the CSM Clients.

To select anchoring options, choose the sides of the dashboard to which the widget should be anchored
(you can use combinations). Options include:

• Left: Widget keeps the same distance to the left edge and moves farther away from the right edge
when the dashboard gets bigger.

• Top: Widget keeps the same distance to the Top edge and moves farther away from the Bottom
edge when the dashboard gets bigger.

• Right: Widget keeps the same distance to the right edge and moves farther away from the left edge
when the dashboard gets bigger.

• Bottom: Widget keeps the same distance to the Bottom edge and moves farther away from the Top
edge when the dashboard gets bigger.

• Left and Right: Distance between both horizontal edges remains the same, and the widget
stretches to fill the horizontal space when the dashboard gets bigger.

• Top and Bottom: Distance between both vertical edges remains the same, and the widget stretches
to fill the vertical space when the dashboard gets bigger.

• All (Left, Right, Top, and Bottom): Distance between all edges remains the same and the widget
proportionally stretches to fill both the horizontal and vertical space when the dashboard gets bigger.

Good to know:

• Top and Left is the default.

• If the widget is not anchored to any edge, it floats between the two edges.

• Anchoring options are available on the dashboard Editor toolbar and from the context (right-click)
menu.

• For tips on working with widgets on dashboards, see Dashboard Editor Behaviors.

To anchor a widget:

1. Open a dashboard in the Dashboard Editor

2. Select a widget.
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3. On the Dashboard Editor toolbar, select the drop-down arrow on the Anchoring button .

4. Select an anchoring option (you can use combinations).

5. To save your changes, click Select.5.

Warning: If you do not click Select, your changes are abandoned.

6. Continue making changes, or select OK to save and close the editor.

Related concepts
Adaptive Layouts
Dashboard Editor Behaviors
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Layer a Widget
Use the Dashboard Editor to layer Widgets (that is, position a Widget in front of or behind other Widgets).

Good to know:

• Layering options are available from the Dashboard Editor toolbar and from the context (right-click)
menu.

• Not all Widgets are allowed to be in front of or behind all other Widgets (ex: Most Shapes cannot be
on top of most graphical Widgets, such as Charts and Gauges).

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To layer a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Select one or more Widgets.

3. To position a Widget in front of other Widgets, click the Widget, and then click the Bring to Front

button  on the Dashboard Editor toolbar.

4. To position a Widget behind other Widgets, click the Widget, and then click the Send to Back

button  on the Dashboard Editor toolbar..

5. Continue making changes, or select OK to save and close the editor.5.
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Define Visibility for a Widget
You can display or hide a Widget by defining its visibility using the Dashboard Editor or an Expression.
Widgets are displayed by default, unless defined otherwise.

Use the Dashboard Editor to define when to display or hide a Widget (Visibility). For example, display an
SLA Widget on a Dashboard. When an SLA is in jeopardy of being breached, display a warning message
(expression-driven visibility). By default, a Widget is always visible, unless defined to be hidden through
an Expression (for more information, see Expressions).

Note: When using an Expression to define widget visibility, if the Expression is:

• True, the widget is displayed

• False, the widget is not displayed

Good to know:

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To define visibility for a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Select a Widget.

3. Select the drop-down arrow on the Visibility button , and then select one of the following
options:

◦ Custom Expression: Select this option to open the Custom Expression Builder, and then
create a custom Expression to use only for this scenario.

◦ Expression Manager: Select this option to open the Expression Manager, and then select an
existing stored Expression or create a new stored Expression to use (for more information, see
Create an Expression). Stored Expressions can be reused in numerous places in CSM.

◦ Clear Visibility Expression: Clears any visibility Expression so that the Widget is always visible.

4. Continue making changes, or select OK to save and close the editor.4.
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Managing Dashboard Tab Stops
Use the Dashboard Editor to establish a tab order, or tab stops for Widgets and images. Tab order is the
order in which the cursor moves to the next Widget or image when the tab key is pressed. Tab stops are
unique to each Adaptive Layout. Manage tab stops by turning them on or off, adding, removing, editing
the order, or clearing the tab stops.

View Dashboard Tab Stops
To view Dashboard tab stops:

1. Open the Dashboard Editor.

2. Select the Show or Hide Tab Index Display icon  from the toolbar. Numbers display in the
upper right corner of each Widget to reflect the current order that the cursor moves through the
Widgets.

3. Click OK.

Add a Tab Stop to a Widget
To add a tab stop to a Widget:

1. Open the Dashboard Editor.

2. From the toolbar, select the Show or Hide Tab Index Display icon .

3. Right-click a Widget.

4. Select Tab Stop to enable the tab stop for the selected Widget. The Widget is now part of the tab

order sequence. Tab stops can also be turned on by selecting  from the toolbar. A number
displays in the upper right corner of the Widget to reflect the current order that the cursor moves
through the Widgets. When adding a tab stop to a Widget, the tab index number defaults to the
highest existing number + 5 at multiples of 5 (example: 0, 5, 10 or 3, 10, 15). The first tab stop
added will default to 5.

5. Change the number in the Tab Index Order box  from the toolbar to change the default order
of a tab stop on a Widget.

6. Click OK.

Remove a Tab Stop from a Widget
To remove a Widget from the tab stop sequence:

1. Open the Dashboard Editor.

2. Select the Show or Hide Tab Index Display icon  from the toolbar.
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3. Right-click a Widget.

4. Click Tab Stop to disable the tab stop for the Widget and remove it from the tab order sequence.

Tab stops can also be turned off by selecting  from the toolbar.

5. Click OK.

To clear/reset all tab stops on the Dashboard, select the Clear All Tab Index Values icon  from the
toolbar.

Focus on Dashboard
To set focus on the current Dashboard view:

• From the CSM Desktop Client menu bar, click Dashboards>Focus on Dashboard.
Focus on Dashboard can also be set by right-clicking within the Dashboard and clicking Focus on
Dashboard. This sets the focus on the current Dashboard view. When the tab key is pressed, the
focus is on the Widget in the Dashboard that has the tab stop enabled and has the next highest tab
index value. Press SHIFT+TAB to set focus in the opposite direction.
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Dashboard Properties
Reference the descriptions for the general, display, filter, and refresh properties for Dashboards.

General Properties

Property Description Notes

Name The name of the
Dashboard

Required

This property can be searched in CSM Item Managers

Description The description of the
Dashboard

Optional

This property can be searched in CSM Item Managers

Title Text The title of the Dashboard
that appears in the UI Optional

Associate The Major Business Object
association

Default value: (None)

Associate the Dashboard with a particular Major Business
Object to take advantage of Business Object functionality.

For example, create an Incident Dashboard that is
associated with the Incident Business Object. When you
open this Dashboard, the Quick Search pane automatically
switches to searching Incidents, and the main New button
option defaults to creating a new Incident.

Display Options

Property Description Notes

Theme The Theme (set of colors, styles, and fonts) to be used by
the different elements (including Widgets) on the Dashboard

Default value:
(None)

Allow User's chosen
Theme to override
Dashboard Theme

The option to apply the User's Theme to the Dashboard
when it is viewed from the User's account

Default value:
True

Filter Options

Property Description Notes

Initial filter criteria are
the last used criteria

The option to display all Widgets using the Dashboard's last
filtering criteria (in other words, "remember" the last used filter
and automatically display it the next time the Dashboard is
viewed, even between sessions)

Default
option
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Property Description Notes

Initial filter criteria are
the widget default
criteria

The option to display each Widget using the Widget's defined
filtering criteria (either its own filtering criteria or a Dashboard's
criteria)

Refresh Options

Property Description Notes

Refresh reloads all
metrics

The option to reload the current
Metric value every time the
Dashboard is refreshed

Default value: False

If not selected, each Metric is refreshed
according to its own refresh rate.

Refresh all widgets
every: X minutes

The option to refresh all Widgets on
a scheduled basis

Default value: False

When enabled, the default refresh time is 0
minutes.

If not selected, each Widget is refreshed
only according to its own refresh rate.

Also refresh
individual widgets
on their own
schedule

The option to refresh each Widget
according to its defined refresh rate,
in addition to the Dashboard's
refresh rate

Default value: True

This option is activated when Refresh all
widgets every: X minutes is selected.

Additional Options

Property Description Notes

Availability The scope of the Dashboard If you already selected a scope at the beginning,
this is auto-filled with your selection.

Association
The option to select a more
filtered scope (example: a
particular Team)

If not applicable, this option is greyed out.

Custom Image The image to represent the Item
in the UI

Select the image to open the Image Manager,
and then select an existing image or import a new
image to represent the item in the UI.
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Configuring Dashboards
Dashboard configuration tasks include setting security rights and selecting default Home Dashboards and
Themes.

To configure Dashboards:

1. Configure Dashboard security rights: Configure who can access Dashboard functionality and data.

2. Configure Dashboard Theme security rights: Configure who can select a Dashboard Theme.

3. Select a default Home Dashboard, HUD, and Dashboard Theme: The default Dashboards (Home
and HUD) and Dashboard Theme are initially selected in CSM Administrator, either Globally or by
Role. Users with security rights can select their own User default Dashboards and Dashboard
Theme in the CSM Desktop Client.
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Select Default Dashboards and Dashboard Themes
Select default dashboards to display relevant information that is viewed frequently. Select dashboard
themes to give the dashboard a cohesive look.

Each user has a designated default:

• Home dashboard: Opens when you first log in or when the Home button  is selected on the
CSM Desktop Client toolbar or CSM Browser Client menu bar.

• Heads-Up Display (HUD): Pops up a transparent dashboard that can be accessed from anywhere in
the application when you press F4.

• Dashboard theme: Colors, styles, and fonts to give the dashboard a cohesive look and feel.

The default dashboards (home and HUD) are initially selected in CSM Administrator, either globally or by
role. If a user has security rights, they can select their own user default dashboards in the CSM Desktop
Client.

The default dashboard theme (home and HUD), either global or role, can be selected for classic themes
only. A default dashboard universal theme can be selected for default user dashboards only.

Related concepts
CSM Desktop Client Toolbar
Heads-Up Display (HUD)
Select Default Global Dashboards and Dashboard Themes
Select Default Role Dashboards and Dashboard Themes
Select Default User Dashboards and Dashboard Themes
Related reference
Browser Client Menu Bar
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Select Default Global Dashboards and Dashboard
Themes

Use the System Settings window in CSM Administrator to select a default global dashboard, Heads-Up
Display (HUD) and dashboard theme.

Good to know:

• Default global dashboard theme selection is limited to classic themes only, you cannot select a
universal theme.

• If a default role or user dashboard/HUD is selected, it overrides the global defaults.

• If a user has security rights, they can select their own default user dashboard and theme in the CSM
Desktop Client. See Select Default User Dashboards and Dashboard Themes. In the CSM Browser
Client, a user can set a default dashboard only.

• When a user selects a default dashboard in the CSM Desktop Client, that setting is mirrored in the
CSM Browser Client and vice versa. This is not a global setting.

• Customers have limited options and cannot override defaults in the Portal.•

• A system administrator can clear role and user defaults (for a specific user/role or all), resetting the
defaults to the global-defined settings (File > Clear Settings in the User Manager or Role
Manager).

• Be sure to select a dashboard/HUD that everyone can access (global scope).

Select a Default Global Dashboard and Dashboard Theme

1. In CSM Administrator select Settings > Edit System Settings.

2. Select Dashboards, etc in the left pane.

3. Select Default dashboard .
The Dashboard Manager opens.

4. Select a dashboard to use as the global default, and then select OK.

Note: Ensure that you select a dashboard that everyone can access (global scope).

5. Select a default dashboard theme. Select either:
◦ Dashboard's default theme: Theme as defined in the dashboard properties.

◦ Specifically-selected theme: Theme that you select in the drop-down list.

Note: Only classic themes are available for selection.

6. Select Default Heads-up Display .
The Dashboard Manager opens.
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7. Select a HUD to use as the default, and then select OK.

Note: Ensure that you select a HUD that everyone can access (global scope).

8. Select OK.8.

Related concepts
Dashboards
Heads-Up Display (HUD)
Dashboard Themes
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Select Default Role Dashboards and Dashboard
Themes

Use the Edit Roles window in CSM Administrator to select a default role dashboard, Heads-Up Display
(HUD) and dashboard theme.

Good to know:

• Default role dashboard theme selection is limited to classic themes only, you cannot select a
universal theme.

• If no default role dashboard/HUD is selected, the global defaults are used.

• If a user has security rights, they can select their own default user dashboard and theme in the CSM
Desktop Client. See Select Default User Dashboards and Dashboard Themes. In the CSM Browser
Client, a user can set a default dashboard only.

• When a user selects a default dashboard in the CSM Desktop Client, that setting is mirrored in the
CSM Browser Client and vice versa.

• Customers have limited options and cannot override defaults in the Portal.•

• A system administrator can clear role and user defaults (for a specific user/role or all), resetting the
defaults to the global-defined settings (File > Clear Settings in the User Manager or Role
Manager).

Select a Default Role Dashboard and Dashboard Theme

1. Open the Role Manager.

2. Select the role in the Roles list for which you want to select a default dashboard.
The role profile appears in the right-hand pane of the Roles window.

3. In the Dashboard section, select the default role dashboard, either:
◦ Use default: Select this option to use the default global dashboard.

◦ Dashboard: Select this option to use a default role dashboard, and then select Dashboard

 to open the Dashboard Manager and select an existing dashboard.

Note: Ensure that you select a dashboard that everyone with that role can access.

4. Select a default role dashboard theme. Select either:
◦ Use System Default: Theme as defined in the System Settings window.

◦ Use Dashboard Theme: Theme as defined in the dashboard properties.

◦ Specifically-selected theme: Theme that you select in the drop-down list.

Note: Only classic themes are available for selection.
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5. In the Heads-up Display section, select the default role Heads-Up Display (HUD), either:
◦ Use default: Select this option to use the default global HUD dashboard.

◦ Dashboard: Select this option to use a default role HUD dashboard, and then select

Dashboard  to open the Dashboard Manager and select an existing HUD dashboard.

Note: Ensure that you select a dashboard that everyone in that role can access.

6. Select Save .

Related concepts
Dashboards
Heads-Up Display (HUD)
Dashboard Themes
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Select Default User Dashboards and Dashboard
Themes

Use the Options dialog in the CSM Desktop Client to select a default user dashboard, Heads-Up Display
(HUD) and dashboard theme.

Good to know:

• Users must have security rights to override the global defaults and select a user default. See
Dashboard Security Rights.

• Use the context menu to quickly set a default user dashboard (right-click and select Set
<dashboard name> as default).

• If a user default is not selected, either the global or role default are used.

• A system administrator can clear role and user defaults (for a specific user/role or all), resetting the
defaults to the global-defined settings (File > Clear Settings in the User Manager or Role
Manager).

• Classic and/or universal themes are available to apply to the default user dashboard depending on
the theme types available in your system. Where only one type of theme is available, you can only
select a theme of that type (classic or universal).

• When a user selects a default dashboard in the CSM Desktop Client, that setting is mirrored in the
CSM Browser Client and vice versa. In the CSM Browser Client, you can only set the default
dashboard, and not HUD or default dashboard theme. See Set the Current Dashboard to be the
Default.

Select a Default User Dashboard and Dashboard Theme

1. In the CSM Desktop Client, select Tools > Options.
The Options dialog opens.

2. Select Dashboards & Calendars in the left pane.

3. In the Dashboard section, select a default user dashboard, either:
◦ Use Default: Select this option to use the default global or role dashboard (depends on which

one the system administrator has configured).

◦ Dashboard: Select this option to use a default user dashboard instead of the default global/

role dashboard, and then select Dashboard  to open the Dashboard Manager and select
an existing dashboard.

Tip: To make the currently displayed dashboard the default, right-click the dashboard
(anywhere where there is not a widget) and select Set current Dashboard as default.

4. Select a dashboard theme from one of the Default Dashboard Theme drop-down lists.
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Note: Separate drop-down lists are displayed for classic and Universal themes where you
have both types of themes in your system. If you only have one type of theme (classic or
Universal), then only one drop-down list is displayed for those theme types.

◦ Select either:
◦ Use system default (classic theme drop-down list): Theme as defined in the System

Settings window

◦ Use role default (classic theme drop-down list): Theme as defined in the Role Manager.

◦ Use Dashboard Theme (classic and Universal theme drop-down list): Theme as defined
in the Dashboard Properties window.

◦ A specifically-selected theme: Theme that you select in the drop-down list.

5. In the Heads-up Display section, select the default user HUD, either:
◦ Use default: Select this option to use the default global or role HUD dashboard (depends on

which one the system administrator has configured).

◦ Dashboard: Select this option to use a default user HUD dashboard instead of the default

global or role HUD dashboard, and then select Dashboard  to open the Dashboard
Manager and select an existing HUD dashboard.

Tip: You can also set the HUD dashboard transparency in this section.

6. Select OK.6.

Related concepts
Dashboards
Heads-Up Display (HUD)
Dashboard Themes
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Enable Anonymous View of a Dashboard

Note: Anonymous access requires some initial configuration. See Anonymous Security Group for
specific information.

Use Dashboard Properties to enable the Dashboard for Anonymous Users.
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To enable a Dashboard for Anonymous Users:

1. Open a Dashboard in the Dashboard Editor.

2. Select Dashboard Properties.

3. Select the Allow view access for anonymous users check box.

4. Select OK.

Note: You can also restrict Anonymous User visibility for a Dashboard Widget and enable
Anonymous view of the Service Catalog Widget.
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About the Dashboard Viewer
The Dashboard Viewer is a stand-alone tool that displays a single CSM Dashboard or cycles through a
group of Dashboards (called a Slideshow) without consuming a license.

Use the Dashboard Viewer to:

• View a Dashboard or a Slideshow of multiple Dashboards without consuming a license.

• Project important status data on a large screen or projector without consuming a license.

The following figure shows a Dashboard displayed in the Dashboard Viewer.

By default, the Dashboard Viewer displays the default Home page Dashboard for the User who is logged
in. However, you can configure the viewer to display a different Dashboard or a Slideshow, if needed.

Note: If you drill down to edit data in a Dashboard, the Dashboard Viewer launches CSM, which
requires a license.
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Dashboard Viewer Good to Know
• The Dashboard Viewer is a stand-alone tool that displays a single CSM Dashboard or cycles

through a group of Dashboards (called a Slideshow) without consuming a license.

• Open the Dashboard Viewer by clicking Start > Cherwell Service Management > Tools >
Dashboard Viewer.

• If you drill down to edit data in a Dashboard, the Dashboard Viewer launches CSM, which requires a
license.

• While most Widgets work in the same way as in the application, there are some limitations related to
the Command Palette. Commands that launch other Dashboards will work, but all other commands
will be ignored.
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Using the Dashboard Viewer
When working with the Dashboard Viewer, Users can:

• Open the Dashboard Viewer.

• View a Dashboard or Slideshow in the Dashboard Viewer.
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Dashboard Viewer Window
Use the Dashboard Viewer to complete the following Dashboard operations:

• Configure default options.

• View a Dashboard.

• View multiple Dashboards in a Slideshow.

• Open the Dashboard Manager to create, edit, and delete Dashboards.
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Dashboard Viewer Menu Bar
File

Action Description

Go Home Displays the default Dashboard.

Options Opens the Dashboard Viewer Options window,
where you can configure default options.

Close Closes the Manager.

View

Action Description

Toggle Full-Screen Mode Toggles the window to Full-Screen mode that can be
projected on a larger screen.

Refresh Refreshes the data.

Dashboards

Action Description

Dashboard Manager Opens the Dashboard Manager, where you can
create, edit, and delete Dashboards.

Widget Manager Opens the Widget Manager where you can create,
edit, and delete Widgets.

MRU list Displays the Most Recently Used (MRU) items.

Slideshows

Action Description

Slideshow Manager
Opens the Slideshow Manager, where you can
create, edit, and delete slideshows to display
multiple Dashboards.

Help

Action Description

Help Opens the online help.
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Action Description

Contents Opens the online help.

Report Error Opens the Report Error window so you can report an
error to Cherwell.
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Dashboard Viewer Behaviors
• Click File>Go Home to return to the default Dashboard.

• Use the Dashboard MRU menu to display Most Recently Used Dashboards.

• To display the Dashboard Viewer on a large screen, press F11 or click View>Toggle Full-Screen
Mode to go to Full-Screen Mode. In Full-Screen Mode, the application takes up the entire screen,
and the menu bar is temporarily hidden so that only the Dashboard is displayed. Hover over the
menu bar to display it again.

• The Widget Manager and Dashboard Manager are available from the Dashboard Viewer.

• If Widgets are set to refresh on a schedule, the data will automatically be updated as appropriate.
You can also press F5 or click View>Refresh to force all Widgets on the Dashboard to refresh.
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Open the Dashboard Viewer
To open the Dashboard Viewer:

1. Select Start > Cherwell Service Management > Tools > Dashboard Viewer.

Note: Depending on your system, you might be prompted to select a database connection
and log in.
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View a Dashboard or Slideshow in the Dashboard
Viewer

By default, the Dashboard Viewer displays the default Home page Dashboard for the User who is logged
in. However, you can also manually display a Dashboard or Slideshow, if needed.

Good to know:

• You can also configure the viewer to display a different default Dashboard or a Slideshow, if needed

To view a Dashboard or Slideshow in the Dashboard Viewer:

1. To view a Dashboard, click Dashboards>Dashboard Manager, then double-click the Dashboard
to display.

2. To view a Slideshow, click Slideshows>Slideshow Manager, then double-click the Slideshow to
display.
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Configuring the Dashboard Viewer
Complete the following procedures to configure the Dashboard Viewer.

To configure the Dashboard Viewer:

1. Configure Dashboard security rights: Configure who can access Dashboard functionality and data
(including Dashboards, Slideshows, etc.).

2. Define Dashboard Viewer options: Define a default Dashboard/Slideshow and drill-down options.
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Define Dashboard Viewer Options
Use the Dashboard Viewer Options window (accessed from within the Dashboard Viewer) to define the
following:

• Dashboard to Show: Default Dashboard to display when the Dashboard Viewer is opened. You can
select the default Home Dashboard, a specific Dashboard, or a Slideshow.

• Allow Drill-Down: Whether or not to allow Users to drill-down on a Dashboard from within the
Dashboard Viewer (either by clicking a record or double-clicking a Widget). Drill-down does
consume a license.

To Define Dashboard Viewer: Options

1. Open the Dashboard Viewer

2. From the Dashboard Viewer menu bar, click File>Options.

3. Select the default Dashboard to display when the Dashboard Viewer starts:
◦ Home Dashboard: Select this radio button to display the default Dashboard for the currently

logged-in User.

◦ Dashboard: Select this radio button to display an alternative Dashboard. Click the Dashboard
button to open the Dashboard Manager, and then select an existing Dashboard or create a
new Dashboard.

◦ Slideshow: Select this radio button to display a Dashboard Slideshow. Click the Slideshow

button  to open the Slideshow Manager, and then select an existing Slideshow or create a
new Slideshow.

4. Allow drill-down: Select this check box to allow Users to drill down into data on a Dashboard (either
by clicking a record or double-clicking a Widget). When a User drills down, the Dashboard Viewer
launches CSM, automatically logs in the User, and consumes a license.
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5. Select OK.5.
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About Dashboard Slideshows
A slideshow is a series of dashboards that displays on a defined cycle. Use a slideshow to cycle through:

• Company dashboards

• Team dashboards

• Executive dashboards

Slideshow behaviors include the following:

• The Dashboard Viewer cycles through a list of selected dashboards. When the last dashboard is
reached, the viewer returns to the first.

• The time to display each dashboard controls the amount of time before the next dashboard is
loaded. The time can be set in hours, minutes or seconds, with 5 seconds the minimum amount of
time between dashboards.

• When a slideshow has been created, it can be selected from the Slideshow Manager, or simply from
the MRU (Most Recently Used) list of recently accessed slideshows.

CSM provides an OOTB slideshow. Use this slideshow as is, edit it, or create your own using the
Slideshow Manager. See Open the Slideshow Manager.
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Slideshow Manager
Use the Slideshow Manager to complete general CSM Item Manager operations for Slideshows.

The Slideshow Manager is opened from within the Dashboard Viewer.
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Open the Slideshow Manager
To open the Slideshow Manager:

1. From the Windows Start screen, open the Apps screen.

2. In the Cherwell Service Management section, select Dashboard Viewer.
3. From the Dashboard Viewer menu bar, select Slideshows>Slideshow Manager.

CSM 2022.3 Features 721

CSM 2022.3 Features



Create a Slideshow
Use the Slideshow properties window (accessed from within the Slideshow Manager) to create a
Slideshow. When you create a Slideshow, you define:

• General properties: Name and description.

• Time to Display Each Dashboard: In hours, minutes, or seconds.

• Dashboards: List of Dashboards to cycle through.

Note: The Slideshow Manager is accessed from within the Dashboard Viewer.

Good to know:

• After a Slideshow is created, it can be run from the Slideshow Manager or from the MRU list of
recently accessed Slideshows.

• You can also specify a default Slideshow to be opened on startup via File>Options.

To create a Slideshow:

1. Open the Slideshow Manager

2. Select a scope and subfolder (if needed).

3. Click the Create New button .
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4. Define general properties:
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

5. Select the Dashboards to include in the Slideshow:
a. Add button: Click this button to add a Dashboard (one at a time). The Dashboard Manager

opens, where you can select an existing Dashboard or create a new Dashboard.
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b. Time to Display Each Dashboard: Specify the amount of time (in hours, minutes, or seconds)
to display each Dashboard. Five (5) seconds is the minimum.

c. Up/Down arrows: Use to define the order of the Dashboards in the Slideshow. When the last
Dashboard is displayed, the Dashboard Viewer returns to the first.

Tip: Click the Remove button to remove the selected Dashboard from the Slideshow.

6. Select OK.6.
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Document Repositories
A CSM Document Repository is a collection of documents (Attachments) that is used to organize information.
One or more Document Repositories can be used on a Portal Site (example: one for support documents and
another for product documents). Display a Document Repository as a Portal Startup Item or add an Action to a
Site menu bar to display a Document Repository.
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Document Repositories
Use a Document Repository to store items such as public documents and troubleshooting documents, or
as an HR forms repository.

Users can populate and manipulate the contents of a Document Repository using the Attachment
Manager in the CSM Desktop Client, as well as import files directly to the Document Repository in the
CSM Portal using the Import button.

Customers can open documents, upload new documents, edit comments, or replace existing documents
depending on their security rights.

CSM provides an OOTB Document Repository for use in the CSM Portal. However, the Document
Repository must be added to the Portal menu bar in CSM Administrator before customers can access it.
Use this OOTB Document Repository as-is, edit it, or create new Repositories using the Document
Repository Manager. Then, use the Attachment Manager in the CSM Desktop Client to add documents to
the Repository.
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Document Repositories Good to Know
Use these tips for helpful information on Document Repositories.

• A Document Repository is typically identified by the Document Repository icon .

• One or more Document Repositories can be used on a Portal Site (example: Have one for Support
documents and another for Product documents). For more information, see Portal Sites.

• Pin Document Repositories to a Pinboard (in the Document Repository Manager) and MRU list (in
the CSM Desktop Client menu bar) to make them easily accessible in CSM. For more information,
see Pin a CSM Item.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights and Configure Document Repository Security Rights.
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Using Document Repositories
When working with Document Repositories, Users can:

• View a Document Repository.

• Open a Document in the Document Repository.
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View a Document Repository
A Document Repository can be viewed several ways:

• Available Document Repositories (based on security rights): Use the Document Repository
Manager.

• From the Portal menu bar (if configured).

• From the Attachment Manager.
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Managing Document Repositories
Document Repositories are managed using the Document Repository Manager.

There are several ways to open the Document Repository Manager.

Use the Document Repository Manager to complete general CSM Item Manager operations for Document
Repositories, including:

• View a Document Repository.

• Create a Document Repository.

• Add a Document (Attachment) to a Document Repository.

• Edit a Document Repository.

• Delete a Document Repository.

• Search for a Document Repository.

• Organize Document Repositories.

• Copy a Document Repository.

• Import/export a Document Repository.

• Find Document Repository dependencies.

• Pin a Document Repository.
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Open the Document Repository Manager
Open the Document Repository Manager from the CSM Desktop Client or CSM Administrator.

• In the Attachment Manager in the CSM Desktop Client menu bar, select Attachments > Document
Repositories....

• In CSM Administrator, select Browser and Mobile > Document Repository Manager.
• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > Document

Repository Manager.
• In the Site Manager in CSM Administrator.
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Create a Document Repository
Use the Document Repository window, accessed from within the Document Repository Manager, to
create a Document Repository.

To create a Document Repository:

1. Open the Document Repository Manager.

2. Select Create New.

3. Define the properties for the Document Repository:
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

b. Title:

Provide a title to display to Users.

c. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

4. Select Save.

Note: After you create a repository, use the Attachment Manager to add documents to the
repository.
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Add a Document (Attachment) to a Document
Repository

To add a document using the Document Repository Manager:

1. Open the Document Repository Manager.

The Manager lists the existing Document Repositories.

2. Select a Document Repository to populate with documents.

3. Select Options > Attachment Manager.

The Attachment Manager opens, listing the available attachments.

4. Select/create Attachments.

5. Select Close.

To add a document using the Document Repository:

1. Open the Document Repository in the Customer Portal.
2. From the Document Repository toolbar, select Import.
3. Select Select File.
4. Select a document from the File Explorer and then select Open.
5. (Optional) Edit the name of the document. If you do not provide a name, the file name is used

by default.

Note: You can remove the document by selecting the X (Remove) icon to the right of
the attachment.

6. Select Submit.
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Configuring Document Repositories
Configuration procedures are completed in CSM Administrator.

1. Configure Document Repository Items Security Rights.

2. Configure Document Repository Manager Security Rights.
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Delegation
Delegation involves handing off your work to one or more colleagues (delegates) when you are
unavailable. You may need someone to cover for you when you are ill, on leave, or otherwise unavailable.

Delegates can be set for any Major and Supporting Business Object where Track Owner has been
selected. For example, you can delegate approvals, Incidents, and Change Requests.
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About Delegation
Delegation involves handing off your work to one or more delegates when you are unavailable.

• Delegation isn't approval-specific and can be set up for any Major and Supporting Business Objects
where Track Owner has been selected. For example, you can delegate approvals, Incidents, and
Change Requests.

• You can set up multiple delegates, for example, one to cover all your Incidents, one to cover all your
Change Requests, etc.

• You can use delegation in the CSM Browser Client and the CSM Desktop Client.

Note: Delegation isn't available in the CSM Portal.

• If you have the rights to do so, you can create, delete, and cancel delegations.

• If you have insufficient permissions to add or remove delegates, the buttons are inaccessible on the
Manage Delegates page.

• If you choose a delegate who has their own delegate set for the same period, you see the following
warning: Warning: Your chosen delegate has set up a delegate of their own
between [StartDate] and [EndDate] so they may be unable to pick up your
work.

• If you choose a delegate who has you as their delegate, you see the following warning: Cannot
choose [DelegateName] because you are their delegate between [start date
time] and [end date time]. The delegate isn't added after closing the error message.

• To configure a user's ability to manage delegates, see Users Security Rights

Related information
Delegate Work
Delete a Delegation
Manage Delegates For Other Users
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Managing Delegation
Delegation is managed using the Manage Delegates dialog in either of the CSM Clients.

Use the Manage Delegates dialog to:

• Create a delegation period for your own work.

• Manage delegates for other users, if you have been granted rights to do so.

• Delete a delegation.

• Cancel a scheduled delegation.
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Delegate Work
Learn how to hand off some or all of your work to a delegate when you are unavailable, for example,
when you are going on vacation or sick leave.

To delegate work:

1. Open the Manage Delegates page:
a. In the CSM Browser Client, select My Profile from the Account Information toolbar, followed

by Manage Delegates.
b. In the CSM Desktop Client, select Tools from the menu bar, followed by Options, then select

the Manage Delegates tab.
The Manage Delegates page opens showing the status of existing delegations assigned to you (My
work), and those you have assigned to colleagues on the other tab (Work delegated to others).

2. Your own name is already selected in the On behalf of user drop-down list. Select the Business
Object you wish to add delegation for from the drop-down list.
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Note: The list of available Business Objects is based on Track Owner being selected, and
then filtered according to the security rights of the selected On behalf of user. See
Configure Delegation.

3. Select a Delegate from the drop-down list.

Note: If you see a message stating Users are in different Security Groups.
Their rights for the selected Business Object may differ,
potentially limiting their ability to action any delegated work you
can prevent this happening by setting up Different rights based on ownership. See
Configure Delegation.

4. Select the Start Date and Time for the delegation period.
5. Select the End Date and Time for the delegation period.

The End Date and Time chosen must be at least one hour after the Start Date and Time.
6. Select Add.

A new record appears in the tabbed table for Work delegated to others.

Tip: Hover over any of the column headings in the table and select the filter icon to filter
delegates by value, date or text (example: Use a text filter of Contains, and Change to filter
out only the records containing delegations for Change Requests). You can also sort your
delegate records in the table by selecting the up/down arrow  next to any of the column
headings.

7. Select Hide expired records on the Work delegated to others tab to hide all completed and
canceled delegations on this tab.

8. Select a row and double-click on it, or select View records to search for all the records for that
particular Business Object that are assigned to that user.

Note: If you select View records for a single Business Object delegation (example:
Incident), you are taken straight to the Search Results list/grid. You see a dialog titled, for
example, Incidents delegated to Andrew Smith. If you select View records for an All
Business Objects delegation, before being taken to the Search Results, you are asked to
choose the object you want to view the records for.

Related concepts
Log in to the Browser Client
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
Related information
Configure Delegation

CSM 2022.3 Features 739

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_delegation
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_delegation
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=log_in_to_the_browser_client
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=log_in_to_the_csm_desktop_client_or_csm_administrator
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fdelegation%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fdelegation%2Fconfigure_delegation.html


Delete a Delegation
Delete a delegation when a delegation record is no longer required.

Good to Know

• You can only delete a scheduled delegation, and not those that are active, completed, or canceled.

• If you try to delete a delegation, and the delegation period starts while you are looking at the
Manage Delegates page; if you don't refresh the page, you see this message: Selected
delegate(s) cannot be deleted due to delegation period having started and
the Delete button isn't available.

To delete a scheduled delegation:

1. Open the Manage Delegates page:
a. In the CSM Browser Client, select My Profile from the Account Information toolbar, then

Manage Delegates.

b. In the CSM Desktop Client, select Tools > Options, then select the Manage Delegates tab.

2. Select one or more check boxes alongside your chosen records and select Delete.2.

The delegation record is removed.

Related concepts
Log in to the Browser Client
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
Related information
Cancel a Delegation
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Cancel a Delegation
Cancel an active delegation when it is no longer required (example: you cancel a delegation part way
through your leave if you decide to work instead).

Good to Know

• You can only cancel an active delegation, and not those that are scheduled, completed, or canceled.

• If you try to cancel a delegation, and the delegation period ended while you are looking at the
Manage Delegates page; if you don't refresh the page, you see this message: Selected
delegate(s) cannot be canceled due to their delegation period(s) not
being active and the Cancel button isn't available.

To cancel an active delegation:

1. Open the Manage Delegates page:
a. In the CSM Browser Client, select My Profile from the Account Information toolbar, then

Manage Delegates.

b. In the CSM Desktop Client, select Tools > Options, then select the Manage Delegates tab.

2. Select one or more check boxes alongside your chosen records and select Cancel.2.

The delegation is canceled.

Related reference
Browser Client Account Information
Related information
Manage Delegates For Other Users
View All Delegations
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Manage Delegates For Other Users
You can assign a delegate on behalf of other CSM users so that their work can still be done in their
absence.

Note: To manage delegates a user has to be granted additional rights. See Users Security Rights.

To manage delegates on behalf of other users:

1. Open the Manage Delegates page:
a. In the CSM Browser Client, select My Profile from the Account Information toolbar, followed

by User Details, then Manage Delegates.
b. In the CSM Desktop Client, select Tools from the menu bar, followed by Options, then select

the Manage Delegates tab.
The Manage Delegates page opens showing the status of existing delegations assigned to you (My
work), and those you have assigned to colleagues on the other tab (Work delegated to others).
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2. In the On behalf of user drop-down list, select the person whose work you want to delegate to
someone else.

3. Select the Business Object you wish to add a delegate for from the drop-down list.

Note: The list of available Business Objects is based on Track Owner being selected, and
then filtered according to the security rights of the selected On behalf of user. See
Configure Delegation.

Note: If you select All Business Objects, this selects all Business Objects for which Track
Owner is enabled. See Define General Properties for a Business Object

4. Select a Delegate from the drop-down list.

Tip: The person selected for On behalf of doesn't appear in this list.

5. Select the Start Date and Time for the delegation period.
6. Select the End Date and Time for the delegation period.

The End Date and Time chosen must be at least one hour after the Start Date and Time.
7. Select Add.

A new record appears in the tabbed table below for either Work delegated to [your name] or Work
delegated to others.

Tip: Hover over any of the column headings in the table and select the filter icon to filter
delegates by value, date or text (example: Use a text filter of Contains, and Change to filter
out only the records containing delegations for Change Requests). You can also sort your
delegate records in the table by selecting the up/down arrow  next to any of the column
headings.

8. Select Hide expired records on the Work delegated to others tab to hide all completed and
canceled delegations on this tab.

9. Select a row and double-click on it, or select View records to search for all the delegations for that
particular Business Object that are assigned to that user.

Note: If you select View records for a single Business Object delegation (example:
Incident), you are taken straight to the Search Results list/grid. You see a dialog titled, for
example, Incidents assigned to Andrew Smith. If you select View records for All Business
Objects delegation, before being taken to the Search Results, you are asked to choose the
object you want to view the records for.

Related concepts
Log in to the Browser Client
Define General Properties for a Business Object
Users Security Rights
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
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Related information
Delete a Delegation
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View All Delegations
View all scheduled, active, completed, and canceled delegations within CSM.

Grant permission to view delegation history

1. In CSM Administrator, select the Security category.

2. Select Edit security groups.

3. Select a security group from the Groups drop-down list.

4. Select the Rights tab and then select Users from the Categories drop-down list.

5. Select Can view delegate history and ensure that Allow is selected.

View all delegations
Records are shown for scheduled, active delegations, and completed delegations and also those that
have been canceled.

1. In CSM Administrator, select the Settings category.

2. Select Delegates Manager.
You see a read-only table showing:

◦ User: The name of the person whose work is being delegated.

◦ Business Object: The scope of the work being delegated.

◦ Delegate: The person who is handling the work in the user's absence.

◦ Start Date: The start date of the delegation period.

◦ End Date: The end date of the delegation period.

◦ Status: The current status of the delegation (scheduled, active, completed, canceled).

◦ Created by: The person who created the delegation.

◦ Created on: The date and time the delegation was created.

◦ Last modified by: The person who last changed the delegation record.

◦ Last modified: The date and time the last change was made to this delegation record.

Tip: Hover over any of the column headings in the table and select the filter icon  to filter
delegates by value, date, or text (example: Use a text filter of Contains, and Change to filter
out only the records containing delegations for Change Requests). You can also sort your
delegate records in the table by selecting the up or down arrow   next to any of the column
headings.

Related concepts
Users Security Rights

CSM 2022.3 Features 745

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_users_security_rights


Configure Delegation
Delegation configuration tasks include the selection of some system-level and Business Object attributes
and setting up delegation emails for approvals if required.

To configure Delegation:

1. In the CSM Administrator main window, select the Blueprints category, and then select the Create
a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

2. In the Object Manager, select a Major Business Object in the Object tree, and then select Edit
Business Object, followed by Business Object Properties.

3. On the General page, ensure that Track Owner is selected in the Tracking section. See Set
Record Ownership.

4. In the CSM Administrator main window, select the Security category, and then select the Edit
security groups task.

5. Select the Business Objects tab and then select your chosen Business Object from the drop-
down list.

6. Select the check box for Differents rights based on ownership.
This ensures that delegates can work on delegated records for that Business Object even if they do
not ordinarily have security rights to do so. The extra security rights are active just for the period
when the delegate works on an item. Also the Delegate of Owner check box is shown.

7. Optional: If you want your security to be more specific, clear the check boxes under General and
then select rights for Delegate of Owner (and other types of ownership) for View/Edit/Delete for
the Business Object and View/Edit any fields you want to changes the rights for.

8. To configure emails so that delegates get notified by email when they have been assigned an
approval, see Configure Delegation Emails for Approvals.

Important: Email notifications for delegated approvals is a feature of the approvals process.
There is no support for delegation emails for any other types of Business Object.

Related information
Configure Delegation Emails for Approvals
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Configure Delegation Emails for Approvals
Configure emails so that delegates get notified by email when they have been assigned an approval. This
ensures that delegates don't miss approvals and can take action with no delays.

Important: Email notifications for delegated approvals is a feature of the approvals process.
There is no support for delegation emails for any other types of Business Object.

Prerequisites

• An approval has been added as a relationship to your Business Object.

• Approval support has been added for the same Business Object.

• An Approval Block has been created for your Business Object.

• Email accounts have been added and configured for the relevant users.

To configure emails for delegates:

1. In CSM Administrator, select Security and then Edit users.

2. Add relevant email addresses for the person being asked to approve the request and their delegate
who is covering during their absence. See Create a User Profile.

3. In CSM Administrator, select Blueprints and then Create a New Blueprint.
4. Select Edit Approvals for your Business Object.

5. Select the Approvals page and then select Edit to edit your approval block.

6. In the Approval Block, check that the users, who had their email addresses added in step 2, are in
the list on the Approvers page.

7. Select OK.

8. In the Edit [Business Object name] Approvals dialog, select the Notify Approver by Email
check box below the Approvals list, and then select Edit.

9. Configure your email contents. See Define an Approval Email.

10. Publish the Blueprint (File > Publish Blueprint) to commit the changes.

When you then set up a delegate on behalf of another user, the delegate receives an email when
their assigning user gets an approval request. The user should be the same person who was added
to the Approval Block in step 6, and had their email address added in step 2. See Manage
Delegates For Other Users.

Related concepts
Define an Approval Email
Define an Approval Relationship
Create/Edit an Approval Block
Related tasks
Create a User Profile
Manage Delegates For Other Users
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Email
Use CSM email features to keep a record of communication between stakeholders.
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About CSM Email
Use email to track correspondence about specific records.

For example:

• When an email is sent from within CSM using a configured email account, the email is optionally
associated with the current record and the customer or user being supported. In addition, a
Conversation ID is included in the message to track the email conversation and associate replies
with the appropriate records. This can be done when the email is sent manually, via a One-Step™
Action, or from an Automation Process.

• When the Customer or User responds by sending an email to an account monitored by the Email
and Event Monitor, the email is automatically associated with the same record and customer or
user. If the email is sent directly to the technician, the technician can forward it to a monitored
account for automatic processing, or associate it directly using the Outlook Add-In. Once received
by the Email and Event Monitor, additional actions can also automatically be triggered (example:
Adding the record to a CSM Queue).
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• The Outlook Add-In can track email correspondence from Microsoft Outlook and interact directly
with CSM Records. With the Add-In, automatically link incoming emails to records, execute Actions
against records, and capture email history.

Email consists of several features:

• E-mail accounts and settings: CSM E-mail Accounts enable Users to send e-mail messages directly
from the CSM Desktop Client, Browser Client, or Portal. Automatic emails can also be sent from
back-end Automation Processes (example: Using One-Step Actions). E-mail accounts can be
monitored using the Cherwell Email and Event Monitor.

• Email and Event Monitor: The Cherwell Email and Event Monitor is a CSM service that automatically
monitors email accounts and event streams, and then performs specified actions, such as creating
or modifying records based on email content or event details. In addition to connecting to the
database server, it connects to the mail server (example: Microsoft Exchange). The Email and Event
Monitor is a micro-service of the Cherwell Service Host.

• Outlook® Add-In: The CSM Outlook® Add-In is a CSM client that enables you to interact with CSM
Business Object Records directly from within Microsoft® Outlook®.

Use this system as-is or tailor it to meet the needs of the organization. Design ideas include:

• Edit existing email templates.

• Personalize (or create) notification emails.

• Personalize (or create) confirmation emails.

• Create a new Email Monitor with custom Monitor Items.

• Integrate with Microsoft Outlook®.

Related concepts
About CSM Email Accounts
Track E-mail Correspondence in Journal - Mail History Records
Define a Send an E-mail Action
Automation Processes
Related tasks
Send an Email from within CSM
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CSM Email Good to Know

Email Accounts

• Email accounts enable Users to send email messages directly from within the CSM Desktop Client
or Browser Client.

• Create and use email templates when a Send an E-mail Action is added to a One-Step Action or
Automation Process. The e-mail template allows Users to insert standard text, Expressions, system
functions, and variables.

• Global e-mail accounts can be used to:
◦ Send e-mails from within CSM (with E-mail security rights).

◦ Monitor incoming e-mails using an E-mail Monitor.

◦ Set up multiple global e-mail accounts in CSM Administrator.

Global e-mail accounts are accessed and configured from the E-mail and Event Monitoring category
in CSM Administrator (click Edit E-mail Accounts and Settings).

• Personal e-mail accounts can be used to send e-mail from the CSM Desktop Client or Browser
Client. Personal e-mail accounts are accessed and configured from the E-mail Options window in
the CSM Desktop Client (Tools>Options>E-mail page).

• The e-mail options defined when a global e-mail account is configured are set as defaults. Users
can customize the defaults with their own personal e-mail settings (if they have security rights).

• The options for sending e-mail from the Portal vary depending on how the administrator configured
the Portal Actions.

Conversation IDs
Conversation IDs are the most reliable way CSM uses to ensure that e-mails are associated with the
correct records. For this reason, it is important not to delete Conversation IDs from e-mail messages.

• When Users set up a CSM e-mail account or configure the Outlook® Integration, they can choose to
have Conversation IDs inserted into outgoing e-mail messages.

• When a monitored account receives a reply to this e-mail, the E-mail and Event Monitor can use the
Conversation ID to associate the e-mail with the appropriate record.

• The Outlook® Add-In also uses Conversation IDs to associate e-mails with records.
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About CSM Email Accounts
Email accounts enable users to send emails directly from within CSM using the E-mail Message window.

Emails can be sent from either a global account (configured by an administrator) or a personal email
account (configured by users in CSM). Users with email security rights can personalize and use a global
email account. Users can also configure a personal account for special circumstances, such as sending
email from home or an off-site location.

CSM supports the following types of email accounts for both global and personal accounts:

• POP/SMTP (or POP3): A simple and very common mail server format for incoming email.

• IMAP/SMTP (or IMAP4): A more advanced mail protocol than POP and is generally considered
more secure and has additional options for dealing with server-based mail. However, fewer mail
services provide IMAP support.

• Microsoft® Exchange: The Exchange Server handles both incoming and outgoing emails. See the
System Requirements for supported versions.
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Using Email Accounts
When working with email accounts, you can send email messages from within CSM using the Email
Message window. You can also track email correspondence in Journals.

Related concepts
Add Attachments to Email
Select Email Recipients from the CSM Address Book
Attach Email Messages to Records
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Send an Email from within CSM
Use the Email Message window to create and send emails directly from within CSM.

To send emails, an email account must be set up. Users who have email security rights can personalize
and use a global email account (configured by an administrator) to send emails. Also configure a personal
email account for special circumstances, such as sending email from home or an off-site location.

To send an email:

1. Do one of the following:
◦ To send an email from anywhere in the system, select File > Send E-mail in the CSM Desktop

Client or select E-mail > Send E-mail in the CSM Browser Client.
◦ To send an email from the current Business Object Record, select File > E-mail Current

Customer in the Desktop Client or E-mail > Send E-mail in the Browser Client.

Note: If Related Item Navigation is enabled for the Business Object, you can send an
email directly from the Communication tab in the Related Items pane.

2. In the Send Via drop-down list, select the email account to send the message from.

Note: This is automatically set to the default email account. The default account is set in
CSM Administrator, or by the user if the user has security rights.

3. Select a From Address. If this field is not visible and you want to make a selection, select the

control visible fields drop-down list  and select From Field.

Note: This is automatically set to the default From Address defined for the account used to
send the email. If using a global email account, the From Settings were defined by an
administrator when configuring global email accounts. Users who have email security rights
can customize the options for From Addresses in a global email account.. If the user is using
a personal email account, the options for From Addresses are defined when configuring the
account.

◦ If the system administrator configured more than one From Address, select one in the drop-
down list on the From line.

◦ If allowed to enter an arbitrary From Address, provide an address in the From line or select
the From button to open the address book and select an address.

Note: The email system might reject emails from arbitrary addresses.

4. Select the To, Cc, or Bcc buttons to open the address book and select email recipients. The Bcc
line is only available in the Desktop Client.

◦ E-mail Current Customer: If selected and CSM can identify a customer's email address from
the current page (example: From an Incident Record), then the To line is automatically
populated with that address.
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Note: If CSM cannot find a customer's email address, it returns an error message:
Customer email address was not found. Ensure the email from a record that has an
active customer is being sent. If it does and an error is still received, see an
administrator.

◦ E-mail all members of a Team: Select the team from the Address Book or provide
team:name, where name is the name of the team, or Customer Workgroup by typing
workgroup:name.

5. Provide a subject for the email.
6. Compose the message and format it using the email message toolbars.
7. Select Attachment Options for attaching files, links, etc. to emails.
8. Customize where to store email.
9. Select Send.

If the Esc key is pressed at any point during the message creation, an email message opens. Select OK
to abandon and delete the message.

Related concepts
Email Message Window
Email Security Rights
Configure a Personal Email Account
Define Options for a Personal E-mail Account
Attach Email Messages to Records
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Select Email Recipients from the CSM Address
Book

Use the CSM Address Book to search for specific names, find names contained in Customer Objects and
groups, or select entire Teams or Workgroups as recipients.

Good to know:

• The ability to access the Address Book is determined by E-mail security rights.

• If a Team or Workgroup is selected as a recipient, the name of the Team or Workgroup is shown on
the To, Cc, or Bcc line with the appropriate prefix (example: Team: 1st Level Support). When a Team
or Workgroup is created or edited, administrators can also select how e-mails are sent to Teams or
Workgroups. For more information, refer to the Teams and Workgroups Documentation.

• Separate e-mail addresses and Teams and Workgroups entries with semicolons (example: Team:
1st Level Support; firstname.lastname@company.com).

• A Team or Workgroup cannot be selected as a From Address.

To select e-mail recipients using the Address Book:

1. Click the To, Cc, or Bcc button in the E-mail Message window.

2. Select how to search for names in the Address Book, either:
a. Provide Name or Select from List: Provide a name and click Go to search for a specific name

in the Address Book.

b. Show Names From: Select a Customer Object or group in the drop-down to select recipients
from a list of names contained in the Customer Object or group. The drop-down includes:

◦ Objects containing Customer or User data (example: Customer Group Object, Customer
- Internal Major Object, and UserInfo Lookup Table). For more information, see Business
Objects.

◦ Teams

◦ Workgroups

3. Select a name from the list.

4. Click the line where it should appear on (To, Cc, or Bcc).

5. Select OK.5.

The selected names are displayed in the E-mail Message window.

6. Send the e-mail.
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Add Attachments to Email
You can attach one or more files to an email message.

To add attachments to an email in the CSM Browser Client and CSM Portal:

1. Open the email message window (example: E-mail > Send E-mail).
2. Select Attach > Attach a file in the Record toolbar.

3. Select Select Files.

4. Navigate to the file(s) and select or multi-select (CTRL+Shift) the file(s) you want to attach.

5. Select Open or drag and drop the file(s) onto the File Upload dialog.

6. Once the file(s) have finished uploading, select Submit.
7. Finish composing the email and send.

To add an attachment to an email in the CSM Desktop Client:

Select Attachments on the E-mail Message toolbar to attach files, links, etc. to e-mails sent from within
CSM.

1. In the E-mail Message window, select the arrow next to Attachments.

2. Select attachments to add to the email message and send the email.
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From
Records

Open the Define Rules for Attachments window and select criteria that defines which
attachments to include in the e-mail. This is useful if the Action is run against records
that contain multiple attachments.

Note: File Attachment rights control the Attachment operations that can be
performed in CSM.

• All Attachments/Files: Select this radio button to include all Attachments/files from
the selected Business Object/directory.

• First: Select this radio button to include the first defined number of Attachments/
files from the selected Business Object/directory. Then, provide a number or use
the up/down arrows to increase/decrease the number.

• Last: Select this radio button to include the last defined number of Attachments/
files from the selected Business Object/directory. Then, provide a number or use
the up/down arrows to increase/decrease the number.

Note: If First or Last is selected, Attachments/files are sorted in alphabetical order
if they are from a directory, and by the order of appearance on the Business
Object's Attachment Bar if they are from a Business Object.

• Include Attachment/File: Select this check box to include Attachments/files based
on file masks (include Attachments/files that contain certain characters, words, file
extensions, etc.). Then, specify the file masks, using semicolons to separate each
mask.

• Exclude Attachment/File: Select this check box to include Attachments/files based
on file masks (include Attachments/files that contain certain characters, words, file
extensions, etc.). Then, specify the file masks, using semicolons to separate each
mask.

• Minimum Size: Select this check box to include Attachments/files that are of a
minimum defined size. Then, provide a number or use the up/down arrows to
increase/decrease the number. In the drop-down, select kilobyte or megabyte.

• Maximum Size: Select this check box to include Attachments/files that are of a
maximum defined size. Then, provide a number or use the up/down arrows to
increase/decrease the number. In the drop-down, select kilobyte or megabyte.

From
Current
Record

Add Attachments from the current Business Object Record. It opens a sub-menu that
lists the items attached to the current Business Object Record.

Note: This option is only available if sending an e-mail from a Business Object Record
that contains Attachments.

Attachment
Manager

Add Attachments from the Attachment Manager.

Note: This option is only available in the CSM Desktop Client.
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Browse Add files from a computer as attachments.
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Attach Email Messages to Records
Define which Business Object Records to attach an email to as a Journal - Mail History Record after it is
sent.

Use the email history attachment options in the Email Message window to attach emails to:

• Business Objects (example: Incidents).

• Customer Records that CSM identifies from the email addresses of the recipients.

Note: If you use a global email account to send an email, it has default email history
attachment options configured. Use the defaults or override them using the email history
attachment options in the E-mail Message window. If you use a personal email account to
send an email, define the email history attachment options in the E-mail Message window.

To define email history attachment options:

1. Open an E-mail Message window.

2. Select email history attachment options:

Attach to Current
Item

Attach the email to the current record (for example, current Incident, current
Problem, etc.).

Note: This option is only available if there is a current record.

Attach to
Recipients

Attach the email to any of the Customer Records associated with recipients
in the To or Cc lines.

3. Click the Options button to select recipients.

Note: This option is only available when the Attach to Recipients check box is selected.

a. Define Recipient Attachment Options:
◦ Attach to recipients in To line: Select this check box to attach the email to the records

of customers that CSM can identify from email addresses in the To line.

◦ Attach to recipients in Cc line: Select this check box to attach the email to the records
of customers that CSM can identify from email addresses in the Cc line.

◦ Attach to recipients in the Bcc line: Select this check box to attach the email to the
customer Records of the recipients in the Bcc line.

◦ Attach to parents of recipients (for example, company that contact works for):
Select this check box to attach the email to the parent records of recipients (ex. If an
email recipient is a contact that works for a particular company, the email can be
attached to the Company Record as well as the Customer Record).

b. Select OK.b.
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4. Send the email and it is attached to the specified records.
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Track E-mail Correspondence in Journal - Mail
History Records

Journal - Mail History records are used to track email correspondence. When email is sent from within
CSM, a Journal - Mail History Record is created from the email and attached to the current record and/or
the Customer associated with the current record.

The record an email is attached to is based on one of these options:

• The e-mail history attachment options selected in the Email Message window.

• The default email history attachment options (if using a global email account to send the email).

Any attachments that were added to the email are also attached to records based on the default email
history attachment options.

Note: Tracking email correspondence on Business Objects requires those Business Objects to
have history Relationships and an object designated specifically for Mail History. Refer to Define
History Properties for a Business Object for more information.

Note: A Journal's appearance is based on the Grid view and design. For additional information,
refer to Grids.

Use the Journal - Mail History to:

• View a list of all emails linked to a particular Business Object Record.

• View the contents of each email.

• Reply to or forward emails (using the email menu).

When viewing, replying to, or forwarding an email from the Journal - Mail History, the sender and the
email recipients might see a Conversation ID either in the subject line or the body (depending on the
settings configured for the account). CSM uses Conversation IDs to associate emails with the appropriate
records. For this reason, it is important not to delete them from emails.
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Email Message Window
Use the Email Message window to send email messages from within CSM.

The following figure shows the Email Message window in the Desktop Client. The window looks slightly
different in the CSM Web Applications because the window has fewer options in the toolbar, and the Bcc
line is not available.

The email message window can be resized and the size persists the next time the messaging system is
opened.

1. Email Recipients: Provide email addresses in the recipient lines, or select recipients from the CSM
Address Book.

2. Email Message: Compose and format email messages.

3. Email History Attachment Options: Define which records the email is attached to as a Journal -
Mail History Record.

Related concepts
Select Email Recipients from the CSM Address Book
Attach Email Messages to Records
Track E-mail Correspondence in Journal - Mail History Records
Related tasks
Send an Email from within CSM
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Configure a Personal Email Account
Personal email accounts are configured in the E-mail Options window in CSM.

To open the E-mail Options window, go to Tools > Options > Email page. From here, customize a
global email account with personal settings or add a personal email account for special circumstances
such as sending emails from home or an off-site location.

Good to know:

• The ability to define personal email settings depends on email security rights. If an email cannot be
added, edited, copied, deleted, or sent, talk to an administrator.

• If an administrator has set up global email accounts and made them available to users for sending
emails, these accounts are listed in the E-mail Options window (Email page) in CSM. If email
security rights have been granted, global email accounts can be edited and the default settings
customized with personal settings.
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Define Personal POP or IMAP Account Settings
Users who have email security rights can customize and use a global POP or IMAP account (set up in
CSM Administrator), or add their own personal email account to send email.

Defining personal POP or IMAP account settings requires:

• A name for the email account.

• Incoming and outgoing email server information, including:
◦ The location of the mail server.

◦ Security protocol.

◦ Account credentials.

• Options for adding Conversation IDs to outgoing messages.

A Conversation ID is a unique, alphanumeric identifier that correlates an email message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts Conversation
IDs into emails to identify if a particular email is a reply to a previous message that was associated
with a specific Business Object record.

A Conversation ID looks similar to the following: {CMI: ABCD1234}, where ABCD is an identifier for
the particular CSM system (set this value in the History Attachment Options for a global email
account), and the numeric indicator is the specific Conversation ID. The number is automatically
incremented for each message.

• From Addresses that are allowed for sending emails from CSM.

To set up a POP or IMAP account:

Note: The options for a POP or IMAP account are the same. The Ports are different and are listed
in step 6c.

1. From the CSM Desktop Client menu bar, go to Tools > Options.

The Options window opens.

2. Select the E-mail page.

3. Select Add, then choose POP account or IMAP account.

Tip: Users can also edit or copy an existing account (unless it is a credential-based account). Select
Edit to modify the settings for an existing email account. Select Copy to copy the settings for an
existing email account, then modify them as necessary.

The E-mail Options window for a POP or IMAP account opens.

4. Select the Incoming Server page.

5. Define general incoming server (POP or IMAP) settings:
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a. Name: Provide a name for the account.

Note: If editing a global email account, the name of the global account appears here.
Change the name if necessary. Changing the name here does not affect the name of
the global account in CSM Administrator.

Note: The Use Credential-Based Authentication option is disabled. You can't create
or edit a credential-based email account from the CSM Desktop Client; this must be
done in CSM Administrator. If you have an existing credential-based account, the Edit,
Delete, and Copy buttons are disabled.

6. Specify incoming mail server (POP or IMAP) information:

Note: If editing a global email account, the server information for that account appears here.
If the server information needs to be changed (and the User has the correct security rights),
select the Custom Server check box, and define the custom server and security protocol
settings.

a. Incoming Mail Server: Provide the name of the POP or IMAP server.

b. Security: Select a security protocol in the drop-down:
◦ Auto: CSM figures out the best method to use. It selects the most secure method

available in order to prevent transmission of unencrypted User IDs and passwords, if
possible.

◦ Basic: User IDs and passwords are passed as plain text.

◦ SSL: Uses SSL encryption (a Server Certificate is required).

◦ SSL with No Authentication (IMAP only): Uses SSL encryption only (no Server
Certificate is required).

◦ TLS (IMAP only): Uses the TLS protocol.

Note: The mail server must support the selected security mode.

c. Custom Port: Select this check box to enter a port for the POP or IMAP server that is different
than the default.

Note: For POP servers, the default port is 110 (the SSL port is 995). For IMAP servers, the
default port is 143 (the SSL port is 993).

7. Enter Account Information:

Note: If editing a global email account, the information for that account appears here. If a
change to the account information (and have security rights), select the Custom Account
Information check box, and provide the custom account information.

a. User Name: Provide the user name for the email account.

b. Password: Provide the password for the email account.
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c. Credentials: This field is disabled in the Desktop Client. Credential-based email accounts
must be set up in CSM Administrator.

d. Mailbox (IMAP only): Select the mailbox (example: Inbox) where incoming mail should be
stored.

8. Select the Outgoing Server page.

9. Define general outgoing server settings:
a. Name: If a name is not specified on the Incoming Server page, provide a name for the

account.

Note: If editing a global email account, the name of the global account appears here. Change
the name if necessary. Changing the name here does not affect the name of the global
account in CSM Administrator.

10. Specify outgoing mail server (SMTP) information:

Note: If editing a global email account, the server information for that account appears here.
If the server information needs to be changed (and the User has security rights), select the
Custom Server check box, and define the custom server and security protocol settings.

a. Outgoing Mail Server (SMTP): Provide the name of the SMTP server.

b. Security: Select a security protocol:
◦ Auto: Select this option to have CSM to figure out the best method to use. It selects the

most secure method available in order to prevent transmission of unencrypted User IDs
and passwords, if possible.

◦ Basic: Select this option to have User IDs and passwords passed as plain text

◦ SSL: Select this option to use SSL encryption (a Server Certificate is required).

◦ TLS: Select this option to use the TLS protocol.

Note: The mail server must support the selected security mode.

c. Custom Port: Select to enter a port for the SMTP server that is different than the default
(default port is 25, SSL port is 465).

11. Specify Account Information:

Note: If editing a global email account, the information for that account appears here. If the
account information needs to be changed (and User has security rights), click the Custom
Account Information check box and provide the custom account information.

a. Requires Authentication: Select this check box if the SMTP server requires authentication,
and select one of the following options:

◦ Use Same Settings as My Incoming Server: Select if the user name and password for
the SMTP server are the same as the incoming server.

◦ Log on Using: Select to specify a user name and password that is different from the
incoming server settings, and provide the user name and password.

12. Define Conversation ID options:
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Note: If editing a global email account, the Conversation ID options for that account appear
here. If the Conversation ID options need to be changed (and the User has security rights),
select the Custom Conversation ID Settings check box, and define the custom options.

a. Add Conversation IDs to Outgoing Messages: Select this check box to include Conversation
IDs in outgoing emails.

Note: When a Conversation ID is found within an email message, CSM can
immediately find the record (example: Incident) associated with the various emails. If
Conversation IDs are not used, then it can still identify records, but it has to use less
reliable techniques, such as comparing the details of the subject line.

b. Specify where in the email to include the Conversation ID, either:
◦ Add to Subject Line: Select to include the Conversation ID in the subject line of

outgoing emails.

◦ Add to Body: Select to include the Conversation ID in the body of outgoing emails.

Note: : Do not delete Conversation IDs from email messages. Doing so makes it
harder for CSM to associate Customer replies with the correct record.

13. Select Test Account to ensure that emails can be sent from within CSM using this account.

A test email is sent to the current User.

Note: All required Incoming and Outgoing Server information must be filled in before testing
the account.

14. Select OK, or select the Options page and specify the From Addresses that are allowed for
outgoing emails.

CSM 2022.3 Features 768

CSM 2022.3 Features



Define Personal Microsoft Exchange Account
Settings

If a User has E-mail security rights, they can customize and use a global Microsoft Exchange account (set
up in CSM Administrator) or add their own personal e-mail account to send email. Defining personal
Exchange account settings requires:

• A name for the email account.

• Exchange Server information.

• Account credentials.

• Options for adding Conversation IDs to outgoing messages.

A Conversation ID is a unique, alphanumeric identifier that correlates an email message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts Conversation
IDs into emails to identify if a particular email is a reply to a previous message that was associated
with a specific Business Object record. A Conversation ID looks similar to the following: {CMI:
ABCD1234}, where ABCD is an identifier for the particular CSM system (set this value in the History
Attachment Options for a global email account), and the numeric indicator is the specific
Conversation ID. The number is automatically incremented for each message.

• From Addresses that are allowed for sending emails from CSM.

To configure a Microsoft Exchange account in CSM:

1. From the CSM Desktop Client Menu bar, select Tools > Options.

The Options window opens.

2. Select the E-mail page.

3. Select Add.
4. Select Exchange account.

Note: To edit or copy an existing account, select Edit to modify the settings for an existing
email account. Select Copy to copy the settings for an existing email account and modify
them as necessary.

The E-mail Options window for an Exchange account opens.

5. Select the Exchange Server page.

6. Define general account information:
a. Name: Provide a name for the Exchange account.

Note: If editing a global email account, the name of the global account appears here. Change
the name if necessary. Changing the name here does not affect the name of the global
account in CSM Administrator.
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7. The Use Credential-Based Authentication option is disabled. You can't create or edit a credential-
based email account from the CSM Desktop Client; this must be done in CSM Administrator.

8. Define Exchange Server Info:

Note: If editing a global email account, the server information for that account appears here.
To change the server information (and have security rights), select the Custom Exchange
Server check box, and define the custom server and security protocol settings.

a. Exchange Domain: Provide the name of the Exchange Domain.

b. Server (Client Access): Provide the name of the Exchange Client Access Server.

Note: The Client Access Server might not be the same as the primary Exchange
Server. Client Access is the web service used by CSM to talk to Exchange.

c. Use SSL Connection: Select this check box to use SSL encryption for sending and receiving
emails.

Note: This is the default for Microsoft Exchange, but if the digital certificate is not
appropriately configured, disable this option.

d. Allow Invalid Server Certificate: Select this check box to allow emails to be sent and received
even when the digital certificate is invalid.

Note: This option is not recommended because it can pose a security risk to the
Exchange email system.

9. Provide Account Information:

Note: If editing a global email account, the information for that account appears here. If the
account information needs to be changed (and the User has security rights), select the
Custom Account Information check box and provide the custom account information.

a. User: Provide the User ID for the Exchange account.

b. Password: Provide the password for the Exchange account.

c. Credentials: This field is disabled in the Desktop Client. Credentials-based email accounts
must be set up in CSM Administrator.

10. Define Conversation ID options:

Note: If editing a global email account, the Conversation ID options for that account appear
here. If the Conversation ID options need to be changed (and the user has security rights),
select the Custom Conversation ID Settings check box and define the custom options.

a. Add Conversation IDs to Outgoing Messages: Select this check box to include Conversation
IDs in outgoing emails.
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Note: When a Conversation ID is found within an email message, CSM can
immediately find the record (example: Incident) associated with the various emails. If
Conversation IDs are not used, then it can still identify records, but it has to use less
reliable techniques, such as comparing the details of the subject line.

b. Specify where in the email to include the Conversation ID, either:
◦ Add to Subject Line: Select this radio button to include Conversation IDs in the subject

line of outgoing emails.

◦ Add to Body: Select this radio button to include Conversation IDs in the body of outgoing
emails.

Note: Do not delete Conversation IDs from email messages. Doing so makes it
harder for CSM to associate Customer replies with the correct record.

11. Select the Test Account button to ensure that emails can be sent from within CSM using this
account.

A test email is sent to the current User.

Note: All required Exchange Server information must be filled in before testing the account.

12. Select OK, or select the Options page and specify the From Addresses that are allowed for
outgoing emails.
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Define Options for a Personal E-mail Account
Use the Options page in the E-Mail Options window to define allowed From Addresses for sending e-mail.

To define from addresses for a personal e-mail account:

1. From the CSM Desktop Client Menu bar, click Tools>Options.

The E-mail Options window opens.

2. Click the E-mail page.

3. Select a POP account, IMAP account, or Microsoft Exchange account that is configured.

The E-mail Options window for a POP, IMAP, or Exchange account opens.

4. Click the Options page.

5. Define general account information:
a. Name: Provide a name for the account.

Note: If these options are defined in the settings for POP or IMAP accounts or for Microsoft
Exchange accounts, then they are displayed here.

Note: If editing a global e-mail account, the name of the global account is displayed here.
Change the name if necessary. Changing the name here does not affect the name of the
global account in CSM Administrator.

6. Set up default From Addresses for e-mail messages sent from this account:
◦ Use Account Default From Address: Select this radio button to use the default From

Address for the account.

Note: This option is only available if editing a global e-mail account that has a default From
address defined.

◦ Use my e-mail address: Select this radio button to use the e-mail address as the From
Address.

Note: If editing a global e-mail account, this option is only available if the account was
configured to allow the User's e-mail address as a valid From Address.

◦ Other: Select this radio button to specify a From Address other than the account default (if
applicable) or a personal account and provide an e-mail address.

Note: If editing a global e-mail account that has a list of Legal From Addresses, click the down
arrow to open a drop-down and select a Legal From Address. If an arbitrary From Address is
allowed for the account, provide an e-mail address that is not in the list.

7. Select OK.7.
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About the Cherwell Outlook Add-In
The CSM Outlook® Add-In is a CSM client that enables you to interact with CSM Business Object
Records directly from within Microsoft® Outlook®. Use the Add-In to:

• Automatically link incoming e-mails to CSM Business Object Records.

• Quick view or go to CSM Business Object Records.

• Execute Actions (example: One-Step Actions™) against records.

• Capture and track e-mail correspondence in Journal - Mail History Records.

• Create new records.

• Insert Attachments and links to records into outgoing e-mails.

The Cherwell Outlook Add-In involves a quick installation and minimal setup to integrate with CSM so that
CSM can begin interacting with Business Object Records directly from Outlook. The way the Add-In
behaves, including which Business Objects that can link e-mails to, is determined by an Outlook
Integration Configuration (set up in CSM Administrator).

Note: Using the Cherwell Outlook Add-In consumes one CSM concurrent license. If the Add-In is
installed, the license is taken while Outlook is running. However, if both the Cherwell Outlook Add-
In and the CSM Desktop Client and/or the CSM Browser Client are used, only a single license is
used.
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Outlook Add-In Good to Know
• The CSM Outlook® Add-In is a CSM client that enables you to interact with CSM Business Object

Records directly from within Microsoft® Outlook®.

• Download and use the Cherwell Outlook Add-In from Microsoft Outlook. The interface includes:
◦ A Cherwell group in the Outlook ribbon to configure the Add-In to connect to CSM and scan

incoming e-mails.

◦ An area at the bottom of each Outlook e-mail to interact directly with linked Business Object
Records.

• Use the Outlook Integration Manager to create Outlook Integration Configurations, which determine
how the Add-In behaves and which Business Objects e-mails can be linked to.

• Specify default Integration Configurations for each Role. Defaults define who sees what in the
Outlook Integration (which Roles can see which Outlook Integrations).

• The Cherwell Outlook Add-In consumes one of the CSM concurrent licenses. If the Add-In is
installed, the license is taken while Outlook is running. However, if both the Cherwell Outlook Add-In
and the CSM Desktop Client and/or the CSM Browser Client are used, only a single license is used.

• System is the only available scope. Create subfolders underneath this scope to organize items.•

• Use the Manager Context (right-click) menu to quickly access menu bar/toolbar options.
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Cherwell Outlook Add-In Interface
The Outlook Add-In interface options appear in both the inbox and when composing an outgoing e-mail.

1. Cherwell group in the Outlook ribbon. From here:
◦ Configure the Add-In to connect to CSM and scan incoming e-mails.

◦ Automatically link incoming e-mails to records if the Add-In can identify a Customer and a
specific Business Object Record.

◦ Link e-mails that already exist in Outlook, click the Rescan Items button to establish links.
When an e-mail is linked to a record, the e-mail is tracked and stored as a Journal - Mail
History Record on the linked record.

2. At the bottom of each e-mail in Outlook, the Add-In interacts directly with linked Business Object
Records.

◦ Open a quick view of the Customer Record or Business Object Record, or go directly to the
records in CSM.

◦ Execute One-Step Actions against linked records.

◦ If the Add-In cannot identify a Customer from an incoming e-mail, access the CSM Contact
Manager and manually select a Customer; or associate the e-mail with a recipient (someone
on the To or Cc line of the e-mail).

◦ If the Add-In cannot find one specific Business Object Record to link to, it provides a list of the
most recent records associated with the identified Customer. Select a record from this list and
link an e-mail to it.
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3. In outgoing e-mails (new e-mails, replies, or forwards sent from Outlook), insert links to Business
Object Records, add Attachments, and add recipients.
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Tour the Cherwell Outlook Add-In
The Cherwell Outlook Add-In interacts with Business Object Records directly from Microsoft Outlook.
What each User sees in the Add-In is controlled by Outlook Integration Configurations (defined in CSM
Administrator), as well as by the options defined in the Cherwell Outlook Add-In setup.

In the Inbox (or other monitored folder), expand or close the Add-In by clicking the  or  buttons. If
the Add-In cannot automatically find one specific record to link to, it lists the most recent Business Object
Records (potential link items) for Users to select from and manually link e-mails to. If an e-mail is linked
(either automatically or manually) to a specific Business Object Record, the Add-In lists only the
associated record.

When sending (replying to, forwarding, or sending new) e-mails from Outlook, the Add-In provides a
Cherwell Group in the Outlook ribbon with options for inserting links to Business Objects, inserting
Attachments, and choosing additional recipients.

The Cherwell Outlook Add-In has several pieces of functionality:

1. View or change Customer: Click the Customer's name to open a context menu to select from the
following options:

Note: The Customer that appears here is based on the Customer Identification settings
configured for the Outlook Integration Configuration being used. If a Customer cannot be
found, the Customer shows as Unknown. The Customer Object (example: Customer -
Internal) precedes the Customer's name.

◦ Quick View: Opens the Customer Record in a second window to take a quick look at the
details.

◦ Go to Record: Navigates to the Customer Record in CSM.

Note: Users might have to log in to CSM before opening the Customer Record in CSM.

◦ Choose from Cherwell: Opens the CSM Contact Manager to select a different Customer to
associate with the e-mail.

◦ Choose from Current Recipients: Opens another context menu with a list of the names in
the To line of the e-mail. Select one of the names to associate the e-mail with that person.

◦ Remove Customer Association: Unlinks the e-mail from the Customer (changes the
Customer to Unknown).

Note: If any of the options that change or remove the Customer association are selected, the
Business Object Records listed in the Cherwell Outlook Add-In change to show the most
recent records associated with the newly selected Customer.

2. Select Type of Business Object: Click the Business Object drop-down to select the types of
Business Object Records to list.
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Note: If only one type of Business Object is defined in the Outlook Integration Configuration
(Objects page), only that Business Object appears in the drop-down (example: Incident).

3. View or Link a Business Object Record: Click a Business Object Record from the list of most
recent records (potential link items) to view or open the record, or to link the record to the current e-
mail.

Note: The list of recent Business Object Records (potential link items) is based on the
Business Object settings for the Outlook Integration Configuration being used. It only
appears if the Add-In cannot automatically find one specific record to link an e-mail to. Click
More to expand the list of linkable Business Object Records.

4. View Open Business Objects only: Select this check box to filter the list of potential link items to only
show records that have not been closed

5. Create a New <Business Object (example: Incident)>: Click this button to create a new Business
Object Record from the current e-mail.

6. View Associated Business Object Record (if an e-mail has been automatically or manually linked to
a specific record): Click the associated Business Object Record to open a context menu to view
the record, open the record, or unlink the record.

7. Select Actions: Click the Actions drop-down to select the One-Step that executes against the
associated Business Object Record.

Note: The One-Step Actions that appear in the drop-down menu are based on the available
Actions configured for the Outlook Integration Configuration being used.
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8. Select Add-In options for outgoing e-mails:
◦ Insert [Business Object Record (example: Incident 101323)]: Inserts a link to open a linked

Business Object Record in the CSM Desktop Client, Portal, or Browser Client.

Note: This option is only available when sending an e-mail that is linked to a specific Business
Object Record.

◦ Add Attachments: Inserts Attachments from the Business Object Record or Attachment
Manager into the e-mail. Select Attachments in the drop-down.

◦ Add Recipients: Opens the CSM Address Book to select recipients to add to the To, Cc, or
Bcc lines.
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Using the Cherwell Outlook Add-In
 3-Minute Video: Using the Outlook Add-In.

To open the Outlook Integration Manager:

1. In the CSM Administrator main window, click E-mail and Event Monitoring category, and then the
Outlook Integration Manager task.

The Outlook Integration Manager opens in a new window.

Note: Outlook Integration security rights control access to Outlook Integration Manager
functionality and data.

When working with the Cherwell Outlook Add-In, Users can:

• Link or Unlink Outlook E-mails to Customers and Business Object Records: Link an e-mail to a
Customer Record or other Business Object Record, or unlink an e-mail from a Business Object
Record.

• Interact with Business Object Records directly from Outlook: Quick view or open Business Object
Records, execute Actions against linked records, or a create a new record from an e-mail.

• Add Links and Attachments to Outgoing E-mails: Insert links to Business Object Records, insert
Attachments, or add recipients to outgoing e-mails.

• Track Outlook E-mail Correspondence in Journal - Mail History Records: View or create Journal -
Mail History Records from e-mails linked to Business Object Records.
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Link Outlook E-mails to Customers and CSM
Business Objects

CSM attempts to auto-link incoming Outlook e-mails to Customers and Business Objects based on the
Outlook Integration settings configured in CSM Administrator. If it cannot identify a Business Object
Record to auto-link an e-mail to, the Add-In lists the most recent records associated with the identified
Customer. Manually link an e-mail to a record by selecting one of the listed records. If the Add-In
automatically links an e-mail to a Customer and/or Business Object, manually change the association.

To link Outlook E-mails to Customers and CSM Business Objects:

1. Select a Customer to link the e-mail to. Do this if the Customer shows as Unknown, or a change is
needed to who the e-mail is associated with.

a. Click Unknown or the Customer's name.

b. From the context menu, select Choose from Cherwell.

The CSM Contact Manager opens.

c. Choose a name from the Contact Manager and click OK.

The e-mail is now linked to the selected contact.

2. Manually link an e-mail to a Business Object Record.
a. In the list of recent records, click the link button next to the record to link the e-mail to.

b. Click Yes on the verification window.

The e-mail is now linked to the selected record, and a Journal - Mail History Record is created
for that record.

3. Unlink a Business Object Record.
a. Click the linked Business Object Record.

b. From the context menu, click Unlink from [Business Object (ex: Incident 101323)].

The Add-In removes the link to the specific record and shows a list of recent records
associated with the identified Customer.
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Interact with CSM Business Object Records from
Outlook

The Cherwell Outlook Add-In allows Users to access and create Business Object Records directly from
Outlook.

To interact with CSM Business Object Records from Outlook:

1. View or Link a Business Object Record: Click a Business Object Record to open a context menu
and select:

◦ Quick View: Opens the Business Object Record in a second window for a quick look at the
details.

◦ Go to Record: Navigates to the Business Object Record in CSM.

Note: Users might have to log into CSM before they can open the Business Object Record in
CSM.

◦ Link to Record: Links the current e-mail to the selected Business Object Record and creates a
Journal - Mail History Record in CSM.

◦ Unlink from Record: Unlinks the current e-mail from the associated Business Object Record,
and then displays a list of potential link items that can be linked to the e-mail instead.

Note: Unlinking an e-mail from a record does not remove the Journal - Mail History
Record from CSM.

2. Execute Actions against a Business Object Record: Click the Actions drop-down to select One-
Step Actions that can execute against the associated Business Object Record (example: Create
Problem from Incident).

Note: The Actions Menu is only available when an e-mail is linked to a specific Business
Object Record. The One-Step Actions that appear in the drop-down are based on the
available Actions configured in CSM Administrator.

3. Create a Business Object Record:
a. Click the New Business Object button (example: Incident).

A Quick View of a new Business Object Record (example: Incident) opens, with the
Description Field populated with the body of the e-mail.
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b. Complete the form with any remaining details (example: Classification), if applicable.

c. Save and close the record.

The record now exists within CSM and can be linked to other e-mails.
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Add Links and Attachments to Outgoing E-mails
The Cherwell Outlook Add-In provides several options when sending (replying to, forwarding, or sending
new) e-mail from Outlook. The Cherwell group in the ribbon (Message tab) allows Users to insert links to
Business Object Records, insert Attachments, and select additional recipients.

The available options are:

1. Insert [Business Object Record (example: Incident 101323)]: Inserts a link to open the Business
Object Record in the CSM Desktop Client, Portal, or Browser Client. Choose any (or all) of the
following options in the drop-down:

a. Link to Cherwell Application: Inserts a hyperlink to launch the CSM Desktop Client and
open the Business Object Record.

b. Link to Customer Portal: Inserts a hyperlink to launch a browser to Cherwell's Customer
Portal browser application.

c. Link to Cherwell Browser Client: Inserts a hyperlink to launch a browser to the CSM
Browser Client application.

Note: To open a Business Object Record in the Portal or Browser Client using links inserted
into an e-mail, the URLs must be specified in the Browser Application Settings.

2. Add Attachments: Inserts Attachments from the Business Object Record or Attachment Manager
into the e-mail. Select the Attachments in the drop-down:

a. Specific Attachment :Inserts specific Attachments from the Business Object Record into the
e-mail. If the linked Business Object contains Attachments, they are listed individually and can
be inserted into the e-mail.

b. Attachment Manager: Opens the Attachment Manager to select Attachments to insert into the
e-mail.

3. Add Recipients: Opens the CSM Address Book to select recipients to add to the To, Cc, or Bcc
lines.
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Track Outlook E-mail Correspondence in Journal -
Mail History Records

When an incoming Outlook e-mail is linked (either automatically or manually) to a Business Object
Record, a Journal - Mail History Record is created from the e-mail and associated with Business Object
Records. Outgoing replies or forwards are also stored as Journal - Mail History Records if the option is
selected to auto-link them when configuring the Add-In. One e-mail can be attached as a Journal - Mail
History Record to multiple Business Object Records (example: An Incident and a Customer Record).

Note: The types of Business Object Records an e-mail can be linked to is based on what was
configured for the Outlook Integration Configuration being used. Based on the behaviors defined
for the Outlook Integration Configuration, e-mail attachments are also imported and attached to
the Business Object Record.

The figure shows an example of a Journal (associated with an Incident Record) that lists several Journal -
Mail History records created from Outlook e-mails.

Note: A Journal's appearance is based on the Grid view and design. For more information about
Grids, refer to the Grids documentation.

Use the Journal - Mail History to:

• View a list of all Journal - Mail History Records linked to a particular Business Object Record.

• View the contents of each e-mail stored as a Journal - Mail History Record.

• Reply to or forward e-mails stored as Journal - Mail History Records (using the e-mail menu on the
Journal toolbar).

Note: To send an e-mail from a CSM Business Object Record, there must be a CSM e-mail
account set up. There is an option to store replies and forwards as Journal - Mail History
Records.
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Expressions
An expression is a combination of explicit values, constants, variables, operators, and functions that receive
input, manipulate the data, and then output the data. In other words, an expression interprets a value, and
then produces another value as a result (example: The IncidentDurationInDays expression calculates the
amount of time that elapses between the time an Incident is created and closed).
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Expressions
Use an expression to conditionally control appearance and behaviors of CSM features.

You can use an expression to:

• Control visibility of items on forms and toolbars.

• Dynamically display text on forms.

• Calculate times and durations.

• Display colors or images on a form or grid.

Use expressions in:

• Queries: In Comparison clauses as values to search for in a specified field. See Query Builders.

• One-Step™ Actions: In Actions where you can specify values to use in Business Object fields,
email messages, Tweets, temporary filenames, command-line arguments, and URLs. See About
One-Step Actions.

• Dashboards: To set colors, images, text, and visibility for widgets. See About Dashboards.

• Business Objects: To set field values and properties, and to autopopulate fields. See About
Business Objects.

• Forms: To set colors, images, and text for form controls. See About Forms.

• Automation Processes: To limit records. See About Automation Processes.

• Approvals: To define/limit trigger conditions, approvers, and set field Actions. See About Approvals.

• Constraints: To limit what a user sees or can select from in a field, Related Item Picker, tab in a
form arrangement, or prompt. See Constraints.

Expression types include:

• Aggregate

• Case

• Counter

• Date/Time

• Duration

• Logical

• Machine Learning Prediction

• Number

• Sentiment

• Text

• User/Customer Data

Good to Know
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• An expression is typically identified by the expression icon .

• You can create custom expressions from many places in CSM. Custom expressions are used only
where they are created but can be saved as stored expressions.

• CSM provides several OOTB stored expressions. Use these OOTB expressions as-is, edit them, or
create new expressions using the Expression Manager. Create impromptu custom expressions from
the token selector. For more information, see Create an Expression.

• Security rights control access to CSM functionality; configure them in the Security Group Manager in
CSM Administrator (Security > Edit Security Groups). For detailed information, see Security rights
and Configure Stored Expression Security Rights.

Related concepts
Define a Comparison Clause
Define Actions for a One-Step Action
Define Approval Block Action Properties
About Prompts
Related tasks
Create an Expression
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View an Expression
View an expression from the Expression Manager, from an item, or from the Token Selector.

View an expression in the following ways:

• From the Expression Manager, view available expressions (based on security rights).

• From an item that uses an expression (example: Image, background, text).

• From the Token Selector.

Related concepts
Open the Expression Manager
Token Selector
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Manage Expressions
Use the Expression Manager to perform many tasks such as view, edit, and delete expressions.

Use the Expressions Manager to:

• View an expression.

• Create an expression.

• Edit an expression.

• Delete an expression

• Search for an expression.

• Organize expressions.

• Copy an expression.

• Import/export an expression.

• Find expression dependencies.

• Pin an expression.
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Related concepts
Open the Expression Manager
Using CSM Item Managers
View an Expression
Related tasks
Create an Expression
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Open the Expression Manager
Open the Expression Manager to access task options for expressions.

Open the Expression Manager in the following ways:

• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > Expressions.

• In the Token Selector available in Query Builders and One-Step™ Actions.

Related concepts
Token Selector
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Create an Expression
Use the Expression window (access from within the Expression Manager) to create a stored expression.
Access a stored expression wherever CSM uses an expression.

Note: Unlike stored expressions, you can create custom expressions from many places in CSM
but you can only use them where you create them. However, you can save custom expressions as
stored expressions if you select the Convert to Stored Expression button in the Custom
Expression Builder.

To create an Expression:

1. Open the Expression Manager and select a scope and subfolder (if needed).

2. Select Create New .
3. Provide a name and description (these are searchable in CSM Item Managers).
4. Select an expression type from the Editor drop-down list, and then define its properties:

◦ Aggregate
◦ Case
◦ Counter
◦ Date/Time
◦ Duration
◦ Logical
◦ Machine Learning Prediction
◦ Number
◦ Sentiment
◦ Text
◦ User/Data

5. Select Save.

Related concepts
Open the Expression Manager
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Define an Aggregate Expression
An Aggregate expression calculates an expression against child data in a relationship (example: Counting
the number of Incidents linked to a Problem).

To define an Aggregate expression:

1. Create an expression.
2. In the Editor drop-down list, select Aggregate.

The Aggregate Expression section opens.
3. Define the expression:

a. In the Relationship drop-down list, select a relationship (example: Problem Has Linked
Incidents).
Available relationships are based on the associated Business Object (example: Problem).

b. In the Function drop-down list, select the type of data you want to retrieve:
◦ Count: Number of relationship occurrences (example: Number of linked Incidents).
◦ Total: Sum of a specified Numerical expression.
◦ Average: Average of a specified Numerical expression.
◦ Maximum: Highest returned value of a specified Numerical expression.
◦ Minimum: Lowest returned value of a specified Numerical expression.

c. In the Apply Against drop-down list Token Selector, select the field or Numerical expression
for which you want to apply the expression. This option is available for total, average,
maximum, and minimum functions.
To create an impromptu custom expression, select New Custom Expression in the Token
Selector.

d. (Optional) Limit the returned data using an additional expression:
i. Select the Limit check box.

The Limit fields become active.

ii. Select an expression:

◦ Stored Expression: Select the ellipsis button  to open the Expression
Manager, and then select an existing stored expression or create a new stored
expression. You can reuse stored expressions in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button  to open the
Custom Expression Builder, and then create a custom expression specifically for
this scenario.

4. Select Save.

Related concepts
Token Selector
Related tasks
Create an Expression
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Define a Case Expression
A Case expression works as a group of if-then-else expressions that are applied together against one
field (example: If the Incident Priority equals 1, then apply the Alert - High color to the Priority alert bar).

To define a Case expression:

1. Create an expression.
2. In the Editor drop-down list, select Case.

The Case Expression section opens.
3. In the If condition is true section, select a type of If statement (Simple, Advanced, or Named

expression), and then define its properties:
a. Simple: Define an expression (example: Incident.Priority equals 1):

i. Select a value from the Token Selector in the far left Value drop-down list (example:
Incident.Priority).

ii. Select an operator from the Operator drop-down list (example: Equals).
iii. Select a value from the Token Selector in the far right Value drop-down list (example: 1).

The If statement displays in the Cases pane.

The If statement ends with the term empty because the Then statement has not been
defined.

b. Advanced: Select Edit to open the Custom Expression window, and then define a custom
expression.

c. Named Expression: Select the ellipsis button  to access the Expression Manager, and
then select a stored expression or create a new expression.

4. In the Then assign this value section, define the Then value (example: Alert - High):
a. Value: Select a value from the Token Selector.
b. Value is a color: Define a color value:

i. Select the Value is a color check box.

ii. Select the Bulk Apply Theme button , and then select an existing theme or color or
create a new color.

The Then value displays in the Cases pane.

5. (Optional) Add related expressions to the Cases pane (example: If the Priority equals 2, then apply
the Alert - Medium color to the Priority alert bar).

6. Define a default value:
The expression displays this value if none of the defined cases are true.

a. Select the Default: empty row in the Cases pane.

The Then assign this value section opens.

b. Repeat steps 4a - 4b above.
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The default Then value displays in the Cases pane.

7. Select Save.

Related tasks
Create an Expression
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Define a Counter Expression
A Counter expression is used to obtain an assigned number (example: Increment the Incident ID).

To define a Counter expression:

1. Create an expression.
2. In the Editor drop-down list, select Counter.

The Counter Expression section opens.

3. Select the ellipsis button  to access the Counter Manager, and then select an existing counter
(example: IncidentID) or create a new counter.

4. Select Save.

Related concepts
Create, Reset, or Change a Counter
Related tasks
Create an Expression

CSM 2022.3 Features 798

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fexpressions%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fcounters%2Fcreate-_reset-_or_change_a_counter.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fexpressions%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fexpressions%2Fcreate_an_expression.html


Define a Date/Time Expression
A Date/Time expression performs date/time calculations (example: Calculate a fifteen-minute warning for
an SLA).

All Date/Time expressions are applied against a 24/7 time period by default. Certain Date/Time
expressions (Date/Time Math, Is Valid Date, Is Valid Date/Time) can also be applied against existing
Business Hours or new Business Hours (create impromptu using the Business Hours Manager).

To define a Date/Time expression:

1. Create an expression.
2. In the Editor drop-down list, select Date/Time.
3. Define the expression:

a. Select a Date/Time expression type from the Expression Type drop-down list, and define its
properties:

◦ Date/Time Math: Displays calculated value based on a specified Date/Time field or
calendar date (example: A 15-minute warning for an SLA).

◦ Is Valid Date: Evaluates as true if the Date parameter falls within the Business Hours for
the selected calendar.

◦ Is Valid Date/Time: Evaluates as true if the Date/Time parameter falls within the
Business Hours for the selected calendar. You can also choose a time zone against
which the parameter is evaluated:

◦ None: No time zone is associated with the Date/Time parameter and it is assumed
to be the same time zone specified for the Business Hours calendar specified in
the Working Hours drop-down list.

◦ Client time zone: Associates the time zone of each user's client machine with the
Date/Time parameter.

◦ Server time zone: Associates the time zone of the Application Server machine
with the Date/Time parameter.

◦ Specific time zone: Uses a specific time zone.
◦ To Minutes: Displays a Numerical expression that is applied against a specified time or

field and converted into minutes.
◦ To Hours: Displays a Numerical expression that is applied against a specified time or

field and converted into hours.
b. Enter positive or negative numbers in the Amount field (found in the Date/Time Math, To

Minutes, and To Hours expression types).
For example, if you select CurrentDateTime() in the Value field, type 5 in the Amount field,
and select Days in the Units field returns a value of 5 days from now.
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Use plus (+) or minus (-) to add or subtract time. For example, use -7 in the Amount field to
return a value of 7 days ago. Be sure to exclude spaces in the amount.
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c. From the Calendar Type drop-down list, select a calendar type:
◦ 24/7: Expression is applied 24/7.
◦ Working Hours: Expression is only applied during the selected Business Hours

(example: Maintenance window) or value (example: SLA.Work Hours).
4. Select Save.

Related concepts
Business Hours
Related tasks
Create an Expression
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Define a Duration Expression
A Duration expression calculates the amount of time between two dates (example: The number of hours it
takes to close an Incident).

To define a Duration expression:

1. Create an expression.
2. In the Editor drop-down list, select Duration.

The Duration Expression section opens.
3. Define the expression:

a. Select a time period:
CSM applies Duration expressions against a 24/7 time period by default; however, the
expressions can also be applied against existing Business Hours or new Business Hours (use
the Business Hours Manager to create impromptu expressions).

i. Start Date/Time: Select a date/time field or calendar date/time to use as the starting
point of the duration (example: Incident.Created Date Time).

This option is disabled when you select the Time Remaining check box because the
expression automatically uses the current time to perform the calculation.

ii. End Date/Time: Select a date/time field or calendar date/time to use as the ending point
of the duration (example: Incident.Closed Date Time).

iii. Units: Select the unit of time for which you want to display the duration (example: Days).

This option is disabled when you select the Time Remaining check box.

iv. Time Remaining: Select this check box to calculate the time remaining in the duration
calculation expression.

This calculates from the current date/time to the end time.

v. Largest Unit: Select the largest unit of time for which you want to display the duration
(example: Hours).

This option isn't available until you select the Time Remaining check box.

vi. Smallest Unit: Select the smallest unit of time for which you want to display the duration
(example: Seconds).

This option isn't available until you select the Time Remaining check box.

vii. Round: Select this check box to round the unit to the nearest whole number (example:
January 1st to February 10th returns a value of one month instead of 1.37 months).

b. Select a calendar type from the Calendar Type drop-down list:
◦ 24/7: Expression is applied 24/7.

The 24/7 calendar option is applied by default.
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◦ Working Hours: Expression is only applied during the selected Business Hours
(example: Maintenance window) or value (example: SLA.Work Hours).

Option Description

Working hours calendar

◦ Select an option from the drop-down
list.

◦ Select the ellipsis to choose the
Business Hours.

Based on scope and value

Expression makes a selection based on a
specified scope and token value.

◦ Select the scope from the drop-down
list.

◦ Select the Token Selector to open the
token menu, and then select a token
that holds the appropriate name or ID.

4. Select Save.

Related concepts
Managing Business Hours
Business Hours
Related tasks
Create an Expression
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Define a Logical Expression
A Logical expression uses one or more conditions (example: Incident.Status does not equal Closed) to
return a true or false value.

To define a Logical expression:

1. Create an expression.
2. In the Editor drop-down list, select Logical.

The Logical Expression section opens.
3. Define the expression condition:

a. Select a value from the Token Selector in the far left Value drop-down list (example:
Incident.Status).

b. Select an operator from the Operator drop-down list (example: Not Equal).
c. Select a value from the Token Selector in the far right Value drop-down list (example: Closed).

If the field is validated, the Legal Values button  displays to the right of the drop-down
list. Use it to choose from a list of appropriate values.

4. (Optional) Add additional related expressions:
When you add additional expressions to the Logical expression, all conditions in the group must be
true for the expression to return a True value.

a. Select Advanced.
The Advanced section opens and displays the defined expression.

b. Define a Group expression:
i. Select New, and then select Group Expression in the drop-down list.

The Grouping section opens.

ii. Select a grouping condition:
◦ All of the items in the group must be true.
◦ At least one of the items in the group must be true.

The grouping condition displays in the Advanced section.

5. (Optional) Define an expression that meets the Group expression condition:
a. Select a value from the Token Selector in the far left Value drop-down list (example:

Incident.Status).
b. Select an operator from the Operator drop-down list (example: Not Equal).
c. Select a value from the Token Selector in the far right Value drop-down list (example:

Resolved).
If the field is validated, the Legal Values button displays to the right of the drop-down list. Use
it to choose from a list of appropriate values.

6. (Optional) Add additional Logical and Group expression conditions.
7. Select Save.

Related tasks
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Create an Expression

CSM 2022.3 Features 805

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fexpressions%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fexpressions%2Fcreate_an_expression.html


Define a Machine Learning Expression
A Machine Learning Prediction expression uses a trained model to autopopulate a prediction field or a
confidence field.

To define a Machine Learning Prediction expression:

1. Create an expression.
2. In the Editor drop-down list, select Machine Learning Prediction.

The Machine Learning Prediction Expression section opens.
3. From the drop-down list, select a trained Machine Learning model that will make the prediction.
4. Select an option from the Display Settings section:

◦ Display Prediction: Configures the expression to display the predicted value.
◦ Display Confidence: Configures the expression to display the confidence score for the

predicted value.
5. Select Save.

Related tasks
Create an Expression
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Define a Numerical Expression
A Numerical expression performs mathematical calculations using a string of tokens and mathematical
symbols (example: Calculate the total cost of a Labor Cost Item by multiplying the work hours by the
monetary rate).

While simple numbers can be used in an expression, only periods can be used as decimal separators to
separate the integer from the fractional part of a number. Commas and other characters cannot be used
in numerical expressions. Commas are not supported as decimal separators or as thousand separators
(example: ten-thousand and five tenths should be entered as 10000.5). For more complex numerical
formats, create a stored value for the number.

To define a Numerical expression:

1. Create an expression.
2. In the Editor drop-down list, select Number.

The Numerical Expression section opens.
3. Define the expression:

a. Select the Down arrow to open the Token Selector, and then select a value.
Right-click anywhere in the Expression field to access the Token Selector.
The token displays in the Expression field.

b. Type a mathematical symbol for the equation (+ to add, - to subtract, * to multiply, or / to
divide).

c. Select the Down arrow to open the Token Selector, and then select a value.
Right-click anywhere in the Expression field to access the Token Selector.
The token displays in the Expression field.

4. (Optional) Add additional tokens and mathematical symbols to the equation.
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5. Select Save.

Note: Cherwell follows IEEE standards for rounding numerical values, specifically the round to
nearest, ties to even rule.

Related tasks
Create an Expression
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Define a Sentiment Expression
A Sentiment expression is used to determine the sentiment of text and returns a numerical value.

Sentiment expressions utilize Microsoft's Machine Learning libraries and a base "binary sentiment model"
which was provided by Microsoft and trained via Wikipedia. For more information, see https://
dotnet.microsoft.com/apps/machinelearning-ai/ml-dotnet.

Text that has an overall positive sentiment will return a positive number. Text that has an overall negative
sentiment will return a negative number.

To define a Sentiment expression:

1. Create an expression.
2. From the Editor drop-down list, select Sentiment.

The Sentiment expression section opens.
3. To define the expression, select the Down Arrow to open the Token Selector, and then select a

value.

Right-click anywhere in the Expression field to access the Token Selector.

The Token displays in the Expression field.

4. Select OK.

Related tasks
Create an Expression

CSM 2022.3 Features 809

CSM 2022.3 Features

https://dotnet.microsoft.com/apps/machinelearning-ai/ml-dotnet
https://dotnet.microsoft.com/apps/machinelearning-ai/ml-dotnet
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fexpressions%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fexpressions%2Fcreate_an_expression.html


Define a Text Expression
A Text expression displays a string of tokens and text. For example, use a Text expression to dynamically
control the last edited text on the Incident form.

The following two formats can be used for link expressions:

• Links in expressions must be URL-encoded. Ensure you replace spaces with %20.

• Use a | (pipe) character as the delimiter between the link text and the URL.
Example:

Text before the link [LINK Click to Send Email|mailto:example@cherwell.
com?subject=Very Important Email&body=This email is of the utmost impor
tance] text after link

Note: If the URL contains a | (pipe) character, ensure you replace the | with %7C.

To define a Text expression:

1. Create an expression.
2. In the Editor drop-down list, select Text.

The Text Expression section opens.
3. Define the expression:

a. (Optional) In the Expression field, provide the text to display before the expression (example:
Last Edited).

b. Select the Down arrow to open the Token Selector, and then select a value (example:
Incident.LastModifiedDateTime).
Right-click anywhere in the Expression field to access the Token Selector.

The token displays in the Expression field.

c. Select the After replacing tokens, evaluate the results as a calculation check box to
display a calculated value instead of the defined numerical equation.

4. (Optional) Add additional text and tokens to the expression.
5. Select Save.

Related tasks
Create an Expression
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Define a User/Customer Data Expression
A User/Customer Data expression allows for efficient retrieval of certain user and customer data without
setting up a relationship.

To define a User/Customer Data expression:

1. Create an expression.
2. In the Editor drop-down list, select User/Customer Data.

The User Data Expression window opens.
3. Define the Expression:

a. In the Type of User section, select a user type:
◦ User: A user is a service desk professional who logs in and uses CSM to manage

service desk data (example: A technician, manager, designer, system administrator) that
has a UserInfo record.

◦ Customer: A customer is an end-user, either an internal employee or an external
individual, who relies on CSM to initiate/fulfill a service or product (example: A person
reporting a lost password or requesting a new phone) that has a Customer - Internal
record.

◦ Current User/Customer: Select this option to create the expression using the currently
logged in user or customer's record data. After you select this option, the User/
Customer record ID drop-down list is disabled as it is no longer required.

b. In the Attribute Name drop-down list, select the Attribute that you want to display. Attributes
include:

◦ Department
◦ Email Address
◦ Full Name
◦ Manager ID
◦ Manager Name
◦ Phone Number

Below the Attribute list is a list of available fields for the UserInfo or Customer table. The two
lists are separated by a line. If user is selected, the list of available fields is from the UserInfo
table. If customer is selected, the list of available fields is from the Customer table.

c. In the User Record ID drop-down list, select the field that holds the Record ID for the user or
customer (example: UserInfo.RecID or Customer.RecID).

4. Select Save.

Related tasks
Create an Expression
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Configure Expressions
Set security rights for roles and permission to view, add, edit, or delete expressions.

Stored expression security rights are configured in CSM Administrator. See Stored Expressions Security
Rights.
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Formats
A format is a token formula that controls how characters and digits are displayed in a Text field (example:
When and where to include hyphens, parentheses, spaces, and capitalization).
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About Formats
Use formats to enforce how field data is displayed. For example, use a format to control how phone
numbers appear.

Examples:

• Phone numbers:
◦ US: (###) ###-####

◦ International: +## (###) ####-####

◦ Enforce an extension: (###) ###-#### x####

• IPv formats: IPv4 (numeric character) or IPv6 (any character) format.

CSM provides a variety of OOTB stored formats to help get you started. Use these as-is, edit them, or
create new formats using the Stored Format Manager. Custom formats (not intended for reuse on other
fields) can also be created for use on a specific field.
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Formats Good to Know
Use these tips for helpful information on formats.

• A format is typically identified by the Format icon .

• Formats can use several formulas, including alphanumeric formulas, upper and lowercase formulas,
and insertion points.
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Use Formats
Use formats to standardize data by controlling how users enter and view information in a field.
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View a Format
Formats can be viewed from the Stored Format Manager, from a Blueprint, or from the Token Selector.

To view a format:

• Available formats: Use the Stored Format Manager (based on security rights).

• From a field that uses a format in CSM Administrator. Open a Blueprint, and then select Business
Object > Field > General.

• From the Token Selector.
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Add a Format to a Field
You can add two types of formats to a field: stored formats and custom formats.

• A stored format can be reused on any field in CSM. Stored formats are managed using the Format
Manager.

• A custom format is defined for use in a specific field.

To add a format to a field:

1. In CSM Administrator, create a Blueprint.
2. In the Object Manager, open the Business Object that contains the field.
3. Edit the field.
4. Select the General tab.
5. Select the Format checkbox.
6. Select the format to apply:

◦ Select the ellipsis to open the Stored Format Manager, and then select an existing format or
create a Stored Format. Stored formats can be used over and over in numerous places.

◦ Select the Custom Format button to open the Custom Format window, and then create a
format to use only for this scenario. A custom format has many of the same properties as a
Stored Format, only it does not have a name or description, and is not managed through the
Stored Format Manager.
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Manage Stored Formats
Manage stored formats in the Stored Format Manager.

Use the Stored Format Manager to complete general CSM Item Manager operations for stored formats,
including:

• View a format.

• Create a format.

• Edit a format.

• Delete a format.

• Search for a format.

• Organize formats.

• Copy a format.

• Import/export a format.

• Find format dependencies.
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Open the Stored Format Manager
Open the Stored Format Manager from CSM Administrator, CSM Desktop Client, or CSM Browser Client.

To open the Stored Format Manager:

• In the Blueprint or mApp Editor menu bar in CSM Administrator, select Managers > Formats.

• In the Token Selector available in query builders, One-Step Actions, and expressions. For more
information, see Query Builders.
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Create a Stored Format
Use the Format window in the Stored Format Manager to create a stored format.

To create a stored format:

1. Open the Stored Format Manager.
2. Select a scope and subfolder (if needed).
3. Select Create New.
4. Provide a name and description for the format.
5. In the Picture field, specify the formula and/or add criteria by selecting an option in the drop-down

list. For example, (###) ###-#### would format numbers in a Phone field to (719) 555-5555.
6. Define the case (select one):

◦ Keep casing as entered: Maintain the case as it is entered into the field by the user.
◦ Make uppercase: Make all characters uppercase (example: AAAA), regardless of how

characters are entered into the field.
◦ Make lowercase: Make all characters lowercase (example: aaaaa), regardless of how

characters are entered into the field.
7. Select the Characters/Digits Entered at Right and Pushed to Left checkbox to add data from left-

to-right (example: (719) 555-5555). If not cleared, data is entered from right-to-left (example: (555)
555-5917).

8. Select Save.
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Grids
A CSM grid is the data from a Business Object displayed in a table.

CSM uses a grid to display:

• Search Results: List of records located through a Quick Search or Search Group.

• Search Results List Widget: List of results on a Dashboard.

• Form Arrangement: List of related records on a tab.

• Contact Manager: List of Customer Records.

• CMDB interface: List of Configuration Item records.

• Table Management interface: List of Lookup values.

• CSM Item Managers: List of CSM Items (example: List of Dashboards in the Dashboard Manager).

• Creating/editing a Business Object Grid (in CSM Administrator).

The following example shows a grid in the CSM Browser Client.

1. Grid menu bar: Displays actions available for the grid, including navigation, Actions, export, number
of items selected, and available columns.

2. Title: Displays the title of the grid. This may or may not match the name of the Business Object that
the grid represents; a Business Object might have multiple grids, so each might have its own name.

3. Sort icon: Arrow indicates the column currently sorting the grid and if it is in ascending or
descending order. Select the icon to toggle sorting. By default, the Browser Client sorts grids using
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single-column sorting. To sort the grid using multiple columns, click the Multi-column sort button in
the Grid menu bar. If you need to resize a column, use the sizing handles to drag the column to the
width you want.

4. Filter icon: Indicates the column data can be filtered. Select the icon to show filtering options
(possible filter values appear in the column's Filter list).

5. Grid item: Each item within a grid contains its own line of information. Select the item to open the
record in the main pane.

6. Selection check boxes: Check boxes allow you to select multiple items for exporting records or
running One-Step Actions.
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About Grids
You can print, export, and run an Action from most CSM grids. Also, you can personalize your instance of
most grids so they display only the data you want in a meaningful way.

CSM grids allow you to sort, filter, group, size, move, and add or remove columns.

Some personal changes persist so that your changes display the same way the next time you view the
grid in the same location.

Good to Know
Consider the following points when working with Grids:

• On small screens, grids in the CSM Browser Client display records in a collapsed format to fit the
screen.

• Business Object grids (record grids) also support running Actions.

• Very large text fields do not support sorting.

• CSM Item Manager grids support sorting and sizing only.

• Nested grids have limited functionality.

• Grids in CSM (except Form Arrangements) display a maximum of 20,000 rows even though there
may be many more rows of data available.

• If there are more than 20,000 rows of data available for a grid, the total number of records is
indicated.

• Search Results grids allow you to select multiple records at one time and export the contents or run
a One-Step™ Action on those selected records. On all other types of grids, exporting or printing a
grid will export or print all rows of data.

• Use the Preview button to preview what a printed grid will look like.

• Business Object grids use colors and icons to indicate priority and status. The colors and icons vary
based on the Business Object. You can use these settings or define your own Business Object grid
options.

• When using grids on a mobile device, use the list view for a better experience.

Business Object Grids
A Business Object grid displays Business Object data. These grids' properties are stored in a grid
definition. The definition and security rights combine to control options to move and group grids and to
add or remove grid columns. Business Object grids support running Actions. Security rights control
access to CSM functionality and are configured in the Security Group Manager in CSM Administrator by
selecting Security > Edit Security Groups.
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Create/Edit Grids
If a field is intentionally excluded from grids, it does not appear in the Field tree and cannot be added to
the grid. You can define advanced properties for a Field (example: excluding fields from forms and grids).
Use this feature when applying a mApp® Solution that includes to new Form; swap in the new Form
without losing the old Form.

Enable Standard Grids on Small Screens
On small screens, grids in the CSM Browser Client display records in a collapsed format by default. The
vertical dots button on a small screen opens a menu that includes the Standard Grid button. Select the
Standard Grid button to view the records as a standard grid.

Note: Selecting Standard Grid display on a small screen in CSM Browser Client makes all grids
display as standard grids.

Related concepts
Define Business Object Grid Options
Security Rights
Define Advanced Properties for a Field
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Tour a Grid
Grids display a list of items that you can view and edit. Common features of grids include titles, columns
that you can sort and filter, check boxes for selecting multiple items (Search Results grids only), and
menu bars for taking Actions.

The following figure shows an example of a grid in the CSM Desktop Client.

1. Grid title: This title may not match the name of the Business Object that the grid represents. Also, a
Business Object might have multiple grids, each with its own name.

2. Group By box: Displays the grid data grouped by one or more columns so that data can be broken
down into smaller parts or examined from a different viewpoint (example: Group Incidents by
Priority). To group a grid, drag a column header into the Group By box (located directly above the
grid header).

3. Sort icon: Indicates the column currently sorting the grid and if it is in ascending or descending
order ( ). Select the icon to toggle sorting. Select another column heading to sort by that column.

4. Filter icon: Indicates the column data can be filtered. Select the icon to show filtering options
(possible filter values appear in the column's Filter drop-down menu).

5. Lock icon: Indicates that the column cannot be sorted.

6. Images: Expression-driven images can be used to indicate a condition has been met (ex: Display
breached SLAs with an Alarm Clock image). Grid rows also support expression-driven colors.

7. Selection check boxes: Check boxes allow you to select multiple items for exporting records or
running One-Step Actions.

8. Context (Right-Click) menus: Shows common grid operations, such as customize columns,
refresh, print, export, and more.

Grids in the Browser Client and CSM Portal look very similar to CSM Desktop Client grids, except that
Export, Run Action, and Add/Remove Grid Column options are available on a grid toolbar rather than from
a context menu or menu bar. Grid grouping is not currently available.
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1. Grid menu bar: Displays actions available for the grid, including navigation, Actions, export,
number of items selected, and available columns.

2. Title: Grid title. This might or might not match the name of the Business Object that the grid
represents. Also, a Business Object might have multiple grids, so each might have its own name.

3. Group By box: Displays the grid data grouped by one or more columns so that data can be broken
down into smaller parts or examined from a different viewpoint (example: Group Incidents by
Priority). To group a grid, drag a column header into the Group By Box (located directly above the
grid header).

4. Sort icon: Indicates the column currently sorting the grid, and if it is in ascending or descending
order ( ). Select the icon to toggle sorting. By default, the Browser Client sorts grids using single-
column sorting. To sort the grid using multiple columns, select the Multi-column sort button in the
grid menu bar. If you need to resize a column, use the sizing handles to drag the column to the
width you want.

5. Filter icon: Indicates the column data can be filtered. Select the icon to show filtering options
(possible filter values appear in the column's Filter list).

6. Grid item: Each item within a grid contains its own line of information. Selecting the item opens the
record in the main pane.

7. Selection check boxes: Check boxes allow you to select multiple items for exporting records or
running One-Step Actions.

Note: The Actions menu is disabled when more than one item is selected in a Search
Results grid.
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Note: Business Object grids use colors and icons to indicate priority and status. The colors and
icons vary based on the Business Object. You can use these settings or define your own Business
Object grid options.

Related concepts
Define Business Object Grid Options
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Grid Persistence
When making changes to a Grid (group, size, move/reorder, and add/remove a column), the changes are
saved to a Personal Grid definition. As a result, changes appear next time the Grid is viewed in the same
location by the same user.

In summary, Grid changes are:

• Persistent: User-specific changes are saved between sessions.

• Personal: Changes affect only the User who makes the changes.

• Location-specific: Changes affect only the Grid in its current location; for example, the same Grid
displayed as part of search results and on a Dashboard is considered a separate entity and persists
on its own.

• Grid changes are remembered until the Grid is reset in the CSM Desktop Client or Administrator, the
settings are cleared (Tools>Options>General>Restore all Customized Grids to the Admin Defaults,
or File>Clear Settings in the Role or User Manager), or a new System Grid definition is
automatically pushed out. If a new System Grid definition is pushed out, a Personal Grid definition
can be reverted manually but the changes in the new definition will be lost.

• The ability to move/reorder, add/remove a Grid column, and group/persist a Grid is enabled in the
System Grid definition (Customization properties). Persistence is enforced through Grid security
rights.

• If Grid grouping persistence is enabled for the Grid and selected from the context menu (select
Remember Current Grouping Between Uses), the grouping persists until:

◦ The Grid is reset or the grouping is cleared.

◦ The settings are cleared (Tools>Options>General>Restore all Customized Grids to the Admin
Defaults, or File>Clear Settings in the Role or User Manager).

◦ A new System Grid definition is automatically pushed out. If a new System Grid definition is
pushed out, then manually revert to the Personal Grid definition but the changes in the new
definition will be lost.

• The Grid's Grouping properties (defined in the Grid's definition in CSM Administrator) controls if the
Grid can be grouped, if the Group By Box shows by default, and if Grouping can be persisted.
Blueprint Display settings define default values.
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About Grid Filtering
Filtering options/values vary according to the type of data in the column (examples: Text, Number, Logical
[true/false], etc.) and whether the column can be filtered by multiple values.

• If a Text column has a length greater than max searchable and Full-Text Search is not enabled (both
for the Field and the Business Object), filtering options are not available. If a Text Field has a length
greater than the max searchable and Full-Text Search is enabled (both for the Field and the
Business Object), only Full-Text Search operators are available when defining a Query.

• Grid filtering does not persist.

• On a Search Results Grid, if multiple items are selected in the Grid, the selection is cleared when a
filter is applied or removed from the Grid. The selection is also cleared after adding a new column or
sorting items on the Grid.

• Text columns can be filtered by multiple values in their column (example: multiple statuses). Select
the values to use to filter the column, and then select OK. Create a custom filter by selecting the
Custom button. Date/Time, Number, and Logical (true/false) columns do not support multi-column
filtering.

• A Grid column's default width is defined in the Grid's definition in CSM Administrator.

• In order to return results from the Description column, the query must be wrapped in ** or
prepended with % so that it returns an exact match.

The following table shows some example filtering options/values, including the option to create a custom
filter.

FilterFilter Description

Empty Shows only rows where there is no value set for the column.

Not Empty Shows only rows where there is any value set for the column.

Letter/Number
Range Values

Shows only rows that begin with a specified alphabet letter or number range
(example: A-H).

Used only for Text columns. This option is only displayed for columns that do not
have an alternative way of providing values, such as the list of valid values for the
column.

Note: Predefined filter options, such as A-H and 0-9, are not available for
Field columns for which foreign key relationships are enabled.
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FilterFilter Description

Validated
Values

Shows a list of legal values for the column (example: Record Type). Select one or
more values to return all rows that match the selected values. In some places within
the system (such as on a tab under a Business Object), this might include all values
in use within the Grid.

Used for fields validated from a table when the table is set as cacheable.

Range

Prompts to provide a start and end date, and then shows only rows where the value
in the column is between those two dates (inclusive).

Used only for date/time columns.

Common Date/
Time Values

For date/time Fields, shows only rows where the value in the column is within a
common date/time range (example: Today, Yesterday, etc.).

Used only for date/time columns.

Custom

(Desktop Client
only)

Opens the Custom Filter window to define your own filter by defining a Comparison
Clause. A Comparison Clause defines an operator (example: Equals, Less Than,
etc.) and the value to find (example: Value, Field, system function, Expression, or
Stored Value).

Related concepts
Define a Comparison Clause
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Using Grids
When working with Grids, Users can perform a number of tasks, including printing, exporting, filtering,
grouping, and modifying settings.

Some changes (group, size, move/reorder, and add/remove column) are persistent.

Detailed Tasks:

• Print a Grid.

• Export a Grid.

• Filter a Grid.

• Group a Grid.

• Revert to personal Grid settings.

View a Grid
A Grid can be viewed several ways:

• Search Results: List of records located through a Quick Search or Search Group.

• Search Results List Widget: List of results on a Dashboard.

• Form Arrangement: List of related records on a tab.

• Contact Manager: List of Customer Records.

• CMDB interface: List of Configuration Item records.

• Table Management interface: List of Lookup values.

• CSM Item Managers: List of CSM Items (example: List of Dashboards in the Dashboard Manager).

• Creating/editing a Business Object Grid (in CSM Administrator).

Run an Action from a Grid
Run a defined Business Object Action directly from a Business Object Grid (record Grid) to quickly initiate
common operations. Actions are defined as part of a Business Object's definition. For information about
Grids in the Browser Client and Portal, see Browser Client Grid Functions.

To run an Action from a Grid in the Desktop Client, select a row (record), right-click the record, and select
Actions > Select an Action. Note that the Actions menu is disabled when more than one row is
selected in a Search Results Grid.

Sort a Grid
Sort a Grid in alphabetical or numerical order, in ascending (1-10 or A-Z) or descending order (10-1 or Z-
A), using the Sort icons  in the Grid's header. Also, sort a Grid by multiple columns (example: Sort by
Status, then sort each Status by Created Date Time).
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A Grid's default sort order is defined in the Grid's definition (in CSM Administrator). A sorting arrow ( )
appears in the Grid header when the Grid is first shown to indicate which column is the default sorting
column.

Grid sorting does not persist in Search and Dashboard Grids or in CSM Web Applications.

To sort a Grid, select the column header to sort, and then select either the up or down arrows.

Tip: To sort multiple columns;

• Desktop Client: Press and hold the Shift key after selecting the first sort column. The
columns are sorted in the same order they are selected (example: select the Status column,
then hold the Shift key while selecting the Created Date Time column).

• Browser Client: Select Multi-column sort in the toolbar. The columns are sorted in the
same order they are selected (example: select the Status column, then select the Created
Date Time column). To revert to single column sort, select Multi-column sort again.

Size a Grid Column
Size a Grid column to a specific width to set how much data is viewable.

To size a Grid column:

1. In a Grid, hover over the column header to resize until the sizing handles appear.

2. select the sizing handles, then drag the column to the desired width.

Move (Reorder) a Grid Column
Rearrange a Grid by moving (reordering) a Grid column to a different location in a Grid.

To move a Grid column, drag-and-drop the column header to a new location in the Grid.

Add/Remove Grid Columns
Business Object Grids are created and managed by a system administrator in CSM Administrator.
However, add and remove columns (Fields) from an instance of the Grid to show only important Fields
(example: Add the Owned By field to the Incident grid to view record owners). If configured, Fields can be
added from other Business Objects in a Relationship with the Grid (example: Add the Problem ID Field to
view Problems related to the Incident).

To add/remove a Grid column in the Desktop Client:

1. In a Grid, right-click the Grid header, and select Customize Columns.
The menu expands to show which Fields are currently selected to display on the Grid (displayed
Fields have a check mark). An alphabetical list of uncategorized Fields from the original Grid
definition are also listed (the list is limited).

2. Select the Field you want to add to/remove from the Grid. There are three options:
◦ Select an unselected Field to add it to the Grid.
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◦ Select a selected Field to remove it from the Grid.

◦ Select More to access additional Fields, including related Fields.
The Column Customization window opens to select one or more available Fields from the
Business Object to add to the Grid. Currently, selected Fields are already listed in the
Selected Fields box (right column). Available Fields are listed in the Fields box (left column).
Available Fields are organized by category; uncategorized Fields are listed at the top and are
likely listed in the menu.

3. Select the Fields (columns) to add to the Grid by moving them to the Selected Fields box.

Tip: Select the Reset button to reset the Grid to its current definition (how it looked when the
window opened) or its System Grid definition (how it looked when the system administrator
defined it).
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Print a Grid
Print a Grid to produce a hard-copy version of data.

Note: Printing a Grid prints only the rows of data that are displayed in the Grid.

To print a Grid in the Desktop Client:

1. In a Grid, click File > Print Grid or right-click in the Grid and select Print Grid.

The Print Grid window opens.

2. Select the columns to print by moving them to the Selected Fields box.

Note: By default, all rows are selected.

3. Use the arrows to move and order fields.

4. Define the printer options:
a. Printer: Select the printer to use.

b. Page Setup: Define basic paper setup options (ex: Paper, orientation, and margins).

c. Font: Define the font, font style, and font size for the text on the printed Grid.

Note: Page Setup and Font options vary according to the driver of the selected printer.

5. Define the print layout options:
a. Force width to single page: Resize the printed Grid so that it fits on a single page (does not off

trail off the edge).

b. Shade alternate rows: Add a gray shade to every other row of the Grid.

c. Number pages: Add a page numbers to the footers of the printed pages.

d. Preview: Show a preview of the Grid before printing it.
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Export a Grid in the Desktop Client
Export a grid to use CSM data in other applications for reporting or display purposes. You can export to
a .csv or Excel file.

You can export any available field in the Business Object or related Business Object (Business Object in a
1:1 Relationship with the selected Business Object.)

Note: To ensure a manageable amount of data is displayed, grids that are displayed in the CSM
Desktop Client (except those in the Form Arrangement) are limited to a maximum of 20,000 rows
even though there may be many more rows of data available. To access all of the data in a grid,
export or print the grid. In the Form Arrangement, Grids are not limited for displaying data,
exporting, or printing.

Note: Search Results grids allow you to select multiple records at one time and export the
contents or run a One-Step™ Action on those selected records. On all other types of grids,
exporting or printing a grid will export or print all rows of data.

For example:

• Export customers to a .csv file to use a spreadsheet tool to manage a mass-mail communication.

• Export Priority 1 Incidents to use the data as text in a report or presentation.

• Export Knowledge Articles to include them in a troubleshooting manual.

To export a Grid in the Desktop Client:

1. In a Grid, select File > Export Grid or right-click and select Export Grid.

Note: Exportable fields are organized by category; uncategorized fields are listed at the top,
and are likely listed in the menu. Relationships fields are listed below the Relationship node
(example: Incident Links Problem Fields).

2. Select the columns to export by moving them to the Selected Fields box.
3. Verify the Truncate long fields check box is selected to truncate exported fields at 300 characters.

Clear the check box to export the entire contents of fields with more than 300 characters.
4. Define the file options:

a. Select Browse to open the Chose Export File window.
b. Provide a file name for the exported file.

5. Select the format to use for export:
◦ CSV (.csv): Exports all rows of data
◦ Excel (.xlsx): Exports only the rows of data that appear in the Grid

6. Select OK to begin the export.
The file immediately begins to download. The download process varies based on the browser and
associated settings.

7. Save the file to your device.
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Related concepts
Filter a Grid in the CSM Browser Client
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Export a Grid in the CSM Browser Client
Export a Grid from the Browser Client using .csv and .xlsx formats.

Note: To ensure a manageable amount of data is displayed, grids that are displayed in the
Browser Client (except those in the Form Arrangement) are limited to a maximum of 20,000 rows
even though there may be many more rows of data available. To access all of the data in a grid,
export or print the grid. In the Form Arrangement, grids are not limited when displaying data,
exporting, or printing.

Note: Search Results grids allow you to select multiple records at one time and export the
contents or run a One-Step™ Action on those selected records. On all other types of grids,
exporting or printing a grid will export or print all rows of data.

1. Open a grid using an applicable feature (example: Search Results List Widget, Quick Search, Form
Arrangement, etc.).

2. (Optional) Filter the grid so the content is organized the way you want.
3. (Optional) Use the Column Chooser to edit grid columns. When the grid is exported, all columns in

the grid are exported to the file.
4. Select the Export drop-down menu on the Browser Client toolbar.

Note: To export grids, the user must have the appropriate Application Security Rights.

5. Select the format to use for export:
◦ CSV (.csv)
◦ Excel (.xlsx)

The file immediately begins to download. The download process varies based on the browser and
associated settings.

6. Save the file to your device.
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Filter a Grid in the Desktop Client
Filter grids in the Desktop Client by a column value so that the grid shows selected data (example: Only
new Incidents).

Multi-filter a grid to show even more specific data, either by using multiple values in a single column
(example: Show Incidents with a status of Assigned, In Progress, or Pending) or by using multiple column
values (example: Filter by owner, and then by status).

Filters use a simple comparison clause to limit the values (example: Owned By = Josh Wilson). Multiple
values in a single column are strung together using or statements (example: Owned By = Josh Wilson or
Clair Wu). Multiple clauses are strung together to create a query using and statements (example: Owner
= Josh Wilson and Status = Assigned, In Progress, or Pending).

Filtering options/values vary according to the type of data in the column (example: Text, Number, Logical
[true/false], etc.) and whether the column can be filtered by multiple values.

Note: On a search results grid, if multiple items are selected in the grid, the selection is cleared
when a filter is applied or removed from the grid.

To filter a grid in the Desktop Client:

1. Open the grid filter one of two ways:
◦ In a grid, hover over the column header to filter, and then select the filter icon  when it

appears. A filter list appears, showing filtering options/values; options/values vary according to
the type of data in the column (example: Number, Text, etc.).

◦ Select a cell in the grid, then select Ctrl+Shift+F to bring up the filter list for the selected
column.

2. Select a filtering option/value, and then select OK.

Note: A check box indicates that multiple values can be selected to filter the grid.

The grid filters the data and shows results. The filter icon is shown in the header of the filtering
column. The filtering criteria (comparison clause/query) is shown in the grid footer. If the grid is a
search results grid, Add, Edit, and Save filter buttons are shown in the grid footer as well.

3. To continue filtering by another column, hover over another column header, select the Filter icon ,
and then select another filtering option/value.

The grid filters the data again and shows the filtered results.

Note: Select the Custom... button to use the custom filter window to define your own filter
by defining a comparison clause. A comparison clause defines an operator (example:
Equals, Less Than, etc.) and the value to find (example: Value, field, system function,
expression, or stored value). For more information about building comparison clauses, refer
to Define a Comparison Clause.
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To remove the filtering criteria and show the original grid, clear the check box next to the criteria.

After a column is filtered, additional options appear in the lower right corner of the grid.

To update and save filtering options to the current query:

• To add the filter to the current search, select the Add filter to current query button .

• To add the filter and edit the current search in the Search Manager, select the Add filter and edit

current query button .

• To add the filter and save the current search so that it can be used again, select the Add and save

filter button .

The Edit and Save options can also be accessed from the Searching menu.

Related concepts
Filter a Grid in the CSM Browser Client
Define a Comparison Clause
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Filter a Grid in the CSM Browser Client
Filter grids in the CSM Browser Client by a column value so that the grid shows only the desired data
(example: Only new Incidents).

Good to know:

• If a column has a filter applied to it, the Filter icon displays a highlighted square around it.

• Grid filters do not persist from session to session in the Browser Client.

To filter a grid in the Browser Client or CSM Portal:

1. In a grid, select the Filter icon in the header of the column to filter.

2. Select the Filter box to open the menu.

The menu shows filtering options. Options vary according to the type of data in the column
(example: Number, text, etc.).

3. Select a filtering option.

4. Select Filter.
5. To continue filtering by another column, select the Filter icon over another column, and select

another filtering option.

The grid filters the data again and displays the filtered results.

To clear the filtering criteria, select the Filter icon on the filtered column, and then select Clear in the
Filter menu.
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Group a Grid
Group data by one or more columns in a Grid to break information down into smaller parts or to examine it
from a different viewpoint.

The following figure shows how Incidents can be grouped by Priority, and then Status. The Group By Box
(located directly above the Grid header) shows which columns are currently being used to group data.
The Grid shows a count of the records in the group.

To group a Grid:

1. In a Grid, drag-and-drop the column to use to group the data into the Group By Box (located
directly above the Grid header). Two arrows indicate the intended location of the column header.

Tip: If the Group By Box is not visible, right-click in the Grid header, and then select Show
Group By Box.

The Grid reloads and shows grouping the data by the column header. The Group By Box shows
which column is currently being used to group data.
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2. To further group the data by a second column, drag-and-drop a second column heading to the
Group By Box. Again, two arrows indicate the intended location of the column header.

Tip: Rearrange the groupings by dragging a new column header before, after, or in-between
other column headers.

The Grid refreshes and the data is grouped by the second column header.

3. After the Grid refreshes, Users can:
◦ Expand and collapse data using the Expand and Collapse arrows.

◦ Expand and collapse all grouped rows by selecting the Expand/Collapse All Grouped Rows
options on the Grid Context menu (right-click on the Grid Header).

◦ Have the grouping persist between sessions by selecting the Remember Current Grouping
Between Uses option on the Grid Context menu.

◦ Clear the groupings and return to the main Grid using the Clear Grouping option on the Grid
Context menu.

◦ Reset the grouped Grid to the administrator-defined Grid definition by selecting the Reset
option on the Grid Context menu.

◦ Use any of the CSM Grid capabilities (ex: Print, export, sort, filter, and size). If the system
administrator has allowed customization on the Grid and if the User has the security rights to
customize Grids, columns can be moved/reordered and added/removed from an instance of
the Grid.
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Reset to the System Grid Definition
Override any changes made to a Grid (example: Grouping, sizing, moving/reordering, and adding/
removing columns) by resetting a Grid to its System Grid Definition. To save time, CSM also has an option
to reset all Grids at once.

To reset a Grid to its System Grid Definition, right-click the Grid header, and then select Reset.
To reset all Grids to their System Grid Definitions:

1. From the CSM Desktop Client menu bar, select Tools > Options.
2. Select the General page on the Cherwell Service Management Options window.

The General Options window opens.
3. Select the Restore All Customized Grids to Admin Defaults check box.

Note: The check box clears itself when you select OK.
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Revert to a Personal Grid Definition
If a system administrator adds or removes a column in the original Grid definition, the new Grid definition
is automatically pushed out to every instance of the Grid, thus overriding your personal Grid. You must
then choose to use the new System Grid Definition or revert to your Personal Grid Definition.

Note: This option is available only the first time you view the Grid (after logging in or reloading
your definitions) after the system administrator has made changes.

To revert to a personal Grid definition, right-click the Grid header, and then select Revert to personal
settings.
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Managing Business Object Grids
Grids are managed using the Grid Editor (accessed from within a Blueprint in CSM Administrator). Use
this tool to:

• Create/Edit a Business Object Grid.

• Delete a Business Object Grid.

Note: Within the Grid Editor is the Grid Wizard, a specialized tool that automatically creates
a new Grid with all the appropriate Fields and Grid properties.

To open the Grid Editor:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

Tip: Also access the Edit feature by clicking View>View Grid on the Blueprint Editor menu bar or

clicking the Grid toolbar button  on the Blueprint Editor toolbar.

The Grid Editor opens showing the Business Object's default Grid. A dynamic Grid menu bar item
appears on the Blueprint Editor menu bar to access Grid-specific commands.

4. If more than one Grid exists for the Business Object, select the Grid to open by selecting it in the
Grid drop-down (upper-left).

To view a Business Object Grid in the Grid Editor:

Note: This is only viewable if there is more than one Grid

1. Open the Grid Editor.

2. In the Grid drop-down (upper-left), select a Grid.

The Grid shows in the Grid Editor preview pane. The Grid properties show below the preview.

Note: To view the Grid as it appears to Users, see Using Grids.
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Grid Wizard
The easiest way to create a new Grid with all appropriate Fields to a Grid at once is to use the Grid
Wizard.

The Grid Wizard (accessed from within the Grid Editor in a Blueprint) automatically creates a new Grid
with all the appropriate Fields and Grid properties. Use the Grid Wizard to initially and quickly create a
new Grid. After creating the Grid, tweak the Fields and properties as needed.

Note: Fields that are 42 characters long cannot be added to a Business Object when using the
Grid Wizard or Form Wizard. You can, however, add 42-character fields manually.

If creating a Grid using the Grid Wizard, the wizard:

• Adds all the appropriate Fields from the Business Object to the Grid.

• Sets default Grid properties.
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Grid Editor
The Grid Editor is a tool within a Blueprint in CSM Administrator that allows users to manage (create, edit,
and delete) Business Object rids.

The Grid Editor's preview is dynamic. As users make changes, the changes are immediately reflected in
the preview. Publish the Blueprint to commit the changes.

Grid Menu Bar
Item

Shows grid-specific commands. This menu bar appears on the Blueprint Editor
menu bar only when a Form Editor is active in the Object Manager.

Toolbar The Grid Editor does not have a dedicated toolbar, but the Blueprint Editor toolbar is
available with commands for cut, copy, paste, delete, and more.

Grid drop-down
list

Lists the grids defined for the selected Business Object (example: Default, Basic,
Info). The currently-selected default grid displays at the top of the list as Default
grid.

Search Control/
Ignore Folders
button

Quickly locates and shows fields. Use the Search Control to quickly locate a field
whose name and description contain a specific word or phrase (example:
OwnedBy). Use the Ignore Folders button to ignore the organizational folders and
show all fields at the root of the list.

Field tree
Lists the Business Object fields that can be added to the grid. Fields are organized
alphabetically and by folder. Fields from relationships are listed alphabetically under
the relationship.

Grid preview Shows a dynamic preview of the grid (which columns (fields) are on it, column
widths, and order).

Grid Properties
button

Opens the Grid Properties window to define row colors and images for grids.

Note: The name of the image defined in the grid properties is the Alt Text
for the image in the Browser Client grid. To change the Alt Text, you need to
change the image name in the Image Manager. See CSM Web
Applications and Accessibility.

Grid title, width,
and sorting Defines title, width, and sorting options for the grid.

General grid
settings

Defines customization options for the grid (whether or not a user can remove
columns and add/remove fields).

Grid grouping Shows or hides grid grouping.
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Create/Edit a Business Object Grid
Use the Grid Editor (accessed from within a Blueprint in CSM Administrator) to create or edit a Business
Object Grid.

To create a Business Object Grid:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio
buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

Also access the Edit feature by clicking View>View Grid on the Blueprint Editor menu bar or

clicking the Grid toolbar button  on the Blueprint Editor toolbar.

4. From the Blueprint Editor menu bar, click Grid>New Grid.

5. Provide a name for the Grid, and then click OK.

6. Add Fields to a Grid: Drag-and-drop Fields from the Field tree into the Grid preview.

To remove a Field from the Grid, click a Field, and then click the Delete button.

7. Use the arrows to define column order or drag-and-drop the column header to a new location.

8. Define Business Object Grid Options:
a. Define row colors and images.

b. Define title, width, and sorting.

c. Define General Incident Grid settings.

d. Define Show grouping properties:

9. Make the Grid the default Grid.

10. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

To edit a Business Object Grid:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.
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The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio
buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

4. In the Grid drop-down (upper-left), select the Grid to edit.

5. Make any changes.

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Business Object Grid Options
To define Business Object Grid options:

1. Row colors and options:
a. Select Properties.

b. Define Row image/color Expressions for rows:
i. Expression check box: Enables using an Expression.

ii. Define the Expression:

◦ Stored Expression: Select the ellipsis button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select Custom Expression to open the Custom Expression
Builder, and then create a custom Expression specifically for this scenario.

2. Select a column (field) and define grid options:

(Optional) Custom
Column Title

Title to show in the UI. By default, the column is the same name as the field it
represents. You might want the column name to be to different than the field
name (example: More user-friendly)

Width Select on what to base the column width, either based on the Field length (so
that it does not get truncated) or an absolute specified value.

Based on Field Automatically sizes the column width to the actual length of the Field.

Value Defines an actual character width, and then specify the value.

This Column Takes up
All Remaining Space
on the Grid

Automatically sizes the column to take up all remaining space on the grid.

Default to Sorting by
this Column

Sets the backup default sorting.

Note: This setting applies only if all other sorting options are invalid.
CSM requires a user to select a sorting option when creating a search
query. If the field the user selects to sort by is deleted, CSM sorts by
the last item modified. If CSM is configured so that modification times
are not recorded and the field that the user selects to sort by is
deleted, then this option is followed.

General Incident Grid
Settings Despite these settings, users also need security rights to customize grids.

Allow Column Reorder Allows the user to move columns around in a grid.

Allow Users to Add
and Remove Available
Fields from Grid

Allows users with rights to add and remove available fields to the grid.
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Allow Users to Add
Fields to the Grid from
Appropriate
Relationships

Allows users with rights to add and remove available related fields to the grid.
Related Fields can be added if the Relationship is a 1-1, non-external
relationship that does not have the "Exclude Relationship from Grid
customization" check box selected on the Advanced page of the Relationship
properties.

Show Grouping  

Options

• Yes: Displays the Group By box.

• No: Hides the Group By box.

• Based on System Default (Yes or No): Ability to show Group By box is
based on the default Grid display settings (defined in
Blueprint>Tools>Options).

Remember Current
Grouping Between
Uses

Allows grouping persistence.
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Make a Grid the Default Grid
Use the Grid Editor (accessed from within a Blueprint in CSM Administrator) to make a Grid the default
Grid for the Business Object. The default Grid is shown by default when the Business Object is accessed.

To make a Grid the default Grid:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

Tip: Also access the Edit feature by clicking View>View Grid on the Blueprint Editor menu bar or
clicking the Grid toolbar button on the Blueprint Editor toolbar.

4. In the Grid drop-down, select the Grid to open.

5. From the Grid menu bar, select Grid>Make this the Default Grid.

A confirmation window opens.

6. Click Yes to confirm.

The Grid now appears at the top of the Grid drop-down list as Default Grid.

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Configuring Grids
Grid configuration procedures are completed in CSM Administrator.

To configure Grids:

1. Define Business Object Grid Options: Customization properties are defined as part of a Grid's
definition and control the ability to reorder columns and add/remove Fields on a specific Grid.

2. Configure Grid security rights: Configure who can access Grid functionality and data. (Grid security
rights are grouped with Application security rights. For more information, see Configure Application
Security Rights.)

3. Configure global Grid display settings: Enable Grid groupings and define default display options.
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HTML Pages
A CSM HTML page is an HTML-coded web-like page used to display information on a CSM Portal site or the
CSM Browser Client.
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About HTML Pages
HTML pages can be internal or external and are used to display websites, forums, or hard-coded pages.

HTML pages can be:

• Internal HTML pages: HTML pages that users design and code. Users can insert CSM commands
directly into the page, as well as CSM images, tokens, and stored values.

• External HTML Pages: Existing websites. Users supply the URL.

Use an HTML page to display:

• A company website as a startup item on a Portal Site.

• A hardware website or forum on a Portal Site (add an action to a site menu bar to display an HTML
page).

• A hard-coded HTML page that users design directly in the CSM Browser Client.

CSM provides several default HTML pages. Use these HTML pages as-is, edit them, or create new HTML
pages using the HTML Page Manager. CSM also provides the HTML Page Editor to help design and
code your own internal HTML page.

Note: The HTML Page Editor is useful for building pages. For more advanced options, it is
assumed that users have a working knowledge of HTML and possibly CSS.

Related concepts
About Portal Actions
Related tasks
HTML Page Editor
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HTML Pages Good to Know
Use these tips for helpful information on HTML pages.

• Display an HTML page as a Portal startup item, or add an action to a Portal site menu bar to display
an HTML page.

• Actions, dashboards, visualizations, calendars, widgets, and searches can be viewed, accessed, or
run in the CSM Portal; however, they are managed (created, edited, and deleted) and configured
(security rights and defaults) only in the CSM Desktop Client and CSM Administrator.

• If the CSM Browser Client or CSM Portal are accessed via HTTPS, an embedded HTML page
displays if the embedded page is also delivered securely over HTTPS. This is a security restriction
enforced by modern web browsers. If the Browser Client or Portal are accessed via HTTP, any
embedded HTML page displays regardless of whether they are delivered over HTTP or HTTPS.

Note: Site owners can configure their sites to include HTTP headers that instruct browsers
not to render the page if it is embedded within another site. This can prevent a browser from
displaying an embedded HTML page. Be aware of this possibility when embedding any
HTML page that is delivered by a web server that is not under your control.

• To configure HTML pages in CSM Administrator, configure HTML pages rights.

Security rights control access to CSM functionality and are configured in the Security Group Manager in
CSM Administrator (Security > Edit Security Groups).

Related concepts
Security Rights
HTML Pages Security Rights
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Manage HTML Pages
Use the HTML Page Manager to complete general CSM Item Manager operations for HTML pages.

HTML pages are managed in CSM Administrator using the HTML Page Manager and the HTML Page
Editor.

There are several ways to open the HTML Page Manager, including from the CSM Desktop Client and
from within the Site Manager.

Use the HTML Page Manager to complete the following operations:

• Create an external HTML page.

• Create an internal HTML page.

• Edit an HTML page.

• Delete an HTML page.

• Search for an HTML page.

• Organize HTML pages.

• Copy an HTML page.

• Import/export an HTML page.

• Find HTML page dependencies.

• Pin an HTML page.

Related concepts
Using CSM Item Managers
Open the HTML Page Manager
Related tasks
HTML Page Editor
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Open the HTML Page Manager
Open the HTML Page Manager to add new HTML pages or edit or delete existing HTML pages. There
are several ways to open the HTML Page Manager.

To open the HTML Page Manager:

• From the CSM Desktop Client, create a Browser Widget. Under Browser Settings, select the
HTML page option, and then select the ellipsis.

• From the CSM Browser Client menu bar, select Pages > Pages Manager.
• In the CSM Administrator main window, select the Browser and Mobile category, and then select

the HTML Page Manager task.

• From within the Site Manager in CSM Administrator.

• From the Blueprint Editor menu bar in CSM Administrator, select Managers > HTML Page
Manager.

• From the mApp Editor menu bar in CSM Administrator, select Managers > HTML Page Manager.

Related concepts
Site Manager
Blueprint Editor Menu Bar
mApp Editor Menu Bar
Related tasks
Create a Browser Widget
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HTML Page Editor
Use the HTML Editor to design and code your own HTML page.

To open the HTML Page Editor:

1. From the HTML Page Manager, create a new HTML page or edit an existing HTML page (right-click
the page and select Edit).
When using a two-tier connection, a CSM login window opens. Provide your user name and
password to open the HTML Editor tool.

2. To delete a page from the HTML Page Editor in the CSM Desktop Client, select the page, and then
select Delete (or right-click and select Delete).

Note: If you select Cancel, it does NOT delete the page.

3. From the toolbar, use the following CSM-specific buttons for common CSM actions:
◦ Edit CSS
◦ Insert Cherwell action
◦ Insert Cherwell image
◦ Insert Cherwell expression, stored value, or system function
◦ Preview in browser

For more information on the Jodit Editor 3, see the XDSoft documentation at https://xdsoft.net/
jodit/doc/.

Related concepts
Open the HTML Page Manager

CSM 2022.3 Features 860

CSM 2022.3 Features

https://xdsoft.net/jodit/doc/
https://xdsoft.net/jodit/doc/
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fhtml_pages%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fhtml_pages%2Fopen_the_html_manager.html


Create an External HTML Page
Create an external HTML page to display an existing website on a Portal Site.

To create an External HTML page:

1. Open the HTML Page Manager.
2. (Optional) Select a scope and subfolder.
3. Select Create New > External HTML Page.
4. Provide a name and description (these can be searched in the CSM Item Managers).
5. Select Options.

a. Select a scope from the Availability drop-down list.

Note: If you already selected a scope at the beginning, this is autopopulated with your
selection.

b. Select an association from the drop-down list. If applicable, select a more filtered scope
(example: A particular team). <Automatic> applies scope based on login. If not applicable, this
option is not available.

c. For a custom image, select the Image, and then select an existing image or import a new
image to represent the item in the UI.

d. Select OK.
6. Enter the URL for the external page or select Browse to open a browser window to locate the site.
7. Select a display option:

◦ Open page in new browser window: Display the HTML page in a new browser window when
it is accessed.

◦ Display within portal page: Display the HTML page within the Portal window. Then, specify
the height of the embedded window.

8. Select Save.

Related concepts
Open the HTML Page Manager
Scope
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Create an Internal HTML Page
You can design and code internal HTML pages.

To create an Internal HTML page:

1. Open the HTML Page Manager.
2. (Optional) Select a scope and subfolder.
3. Select Create New > Internal HTML Page.
4. Provide a name and description (these can be searched in the CSM Item Managers).
5. Select Options.

a. Select a scope from the Availability drop-down list.

Note: If you already selected a scope at the beginning, this is autopopulated with your
selection.

b. Select an association from the drop-down list. If applicable, select a more filtered scope
(example: A particular team). <Automatic> applies scope based on login. If not applicable, this
option is not available.

c. For a custom image, select the Image, and then select an existing image or import a new
image to represent the item in the UI.

d. Select OK.
6. Select the Set background color check box to apply a background color to the HTML page. Then,

select the Color Selector button to select the color for the page.
7. Select OK.

The HTML Page Editor opens to format the layout/appearance of the HTML page.

Related concepts
Open the HTML Page Manager
Scope
Related tasks
HTML Page Editor
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Use HTML Pages
When working with HTML pages, users can create an external or internal HTML page.

To view an HTML page:

• Use the HTML Page Manager (for available HTML pages, based on security rights).

• From the CSM Browser Client menu bar, select Pages.

• From the CSM Portal menu bar (if configured).

Related concepts
Open the HTML Page Manager
Related tasks
Create an External HTML Page
Create an Internal HTML Page
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Image Manager
Use the Image Manager to complete general CSM Item Manager operations for images.

When you create a new image in the Image Manager, you import or link to an image located on your
computer or in a directory. To import/link multiple images simultaneously, select them from the appropriate
location and drag them into the Image Manager.

The Image Manager supports most image file types, including .gif, .ico, .jpg, and .png.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.
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4. Culture selector:

Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

5. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

6. Main Pane:

Displays items by view (icon, list, or details [grid]) and lists search results when a search is run.

Supported Image File Paths
The image paths can be used in Expressions.

• Imported: These images are found in the Image Manager under any scope other than the Built In
scope (example: [IMPORTED]Global;(None);John_Allard).

• PlugIn: These images are found in the Image Manager under any scope other than the Built In
scope (example: [PlugIn]Images;Trebuchet.Plugin.Images.Images.Public.Cherwell256.png).

• URL: These images are from URL paths. The URL must return a valid image file type (example:
[URL]https://az495088.vo.msecnd.net/app-logo/cherwell_215.png).

• File: These images are from file paths. These include both paths local to the machine or network
shares. The user account running the application must have access to the image path (example:
[FILE]C:\Images\CSM.png).

• Theme: These images are from the current theme (example: [Theme]CornerGraphic).

Related concepts
CSM Item Manager Main Window (Typical)
Scope
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Item Managers
CSM Item Managers help manage (view, create, edit, organize, or delete) CSM Items such as Dashboards,
Saved Searches, and One-Step™ Actions.
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About CSM Item Managers
Some CSM Item Managers can be accessed from multiple places; Browser Client Managers may have
limited functionality.

CSM Manager Accessibility

CSM Item Manager Desktop Client CSM Administrator Browser Client

Action Manager  

Action Block Manager

Adaptive Layout Presets
*

Attachment Manager  

Automation Processes Manager   

Business Hours Manager  

Calendar Manager
* **

Canonical Definitions
*

Color Palette Editor

Command Manager  

Contact Manager

Counter Manager
*

 

Dashboard Manager
*

Database Server Objects
Manager  

*
 

Document Repository Manager
*
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E-mail and Event Monitoring
*

Expression Manager
*

 

External Connection Manager  
*

 

Format Manager  
*

 

Group Map Manager  
*

 

HTML Page Manager

Image Manager
*

Knowledge Mapping & Sources
Manager  

*
 

Metric Manager
*

 

Language Packs Manager
*

Locked Strings Manager
*

One-Step Action Manager
*

Prompts Manager

Queue Manager  

Report Manager  

Role Manager   

Scheduled Items Manager
*

Search Manager
*
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Site Manager  
*

 

Stored Imports Manager
*

Stored Value Manager
*

 

Teams Manager
*

Team and Workgroup Manager  
*

 

Theme Manager
* **

Twitter Account Manager  

User Manager   

Visualization Manager
*

Web Services Manager
*

Webhooks Manager
*

Widget Manager
*

 

* Note: Some Managers are accessed through the Managers menu in a Blueprint in CSM
Administrator. Some Managers are also available when you are creating a mApp Solution.

**Note: View only.

E-mail and Event Monitoring provides the following CSM Item Managers:

• E-mail and Event Monitoring Manager

• Outlook Integration Manager
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CSM Item Manager Main Window (Typical)
Most CSM Item Managers look and behave similarly, although a few exhibit minute differences.

Note: For more information about specific CSM Managers (example: Dashboard Manager, One-
Step Action Manager, Calendar Manager, etc.), please refer to their individual documentation.

In general, use CSM Item Managers to complete the following operations:

• Run/Display: Run/display the selected item (example: Runs the selected Saved Search, One-
Step™ Action, or Report; displays a Dashboard, Widget, or Calendar).

• View/Display: View a list of available items. Double-click an item to display it in the main window.

• Create, Edit , and Delete: Configure items to meet your requirements.

• Search: Use the Search Control to run a search that locates and lists all items whose Display Name
and Description contain a specific word or phrase.

• Organize: Items are organized at the root level by default scope (intended audience); however,
Users can create subfolders to further organize items.

• Copy: Copy existing items as a starting point or template for a similar item.

• Rename: Rename a subfolder or item. Users cannot rename default scopes.

• Import/Export: Import/export item definitions to a .ced file to share items across systems.

• Find Dependencies: Identify where the item is used and what other items it uses, if applicable.

• Add To Task Pane/Toolbar (available only in appropriate CSM Item Managers): Use to add the•
item to your personal Task Pane or a custom toolbar.

• Pin (available only in appropriate CSM Item Managers): Pin items to a Pinboard (in the Item
Manager) and MRU list (in the CSM Desktop Client menu bar) to make them easily accessible in
CSM.

Note: The pinning functionality allows Users to pin frequently used items to locations that
are easily accessible in CSM. For more information, see Pin a CSM Item.

• Localize: View and set localization properties (in CSM Administrator only).
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1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Culture selector:

Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

5. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.
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6. Main Pane:

Displays items by view (icon, list, or details [grid]) and lists search results when a search is run.

Note:

Managers look and behave differently in the Browser Client. For more information, refer to
the Browser Client documentation.
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CSM Item Manager Menu Bar (Typical)
File

Action Description

New Creates a new item.

Edit Edits the current selection.

Delete Deletes the current selection.

Rename Renames the current selection.

Import Imports the item definition from a saved Cherwell
Export Definition file (.ced).

Export Exports the current item to a Cherwell Export
Definition file (.ced).

Close Closes the Manager.

Edit

Action Description

Cut Moves the current selection to the clipboard, so you
can then paste it into a new location.

Copy
Creates a new item whose properties are the same
as the copied item. The new item can then be named
and customized.

Paste Inserts the cut or copied item from the clipboard.

Select All Selects all items in the current window.

Localization
Provides options for managing translated values for
items (CSM Administrator only). See Managing
Translations for Individual Definitions.

View

Action Description

Icon Displays items as icons.

List Lists items by Display Name.

Details Lists items in a detailed, sortable Grid (displays
Display Name, Description, Last Modified, etc.).
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Action Description

Show [Items] for...

Selects the scopes to display in the Manager tree.
By default, scopes are displayed for the User/Role
currently accessing the item, but Users can select to
display items for all Users, Roles, Teams, or
Customer Workgroups.

Refresh Refreshes the data.

Find Dependencies Displays other CSM Items using the selected item.

Help

Action Description

Help Opens the online help.

Contents Opens the online help.

Report Error Opens the Report Error window so you can report an
error to Cherwell.

CSM 2022.3 Features 874

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=scope


CSM Item Manager Toolbar (Typical)

Action Description

Create New Creates a new item.

Edit Edits the current selection.

Delete Deletes the current selection.

New Folder Create a new folder.

Parent Folder Navigates up to the parent folder.

View

Displays items as:

• Icon: Images.

• List: List of names (Display Name).

• Details: Detailed, sortable Grid (displays Display Name, Description, Last
Modified, etc.).

Note: Multiple CSM Items provide pinning functionality in the toolbar,

which is indicated by the Pin button . For more information, see
Pin a CSM Item.

Localization Opens localization options for specific items (CSM Administrator only).
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CSM Item Manager Search Control

Action Description

Search Displays the word or phrase to search for. The drop-
down displays the most recently used (MRU) searches.

Go
Runs the search. Search results are displayed in a Grid
(if they are of the same type) or a List (if they are of
different types).
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CSM Item Manager Tree
The CSM Item Manager tree displays items in a hierarchical format, organized by scope and subfolder (if
applicable). The Manager tree also lists any Searches run during the current session.

Using the CSM Item Manager tree, Users can:

• Sort through folders by clicking the Plus button to expand the folder list (if applicable).

• Open folders by clicking the desired folder once. Items in the folder display in the CSM Item
Manager Main Pane.

• Open the CSM Item Manager tree context (right-click) menu to delete, rename, or refresh folders in
the tree.

• Organize CSM Manager items.

Good to know:

• Multiple CSM Items provide pinning functionality in the Manager tree. For more information, see Pin
a CSM Item.

• The ability to organize CSM Items is configured through security rights. For more information, refer
to the Security Rights documentation.
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CSM Item Manager Tree Context Menu
From the CSM Item Manager Tree context (right-click) menu, Users can delete, rename, and refresh the
folders in the Item Manager tree.

Note: Delete and Rename option availability depend upon a User's security rights. For more
information, refer to the Security Rights documentation.

To open the Manager tree context menu:

1. Open a CSM Item Manager.

2. In the Manager tree, right-click a folder.

The context menu opens.

3. With the context menu open, Users can:
◦ Delete: Deletes the folder (with security rights). When selected, Users are prompted Yes

(Delete), No (Cancel).

◦ Rename: Renames the folder (with security rights).

◦ Refresh: Refreshes the folder with the most up-to-date items.
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CSM Item Manager Main Pane
The CSM Item Manager Main Pane displays items by View (Icon, List, or Details (Grid)) for a selected
scope. The Manager Main Pane also lists search results from any Searches run during the current
session.

Using the CSM Item Manager Main Pane, Users can:

• View, display, or run CSM Items.

• Open the CSM Item Manager Main Pane context (right-click) menu to perform a number of actions
with the selected item.
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CSM Item Manager Main Pane Context Menu
From the CSM Item Manager Main Pane context (right-click) menu, Users can perform a variety of tasks
for items displayed in the Main Pane. The context menus differ in available actions between CSM
Administrator and the CSM Desktop Client.

Left: CSM Administrator. Right: CSM Desktop Client.

To open the CSM Item Manager Main Pane context menu:

1. Open a CSM Item Manager.

2. In the Main Pane, right-click an item.

The context menu opens.

CSM Item Manager Main Pane Context Menu Actions

Action Description

New Creates a new item.

Edit Edits the current selection.

Delete Deletes the current selection.

New folder Creates a new folder.

Cut Moves the current selection to the clipboard, so you can then paste it into a new
location.
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Action Description

Copy Creates a new item whose properties are the same as the copied item. The new
item can then be named and customized.

Paste Inserts the cut or copied item from the clipboard.

Rename Renames the current selection.

Pin

Pins items to the Pinboard and MRU list for a specified scope:

• Pin for User ([User])

• Pin for Role ([User's Role])

• Pin for other Role

• Pin for all Users

Localization Opens localization options for a selected definition (CSM Administrator only).

Add to...

Adds the selected item to one of the following:

• Blueprint (CSM Administrator only).

• Task Pane.

• Toolbar.

Refresh Refreshes the data.

Find Dependencies Displays other CSM Items using the selected item.

Note: Multiple CSM Items provide pinning functionality in the context menu. For more information,
see Pin a CSM Item.
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CSM Item Managers Good to Know
Use these tips for helpful information on CSM Item Managers.

• Dependencies are important to note when editing or deleting items in CSM Item Managers. For
example, a Widget might be dependent on a specific Metric to show the correct data. Use the CSM
Item Manager to find dependencies between items (example: Dashboards, Reports, One-Step
Actions) in the CSM System. This process scans the CSM system to find everything that uses the
selected item. For more information, see Find CSM Item Dependencies.

• A copied item retains the same dependencies as its original. Be sure to find dependencies before
editing the item's copy.

• It is important to rename imported or exported items to ensure existing items are not overwritten.

• The ability to organize CSM Items is configured through security rights. For more information, see
Security Rights documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights and Configure CSM Item Manager Security Rights.
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Using CSM Item Managers
When working with CSM Item Managers, Users can perform many tasks, such as viewing and editing
items.

CSM 2022.3 Features 883

CSM 2022.3 Features



Open a CSM Item Manager
There are many ways to open CSM Item Managers in CSM:

• From the CSM Desktop Client menu bar (example: Dashboards>Dashboard Manager).

• From the Browser Client menu bar (example: Dashboards>Dashboard Manager or
Tools>Calendars>Calendar Manager).

• From the Blueprint Editor menu bar in CSM Administrator (example: Managers>[Item] Manager).

• From within the other Managers and Editors in CSM (example: Access the Dashboard Manager
from within the Site Manager).

• From various selectors throughout CSM (example: Click Tools>Options>Dashboards &
Calendars in the CSM Desktop Client).

Note: Managers look and behave differently in the CSM Browser Client.
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Search in a CSM Item Manager
Use the CSM Item Manager Search Control (upper-right corner of each Item Manager) to find items by
name or description.

Good to know:

• Press CTRL+F in an Item Manager to put focus on (jump the cursor to) the Search Control.

• Wildcards (*, %) can be used.

• The search includes the name and description of items. For certain Managers (notably Attachment
Manager), the contents of the item will also be searched.

• CSM searches the selected folder and its subfolders. (Typically, the selected folder is scope.)
Examples:

◦ If the root folder (Dashboards in the screenshot) is selected, all scopes and folders are
searched.

◦ If the Team folder is selected, the Team folder and its subfolders are searched.

◦ If a Global subfolder is selected, only that subfolder and its subfolders are searched.

Note: CSM searches only displayed folders (example: If you are not currently viewing
all roles, then all roles would not be searched.

• Search results are displayed in a sortable Grid (Details View) in the Item Manager Main pane (all
other View options are disabled).

• The Search Results Grid displays an additional column called Folder, which includes the scope and
folder (example: Global/Availability or User (Bob)/My Stuff).

• When a search result is selected:
◦ Run, Edit, Delete, and Clipboard drag/drop operations work. Any copy/paste within the folder

will maintain the same scope and folder as the original item.

◦ Add, New, and View buttons are disabled.

• A list of searches for the current session is displayed in the Item Manager Tree so Users can return
to the search at any time during the session.

• Changing the association or closing the Manager clears the current search. Users can also right-
click on the search folder and choose to remove search results.

To search in an Item Manager:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

Note: CSM searches a selected folder and its subfolders, so you can search all folders in
the tree by selecting the top folder, or you can limit the search to a specific folder.

3. Provide a word or phrase in the Search Control.
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Tip: Press CTRL+F to jump your cursor to the Item Manager's Search Control.

4. Click Go or press ENTER.

Search results are displayed in a Grid in the Main pane. A list of searches for the session is
displayed in the Item Manager Tree.

Tip: To sort the results, click the column header to sort: the Up arrow  sorts the column in
ascending order (example: 1-10, A-Z, etc.); the Down arrow  sorts the column in
descending order (example: 10-1, Z-A, etc.).
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View a CSM Item
Use CSM Item Managers to view CSM Items. All available items are displayed in the Manager Main
Pane; however, items can be viewed by scope and subfolder as well. Additionally, the view of the Item
Manager can be changed to display items in different ways: by icon, in a list, or in a detailed grid.

To view CSM Items in the CSM Item Managers:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

Available items display in the Main Pane.
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View Items by Scope
In addition to viewing items by Icon, List, or Details, Users can also change the items they view in the Item
Managers by scope depending upon their security rights and security groups.

For example, Henri is both a Technician and a Service Desk Manager. Initially, he may only be able to
view items based on his Role as a Technician. By selecting to view items in the Item Managers for all his
Roles, Henri can then see items allocated to his Role as a Service Desk Manager as well as a Technician.

To change the view of items in the Item Managers by scope:

1. Open a CSM Item Manager.

2. In the menu bar, click View, and then select from the following options.

Action Description

Show [Items] for all my Roles Displays items for all Roles the current User belongs to
(example: Technician and Service Desk Manager).

Show [Items] for all Roles Displays items for all Roles.

Show [Items] for all Users Displays items for all Users.

Show [Items] for all Teams Displays items for all Teams.

Show [Items] for Customer Workgroups Displays items for Customer Workgroups.
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Change the View of the CSM Item Manager
Within the CSM Item Managers, there are different ways to view CSM Items. Users can view items in the
Manager by:

1. Icon

2. List

3. Details

Good to know:

• In Details view, Users can sort a CSM Manager Grid column in ascending (A-Z) or descending (Z-A)
order.

Sort a CSM Item Manager Grid by column in ascending (A-Z) or descending order (Z-A).

To sort a CSM Manager Grid column:

1. Open the CSM Item Manager.

2. Set the View to Details (View>Details).

3. Click the column header to sort by:
◦ Up arrow  : Sorts the column in ascending order (example: 1-10, A-Z, etc.).

◦ Down arrow  Sorts the column in descending order (example: 10-1, Z-A, etc.).

To change the view of the CSM Item Manager:

1. Open a CSM Item Manager.

2. Click the View button on the toolbar.

3. Select from the following:
◦ Icon: Displays items in the Manager with a large icon and the name of the item below.

◦ List: Displays items in the Manager with small icons and the name of the item immediately to
the side in a list.

◦ Details: Displays items in the Manager with small icons and the details of the item in a Grid.
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Sort a CSM Item Manager Grid Column
Sort a CSM Item Manager Grid by column in ascending (A-Z) or descending order (Z-A).

To sort a CSM Manager Grid column:

1. Open a CSM Item Manager.

2. Set the View to Details (View>Details).

3. Click the column header to sort by:
◦ Up arrow: Sorts the column in ascending order (example: 1-10, A-Z, etc.).

◦ Down arrow: Sorts the column in descending order (example: 10-1, Z-A, etc.).
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Display/Run a CSM Item
Use the CSM Item Managers to display or run CSM Items. Items are viewed in the Manager Main window.
Users can display or run an item by double-clicking it.

Good to know:

• For Run items, Users can also click the Run button at the bottom of the window.

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

To display/run a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Double-click theCSM Item to display/run.
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Create a CSM Item
Use the CSM Item Managers to create the different CSM Items (example: Dashboard, Report, etc.) in the
CSM system. Typically, the Manager launches a Property window to define the properties/behaviors for
the item.

Good to know:

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

To create a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. The following actions are available:
◦ Click the Create New button .

◦ In the CSM Item Manager window, right-click>New.

◦ From the CSM Item Manager menu bar, select File>New.

The item's Property page or Editor opens to create a definition.

4. Save changes.
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Edit a CSM Item
Use the CSM Item Manager to edit existing CSM Items (example: Dashboards, Reports, One-Step
Actions etc.). Edit CSM Items when information needs to be updated (example: Adding a new Field to a
Report) or changed (example: Changing the text in an e-mail One-Step Action).

Good to know:

• Editing items does not affect past versions (example: Adding a new Field to a Report only adds the
Field for present and future Reports). However, dependencies between CSM Items might be
affected when editing items.

For example, a Widget might be dependent on a specific Metric in order to show the correct data.
Editing the Metric to display a different set of data could result in incorrect data displaying or a
broken Widget.

• Dependencies are important to note when editing or deleting items in CSM Item Managers. Select
Dependencies to scan CSM for everything that uses the item.

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

To edit a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Select the CSM Item to edit, and then do one of the following:
◦ In the CSM Item Manager toolbar, select Edit.
◦ From the CSM Item Manager window, right-click > Edit.
◦ Select the Edit tab in the CSM Item Manager menu bar.

The item's Property page or Editor opens so that you can make changes.

4. Save the changes by selecting Save or Save As.

CSM 2022.3 Features 893

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=browser_client


Delete a CSM Item
Use the CSM Item Managers to delete CSM Items (example: Dashboards, Reports, etc.). For example,
you might want to delete obsolete Searches or Dashboards that are no longer used.

Good to know:

• Deleting items in the CSM Item Managers does not delete the items associated with them (example:
Widgets associated with Dashboards). However, there may be dependencies between CSM Items
that can be affected when deleting items.

• Dependencies are important to note when editing or deleting items in CSM Item Managers. Click the
Dependencies button to scan CSM for everything that uses the item.

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

To delete a CSM Item:

1. Open the CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Click the CSM Item to delete, and then select one of the following:

◦ Click the Delete  button.

◦ From the CSM Item Manager window, right-click>Delete.

◦ From the CSM Item Manager menu bar, select File>Delete.

4. Click Yes to confirm the deletion.
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Copy a CSM Item
Use the CSM Item Managers to copy and paste existing CSM Items (example: Dashboard, Report, One-
Step Actions etc.) to use as a starting point or a template for another CSM Item.

Good to know:

• A copied item retains the same dependencies as its original. Be sure to find dependencies before
editing the item's copy.

• A copied item is named Copy of... by default. Rename copied items to avoid confusion between the
original and the copied item.

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

Note: Editing an item, making changes and selecting Save As copies and edits an item in one
action.

To copy a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Select the CSM Item to copy, and then select one of the following:
◦ In the CSM Item Manager window, right-click > Copy.

◦ From the CSM Item Manager menu bar, select Edit > Copy.

4. Paste the item using one of the following:
◦ In the CSM Item Manager window, right-click > Paste.

◦ From the CSM Item Manager menu bar, select Edit > Paste.

5. (Optional but recommended) Rename the copied item.

Note: Alternatively, in the CSM Item Manager window, right-click > Edit, and then select Save
As when you have made changes and want to save your edited copy.
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Import/Export a CSM Item
Use the CSM Item Managers to import/export items (example: Dashboards, Reports, etc.) as .ced files
across CSM systems.

Good to know:

• It is important to rename imported or exported items to ensure existing items are not overwritten.

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

To export a CSM Item:

1. Open the CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Click the CSM Item to export.

4. From the CSM Item Manager menu bar, select File>Export.

The Export To window opens.

5. Provide a filename and location to export the item as a .ced file.

6. Click Save.

To import a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. From the CSM Item Manager menu bar, select File>Import.

The Import From window opens.

4. Locate a .ced file to import, and then click Open.
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Organize CSM Manager Items
Use the CSM Item Manager tree and Main Pane to organize CSM Items (example: Dashboards, Reports,
One-Step Actions etc.). Items are organized at the root level by scope (intended audience) and can be
further organized by subfolders. CSM Items in the Managers can be organized within folders by purpose
(example: Portal Dashboards), theme (example: Executive Dashboards), or any categorization that suits
company needs.

Good to know:

• The ability to organize CSM Items is configured through security rights. For more information, refer
to the Security Rights documentation.

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

To create a subfolder to organize CSM Items:

1. Open a CSM Item Manager.

2. Place your cursor in the scope or subfolder where you want to create the folder.

3. Click the Create a New Folder button.

A new folder is created, with the pending name highlighted.

4. Provide a name for the folder, and then click away from the folder to save the name.

5. Users can now:
◦ Drag-and-drop CSM Items into the folder.

◦ Rename the folder by right-clicking the folder and selecting Rename.
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Find CSM Item Dependencies
In CSM, a dependency is the bond of an item in the system that uses or relies upon another item to
function. For example, a Widget might be dependent on a specific Metric in order to show the correct
data. Use the CSM Item Manager to find dependencies between items (example: Dashboards, Reports,
One-Step Actions, etc.) in the CSM System. This process scans the CSM system to find everything that
uses the selected item.

Good to know:

• Dependencies are important to note when editing or deleting items in CSM Item Managers.

• The Find Dependencies option can be found in the View menu from the CSM Item Manager menu
bar, as well as the context (right-click) menu in the Manager Main Pane.

• Managers look and behave differently in the Browser Client. For more information, refer to the•
Browser Client documentation.

To find CSM Item dependencies:

1. Open the CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Run the dependencies scan one of two ways:
◦ Right-click the CSM Item, and then select Find Dependencies.

◦ Select the CSM Item, and then select View (menu bar)>Find dependencies.

A scan runs and results are displayed in the Definition Dependencies window.

4. (Optional) Click the Edit button to change the scope selected for the dependencies scan.

The Scopes used for Dependency Scan window opens.

5. Select the scopes to include, and then click OK.

6. Click the Refresh button to scan for dependencies using the new scope.

Note: Select the Show full path check box to show the full path of the scan. This is useful
when copying or deleting items to ensure dependent items are not affected by changes
made to the selected item.
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Add a CSM Item to the Task Pane or Toolbar,
Toolbar, or Blueprint

Some CSM Item Managers support adding a CSM Item to a personal Task Pane or a custom toolbar
directly from the CSM Item Manager (example: in the Dashboard Manager, add a Dashboard to your
toolbar). Some CSM Item Managers also support adding a CSM Item to a Blueprint from an Item Manager
opened in CSM Administrator. The following CSM Item Managers support adding items to the Task Pane/
toolbar:

• Dashboard Manager

• Search Manager

• One-Step Action Manager

• Visualization Manager

• Calendar Manager

• Report Manager

Note: This feature is not available when accessing the CSM Item Managers from CSM
Administrator. Items cannot be added to Blueprints in the CSM Desktop Client.

To add a CSM Item to the Task Pane/toolbar:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Right-click the CSMItem to add to the Task Pane/toolbar, and then select Add To>:
◦ Task Pane: Adds the item to your Task Pane (in the Common Tasks area).

◦ Toolbar: Adds the item to a custom toolbar. Select an existing toolbar or create a new one.

Note: This option is also available from the File menu (File>Add To).

◦ Blueprint: Adds the item to a Blueprint. This option is only available in CSM Administrator.

4. Select OK.4.
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Pin a CSM Item
Use CSM Item Managers to pin frequently used items to locations that are easily accessible in CSM.
When a CSM Item is pinned, a pin icon displays on the selected item, and the pin is added to the
Pinboard (in the CSM Item Manager tree) and MRU list (in the CSM Desktop Client menu bar, if
applicable).

Pinning is available for the following CSM Items:

• Attachments

• Actions

• Business Hours

• Calendars

• Commands

• Counters

• Dashboards

• Document Repositories

• E-mail and Event Monitors

• Expressions

• HTML Pages

• Knowledge Sources

• One-Step Actions

• Queues

• Reports

• Saved Searches

• Stored Values

• Themes

• Visualizations

Good to know:

• Pin and unpin CSM Items in CSM Item Managers using the CSM Item Manager toolbar or context
menu.

• The number of items that can be pinned to the Pinboard and viewed in the MRU list at one time is
defined in the Cherwell Service Management Options window (Tools>Options>General Options
page>MRU (Most Recently Used) Items section).

• The scope of a CSM Item is identified by a pin icon:

◦ Pins that are visible for the current User are identified by a blue pin icon .

◦ Pins that are visible for the current User's Role are identified by a red pin icon .
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◦ Pins that are visible for an alternate Role of the current User are identified by a red pin icon

.

◦ Pins that are visible to all Users are identified by a green pin icon .

◦ Pins that are visible for multiple scopes are identified by a purple pin icon .

• When a CSM Item is pinned, a pin icon displays on the selected item, and the pin is added to the
Pinboard and MRU list.

• Pinned items display above MRU items in the MRU list and are indicated by a purple pin icon .

• Locate the original scope of a pinned item by right-clicking the item and selecting Pinning>Go to
Item.

• Organize pinned items in the Pinboard folder by using the Up and Down buttons on the CSM Item
Manager toolbar or by right-clicking the item and selecting Pinning>Move Up or Move Down. Users
can also drag-and-drop items to a new location within the same scope. Items in the MRU list display
in this order.

• Managers look and behave differently in the Cherwell Browser Client. For more information, refer to
the Cherwell Browser Client documentation.

• The ability to pin CSM Items is configured through security rights. For more information, refer to the
Security Rights documentation.

To pin a CSM Item:

1. Open a CSM Item Manager.

2. In the CSM Item Manager toolbar, click the down arrow on the Pin button.

3. Select Pinning from the drop-down, and then select a scope for the pin:
◦ Pin for User ([User]): Pin is visible in the current User's Pinboard folder and in the current

User's MRU lists.

◦ Pin for Role ([User's Role]): Pin is visible in the current User's Pinboard folder and in the
current User's MRU lists for the Role that the User is currently using. It is also visible to other
Users who are using the Role.

◦ Pin for other Role: Pin is visible in the current User's Pinboard folder and in the current User's
MRU lists for a Role that the User has, but is not currently using. It is also visible to other
Users who are using the Role.

◦ Pin for all Users: Pin is visible in Pinboard folders and MRU lists for all CSM Users.

A pin icon displays on the selected item, and the pin is added to the Pinboard and MRU list.

4. Users can now:
◦ View pinned items in the Pinboard folder.

◦ View pinned items in the MRU list, if applicable.
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Configuring CSM Item Managers
To configure Item Managers in CSM Administrator, configure Managers security rights.
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Knowledge Management
CSM Knowledge Management provides a powerful Knowledge Base so that users can find relevant
information quickly with or without the use of outside resources. Depending on the configuration of your
system, users might also have access to Knowledge through a CSM Portal that allows them to
independently solve issues.
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About Knowledge Management
CSM Knowledge Management has multiple features, including Knowledge Sources, Mapping, Importing,
Searching, and Security. Knowledge can come from many different sources, including Knowledge Articles
(KAs), other Business Object records, attachments, and web sites.

Knowledge Management Features

• Knowledge Sources: Use multiple sources, including Knowledge-IT (Knowledge Articles), other
Business Object records, attachments, and web sites. Manage your sources using the Knowledge
Source Manager.

• Knowledge Mapping: Use Knowledge Mapping to control which Knowledge Sources should be
used, when they should be used, and how to use appropriate solutions.

• Knowledge Import: Import Knowledge from third-party knowledge providers.

• Searching: Search for Knowledge using the CSM Desktop Client Knowledge Pane, Search Control,
or Quick Search pane to access Knowledge Sources to troubleshoot and find solutions. Search from
within CSM, a CSM record, or the Portal.

• Security: Secure Knowledge by controlling who can log, approve, publish, and access Knowledge.
Use the built-in Knowledge Team to allow access to the Knowledge Management dashboard and to
allow security rights to review/approve/publish KAs.

Knowledge Sources

• Knowledge Articles (KAs): In CSM Administrator, this Group Object holds Knowledge Base
entries, including the Knowledge-IT Business Object. See Knowledge Article Workflow for specific
information on the process for creating, reviewing, publishing, and managing KAs. KAs can also be
imported from third-party Knowledge providers.

◦ Knowledge-IT: Use this specific Business Object to create and share Knowledge Articles with
users and customers.

• Other Business Object records: Closed Incidents or Problems (Known Errors), or any other
appropriate Business Object records.

• Attachments: Imported internal or external documentation. The search returns results that match
the text within .txt, .doc, and .xls files and any file type with a matching file name.

• Web: Adobe®, Google®, Microsoft TechNet®, Twitter®, Yahoo!®, YouTube®, etc.

Knowledge Searching
Use the following tools to search Knowledge sources. Results display in order of relevancy ranking. This
means the records most likely to be relevant to your search string display at the top of the results by
default.

1. Quick Search Widget: Use to search only KAs (or other Business Objects).

2. Knowledge Pane: Use to search all Knowledge sources. You can search in general or while on a
Business Object record (if configured). Searchable Knowledge sources and searching options vary
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by Business Object so that the Knowledge search is always appropriate (controlled by your system
administrator through Knowledge Mapping).

In the CSM Portal, users can search for KAs using a configured search or the Knowledge Article
dashboard. When in a KA in the CSM Portal, users can vote on KA popularity by selecting Like/Dislike,
increment usage counts by selecting Yes/No concerning whether or not the KA resolved their issue, and
add feedback by selecting the Add Comment link.

Related concepts
Knowledge Management
Manage Knowledge Sources
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge

CSM 2022.3 Features 905

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fknowledge%2Fknowledge.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fknowledge%2Fmanaging_knowledge_sources.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fabout_knowledge_articles.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fknowledge_article_workflow.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fknowledge%2Fknowledge_article_features_and_capabilities.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fit_knowledge_manager_dashboard.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fknowledge_article_features.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fknowledge_article_form.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fknowledge_article_journals.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fknowledge_article_one-steps.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fshared%2Fknowledge_team.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fknowledge%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fknowledge%2Fsearch_knowledge.html


Related tasks
Configure Knowledge Security Group Permissions
Create a New Knowledge Article
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Knowledge Articles
Knowledge Articles (KAs) are created, reviewed, published, updated, commented on, voted on, and
retired using the Knowledge-IT forms.

Knowledge Article types:

• How To (example: "How to print a section of a Microsoft Excel Worksheet")

• Policy/Procedure (example: "Approval Procedure for Paid Time Off")

• Question and Answer (example: "How do I correct a printer error?")

• Solution: (example: "Understanding Error Messages")

In the KA workflow, specific Knowledge Management teams are responsible for reviewing, approving, and
managing KAs to ensure quality.

Related concepts
Knowledge Article Workflow
Knowledge Management Teams
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Knowledge Article Workflow
CSM uses several features to manage the Knowledge Article (KA) workflow: the Knowledge-IT forms help
create, manage, track, and use KAs, One-Step Actions help move the KA through its workflow,
Automation Processes notify stakeholders via emails, and a Knowledge Management dashboard notifies
stakeholders and tracks analytics.

The following diagram shows the high-level KA workflow. See the Knowledge Article Workflow One-Step
Actions for specific information about each phase of the workflow.

1

After logging/submitting the KA, the creator records the necessary details including the Article Type,
Service, and Category. Some fields, such as Article Type, are mandatory.

Completing certain details automatically completes other fields. For example, completing the
Category also completes the Technical Review Team and Format Review Team options.

Note: If you select the Visible on Customer Portal check box, the KA workflow will include
a formatting review. Leaving the check box cleared skips the formatting review and
publishes the KA.

2

When the creator selects Next:

• The Submit For Review One-Step Action runs.

• The status of the KA is changed to Technical Review.

• An email is sent to the ITKM Technical Review team.

• The KA is read-only and can only be edited by the ITKM Technical Review team.

• The KA is displayed on the IT Knowledge Manager dashboard.
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3

When the Technical Review team member reviews the KA for technical accuracy and selects Next:

• The Technical Review Complete One-Step Action takes place.

• If the Visible on Customer Portal check box is:

◦ Selected, the status of the KA is changed to Formatting Review.◦

An email is sent to the ITKM Formatting Review team.

The KA is read-only and can only be edited by the ITKM Formatting Review team.

◦ Cleared, the status of the KA is changed to Published.

4

When the Formatting Review team member reviews the KA and selects Next:

• The Formatting Review Complete One-Step Action runs.

• The status of the KA is changed to Published.

• The KA is published to the Knowledge Base (using the Business Process engine) in read-only
view.

• A review date for the KA is scheduled for one year in the future. You can set this date manually
on the form.

The KA can now be accessed (by users in CSM and customers in CSM Portal). To simplify the form
for reading, the Overview form is hidden.

5

The Knowledge team periodically review existing Knowledge Articles. The KA is either:

• Left in its existing published status.

• Reviewed, in which case the KA returns to the Technical Review status and the workflow is
repeated. Multiple One-Step Action options are available to change the status of the KA.

• Retired (see below for details).

6

The Knowledge Team periodically retire existing Knowledge Articles.

• The status of the KA is changed to Retired.

• The KA is removed from the Knowledge Base.

Note: A KA can be removed from retirement and sent back to the Technical Review status
and the workflow is repeated.

Note: Knowledge teams can send KA back for update/revise/rework anytime after it is submitted
for review. When reviewed again, updated, or revised, One-Step Action prompts for a Knowledge
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team reviewer and then changes the status back to Technical Review. When sent for rework, a
One-Step Action changes the status to Rejected.

Workflow Contributor Roles
A KA typically involves the following contributor roles. Depending on your workflow and the size of your
organization, some of these roles might be handled by the same individual:

• Creator: User who first logs the KA.

• Technical Review Team: A member of the ITKM Technical Review team (for more information, see
Knowledge Management Teams) reviews the KA for technical accuracy.

• Format Review Team: If Visible on Customer Portal is selected, a member of the Format Review
team (for more information, see Knowledge Management Teams) reviews the formatting of the KA.

• Consumer: User or customer who searches for and uses the KA.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Related tasks
Create a New Knowledge Article
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Knowledge Article Features and Capabilities
CSM Knowledge Articles (KAs) have numerous features and capabilities.

• Business Object: Under the Knowledge Article Group Business Object, use the dedicated
Knowledge-IT Business Object to create and manage KAs.

• Workflow: Use the default Knowledge Article Workflow to move a KA from Draft to Retired.

• Forms: Use the default Knowledge-IT Forms to log, manage, track, and use KAs. The forms display
important, at-a-glance information, such as KA ID, Status bar (current and next status), and record
ownership. Prior to publishing, use the form fields for the tab selected to create the KA. Once
published, the KA appears in a more streamlined format for easier reading. On the right, Article
Stats and an Actions list display.

• One-Step Actions: The default Knowledge Article One-Step Actions assist in the automation of the
Knowledge Article workflow.

• Teams: The default Knowledge Management Teams review and publish KAs using the IT
Knowledge Manager Dashboard.

• Dashboards: Knowledge Management Teams use the default IT Knowledge Manager Dashboard
to manage the KA workflow.

• Quick Search: Quickly locate all KAs by running a quick search, or search for a particular KA or set
of KAs by refining the search criteria to a word/phrase, timeframe, status, etc. Use search group to
save/run commonly-run searches.

• Saved Searches: Use saved searches to quickly locate/filter KAs, or to automate searching on
dashboards.

• Security: Secure KAs by controlling who can view, create, edit, and delete records.

• Creation flexibility: Log a KA manually or from an Incident/Problem.

• Linked records: Link child records to a parent KA record to keep supporting information at your
fingertips and to ensure data relationships. Linked child records are displayed in the KA form
arrangement.

• History and Revision tracking: Use linked Journals to track important status and field changes.

• User and Customer comment tracking: Use linked Journals to track user and customer
comments.

• Email correspondence tracking: Use linked Journals to track email correspondence.

• Popularity and usage counts: Use voting on KA forms in CSM and in the CSM Portal to track
popularity and usage. View statistics on the KA forms and IT Knowledge Manager dashboard.

• Rich Text: Use rich text to complement your content by adding formatting and images/screenshots.

• Automated review cycle: Use Review Date to schedule KA reviews. By default, reviews are
automatically scheduled one year from the publish date. This date can be manually modified, as
needed.

• Retirement: Retire out-of date KAs.

• Automation Processes: Use Automation Processes to automatically publish KAs and send
notification emails.
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Related concepts
Knowledge Management
About Knowledge Management
Knowledge Source Manager
Knowledge Mapping
Import Knowledge
Knowledge Articles
Knowledge Article Workflow
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge
About Quick Search
About Saved Searches
Record Ownership
About Actions
About One-Step Actions
About Reporting
Knowledge Article Workflow Design Ideas
Related tasks
Create a New Knowledge Article
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Create a New Knowledge Article
This procedure walks you through the typical steps to create a new Knowledge Article (KA).

To create a new KA:

1. In the CSM Desktop Client or CSM Browser Client, select File > New > New Knowledge-IT.
A new KA record is logged with a unique ID and a status of Draft.

2. Complete the fields on the Overview tab. See Knowledge-IT Forms.
3. Select Save to save the information. If you select Cancel, your KA will not be saved.
4. Once you are done creating a draft KA, select Next: Technical Review.The KA status changes to

Technical Review.
5. The default Knowledge Article workflow automatically routes the form through the appropriate

phases for review and publishing. See Knowledge Article Workflow One-Step Actions for specific
information about each phase of the workflow.

Related concepts
Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities

CSM 2022.3 Features 913

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=knowledge_article_form
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=knowledge_article_one-steps
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2F..%2Fcontent%2Fsuite_features%2Fknowledge%2Fknowledge.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2F..%2Fcontent%2Fshared%2Fabout_knowledge_articles.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2F..%2Fcontent%2Fshared%2Fknowledge_article_workflow.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fshared%2F..%2F..%2Fcontent%2Fsuite_features%2Fknowledge%2Fknowledge_article_features_and_capabilities.html


IT Knowledge Manager Dashboard
CSM provides an IT Knowledge Manager dashboard to help manage the Knowledge Article (KA)
workflow.

By default, the IT Knowledge Manager dashboard is available to members of the Knowledge teams to
help them manage the KA workflow. This dashboard is in the Dashboard Manager in the Global >
Knowledge Management folder as Knowledge IT.

The following table describes the items on the dashboard.

Widget
Display Name Description Widget

Type Widget Name Widget Uses:

Articles used
as Solutions in
Portal

Number of KAs used
as solutions on the
CSM Portal (Status =
Published).

Text
Gauge

Articles used
as solutions in
CSM Portal

Custom Query:

Knowledge Articles where all of the
following are true:

Knowledge Article status equals
Published

and Knowledge Article. Knowledge
Portal Usage Count is greater than
0
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Widget
Display Name Description Widget

Type Widget Name Widget Uses:

Articles used
as Solutions

Number of KAs used
as solutions (Status
= Published).

Text
Gauge

Articles used
as solutions

Custom Query:

Knowledge Articles where all of the
following are true:

Knowledge Article.Status equals
Published

and Knowledge Article.Knowledge
Usage Count is greater than 0

Articles with
Likes

Number of KAs with
one or more Likes
(Status = Published).

Text
Gauge

IT Articles
With Likes

Custom Query:

Knowledge Articles where all of the
following are true:

Knowledge Article.Status equals
Published

and Knowledge Article.Like Count
is greater than 0

Articles with
Dislikes

Number of KAs with
one or more Dislikes
(Status = Published).

Text
Gauge

IT Articles
With Dislikes

Custom Query:

Knowledge Articles where all of the
following are true:

Knowledge Article.Status equals
Published

and Knowledge Article.Dislike
Count is greater than 0

Published IT
Knowledge
Articles

List of published KAs
in descending order
using the Knowledge
Manager grid (Status
= Published).

Search
Results
List

Published IT
Articles

Stored Query: Published Articles

Knowledge Articles where all of the
following are true:

Knowledge Article.Status equals
Published
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Widget
Display Name Description Widget

Type Widget Name Widget Uses:

Unpublished
IT Knowledge
Articles

List of unpublished
KAs in descending
order using the
Knowledge
dashboard grid.

Search
Results
List

Unpublished
IT Articles

Stored Query: Unpublished IT
Articles

Knowledge Articles where all of the
following are true:

Knowledge Article.Status is not
equal to Published

and Knowledge Article.Status is
not equal to Retired

and Knowledge Article.Status is
not equal to Rejected

IT Articles
Ready for
Review

List of published KAs
in descending order
using the Knowledge
for Review grid with
a review date less
than or equal to two
weeks from current
day (Status =
Published).

Search
Results
List

IT Articles
Ready for
Review

Custom Query:

Knowledge Articles where all of the
following are true:

Knowledge Article Status equals
Published

and Knowledge Article review date
is less than or equal to Two weeks
from Today expression

Unpublished
IT Knowledge
By Status

Doughnut chart of
the number of
unpublished KAs
displayed by color
with size of slices
based on the number
of records per status
that DOES NOT
equal Published,
Retired, or Rejected.

Chart
Unpublished
IT Knowledge
by Status

Stored Query: Unpublished IT
Articles

Knowledge Articles where all of the
following are true:

Knowledge Article.Status is not
equal to Published

and Knowledge Article.Status is
not equal to Retired

and Knowledge Article.Status is
not equal to Rejected

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Article Workflow
Knowledge Article Features and Capabilities
Knowledge Article Workflow Features
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Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge
Related tasks
Create a New Knowledge Article
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Knowledge Article Workflow Features
CSM uses several features to manage the Knowledge Article Workflow: Knowledge_IT forms, Journals,
One-Step Actions, Automation Processes, IT Knowledge Manager dashboard, saved searches, and
Knowledge Management security.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Article Workflow
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge
Related tasks
Create a New Knowledge Article
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Knowledge-IT Forms
All of the following are Knowledge-IT forms: Knowledge Article, Knowledge Article Overview, Knowledge
Article Read Only View, and Knowledge Article Summary.

Overview
In the CSM Desktop Client and CSM Browser Client, the Knowledge Article and Knowledge Article
Overview forms display in the Overview tab when creating a new KA. There are five main sections
displayed:

1. Knowledge Article Form: Displays important at-a-glance information at the top of the window,
including Knowledge ID, status, next step in the Knowledge Article Workflow, publish date, review
date, and assigned to owner and/or Knowledge team.

2. Form Arrangement Tabs: Dynamically displays a tabbed collection of child forms and records that
are in a relationship with the parent form.

3. Form Fields: This section of the window displays the form fields for the selected tab. The Overview
tab contains the Knowledge Article Overview form for creating a new Knowledge Article. Once the
form is in Published status, the Overview tab disappears and the Knowledge Article Read-Only
View form displays in the Article tab.

4. Article Stats (part of Knowledge Article Overview form): Displays statistics for the current KA.

5. Actions List (part of Knowledge Article Overview form): Dynamically displays a list of actions that
are available for the current KA.

Note: For more information, see Knowledge Article Workflow One-Step Actions.
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Knowledge Article Form
The Knowledge Article form displays important at-a-glance information at the top of the window, including
Knowledge ID, status, next step in the KA workflow, publish date, review date, and who it is assigned to.

The following table describes the fields on the Knowledge Article form.

* Required field

Field Description Comments

Knowledge
[ID] Unique record identifier (example: 10380) for the KA.

CSM automatically
assigns the ID when
the KA is created.

Status: Draft

Creator logs a new KA or modifies an existing one, adding as
much information as possible to the form. When the article is
ready for review, the creator selects Next: Technical Review.
One-Step Action changes status to Technical Review. Email is
sent to ITKM Technical Review Team. KA appears on Knowledge
Management dashboard. KA becomes read-only and is editable
only by the ITKM Technical Review team.

 

Status:
Technical
Review

ITKM Technical Review Team member reviews the KA for
technical accuracy and approves the KA by selecting Next:
Technical Review Complete.
If Visible on Customer Portal is NOT selected on the form,
One-Step Action changes status to Published.

If Visible on Customer Portal is selected on the form, One-Step
Action changes status to Formatting Review. An email is sent to
Format Review team. KA becomes read-only and is editable only
by the Format Review team.

Status:
Formatting
Review

If Visible on Customer Portal is selected on the form, a
member of the Format Review team reviews KA and approves it
by selecting Next: Formatting Review Complete. A One-Step
Action changes status to Published.

Status:
Published

If the Technical Review team (and Formatting Review team if
visible on CSM Portall) have completed review, One-Step Action
changes status to Published. The KA is published to the
Knowledge Base (using the Business Process engine) in read-
only view. Consumer accesses KA (user in CSM and customer in
CSM Portal). To simplify the form for reading, the Overview form
is hidden from view. One-Step Action schedules a review date in
one year. This date can also be manually set on the form.

Publish Date The date the KA was last published.

CSM automatically
fills in the date the
KA was last
published.

Review Date The next scheduled review date. This autofills with the date one
year from the publish date. This field can be modified.

CSM automatically
fills in one year from
the publish date.
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Field Description Comments

Assigned To Name of the individual user and team currently working on the
KA.

CSM automatically
fills in the user and
team names. 

Knowledge Article Overview Form
In the CSM Desktop Client and CSM Browser Client, the Knowledge Article Overview form displays in the
Overview tab when creating a new KA.

The following table describes the fields on the Knowledge Article Overview form.

Field Description Comments

*Article Type

Type of KA:

• How To

• Policy/Procedure

• Question and Answer

• Solution Article

*Required.

*Service

Service that the KA relates to:

• Account Management

• Conferencing/
Presentation

• Desktop Management

• Email/Calendaring

• Employee Support

• Enterprise Apps

• IT Service Desk

• Network Services

• Printing

• Telephony/Fax

• Web Services

*Required.

Autofills when created from an Incident or Problem.

See the table in Knowledge Management Teams for a
list of teams and how they autofill according to the
selected Category.
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Field Description Comments

Category

Service Category that the KA
relates to:

• Accounting System

• CRM/Sales Software

• JD Edwards

• Microsoft Office

• Office Suite

• Oracle

• PeopleSoft

• SAP

Autofills when created from an Incident or Problem.
The Category selected in this field determines which
teams will autofill the Assigned Team, Technical
Review Team, and Format Review Team fields. See
the table in Knowledge Management Teams for a list
of teams and how they autofill according to the
selected Category.

Subcategory
Service Subcategory that the
KA relates to (example: Submit
Incident).

Not always applicable. Autofills when created from an
Incident or Problem.

Configuration
Item Type

The type of Configuration Item
that the KA relates to.

Assigned
Team

Autofills based on the selected
Category. Matches the
Technical Review Team.

Note: You can
manually change the
Assigned Team after
selecting the
Category. For
example, you may
want to assign the KA
to yourself when it is in
Draft form. However,
once you submit the
KA for Technical
Review, the Assigned
Team will
automatically change
to match the
Technical Review
Team.

See the table in Knowledge Management Teams for a
list of teams and how they autofill according to the
selected Category.

Assigned To

Select a specific user or allow
the individuals within the
assigned team(s) to assign to
themselves.

The options in this field are limited to the individual
users in the current team (based on Status).

Technical
Review Team

Autofills based on the selected
Category.

See the table in Knowledge Management Teams for a
list of teams and how they autofill according to the
selected Category.
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Field Description Comments

Format
Review Team

Autofills based on the selected
Category.

See the table in Knowledge Management Teams for a
list of teams and how they autofill according to the
selected Category.

Title Title of KA.

Try to match what people will be searching/browsing
for.

Tip: Include feature name and recognizable
words, such as "How To Reset a Password".

Description Description of the article.

Content Details of the article, such as
step-by-step instructions.

Source Source of KA.

This field reflects the Business Object the article
originated from (example: Incident or Problem) when
Submit to Knowledge Base is used from the Business
Object.

Tags

List of keywords, separated by
commas and a space, related
to the KA that can help with
categorization and searching.
Select synonyms, related
terms, regional versions, usual
typos, etc.

 

Article Stats

Current statistics, which
include:

• Number of likes

• Number of dislikes

• Number of times the KA
has been used overall

• Number of times the KA
has been used in the
CSM Portal

Usage is tracked using the
KnowledgeArticle.KnowledgeUsageCount
expression.

Actions List Dynamic display of the Actions
available for the current KA.

Assign to Me

Makes the current user the
owner of the KA. The current
user's name appears in the
Assigned to field.
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Field Description Comments

Add Comment

Opens a window to add a
comment for the Knowledge
team to review. The comment
appears as a Journal-Note
entry in the Journals tab and
Comments tab of the form
arrangement.

Update/
Revise Article

Opens a window to select a
Knowledge team member from
a drop-down list. You can also
select the Ellipsis (...) button.

Set Review
Date

Allows members of the
Knowledge Management
teams to set the Review Date
to something other than the
default value, which is one year
from Publish Date.

Set Publish
Date

Allows members of the
Knowledge Management
teams to set a future Publish
Date.

Publish Now

Allows a Knowledge Manager
or a Cherwell admin to skip the
Technical Review and
Formatting Review and go
directly to Publish. If Visible on
Customer Portal is selected, a
prompt displays confirming that
you want to publish this KA to
the CSM Portal. Select True or
False, then select OK.

Reject This
Article Rejects the KA.

Retire This
Article Retires the KA.

Knowledge Article Read-Only View Form
The Knowledge Article Read-Only View form displays in the Article tab once the KA is published. To
simplify the reading experience of the published KA, the Overview tab no longer displays.
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The following table describes the fields on the Knowledge Article Read-Only View form.

Field Description Comments

Article Content Displays the title and content of the
article.

Pencil icon
Members of the Knowledge
Management teams can select this to
modify the KA.

Was this useful?
This form section allows user to
provide feedback on the KA and
email to others.

Likes Allows user to like the KA. Like Count Value displayed.

Dislikes Allows user to dislike the KA. Dislike Count Value displayed.

Email this article Technicians can select to email KA to
someone.
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Field Description Comments

Classification
The Classification Value of the KA is
determined by the Service, Category,
and Subcategory.

Uses an expression:
KnowledgeArticle.Category Custom
expression [If
KnowledgeArticle.SubCategory is
not empty then > Default: empty]
KnowledgeArticle.SubCategory

Configuration
Item Type

The type of Configuration Item that
the KA relates to.

Source Source of KA.

Tags
List of keywords related to the KA
that can help with categorization and
searching.

 

Knowledge Article Summary Form
The following table describes the fields on the Knowledge Article Summary form.

Field Description Comments

Title Title of KA.

Assigned
To

Name of the individual user and team
currently working on the KA.

CSM automatically fills in the user and team
names. 

Article Type

Type of KA:

• How To

• Policy/Procedure

• Question and Answer

• Solution Article

Status

The current status of the KA within
the Knowledge Article Workflow. See
the Knowledge Article form fields for
a specific list of status options.

  CSM automatically fills in the status. 

Usage
Count

Number of times the KA has been
used.

Usage is tracked using the
KnowledgeArticle.KnowledgeUsageCount
expression.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
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IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge
Managing Form Arrangements
About Rich Text
Related tasks
Create a New Knowledge Article
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Knowledge-IT Portal Form
Using the Knowledge-IT Portal form, a customer can edit the Knowledge Article (KA) if they are the
owner; otherwise, most fields are read-only.

Only members of the Portal Workgroup Manager security group have the rights to create new Knowledge
Articles in the CSM Portal. Customers can contribute by adding comments and providing feedback on
whether the Knowledge Article resolved the issue.

The following table describes the fields on the Knowledge-IT Portal form.

Item Description Comments

Main Form

Title Title of the KA.  

Description Description of the KA.  

Did you like this article?

Like button Select to "Like" the KA.
One-Step™ Action (Like Increment): Increments the
appropriate Popularity Count by one (1). You can only
vote once per session.

Did this resolve your issue?

Yes Select to indicate that the KA
helped resolve your issue.

One-Step Action (Issue resolved via Portal - show
usage): Increments the KA usage count by one (1)
when a Portal customer indicates that this KA resolved
the issue. Also displays a pop-up message to thank
the customer for her feedback.

No Select to indicate that the KA
did not resolve your issue.

One-Step Action (Issue not resolved via Portal-log
Incident): Prompts a Portal customer to describe why
the KA did not resolve her issue. Also displays a pop-
up message saying an Incident has been created and
provides tracking information.

Add Comment
Select to launch the Prompt
window, and then provide a
comment about the KA.

One-Step Action (Add Comment): Creates a Journal-
Note to capture the comment; the Journal appears on
the Journals tab (Arrangement area).
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Knowledge Article Journals
You can access Knowledge Article (KA) Journals by selecting the Journals, History, and Comment tabs
in the KA record.

Each Journal type has its own unique form. Journals are child records, so they are linked to and available
from their parent records.

CSM provides the following KA Journal types:

• Journal - Comment: Tracks user comments. For example, a user might add a comment to a KA.

• Journal - Customer Request: Tracks customer requests on a KA in the CSM Portal.

• Journal - History: Tracks important field changes. Tracked fields are configurable and are defined
in the Business Object definition. For the specific One-Step™ Actions that automatically log Journal
- History records for auditing, see Knowledge Article Workflow One-Step Actions.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge
Managing Form Arrangements
About Rich Text
Related tasks
Create a New Knowledge Article
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Knowledge Article Workflow One-Step Actions
CSM provides numerous OOTB Knowledge Article workflow One-Step™ Actions.

The following One-Step Actions are used to process the Knowledge Article workflow:

• Submit For Review

• Technical Review Complete

• Format Review Complete

• Publish

"Submit For Review" One-Step Action
The "Submit For Review" One-Step Action runs when the user selects Next: Technical Review on the
Knowledge Article form.

• Scope: Blueprint

• Description: Knowledge Article submitted for technical review.

• Conditions: One-Step Action is allowed to run against: Single record or a group of records.

Submit For Review Steps

Step Name Description Action(s) Expression(s)

Show a Popup

When the creator of the
Knowledge Article selects
Next: Technical Review on
the Knowledge Article form,
a pop-up message appears
thanking the creator for the
submission.

Automated: Displays pop-up
message.

User: Selects OK button.

Step only runs if
expression is True:
Knowledge Article.Status is
not equal to Retired

Create Audit Record

Adds two audit records to
the History tab: (1) the
name of the User who
created the Knowledge
Article and (2) the name of
the user who submitted the
Knowledge Article.

Automated: Adds an audit
record using template text in
the
'Article Creator: [Knowledge
Article.Created By] field

Article was submitted for
technical review by:
[CurrentUserDisplayName]'

Step only runs if
expression is True:
Knowledge Article.Status is
not equal to Retired

Set Status to Technical
Review

Changes the status to
Technical Review and the
Next Status to Technical
Review Complete.

Automated: Changes the
status to Technical Review
and the Next Status to
Technical Review Complete.
Saves the Business Object
after action.
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Step Name Description Action(s) Expression(s)

Set Assigned Team
Sets the Assigned team to
the same value as the
Technical Review team.

Automated: Changes the
Assigned Team field to match
the Technical Review Team
field. Saves the Business
Object after action.

The value of the Technical
Review team is determined
by the selection made on
the Knowledge Article form
in the Category field. See
the table in OOTB
Knowledge Management
Teams for a list of teams
and how they correlate with
the selected Category.

Email Technical Review
Team

Sends an email to the
Technical Review team
informing them that the
Knowledge Article is ready
for review and attaches the
email record to the
Knowledge Article's history.

Automated: Email sent to the
Technical Review team via the
default user account.

• To: [To Email]

• Subject: Please Review
Knowledge Article
[Knowledge
Article.Knowledge Article
ID]

• Format: HTML format
(*.html;*.htm)

• Priority: Normal

Email record is also:

• Attached to the current
record's history.

• Attached to recipients in
To line.

• Attached to recipients in
CC line.

The Technical Review team
is determined by the
selection made on the
Knowledge Article form in
the Category field. See the
table in OOTB Knowledge
Management Teams for a
list of teams and how they
correlate with the selected
Category.

Refresh Runs the Refresh command
to update the display.

Automated: Runs the Refresh
command.

"Technical Review Complete" One-Step Action
The "Technical Review Complete" One-Step Action runs when the user selects Next: Technical Review
Complete on the Knowledge Article form.

• Scope: Blueprint

• Description: Technical Review Team has completed its review of the Knowledge Article.

• Conditions: One-Step Action is allowed to run against: Single record or a group of records.

Technical Review Complete Steps
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Step Name Description Action(s) Expression(s)

Must be a Technical
Review Team Member

If a user who is not a member of
the Technical Review team
selects Next: Technical Review
Complete, a pop-up message
displays stating, "You must be a
member of the Technical Review
team."

Automated: Displays pop-up
message.

User: Selects OK button.

Step only runs if expression
is True; otherwise the One-
Step Action continues to the
next step:
"Is Member of Technical
Review Team" expression
equals False

Technical Review Team

If the user who selected Next:
Technical Review Complete is
not a member of the Technical
Review team, the One-Step
Action stops running.
If the user is a member of the
Technical Review team, the One-
Step Action continues to the next
step.

Automated: One-Step Action
stops running if user is not a
member of the Technical Review
team; otherwise it continues to
the next step.

Step only runs if expression
is True; otherwise the One-
Step Action continues to the
next step:
"Is Member of Technical
Review Team" expression
equals False

Decide Between Multiple
Cases

Determines which of the following
paths to take based on specific
field values on the form:

• Set Status to Format
Review (if the Visible on
Customer Portal check box
is selected)

• Set Status to Pending
Publish Date (if the publish
date is set to the future)

• Set Status to Published
(default path if none of the
above conditions are True)

Automated: Follows the path
where the expression is True.

One-Step Action follows one
of three paths where
expression is True with
priority from top to bottom as
follows:

• Follow path to Set
Status to Format
Review step if:
Knowledge
Article.Visible to
Customer Portal equals
True

• Follow path to Set
Status to Pending
Publish Date step if:
Knowledge
Article.Publish Date
(date) is greater than
CurrentDateTime()

• If none of the above
conditions are True, the
Default path is to the
Set Status to Published
step.

Set Status to Format
Review

If the Visible on Customer Portal
check box is selected, changes
the KA status to Format Review
and the Next Status Text to
Format Review Complete.

Automated: Changes the status
to Format Review and the Next
Status Text to Format Review
Complete. Saves the Business
Object after action.
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Step Name Description Action(s) Expression(s)

Set Status to Pending
Publish Date

If the publish date is set to the
future, changes the KA status to
Pending Publish Date.

Automated: Changes the status
to Pending Publish Date.

Set Status to Published

If the Visible on Customer Portal
check box is not selected and the
publish date is not set to the
future, changes the KA status to
Published and the Next Status
Text to Retire this Article.
The Publish One-Step Action
runs.

Automated: Changes the status
field to Published and the Next
Status Text to Retire this Article.
The Publish One-Step Action
runs.

Set Assigned Team
Sets the Assigned Team field to
the same value as the Format
Review team.

Automated: Changes the
Assigned team to match the
Format Review team. Saves the
Business Object after action.

The Format Review team is
determined by the selection
made on the Knowledge
Article form in the Category
field. See the table in OOTB
Knowledge Management
Teams for a list of teams and
how they correlate with the
selected Category.

Set Assigned To Saves the Knowledge Article. Automated: Saves the Business
Object after action.

Email Format Review
Team

Sends an email to the Format
Review team informing them that
the Knowledge Article is ready for
review and attaches the email
record to the Knowledge Article's
History.

Automated: Email sent to the
Format Review team via the
default user account.

• To: [To Email]

• Subject: Please Review
Knowledge Article
[Knowledge
Article.Knowledge Article
ID]

• Format: HTML format
(*.html;*.htm)

• Priority: Normal

Email record is also:

• Attached to the current
record's history.

• Attached to recipients in TO
line.

• Attached to recipients in CC
line.

The Format Review team is
determined by the selection
made on the Knowledge
Article form in the Category
field. See the table in OOTB
Knowledge Management
Teams for a list of teams and
how they correlate with the
selected Category.
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"Format Review Complete" One-Step Action
The "Format Review Complete" One-Step Action runs when the user clicks Next: Format Review
Complete on the Knowledge Article form.

• Scope: Blueprint

• Description: Format Review team has completed its review of the Knowledge Article.

• Conditions: One-Step Action is allowed to run against: Single record or a group of records.

Format Review Complete Steps

Step Name Description Action(s) Expression(s)

Format Review Team (1)

If a user who is not a member of
the Format Review team selects
Next: Format Review Complete,
a pop-up message displays
stating, "You must be a member
of the Format Review Team."

Automated: Displays pop-up
message.

User: Selects OK button.

Step only runs if expression is
True; otherwise the One-Step
Action continues to the next
step:
"Is Member of Format Review
Team" expression equals
False

Format Review Team (2)

If the user who selects Next:
Format Review Complete is not a
member of the Format Review
team, the One-Step Action stops
running.
If the user is a member of the
Format Review team, the One-
Step Action continues to the next
step.

Automated: One-Step Action
stops running if User is not a
member of the Format
Review Team; otherwise it
continues to the next step.

Step only runs if expression is
False; otherwise the One-Step
Action continues to the next
step:
"Is Member of Format Review
Team" expression equals True

Set Assigned Team
Sets the Assigned Team field to
the same value as the Technical
Review Team.

Automated: Changes the
Assigned team to match the
Technical Review team.
Saves the Business Object
after action.

The Technical Review team is
determined by the selection
made on the Knowledge
Article Form in the Category
field. See the table in OOTB
Knowledge Management
Teams for a list of teams and
how they correlate with the
selected Category.
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Step Name Description Action(s) Expression(s)

Decide Between Multiple
Cases

Determines which of the
following paths to take based on
specific field values on the form:

• Set Status to Pending
Publish Date (if the Publish
Date is set to the future)

• Set Status to Published
(default path if above
condition is not True)

Automated: Follows the path
where the expression is True.

One-Step Action follows one
of three paths where
expression is True with priority
from top to bottom as follows:

• Follow path to Set Status
to Pending Publish Date
step if: Knowledge
Article.Publish Date
(date) is greater than
CurrentDateTime()

• If the above condition is
not True, the default path
is to the Set Status to
Published step.

Set to Pending Publish
Date

If the Publish Date is set to the
future, changes the KA status to
Pending Publish Date.

Automated: Changes the
status to Pending Publish
Date.

Set to Published

If the Publish Date is not set to
the future, changes the KA status
to Published and the Next Status
text to Retire this Article.
The Publish One-Step Action
runs.

Automated: Changes the
status to Published and the
Next Status text to Retire this
Article.
The Publish One-Step Action
runs.

Publish One-Step Action
If a Knowledge Manager is also the creator of KA, they can bypass the KA workflow and go straight to
publishing the article.

As part of the KA workflow, the Publish One-Step Action runs once the status on the Knowledge Article
form changes to Published via the Technical Review Complete or Format Review Complete One-Step
Actions.

• Scope: Blueprint

• Description: KA is published.

• Conditions: One-Step Action is allowed to run against: Single record or a group of records.

Publish Steps
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Step Name Description Action(s) Expression(s)

Publish

This One-Step Action can
be manually run by a
member of the Knowledge
Management team.

User: Can manually run this
One-Step Action if a member
of the Knowledge
Management team.

Step only runs if
expression is True:
CurrentUserRecordID() Is
member of team [GUID]

The GUID in this
expression is the
TeamDef ID of the
Knowledge Management
team.

Publish and Verify
Visibility to the Portal

Sets the Published Date,
Status, and Visible to
Customer Portal (if
applicable) fields.

Automated: Sets the
Published Date to the Current
Date and Time.
Changes the Status to
Published.

Prompts for the CSM Portal,
if visible.

Published Date set by
custom expression:
CurrentDateTime

Reset Review Date Runs the Reset Review
Date One-Step Action.

Automated: Runs the Reset
Review Date One-Step
Action, which sets the Review
Date to one year from the
current date. (This field can
also be manually modified on
the Knowledge Article form.)

Additional One-Step Actions

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full
list of One-Step Actions associated with a particular type of Business Object (example: Major).

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Management Teams
Search Knowledge
Related tasks
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Create a New Knowledge Article
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Knowledge Article Saved Searches
CSM provides numerous Knowledge Article (KA) saved searches.

Notable KA saved searches include:

Saved Search Returns Association Executed From

All Knowledge
Articles All KAs, regardless of status. Knowledge

Article

Updated Knowledge
Articles widget,
user-selectable Last
Modified Date Time
range

Articles with
Dislike Votes

KAs by their "Dislike" count, in
descending order. KAs with the most
dislikes will be at the top of the search
results.

Knowledge
Article

Articles with Like
Votes

KAs by their "Like" count, in descending
order. KAs with the most likes will be at
the top of the search results.

Knowledge
Article

Articles with
Usage Count

KAs by their usage count, in descending
order. KAs with the most usage will be
at the top of the search results.

Knowledge
Article

My KB Approvals KAs awaiting my (current user)
approval.

Knowledge
Article

Awaiting My
Approval widget

My Overdue KB
Approvals

Overdue KAs awaiting my (current user)
approval.

Knowledge
Article

Awaiting My
Approval Overdue
widget

My Working KB
Articles

KAs that are owned by me (current
user), and are not yet published.

Knowledge
Article

My Articles for
Review widget

New Team
Comments

KAs with user comments (on the CSM
KA form).

Knowledge
Article

New Team
Comments widget

Published Articles KAs with a status of Published. Knowledge
Article

Up For Review
widget; user-
selectable date
range

Submitted Articles
KAs that have been submitted to the
Knowledge team for Review or
Approval.

Knowledge
Article

Submitted
Knowledge Article
widget

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
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IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge
About Saved Searches
Related tasks
Create a New Knowledge Article
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Knowledge Article Automation Processes
CSM provides several Knowledge Article Automation Processes.

Name Description

Notify Knowledge
Article Owner of
Assignment

When the Owned By field of a Knowledge Article is changed, the process
initiates the "Notify Owned By" One-Step™ Action, which sends a notification
email to the new owner.

Notify Knowledge
Article Team of
Assignment

When the Owned By Team field of a Knowledge Article is changed, the
process initiates the "Notify Owned By Team via E-mail" One-Step Action,
which sends a notification email to members of the team that owns the
Knowledge Article.

Notify Owner of
Comments

When a Journal is added to a Knowledge Article, an email notification is sent
to the owner of the KA.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Knowledge Management Teams
Search Knowledge
Related tasks
Create a New Knowledge Article
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Knowledge Management Teams
By default, CSM provides a general Knowledge Management team, multiple IT Knowledge Management
(ITKM) Technical Review teams, and a Format Review team.

Knowledge Management Team
The Knowledge Management team is responsible for managing Knowledge Articles (KAs). Members of
this team have access to certain KA tools. For example, members can:

• Access the IT Knowledge Manager dashboard.

• Edit a KA in any workflow phase (other users can edit only in the New or Draft phase).

• Send the KAs back for review/revision.

• Access KA-related One-Step™ Actions.

IT Knowledge Management (ITKM) Teams
When logging a KA, the Technical Review Team and Assigned Team form fields autopopulate based on
the selection made in the Category field (see the table below).

Note: You can manually change the Assigned Team after selecting the Category. For example,
you may want to assign the KA to yourself when it is in Draft form. However, once you submit the
KA for technical review, the Assigned team will automatically change to match the Technical
Review team.

ITKM Technical Review Teams
There are three ITKM Technical Review teams:

• ITKM - Enterprise (for Enterprise Apps)

• ITKM - HR (for Employee Support)

• ITKM - IT (for all other Services listed in the table below)

Format Review Team
There is one Format Review team:

• Formatting

The KA automatically routes from the Technical Review team to the Format Review team if the Visible on
Customer Portal check box is selected.

Service Category ITKM Technical Review
Team Format Review Team

Account Management Cherwell Self Service ITKM - IT Formatting

Account Management Network Access ITKM - IT Formatting
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Service Category ITKM Technical Review
Team Format Review Team

Conferencing/
Presentation Equipment Request ITKM - IT Formatting

Conferencing/
Presentation Video/Audio Conferencing ITKM - IT Formatting

Desktop Management Anti-Virus ITKM - IT Formatting

Desktop Management Computer ITKM - IT Formatting

Desktop Management Misc. Software ITKM - IT Formatting

Desktop Management OS ITKM - IT Formatting

E-Mail/Calendaring Browser Client ITKM - IT Formatting

E-Mail/Calendaring Desktop Client ITKM - IT Formatting

E-Mail/Calendaring Mailbox ITKM - IT Formatting

E-Mail/Calendaring Mobile Client ITKM - IT Formatting

Employee Support Add/Change ITKM - HR Formatting

Enterprise Apps Accounting System ITKM - Enterprise Formatting

Enterprise Apps CRM/Sales Software ITKM - Enterprise Formatting

Enterprise Apps JD Edwards ITKM - Enterprise Formatting

Enterprise Apps Microsoft Office ITKM - Enterprise Formatting

Enterprise Apps Office Suite ITKM - Enterprise Formatting

Enterprise Apps Oracle ITKM - Enterprise Formatting

Enterprise Apps PeopleSoft ITKM - Enterprise Formatting

Enterprise Apps SAP ITKM - Enterprise Formatting

IT Service Desk Report Outage or Error ITKM - IT Formatting

IT Service Desk Request Help ITKM - IT Formatting

Network Services Backup/Restore ITKM - IT Formatting

Network Services Fileserver ITKM - IT Formatting

Network Services Physical Wires ITKM - IT Formatting

Network Services Wireless ITKM - IT Formatting

Printing Desktop ITKM - IT Formatting

Printing Network ITKM - IT Formatting

Telephony/Fax Call Center Telephony ITKM - IT Formatting

Telephony/Fax Desktop Telephone ITKM - IT Formatting
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Service Category ITKM Technical Review
Team Format Review Team

Telephony/Fax Fax ITKM - IT Formatting

Telephony/Fax Mobile Telephone ITKM - IT Formatting

Web Services Internet ITKM - IT Formatting

Web Services Intranet ITKM - IT Formatting

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
Search Knowledge
Knowledge Management Teams
Related tasks
Create a New Knowledge Article
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Knowledge Management Security Group
Permissions

CSM provides default security group permissions for Knowledge Management. Administrators use the
CSM Administrator Security Groups window to view and manage these permissions.

Note: For configuration steps, see Configure Knowledge Security Group Permissions. Knowledge
Administrators also view and manage Knowledge Teams.

Security group permissions control access to CSM functionality and are managed on the Security
Groups window. To access this window, in CSM Administrator select Security > Edit Security Groups.

Security Groups > Rights > Knowledge
On the Security Groups window, select the Rights tab. In the Category drop-down list, select
Knowledge. See Knowledge Security Rights for the default security group rights for Knowledge.

Security Groups > Business Objects > Knowledge Article, Incident Category,
Journal - Comment
On the Security Groups window, select the Business Objects tab. The following are the default
Business Object permissions by group:

Group Business
Object General (selected ) File Attachments (selected )

Admin

Knowledge
Article

• View

• Add

• Edit

• Delete

• Can change Retired to
Technical Review

• View

• Add

• Edit

• Delete

Incident
Category

• View

• Add

• Edit

• Delete

• View

• Add

• Edit

• Delete
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Group Business
Object General (selected ) File Attachments (selected )

IT Service Desk
Level 1

Knowledge
Article • View

• View

• Add

Incident
Category

• View

• Add

• Edit

• View

• Add

• Edit

• Delete

IT Service Desk
Level 2 & 3

Knowledge
Article • View

• View

• Add

Incident
Category

• View

• Add

• Edit

• View

• Add

• Edit

• Delete

IT Service Desk
Manager

Knowledge
Article • View

• View

• Add

Incident
Category

• View

• Add

• Edit

• View

• Add

• Edit

• Delete
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Group Business
Object General (selected ) File Attachments (selected )

Knowledge Manager

Knowledge
Article

• View

• Add

• Edit

• Can edit Retired

• Can change Retired to
Technical Review

• View

• Add

• Edit

Incident
Category

• View

• Add

• Edit

• View

• Add

• Edit

• Delete

Portal Customer

Knowledge
Article

• View

• Edit

• Limit records based on
criteria

• View

Incident
Category • View • View

Journal -
Comment

• View

• Add

• Edit

• View

• Add

• Edit
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Group Business
Object General (selected ) File Attachments (selected )

Portal Workgroup
Manager

Knowledge
Article

• View

• Add

• Edit

• Limit records based on
criteria

• View

Incident
Category • View • View

Journal -
Comment

• View

• Add

• Edit

• View

• Add

• Edit

Service Desk - KM
Tier 1

Knowledge
Article

• View

• Add

• Edit

• View

• Add

• Edit

Incident
Category

• View

• Add

• Edit

• View

• Add

• Edit

• Delete

Note: For additional information about CSM security, see About Security.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Articles
Knowledge Article Workflow
Knowledge Article Features and Capabilities
IT Knowledge Manager Dashboard
Knowledge Article Workflow Features
Knowledge-IT Forms
Knowledge Article Journals
Knowledge Article Workflow One-Step Actions
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Knowledge Management Teams
Search Knowledge
Related tasks
Create a New Knowledge Article
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Search Knowledge
Use the following tools to search Knowledge sources. Results display in order of Relevancy ranking. This
means the records most likely to be relevant to your search string display at the top of the results by
default.

• Knowledge Pane: Search all Knowledge sources from a pane in the CSM Desktop Client main
window.

• Quick Search Widget: Search KAs from the Quick Search widget.

• Quick Search in Task Pane: Search KAs from the Task pane in the CSM Desktop Client main
window.

• Solution Search: Search for KAs from any Business Object record.

• Portal Search: Search for KAs in the CSM Portal using a site's configured search.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Source Types
Search for Knowledge Using the Knowledge Pane
CSM Desktop Client Main Window
Quick Search Widget
Knowledge Articles
Search for Knowledge Articles from a Record and Use the Found Solution
Search for Knowledge Articles in the Portal
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Search for Knowledge Using the Knowledge Pane
In the CSM Browser Client, use the Related Item Navigation Solution search tab to search for and use
Knowledge sources.

The following information applies to the CSM Desktop Client.

In CSM Desktop Client, use the Knowledge pane to search for Knowledge sources.

Good to Know:

• Select Browse under online resource results to view Web Knowledge.

• If the search is conducted from a record (example: Incident), you can select the Use Solution
button to link the solution to the record. The way in which the record is linked depends on the
configuration (example: Data could be copied into the record, a journal entry could be added, or the
record could be linked via a relationship). For Knowledge Articles, selecting the Use Solution button
also increments the KA's usage count.

To search for Knowledge using the Knowledge pane:

1. Open the Knowledge Pane.

2. In the Knowledge Pane toolbar, define Knowledge pane search options.

3. In the Search For field, specify a word or phrase to search (example: Printing).

4. In the Options section, define Knowledge Pane options.

5. Select the Go button to run the search.

Knowledge Pane results open in the Knowledge pane.

6. Select a Knowledge source link to view the content.
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Search for Knowledge Articles Using Quick Search
in the Task Pane

Use the Quick Search in the Task pane to search for Knowledge Articles.

To search for Knowledge Articles using the Quick Search pane:

1. Open a Quick Search pane.
2. Select the down arrow on the Search button, and then select Knowledge Article.
3. In the Search Knowledge Article field, provide a word or phrase to search (example: Printing).
4. Define search criteria:

◦ View open <Business Objects> only.
◦ Search a specific timeframe.
◦ Include relationships in the search (example: Related Business Objects).
◦ Select Search Attachments to return results that match the text within .txt, .doc, and .xls files.

5. Select Go.

The Quick Search results display in a list or grid in the main pane. Results display in order of relevancy
ranking. This means the records most likely to be relevant to your search string display at the top of the
results by default.
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Search for Knowledge Articles from a Record and
Use the Found Solution

Use an open Business Object record to search for a Knowledge Article (KA) and attach a found solution
to the record for future reference.

In the CSM Browser Client, use the Related Item Navigation Solution Search tab to search for and use
Knowledge sources.

The following information applies to the CSM Desktop Client.

Good to Know:

• To place the information from the KA into the current record, you must use the Knowledge pane.
Searching Knowledge from the Quick Search widget or the Quick Search in the Task pane does not
provide this option.

• If the Knowledge tab is not displayed on the right side of the CSM Desktop Client main window,
right-click the CSM Desktop Client toolbar area and select Knowledge.

• The way in which the record is linked depends on the configuration (examples: Data could be copied
into the record, a journal entry could be added, or the record could be linked via a relationship). For
KAs, selecting the Use Solution button also increments the KA's usage count.

To search for Knowledge from an open record:

1. Open the Knowledge pane.

2. In the Knowledge pane toolbar, define Knowledge pane search options.

3. In the Search For Field, specify a word or phrase to search (example: Printing).

4. In the Options section, define Knowledge pane options.

5. Select the Go button to run the search.

Knowledge pane results open in the Knowledge pane.

6. Select a Knowledge Article that you want to view.

The KA opens in a new window.

7. Select the Use Solution button to link the KA information to the record.

Note: The field in which the solution is placed is defined using Knowledge mapping in CSM
Administrator.

The solution is placed in the defined field.

Related concepts
Knowledge Management
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About Knowledge Management
Quick Search Widget
Quick Search in the Task Pane
Knowledge Mapping
Knowledge Pane Toolbar
Knowledge Pane Options
Knowledge Pane Results
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Search for Knowledge Articles in the Portal
In the CSM Portal, customers can search for Knowledge Articles (KAs) using a CSM Portal site's
configured search control or using the Search Knowledge Base field.
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CSM Desktop Client Knowledge Pane
Use the CSM Desktop Client Knowledge pane to quickly search the configured Knowledge sources in
your Knowledge base.

The pane has the following behaviors:

• Dynamic: Searchable Knowledge sources and options vary by Business Object. This ensures that
the Knowledge search is always appropriate (example: A mobile device website might be available
as a searchable Knowledge source while on a Config - Mobile Device record but would not be
appropriate when on a Customer record).

• Collapsible and dockable: Display the pane when and where you need it. By default, the Knowledge
pane is located on the right side of the CSM Desktop Client main window.
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1. Toolbar: Displays a row of buttons for available operations.

2. Search: Find all Knowledge sources that contain a specific word or phrase. For attachments, the
search returns results that match the text within .txt, .doc, and .xls files and will return any file type
with a matching file name.

3. Search Options: Define the scope of the search to filter the results.

4. Results Pane: View Knowledge sources found as a result of the search.

Note: Security rights control access to CSM functionality and are configured in the Security
Group Manager in CSM Administrator (In CSM Administrator, go to Security > Edit
Security Groups).

Related concepts
Knowledge Management
About Knowledge Management
Pin/Collapse a Pane
Move/Dock a Pane
Knowledge Pane Toolbar
Knowledge Pane Search
Knowledge Pane Options
Knowledge Pane Results
Browser and Mobile Device Security Rights
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Open the Knowledge Pane
Open the Knowledge pane from the CSM Desktop Client.

To open the Knowledge pane:

1. From the CSM Desktop Client, select the Knowledge tab on the right side of the CSM main pane
and then select the Pin button

or

2. From the CSM Desktop Client menu bar, select View > Knowledge.
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Knowledge Pane Toolbar
Use the Knowledge pane toolbar to interact with the Knowledge pane.

Item Action

Run Knowledge search.

Populate search field with text from the current record (CTRL+K keyboard shortcut):

• Pull text from the field the system administrator has configured as the search field
(example: Text in the Incident Description area).

• Highlight the text to search and select this button. (If any text is highlighted, the search will
pull the highlighted text rather than the contents of the search field.)

• Noise words (example: and, or, the, etc.) are automatically removed from the pulled text
and a single version of each word is searched.

Populate search field with text from the current record and immediately search (Ctrl+Shift+K).
Equivalent to pressing Ctrl+K and then selecting the Go button.

Stop the current search.

Search based on the current record type.

General Knowledge search.

Search all words (AND is used to separate words in search). The system finds records that
contain all of the search words (with the exception of noise words such as "the," "will," etc.). For
example, if you search for the words "printer driver," the system finds all records that contain
both words.

Search any of the words (OR is used to separate words in search). The system finds records
that contain any of the search words (with the exception of noise words). For example, if you
search for the words "printer driver," the system finds all records containing the word "printer" or
the word "driver," and also finds records that have both words.
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Knowledge Pane Search
The Knowledge pane search allows you to create a unique Knowledge search, or run a previous search
again.

To run a search using the Knowledge pane search:

1. Enter a word or phrase in the search text box.

Tip: Select the down arrow button to select a word or phrase you have previously
searched.

2. Select the Go button to run the search.

The search results appear in the Knowledge Search Results pane.
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Knowledge Pane Options
The Knowledge pane allows you to define specific Knowledge sources for each search (example: Search
KAs, but not Google).

The Knowledge pane is dynamic so search options vary based on the Business Object you are searching
(example: You will see a different list of options when working on an Incident than you will see when
working on a Problem). If you are not working with a particular Business Object (example: When you view
a dashboard), the Knowledge pane shows a minimal set of search options.

The following figure is an example list of search options:

Search options include the following behaviors:

• Select the Show Option check box to view options.

• Select a Knowledge Source check box (examples: Knowledge Articles, attachments) to search the
corresponding Knowledge source. For attachments, the search returns results that match the text
within .txt, .doc, and .xls files and any file type with a matching file name.

• Select the arrow to view additional options (if available).

Note: Certain option changes will only be applied to future Knowledge searches.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Pane Options
Knowledge Articles
Knowledge Source Manager
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Knowledge Pane Results
Knowledge pane results are based on selected Knowledge Sources. After you run a Knowledge search,
the results appear in the bottom pane.

Results display in order of relevancy ranking. This means the records most likely to be relevant to your
search string display at the top of the results by default. For attachments, the search returns results that
match the text within .txt, .doc, and .xls files and any file type with a matching file name.

The following example shows results for the term "print":
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To view result details, select the link associated with the result.

Tip: Right-click the result to view the record (opens in a new window with limited functionality), go
to the record (opens the record in the CSM Desktop Client main window), or go to record in a new
window (opens in a new window with full functionality).
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Note: You must select Browse... under online resource results to view the content.

Depending on the type of Knowledge source you select, the information will open in different ways,
including:

• Attachment links open the attachment file.

• Business Object links open the associated Business Object in a new window.

• Web links open a browser in a new window.

• Knowledge Articles open in a new window.
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Manage Knowledge Sources
CSM Manage Knowledge using the Knowledge Source Manager, Knowledge Mapping, and Knowledge
Importing.

• Knowledge Source Manager
◦ Use this tool to:

◦ Create a Knowledge source.

◦ Edit a Knowledge source.

◦ Delete a Knowledge source.

◦ Search for a Knowledge source.

◦ Organize Knowledge sources.

◦ Copy a Knowledge source.

◦ Import/export a Knowledge source.

◦ Find Knowledge source dependencies.

• Knowledge Mapping
◦ Use this tool to:

◦ Define general Knowledge sources.

◦ Define Portal Knowledge search options.

◦ Define Business Object Knowledge search options.

• Knowledge Importing
◦ Use this tool to:

◦ Import third-party Knowledge Articles.

Related concepts
Knowledge Management
About Knowledge Management
Knowledge Source Manager
Import Knowledge Wizard
Edit a CSM Item
Delete a CSM Item
Search in a CSM Item Manager
Organize CSM Manager Items
Copy a CSM Item
Import/Export a CSM Item
Find CSM Item Dependencies
Knowledge Mapping
Define General Knowledge Search Options
Define Business Object Knowledge Search Options
Related tasks
Create a Knowledge Source
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Knowledge Source Types
CSM allows you to define three types of Knowledge Sources: Attachment, Business Object, and Web.
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Define an Attachment Knowledge Source
Use an attachment Knowledge source to search documents (example: Microsoft Office documents, PDFs,
etc.) that have been imported into CSM using the Attachment Manager. When you define an attachment
Knowledge source, you define:

• General properties: Type of Knowledge source and display name.

• Search criteria: Search categories and options.

• Solution: Use attachments as a solution when on a Business Object record.

Good to Know:

• Search options for this feature include global and/or user folders, so ensure that the attachments
you want to search are placed in one or both of the folders.

• The Business Object drop-down list is disabled for this type of Knowledge source.

To define an attachment Knowledge source:

1. Open the Knowledge Source Manager.

2. Define general properties:
a. Source: Select Attachment in the drop-down list.

b. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

3. Define search criteria:
◦ Categories: When a search is launched from a Business Object that has categorization

(example: An Incident with a Network category and Performance subcategory), the categories
are passed to the Knowledge source. If you select the Add to Search String option for each
of these categories, then the words that appear in the categories are added to the list of words
that must be found.

◦ Allow Users to ignore categories: Select this check box to give the user the ability to specify
whether the category values should be included in the search or not. Otherwise, the category
values are always passed.

◦ Allow User to limit by date: Select this check box to give the user the option to only find
Attachments that were created or modified within a certain period of time (example: Within the
past week). Otherwise, all attachments are searched, regardless of when they were modified.

◦ Search Global Attachments: Select this check box to search the Global folder of the current
user in the Attachment Manager.

◦ Search User attachments: Select this check box to search the current user's folder in the
Attachment Manager.

4. Define the solution:
◦ Solution can be put into Business Object Attachment: Select this check box to give users

the ability to select the Use Solution option (attaches the Knowledge source to the current
record) if an appropriate attachment is found.

CSM 2022.3 Features 967

CSM 2022.3 Features



5. Select Save.
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Define a Business Object Knowledge Source
Use a Business Object Knowledge Source to search a specific type of Business Object (Incident,
Problem, etc.) as well as its children and attachments. When you define a Business Object Knowledge
Source, you define:

• General properties: Type of Knowledge Source, associated Business Object, and display name.

• Items to Search: Scope of the search.

• Search Criteria: Search categories and options.

• Solution: Information that the solution uses and where the information is used.

Good to know:

• Searches that include child records and/or attachments run slower and return more results.

To define a Business Object Knowledge Source:

1. Open the Knowledge Source Manager.

2. Define general properties:
a. Source: Select Business Object in the drop-down list.

b. Business Object: Select the type of Business Object that you want to search.

c. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

3. Define items to search:
◦ Business Object: Searches all fields of the main Business Object record that have been

added to the full-text index.

◦ Children: Searches all child records (example: journals) of the main Business Object.

◦ Attachments: Searches any documents that have been imported or attached to the main
Business Object.

4. Define search criteria:
◦ Categories: When a search is launched from a Business Object that has categorization

(example: An Incident with a Network category and Performance subcategory), the categories
are passed to the Knowledge Source.

◦ Allow user to ignore categories when searching
◦ Allow user to limit by
◦ Allow user to limit to final state: Select this check box to give the user the option to limit the

search to only final (example: Closed) records.

Tip: This check box applies to lifecycles created using the Business Object Lifecycle
Editor or records from legacy lifecycles.
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◦ Additional search criteria: Use the Search Manager or the Custom Query Builder to further
define your search criteria (example: Limit the search to Incidents that have already been
resolved where the customer approved the solution).

5. Define the solution:
◦ Solution field: The field that contains the details of the solution. When populating a field,

creating a journal entry, etc., the text from this field is copied into the target field.

◦ Solution description field: The field that contains text displayed in the Knowledge Pane
when a record is found. Typically, it contains a shorter description (or summary) of the solution.

◦ Solution can be put into:
◦ Field: Data from the solution field that can be placed in a field within the target object.

◦ Journal entry: A new journal entry can be created on the target object and the data from
the solution field is used for the journal text.

◦ Attachment: The solution Business Object can be attached to the target object, and
appears on the Attachment bar.

◦ Relationship: The solution Business Object can be added to an existing relationship on
the target object (example: There is a relationship between Incidents and Problems. If a
Problem is found, it can be added to that relationship.)

6. Select Save or Save As.6.
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Define a Web Knowledge Source
Use a Web Knowledge source to search a specific website (example: Google, Yahoo, YouTube).

When you define a Web Knowledge source, you define:

• General properties: Type of Knowledge source, display name, image, website, and search text
parameter name.

• Search criteria: Search categories.

• Solution: Option as to how to link the source to a record.

Good to Know:

• Web Knowledge source is only accessible from the CSM Desktop Client.

• The Business Object drop-down list is not relevant for this type of Knowledge source.

• To ensure that you typed in the correct Web page, select View on the right side of the field to
preview the site.

• Determine the appropriate URL and search parameter by accessing the website and executing a
search. Then, look at the resulting URL in your browser.

To define a web Knowledge source:

1. Open the Knowledge Source Manager.

2. Define general properties:
a. Source: Select Web in the drop-down list.

b. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

c. Image: Select a display image to use within CSM using the Image Manager.

d. Website: Enter the URL for the website.

e. Search text parameter name: Provide the name of the search parameter (specific to the Web
Knowledge source) that needs to be passed on to the search engine.

Note: The value of the parameter is the list of search words (example: When
searching Google, the parameter is "q", which generates a search URL, such as http://
www.google.com/search?q=My+Search+Words).

3. Define Search Criteria:
◦ Categories: When a search is launched from a Business Object that has categorization

(example: An Incident with a Network category and Performance subcategory), the categories
are passed to the Knowledge source.

4. Define the solution:
◦ Journal entry: A new Journal entry is created on the target object and the data from the web

page is used for the Journal text.
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◦ Attachment: The URL of the final search result is attached to the target object, and appears
on the attachment bar.

5. Select Save.5.
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Knowledge Source Manager
Use the Knowledge Source Manager to complete general CSM Item Manager operations for knowledge
sources.

There are several ways to open the Knowledge Source Manager.

Good to Know:

• System is the only available scope. Create subfolders underneath this scope to organize items.•

• Use the context (right-click) menu to quickly access menu bar/toolbar options.

• For more information about working in CSM Item Managers, refer to the Item Managers
documentation.
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Open the Knowledge Source Manager
You can open the Knowledge Source Manager several ways.

Open the Knowledge Source Manager in one of two ways:

1. From the CSM Administrator main window, select the Settings category, and then select the
Knowledge Sources task.

2. From the Knowledge Mapping window, select the Add button.
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Create a Knowledge Source
Use the Knowledge Source Manager to create, edit, delete, and organize knowledge sources.

To create a Knowledge source:

1. Open the Knowledge Source Manager.
2. Select a scope and subfolder (if needed).

3. Select Create New .
The Knowledge Source Properties window opens.

4. Select the type of Knowledge source that you want to create.
◦ Attachment: Search imported documentation (example: White papers) in the CSM

Knowledge source system using the Attachment Manager (CSM > Tools > Attachments).
◦ Business Object: Search a specific type of Business Object as well as its children and

attachments.
◦ Web: Search a specific website.

5. Define additional criteria for the search.

Note: Additional search criteria varies based on the type of Knowledge Source you create
(Attachment Knowledge Source, Business Object Knowledge Source, or Web Knowledge
Source). Use this criteria to narrow your search.

6. Select Save.

Related concepts
Knowledge Management
About Knowledge Management
Scope
Define an Attachment Knowledge Source
Define a Business Object Knowledge Source
Define a Web Knowledge Source
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Knowledge Mapping
Use Knowledge mapping to determine when and how a Knowledge source can be searched and how the
resulting solution can be used.

When mapping a Knowledge source, define:

• What Knowledge sources can be searched using a general search and/or a [Business Object]
search (example: A mobile device website is useful as a searchable Knowledge source from a
Config - Mobile Device record).

• What field categories should be included in the search (example: If Service, Category, and
Subcategory fields are selected for an Incident record, the fields are included in the search).

• Which Business Object fields should be populated with the found Knowledge (example: If the
Description field is selected, found solutions are placed in that field).

To open the Knowledge Mapping window from the CSM Administrator main window, select the Settings
category, and then select the Knowledge Mapping task.
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Open the Knowledge Mapping Window
To open the Knowledge Mapping window from the CSM Administrator main window, select the Settings
category, and then select the Knowledge Mapping task.
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Define General Knowledge Search Options
Use Knowledge mapping to determine what Knowledge sources can be searched during a general
knowledge search. Use this for impromptu searches or research when you are not working with a
particular Business Object.

Good to Know:

• Knowledge sources must be defined using the Knowledge Source Manager before adding them to
the general search list.

• Select a Knowledge Source, then select Remove to remove it from the list. Select a Knowledge
Source, then select the Up/Down buttons to organize the items in the list.

To add general search Knowledge sources:

1. Open the Knowledge Mapping window.

2. In the Search From menu, select General Search.

Knowledge sources open in the window. (Some Knowledge sources may be provided with your
system.)

3. Add Knowledge sources that you want available to users for general searches:
a. Select the Add button.

The Knowledge Source Manager opens.

b. Select a Knowledge Source.

c. Select OK.c.

The new Knowledge source appears in the list.

4. Select OK.4.

CSM 2022.3 Features 978

CSM 2022.3 Features



Define Business Object Knowledge Search Options
Use Knowledge mapping to determine what Knowledge sources can be searched during a Knowledge
search from a specific Business Object.

To define Business Object Knowledge Sources:

1. Open the Knowledge Mapping window.

2. In the Search From menu, select the Business Object for which you want to define the Knowledge
sources.

3. Define Fields Pulled for Categories options:
a. Categories: Select the field that should be included in the search (example: If you select

Service, Category, and Subcategory fields for an Incident record, the search will look in these
fields for matching items). The way the category values are used depends on the type and
definition of the Knowledge source.

b. Source Field for Text Search: Select the field from which the text will be pulled, by default, to
initiate a search. Typically, this is a description field.

4. Add Knowledge sources that you want available for the Business Object search:
a. Select the Add button.

The Knowledge Source Manager opens.

b. Select a Knowledge Source.

c. Select OK.c.

The Knowledge source displays in the knowledge sources list.

5. In the Open <Business Objects> Solution Goes Into section, define where found solutions should
be placed.

◦ Field: The data from the solution is placed in this field within the target Business Object.

◦ Journal entry: A new Journal entry is created on the target Business Object and the data from
the solution is used as the Journal text.

◦ Attachment: The <Business Object> solution is added as an attachment to the target
Business Object and appears on the attachment bar.

◦ Relationship: The <Business Object> solution is added to an existing relationship on the
target Business Object (example: There is typically a relationship between Incident and
Problem, so if a Problem is found, it is added to the selected field in the related Business
Object.)

6. Select OK.6.
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Import Knowledge
CSM integrates with KnowledgeBroker, Inc. so you can import pre-existing Knowledge Articles into CSM
via CSM Administrator. Users can search third-party Knowledge Articles from the Quick Search pane, the
Knowledge pane, or directly from forms (example: Incident).
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Configure a Business Object for Knowledge Import
By default, CSM is configured to import knowledge into the Knowledge Article Business Object. If you are
using an older version of the CSM content, or want to change the way in which the import takes place,
you can do this by setting attributes on the appropriate Business Object and fields.

1. Open CSM Administrator.

2. Create a Blueprint.

3. Specify which Business Object will be used for Knowledge.
a. Select the appropriate Business Object, and open the Business Object Properties window.

b. On the Advanced page, expand the General Attributes section, and add the Knowledge
attribute:

CSM 2022.3 Features 981

CSM 2022.3 Features



Note: You can have only one Business Object with this attribute. If you set it on
multiple objects, the first one that the system finds is used, so we recommend you
remove it from any other object.

4. Associate a field with the Knowledge attribute. Attributes are also used to associate different fields in
the Business Object with different pieces of knowledge data. For example, to retrieve the title of a
Knowledge Article (KA) into the title field of the Knowledge Business Object, open the Field
Properties dialog, select the Advanced page, and expand the General attributes section. Add an
attribute with the name Knowledge and the value Title:

There are a number of values for the knowledge attribute that can be set:

• Title: The title of the KA.

• Description: A short description of the article.
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• Details: The details/solution/actions to take to resolve the described issue.

• ProblemType: A general classification of the type of article. Expected values include "How to",
"Error Message", "Problem/Symptom" and "Usage Information".

• Source: The source of the KA. This will be set to KnowledgeBrokers during the import and can be
used to easily differentiate between imported vs. manually created KAs.

• Domain: The area of Knowledge being addressed, such as Microsoft Office.

• ArticleID: A unique identifier used to associate the Cherwell imported record with the original
KnowledgeBroker article. If this is not set, then Cherwell will not be able to tell whether it is updating
an article vs. importing a new article, and will create multiple versions of the same article.

• Keywords: These are a list of keywords related to the article that can help with categorization and
searching.

• LastImported: When the article was last imported.

Note: This may get updated during an import even if the article didn’t change. The reason
for this is to make it simpler to identify articles that are no longer current.

You can exclude any fields if you do not want to import that data. However, it is strongly recommended
that you include ArticleID.

CSM 2022.3 Features 983

CSM 2022.3 Features



Import Knowledge Wizard
Use the Import Knowledge Wizard to import third-party Knowledge bases that can be accessed from
within CSM.

Good to Know:

• When you import knowledge, it might be located in a number of directories. Just point to the root of
the knowledge directory, and CSM finds all of the appropriate files.

• You can create or import Knowledge Articles with embedded screenshots, numbered lists, and other
rich text formatting.

To import Knowledge:

1. In the CSM Administrator main window, select the Database category, and then select the Import
Knowledge task.

The Import Knowledge Wizard opens.

2. Read the welcome information and select Next.

The Server Location page opens.

3. Select the ellipsis button  to navigate to the location of the Knowledge Broker data.

The Browse For Folder window opens.

4. Select the folder that contains the knowledge data.

5. Select OK.5.

The window closes to return to viewing the Import Knowledge Wizard.

6. Select Finish.6.

A message window opens indicating that the import is complete.
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Configure Knowledge Security Group Permissions
Knowledge administrators use the CSM Administrator Security Groups window to configure security
group permissions for Knowledge Management.

1. In CSM Administrator select Security > Edit Security Groups. The Security Groups window
opens.

2. Select a group.
3. Select the Rights tab and set the applicable permissions. See Knowledge Security Rights for the

default security group rights for Knowledge.
4. Select the Business Objects tab.
5. In the Business Object drop-down list, select Knowledge Article, Incident Category, or Journal -

Comment and set the applicable permissions. See Knowledge Management Security Group
Permissions for the default security group Business Object permissions for Knowledge.
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Knowledge Article Workflow Design Ideas
CSM provides a Knowledge Article (KA) workflow with all the features you need to successfully manage
KAs. You can use this workflow as-is, or tailor it to meet the needs of your organization.

Design ideas include:

• Fields: Change which fields are required and when, which fields support rich text, etc.

• View Counter: Incrementally track the number of times a record is viewed by a customer or user in
the Desktop Client, Browser Client, and CSM Portal. View Counter functionality is configured in
CSM Administrator.

• Statuses: Change KA statuses and/or the One-Step™ Actions that are initiated when a KA enters
each status.

• Form: Change the form theme (background and text color), tab order, and size. Change the
popularity voting buttons.

• Email: Change the templates that are used to create the emails sent by One-Step Actions or
Automation Processes (example: "Approval Denied" One-Step Action). The email templates are
defined as part of the One-Step Action. Or, disable/change when and to whom notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that notify KA owners/teams of
assignments.

• Review Processes: Modify or eliminate the review processes.

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down fields (example: Article Type).
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Metrics
A CSM Metric is a stored measurement query whose value can be used to measure, monitor, and predict
service desk performance and trends (example: average time to resolve incidents).
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About Metrics
Use a Metric to measure, monitor, and predict:

• Input: Work coming into the service desk (example: Logged Incidents)

• Output: Work being completed by the service desk (example: Resolved Incidents).

• Status: Snapshot of data at a specific point in time (example: Open Incidents).

• Timeliness: In regard to SLA agreements of resolve/respond (example: Late Incidents).

• Thresholds: Work exceeding an expectation (example: More than 30 Incidents are open).

• Satisfaction: Level of service appreciation (example: Customer satisfaction rate—average survey
scores or % of surveys where survey scores are above 75%).

• Success: Value and Outcomes (example: First Call Resolution (FCR) rate—% of Incidents closed
on first call); SLA success rate (% of Incidents where SLA was met).

• Trends: Compare points in time (example: Increasing satisfaction).

• Cause: What caused the work (example: Printer Incidents).

• Individual and Team performance: Who is completing the work and how efficient they are
(example: Incidents per Team).

• Averages: Mean Time to Resolve (MTTR), Mean Time Between Failures (MTBF) for CIs, average
response time, etc.

A Metric value can be a:

• Query Value:

Based on a Search Query (ex: Open Incidents, SLAs warnings and breaches, records with unread
Journals, etc.). Queries can contain simple calculation functions (ex: Averages, such as Incident
MTTR).

• Calculation:

Calculated measurement that involves other values (can be other Metrics) and math operator
(example: FCR rate).

In CSM, a Metric can be used in:

• Expressions:

To conditionally control appearance and behaviors (example: Change a Widget's border color to red
if the FCR rate is less than 75 percent).

• Gauge Widgets:

To monitor service desk performance on Dashboards (example: Number of records, MTTR, FCR,
success, satisfaction).

• Queries:

CSM 2022.3 Features 988

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_create_query_value_metric
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_create_calculated_metric


To find/filter data (example: Find all surveys where the score is below the Customer satisfaction
rate).

Related concepts
Metric Caching
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Metric Caching
To increase performance, Metric values are stored (cached) on and retrieved from the local machine of
the Desktop Client user who requests the Metric. Once cached, the local user can retrieve any of the
cached values for use in a gauge widget, expression, or query.

How Metric Caching Works

• For the Desktop Client, when a Metric value is requested, a query is sent to the CSM database and
a result is retrieved. This result is stored (cached) on the local machine of the Desktop Client user
who requested the Metric so that it can be used as long as it is considered useful (or fresh). The
period of time that this cached Metric value is considered useful varies and is defined in the Metric's
definition. Highly dynamic Metric values might be useful for 5 minutes, while very static values might
be useful for a month. In any case, when a Metric value exceeds its usefulness (becomes stale), it
needs to be re-queried and re-cached.

Note: The cache value remains in memory until the user closes the Desktop Client, after
which it is written to a cache file on disk. After reopening the Desktop Client, the values from
the cache file are read from the file and stored in memory for future use. This allows data to
be saved when the user is not running CSM.

• For the Browser Client the cache from the hosted server is used, so the information is last-in/first-
out. Metrics may often calculate correctly for global information (all Incidents, all Change Requests)
but will not calculate correctly for widgets that are calculating for individuals, teams, and roles.

Metric Caching Example
The Metric value is defined to be useful for up to 10 minutes. The first time the Metric value is requested,
there is nothing in cache, so a query is sent to the database, and the result is stored on the Desktop
Client user's machine. The next time the value is requested, the behavior varies depending on how much
time has elapsed:

• If the Metric value is requested 5 minutes later, then the local cached value will be returned because
the value is still useful ("fresh enough") that a re-query is not required. That is true all the way up to
9 minutes and 59 seconds.

• However, if the Metric value is requested 11 minutes later, then the local cached value is not fresh
enough, so the database will be re-queried.

Frequency
The frequency at which Metric values are cached is determined by three factors:

• Session activity
Metric values are cached only when a session is active. Users likely closes their sessions every
night so Metric values will not be cached during the inactive session. A wallboard, which is always
running, might continually cache Metric values for extended periods of time.

• How often the Metric is requested
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Metric values are cached only when requested by a widget or dashboard refresh, or by initiating a
query or expression. (Metric values are not automatically gathered.) For example, live trends
dashboard might predictably auto-refresh every 30 minutes, an active user dashboard might auto-
refresh every 30 minutes but the individual widgets might be manually refreshed more often than
that by the user, and an expression might occasionally initiate a request.

• The amount of time the Metric is considered useful (fresh):
Metric values are re-cached only when their value is no longer considered useful (fresh). This
means that a request might not necessarily re-cache a Metric value. The time that a Metric value is
considered useful (example: 10 minutes, 24 hours, etc.) is defined in the Metric's definition.

Metric values are cached only when a session is active, only when requested, and only when the value is
no longer considered useful (fresh). Consider these factors when viewing Metrics, especially when
trending.

Using Cached Values
Desktop Client users can retrieve:

• Current value
Current Metric value, within context of freshness. In other words, retrieve the current usable (fresh)
value sitting in the user's local cache. If value is no longer considered fresh, the value will be re-
queried and re-cached (that is, synced with the database).

(Advanced property) You can also force a re-query each time the value is requested (that is, sync
with database); however, syncing affects performance and replaces the local cache value on the
user's machine, which could interfere with trending.

• Value from "last cache"
The Metric value from one cache ago (that is, the value that was cached right before the current
value).

• Past value
A previously cached Metric value that you specify. You can count back (example: From 1 minute
ago), specify by first of the month, quarter/year, or select a value from a specific weekday.

Note: Sometimes, the requested cached Metric value cannot be found (example: Values
were not cached during the time you requested). In this case, CSM returns a cached value
closest to the requested time (this cannot be the current value). If specifically requested,
CSM can instead return a specific defined value or the latest cached value (whatever is
currently sitting in cache; might or might not be considered fresh). To help indicate which
cached value was returned, users can also select to return the cached value's stored time
and whether or not the returned value was the original requested value or an alternate value.

Local Caching Trade-offs
Local caching improves performance because data is delivered faster and fewer requests are made to a
database. Local cache values are also stored and reusable, so you can use any value at any time. This is
useful for trending.
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However, local cached values can:

• Become stale
Metric values are static for a defined period of time, so values can quickly become outdated.

• Miss a sudden dip or spike
Metric values are static for a defined period of time, so you might not cache a sudden change in
data. For example, you might decide to re-cache a Metric value every 60 minutes. If a drastic event
happens at minute 32 but is corrected at minute 35, you will miss it.

• Vary from user to user
Metric values are cached locally, which means your cached vales and your colleague's cached
values might be different, even if they are cached within a few seconds of each other. For example,
you might calculate a closure rate of 50 percent because your values were 10 open and 5 closed
Incidents. Your colleague might calculate a closure rate of 55 percent because his values were 11
open and 5 closed Incidents.

Related concepts
About Metrics
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Metric Example
First Call Resolution (FCR) rate is a Metric that measures the percentage of Incidents that are closed on
the first call.

FCR rate could be calculated like this:

AllIncidentsClosedonFirstCall/AllClosedIncidents

Metric Definition
The Metric definition would look like this:

All IncidentsClosed on FirstCall/AllClosed Incidents

and would generate a decimal value like this:

.54
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Once created, you could use this Metric on a Gauge Widget, Expression, or Query.

Use the Metric in a Gauge Widget
Here is what the Metric could look like in a Gauge Widget:
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Note that on the Gauge, the Metric is formatted as a percentage.
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Note: You could also build the percentage into the Metric (example:
(AllIncidentsClosedonFirstCall/AllClosedIncidents) *100); however, you would then need to format
the value as a number; otherwise, you'll get an unexpected result (percentage of percentage).
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Use the Metric in an Expression
You could then use the same Metric in an Expression to conditionally change the border color of the
Gauge Widget to an Alert when the percentage falls below a satisfactory level (example: 75 percent).
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Metrics Good to Know
Use these tips for helpful information on Metrics.

It is important to understand Metric Caching when creating Metrics. For more information, see Metric
Caching.
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Using Metrics
In CSM, Metrics are used to measure and monitor service desk performance. Metrics can be used in:

• Gauge Widgets.

• Expressions.

• Queries.
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View a Metric
A Metric can be viewed several ways:

• Available Metrics (based on security rights): Use the Metric Manager.

• From a Gauge Widget, Expression, or Query that uses a Metric.
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Use Metrics in Gauge Widgets
A Metric can be used in a Gauge Widget to monitor service desk performance on a Dashboard.

For example, display:

• The total number of Open Incidents.

• Incident MTTR.

• An FCR rate.

• An SLA success rate.

• A Customer satisfaction rate.

A Widget can also use a Metric in an Expression to conditionally change its color if the Metric exceeds a
threshold (example: If there are more than 15 Open Incidents, an Expression can change the Widget
foreground color to an Alert color).
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Use Metrics in Expressions
A Metric can be used in an Expression to conditionally change appearance and behavior:

• Change appearance (color, text, and image):

For example, change a Widget's border color to red if the satisfaction rate (Metric) is less than 75
percent.

• Change availability (visibility/enabling):

For example, enable or make a Widget visible only when the satisfaction rate (Metric) is less than 75
percent.
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Use Metrics in a Query
A Metric can be used in Query Comparison Clauses to find/filter data. For example, find all records where:

• Survey score is below (less than) the Customer satisfaction rate (Metric).

• Respond/resolve times were more than (greater than) SLA success time (Metric)
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Managing Metrics
Metrics are managed in CSM using the Metric Manager.

There are several ways to open the Metric Manager.

Use the Metric Manager to complete general CSM Item Manager operations for Metrics, including:

• View a Metric.

• Create a Metric.

• Edit a Metric.

• Delete a Metric.

• Search for a Metric.

• Organize Metrics.

• Copy a Metric.

• Import/export a Metric.

• Find Metric dependencies.

• Pin a Metric.
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Open the Metric Manager
There are several ways to open the Metric Manager:

• From the CSM Desktop Client menu bar, select Dashboards > Metric Manager
• From the Blueprint Editor menu bar in CSM Administrator, select Managers > Dashboards >

Metric Manager.
• From the Token Selector in Queries and Expressions.

• From a Gauge Widget, right-click Widget > Widget Properties > Values page.
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Create a Metric
Use the Metric Properties window (accessed from within the Metric Manager) to create a Metric.

When you create a Metric, you can choose from these types:

• Query Value:

Based on a Search Query (ex: Open Incidents, SLAs warnings and breaches, records with unread
Journals, etc.). Queries can contain simple calculation functions (ex: Averages, such as Incident
MTTR).

• Calculation:

Calculated measurement that involves other values (can be other Metrics) and math operator
(example: FCR rate).

Good to know:

• Read Metric Caching before creating Metrics.

• Consider where the Metric will be used (example: Widget, Expression, or Query), how the Metric will
be used (just on a Widget, built into another Metric, etc.), what type of value you are seeking
(decimal, percentage, etc.) before creating Metrics. For example, if the Metric will be used in an
Expression to calculate another Metric value, make sure that the format is consistent—a percentage
value cannot be divided by a decimal value.
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Creating a Query Value Metric
Query Value Metric properties include:

• Limiting Criteria (Query): Which data/records to include in the Metric (example: All Open Incidents).

• Value: Type of value to display in the Metric (example: Number of Records, Function, or Duration).

• Local Cache Value: Amount of time the local cached value is considered useful (fresh) before the
value needs to be updated (re-queried and re-cached) (example: 5 minutes).

To create a Query Value Metric:

1. Open the Metric Manager.
2. (Optional) Select a scope and subfolder.
3. Select Create New.
4. Define the following Metrics properties:

Option Description

Name
Provide a display name within CSM (search
this property in CSM Item Managers).

Description
Provide a description to use within CSM
(search this property in CSM Item
Managers).

Metric Type
Select the Query Value radio button.

Business Object Select the Business Object whose data to
include in the Metric (example: Incident).

Note: Only one type of Business
Object can be selected. The drop-
down list displays only Major
Business Objects. To display all
Business Objects, select the Show
All check box.
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Option Description

Data Type Select the type of data (format) to return in
the Metric (select one):

◦ Date/Time
◦ Logical
◦ Number
◦ Text

5. Define the limiting criteria (example: All Open Incidents):
a. Select the Limiting Criteria page.
b. Search Criteria: Define which data/records to include (example: All Open Incidents). Use a

custom Search Query or a saved Search Query (Saved Searches) to locate/filter the data.

◦ Select the ellipses button  to open the Search Manager, and then select an existing
Saved Search or create a Saved Searches. Saved Searches can be used over and over
in numerous places.

◦ Select Custom Query  to open the Custom Query Builder, and then create a
custom Search Query to use only for this scenario.

6. Define the type of value to display in the Metric:
a. Select the Value page.
b. Select one value to display:

◦ Function: Select this radio button to display a value that calculates an average,
maximum, minimum, or total value based on a selected field. Then, select the function
and field (example: Display an average customer satisfaction rating).

◦ Number of records: Select this radio button to display the number of records that match
the criteria (example: 15 Open Incidents).

◦ Duration Function: Select this radio button to display a value that is calculated based
on an amount of time. Then, select the Start/End fields and the units (duration) (example:
Display the average amount of time that Incidents (meeting your criteria) take to resolve
each day (example: Start field = Created Date/Time, End field = Closed Date/Time, and
Units = Days).

◦ Optimize for database (for best performance): Select this check box to have the
system first check the metric cache for a recent version of the metric (if the current value
is less than 30 seconds old) before querying the database when a metric is loaded. If this
option is disabled, the system always queries the database for the latest value when
loading a metric.

7. Define the local cache value.

Note: Local cache value is the amount of time the local cached value is considered useful
(fresh) before the value needs to be updated (re-queried and re-cached). For more
information about Metric caching, see Metric Caching.

8. Select Save.
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Creating a Calculated Metric
Calculated Metric properties include:

• Calculated Value: Expression to determine the Metric value. For example, FCR rate could be
calculated like this:
(AllIncidentsClosedonFirstCall/AllClosedIncidents)

To create a Calculated Metric:

1. Open the Metric Manager.
2. Select a scope and subfolder (if needed).

3. Select Create New .
4. Define the following Metrics properties:

Option Description

Name
Provide a display name to use within CSM
(search this property in CSM Item
Managers).

Description
Provide a description to use within CSM
(search this property in CSM Item
Managers).

Metric Type
Select the Calculated radio button.

Business Object Select the Business Object whose data to
include in the Metric (example: Incident).

Note: Only one type of Business
Object can be selected. The drop-
down list displays only Major
Business Objects. To display all
Business Objects, select the Show
All check box.
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Option Description

Data Type Select the type of data (format) to return in
the Metric (select one):

◦ Date/Time
◦ Logical
◦ Number
◦ Text

5. In the Expression area, select Selector  (or right-click in the text box), and then add Tokens
(example: System Functions, Prompts, Expressions, Stored Values, Metrics, and Counters) and
Math Operators (example: Add, Subtract, Multiply, etc.) to create an Expression. Examples might
include:

◦ FCR Rate: (AllIncidentsClosedonFirstCall/AllClosedIncidents) would return a decimal value
like .54.

◦ Percentage of reopened Incidents: (AllReopenedIncidents/AllOpenIncidents)*100 would
return a whole number that is then converted to a percentage value, like 10 percent.

◦ Incident Success rate: (AllResolvedClosedIncidentswithinResolutionSLA/
AllResolvedClosedIncidents)*100 would return a whole number that is then converted to a
percentage value, like 85 percent.

6. (Optional) Right-click in the Expression text to access a context menu with options to delete an item,
access its properties, or add a Modifier (example: Number format).

Note: If using other Metrics in the Expression, you are prompted to define which Metric
values to retrieve for use in the Expression (Metric Properties window pops up when you
add a Metric). For details, refer to Using a Metric Within a Metric.

7. Select Save.
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Using a Metric Within a Metric
To use a Metric within a Metric:

1. Right-click a Metric in the Calculated Metrics window, and then select Properties.
2. Define the Value to Retrieve:

◦ Current value: Current Metric value, within context of freshness. In other words, retrieve the
current usable (fresh) value sitting in the User's local cache. If the value is no longer
considered fresh, the value will be re-queried and re-cached (that is, synced with the
database).

Note: (Advanced property) Select the Reload the current cache value each time
Metric is requested check box to force a re-query each time the value is requested
(that is, sync with database); however, syncing affects performance and replaces the
local cache value on the User's machine, which could interfere with trending.

◦ Value from [last cache]: The Metric value from one cache ago (that is, the value that was
cached right before the Current Value).

◦ Past value: A previously-cached Metric value that you specify. You can count back (example:
From 1 minute ago), specify by first of the month, quarter/year, or select a value from a
specific weekday.

3. Select the Define the Value to Return (Advanced property) check box to determine what happens
when a requested cached Metric values cannot be found. In this case, CSM returns a cached value
closest to the requested time. You can choose:

◦ Retrieved Value:
◦ Last cached value
◦ Cached value closest to requested time: The current value sitting in cache; may or

may not be considered fresh.
◦ Specific value

◦ Stored time of retrieved value
4. Click OK.
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Configuring Metrics
Metric Security rights are configured in CSM Administrator. See Metric Security Rights.
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Modifiers
A modifier is a token element that changes the visual format or calculated value of a token in a One-Step™
Action or expression.
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About Modifiers
Fields and tokens (stored values, other expressions) can be added when building One-Step Actions and
expressions.

For example, a field containing the customer's name can be added to a One-Step Action that sends an e-
mail to that customer to make the e-mail more personal. When adding a value, the way the field appears
depends on its data type:

• Text Fields: Shows the value.

• Number Fields: Shows a standard system format.

• Logical Fields: Shows the text as True or False depending on the value.

• Date/Time Fields: Shows in a sortable, standard format.

• Encryption: Store sensitive data, such as private API keys, user names, or passwords, as
encrypted.

• JSON: Shows JSON data.

• JSON Array: Steps through data from a JSON array.

• XML: Shows XML data.

• XML Collection: Steps through data from a set of XML elements that have the same structure.

While this is often sufficient, there are many situations where it is useful to format the value. For example,
when showing a date/time, a user might want to show only the date without the time.

Additionally, a user may want to manipulate the value. For example, the user may only want the first part
of a field’s value or change a value to be upper-case or lower-case.

Users can apply modifiers to tokens inserted into One-Step Actions and expressions to format and modify
the value that is ultimately shown or calculated.
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Modify/Format Value Window
Use the Modifiers window to create or edit modifiers on a particular token.

The Modifiers window consists of the following:

• A list of modifiers: Apply multiple modifiers to the same token. For example, take the first five
characters of a field, then change the value to upper-case and pad the value with leading Xs, etc.

To add modifiers, select Create New. Select Delete to remove modifiers. Modifiers are applied in
the order they appear in the list.

• Modifier details: Available modifiers depend on the data type of the selected token, as well as
additional arguments. A brief description of the modifier function appears at the bottom of the
window.
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Modifier Types
You can apply the following types of modifiers to tokens in CSM:

• Text: Shows a value or string of text (example: The Last Edited text on the Incident form).

• Date/Time: Shows or performs a date/time calculation (example: Calculate a 15-minute warning for
an SLA).

• Numeric: Shows or performs a mathematical calculation using a string of tokens and mathematical
symbols (example: Calculate the total cost of labor of a Labor Cost Item by multiplying the work
hours by the monetary rate).

• Logical: Uses one or more conditions to return a True or False value (example: Incident.Status
does not equal Closed).

• XML: Use to pull pieces of XML data (example: Returned from a web service call) into CSM in a
usable format.

• JSON: Use to pull pieces of JSON data (example: Returned from a web service call) into CSM in a
usable format.

• Encryption: Use to store private API keys, user names, and passwords as encrypted in the
database. Helpful when integrating CSM with other systems (example: Amazon Web Services,
Microsoft Teams).
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Text Modifiers
A text token displays a value or string of text.

An example of a text modifier is the Last Edited text on the Incident form.

The following modifiers can be applied to text tokens.

Note: Text modifiers are designed to target plain text only. Rich text content is not currently
supported.

As XML Returns text as an XML element.

Contains

Determines whether another string is contained within the source string. Example:

• Original token: Now is the winter of our discontent

• Modifier: Contains (winter)

• Result: True

Ellipse Text

Used to truncate a string if it is too long. If the string is longer than the specified length,
then the value has an ellipsis (…) added to the end.

Spaces are included in the character count for this modifier.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Ellipse Text (20)

• Result: Now is the winter…

Encode Text

Applies the selected encoding method to text. You can choose from:

• Base 64

• Backslash CR LF

• Backslash Quote

• Double Quote
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First Word

Returns the first word in a string.

Example:

• Original token: Now is the winter of our discontent

• Modifier: First Word

• Result: Now

Hash Text

Applies cryptographic hashing algorithms to text strings. This enables you to create
encrypted strings you can use to create tokens for APIs and to detect data changes.

Available hash formats:

• MD5

• SHA-1

• SHA-256

• SHA-512

By default, converted strings are converted to hex format and use UTF-8 encoding. To
shorten the strings, select the Base 64 check box.

Hash MAC
Text

Applies cryptographic hashing algorithms with Message Authentication signing to text
strings. Provide a Hash MAC (Message Authentication Code) Key for an extra level of
security.

By default, converted strings are converted to hex format and use UTF-8 encoding. To
shorten the strings, select the Base 64 check box.

Index of Text

Returns the position of another string within the source string. The index is 0-based, so if
the searched-for text is at the very beginning of the source, then the index is 0. If the
string is not found, then the return value is -1.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Index of Text (winter)

• Result: 11
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JSON
Encode

Converts a string into a value that can be used as JSON.

Example:

• Original token: some text "quoted text" other text slash \ more text

newline

• Modifier: JSON Encode

• Result: "some text \"quoted text\" other text slash \\ more text\nnewline"

Last Word

Returns the last word in a string.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Last Word

• Result: discontent

Left

Shows the left X-most characters from the original token, where X=6 in the example
below.

Spaces are included in the character count for this modifier.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Left (6)

• Result: Now is

Length of
Text

Counts the number of characters in the string.

Spaces are included in the character count for this modifier.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Length of Text

• Result: 35
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Lowercase

Converts any upper-case characters in the original token to lower-case.

Example:

• Original token: Now IS The Winter Of Our Discontent

• Modifier: Lower-case

• Result: now is the winter of our discontent

Pad Left

Inserts a particular character(s) to the left of a value to force the value to be a particular
length.

Example:

• Original token: ABC

• Modifier: Pad Left (0,7)

• Result: 0000ABC

Pad Right

Inserts a particular character(s) to the right of a value to force the value to be a particular
length.

Example:

• Original token: ABC

• Modifier: Pad Right (0,7)

• Result: ABC0000

Remove

Removes a particular value from the original token.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Remove (winter)

• Result: Now is the of our discontent
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Remove
Line Breaks

Removes line breaks to make the token fit on a single line.

Example:

• Original token: Now is the winter of our discontent,

• Made glorious summer by this son of York.

• Modifier: Remove line breaks

• Result: Now is the winter of our discontent,Made glorious summer by this son of
York.

Remove
White Space

Removes any white space characters from the tokens: line breaks, spaces, tabs.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Remove white-space

• Result: Nowisthewinterofourdiscontent

Replace

Replaces one value in the string with another on every occurrence.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Replace (winter, summer)

• Result: Now is the summer of our discontent

Right

Shows the right X-most characters from the original token, where X=6 in the example
below.

Spaces are included in the character count for this modifier.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Right (6)

• Result: ontent
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Substring

Shows a certain number of characters from the middle of the token. The start position for
a text string is considered to be 0, so Substring (0,6) is the equivalent of Left (6).

Spaces are included in the character count for this modifier.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Substring (11,6)

• Result: winter

Text After

Finds a value after a particular word or phrase inside of the token. There are several
options to control how this modifier operates:

• Next Word: Displays the next word after the search text.

• Next Number: Displays the next number after the search text. This will skip over
any text until it finds a number.

• To End: Returns all of the text that appears after the text to search for.

• To End of Line: Returns all of the text that appears after text to search for, up until
the end of the line.

This modifier is often useful when parsing email messages.

Example:

• Original token: This is regarding Incident: 1234 which is important

• Modifier: Text After (Next Word, Incident: )

• Result: 1234

• Modifier: To End of Line (Next Word, Incident: )

• Result: 1234 which is important

Text Before

Finds a value before a particular word or phrase inside of the token. There are several
options to control how this modifier operates:

• From Start: Returns the test that appears before the search text.

• From Start of Line: Returns all of the text that appears before the search text, up
until the end of the line.

• Previous Word: Displays the next word before the search text.

• Previous Number: Displays the next number before the search text.

CSM 2022.3 Features 1026

CSM 2022.3 Features



Text
Between

Returns all of the text that appears between two values in a token. This modifier is often
useful when parsing email messages.

We recommend using the following markers:

• ()

• {}

• *

Example:

• Original token: Please enter a description between {Here} and {There}

• Modifier: Text Between ({Here}, {There})

• Result: and

We do not recommend using angle brackets (<>) as markers; the E-mail and Event
Monitor reads HTML coding, and use of angle brackets as markers could cause
unintended results.

Text to
Logical

Converts a text value to a logical value. This is useful when reformatting a text value
based on whether the text result is equal to True or False.

The values True, T, Yes, and 1 are converted to True. Any other values are converted to
False.

Text to
Number

Converts the value in a text token to a number. Numeric Modifiers can then be applied to
the result. See Numeric Modifiers.

Example:

• Original token: 12345

• Modifier: Text to Number

• Result: 12345 (now available for Numeric Modifiers)
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Trim End

Trims specified characters from the end of a text string. Each character in the modifier is
evaluated, regardless of order. Repeated characters are removed.

The following example shows how to trim end characters from a string:

• Original token: 80906-1234

• Modifier: Trim -1234

• Results: 80906

The following example shows how to trim repeated characters from the end of a string:

• Original token: 123400005

• Modifier: Trim 05

• Results: 1234

The following example shows how to trim characters from the end of a string, regardless
of order:

• Original token: abcergzxy

• Modifier: Trim yxz

• Results: abcerg

Trim Start

Trims specified characters from the start of a text string. Each character in the modifier is
evaluated, regardless of order. Repeated characters are removed.

The following example shows how to trim start characters from a string:

• Original token: 719-386-7000

• Modifier: Trim 719-

• Results: 386-7000

The following example shows how to trim repeated characters from the beginning of a
string:

• Original token: 000051234

• Modifier: Trim 05

• Results: 1234

The following example shows how to trim characters from the beginning of a string,
regardless of order:

• Original token: abcergzxy

• Modifier: Trim cba

• Results: ergzxy
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Uppercase

Converts any lower-case characters in the original token to upper-case.

Example:

• Original token: Now IS The Winter Of Our Discontent

• Modifier: Upper-case

• Result: NOW IS THE WINTER OF OUR DISCONTENT

Uppercase
First

Converts only the first character to upper-case. This is often useful when working with
names and proper nouns.

Example:

• Original token: george

• Modifier: Upper-case first

• Result: George

URL Encode

Converts a string into a value that can be legally used as a URL.

Example:

• Original token: This <is> a test

• Modifier: URL Encode

• Result: This%20&lt;is&gt;%20a%20test
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Date/Time Modifier
A date/time token displays or performs a date/time calculation (example: Calculate a 15-minute warning
for an SLA). The format of the Date/Time value must be taken into consideration when applying date/time
modifiers to tokens.

The following modifiers can be applied to date/time tokens.

First of
Month

Returns the first day of the month for the specified date/time.

Example:

• Original token: 9/16/2021

• Modifier: First of Month

• Result: 9/1/2021

Last of
Month

Returns the last day of the month for the specified date/time.

Example:

• Original token: 9/16/2021

• Modifier: Last of Month

• Result: 9/30/2021

First of Year

Returns the first day of the year for the specified date/time.

Example:

• Original token: 9/16/2021

• Modifier: First of Year

• Result: 1/1/2021

Last of Year

Returns the last day of the year for the specified date/time.

Example:

• Original token: 9/16/2021

• Modifier: Last of Year

• Result: 12/31/2021

CSM 2022.3 Features 1030

CSM 2022.3 Features



First of
Week

Returns the first day of the week for the specified date/time. In the U.S., the first day of
the week is Sunday, but this can differ depending on location.

Example:

• Original token: 9/16/2021

• Modifier: First of Week

• Result: 9/13/2021

Last of
Week

Returns the last day of the week for the specified date/time. In the U.S, the last day of
the week is Saturday, but this can differ depending on location.

Example:

• Original token: 9/16/2021

• Modifier: Last of Week

• Result: 9/19/2021
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Date/Time Modifier Formats
Date/time modifier formats take the date/time values and converts them to text in a number of different
ways. The table below shows all of the supported formats, along with an example. The example date/time
is 12/4/2016 6:14 PM. Using an @ symbol in the format (example: 12/4/2016 @ 6:14 PM) causes
incorrect modifier outcomes.

After applying a date/time format, the resulting value is considered to be text. Users can then apply any
text operators to the value. For example, if you want to use the result as a number (example: Day), then
you need to use the Text to Number modifier.

Note: The formats may change depending on system settings. For example, the Short Date
format is based on the regional settings of the current user’s machine.

Date/Time Modifier Formats

Format Example

Short Date 12/4/2021

Short Time 6:14 PM

Long Date Thursday, December 04, 2021

Short Date & Time 12/4/2021 6:14 PM

Long Date & Time Thursday, December 04, 2021 6:14 PM

Sortable Date & Time 2021-12-04T18:14:13

Day 4

Day (with leading 0) 04

Day of Week (short) Thu

Day of Week (long) Thursday

Month (number) 12

Month (name) December

Year (short) 21

Year (long) 2021

Hour (12-hour) 6

Hour (12-hour with leading 0) 06

Hour (24-hour) 18

Minute 14

Minute (with leading 0) 014

AM/PM PM
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Format Example

Z

Client time zone

Note: For use with the CreatedDateTime
token. MM/dd/yyyy hh:mm:ss tt Z

Custom

Custom requires knowledge of the legal .NET date/
time formats. An example, however would be
something like: yy-M-d ddd which would return
21-12-4 Thu. See this resource for more information
on custom formatting.

Note: There is a Cherwell-specific custom
modifier for a client's local time zone. Use a
capital Z (capitalization is important) with
any date/time field
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Numeric Modifiers
A numeric token displays or performs a mathematical calculation using a string of tokens and
mathematical symbols (example: Calculate the total cost of labor of a Labor Cost Item by multiplying the
work hours by the monetary rate).

The format of the numeric value must be taken into consideration when applying numeric modifiers to
tokens.

The following modifiers can be applied to numeric tokens.

Absolute
Value

Returns the absolute value of the original.

Example:

• Original token: -42

• Modifier: Absolute Value

• Result: 42

Format See Numeric Modifier Formats.

Hours to
Time Format

Converts hours to a specified time format:

• DD:HH:MM:SS

• DD:HH:MM

• HH:MM:SS

• HH:MM
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Math

Allows for simple math operators to be applied against the value in the token.

Note: Users cannot use values from other tokens as part of the calculation. To use
values from other tokens in the calculation, use a Numeric Expression.

The math modifier supports these operators:

• Add: Adds a specific amount to the value.

• Subtract: Subtracts a specific amount from the value.

• Multiple: Multiplies the value by a specific amount.

• Divide: Divides the value by a specific amount.

• Absolute Value: If the value is negative, the value is made positive. Positive
values will remain unchanged.

• Modulo: Returns the remainder of a division calculation. Examples:
◦ 10%3 returns 1

◦ 5%3 returns 2

◦ 3%10 returns 3

In the last example, 3 is returned because the 3 divided by 10 is 0, with 3 as the
remainder.

Minutes to
Time Format

Converts minutes to a specified time format:

• DD:HH:MM:SS

• DD:HH:MM

• HH:MM:SS

• HH:MM

Number to
Logical

Converts a number to a logical value. This is useful when formatting a result based on
whether the value is 0 or not.

The value 0 will be converted to False. Any other value will be converted to True.

Round

Rounds a number to a specified number of decimal places.

Example:

• Original token: 33.75

• Modifier: Round (0 places)

• Result: 34
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Seconds to
Time Format

Converts seconds to a specified time format.

• DD:HH:MM:SS

• DD:HH:MM

• HH:MM:SS

• HH:MM

Truncate

Removes the decimal component of a number.

Example:

• Original token: 33.75

• Modifier: Truncate

• Result: 33
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Numeric Modifier Formats
As with date/time modifiers, numeric modifier formats can control the way in which numbers are
displayed. The table below shows the supported options along with an example of each. The examples
are based on the number 12345.67890.

Good to Know

• Several of the formats are based on the regional settings of the current user’s machine.

• After applying a numeric format, the resulting value is considered to be text, so any text operators
can then be applied to the value.

• Cherwell follows IEEE standards for rounding numerical values, specifically the round to nearest,
ties to even rule.

Format Example

Number 12345.68

Number (set decimals) 12345.7 (one decimal place)

General 12345.6789

Currency $12345.68

Currency (set decimals) $12345.678 (three decimal places)

Fixed Point 12345.68

Fixed Point (set decimals) 12345.679 (three decimal places)

Percent 1,234,567.89%

Percent (set decimals) 1,234,567.890% (three decimal places)

Scientific 1.234568E+ 004

Hexadecimal ABCD (from value 43981)

Custom

Requires knowledge of the legal .NET numeric
formats. An example: F3, which would return
12345.679. See this resource for more information
on custom formatting.
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Logical Modifiers
Logical tokens use one or more conditions to return a True or False value (example: Incident.Status does
not equal Closed).

There is only one supported operator for logical tokens, which is format. The format takes two values:

• Value if True: Value that is displayed if the logical token’s value is true.

• Value if False: Value that is displayed if the logical token’s value is false.

This allows for more flexible formatting of logical values than simply True or False.
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XML Modifiers
Use XML modifiers to pull pieces of XML data into CSM in a usable format. For example, use XML
modifiers with webhooks to parse, change, and use data between an external tool and CSM.

XML modifiers build on each other and typically must be used in conjunction with each other to return
useful values. In addition, field tokens can be used in the modifiers. See also Webhook Modifier
Examples.

Note: All XML should be inside a root container so that you can use modifiers to successfully find
it. Encapsulate the entire list in a root container as follows:

<directory>
<name id=”bob”>Value</name>
<name id=”Jane”>Value</name>
</directory>

The following modifiers can be applied to XML data. The examples use an XML collection that contains a
list of books.

<?xml version="1.0"?>
<catalog>
   <book id="B1001">
      <author>Johns, Jorge</author>
      <title>The Rest API</title>
      <genre>Computer</genre>
      <price>3.50</price>
      <publish_date>2016-03-15</publish_date>
      <description>An in-depth look at the REST API.</description>
      <in_stock>True</in_stock>
   </book>
   <book id="B1002">
      <author>Boberson, Bob</author>
      <title>XML Modifiers and You</title>
      <genre>Fantasy</genre>
      <price>
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         <priceUS>48.95</priceUS>
         <priceUK>48.96</priceUK>
      </price>
      <publish_date>2016-03-14</publish_date>
      <description>A book about XML Modifiers and you.</description>
      <in_stock>false</in_stock>
    </book>
</catalog>

Find Element
Returns an XML element with a specific name.

Example: Return the genre of the first book in an XML collection.

Modifier:

Result:

<genre>Computer</genre>

Find Element Collection
Returns an XML element that contains a series of common child elements.

Example: Find the collection of prices for the last book in the XML collection.
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Modifier:

Result:

<price>
   <priceUS>48.95</priceUS>
   <priceUK>48.96</priceUK>
</price>

Find Element with Attribute
Returns an XML element with a specific name and attribute.

Example: Find a book with the id attribute of B1002.

Modifier: Find Element with Attribute (book .id .b1002)
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Result:

<book id="B1002">
        <author>Boberson, Bob</author>
        <title>XML Modifiers and You</title>
        <genre>Fantasy</genre>
        <price>
           <priceUS>48.95</priceUS>
           <priceUK>48.96</priceUK>
        </price>
        <publish_date>2020-03-14</publish_date>
        <description>A book about XML modifiers and you.</description>
</book>

First Child
Returns the first XML child element of the current element.

Example: Return the first book in the XML collection.

Modifier:
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Result:

<book id="B1001">
       <author>Johns, Jorge</author>
       <title>The Rest API</title>
       <genre>Computer</genre>
       <price>3.50</price>
       <publish_date>2016-03-15</publish_date>
       <description>An in-depth look at the REST API.</description>
       <in_stock>True</in_stock>
</book>

Has Child Element(s)
Returns whether an XML element has child elements.

Example: Check to see if there are any elements in the provided XML collection.

Modifier: Has Child Element(s) ()
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Result:

True

Last Child
Returns the last XML child element of the current element.

Example: Return the last book from the XML collection.

Modifier: Last Child ()
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Result:

<book id="B1002">
         <author>Boberson, Bob</author>
         <title>XML Modifiers and You</title>
         <genre>Fantasy</genre>
         <price>
             <priceUS>48.95</priceUS>
             <priceUK>48.96</priceUK>
         </price>
         <publish_date>2020-03-14</publish_date>
         <description>A book about XML modifiers and you.</description>
</book>

Logical from Element
Returns a logical value from a specified XML element.

Example: Check if the second book in the XML Collection is in stock.

Modifier: in_stock
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Result:

False

Number from Element
Returns a numerical value from a specified XML element.

Example: Find the price of the first book in the XML collection.

Modifier: price
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Result:

3.5

String from Attribute
Returns a string value from a specified attribute on the current XML element.

Example: Find the ID of the first book in the XML collection.

Modifier: id
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Result:

B1001 

String from Element
Returns a string value from a specified XML element.

Example: Retrieve the author's name from the first book in the XML collection.

Modifier: author
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Result:

Johns, Jorge

XPath (element)
Returns an XML element based on the provided XPath.

Note: Version 1.0 of XPath is supported; version 2.0 is not supported.

Example: Retrieve the USA Price of the second book in the XML collection.

Modifier: //book[2]/price/priceUS
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Result:

 <priceUS>48.95</priceUS> 

XPath (value)
Returns a value based on the provided XPath.

Note: Version 1.0 of XPath is supported; version 2.0 is not supported.

Example: Return the value of the second book in the XML collection.

Modifier: //book[2]

CSM 2022.3 Features 1050

CSM 2022.3 Features



Result:

<book id="B1002">
     <author>Boberson, Bob</author>
     <title>XML Modifiers and You</title>
     <genre>Fantasy</genre>
     <price>
        <priceUS>48.95</priceUS>
        <priceUK>48.96</priceUK>
     </price>
     <publish_date>2016-03-14</publish_date>
     <description>A book about XML Modifiers and you.</description>
     <in_stock>false</in_stock>
</book>

Related concepts
JSON Modifiers
Webhook Modifier Examples
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JSON Modifiers
Use JSON modifiers to pull pieces of JSON data into CSM in a usable format. For example, use JSON
modifiers with webhooks to parse, change, and use data between an external tool and CSM.

JSON modifiers build on each other and typically must be used in conjunction with each other to return
useful values. In addition, field tokens can be used in the modifiers. See also Webhook Modifier
Examples.

The following modifiers can be applied to JSON data. The examples use a JSON collection from a store.

Date Time from Element
Returns a date time value from a specified JSON element.

Example: Retrieve the return date value for the bike in the JSON collection.

Modifier:
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Result:

2012-04-23T18:25:43

Find Array
Finds and returns a JSON array from a specified name.
Example: Retrieve the list of books from the store's JSON collection of inventory.

Modifier:
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Result:

Information

[
{
"category": "reference",
"author": "Nigel Rees",
"title": "Sayings of the Century",
"price": 8.95
},
{
"category": "fiction",
"author": "Evelyn Waugh",
"title": "Sword of Honour",
"price": 12.99
},
{
"category": "fiction",
"author": "Herman Melville",
"title": "Moby Dick",
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"isbn": "0-553-21311-3",
"price": 8.99
},
{
"category": "fiction",
"author": "J. R. R. Tolkien",
"title": "The Lord of the Rings",
"isbn": "0-395-19395-8",
"price": 22.99
}
]

Find Object
Finds and returns the JSON object from a specified name.
Example: Retrieve the bicycle object from the JSON collection.

Modifier:

Result:

{
"color": "red",
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"price": 19.95,
"used": "True",
"returnDate": "2012-04-23T18:25:43.5111Z"
}

JSON Path (replace)
Uses a JSON path query to replace a value within a JSON document.
Example: Update the price of the bicycle to 20.95.

Modifier:

Result: (Full JSON value is returned with updated value from replace)

JSON Path (value)
Returns a single value based on the provided JSON path.
Example: Find a book with a price less than $8.99.

Modifier:
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Result:

{
"category": "reference",
"author": "Nigel Rees",
"title": "Sayings of the Century",
"price": 8.95
}

JSON Path (array)
Returns an array of values based on the provided JSON path.
Example: Find books with a price greater than $10.00.

Modifier:
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Result:

[
{
"category": "fiction",
"author": "Evelyn Waugh",
"title": "Sword of Honour",
"price": 12.99
},
{
"category": "fiction",
"author": "J. R. R. Tolkien",
"title": "The Lord of the Rings",
"isbn": "0-395-19395-8",
"price": 22.99
}
]

Logical from Element
Returns a logical value from a specified JSON element.
Example: Retrieve the previously owned value for the bicycle in the store.
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Modifier:

Result:

True 

Number from Element
Returns a numerical value from a specified JSON element.
Example: Retrieve the price of the 4th book.

Modifier:
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Result:

22.99 

String from Element
Returns a string value from a specified JSON element.
Example: Get the title of the 3rd book in the JSON collection.

Modifier:
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Result:

Moby Dick 

Goto Array Index
Returns the JSON object at the specified index of the JSON array.
Example: Go to the 2nd book in the JSON collection.

Modifier: (array index values start at 0)
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Result:

{
"category": "fiction",
"author": "Evelyn Waugh",
"title": "Sword of Honour",
"price": 12.99
}

{
Related concepts
About Tokens
Define Actions Using XML Collections and JSON Arrays
Webhook Modifier Examples
Related tasks
Define a Step Through Collection Action
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Using Modifiers
When working with modifiers, users can access and apply modifiers.
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Access Modifiers
To access modifiers while working with One-Step™ Action and expressions:

1. Right-click to insert new tokens (example: fields, expressions, stored values, etc.) or use the existing
tokens.

2. Double-click the token text, or right-click and select Modifiers to access available modifiers for that
token.

Note: If the token has custom properties (such as a Prompt option), then double-clicking
displays the properties for the Prompt but not the modifiers. In this case, users must use the
right-click (context) menu.

The Modify/Format Value window opens.
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Apply Modifiers
Use the Modify/Format Value window to add modifiers to tokens. The type of modifier you can add
depends on the token.

To apply a modifier:

1. Right-click a Token in a One-Step™ Action or expression.

2. From the context menu, select Modifiers.

The Modify/Format Value window opens showing a list of existing modifiers in the left pane.

3. Select a Modifier from the list to edit an existing modifier. To create a new modifier, select Create
New.

4. Select the type of modifier you want for the token from the modifiers drop-down list.

5. Select OK.5.

The modifier is applied to the selected token.

View the new modifier, as well as existing modifiers, by opening the Modify/Format Value window
for that token again.
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Encryption Modifiers
When integrating CSM with other systems (Examples: Amazon, Microsoft Teams) you may be required to
store private information such as API keys, user names, and/or passwords in the CSM database. This
information is sensitive, so Cherwell provides CSM encryption resources that you can use within your
system to ensure secure storage and communication of that sensitive data.

Encryption modifiers are only available in certain contexts, such as within One-Step™ Actions,
expressions, or prompts.

What You Need for Encryption

• Encryption Key (stored value): This key is system-generated and is unique to each customer. To do
this, create an empty stored value called Cherwell Encryption Key. As the encryption and decryption
modifier will not work without this piece, you may want to create a One-Step Action or Action Block
to ensure that the stored value is populated, and if not, generate a value.

• Nonce (field data or stored value): A nonce is a random value and is combined with the Cherwell
encryption key to hash a string.

◦ Field data: This string must be entered via a One-Step Action, because a modifier needs to be
applied to encrypt the string. If storing the data on a record, link to a One-Step Action from the
form to add the value, rather than allowing direct entry into the field.

◦ Stored Value: If the nonce in a stored value, as is often the case with One-Step Actions, set a
One-Step Action to run on publish of the solution and prompt the user for the value. This
allows encryption to happen via a One-Step Action, rather than directly providing a stored
value that contains plain-text sensitive data.

• Data String (field or stored value): This string needs to be entered via a One-Step Action because a
modifier must be applied to encrypt the string. If storing the data on a record, an action on the form
can add the value. If it's in a stored value, a One-Step Action ran on publish of the One-Step Action
can prompt the user for the value and encryption can happen then.

Once you encrypt the string with an encryption key and nonce, you will need these exact values to
decrypt it.

Encryption Key and Nonce (Cherwell-Generated)
Data strings of a sensitive nature should be encrypted and stored in CSM in the Business Object field.
With every request to the other system, the string must be decrypted at the point of use. The encryption
and decryption actions require both a Cherwell-generated encryption key and a nonce.

The Cherwell-generated encryption key is generated and stored only one time, and the value of the key
remains constant. This key is stored globally and should be protected so that it's never overwritten. One
option is to add the global value into an Action Block that makes sure that it's only populated if it doesn't
already have a value. You can also add other protection measures such as scoping so that only a
designated set of people are allowed to write to the storage location.

The Cherwell-generated nonce is an arbitrary value that is unique to each Business Object. The nonce
value is stored per account record as a stored value, depending on the situation. If the string you want to
encrypt is stored on a Business Object record, the nonce used for encryption should live on the record as
well. If the string you want to encrypt is in a stored value, then your nonce should also be a stored value.
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Note: Each solution that uses a stored value nonce should include its own stored value. This
minimizes the impact of a nonce changing or being compromised.

Security and Scope
All configuration to the data string and the Cherwell-generated encryption key and nonce is performed in
CSM Administrator within a Blueprint. As a precaution to protect sensitive data, the encryption key stored
value, nonce field, and the encrypted data string should be scoped so that only appropriate users can
read and modify the values.

Create Fields for Storing the Data String and Nonce
As a best practice, store the data string and nonce inside text fields in the Business Object that is used for
the request. Once the fields are available, you can run the One-Step Action that stores the data string and
Cherwell-generated nonce directly inside text fields.

To create the text fields:

1. In CSM Administrator, create or edit a Blueprint, and then open the Business Object.

2. Add a text field for the external key. The key is populated through the One-Step Action that you
create in the following step.

3. Create a text field for the Cherwell-generated nonce. This field is populated by setting its default
value as the output of the GenerateEncryptionNonce system function in the Field Properties
window.

4. Change the default character length of the text field that you created in the previous step to 100
characters. The default length is 15 characters.

5. Save and publish your changes.

Create an Action Block to Populate the Encryption Key Stored Value
Create an Action Block that populates a stored value containing the Cherwell-generated encryption key.
This Action Block is used in a One-Step Action that decrypts the external key and passes through the
HTTP request header.

The Action Block first uses an expression to check for the stored value. If it does not exist, a system
function is called to generate the encryption key and store it on the Business Object field. The encryption
key is generated and stored only one time. From that point forward, when the Action Block is triggered in
the One-Step Action, the expression confirms that the stored value exists and moves to the next step.

The default expression must have the "Terminate parent One-Step Actions and Action Blocks" option
disabled.

Note: Before creating the Action Block, create a stored value for the Cherwell-generated
encryption key.

To create the Action Block:
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1. In CSM Administrator, select Managers > Action Blocks to open the Action Block Manager.

2. In the General tab, in the Name field, provide an intuitive name (example: Encryption Key).

3. Drag the Decide Between Multiple Cases action from the Advanced Actions section in the
designer toolbox on to the editor as the first step.

4. Configure Case 1 with a custom expression:
a. In the Value field, select the stored value that you created for the Cherwell-generated

encryption key. This key is used with the Cherwell-generated nonce to encrypt and save the
data string on the Business Object Form.

b. In the Operator field, select Empty.

5. Configure the first decision step to take action when the stored value is empty:
a. Drag the Update Variables and Stored Values action from the Advanced Actions section in

the designer toolbox on to the step.

b. In the General tab, in the Stored Value field, select the stored value that you created for the
Cherwell-generated encryption key.

c. In the Value field, select the GenerateEncryptionKey system function.

Related tasks
Create an Action Block
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One-Step Actions
A One-Step™ Action is an entity that initiates one or more defined Actions (example: Create an Incident
record).

Related concepts
Open the One-Step Action Manager
Open the One-Step Editor
Open the Action Manager
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About Actions
An Action is an activity that can be initiated manually from a button, link, menu bar item, or widget or
automatically from an Automation Process, One-Step™ Action, or Email Monitor to execute a command
or display/run a CSM item For example, you can use an Action to print a record, display a dashboard, or
run a search.

Use Actions to:

• Run a Command, One-Step Action, report, or search.

• Display a CSM item, such as an Action Catalog, calendar, dashboard, Document Repository, HTML
page, or visualization.

Note: Actions vary depending on the location from which they are initiated. For example, an
Action to display a Document Repository can be initiated from a CSM Portal menu bar, but
not from a toolbar in the Desktop Client.

In general, Actions can be initiated from the following major areas:
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• CSM Desktop Client toolbar.

• CSM Desktop Client Task Pane.

• Automation Processes.

• One-Step Actions.

• Business Objects: As record-specific Actions on the CSM Desktop Client toolbar, menu bar, context
menu, and Task Pane. Automatic Actions can also be executed when a Business Object is saved.

• Dashboards: As buttons, links, and widgets.

• Forms: As buttons and links.

• CSM Portal: Menu bar, dashboard widget, or HTML page.

• Cherwell Mobile: As record-specific Actions run from a mobile device.

In addition, you can initiate Actions from the following:

• E-mail and Event Monitor: As Actions for processing monitored e-mails.

• Approvals: As Actions that are run when an Approval is approved, denied, or expired.

• Scheduled Items: As Actions that are run on a scheduled basis.

CSM provides many OOTB Actions on the CSM Desktop Client Task Pane, menu bar, and toolbar, as well
as on forms, dashboards, and default CSM Portal site. Use these Actions as-is, edit them, or add your
own Actions.
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Actions Good to Know
• Actions vary depending on the location from which they are initiated. For example, an Action to

display a Document Repository can be initiated from a Customer Portal menu bar, but not from a
toolbar in the Desktop Client.

• System administrators can add Actions to the CSM Desktop Client toolbar and Task Pane (Global or
Role), Customer Portals, Business Objects, Automation Processes, Dashboards, and One-Step
Actions.

• Users can add Actions to the CSM Desktop Client toolbar and Task Pane (Personal/User),
Dashboards, and One-Step Actions (and, in some cases, modify the Global or Role defaults created
by the system administrator).

Business Object Actions

• Actions that access or update Business Object data require at least one Business Object to be
available within the One-Step Action. A Business Object can be made available in a One-Step
Action by:

◦ Selecting a Business Object association (either the current record or an available Business
Object in the Association drop-down on the One-Step Action Manager toolbar). A Business
Object association can only be selected when a One-Step Action is first created and cannot be
changed for an existing One-Step Action.

◦ Creating it using a Create a New Business Object Action preceding the Action that requires
Business Object access (in the One-Step Editor).

◦ Navigating to it using a Go to a Record Action preceding the Action that requires Business
Object access (in the One-Step Editor).

• Some Business Object Actions allow you to select which Business Object to execute against, if
more than one is available within a One-Step Action. Options can include one or more of the
following, depending on which Business Objects are available:

◦ Original Business Object from the Association (selected when the One-Step Action is created).

◦ Business Object from a Create a New Business Object Action preceding this Action.

◦ Business Object from a Go To a Record Action preceding this Action.
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Managing Actions
CSM provides several tools for managing Actions.

• Action Manager: Contains various types of Actions, including displaying Action Catalogs,
Calendars, Document Repositories, and Visualizations; executing commands; and running One-
Step Actions, Reports, and Saved Searches. The Actions available in the Action Manager depend
on the location from which you are accessing it.

• Actions Menu: A drop-down menu that contains a list of available Actions.

• CSM Item Managers: When you select an Action from an Actions menu, the appropriate CSM Item
Manager opens, from which you can select the specific CSM Item to display/run (or the specific
command to execute for Command Actions). Select a specific item, edit an item, or create a new
item on the fly. The Managers available from an Actions menu vary depending on your location in
CSM.

• Command Manager: A specific CSM Item Manager that opens when you select a Command Action
from an Actions menu. You can view and select specific commands, but you cannot create, edit, or
delete them (they are built into the system). The commands might vary depending on where the
Command Manager is accessed.

• One-Step Action Manager: When creating One-Step Actions, you select Actions from the Actions
pane in the Visual Workflow One-Step Action Designer and add them to the Designer Board in the
desired sequence. If you are adding a One-Step Action to a CSM area, you select it from either the
Action Manager (if One-Step Actions are one of several types of Actions that can be selected for an
area) or One-Step Action Manager (if One-Step Actions are the only type of Action that can be
selected for an area).

Note: Adding Actions to some areas might look different than the tools listed above. For
example, Approval Actions are defined in a specific window using a list of check boxes.

• Action Block Manager: Use the Action Block Manager to build reusable sets of Actions. The Action
Blocks are then available in the One-Step Editor under the Action Blocks section of the Actions
pane.
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Action Manager
Use the Action Manager to complete general CSM Item Manager operations for Actions.

Your ability to perform certain operations for items in certain scopes might be limited by your security
rights. However, regardless of security rights, the available operations for commands are extremely
limited because commands are built into the system. For more information, see Command Manager.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

Click the Clear button  to clear an Action or item that was previously selected for a CSM area.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

In some cases (example: One-Step Actions), you might see an Association drop-down menu on the
toolbar. This is for Actions and items that are associated with particular Business Objects.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Culture selector:
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Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

5. Action Pane:

Displays the categories from which Actions, or items that will be initiated through Actions, are
selected. The available categories vary depending on the location from which the Action Manager is
launched.

6. Action tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

7. Main Pane:

Displays items by view (icon, list, or details [grid]) and lists search results when a search is run.

For certain categories, what you see in the Main pane can also be filtered by Business Object
Association (appears on the toolbar if applicable).
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Actions Available from the Action Manager
The following Actions are available from the Action Manager when you open it from specific areas in
CSM. The Actions that are available for you to add to certain areas depend on where you are accessing
the Action Manager.

Action Description CSM Area

Action Catalog Displays an Action Catalog (Widget).
Buttons and Links

Command Palette Widget

Calendars Displays a Calendar.

Task Pane

Buttons and Links

Command Palette Widget

Commands Executes a command.

Task Pane

Buttons and Links

Command Palette Widget

Dashboards Displays a Dashboard.

Task Pane

Buttons and Links

Command Palette Widget

Doc Repositories Displays a Document Repository.

Task Pane

Buttons and Links

Command Palette Widget

One-Step Actions Runs a One-Step Action.

Task Pane

Business Object (Print Options)

Buttons and Links

Command Palette Widget

Other Widgets/Automatic Actions*

HTML pages Displays an HTML page. Command Palette Widget

Reports Runs a Report.

Task Pane

Business Object (Print Options)

Buttons and Links

Command Palette Widget
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Action Description CSM Area

Searches Runs a Saved Search.

Task Pane

Buttons and Links

Command Palette Widget

Visualizations Displays a Visualization.

Task Pane

Buttons and Links

Command Palette Widget

*Applies to Action Catalog, RSS Feed, and Twitter Feed Widgets. Because One-Step Actions are the only
Actions that can be added to these Widgets, they are selected directly from the One-Step Action Manager
rather than the Action Manager. The same is true for Automatic Actions in a Business Object.

Note: Some Actions might be limited in the Browser Client.
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Open the Action Manager
There are several ways to open the Action Manager:

• From CSM Administrator:
◦ In the Task Pane Section window (when configuring Global/Role Task Pane settings), click

Add.

◦ In the Menu page of the Site Editor (when defining menu bar properties for a Portal Site), click

the Ellipses button  next to the Action field to select a different Action or clear the selected
Action.

◦ In the Business Object Actions window (when defining Actions for a Business Object), click the

Ellipses button  next to the Action field to select a different Action or clear the selected
Action.

◦ In the Choose Action window (when defining Control properties for a Link Label Control or

Button Control on a Form), click the Ellipses button .

◦ In the Outlook Integration - Condition and Action window (when defining available Actions for

an Outlook Integration configuration), click the Ellipses button  to select a different Action
or clear the selected Action.

• From the CSM Desktop Client:
◦ In the Task Pane Section window (when defining User Task Pane settings), click Add.

◦ From a Dashboard Widget button or link: Right-click Widget Properties.
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Actions Menu
Use the Actions menu (accessible by clicking the Add Action button) to quickly add Actions to areas such
as CSM Desktop Client toolbars, Business Objects, or a Customer Portal.

Depending on where you are accessing the menu, a combination of different types of Actions are
available from the Actions menu:

• Action Catalog: Displays an Action Catalog (Widget).

• Calendar: Displays a Calendar.

• Command: Executes a command.

• Dashboard: Displays a Dashboard.

• Doc Repository: Displays a Document Repository.

• One-Step™ Action: Runs a One-Step™ Action.

• Page: Displays an HTML page.

• Report: Runs a Report.

• Search: Runs a Saved Search.

• Visualization: Displays a Visualization.

When you select an Action, the appropriate CSM Item Manager opens. From the Command Manager,
select a specific CSM item to display/run (or specific command to execute for a Command Action). The
items available for you to select might differ depending on where you are adding the Action (example: Edit
commands are available for CSM Desktop Client toolbars but not for a Customer Portal).

Some CSM Item Managers support adding a CSM Item to your personal Task Pane or a custom toolbar
directly from the CSM Item Manager (example: In the Dashboard Manager, add a Dashboard to your
toolbar). For more information, see CSM Item Managers and adding CSM items to the Task Pane or
toolbar.
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Command Manager
Commands are built into the system and can be added to CSM menus, toolbars, Task Panes, Business
Objects, Customer Portals, and Dashboards.

Use the Command Manager, accessed from the Actions menu, to complete the following operations:

• View: Displays commands by Icon (image), List (by name), or Details (sortable Grid view). You can
filter by scope in the Manager tree.

• Search: Runs a search that locates and lists all commands whose display name and description
contain a specific word or phrase. For more information, see Search in a CSM Item Manager.

• Pin Commands to a Pinboard (in the Command Manager) and MRU list (in the CSM Desktop Client
menu bar) to make them easily accessible in CSM.
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Open the Command Manager
There are several ways to open the Command Manager:

• From CSM Administrator:
◦ From the Business Object Actions window (when defining Actions for a Business Object), click

the Actions menu, and then select Add Command Action to add a command to a Business
Object's menu bar, Task Pane, toolbar, or context menu.

◦ From the Menu page of the Site Editor (when defining menu bar properties for a Portal Site),
click the Actions menu, and then select Add Command Action to add a command to the
Portal menu bar.

• From the CSM Desktop Client:
◦ From the New Toolbar window (when creating a User toolbar), click the Actions menu, and

then select Add Command Action to add a command to the User toolbar.

◦ From a Dashboard Widget button or link: Right-click>Widget Properties, select a Command
Action.
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Add Actions to CSM Areas
You can add an Action to the following major CSM areas:

• CSM Desktop Client toolbars.

• CSM Desktop Client Task Pane.

• Dashboards.

• Forms.

• One-Step Actions.

• Automation Processes.

• Business Objects (as record-specific Actions on the toolbar, menu bar, context menu, and Task
Pane). Automatic Actions can also be executed when a Business Object is saved.

• Portal (menu bar, Dashboard Widget, or HTML Page).

• Cherwell Outlook Add-In (as record-specific Actions you can run from Microsoft Outlook).

• E-mail and Event Monitor (as Actions for processing monitored e-mails).

• Approvals (as Actions that are run when an Approval is approved, denied, or expired).

• Scheduled Items (as Actions that are run on a scheduled basis).
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Add an Action to a CSM Desktop Client Toolbar
You can add Actions to:

• User toolbars: Personal CSM Desktop Client toolbars Users create to initiate Actions that are
important to them.

• Global/Role toolbars: Toolbars a system administrator creates for all Users or for Users in particular
Roles.

For example:

• Run a One-Step Action (example: Open the Cherwell Support site).

• Display/run a CSM Item (example: Dashboard, Calendar, Visualization, etc.).

• Execute a command (example: Open the Search Manager).

CSM 2022.3 Features 1083

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_user_toolbar
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_custom_global-role_toolbars


Add an Action to a CSM Task Pane
You can add Actions to:

• Personal Task Pane: Personal CSM Desktop Client Task Panes Users create to initiate Actions that
are important to them.

• Global/Role Task Panes: Task Panes a system administrator creates for all Users or for Users in
particular Roles.

For example:

• Run a One-Step™ Action (example: Create a Business Object record).

• Display/run a CSM Item (example: Dashboard, Calendar, Visualization, etc.).

• Execute a command (example: Open your CMDB).
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Add an Action to a Dashboard
A Dashboard is a configurable, interactive, and insightful console capable of initiating commands and
Actions. Dashboards provide real-time, at-a-glance information through the use of filterable, configurable
Widgets (Action Catalogs, Websites, Buttons and Links, Charts, Command Palettes, Gauges, Matrixes,
Search Controls, Search Results, Twitter Feeds, RSS Feeds, and Shapes).

Add Actions to the types of Widgets so they can be launched directly from a Dashboard:

• Action Catalog Widget: Displays a self-building and dynamic list (catalog) of executable Actions.

• Command Palette Widget: Displays a list of commands (Actions).

• RSS Feed Widget: Displays frequently updated information, such as news or blog entries, from a
particular feed.

• Twitter Feed Widget: Displays entries from a Twitter Account or search.

• Buttons and Links: Execute single commands.
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Add an Action to a One-Step Action
A One-Step™ Action is an entity that initiates one or more defined Actions (example: Create an Incident
record). A One-Step Action is made up of a series of Actions and can be simple (a few Actions) or
complex (multiple Actions that run under conditional circumstances). Numerous Actions are available to
add to a One-Step Action.

One-Step Actions are also a type of Action you can add to various areas within CSM:

• CSM Desktop Client Task Pane and various Dashboard Widgets: Select the One-Step Action
category in the Action Manager and then select a specific One-Step Action (or create your own).

• CSM Desktop Client toolbar, Business Objects, and Customer Portal: Click Add One-Step Action
in the Actions Menu to open the One-Step Action Manager and select a specific One-Step Action
(or create your own).

• Automation Processes: Select One-Step Action as the type of Action to add to an Automation
Process.
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Add an Action to an Automation Process
Automation Processes allow CSM Users to automate behavior by creating rules for the system to follow.
Define Actions for an Automation Process to automatically execute when certain criteria are met
(example: Automatically send an e-mail if a Change Request exceeds its end date by 4 hours). Add
Actions to all three types of Automation Processes:

• Simple Action/Event Process: Launches a One-Step™ Action or Action after a specific Event
occurs.

• Threshold-Based Process: Watches a value and performs an Action after a threshold is crossed.

• Visual Workflow Process: Defines a sequence of time-based and Event-based steps that manage a
Business Object as it passes through various stages.
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Add an Action to a Business Object
Business Object Actions allow you to define which Actions appear in the menu bar, Task Pane, and
toolbar of a specific Business Object. For example:

• Add a Reset Password One-Step™ Action to an Incident menu bar and/or Task Pane so that Users
can quickly initiate the Action directly from an Incident record.

• Define Actions that execute automatically when a record is saved, updated, or changes status
(example: Send a follow-up e-mail when an Incident changes status).

• Add Actions to link labels and buttons directly on Forms (example: Add a button to an Incident that
launches a command to initiate a remote support session).

Many Actions are available in the OOTB Business Objects to facilitate working with records. Use these
as-is, edit them, or add your own Actions.
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Add an Action to a Customer Portal
Portal Actions are customizable Actions that can be added to/executed from the Portal Menu Bar, a
Dashboard, or an HTML page. For example, you can:

• Display create commands for the Business Objects used on the Portal Site (example: Create
Incident).

• Display common Searches (example: Search My Open Incidents).

• Display a Home button on the Portal menu bar to take Customers back to the Startup Item.

• Display/run a CSM Item (example: Action Catalog, Report, and Document Repository).

• Launch a CSM Item Manager so that a Customer can select a CSM Item to display/run.

• Run a One-Step™ Action to run one or more other Actions.

• Display an MRU (Most Recently Used) list.

• Display a Business Object drop-down.
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About One-Step Actions
A One-Step™ Action is made up of a series of Actions and can be simple (a few Actions) or complex
(multiple Actions that run under conditional circumstances). Use One-Step Actions to automate common
or repetitive tasks.

For example, you can use One-Step Actions to:

• Create a file for all Incidents that have been open for more than a week, and then e-mail it to the
manager (simple example with no conditions).
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• Create a Change Request from an Incident, and then notify the change owner via e-mail (complex
example with multiple Actions and conditions).
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• Run One-Step Actions from the One-Step Action Manager or from a variety of places within CSM,
including:

• CSM Desktop Client toolbars (either User or Global/Role).

• CSM Desktop Client Task Pane (either User or Global/Role).

• Business Object records (as record-specific One-Step Actions on the toolbar, menu bar, context
menu, Task Pane, a button, or a link). One-Step Actions can also be Automatic Actions that are
executed when a Business Object is saved.

• Browser Client (from the menu bar; as buttons, links, and Widgets on Dashboards; as buttons and
links on Business Object records, or as record-specific Actions in a context menu).

• Customer Portal (from a menu bar, Dashboard Widget, or HTML page).

• Dashboards (by clicking Widgets).

• Automation Processes (One-Step Actions that run automatically based on specified rules).

• Cherwell Outlook Add-In (record-specific One-Step Actions that run from Microsoft Outlook®).

• E-mail and Event Monitor (One-Step Actions for processing monitored e-mails).

• Approvals (One-Step Actions that run when an Approval is approved, denied, or expired).

• Scheduled Items (One-Step Actions that run on a scheduled basis).

CSM provides several OOTB One-Step Actions in the CSM Desktop Client and Browser Client (on panes,
menu bars, and toolbars, as well as in Business Objects (to help you work with records) and OOTB
Automation Processes). Use these One-Step Actions as-is, edit them, or create your own using the One-
Step Editor. You can also add One-Step Actions (along with many other types of Actions) to various CSM
areas.

Related concepts
About Actions
Using One-Step Actions
Open the One-Step Action Manager
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One-Step Actions Good to Know
• One-Step Actions in the Blueprint scope can be used virtually anywhere in CSM, but they can only

be created and edited in CSM Administrator if you have security rights. The Blueprint scope is for
One-Step Actions that administrators do not want Users to edit or delete, such as those that run
behind the scenes (example: Form buttons and links on Forms).

Note: To run a One-Step that is associated with a particular Business Object (example:
Incident), the same type of record must be active (open or selected in a Grid). If the active
record is from a different Business Object than the One-Step that is trying to run, you will
receive an error.

• Actions that access or update Business Object data require at least one Business Object to be
available within the One-Step Action. A Business Object can be made available in a One-Step
Action by:

◦ Selecting a Business Object association (either the current record or an available Business
Object in the Association drop-down on the One-Step Action Manager toolbar). A Business
Object association can only be selected when a One-Step Action is first created and cannot be
changed for an existing One-Step Action.

◦ Creating it using a Create a New Business Object Action preceding the Action that requires
Business Object access (in the One-Step Editor).

◦ Navigating to it using a Go to a Record Action preceding the Action that requires Business
Object access (in the One-Step Editor).

Running One-Step Actions Using Trusted Agents

• One-Step Actions that run using Trusted Agents are intended to run unattended. One-Step Actions
that require User interaction during execution may fail when they are run using Trusted Agents. For
example, a Run a Report Action that saves a Report to a file may fail if the User is prompted to
provide information about the file, such as PDF options.

• Print Actions are supported in the CSM Browser Client and Portal when Trusted Agents are used to
run the Actions. This includes Run a Report Actions that are configured to print a Report. Cherwell
SaaS customers can configure a Trusted Agent to use printers on their remote network; on-
premises customers can configure a Trusted Agent to use printers on their local network or on a
remote network. If you do not configure Trusted Agents, Users receive an error indicating that Print
Actions are not supported when the One-Step Actions is run on the Browser Client or Portal.
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One-Step Actions and Record Locking
The following record locking guidelines apply to One-Step Actions:

• By default, a One-Step Action that updates a record (including Actions that update or create child
records) honors the record locking behavior of the active record on which the One-Step Action is run
(the record must be open or selected in a Grid). For more information, refer to Record Locking.

• For One-Step Actions that update a Business Object, it is best practice to configure the One-Step
Action (in general properties and conditions) to explicitly acquire a lock before running to ensure that
the active record is locked prior to One-Step Action execution, not just when a specific Action to
update a record is being executed. That way, a One-Step Action will not fail if a particular Action
cannot acquire a lock.

• If a One-Step Action is configured to acquire a lock prior to execution, it can also be configured to
explicitly release the lock after the entire One-Step Action finishes executing. Otherwise, the lock will
be released according to the record locking behavior configured for the active record (example: If
the Business Object is configured to automatically release locks upon save and the One-Step Action
saves the record, then the lock is released when the One-Step Action saves the record).
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Using One-Step Actions
Users can view and run One-Step™ Actions from a variety of locations in CSM.
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View a One-Step Action
A One-Step™ Action can be viewed several ways:

• From an item that uses a One-Step Action (example: Toolbars, menu bars, Dashboards, etc.).

• Available One-Step Action (based on security rights): Use the One-Step Action Manager.
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Run a One-Step Action from the One-Step Action
Manager

From the One-Step Action Manager in the CSM Desktop Client, you can run One-Step Actions against
groups, single records, or predefined Saved Searches.

You can also access the One-Step Action Manager in the CSM Browser Client to run One-Step Actions
against single records or multiple records (Search Results Grids only).

You cannot run One-Step Actions in CSM Administrator. When accessing One-Step Actions in CSM
Administrator, it is primarily to create, edit, or delete them for Users and/or to add them to various areas
within CSM (example: Business Object Forms, Dashboards, and Automation Processes).

Note: To run a One-Step Action that is associated with a particular Business Object (example:
Incident), the same type of record must be active (open or selected in a Grid). If the active record
is from a different Business Object than the One-Step Action that is trying to run, you will receive
an error.

To run a One-Step Action from the One-Step Action Manager:

1. Open the One-Step Action Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association, if applicable.3.

4. Run the One-Step Action:
◦ Against the active record:

◦ Select the Run button on the One-Step Action Manager toolbar.

◦ Select File > Run from the menu bar (CSM Desktop Client only).

◦ Double-click the One-Step Action.

◦ Against a selection of records in the CSM Browser Client (Search Results Grid only):
◦ Select the Run button on the One-Step Action Manager toolbar.

◦ Double-click the One-Step Action.

When running a One-Step Action on multiple records, a pop-up window displays the Business
Object publicID of each record as it is processed by the Action. If you cancel the One-Step
Action before it completes, the Action processes the current record and then terminates. Once
the One-Step Action is complete, you may need to refresh the screen to see the updates in the
Grid.

◦ Against a group of records in the CSM Desktop Client:

◦ Select the Run for Currently Open Group button  on the One-Step Action
Manager toolbar.

◦ Select File > Run for Group from the menu bar.
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This runs the One-Step Action against the active group of records that the group the open
record belongs to, or the group of records shown in a Grid.

Note: You can configure a One-Step Action to run against a specific Saved Search. In
this case, the One-Step Action runs against the defined group of records, regardless of
the client used to run the One-Step Action.

Related concepts
Define the Conditions for a One-Step Action
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Run a One-Step Action
Run a One-Step™ Action from a variety of places within CSM, including:

• CSM Desktop Client toolbars (either User or Global/Role).

• CSM Desktop Client Task Pane (either User or Global/Role).

• Business Object records (as record-specific One-Step Actions on the toolbar, menu bar, context
menu, Task Pane, a button, or a link). One-Step Actions can also be Automatic Actions that are
executed when a Business Object is saved.

• Browser Client (from the menu bar; as buttons, links, and Widgets on Dashboards; as buttons and
links on Business Object records, or as record-specific Actions in a context menu).

• Customer Portal (on a menu bar, a Dashboard Widget, or HTML page).

• Dashboards (as buttons, links, and Widgets).

• Automation Processes (One-Step Actions that run automatically based on specified rules).

• Cherwell Outlook Add-In (record-specific One-Step Actions that run from Microsoft Outlook).

• E-mail and Event Monitor (One-Step Actions for processing monitored e-mails).

• Approvals (One-Step Actions that run when an Approval is approved, denied, or expired).

• Scheduled Items (One-Step Actions that run on a scheduled basis).
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Managing One-Step Actions
Use the One-Step Action Manager to view, create, edit, and delete One-Step Actions.

Tips for viewing One-Step Actions:

• Use the View menu to limit the list of One-Step Actions Manager by your assigned Roles or all
Roles; by all Users or Teams; by Customer Workgroups; by One-Step Actions configured to run on
Trusted Agents; and by Sub-Action (the Sub-Action[s] contained within the One-Step Action).

Note: The Sub-Actions are components of a One-Step Action. A One-Step Action will
appear in all Sub-Action folders that it contains, so a One-Step Action could be listed in
multiple Sub-Action folders.

• Switch to the Detailed View (View>Details) to see the description, last modification date and User,
and Trusted Agents information for each One-Step Action.

Related concepts
Using CSM Item Managers
Run a One-Step Action from the One-Step Action Manager
Create/Edit a One-Step Action
Define Actions for a One-Step Action
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Open the One-Step Action Manager
Open the One-Step™ Action Manager from the CSM Desktop Client, the CSM Browser Client, or CSM
Administrator.

There are several ways to open the One-Step Action Manager:

• In the CSM Desktop Client or Browser Client menu bar, select One-Step > One-Step Manager.
• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > One-Step

Manager.
• In One-Step Action selectors throughout CSM (example: When adding One-Step Actions to various

areas within CSM). For more information, see Add an Action to a One-Step Action.
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One-Step Editor
The One-Step Editor is a tool that allows you to easily create simple or complex One-Step Actions to
automate common or repetitive tasks in CSM. Use the One-Step Editor to create and edit One-Step
Actions in CSM Administrator or the CSM Desktop Client.

1. Toolbar.

2. One-Step Action Components:

Tabs that show Designer Boards for the series of Actions that comprise the One-Step Action (the
main Actions as well as pre-steps and post-steps, if applicable).

3. Aerial View:

View the entire process as you zoom in and out. Also allows you to move the section of the current
process on the Designer Board.

4. Designer Board:

A visual representation of the process.

5. Actions Pane: Actions available to be added to the Designer Boards. These are categorized as:
◦ Common Actions: Actions that are commonly used in One-Step Actions.
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◦ Business Object Actions: Actions that create new Business Objects or require access to
Business Object data.

◦ Advanced Actions: Actions that involve knowledge of advanced concepts and/or more
complex configuration.

The Trusted Agents icon ( ) indicates Actions that can be executed using Trusted Agents.

6. Step Details:

Details of the currently selected step in the process.

This is where you define properties for the One-Step Action and for each Action.

The Designer Board for the One-Step Editor includes the following elements:

1. Start Graphic:

Event or starting point that initiates the process.

Tip: Select the Start Graphic on the Designer Board to define general properties for the
process.

2. Placeholder Graphic:

Holds the steps (Events and/or Actions) that constitute the process.

A yellow Trusted Agents icon indicates if an Action is configured to run using Trusted Agents.
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3. End Graphic:

Indicates the end of the process.
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One-Step Editor Toolbar
The One-Step Editor toolbar allows you to perform common tasks, such as save and copy, along with
tasks specific to One-Step Actions.

Button Action

Save

Undo

Redo

Clone: creates another instance of an Action within
the current One-Step Action.

Copy

Paste: Pastes a copied Action in another One-Step
Action. The One-Step Action you copy an Action into
should have the same association type as the original
One-Step Action.

Add an Action

Delete

Action Condition

Combines any Update Stored Value or Variable
Actions that are next to each other into a single Action

Child Record Actions

Define Preferences for the Designer/Editor

Increase or decrease the size of the diagram on the
Designer Board.
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Available One-Step Editor Actions
Multiple Actions are available in the Actions pane of the One-Step Editor. These Actions can be added to
the Designer Board in countless combinations to create simple or complex One-Step Actions.

Actions are categorized as follows:

• Common Actions: Actions that are commonly used in One-Step Actions.

• Business Object Actions: Actions that create new Business Objects or require access to Business
Object data.

• Advanced Actions: Actions that involve user knowledge of advanced concepts and/or more complex
configuration.

Common Actions

One-Step Action Description Business Object
Required Trusted Agent Support

Launch a URL Launches a specified URL. Not required No

Print

Creates a document that is
automatically sent to the printer.
This Action requires a
connection to a printer.

Not required Yes

Run a Program
Launches a program that can
be run from a Windows
command line.

Not required Yes

Run a Report Runs a Report created using
the Cherwell Report Writer™. Not required Yes

Send a Tweet

Posts a Tweet to a Twitter
Account.

Note: This Action requires a
Twitter Account.

Not required No

Send an E-mail

Automatically sends an e-mail
to specified recipients

Note: This Action requires a
CSM E-mail Account.

Not required No

Show a Pop-Up

Shows a message to Users,
usually asking whether they
want to continue, requesting
additional information, or
prompting them to select from a
list of options.

Not required No

Write to a File Creates, overwrites, or appends
contents to a file. Not required Yes
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Business Object Actions
Several Actions that access Business Object data (example: Update a Business Object) are executed
against whichever Business Object is active, either a Business Object association or a Business Object
from a preceding Action (Create a New Business Object or Go to a Record). For example, if a One-Step
Action that updates a Business Object is associated with an Incident, then Incident is the active object
(the Update a Business Object Action runs against Incident). If a Create a New Business Object Action is
added to create a Problem record (preceding the Update a Business Object Action), then the Problem
Business Object becomes the active object (the Update a Business Object Action runs against Problem).

Several Actions that access Business Object data (example: Link/Unlink Business Objects) allow you to
select which Business Object to execute against (if more than one Business Object is available within a
One-Step Action).

One-Step Action Description Business Object
Required Trusted Agent Support

Create a New Business
Object

Creates a Business Object and
optionally sets values for Fields
within the Business Object.

Not required No

Create a New Child
Business Object

Creates a child record that
belongs to the active Business
Object.

Required No

Delete a Business Object
Deletes a Business Object, either
the active Business Object or a
related Business Object.

Required No

Go to a Record
Navigates to a specified record
based on type and record ID or a
Relationship.

Not required (unless
going to a record in a
Relationship)

No

Link/Unlink Business
Objects

Links/unlinks records to/from a
Relationship. Required* No

Step Through Children
Runs the same Actions on each
child record of a Business
Object.

Required No

Transfer Attachments

Transfers Attachments to a file
system or Business Object from
another file system or Business
Object.

Required*

 Yes

Transfer Related Business
Objects

Transfers related records from
one Business Object to another. Required* No

Transition a Business Object

Performs transitions from one
lifecycle status to another for
multiple Business Object records.
Also migrates records from
legacy lifecycle to the Business
Object Lifecycle Editor.

Required* No
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One-Step Action Description Business Object
Required Trusted Agent Support

Update a Business Object Updates the value of Fields in the
active Business Object. Required No

Work with a Queue Performs Queue operations
against the active record. Required No

*Select the Business Object for this Action (if more than one Business Object is available within a One-
Step Action).

Advanced Actions

One-Step Action Description Business Object
Required Trusted Agent Support

Call a Web Service
Dynamically calls a web
service, and then saves the
results as a variable.

Not required Yes

Decide Between Multiple
Cases

Branches the One-Step into
multiple paths that are
executed based on defined
conditions.

Not required No

Excel Merge

Creates an Excel file using
data from CSM.

Requires creating an Excel
template.

Not required Yes

Execute a Command

Executes commands, runs
reports or Search Groups, or
opens Calendars,
Dashboards, or
Visualizations.

Not required No

Go to a Field Navigates to a particular Field
or tab in the active record. Required No

Go To Action
Navigates to another One-
Step Action, or ends One-
Step Action execution.

Not required No

HTTP Request

Passes information to and
from a web service, and then
saves the results as a
variable.

Not required No

Import Data Action
Runs a Stored Import (.csv
import). Can import User data
or stored data.

Not required No

Run Another One-Step
Action

Runs another One-Step
Action. Not required No
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One-Step Action Description Business Object
Required Trusted Agent Support

Step Through Collection
Steps through each item or
object in a collection or array
of XML or JSON data.

Not required No

Update a Variable or
Stored Value

Updates a variable value or
Stored Value using a
predefined value, or the value
of a User-specific variable that
you create.

Not required No
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Open the One-Step Editor
The One-Step Editor can be opened from the One-Step Action Manager.

You can open the One-Step Editor:

• From within the One-Step Action Manager, click the Create New button. The One-Step Editor is
automatically opened after you define One-Step Action properties (name and description).

• From within the One-Step Action Manager, select the One-Step Action to edit, and then do one of
the following:

◦ Right-click>Edit.
◦ Click File>Edit.
◦ Click the Edit button.
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Create/Edit a One-Step Action
Use the One-Step Action Manager and One-Step Editor (accessed from the One-Step Action Manager) to
create a One-Step Action.

Video Resources

• Subscription-based Video Learning Library: Designing One-Steps and Automation Processes

• Subscription-based Video Learning Library: Creating a One-Step for an Incident

Note: In the CSM Browser Client and CSM Portal, you can run One-Step™ Actions, but you
cannot create, edit, or delete them.

Create a One-Step Action
To create a One-Step Action:

1. Open the One-Step Action Manager. For more information, see Open the One-Step Action
Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association, if applicable.3.

One-Step Actions do not need to be associated with a Business Object. Select (None) from the
Association drop-down list for general One-Step Actions that do not need to access any Business
Object data (example: One-Step Actions that create completely new Business Objects or launch
URLs).

4. Select the Create New button.

5. Provide a name and description.

6. Select OK.6.

7. Define general properties and conditions.

8. Define the annotation and action properties.

9. Define pre-/post-steps.

10. Select OK.10.

Edit a One-Step Action
To edit a One-Step Action:

1. Open a One-Step Action in the One-Step Editor. For more information, see Open the One-Step
Editor.

2. Make changes and then select the Start Graphic on the Designer Board to edit One-Step Action
general properties and conditions.

3. Select OK.3.
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Related concepts
Define General Properties for a One-Step Action
Define the Conditions for a One-Step Action
Define the Annotations for a One-Step Action
Define Actions for a One-Step Action
Define Pre/Post-Steps for a One-Step Action
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Define General Properties for a One-Step Action
General One-Step Action properties include name and description, Business Object association, scope,
and a custom image. You can also choose a specific culture to use when the One-Step Action is run.

Use the Create a New One-Step window and the Start window in the Step Details section of the One-Step
Editor to define the general properties for a One-Step Action.

To define general properties for a One-Step Action:

1. Open the One-Step Editor.

2. Click the Start Graphic.

3. In the Step Details section, click the General page.

4. Modify the Name and Description defined when the One-Step Action was created, if needed.

5. Verify the Business Object association selected in the One-Step Action Manager. This setting is
read only.

6. Optionally, select the Use a specific culture when executing the One-Step check box, and then
select a culture to use when the One-Step Action is run. This is particularly useful for ensuring that
email messages sent by the One-Step Action are translated into a specific language. Options
include:

◦ Select a culture from the list of enabled cultures.

◦ Select a custom culture code stored in a Business Object Field. For example, you can create a
Culture Field in the UserInfo table so the One-Step Action is run using the culture set for the
User running the One-Step Action.

If you do not select a specific culture, the One-Step Action runs in the culture of the User who runs
the One-Step Action.

7. Click the Options button.

Option Description

Availability Select a scope. If you already selected a scope at the beginning, this is
auto-filled with your selection.

Association
If applicable, select a more filtered scope (example: A particular team).
<Automatic> applies scope based on login. If not applicable, this option
is disabled.

Options Click the Options button to set a scope, association, and custom image
for the One-Step Action.

Related concepts
Open the One-Step Editor
Setting a Culture for Running One-Step Actions
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Define the Conditions for a One-Step Action
Use conditions to run a One-Step Action against a single record or a group of records, to limit when a
One-Step Action runs, and to limit who can run the One-Step Action by Security Group.

Use the Create a new One-Step window and the Start window in the Step Details section of the One-Step
Editor to define the condition properties for a One-Step Action.

To define condition properties for a One-Step Action:

1. Open the One-Step Editor.

2. Select the Start Graphic.

3. In the Step Details section, select the Conditions page.

4. From the Allow One-Steps to Run Against list, select an option.

Option Description

Single Record or Group of
Records

Select this option to allow the One-Step Action to run against the
active record or group of records.

Single Record Select this option to allow the One-Step Action to run only against
the active record.

Group of Records
Select this option to allow the One-Step Action to run only against
the group of records that is active when the One-Step Action is
launched.

Specific Group Select this option to allow the One-Step Action to run only against
a specified Saved Search.

5. (For Specific Group only) Select the Ellipses button to open the Search Manager, and then select
an existing Saved Search or create a Saved Search. Saved Searches can be used over and over in
numerous places.

6. Define a condition that limits when the One-Step Action runs:

Option Description

Only Allow One-Step Action to
Be Run Based on Condition

Select this check box to have the One-Step Action run only when it
meets the criteria of a defined Expression.

Expression

Define an Expression that determines when the One-Step Action
runs. You can:

◦ Select the Ellipses to select a stored Expression or create a
new stored Expression.

◦ Select the Custom Expression button to create a custom
Expression specifically for this scenario.

Error Message

Provide an error message that appears when a One-Step Action
attempts to run but fails because it does not meet the defined
condition. This is required if you select to run the One-Step Action
based on a condition.
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7. Select the Only Allow This One-Step Process to be Run in the Application check box to prevent
the One-Step Action from being run from the Cherwell REST API.

8. Select the Allow One-Step to be Run Even if No Current Record check box to allow the One-
Step Action to run even if no record is active. This option is only available if the One-Step Action
runs against a single a record (either Single Record or Group of Records or Single Record is
selected in the Allow One-Step to Run Against drop-down).

9. From the Show Custom Tokens list, select the type of Token to show in One-Step Actions where
the Token menu is available. Examples:

◦ Select Email to make email Tokens available so the One-Step Action can access email-
specific data, such as the sender's email address, the subject line, etc. This is useful for One-
Step Actions used in an Email Monitor.

◦ Select Webhooks to make the webhooks Token available to the One-Step Action so you can
use JSON and XML Modifiers to map data between an external tool and CSM. For details, see
Create a Webhook Endpoint.

10. Run under Security Group: Select a Security Group under which the One-Step Action can run. This
determines which Business Object Fields the One-Step Action can access when it runs.

Option Description

(Default) Current User's
Security Group

Select this option to allow the One-Step Action to be run under the Security
Group to which the current User belongs.

Alternate Security Group

Select another existing Security Group under which the One-Step Action is
allowed to run (example: IT Service Desk Manager).

Note: Security rights control which Security Groups are available in
the drop-down. For example, you might only be able to select either
Current User's Security Group (which is subject to change) or the
specific Security Group to which you belong (example: Admin). If
you select Current User's Security Group, then the One-Step Action
runs under the Security Group to which the current User belongs. If
you select a specific Security Group, then the One-Step Action runs
under that specific Security Group (example: If you select Admin,
then the One-Step Action runs under the Admin group, even if your
current Security Group changes).

11. Define record locking options. These options are only available if the One-Step Action has a
Business Object association.
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Options Description

Acquire Lock Before
Running

Select this check box to have the One-Step Action lock an active record
before executing any Actions, including pre-steps.

Important: Selecting this check box is recommended for One-Step
Actions that update Business Objects; it ensures that the active
record is locked prior to One-Step Action execution, not just when
a specific Action to update a record is being executed. That way, a
One-Step Action will not fail if a particular Action cannot acquire a
lock. If this check box is not selected, the One-Step Action will still
lock an active record (if the record participates in locking) when it
runs Actions to update that record.

Release Lock After
Running

Select this check box to have the One-Step Action release any acquired
locks after the entire One-Step Action finishes running. If this check box is
not selected, locks are released based on the record locking settings
configured in CSM Administrator.

Related concepts
About Saved Searches
Create a Saved Search
About Record Locking
Define Actions for a One-Step Action
Related tasks
Create an Expression

CSM 2022.3 Features 1116

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fsearching%2Fabout_search_groups.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fsearching%2Fcreate_a_search_group.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Frecord_locking%2Fabout_record_locking.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fone-steps%2Fdefine_actions_for_a_one-step.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fexpressions%2Fcreate_an_expression.html


View a Summary of Trusted Agents for a One-Step
Action

You can configure multiple Actions in a One-Step Action to run on Trusted Agents. Use the Trusted Agent
Summary page to view the Actions and assigned Trusted Agent Groups assigned to each Action.

To view the Trusted Agent Groups configured for a One-Step Action:

1. Open the One-Step Editor.

2. Click the Start Graphic.

3. In the Step Details section, select the Trusted Agent Summary page.

4. The list of Actions shows the name of each Action and its assigned Trusted Agent Group.

Related concepts
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
Configure Trusted Agent Service Groups
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Define Pre/Post-Steps for a One-Step Action
Pre- and post-steps run before or after the main Actions in a One-Step™ Action are executed.

When you run a One-Step Action against a group of records, pre- and post-steps are only executed once,
whereas the main Actions are run once for each record in the group. The pre- and post-step Actions are
configured the same way as the main Actions in a One-Step Action.

Actions that require accessing information in Business Object records are not applicable for pre- and post-
steps because they do not have access to Fields in the active record. They are designed to run before or
after a record (or an entire group of records) has been processed, so technically there is not yet (or no
longer) an active record (or group of records) when the steps are executed.

To define Pre/Post-Steps for a One-Step Action:

1. Open the One-Step Editor.

2. Click the Pre-Steps tab or Post-Steps tab.
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3. Add one or more Actions to the Designer Board.

4. Define the properties for each Action.

5. (Optional) Define conditions that limit when an Action is executed:
a. Right-click an Action on the Designer Board, and then click Action Condition in the context

menu.

Tip: You can also click the Expression button on the One-Step Editor toolbar to add
conditions to a selected Action. To edit the Action condition, double-click the
Expression icon, right-click the Action on the Designer Board and select Action
Condition, or click the Expression button on the toolbar.

b. Select Only Run Action [name of Action] if Condition is True check box to define an
Expression that controls when the Action is executed.

c. Define an Expression for the condition, either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

d. Select OK.d.

6. Click Save.
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Define Actions for a One-Step Action
Use the Actions pane in the One-Step Editor to add Actions to the One-Step Action Designer Board.

When you add an Action to the Designer Board, the Action properties window opens in the Step details
section, where you can define specific properties for each Action. Adding or changing which Business
Objects are available within a One-Step Action affects any Actions that are configured to access a
particular Business Object (example: Adding, moving, or deleting a Create a New Business Object Action
or Go to a Record Action, or moving Actions that were defined to execute against a particular Business
Object). Properties that were based on a particular Business Object must be redefined if the available
Business Object changes.

There are some icons that are shown on the Designer Board when working with Actions:

Icon Description

The Go To Action icon shows when it is dragged onto other Actions in the One-
Step Action that you want the Action to jump to.

A function icon is shown on the Action Graphic (upper left corner) if the Action is
conditional. The Action does not execute if it does not meet the defined
condition.

If you navigate away from an Action without defining all of its required properties,
a Warning icon shows on the Action Graphic on the Designer Board. Click the
Action to return to the Step Details where a warning icon shows next to the
required text boxes. Hover over the icon to show a tooltip that explains what
information is required. In some cases, a More Info link is available. Click the link
to open a pop-up window containing more details about the warning.

To define Actions for a One-Step Action:

1. Open the One-Step Editor.

2. Add one or more Actions to the Designer Board.

3. In the Step Details section, define the properties for each Action.

4. (Optional) Define conditions that limit when an Action is executed. To add conditions:
◦ Right-click an Action on the Designer Board, and then click Action Condition in the context

menu.

◦ Click the function button on the One-Step Editor toolbar.

◦ Edit the condition by double-clicking the function icon, right-click the Action on the Designer
Board, and select Action Condition, or click the function button on the toolbar.

5. Select Only Run Action [name of Action] if Condition is True check box to define an Expression
that controls when the Action is executed.

6. Define the Expression for the condition:
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Option Description

Stored Expression
Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression.
Stored Expressions can be reused in CSM.

Custom Expression
Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this
scenario.
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Define a Copy to Clipboard Action
Use the Copy to Clipboard Action to copy text data to the clipboard when a One-Step™ Action is run, so
you can use the data outside of the One-Step Action.

For example, copy the contents of the Incident description field so you can send the information to the IT
Manager. Fields can be inserted as tokens, and the Rich Text Zoom window can be used to format the
contents.

• Copy to Clipboard Actions are supported in the CSM Desktop Client and the CSM Browser Client.

• You can associate this action with any Business Object.

• This action only copies text values.

To define a Copy to Clipboard Action:

1. Open the One-Step Editor.
2. Add a Copy to Clipboard Action to the Designer Board.
3. Define general properties:

Option Description

Name Provide a name for the action.

Contents Provide the text you want to copy to the
clipboard. Select the Selector button to
insert tokens (example: fields, system
functions, prompts, expressions, stored
values, metrics, and counters) directly into
the text.

4. Define Annotation properties.
5. Select Save.

Related concepts
Open the One-Step Editor
Define the Annotations for a One-Step Action
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Define a Launch a URL Action
Use the Launch a URL Action to launch a URL using a One-Step Action.

For example, add a One-Step Action to a Dashboard Widget on a Customer Portal to launch your
company's website when Customers click on a link.

To define a Launch a URL Action:

1. Open the One-Step Editor.

2. Add a Launch a URL Action to the Designer Board.

3. Provide a display name for the Action.

4. Define a URL to launch from this Action. Provide text. Click the Selector button to insert Tokens
(example: Fields, System Functions, Prompts, Expressions, Stored Values, Metrics, and Counters)
directly into the text.

5. Click the Ellipses button to navigate to the specified URL to ensure it is correct.

6. Define Annotation properties.

7. Click Save.
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Define a Print Action
Use the Print Action to create a document that is automatically sent to a selected printer when a One-
Step™ Action is run.

For example, print certain fields of an Incident record (or group of Incident records) in a memo format.
Fields can be inserted as tokens, and the Rich Text Zoom window can be used to format the contents.

You can use a printer:

• On the machine from which the One-Step Action is run.

• On another machine on the same network.

• On a machine on a remote network, using Trusted Agents.

Users running the One-Step Action must have permissions to access the printer you specify in any case.

Print Actions Good to Know

• Print Actions are supported in the Browser Client and CSM Portal when Trusted Agents are used to
run the Print Actions. Cherwell SaaS customers must configure a Trusted Agent to use printers on
their remote network; on-premises customers can configure a Trusted Agent to use printers on their
local network or on a remote network. If you do not configure Trusted Agents, users receive an error
indicating that Print Actions are not supported when the One-Step Action is run on the Browser
Client or CSM Portal. See Configure One-Step Actions for Trusted Agent. SaaS customers can
configure a Trusted Agent to use printers on their remote network; on-premises customers can
configure a Trusted Agent to use printers on their local network or on a remote network. If you do
not configure Trusted Agents, Users receive an error indicating that Print Actions are not supported
when the One-Step Actions is run on the Browser Client or Portal.

• If multiple Print Actions within a One-Step Action are not associated with the same print job, then the
contents from each Action are sent to the printer separately and are typically printed on separate
pages.

Defining a Print Action
To define a Print Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Print Action to the Designer Board.

3. Define general properties for the Print Action:

Option Description

Name Provide a display name for the Action.
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Option Description

Printer

In the drop-down, select a printer from the following options:
◦ Printers available in your network.

◦ Remote printers available for the selected Trusted Agent
Group, if Trusted Agents are enabled for the Action.

Select the Page Setup button to open the Page Setup window
and define options for how the document is printed (paper size,
paper source, orientation, and margin size).

4. Provide content to print, such as text. Select the Selector button to insert tokens (example: fields,
system functions, prompts, expressions, stored values, metrics, and counters) directly into the text.

5. Define additional options for the Print Action:

Option Description

When running against a group,
append text together before
printing

If you run the One-Step Action against a group of records, select
this check box to append them together before they are printed
(rather than printing each record separately).

Associate with a print job

If there are several Print Actions within a One-Step Action, select
this check box to have the contents for each Print Action printed
together under the same print job, and then provide a name for
the print job. This option is only available if you select the option to
append text together before printing.

6. Define Annotation properties.

7. Select Save.

Configuring the Print Action for Trusted Agents

Note: These steps must be performed if you intend to run a One-Step Action that includes a Print
Action from the CSM Browser Client or Portal.

To configure the Print Action to run on a remote network:

1. Follow the steps in Configure One-Step Actions to Run on Trusted Agents.

2. Select the Print page for the Print Action, and then select a printer from the drop-down list. The list
should contain printers available on the remote Trusted Agent machine.

Related concepts
Open the One-Step Editor
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
SaaS One-Step Action Check
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Define a Run a Program Action
Use the Run a Program Action to launch any program that can be run from a Windows command line.

For example, add a One-Step Action to a button, link, menu bar, or task pane of an Incident record to run
a program to reset a password, page a technician, or ping a server directly from a record.

You can run a program from:

• The machine from which the One-Step Action is run.

• Another machine on the same network.

• A machine on a remote network, using Trusted Agents.

Users running the One-Step Action must have permissions to access the program location and to run the
program you specify in any case.

Note: Using a Trusted Agent with this Action may be required for SaaS customers. See Configure
One-Step Actions for Trusted Agent.

To define a Run a Program Action for a One-Step Action:

1. Open the One-Step Editor.
2. Add a Run a Program Action to the Designer Board.

3. Define general properties for the Run a Program Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Filename

Provide the fully qualified path and file name of the program you want to
run (using text and/or tokens).

If you are running a program on a local machine or an accessible machine
on your network, you can select the Ellipses button to navigate to the
program location.

If you are configuring the Action to run using a Trusted Agent Group, the
Ellipses button is disabled and you must type or paste the fully qualified
path and program file name for the remote machine.
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Option Description

Start In

If the program or file should start running in a particular directory, then
provide the name of that directory (using text and/or tokens), or select the
Ellipses button to browse to the directory on your computer. If no directory
is specified, the current working directory is used (this is usually the
directory from which CSM was launched).

If you are configuring the Action to run using a Trusted Agent Group, the
Ellipses button is disabled and you must type or paste the fully qualified
path for the remote machine.

4. Define command-line arguments: Provide any arguments that must be passed to the program
(using text and/or tokens). Tokens are passed to the program as parameters.

5. Define how the One-Step Action should interact with the program:

Option Description

Wait for Program to End
before Continuing

Select this check box to have the One-Step Action wait until the program
finishes executing before continuing to the next Action.

Timeout after X Seconds

When the Wait for Program to End before Continuing check box is
selected, specify a timeout period in seconds. The program either waits
until the program is finished executing or the specified number of seconds
has passed.

Store Exit Code from
Program

Select this check box to store the program’s return code for use in future
One-Step Actions. A name is provided for the variable that will hold the
return code (example: Run program result). The variable is available in the
system so you can reuse it. This is not required; however, in most cases,
you want to store the program result so that you can do something with it
(example: Create a Journal - History record that stores the result).

6. Define how the program should run:

Option Description

Run

In the drop-down, select the size of window (normal, minimized, maximized,
or no window) to open the program in. This applies to a command prompt
window as well as the executable program. The command prompt window
is in the background and is not shown to users.

Custom Run Verb

Uses a custom run verb. This is an additional parameter that tells the
program how to run (if the program requires one). Some common verbs are
new, open, edit, and print. Consult the program’s documentation to find out
what verbs are available. If the program makes its list of supported verbs
available, they are available in the drop-down.

Pause after Run
The One-Step Action pauses for a few extra seconds after running the
program before continuing to the next Action; the User specifies the number
of seconds the One-Step Action should pause.

7. Define Annotation properties.
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8. Select Save.

Configuring the Run a Program Action for Trusted Agents
To configure the Run a Program Action to run on a remote network, follow the steps in Configure One-
Step Actions to Run on Trusted Agents.

Note: One-Step Actions that run using Trusted Agents are intended to run unattended. One-Step
Actions that require User interaction during execution may fail when they are run using Trusted
Agents.

Related concepts
Open the One-Step Editor
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
SaaS One-Step Action Check
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Define a Run a Report Action
Use the Run a Report Action to run a report that was created using the Cherwell Report Writer™.

For example, add a One-Step Action to an Automation Process to periodically run a report of all open
Incidents assigned to you, and then print the report or save it to a file.

You can save the report to a file or use a printer:

• On the machine from which the One-Step Action is run.

• On another machine on the same network.

• On a machine on a remote network, using Trusted Agents.

Users running the One-Step Action must have permissions to access the file location or printer you
specify in any case.

Note: Run a Report Actions that print a report are supported in the Browser Client and CSM
Portal when Trusted Agents are used to run the Actions. SaaS customers must configure a
Trusted Agent to use printers on their remote network; on-premises customers can configure a
Trusted Agent to use printers on their local network or on a remote network. If you do not
configure Trusted Agents, users receive an error indicating that Print Actions are not supported
when the One-Step Action is run on the Browser Client or CSM Portal. See Configure One-Step
Actions for Trusted Agent.

To define a Run a Report Action for a One-Step Action:

1. Open the One-Step Editor.
2. Add a Run a Report Action to the Designer Board.

3. Define properties for the Run a Report Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Report Select the Ellipses button to open the Report Manager and select a report
for the Action to run.

Data

Select the data to use for the report:
◦ Use Report Criteria: The Action runs the report exactly as designed

(example: Against a particular Search Group).

◦ Current Record: The Action runs the report against the active record
(the single record selected before running the One-Step Action).

◦ Current Group: The Action runs the report against the current group
of records. For example, run a Quick Search for all Incidents
containing the word print, and then execute the One-Step Action. The
list of records resulting from the search become the data for the report.
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4. Define an option for outputting the report after it runs:

Option Description

Print

Select this option to print the report. Then, in the drop-down, select a
printer from the following options:

◦ Printers available in your network.

◦ Remote printers available for the selected Trusted Agent Group, if
Trusted Agents are enabled for the Action.

Select the Page Setup button to open the Page Setup window and define
options for how the document is printed (paper size, paper source,
orientation, and margin size).

Write to a File

Select this option to export the report to a file, and then provide the fully
qualified path and name of the file that you want to create (using text and/or
Tokens).

If you are writing to a file to a local machine or an accessible machine on
your network, you can click the Ellipses button to navigate to the file
location.

If you are configuring the Action to run using a Trusted Agent Group, the
Ellipses button is disabled and you must type or paste the fully qualified
path and file name for the remote machine.

CSM supports the following export formats:

◦ Adobe PDF

◦ Bitmap

◦ CSV

◦ EMF

◦ Excel

◦ HTML

◦ JPEG

◦ Plain Text

◦ PNG

◦ Rich Text

◦ TIFF

Note: If a report is exported to an existing file, the report
overwrites the data in the file. If a report is not exported to an
existing file, a new file is created.

5. Define Annotation properties.

6. Select Save.
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Configuring the Run a Report Action for Trusted Agents

Note: These steps must be performed if you intend to run a One-Step Action that includes a Run
a Report Action that prints from the Browser Client or CSM Portal.

To configure the Run a Report Action to run on a remote network:

1. Follow the steps in Configure One-Step Actions to Run on Trusted Agents.

2. On the General page for the Run a Report Action, select a printer from the drop-down list. The list
should contain printers available on the remote Trusted Agent machine.

Related concepts
Open the One-Step Editor
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
SaaS One-Step Action Check
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Define a Send a Tweet Action
Use the Send a Tweet Action to post a new tweet to a Twitter account.

For example, add a One-Step™ Action to a Twitter button on the Problem Form to tweet the Resolution
description when the Problem is closed.

To use Twitter buttons on a Form or Dashboard, first create a Twitter Account and Activate Twitter
Buttons. Character limits are defined by Twitter. If the total text, including inserted Tokens, exceeds the
character limit, the text is truncated. The Characters Remaining indicator at the bottom of the Send Tweet
window shows how many characters are remaining.

To define a Send Tweet Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Send a Tweet Action to the Designer Board.

3. Define general properties for the Send a Tweet Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Account Click the Ellipses button to open the Twitter Account Manager and select
the account to which the Tweet should be posted.

Tweet
Provide text. Click the Selector button to insert Tokens (example: Fields,
System Functions, Prompts, Expressions, Stored Values, Metrics, and
Counters) directly into the text.

4. Define Annotation properties.

5. Click Save.
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Define a Send an E-mail Action
Use the Send an E-mail action to quickly send an email when the One-Step Action is run.

For example, select a link on an Incident record to send a follow-up email to the customer who submitted
the Incident, providing information or asking a question about the Incident. You can specify the contents of
the email, even inserting fields from the Incident as tokens in the subject and/or body.

To send an email using a One-Step Action, you must have an email account in CSM and security rights to
send email. For more information, see CSM Email Accounts and Email Security Rights.

To define an email action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Send an E-mail action to the Designer Board. Select Zoom on the toolbar to open the email
message in a separate window.

3. Define email options:

Option Description

Send Via

Select the email account from which emails are sent when the One-Step
Action is run. This is automatically set to your default email account set in
CSM Administrator, or by you (if you have security rights). If your
administrator has configured other accounts, select them in the drop-down
list. It is best to leave the default account so it works for every user that runs
the One-Step Action.

Field Visibility Select additional lines to show (From Address, Cc, Bcc, and Attachments).

Attachments Select the arrow to add attachments to the email. For more information, see
Action Attachments.

Attach to Recipients
Select the arrow to choose options for attaching the email to any of the
customer records associated with recipients in the To, Cc, or Bcc lines after
the One-Step Action is run and the email is sent.

Attach to Current Record

Attach the email to the active record as a Journal - Mail History record after
the One-Step Action is run and the email is sent. This button is shown only if
there is a Business Object available within the One-Step Action to which the
email can be attached.

Allow User to Edit

Select the allow user to edit button on the toolbar to allow the user to edit
the email before sending. If this option is not selected, the email is sent as-is
without allowing the user to view and edit it first. For more information about
email history attachment options, see the Email Accounts documentation on
where to store email history.
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Option Description

Selector

Insert Tokens (example: fields, system functions, prompts, expressions,
stored values, metrics, and counters) directly into the text.

Depending on the token, select the token, and then right-click the token to
access these options:

◦ Delete

◦ Edit Properties: Modify properties for expressions, prompts, metric
values, file names, and file contents.

◦ Modifiers: Add modifiers.

◦ Use rich text field style: Use the formatting applied to the Business
Object field rather than the formatting applied to the email message.
This enables you to include hyperlinks and styled text from the Business
Object record in the email.

◦ Display images as: Choose to size images associated with the token
as small, medium, or large thumbnails or as their full size.

Name Provide a display name for the Action.

To Select Address Book to open and select the email recipients, or provide
recipient email addresses directly.

Subject Provide a subject for the email.

4. Compose and format a message using the email message toolbars and providing text.

5. Define Annotation properties.

6. Select Save.

Related tasks
Format an E-mail for a One-Step Action
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Format an E-mail for a One-Step Action
Format an email for the Send an E-mail action when using a One-Step Action.

There are several ways to access email templates within One-Step Actions in CSM. These include:

• Define a Send an E-mail Action.

• Define an Approval Email.

• Action Block Email Templates.

To format an email for a One-Step Action:

1. Place your cursor in the body of the email and then select the magnifying glass icon as shown
below:

The window for email formatting opens:
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2. Choose from the formatting options in the drop-down menus or by using the toolbar icons.

Menu Options

File Save and Close options.

Edit Undo, Redo, Cut, Copy, Paste, Paste Special, Edit Picture, Select All

View Switch Status Bar on/off, switch Paragraph Markers on/off, Zoom

Insert Embed Picture, Link Picture, Insert Current Date and Time, Insert a Non-Breaking
Space

Font Bold, Underline, Italic, Superscript, Subscript, Strike through. Also choose Fonts, Text
Color and Background Color.

Paragraph Paragraph Alignment, Indenting, Spacing, Background Color, Bullets, Numbering and
Increase/Decrease of Indents.

Table

Insert Table, insert Rows and Columns, Merge/Split/Delete Cells, change Row
Alignment and Height, toggle Header Attribute for current table row. Also manage cell
properties such as Width, Border Width, Border Color, Shading, Color and Vertical
Alignment. Select Current column, Show Gridlines

Other Search within the file; Replace something; Jump to a line number, Snap to Grid
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3. Select Save.

Related concepts
Define a Send an E-mail Action
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Define a Show a Pop-Up Action
Use the Show a Pop-Up Action to provide information or to prompt users to do something. Pop-ups can
be used to ask users if they want to continue, to request additional information, or to select from a list of
options.

For example:

• Use a pop-up with a prompt to have users select an Incident owner from a list of names.

• Show a pop-up window with a confirmation message after a customer adds a comment to the
Portal.

• Show a pop-up window with a list of buttons from which users can select to return different values or
end One-Step Action execution.

You can define the appearance of a pop-up window. Pop-up windows can be shown as simple message
boxes and text boxes, as message boxes with selectable radio buttons or commands, etc.

To define a Pop-Up Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Show a Pop-Up Action to the Designer Board.

3. Define General options for the Pop-Up Action.

4. Define Button options for the Pop-Up Action.

5. Define Annotation properties.

6. Select Save.

Define General Pop-Up Actions
To define general properties for the Show a Pop-Up Action:

1. Provide descriptive information for the Pop-Up Action.

Option Description

Name Provide a display name for the Action.

Caption Provide a title for the pop-up window that is
shown to the User (using text and/or Tokens).

2. Provide text in the Contents box to show as a message in the pop-up window. Select the Selector
button to insert tokens (example: fields, system functions, prompts, expressions, stored values,
metrics, and counters) directly into the text.

Note: Tokens for Business Object lifecycle status and stage are only shown if the Business
Object has a lifecycle associated with it. See Migrate a Business Object Lifecycle.

3. From the Format drop-down list, define the appearance of the pop-up window:
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Option Description

Message Box Select this option to show the pop-up window as a
message box with a Close button.

Text Box Select this option to show the pop-up window as a
text box with an OK button.

Command Button Message Box
Select this option to show the pop-up window with
custom command buttons that represent different
options for the user to select.

Radio Button Message Box

Select this option to show the pop-up window with
custom radio buttons that represent different
options for the user to select.

Note: In the Browser Client, the Command
Button and Radio Button Message boxes
both appear as text boxes with a list of
options from which the User can select.
The functionality is the same as in the
Desktop Client; only the appearance is
different.

4. In the Buttons drop-down list, select which buttons to show in the pop-up window:

Option Description

OK (Message Box and Text Box only) Select this option to show only an OK button in the
pop-up window.

OK and Cancel (Message Box and Text Box only)

Select this option to show both an OK button and
a Cancel button in the pop-up window. If a user
clicks the Cancel button, the Action is canceled
and the One-Step Action stops executing.

Note: If you select the Message Box
option and select to show a Cancel
button, the pop-up window shows an OK
button instead of a Close button.

Custom (Command/Radio Button Message Boxes
only)

Select this option to define custom buttons to show
in the pop-up window.

5. For message boxes, select an icon from Message Box Icon drop-down list to show along with the
message in the pop-up window (asterisk, warning, or stop).

Define Button Options for the Pop-Up Action
You can add custom buttons to a Command Button Message Box or a Radio Button Message Box. For
example, create a workflow for an Incident with buttons to create child records, link records, or transfer
Attachments.
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To Define custom buttons for a Command Button Message Box or Radio Button Message box:

1. Select the Buttons page.

2. Select Add.

3. Define properties for the button:

Option Description

Display Text
Provide the value to show on or next to the button
(using text, or selecting the Selector button to insert
a Token).

Result Value Provide the value that the Pop-Up Action returns
when a user selects the button.

Only show button if condition is true
Select this check box to define an Expression that
determines when the button should be visible. Then
define an Expression.

4. Select the Button Cancels One-Step check box to have the button cancel One-Step execution if a
user selects it.

5. Select OK.5.

6. Define additional buttons as necessary.

7. Select the Store User's Selection in Variable check box to store the button's result value as a
variable that can be used in other Actions within the One-Step Action. Then select an existing
variable (if one was defined in a previous Action within the One-Step Action) or provide a name for a
new variable.

Define Annotation Properties

• Define Annotation properties.
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Define a Write to a File Action
Use the Write to a File Action to create, overwrite, or append contents to a file when a One-Step Action
runs.

For example, add a One-Step Action to a threshold-based Automation Process to keep a log file of the
current date and time whenever the number of open VIP Incidents exceeds a certain threshold. Use the
Temporary Filename Token to create a temporary file that goes away after a One-Step Action is finished
executing.

You can write to a file:

• On the machine from which the One-Step Action is run.

• On another machine on the same network.

• On a machine on a remote network, using Trusted Agents.

Users running the One-Step Action must have permissions to access and write to the file location you
specify in any case.

Important: Using a Trusted Agent with this Action may be required for SaaS customers.
See Configure One-Step Actions for Trusted Agent.

To define a Write to a File Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Write to a File Action to the Designer Board.

3. Define properties for the Write to a File Action:

Option Description

Name Provide a display name for the Action.

Filename

Provide the fully qualified path and name of the file that you want to create
(using text and/or tokens).

If you are writing to a file to a local machine or an accessible machine on
your network, you can select the Ellipses button to navigate to the file
location.

If you are configuring the Action to run using a Trusted Agent Group, the
Ellipses button is disabled and you must type or paste the fully qualified
path and file name for the remote machine.

Contents
Provide text. Select the selector button to insert tokens (example: fields,
system functions, prompts, expressions, stored values, metrics, and
counters) directly into the text.
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Option Description

Format

Select the format of the file to create, overwrite, or append (plain text, Rich
Text, or HTML).

Note: Rich Text file size is limited to 2 MB when used with this
Action. If you expect to write a large amount of Rich Text to a file,
consider using a Transfer Attachments Action instead. See Define
a Transfer Attachments Action.

Make sure file is written

Select when the file should be written:
◦ By End of One-Step Action Process: The Action keeps the file open

during One-Step Action execution and writes to it during each step
(the file is not completely written until all of the post-steps are
completed).

◦ Before Post-Steps Are Run: The Action writes to the file before any
of the post-steps are executed.

◦ Before Next Sub-Step: The Action writes to the file after each Action
in the One-Step Action.

The Before Next Post-Steps Are Run or Before Next Sub-Step options
cannot be used with the Rich Text Format (RTF). RTF documents have
close tags that do not allow files to be appended after they are created.

Overwrite existing file Select this check box to overwrite an existing file. Clear the check box to
append the contents to the file.

4. Define Annotation properties.

5. Select Save.

Configuring the Write to a File Action for Trusted Agents
To configure the Write to a File Action to run on a remote network, follow the steps in Configure One-Step
Actions to Run on Trusted Agents.

Related concepts
Open the One-Step Editor
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
SaaS One-Step Action Check

CSM 2022.3 Features 1142

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_a_transfer_attachments_action_for_a_one-step
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_a_transfer_attachments_action_for_a_one-step
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_the_annotations_for_a_onestep
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_trusted_agents_for_a_onestep
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_trusted_agents_for_a_onestep
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fone-steps%2Fopen_the_one-step_editor.html
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configuring_ta
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=configure_trusted_agents_for_a_onestep
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=saas_one-step_action_check


Create a Temporary File
Use the Temporary Filename Token to create a temporary file for a Write to a File Action or an Excel
Merge Action in a One-Step™ Action.

Use temporary files to create files that do not need a particular name and to avoid overwriting the same
file multiple times. Temporary files can be deleted after the One-Step Action is finished executing.

To create a Temporary File:

1. In a Write to a File Action in a One-Step Action, right-click in the Filename text box.

2. Click Filenames>New Filename.

3. Define properties for the temporary file:
◦ Name: Provide a name for the temporary file (example: Report). This is the name that appears

in the Token menu under Filenames so that it can be used in other One-Step Actions. This
name is for reference only; it is not the actual name of the file. It is given a unique name
(example: tmp001) wherever it is stored (temporarily or persistently) on a computer. The
Sample area in the Filename Properties window shows what the actual name might look like
(with or without the full path).

◦ Filename Includes a Full Path: Select this check box to include the full path to the User’s
temporary directory (example:
C:\Users\firstname.lastname\AppData\Local\Temp\tmp0001.TMP). Clear the check box to use
only the filename (example: tmp0001.TMP).

Note: In the figure, the temporary file (tmp0001.TMP) is being created in the current
User’s working directory. To specify a particular directory, provide it before the name
you specified for the file. You can also clear the Filename Includes a Full Path check
box and specify the full path in the Filename text box of the Write to a File Action.

◦ Delete File after One-Step Action Process is Complete: Select this check box to delete the
temporary file after the One-Step Action finishes executing. Clear this check box to have the
file persist. Include a full path so that CSM can find the location of the file to delete it.

◦ Use Custom Extension: Select this check box to define a custom extension. Then, provide the
extension.

Note: By default, temporary files have a TMP extension. However, if you are creating a
specific type of file, such as a text file (TXT) or a Rich Text Format (RTF) file, consider
using an appropriate extension so that other programs know how to handle the file.

4. Select OK.4.

The filename is shown in the Token menu under Filenames and can be used again for other One-
Step Actions.
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Define a Write to Log Action
Use the Write to Log Action to create a custom log when a One-Step Action is run. The log includes
content defined in the Write to Log Action, along with information based on the log level defined in the
Action.

The process or client used to run the One-Step Action determines the log location. For example, when a
One-Step Action that includes a Write to Log Action is run from the Desktop Client, Desktop Client logging
options are used. When a Simple Action/Event Automation Process that includes a Write to Log Action is
run, the log is written to the Automation Process Service log.

Good to Know

• If you log to a file, Users running the One-Step Action must have permissions to access and write to
the specified file and location.

• The One-Step Action log level should be at the same level or above the level of the service or client
log level. If the log level is lower, the log is not created for the One-Step Action. For example, if the
service or client log level is set to warning and above, you can set the One-Step Action log level to
warning, error, or fatal.

• If the content of the Write to Log Action is too large, the machine running the Action may become
unresponsive. Solve this problem by limiting the content added to the Write to Log Action.

To define a Write to Log Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Write to log Action to the Designer Board.

3. Define properties for the Write to Log Action:

Option Description

Name Provide a display name for the Action.

Log Level

Select a log level:
◦ Debug: Very verbose messages. This level is space and resource

intensive.

Note: For best results, log Debug messages (Debug and
above) to a file or to Splunk, and NOT to an event log. CSM
logs numerous Debug messages, so a log would be slow
and might require more resources.

◦ Stats: Detailed messages that track performance.

◦ Info: Informational messages that can be used to diagnose a
problem.

◦ Warning: Warning messages that occurred.

◦ Error: Errors that were encountered.

◦ Fatal only: Errors that caused the service or process to stop.
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Option Description

Contents
Add content to the log. You can manually enter text or right-click to insert
Tokens (example: Fields, System Functions, Prompts, Expressions, Stored
Values, Metrics, and Counters).

4. Define Annotation properties.

5. Select Save.

Related concepts
Open the One-Step Editor
Logging Options
Configure Logging to a Splunk Server
Configure User General Settings
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Define a Create a New Business Object Action
Use the Create a New Business Object Action to create any Business Object that is allowed in One-
Step™ Actions.

For example, use a One-Step Action to automatically create a Problem using values from the active
Incident record.

To define a Create a New Business Object Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Create a New Business Object Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Create a New Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Business Object

Select a single type of Major Business Object to create. If you selected a
Business Object association when the One-Step Action was created, it is
selected by default. Select a different one if needed. To display all Business
Objects, select the Show All check box.

Open New Record After
Action

Makes the Business Object from the Action the active record after the Action
is executed. This allows Users to immediately view and edit the record. If this
check box is not selected, the record does not appear on the screen.

Link to Parent

Links the new Business Object to another Business Object using an existing
Relationship. Select a Relationship that links the two Business Objects. The
Link to Parent option is only available if the Business Object being created
has an existing Relationship with another Business Object that is available
within the One-Step Action (from a Business Object association, another
Create a New Business Object Action or a Go to a Record Action).
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Option Description

Save Business Object
after Action

Select the check box to automatically save updates to the Business Object
after the Action executes.

If the check box is cleared, updates to the Business Object are not
automatically saved.

Users are prompted to save their changes if they navigate from the Business
Object, however. This includes changes made by the Action and any changes
made by Users before they ran the One-Step. The One-Step Action continues
to run whether or not they choose to save their changes. In the Browser
Client and Portal, this occurs after the last Action is executed for the One-
Step Action.

Note: If the One-Step Action is run from the Scheduling Server or an
Automation Process, there is no Prompt to save changes and they
may be lost.

5. Click the Fields page.

6. Define options for selected Business Object Fields:
a. Filter the Fields tree:

Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when
going back to edit the Action to quickly see which Field values are set
by the Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of
the list.

Show Field Values 

Opens a window that shows the Fields and values from the currently
open record. Click a Field, and then click the Select button (selecting a
Field in the window also selects it in the Fields tree). The Show Field
Values button  is only available if a currently open record is the same
as the Business Object the Action is defined to execute against
(example: An Incident record is currently open, and the Action is
defined to execute against an Incident).

b. Select a Field in the Fields tree, and then select one of the following options:

Option Description

Don't Set Field
(Default)

The Action does not have a set value. However, if the Field has a
default or auto-populated value, that value is used.
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Option Description

Clear Value The Action clears any default or auto-populated value that gets
assigned to the Field when the Business Object is updated.

Set Value

The Action sets a specific value. Provide text, or click the Selector
button to insert a Token (Field, System Function, Prompt, Expression,
Stored Value, Metric, Counter, etc.). The available Fields in the Token
Selector reflect the current Business Object (the Business Object being
updated or created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.

Template

The Action creates a custom defined value. Provide text. Click the
Selector button or right-click in the Template field to insert Tokens
(example: Fields, System Functions, Prompts, Expressions, Stored
Values, Metrics, and Counters) directly into the text. The available
Fields in the Token Selector reflect the One-Step Business Object
context (from the One-Step association or from a preceding Create a
Business Object Action or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently
open, and the Action is defined to execute against an Incident). Select
this option to open a window that shows the Fields and values
contained in the currently open record. Click a Field, and then click the
Select button to insert the Field as a Token.

Append to Current
Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled
if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

7. Define Annotation properties.

8. Click Save.
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Define a Create a New Child Business Object
Action

Use the Create a New Child Business Object Action to create a child Business Object that belongs to the
active Business Object.

For example, add a Journal History record to an Incident when the One-Step™ Action is run against the
Incident.

This Action is executed against whichever Business Object is active, either a Business Object association
or a Business Object from another Action (Create a New Business Object or Go To a Record) preceding
this Action. For example, if the One-Step Action is associated with Incident, the Incident Business Object
is the active object (this Action runs against Incident). If a Create a New Business Object Action is added
to create a Problem record (preceding this Action), the Problem Business Object becomes the active
object (the Action runs against Problem).

If the active Business Object changes (example: The Action was initially defined to run against Incident,
but a Create a New Business Object Action makes Problem the active Business Object), a warning
appears. The Action properties might need to be modified to reflect the newly active Business Object.

To define a Create a New Child Business Object Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Create a New Child Business Object Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Create a New Child Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Child Business Object

Select the child Business Object to create. For the Business Object to be
listed in the drop-down, it must have a Relationship in which it is owned by the
parent object. For more information about Relationships, refer to the
Relationships Documentation. The parent object is the active Business
Object.

Open New Record After
Action

Makes the Business Object from the Action the active record after the Action
is executed. This allows Users to immediately view and edit the record. If this
check box is not selected, the record does not appear on the screen.

Group Member If the selected child object is a Group Object (example: Journals), select the
Group Member to have the Action create (example: Journal - History).
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Option Description

Save Business Object
After Action

Select the check box to automatically save updates to the Business Object
after the Action executes.

If the check box is cleared, updates to the Business Object are not
automatically saved.

Users are prompted to save their changes if they navigate from the Business
Object, however. This includes changes made by the Action and any changes
made by Users before they ran the One-Step. The One-Step Action continues
to run whether or not they choose to save their changes. In the Browser Client
and Portal, this occurs after the last Action is executed for the One-Step
Action.

Note: If the One-Step Action is run from the Scheduling Server or an
Automation Process, there is no Prompt to save changes and they
may be lost.

Evaluate Expressions
from New Child’s
Perspective

Evaluate Expressions from the child object rather than from the parent object.
This option is rarely used; however, it is necessary if the parent and child are
the same type of object. To do calculations within the child (example: Adding
values in multiple Fields), select this check box to ensure that data is pulled
from the child object rather than the parent object.

5. Click the Fields page.

6. Define options for selected Business Object Fields:
a. Filter the Fields tree:

Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when
going back to edit the Action to quickly see which Field values are set
by the Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of
the list.

Show Field Values 

Opens a window that shows the Fields and values from the currently
open record. Click a Field, and then click the Select button (selecting a
Field in the window also selects it in the Fields tree). The Show Field
Values button  is only available if a currently open record is the same
as the Business Object the Action is defined to execute against
(example: An Incident record is currently open, and the Action is
defined to execute against an Incident).

b. Select a Field in the Fields tree, and then select one of the following options:
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Option Description

Don't Set Field
(Default)

The Action does not have a set value. However, if the Field has a
default or auto-populated value, that value is used.

Clear Value The Action clears any default or auto-populated value that gets
assigned to the Field when the Business Object is updated.

Set Value

The Action sets a specific value. Provide text, or click the Selector
button to insert a Token (Field, System Function, Prompt, Expression,
Stored Value, Metric, Counter, etc.). The available Fields in the Token
Selector reflect the current Business Object (the Business Object being
updated or created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.

Template

The Action creates a custom defined value. Provide text. Click the
Selector button or right-click in the Template field to insert Tokens
(example: Fields, System Functions, Prompts, Expressions, Stored
Values, Metrics, and Counters) directly into the text. The available
Fields in the Token Selector reflect the One-Step Business Object
context (from the One-Step association or from a preceding Create a
Business Object Action or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently
open, and the Action is defined to execute against an Incident). Select
this option to open a window that shows the Fields and values
contained in the currently open record. Click a Field, and then click the
Select button to insert the Field as a Token.

Append to Current
Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled
if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

◦ Append to Current Value: Select this check box to have the Action append a Set Value or
Template Value to any default value defined for the Field. To avoid duplication of data, this
option is disabled if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

7. Define Annotation properties.

8. Click Save.
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Define a Delete a Business Object Action
Use the Delete a Business Object Action to delete Business Objects, either the active Business Object or
a related Business Object.

For example, administrators can use this Action to perform a record cleanup of Journals, Tasks, etc.

This Action is executed against whichever Business Object is active, either a Business Object association
or a Business Object from another Action (Create a New Business Object or Go To a Record) preceding
this Action. For example, if the One-Step™ Action is associated with Incident, the Incident Business
Object is the active object (this Action runs against Incident). If a Create a New Business Object Action is
added to create a Problem record (preceding this Action), the Problem Business Object becomes the
active object (the Action runs against Problem).

Note: If the active Business Object changes (example: The Action was initially defined to run
against Incident, but a Create a New Business Object Action makes Problem the active Business
Object), a warning appears. The Action properties might need to be modified to reflect the newly
active Business Object.

To define a Delete a Business Object Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Delete a Business Object Action to the Designer Board.

3. Define general properties for the Delete a Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Delete current record The Action deletes the active Business Object record (or current group of
records, if the One-Step Action is running against a group).

Delete related record
The Action deletes related Business Object record(s). Then, select a
Relationship in the drop-down. The records that are owned by or linked to
the active Business Object are deleted by the Action.

Prompt before deleting
(In application only)

The Action prompts Users before deleting the Business Object. This gives
Users the option to continue with or cancel the Delete a Business Object
Action.

4. Define Annotation properties.

5. Click Save.
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Define a Go to a Record Action
Use the Go to a Record Action to navigate to a specific Business Object record. Navigate to a record
based on Relationship or Business Object, field and field value. For example, select a link on an Incident
record to go to the Major Incident it is linked to.

Good to Know

• If the One-Step™ Action is set to go to an arbitrary record and multiple records that contain the
specified value, the first record found is returned.

• If the selected field references a foreign key field, you must specify the foreign key record ID as the
value.

• Go to a Record Actions cannot be run against a group of records.

To define a Go to a Record Action for a One-Step Action:

1. Open the One-Step Editor.
2. Add a Go to a Record Action to the Designer Board.
3. On the General properties page, provide a name for the Action.
4. Choose one of the following options:
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Option Description

Go to an arbitrary record Select this option to go to a record based on a
Business Object, field, and field value.

a. In the Business Object (ID) drop-down
list, select a Token that holds the name of
the Business Object that contains the
record you want to go to. The drop-down
list only includes Major Business Objects
unless you select the Show All check
box.

Example: select Incident.

b. If you selected a Group Object, select the
Token that holds its name or record ID
from the Group Member drop-down list.

c. From the Field drop-down list, select a
Token that holds the name of the field in
the Business Object. You can choose any
field.

Example: Select Incident.Incident ID.

d. From the Value drop-down list, select or
provide an exact value for the chosen
field.

Example: Provide 102035.

Go to current record in a relationship Select this option to go to a record based on a
Relationship (navigate to a related record), and
then select a Relationship from the drop-down
list. You can choose any Relationship for the
selected Business Object.

Search for a record Select this option to search for a record.
a. Select the ellipsis to open the Search

Manager.
b. Use the magnifying glass to define the

search.
c. Use the delete button to delete the search

criteria.

Open new record after action Select this check box to allow users to
immediately view and edit the record.
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Option Description

Continue on error Select this check box to continue the One-Step
Action if the Action fails. Add a name to the text
field to store the error as a variable to use later.

5. On the Annotation page, define Annotation properties.
6. Select OK.
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Define a Link/Unlink Business Object Action
Use the Link/Unlink Business Object Action to link or unlink a Business Object in a Relationship. The Link/
Unlink Business Object Action adds records to or removes them from a Relationship, which adds/removes
them from tabs in Form Arrangements.

For example, link critical Configuration Items to the active Incident.

Link Relationships are the only type of Relationships to which Business Objects can be linked/unlinked
using this Action. Records can only be linked to/unlinked from an existing Relationship. If a Relationship
does not already exist, create one. If a Relationship is not already displayed as a tab in a Form
Arrangement, linking/unlinking records in the Relationship does not add or remove tabs in the Form
Arrangement; it only adds or removes records in existing tabs.

To define a Link/Unlink Business Object Action for a One-Step™ Action:

1. Open the One-Step Editor.

2. Add a Link/Unlink Business Object Action to the Designer Board.

3. Define general properties for the Link/Unlink Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Link Add records to the selected Relationship.

Unlink Remove records from the selected Relationship.

Business Object Select the Business Object to link/unlink.

Link to Relationship Select the Relationship to which the Business Object records are linked/
unlinked.

4. Define which records to link/unlink:

To link records:

Option Description

Records Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Ellipses 

Opens the Search Manager; select an existing Saved Search or create a
Saved Search. Saved Searches can be used over and over in numerous
places.

Custom Query 
Opens the Custom Query Builder; create a custom Search Query to use
only for this scenario.
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Option Description

Join Reason

Provide a join reason, or click the Selector button to open the Token
menu and insert a Token to use as the join reason. A join reason allows
you to provide brief information about why records are being linked. A join
reason can be provided only if the selected Relationship uses a join table
and has join reasons enabled. If join reasons are used for the Relationship,
and no join reason is provided for this Action, the join reason defined for
the Relationship is used. For more information, refer to Define Links
Properties for a Relationship

Legal Values 

Enabled if there is a list of valid values to use for the join reason. These are
based on the list of values defined for the selected Relationship's join
reason. For more information, refer to Define Links Properties for a
Relationship

To unlink records:

Option Description

Condition Unlink records based on an Expression, and then select an Expression.

Most recently used Select a most recently used (MRU) Expression.

Custom Expression Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this scenario.

5. Define link/unlink options:

Option Description

Link/Unlink all found
records

Link/unlink all records found based on the defined search criteria or
condition.

Link/Unlink specific
number of records

Link/unlink a specified number of records, and then provide a number, or
use the up/down arrows to increase/decrease the number. The first x
number of records are linked (up to the defined number of records).

This option is only available if the Relationship is 1-to-many (multiple records
can be linked/unlinked).
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Option Description

Order By (Unlink only)

Select a Field from the related Business Object to use to control the order in
which records are unlinked.

Ascending: Unlink records in ascending order (example: 0-10, A-Z) based
on the selected Field. The alphabetical order rarely matches the order in
which the records should be unlinked, unless you prefix the values with
numbers or letters (example: For status, you would likely want lifecycle
order, not alphabetical order); therefore, it is common to define a Field that
contains a sequence number purely for controlling the order (example:
Status Order).

Selecting (Default) unlinks records in ascending order based on the default
sorting column in the related Business Object's default Grid.

Save Business Object
After Action

Select the check box to automatically save updates to the Business Object
after the Action executes.

If the check box is cleared, updates to the Business Object are not
automatically saved.

Users are prompted to save their changes if they navigate from the Business
Object, however. This includes changes made by the Action and any
changes made by Users before they ran the One-Step. The One-Step Action
continues to run whether or not they choose to save their changes. In the
Browser Client and Portal, this occurs after the last Action is executed for
the One-Step Action.

Note: If the One-Step Action is run from the Scheduling Server or
an Automation Process, there is no Prompt to save changes and
they may be lost.

6. Define Annotation properties.

7. Click Save.
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Define a Step Through Children Action
Use the Step Through Children Action to run a sequence of Actions against each child record of a
Business Object.

For example, send an email to each Customer that is associated with an Incident to notify them when an
Incident is resolved. To limit the records that the Actions run against, define a condition (example: Only
run Actions against Customer records where the email address is not empty).

If the active Business Object changes (example: The Action was initially defined to run against Incident,
but a Create a New Business Object Action makes Problem the active Business Object), a warning
appears. The Action properties might need to be modified to reflect the newly active Business Object.

To define a Step Through Children Action for a One-Step™ Action:

1. Open the One-Step Editor. SeeOpen the One-Step Editor.

2. Add a Step Through Children Action to the Designer Board.

3. Define general properties for the Step Through Children Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Child Business Object

In the drop-down list, select the Child Business Object to run Actions
against.

Note: For the Business Object to be listed in the drop-down list, it
must have a relationship with the parent object (the active Business
Object). See Relationships.

Order

To run Actions against the child records in a specific order, select a field in
the drop-down list by which the records should be sorted. The drop-down list
lists the fields from the child Business Object selected in the previous step.

Ascending: Select this check box to run through the child records in
ascending order (example: 0-10, A-Z) based on the selected field. Rarely will
the alphabetical order match the desired order, unless you prefix the values
with numbers or letters (example: For status, you would likely want lifecycle
order, not alphabetical order); therefore, it is common to define a field that
contains a sequence number purely for controlling the order (example: Status
Order).
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Option Description

Reload data in
Relationship

Select this check box to reload relationship data before the Step Through
Children Action is executed against the child records.

Reloading might be necessary if the relationship is changed behind the
scenes (example: Through a reverse Relationship). If this check box is
selected, the relationship is refreshed from the database so that the Action
updates the latest version of the relationship. In addition, no child Actions are
required if this check box is selected.

Only run against record
where Expression is true

Limit the records that Actions run against, and then define an expression for
the condition.

Stored Expression

Select the ellipsis button to open the Expression Manager, and then select
an existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM. See Create an
Expression.

Custom Expression Select the Custom Expression button to open the Custom Expression
Builder, and then create a custom expression specifically for this scenario.

Record to select after run Define which record to select after all Step Through Children Actions are
completed (Record to Select after Run section).

Original The record that was active prior to execution of the Step Through Children
Action becomes the active record.

First found The first record found by the Step Through Children Action becomes the
active record.

Last found The last record found by the Step Through Children Action become the active
record.

4. Define Annotation properties. See Define the Annotations for a One-Step.

5. Select Save.

Define Actions to Run Against Child Records

1. Double-click the Step Through Children Graphic. You can also right-click the Action graphic and

select Define Actions for Child Records, or select the Child Record Actions button  on the
One-Step Editor toolbar. A Designer Board opens for the Step Through Children Action.

2. Add Actions to the Designer Board.

3. Define properties for each Action. Changing the child Business Object (in the Child drop-down list)
after defining Actions clears the Actions and any conditions associated with them.

Note: For Actions that access a field, if the relationship between the parent and child
Business Objects is a reverse relationship, fields will be available for both the parent and
child records, but if it is a non-reverse relationship, only the child fields will be available.

4. Select Save to save changes and return to the main Designer Board.
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(Optional) Define Conditions that Limit When an Action is Executed

1. Right-click an Action on the Designer Board, and then select Action Condition in the context
menu. You can also select the Expression button on the One-Step Editor toolbar to add conditions
to a selected Action. To edit the Action condition, double-click the Expression icon, right-click the
Action on the Designer Board and select Action Condition, or select the Expression button on the
toolbar.

2. Select Only Run Action [name of Action] if Condition is True check box to define an expression
that controls when the Action is executed.

3. Define an expression for the condition, either:

◦ Stored Expression: Select the ellipsis button  to open the Expression Manager, and then
select an existing stored Expression or create a new stored expression. See Create an
Expression. Stored expressions can be reused in numerous places in CSM.

◦ Custom Expression: Select the Custom Expression button to open the Custom Expression
Builder, and then create a custom expression specifically for this scenario.

4. Select OK.4.

5. Select Save to return to the Designer Board for the main One-Step Action.
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Define a Transfer Attachments Action
Use the Transfer Attachments Action to transfer attachments to a file system or Business Object from
another file system or Business Object.

For example, import files from a folder on your computer into CSM and attach them to an Incident record.
Or, get log files from users by executing the Action on a remote network using Trusted Agents.

This Action allows you to select which Business Object to execute against, if more than one is available
within the One-Step™ Action. Options can include one or more of the following, depending on which
Business Objects are available:

• Original Business Object from the Association (selected when the One-Step Action is created).

• Business Object from a Create a New Business Object Action preceding this Action.

• Business Object from a Go To a Record Action preceding this Action.

Types of Attachment Transfers
You can transfer attachments from a Business Object or a directory. In some cases, you can execute the
Action on a remote network using Trusted Agents.

Transfer Action From Description Trusted Agent
Support

Save Business Objects

Attachments are saved as
files in a specified directory
(they also remain in the
original Business Object).

Yes

Move Business Objects

Attachments are transferred
to another Business Object
(they are no longer in the
original Business Object).

No

Copy Business Objects

Attachments are duplicated
and attached to another
Business Object (they also
remain in the original
Business Object).

No

Delete Business Objects
Attachments are
permanently removed from
the Business Object.

No
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Transfer Action From Description Trusted Agent
Support

Imported Directory

Files are imported into CSM
from a specified directory
and attached to a selected
Business Object. Imported
files become part of the CSM
database (increasing its size)
and are not linked to the
directory; therefore, they
must be re-imported each
time the files are changed.

Yes

Link Directory

Files are linked to CSM from
a specified directory and
attached to a selected
Business Object. Files are
located in and accessed from
the directory, and Users must
have access to that directory
in order to view the files.

No

Delete Directory Files are deleted from the
specified directory. Yes

Transfer Attachments Good to Know

• If you are writing to or importing from a directory on a local machine or an accessible machine on•
your network, you can select the Ellipses button to navigate to the directory location. If you are
configuring the Action to run using a Trusted Agent Group, the Ellipses button is disabled and you
must type or paste the fully qualified path and directory name for the remote machine.

• Using a Trusted Agent with this Action may be required for SaaS customers. See Configure One-
Step Actions for Trusted Agent.

• The ability to transfer attachments using a One-Step Action depends on File Attachment rights.

Define a Transfer Attachments Action for a One-Step Action
To define a Transfer Attachments Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Transfer Attachments Action to the Designer Board.

3. Select the General page.

4. Define general properties for the Transfer Attachments Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).
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Option Description

From Attachment Source (the location from which attachments are transferred)

From Business Object Select this radio button to transfer attachments from a Business Object. In
the drop-down, select a Business Object.

Save Business Object
After Action

Select the check box to automatically save updates to the Business Object
after the Action executes.

If the check box is cleared, updates to the Business Object are not
automatically saved.

Users are prompted to save their changes if they navigate from the
Business Object, however. This includes changes made by the Action and
any changes made by Users before they ran the One-Step. The One-Step
Action continues to run whether or not they choose to save their changes. In
the Browser Client and Portal, this occurs after the last Action is executed
for the One-Step Action.

Note: If the One-Step Action is run from the Scheduling Server or
an Automation Process, there is no Prompt to save changes and
they may be lost.

From Directory

Select this radio button to transfer attachments from a folder in a system
directory and specify a directory. Browse to a folder location on the
computer or use the selector to open the Token menu and insert Tokens that
contain the name of the directory.

5. Select a transfer action for the attachments:

Option Description

Business Object

◦ Save: Save attachments from the selected Business Object to a
directory. Provide the fully qualified path and name (using text and/or
Tokens) of the directory where attachments will be saved.

◦ Move: Move attachments from the selected From Business Object to
another Business Object. Then, in the drop-down, select a To
Business Object.

◦ Copy: Copy attachments from the selected From Business Object to
another Business Object. Then, in the drop-down, select a To
Business Object. Save Business Object after Action: Select this
check box to automatically save the Business Object after the Action
executes.

◦ Delete: Delete attachments from the selected From Business Object.
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Option Description

Directory

◦ Import: Import files from the defined From Directory into the CSM
system and attach them to a Business Object. Then, select a To
Business Object.

◦ Link: Link files from the defined From Directory directly to the CSM
system and attach them to a Business Object. Then, select a To
Business Object. To view linked files, Users must have access to the
network where the files are located.

◦ Delete: Delete files from the selected directory.

6. Select an action to perform if saving attachments results in conflicts:

Option Description

Overwrite Overwrite existing attachments/files in the Business Object/directory with
the transferred attachments/files if they have the same name.

Skip Skip transferring attachments/files if they have the same name as the
existing attachments/files in the Business Object/directory.

Save with a new name
(will append number)

Import, link, save, move, or copy attachments/files but to give them a new
filename if they have the same name as the existing attachment/files in the
Business Object/directory.

Prompt before
overwriting

Prompt the User before any attachments/files are overwritten (works in the
Desktop Client only).

7. Select the Attachments/Files page. If a Business Object is the attachment source, the Attachments
page is shown. If a File System is the attachment source, the Files page is shown.

8. Define which attachments/files to include in the transfer action selected on the General page. For
more information, see Action Attachments. File Attachment rights control the attachment operations
that can be performed in CSM.

9. Define Annotation properties.

10. Select Save.

Configuring the Transfer Attachments Action for Trusted Agents
To configure the Transfer Attachments Action to run on a remote network, follow the steps in Configure
One-Step Actions to Run on Trusted Agents.

Related concepts
Open the One-Step Editor
Attachments
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
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Define a Transition a Business Object Action
Use the Transition a Business Object Action to move Business Objects from one lifecycle status to
another.

This One-Step™ Action performs transitions for multiple Business Objects records that are already using
the Business Object Lifecycle Editor.

Tip: You can also use this One-Step Action to move records backwards in a lifecycle or between
branches in a lifecycle or to assign a status to an object that has never had a lifecycle.

To define a Transition a Business Object Action for a One-Step Action, see Perform Transitions using a
One-Step Action .

Related concepts
Migrate a Business Object Lifecycle
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Define a Transfer Related Business Objects Action
Use the Transfer Related Business Objects Action to transfer related records from one Business Object to
another.

For example, copy the Journals from an Incident to an associated Problem.

If records are transferred to the same type of Relationship, they can be copied or moved. For example,
copy or move Journals from an Incident (Incident Owns Journals) to a Change Request (Change Request
Owns Journals):

• Copied: Child records are duplicated and added to the target Relationship (they also remain in the
original Relationship).

• Moved: Child records are transferred to the target Relationship (they are no longer in the original
Relationship).

If records are transferred to a different type of Relationship, new records are created in the target
Relationship (example: Create Journals in a Change Request (Change Request Owns Journals) from
Tasks in an Incident (Incident Owns Tasks)).

For more information about Relationships, refer to the Relationships Documentation.

To define a Transfer Attachments Action for a One-Step™ Action:

1. Open the One-Step Editor.

2. Add a Transfer Related Business Objects Action to the Designer Board.

3. Click the Transfer From page.

4. Define general properties for the Transfer Related Business Objects Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

From Business Object Select the Business Object from which records will be transferred.

Relationship Select the Relationship from which records will be transferred.

Condition Use an Expression to limit the records that are transferred, and then define an
Expression.

MRU Expression Select a Most Recently Used (MRU) Expression.

Custom Expression Click the Custom Expression button to open the Custom Expression Builder,
and then create a custom Expression specifically for this scenario.
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Option Description

Order By

Select a Field from the related Business Object to control the order in which
records are transferred to the target Relationship.

Ascending: Select this check box to transfer records in ascending order
(example: 0-10, A-Z). Alphabetical order rarely matches the order in which the
records should be transferred, unless you prefix the values with numbers or
letters (example: For status, you would likely want lifecycle order, not
alphabetical order); therefore, it is common to define a Field that contains a
sequence number purely for controlling the order (example: Status Order).

Selecting (Default) transfers records in ascending order based on the default
sorting column in the related Business Object's default Grid.

Save Business Object
After Action

Select the check box to automatically save updates to the Business Object
after the Action executes.

If the check box is cleared, updates to the Business Object are not
automatically saved.

Users are prompted to save their changes if they navigate from the Business
Object, however. This includes changes made by the Action and any changes
made by Users before they ran the One-Step. The One-Step Action continues
to run whether or not they choose to save their changes. In the Browser Client
and Portal, this occurs after the last Action is executed for the One-Step
Action.

Note: If the One-Step Action is run from the Scheduling Server or an
Automation Process, there is no Prompt to save changes and they
may be lost.

5. Click the Transfer To page.

6. Define properties for transferring records to a Business Object:

Option Description

To Business Object Select the Business Object to which records will be transferred.

Relationship Select the Relationship to which records will be transferred.

Group Member Select a Group Member (only applicable if the selected Relationship
contains a Group Object).

Transfer Related Business Objects

Copy Copy related records to the selected Business Object and Relationship.

Move Move related records to the selected Business Object and Relationship.
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Option Description

For each [Transfer From
Relationship] object
create a [Transfer To
Object] on [Transfer To
Relationship]

Creates a new record in the target Relationship for each of the records
being transferred.

Save Business Object
after Action Automatically save the Business Object after the Action executes.

7. Click the Create Object page to decide what to do with Fields in the new objects being created.

Note: This page is only available if objects are being transferred between two different types
of Relationships. The Fields tree is populated with Fields from the Business Object in the
selected To Relationship. Use Fields from the Business Object in the From Relationship as
Tokens to set values in the To Business Object.

8. Define options for selected Business Object Fields:
a. Filter the Fields tree:

Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when
going back to edit the Action to quickly see which Field values are set
by the Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of
the list.

Show Field Values 

Opens a window that shows the Fields and values from the currently
open record. Click a Field, and then click the Select button (selecting a
Field in the window also selects it in the Fields tree). The Show Field
Values button  is only available if a currently open record is the same
as the Business Object the Action is defined to execute against
(example: An Incident record is currently open, and the Action is
defined to execute against an Incident).

b. Select a Field in the Fields tree, and then select one of the following options:

Option Description

Don't Set Field
(Default)

The Action does not have a set value. However, if the Field has a
default or auto-populated value, that value is used.

Clear Value The Action clears any default or auto-populated value that gets
assigned to the Field when the Business Object is updated.
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Option Description

Set Value

The Action sets a specific value. Provide text, or click the Selector
button to insert a Token (Field, System Function, Prompt, Expression,
Stored Value, Metric, Counter, etc.). The available Fields in the Token
Selector reflect the current Business Object (the Business Object being
updated or created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.

Template

The Action creates a custom defined value. Provide text. Click the
Selector button or right-click in the Template field to insert Tokens
(example: Fields, System Functions, Prompts, Expressions, Stored
Values, Metrics, and Counters) directly into the text. The available
Fields in the Token Selector reflect the One-Step Business Object
context (from the One-Step association or from a preceding Create a
Business Object Action or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently
open, and the Action is defined to execute against an Incident). Select
this option to open a window that shows the Fields and values
contained in the currently open record. Click a Field, and then click the
Select button to insert the Field as a Token.

Append to Current
Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled
if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

◦ Append to Current Value: Select this check box to have the Action append a Set Value or
Template Value to any default value defined for the Field. To avoid duplication of data, this
option is disabled if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

9. Define Annotation properties.

10. Click Save.
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Define an Update a Business Object Action
Use the Update a Business Object Action to update Field values in the active Business Object.

For example, click a link on an Incident to update its status to a set value (example: Resolved).

This Action is executed against whichever Business Object is active, either a Business Object association
or a Business Object from another Action (Create a New Business Object or Go To a Record) preceding
this Action. For example, if the One-Step Action is associated with Incident, the Incident Business Object
is the active object (this Action runs against Incident). If a Create a New Business Object Action is added
to create a Problem record (preceding this Action), the Problem Business Object becomes the active
object (the Action runs against Problem). If the active Business Object changes (example: The Action was
initially defined to run against Incident, but a Create a New Business Object Action makes Problem the
active Business Object), a warning appears. The Action properties might need to be modified to reflect the
newly active Business Object.

To define an Update a Business Object Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add an Update a Business Object Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Update a Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Business Object Shows the Business Object that the Action will update.

Reload Business Object
Before Update

Reloads the active Business Object before the Action updates it. If this
check box is selected, the Business Object is refreshed from the database
so that the Action updates the latest version of the Business Object.

The Reload Business Object Before Update check box is not available
for Update Actions that are configured as children of Step Through Children
Actions.

CSM 2022.3 Features 1171

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=open_the_one-step_editor


Option Description

Save Business Object
After Action

Select the check box to automatically save updates to the Business Object
after the Action executes.

If the check box is cleared, updates to the Business Object are not
automatically saved.

Users are prompted to save their changes if they navigate from the
Business Object, however. This includes changes made by the Action and
any changes made by Users before they ran the One-Step. The One-Step
Action continues to run whether or not they choose to save their changes.
In the Browser Client and Portal, this occurs after the last Action is executed
for the One-Step Action.

Note: If the One-Step Action is run from the Scheduling Server or
an Automation Process, there is no Prompt to save changes and
they may be lost.

5. Click the Fields page.

6. Define options for selected Business Object Fields:

7. Filter the Fields tree:

Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when going
back to edit the Action to quickly see which Field values are set by the
Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of the
list.

Show Field Values 

Opens a window that shows the Fields and values from the currently open
record. Click a Field, and then click the Select button (selecting a Field in
the window also selects it in the Fields tree). The Show Field Values button

 is only available if a currently open record is the same as the Business
Object the Action is defined to execute against (example: An Incident
record is currently open, and the Action is defined to execute against an
Incident).

8. Select a Field in the Fields tree, and then select one of the following options:

Option Description

Don't Set Field (Default) The Action does not have a set value. However, if the Field has a default
or auto-populated value, that value is used.
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Option Description

Clear Value The Action clears any default or auto-populated value that gets assigned
to the Field when the Business Object is updated.

Set Value

The Action sets a specific value. Provide text, or click the Selector button
to insert a Token (Field, System Function, Prompt, Expression, Stored
Value, Metric, Counter, etc.). The available Fields in the Token Selector
reflect the current Business Object (the Business Object being updated or
created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.

Template

The Action creates a custom defined value. Provide text. Click the
Selector button or right-click in the Template field to insert Tokens
(example: Fields, System Functions, Prompts, Expressions, Stored Values,
Metrics, and Counters) directly into the text. The available Fields in the
Token Selector reflect the One-Step Business Object context (from the
One-Step association or from a preceding Create a Business Object Action
or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently open,
and the Action is defined to execute against an Incident). Select this option
to open a window that shows the Fields and values contained in the
currently open record. Click a Field, and then click the Select button to
insert the Field as a Token.

Append to Current Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled if
the Field selected in the Fields tree is also inserted as a Token in the
Template field.

9. Define Annotation properties.

10. Click Save.
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Define a Work with a Queue Action
Use the Work with a Queue Action to perform Queue operations.

For example, create a Problem from an existing Incident (Create a New Business Object Action), and
then add the newly created Problem to the Problem Management Queue.

To define a Work with a Queue Action for a One-Step™ Action:

1. Open the One-Step Editor.

2. Add a Work with a Queue Action to the Designer Board.

3. Define general properties for the Work with a Queue Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Operation

◦ Add: Adds the active record to a Queue.

◦ Remove: Removes the active record from a specific Queue or from all
Queues where it exists.

◦ Check Out: Check out the active record from a Queue.

◦ Check In: Check the active record into a Queue.

◦ Suspend: Suspends the active record from a Queue so it cannot be
checked out.

◦ Unsuspend: Unsuspends the active record from a Queue so it is
available for checkout.

Queue

Operations are performed against a specific Queue. Select a most recently

used (MRU) Queue in the drop-down, or click the Ellipses button  to
open the Queue Manager and select a Queue or create a new Queue.

Based on Scope and
Value

The Action makes a selection based on a specified scope and Token Value.
Select the scope in the drop-down. Click the Selector button to open the
Token menu and select a Token that holds the appropriate name or ID.

All Queues (Remove
only) Remove the active record from all Queues to which it belongs.

History Comments

Comments that are attached to the active record's history. Provide text. Click
the Selector button to insert Tokens (example: Fields, System Functions,
Prompts, Expressions, Stored Values, Metrics, and Counters) directly into the
text.

4. Define Annotation properties.

5. Click Save.
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Define a Call a Web Service Action
Use the Call a Web Service One-Step™ Action to dynamically call a web service and save the results as
a variable.

For example, call a web service that calculates currency, then use the results in a Field. The results can
be saved as a variable in one of the following data types: number, string, or Boolean.

Note: Currently, CSM supports REST and WSDL-based web services using either no
authentication or Basic authentication.

To define a Call a Web Service Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Call a Web Service Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Call a Web Service Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Service
Select the web service to call by clicking the Ellipses button. The Web
Service Manager opens, where you can select an existing web service or
set up a web service.

Account

Select the Web Service Account to use to provide the User ID and
password required to call the web service. This is only enabled if the web
service requires authentication (Basic Security is selected for the web
service) and Accounts were defined for the web service.

5. (Optional) Define how results are stored:

Note: This is not required; however, in most cases, you want to store the result as a variable
so that you can do something with it (example: Pop-up results, edit a Business Object, etc.).
There are some cases where you might not save the result (example: Where posting data to
the web service might not return anything; for example, Send a Tweet).

Option Description

Store Results Select this check box to store the result of the web service call as a
variable in the system using the specified name.

Store Return Code

Select this check box to store the error code if the web service call returns
an error (example: Error code 403 indicates that you do not have sufficient
rights, or 408 indicates that the server timed out). It is then available as a
variable in the system using the specified name.
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Option Description

Store Headers As Select this check box to store headers as variables in the system using the
specified name.

Don't Stop One-Step on
Error

Select this check box to have the One-Step Action continue executing even
if the web service call returns an error. This allows for the creation of future
steps that show details about the error, or try to handle the error in another
way.

Note: This option is only available if the Store Return Code As
check box is selected.

6. Click the Method page.

7. Specify the Method to call on the web service:

Option Description

Method
Select Web Service Method. The Parameters tree on the left shows all
the parameters for the selected Web Service Method. Define a value for
each parameter.

Blank
Select this radio button to not set a value for the parameter. This might or
might not be valid for different web services. If a required parameter is not
provided, the web service will likely generate an error.

Set Value

Select this radio button to manually set the Method value. Provide text.
Click the Selector button to insert Tokens (example: Fields, System
Functions, Prompts, Expressions, Stored Values, Metrics, and Counters)
directly into the text.

8. Define Annotation properties.

9. Click Save.

Configuring the Call a Web Service Action for Trusted Agents
To configure the Call a Web Service Action to run on a remote network, follow the steps in Configure One-
Step Actions to Run on Trusted Agents.

Related concepts
Open the One-Step Editor
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
SaaS One-Step Action Check
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Web Service Good to Know
• Before calling a web service from a One-Step™ Action, set up the web service using the Web

Service Manager, which can be accessed either from One-Step Action (Browser and Mobile>Web
Service Manager), or directly from the Call a Web Service Action in a One-Step Action.

• Security rights: Using and configuring web services requires security rights.
◦ If you cannot run, add, edit, or delete the Call a Web Service Action in One-Step Actions,

check your One-Step Action functionality security rights (CSM Administrator>Security>Edit
Security Groups>[Security Group]>Rights tab>One-Step Action).

◦ If you cannot call a web service, or view, add, edit, or delete web services using the Web
Service Manager, check your Web Services security rights (CSM Administrator>Security>Edit
Security Groups>[Security Group]>Rights tab>Web Services category).
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Set Up a Web Service
Before calling a web service from a One-Step™ Action, first set up a web service in the Web Service
Manager.

When you set up a web service, you define the following:

• General properties for the web service: Name, description, URL, Service Type (REST or WSDL),
and Security Type (Basic or None).

• Web Service Method: Define one or more Methods and parameters that are available from the web
service.

Note: WSDL Methods can be generated by parsing the WSDL definition, if available, and
generally do not need to be modified.

• Web Service Account: User ID and password required to call the web service (only required when
Basic Security is required).

CAUTION: If you delete a Web Service Account that is used by existing One-Step Actions,
the One-Step Actions may no longer work as expected. For best results, edit the existing
account information rather than deleting and re-adding it.

Note: The ability to set up a web service requires security rights.

To set up a web service:

1. Open the Web Service Manager.

2. Optional: Select a scope and subfolder.

3. Select Create New .

The Web Service Options window opens, showing two pages (General and Methods; Accounts
appears later if Basic Security is used).

4. Select the General page.

5. Define general properties for the web service:
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

It does not have to match the web service, although it is wise to do so.

b. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

c. URL:
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Provide the URL for the web service (example: http://test.com/webservice/). Select the
Selector button (or right-click in the URL field) to insert Tokens into the URL (example: System
Functions, Expressions, Stored Values, etc.).

Note: The URL can also be used as a value in Expressions and Stored Values for use
in other areas of the system (example: Use different URLs in Stored Values for
development, test, and production environments).

6. Define the Service Type, either:
◦ REST: Manually define the Methods and parameters available from the web service (see

below).

◦ WSDL (SOAP 1.1 or SOAP 1.2): Many WSDL web services expose a WSDL file from which
CSM can automatically generate the Methods and parameters that are available from the web
service. To parse the items, provide the full path to the WSDL file in the WSDL URL field
(example: http://www.test.com/service.asmx?WSDL), and then select the Parse WSDL button
when it is enabled. If the web service does not expose a WSDL file, then the Methods and
parameters to call must be manually defined (see below).

7. Define the Security Type:
◦ None.
◦ Basic: If Basic is selected, the Accounts page appears to define the Web Service Account

information.

Note: With Basic authentication, credentials are passed as plain text, so we
recommend that you only use it with SSL (https).

8. Define web service call options:
◦ Always call web service from Cherwell Server: Select this check box to make all calls to this

web service from the Cherwell Application Server (rather than from the client). This is usually
done for security reasons, since the web service might be configured to only allow calls from a
specific client machine.

◦ Log calls to this web service: Select this check box to log web service calls to the Application
Server log residing on the server.

Note: The global system settings might override these options.

9. Select the Methods page.

10. Define a Web Service Method:
a. Select Add to add a Method.

b. Define general properties for the Method:
i. Name: Provide a name for the Method.

ii. Description: Provide a description for the Method.

iii. (Optional) Endpoint: Provide the additional URL path for the Method. Some services
have an additional endpoint in the URL to access the Method. For example, if the full
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path to an addition Method is http://test.com/webservice/addNumbers, the base URL of
the service is http://test.com/webservice/ and the endpoint would be addNumbers.

Tip: Many web services have variable endpoints. Use variables in the endpoint
URL by enclosing them in braces { } (example: http://test.com/webservice/
{variable}). Provide the variable endpoint parameter directly in the text box, or
select the Selector button to add an endpoint parameter using the Web Service
Parameter window (see step c below). The parameter is automatically enclosed
in braces if you add it using the Web Service Parameter window.

iv. Result Type: Select the data type to use when saving the results:
◦ None

◦ Text (Default)

◦ Number

◦ Boolean

v. Request Type: Select a verb that determines the way a web service is called.
◦ POST

◦ GET

◦ PUT

◦ DELETE

◦ PATCH

◦ HEAD

Note: For most WSDL web services, the Method should be set to POST.
For most REST web services, the Method should be set to GET. Only
override these defaults if indicated by the web service’s documentation.

c. Add the Parameters:

Note: Most Methods require one or more parameters to be passed to the Web Service
Method. For example, addNumbers would likely require passing two numbers that
would be added together.

i. Select Add.

ii. Name: Provide a name for the parameter.

iii. Data Type: Select the data type for the parameter (Date/Time, Logical, Number, or
Text).

Note: With the WDSL (SOAP 1.1 or SOAP 1.2) Service Type, you can pass a
text parameter that contains XML representing the full SOAP message. The full
SOAP message is included in the web service log if the logging level is set to
Debug (refer to Configure Logging for a CSM Server or Web Application for more
information).
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iv. Parameter Type: Select the type of parameter to pass to the Web Service Method:
◦ Standard: Select this option to use the parameter as a regular element in the body

content (the parameter value is passed as an argument).

◦ Header: Select this option to send the parameter in the header of the call (the
parameter value is added to the message header rather than the body content).

◦ Endpoint: Select this option to use the parameter in the endpoint URL (the
parameter is not passed directly, but is used as a variable in the endpoint URL).

v. Is SOAP Content: Select this check box if the parameter contains an XML value that
includes all of the values (the entire SOAP content) that would otherwise be specified in
individual parameters.

Note: This check box is only shown if WSDL (SOAP 1.1 or SOAP 1.2) is the
selected Web Service Method.

vi. Select OK.vi.

11. Select the Accounts page.

Note: The page is only shown if Basic is selected as the web service Security Type.

12. Define one or more Web Service Accounts:

Note: The Web Service Account is used when a web service simply requires a User ID and
password to be passed with the web service call. You can define multiple accounts
(example: A basic account and an administrative account) and select the appropriate
account when you define a Call a Web Service Action for a One-Step Action.

a. Select Add.

b. Name: Provide a name for the Web Service Account.

c. Description: Provide a description for the Web Service Account.

d. User ID: Provide the user name for the Web Service Account.

e. Password: Provide and confirm the password for the Web Service Account.

f. Select OK.f.

13. Select Save.13.
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Open the Web Service Manager
Open the Web Service Manager from CSM Administrator or the CSM Desktop Client.

There are several ways to open the Web Service Manager:

• In the CSM Administrator main window, select Browser and Mobile > Web Service Manager.
• In a One-Step™ Action (select the ellipsis in a Call a Web Service One-Step Action). For more

information, see Create a One-Step Action.

• In CSM Administrator, from the Blueprint or mApp Editor menu bar, select Managers > Web
Services.
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Define a Decide Between Multiple Cases Action
Use the Decide Between Multiple Cases Action to define multiple cases (or paths) that the One-Step™
Action executes next based on defined conditions.

With this Action, Users can build branching logic into One-Step Actions to create advanced workflows to
manage and automate processes.

The Decide Between Multiple Cases Action allows Users to:

• Add an unlimited number of Actions to each path, including other Decide Between Multiple Cases
Actions.

• Use Go To Actions on or before paths to jump into or out of other paths, or anywhere else within the
One-Step. For example, use a Go To Action to conditionally run the Actions in another path after the
current path completes execution.

When a decision Action executes, the cases are evaluated in the order defined in the step details for the
Action. The case with the first true condition is executed, including all of the Actions on its path. The
Decide Between Multiple Cases Action is completed after all of the Actions on the path with the true
condition have been executed. At that point, overall One-Step execution is also completed unless Go To
Actions are used to jump to other Actions within the One-Step Action.

When you add a Decide Between Multiple Cases Action to the Designer Board, two cases are
automatically created: a default case and a standard case. The default case (indicated with an arrow on
the Designer Board) is executed if none of the conditions for any of the other cases are true. The default
case cannot have conditions and cannot be deleted. There must always be at least one standard case. If
there is only one, it cannot be deleted.

When defining cases, consider the following:

• All cases with Actions on their paths must have conditions defined.

• A case with no Actions on its path (an empty case) has no effect on execution.

• No part of a case with a false condition will be executed, unless a Go To Action jumps to an Action
within that case.

When you add an Action to a case, a new empty case is automatically created if one does not already
exist. This provides a way to easily begin adding Actions to new cases as needed. If a new case is not
needed, it can be deleted in the step details or by deleting the Decide Between Multiple Cases Action.
Empty cases are not deleted when Actions are removed from a case.

A Decide Between Multiple Cases Action is considered one Action even though it can contain an
unlimited number of other Actions on its path. If a decision Action is deleted, the options Delete Action
and Delete Action and Children behave identically: the Decide Between Multiple Cases Action and all of
the Actions on its path are deleted.

Actions cannot be added after a Decide Between Multiple Cases Action. The end of a path is the end of
the sequence of Actions for the overall One-Step Action. If another Decide Between Multiple Cases Action
is included on a path, it is still treated as one Action in the series of Actions on the path. Go To Actions
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can significantly alter execution behavior by jumping in or out of other paths, or anywhere else within the
One-Step Action.

Define a Decide Between Multiple Cases Action for a One-Step Action

1. Open the One-Step Editor.

2. Add a Decide Between Multiple Cases Action to the Designer Board.

3. Define general properties for the Decide Between Multiple Cases Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Define a list of cases

◦ Add: Add a case to the list.

◦ Remove: Remove a selected case from the list.

◦ Clone: Copy a selected case, including all of the Actions on its path.

◦ Edit Case: Edit the name and condition for a selected case.

◦ Up/Down Arrows: Change the order of the cases.

Define a series of One-Step Actions for each case on the Designer Board
(the same way you define Actions for the overall One-Step).

Unlink Remove records from the selected Relationship.
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Option Description

Business Object Select the Business Object to link/unlink.

Link to Relationship Select the Relationship to which the Business Object records are linked/
unlinked.

4. Define a condition for each case:
a. Select a case from the list in the step details and click Edit Case, or double-click the function

icon  before a case on the Designer Board.

b. Define an Expression.

c. Select the Terminate parent one-steps and action blocks check box to end the Action's
parent One-Step Action or Action Block after the steps for the current case have executed.

5. Define Annotation properties.

6. Click Save.
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Define an Excel Merge Action
Use the Excel Merge Action to create Excel files that contain data from CSM.

For example, create a One-Step Action for a dashboard that exports Incident data into an Excel file to
create a monthly report of all Incidents within the last 30 days (including total number of Incidents, how
many were closed, the percentage closed on first call, the average time it took to close Incidents, etc.).

You can use templates and save to Excel files:

• On the machine from which the One-Step Action is run.

• On another machine on the same network.

• On a machine on a remote network, using Trusted Agents.

Note: Using a Trusted Agent with this Action may be required for SaaS customers. See Configure
One-Step Actions for Trusted Agent.

Tips for Using Excel Merge Actions

• Create and use the Temporary Filename Token to create a temporary file that goes away after a
One-Step Action is finished executing.

• To save the data outputs to an Excel file and open the file automatically after the One-Step Action
runs, add a Post-Step with a Run a Program Action. Specify excel.exe in the Filename text box, and
then provide the name of the saved file as the command-line argument. If you used a Temporary
Filename, insert it as the filename (right-click to open the Token menu, and then select
Filenames>[your filename]).

Define an Excel Merge Action for a One-Step Action
To define an Excel Merge Action for a One-Step Action:

1. Create an Excel template.

2. Open the One-Step Editor.

3. Add an Excel Merge Action to the Designer Board.

4. Define general properties for the Excel Merge Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).
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Option Description

Select the template to
use for the Excel Merge
Action

◦ File: Select this radio button if the template is saved to a location other
than the Attachment Manager. Then provide the name of the template
file (using text and/or tokens).

◦ File Manager: Select this radio button if the template file is saved in
the Attachment Manager. Then select the Ellipses button to open the
Attachment Manager and navigate to the file.

Save to File Saves the output to a file. Then provide the filename (using text and/or
tokens) or select the Ellipses button to navigate to the file on your computer.

Print Prints the file. Select the printer from the drop-down.

Page Setup Select paper size, paper source, orientation, and margin size.

Note: For the file location options, if you are selecting or saving to a file to a local machine
or an accessible machine on your network, you can select the Ellipses button to navigate to
the file location. If you are configuring the Action to run using a Trusted Agent Group, the
Ellipses button is disabled and you must type or paste the fully qualified path and file name
for the remote machine.

5. Define Annotation properties.

6. Select Save.

Configuring the Excel Merge Action for Trusted Agents
To configure the Excel Merge Action to run on a remote network, follow the steps in Configure One-Step
Actions to Run on Trusted Agents.

Related concepts
Create an Excel Template
Create a Temporary File
Open the One-Step Editor
Configuring Trusted Agent
Related tasks
Configure One-Step Actions for Trusted Agent
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Create an Excel Template
To use the Excel Merge Action, you must first create an Excel template to define what data is retrieved
from CSM.

Data can be retrieved from:

• Business Objects (example: Incident)

• Relationships

• Business Object Fields

• Tokens (Counters, Expressions, or Stored Values)

Good to Know

• For best results, use a template from the Attachment Manager as a starting point (example: Incident
Scorecard).

• Templates must be saved with an .xls, .xlt, .xlsx, or .xltx extension.

• Many functions can be defined for an Excel template. For several examples of useful functions, see
Excel Merge Template Functions.
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Creating an Excel Template with a Single Business Object

1. Name the first tab of the template <#Config>. CSM uses this page to retrieve data from a Business
Object, Business Object Relationships, and other settings to properly create the file.

Note: All items must be in the AA column of the worksheet. Use the Excel Hide feature to
hide columns A through Z.

2. Define the Business Object, Relationships, and settings to use for retrieving data from CSM.
a. In the AA column of the worksheet, specify BusinessObject on a row, and then provide the

name of the Business Object (example: Incident) on the following row.

b. Specify Relationships on another row. Leave the rows underneath Relationships blank for a
single object template.

c. Specify Settings on another row. If the One-Step Action is run against a group of records,
specify RunForAll in the following row to have the file append all of the records together. If
this keyword is not present, a file is generated for each record.

Note: GetField functions do not work against a group of records. Consider using the
lookup function instead (see Excel Merge Template Functions).

3. Define the contents for the Excel file (on another tab/worksheet of the Excel template). This is done
using functions that pull data from CSM.

Note: Functions must be in the following format: <#FunctionName(parameters)>. When
multiple parameters are passed to these functions, a semicolon is used to separate the
values.
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a. Define which Fields to pull data from:
◦ <#BusinessObject.FieldName>: Provide this function to look for the specified Field in the

parent Business Object (example: Specify <#Incident.Status> to retrieve values from
the Status field in Incident Business Objects).

◦ <#GetField(BusinessObjectName;fieldname)>: Provide this function to look for a Field in
a related Business Object (example: Type <#GetField(Customer;Full Name)> to
retrieve a Customer's name from the Customer Business Object related to an Incident).

◦ <#GetField(RelationshipName;fieldname)>: Provide this function to use the specified
Relationship to find the related Business Object.

Note: It is important to use the Relationship name so the correct Business Object
is used, especially if more than one Relationship exists with the same related
Business Object (example: CustomerHasContacts,
CustomerHasPrimaryContact).

Important: Do not use the GetField function if you run an Excel Merge One-Step
Action against a group of records and also include data from a related Business
Object (example: You want a list of Tasks and also want to include the parent
Incident's Service category). See the section below to create an Excel template
with multiple Business Objects.

b. (Optional) Define which Tokens to pull data from. This is done using the GetCounter,
GetExpression, and GetStoredValue functions, which have the following options:

◦ Use the name of the Counter, Expression, or Stored Value:
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◦ <#GetCounter(name)>

◦ <#GetExpression(name)>

◦ <#GetStoredValue(name)>

◦ Use the scope and then the name of the Counter, Expression, or Stored Value:
◦ <#GetCounter(scope;name)>

◦ <#GetExpression(scope;name)>

◦ <#GetStoredValue(scope;name)>

4. Create a named range. CSM uses the named range to structure the report.

a. On the Contents tab, select the series of cells containing the functions. Do not select the
column headers.

b. Click Formulas>Define Name, or right-click>Define Name.

c. Provide the name of the Business Object with two underscores on each side (example: _ _
BusinessObject _ _).

5. Save the file in the Attachment Manager or on the computer.
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Creating an Excel Template with Multiple Business Objects

1. Complete the steps to create an Excel template with a single Business Object.

2. Define additional Business Objects and Relationships to use for retrieving data from CSM.
a. In the AA column of the <#Config> worksheet, underneath BusinessObject provide the name

of each additional Business Object to be used.

b. Use the rows underneath Relationships to provide the Relationships between the Business
Objects.

Note: To include multiple Relationships, provide each one in a separate, consecutive
row. Leave the rows underneath Relationships blank to not include any data from
related Business Objects.

3. On the Contents tab, define additional functions to pull Field data from CSM.

Note: The placement of functions will determine the structure of the report. (example:
defining the Field <#Incident.IncidentID> in cell A1 and <#Task.TaskID> in cell B2 will
generate a report with Incident ID values in column A and associated task ID values in
subsequent rows in column B).
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Important: Do not define Fields for multiple Business Objects on the same row. Each row
should handle Fields for a single Business Object.

4. Re-configure the existing named range to accommodate multiple Business Objects, and create
additional named ranges.

a. Expand the named range for the parent Business Object to include all cells containing Fields.
i. Click Formulas>Name Manager.
ii. Select the existing named range (example: __Incident__) and click Edit.
iii. Select and delete the text in Refers To.

iv. Select all cells containing functions. The named range will automatically populate with
the new selection.

v. Click OK.

b. Create a named range for the child Business Object that includes all cells containing child
object Fields.

The following figure shows an example:

When the Excel Merge One-Step Action retrieves the data from the specified Fields, the parent
object data is listed first, and the child object data is listed underneath (example: Incident data
followed by data from related Tasks).

5. Save the file in the Attachment Manager or on the computer.
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Excel Merge Template Functions

Function Description Syntax Parameters Example

If

A conditional
statement. When
condition is true, the
IfTrue expression is
evaluated; otherwise,
the IfFalse
expression is.

<#if(Condition; IfTrue;
IfFalse)> NA <if(<#value>=1;One;Not One)> writes “One” if the report variable “Value” is

1, and “Not One” if not.
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Function Description Syntax Parameters Example

List

Returns a string with
all values from a
table one after the
other, separated by a
delimiter. If the table
has only one record,
use
<#List(table.field)> to
get the value of the
only record without
having to define any
__table__ named
range.

<#List(dataset name
and column)>

or

<#List(dataset name;
list separator; agg
expression; filter)>

• Dataset name (and
column): Name of
the dataset in which
the values are
returned as a list.
Note that this
dataset doesn't need
to be inside any
named range, since
all of its records are
used anyway. If "agg
expression" is
present, column
name is not needed,
as the columns to
aggregate are taken
from the expression.
If not present,
include the column in
which to aggregate.

• List separator
(optional): If not
present, defaults to a
single space as the
character that
separates the
elements in the list.
To use a semicolon,
write it in quotes (";")
so it is not
considered a
parameter separator.

• Agg expression
(optional): An
expression that is
applied to every
record in the dataset
(any Excel function
is valid here, and
any combination of
Excel functions can
be used). Null values
are ignored and not
added to the list. If
not present, the
values of the column
specified in "dataset
name and column"
are used.

• Filter (optional): If
present, it should be
an expression that
returns true or false.
Any Excel formula is
valid. Only those
records where the
filter value is true are
used in the
aggregate.

• <#List(Employees.Lastname)> returns a string like "Smith Brown
Perez". Because a separator wasn't specified, a single space is used.
If Employees has only one record, you can use this to avoid defining
an "__employees__" named range.

• <#list(employees.lastname;, )> returns a string like "Smith, Brown,
Perez".

• <#list(employees;"; "; <#employees.firstname> & " " &
<#employees.lastname>)> returns a string like "John Smith; Carl
Brown; Jorge Perez". Note that using ";" as a list separator requires
writing it inside quotes.
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Function Description Syntax Parameters Example

Lookup
Searches for a field
description on
another table.

<#lookup(table name;
search key names;
search key
values ;result field)>

• Table name: Master
table that contains
the value.

• Search key names:
A list of columns
containing the
search key on the
master table. It will
normally be just one
column, but if you
need to search by
more than one, you
can separate column
names with a comma
(“,”).

• Result field: The field
of Table name you
want to display.

If you keep a CustomerId on an Orders table and the Customer data on a
Customers table, you can use the following to output the real customer
name for an order:

<#lookup(Customers;CustomerId;<#Orders.CustomerId>;CustomerName)>

Switch

Compares
SwitchValue against
value1, value2, etc.,
in order. If
SwitchValue is equal
to any of the value_n,
then result_n is
returned. You can
provide a default
value as the last
parameter. If no value
matches
SwitchValue, and you
have a default
parameter, then the
default is returned.
The default is inferred
from the number of
arguments: An odd
number of arguments
(3, 5, 7...) don't have
a default value. If the
number of arguments
is even, then the last
parameter is the
default.

<#switch(SwitchValue;
value1; result1; value2;
result2...[default])>

NA

• <#switch(<#value>;1;One;2;Two)> writes “One” if the report variable
“Value” is 1, "Two" if value is 2, and #N/A! if the value isn't 1 or 2.

• <switch(<#value>;1;One;2;Two;Something else)> writes “One” if the
report variable “Value” is 1, "Two" if value is 2, and "Something else" if
the value isn't 1 or 2.

CSM 2022.3 Features 1196

CSM 2022.3 Features



Define an Execute a Command Action
Use the Execute Command Action to execute a built-in system command, run a Report or Saved Search,
or open a Calendar, Dashboard, or Visualization.

For example, launch a Visualization of impacted Configuration Items from an Incident record.

Best Practices for Execute a Command Actions
Commands may alter the user interface separately from other Actions and therefore may not work as
expected in some cases. For example, Actions may run separately from the visible Business Object. For
best results, use one of the following approaches:

• Use Execute a Command Actions as a standalone One-Step Action.

• Place Execute a Command Actions at the end of a One-Step Action.

Defining an Execute a Command Action
To define an Execute a Command Action for a One-Step™ Action:

1. Open the One-Step Editor.

2. Add an Execute a Command Action to the Designer Board.

3. Define general properties for the Execute a Command Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Specific Command
Use a specific command for the Action to execute. Then click the Ellipses
button to open the Action Manager and select a command, Calendar,
Dashboard, Saved Search, Visualization, etc.

Command from Field

Use a Field from the active Business Object or related Business Objects
that holds a command for the Action to execute. Click the Selector button
to open the Token menu and select a Field. This option is only available if
the One-Step Action has a Business Object association.

4. Define Annotation properties.

5. Click Save.
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Define a Go to a Field Action
Use the Go to Field Action to navigate to a particular Field or tab (in the Form Arrangement) in the active
record.

To define a Go to Field Action for a One-Step™ Action:

1. Open the One-Step Editor.

2. Add a Go to a Field Action to the Designer Board.

3. Define general properties for the Go to Field Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

Go to a Field
The Action navigates to a specified Field in the associated Business Object.
Select a Field in the drop-down. Select Fields from the main object as well
as from related objects.

Go to a Tab by
Relationship

The Action navigates to a tab in the Form Arrangement based on a specified
Relationship. Select a Relationship in the drop-down.

Example: If you select Incident Links Problem as the Relationship, then the
Go to a Field Action navigates to the tab that shows the Problems linked to
the active Incident.

Go to a Tab by Index

The Action navigates to the specified tab number on the active record
(example: If you specify 1, the Action navigates to the first tab in the Form
Arrangement). Provide a number or use the up/down arrows to increase/
decrease the number.

4. Define Annotation properties.

5. Click Save.
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Define a Go To Action
Use the Go To Action to define criteria for determining which Action the One-Step™ Action should
execute next.

With the Go To Action, Users can navigate to any other Action within the One-Step Action or end the One-
Step Action execution.

For example, use a Go To Action in conjunction with a Prompt to prompt Users for a value, which then
determines which Action is executed next.

The Go To Action can be configured to always jump to a selected Action within the One-Step Action (or
end One-Step Action execution), or to jump based on a condition. Unless a Go To Action ends One-Step
Action execution, the Go To Action navigates to the appropriate Action and executes it, and then the One-

Step Action proceeds with any subsequent Actions. You can drag the Go To icon  onto other Actions
in the One-Step Action that you want the Action to navigate to. A number on the Go To icon and the
Action indicates where the One-Step Action will jump.

Drag-and-drop a Go To Action onto the Designer Board to branch the One-Step Action. The upper path is
the main One-Step Action, with the branches created by the Go To Action underneath. The main branch is
identified with a Broken Link icon  to indicate that it is no longer the path the One-Step Action follows (it
follows the branched path).

To define a Go To Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Go To Action to the Designer Board.

3. Provide a display name for the Action.

4. Define jump options:

Option Description

(Default) Always Jump

Select this radio button to always go to a selected Action within
the One-Step Action (or end One-Step Action execution). The

branched path is indicated with a Green Branch icon .

Jump When Condition is True

Select this radio button to go to a selected Action within the One-
Step Action (or end One-Step Action execution) if the defined
condition is true. The branched path is indicated with a Green

Branch icon .

Jump When Condition is False

Select this radio button to go to a selected Action within the One-
Step Action (or end One-Step Action execution) if the defined
condition is false. The branched path is indicated with a Red

Branch icon .
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5. Define a condition for the Go To Action, either:

Option Description

Stored Expression

Click the Ellipses button to open the Expression Manager, and
then select an existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in numerous
places in CSM.

Custom Expression
Click the Custom Expression button to open the Custom
Expression Builder, and then create a custom Expression
specifically for this scenario.

6. Define which Action to execute next. In the Jump To drop-down, select one of the following options:

Option Description

End One-Step Action Execution Select this option to have the One-Step Action end execution
when it reaches the Go To Action.

Navigate to Another Action

Select any other Action within the One-Step Action to execute
next.

If the Go To Action is used in a Step Through Children Action, you
can only select from the Actions used within the Step Through
Children Action. You cannot select from Actions used in the main
One-Step Action or in the Pre/Post-Steps.

7. Click the down arrow to expand advanced options. Define advanced options for limiting the
execution of the Go To Action. These limitations ensure that this Action does not lead to an endless
loop in which it is executed an infinite number of times. If either of the following limits is reached, the
entire One-Step Action is aborted.

Option Description

Maximum Number of Times This
Action can be Executed

Provide a number or use the up/down arrows to increase/
decrease the maximum number of times this Action is executed
(maximum is 1000).

Maximum Time in Seconds This
Action is Allowed to Execute

Provide a number or use the up/down arrows to increase/
decrease the maximum number of seconds this Action is allowed
to execute (maximum is 180).

8. Define Annotation properties.

9. Click Save.

Related concepts
Finding Internal Record IDs
Define the Annotations for a One-Step Action
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Define an HTTP Request Action
Use the HTTP Request Action to communicate with an external API using a One-Step™ Action.

For example, add an HTTP Request Action to communicate with AWS.

To define an HTTP Request Action:

1. Open the One-Step Editor.
2. Add an HTTP Request Action to the Designer Board.
3. Provide basic information in the General page:

a. Provide a name for the action.
b. Select a Method. An HTTP Method defines how a request should be interpreted by a server.
c. Provide a URL. Type the URL directly in the field, or use the Selector button to insert Tokens

(example: Fields, System Functions, Prompts, Expressions, Stored Values, Metrics, and
Counters) into the URL.

d. The Body field is not required. If you enter information, ensure you provide the format required
by the service you're calling (example: AWS requires JSON). Information you provide in this
field is dependent on what web service you are calling, and what information it expects in the
call.

e. Select the Don't stop One-Step on error check box to have the One-Step™ ActionOne-Step
Action continue executing even if the web service call returns an error. This allows for the
creation of future steps that show details about the error, or try to handle the error in another
way.

4. On the Headers page, add any headers you want to pass to the web service. Provide a key and a
value for each header. Use the Include variables from: field to add headers to the request using
tokens.

5. On the Response page, select the POST responses you want to store as variables in the Token
selector. You can use those values elsewhere in the One-Step Action. Variable names are provided,
but you can change them.

◦ Store result as:
◦ Store return code as:
◦ Store headers as:

6. On the Advanced page:
◦ Select Ignore certificate errors to continue the One-Step Action even if the web service call

encounters a certificate error.
◦ Select Store raw request as: to store the raw request sent to the web service as a variable.
◦ Select Store raw response as: to store the web service's raw response as a variable.

7. Define Annotation properties.

Related concepts
Define a Call a Web Service Action
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Define an Import Data Action
Use the Import Data Action to run a stored import (.csv imports) from the Stored Import Manager using a
One-Step Action.

One-Step Security Rights and Database Options Security Rights will apply. If Users do not have the
required permissions, they will receive a notification.

To define an Import Data Action:

1. Open the One-Step Editor.

2. Add an Import Data Action to the Designer Board.

3. Provide a display name for the Action.

4. Select a Stored Import from the drop-down or click the Ellipses button to open the Stored Import
Definition Manager.

5. Define Annotation properties.

Related concepts
One-Step Security Rights
Database Options Security Rights
Open the One-Step Editor
Stored Import Definition Manager
Define the Annotations for a One-Step Action
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Define a Run another One-Step Action
Use the Run another One-Step Action to run another One-Step Action. This is useful for creating One-
Step Actions with common functionality for use inside of other One-Step Actions.

For example, use a Customer Feedback Survey One-Step Action that runs from other One-Step Actions
after they run against the Customer's records.

To define a Run Another One-Step Action:

1. Open the One-Step Editor.

2. Add a Run another One-Step Action to the Designer Board.

3. Define general properties for the Run another One-Step Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step Action).

One-Step Action

Select this radio button to select a specific One-Step Action, and then
select a most recently used (MRU) One-Step Action in the drop-down. Or,
click the Ellipses button to open the One-Step Action Manager, and then
select an existing One-Step Action or create a new one.

Based on Scope and
Value

Select this radio button to have the Action run based on a specified scope
and Token Value. Then, select the scope in the drop-down. Click the
Selector button to open the Token menu and select a Token that holds the
appropriate name or ID.

Note: For best results, use a Lookup Table to limit the Action by a
Field value. You must first create Action Fields in the Lookup Table,
and then connect those Fields to a control on the table's Form. Use
Table Management to select the One-Step Action you want to run
for values in the Lookup Table.

Number of times the
One-Step Action should
run

Provide a number or use the up/down arrows to increase/decrease the
number of times the One-Step Action should run. This is useful for running
the same One-Step Action multiple times. The maximum limit is 100.

4. Define Annotation properties.

5. Click Save.
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Define a Step Through Collection Action
Use the Step Through Collection Action to step through each item or object in a collection or array of XML
or JSON data and store it as a variable for use in CSM.

This allows users to extract pieces of information that can be used within CSM (example: Create new
records and set fields using JSON or XML variables).

To define a Step Through Collection Action for a One-Step™ Action:

1. Open the One-Step Editor.
2. Add a Step Through Collection Action to the Designer Board.
3. Define General properties for the Step Through Collection Action:

Option Description

Name Provide a display name for the Action (this is
how the Action is identified within the One-
Step Action).

Collection to step through Provide the collection for the Action to step
through (a variable that is a JSON Array or
XML Collection, such as the result of a web
service call).

Order Select the Step through in reverse order
check box to have the action step through the
items in the XML or JSON collection in reverse
order.

Item Variable Name Provide a name for the variable that stores the
value of each item in the specified collection.
This variable can be used in child actions
(example: Display values in a popup, populate
fields in a Business Object, etc.). Use
Modifiers on the variable to extract the
appropriate pieces of information from the XML
or JSON data.

Stop on Error Select if the Action should be terminated if an
error occurs.

4. Define child Actions for the Step Through Collection Action:
a. Double-click the Step through collection graphic.
b. Add child Actions to the Designer Board.
c. Define properties for each Action.
d. Select Save to save changes and return to the main Designer Board.

5. Define Annotation properties.
6. Select Save to return to the Designer Board for the main One-Step Action.
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(Optional) Define conditions that limit when an Action is executed

1. Right-click an Action on the Designer Board, and then select Action Condition in the context
menu. You can also select Expression on the One-Step Editor toolbar to add conditions to a
selected Action.

2. Select the Only run action [name of action] if condition is true check box to define an
expression that controls when the Action is executed.

3. Define an expression for the condition:

Option Description

Most recently used
Expression Select the drop-down list to choose a most recently used expression.

Stored Expression
Select the ellipsis to open the Expression Manager, and then select an
existing stored expression or create a new stored expression. Stored
expressions can be reused in numerous places in CSM.

Custom Expression Select Custom Expression to open the Custom Expression Builder, and
then create a custom expression specifically for this scenario.

4. Select OK.4.

Related concepts
JSON Modifiers
Open the One-Step Editor
Define the Annotations for a One-Step Action
Related tasks
Create an Expression
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Define an Update Variables or Stored Values Action
Use the Update Variables or Stored Values action to set and update variables or stored values using a
pre-defined value. Adding multiple variables in a single One-Step Action can reduce the complexity and
effort of creating and maintaining One-Step Actions.

When you create variables, they are available in other actions within the One-Step™ Action, including
pre/post-steps and expressions. For example, use a One-Step Action to prompt a User for a value
(example: name of a Customer), and then store the selected value as a variable (rather than in a
temporary Field). The variable can be used throughout the One-Step Action to take different actions
depending on which value was selected.

When executing a One-Step Action containing variables, those variables only retain their values while the
One-Step Action executes. If the One-Step Action is executed again, the variables have no values until
set by this action. If this window is canceled, all User-defined variables are removed and are no longer
available for use.

To define an Update Variables or Stored Values action for a One-Step Action:

1. Open the One-Step Editor.

2. Add an Update Variables or Stored Values action to the Designer board.

3. Define general properties and the type of value to update for the Update Variables or Stored Values
action:

Option Description

Name Provide a display name for the action (this is how the action is identified
within the One-Step Action).

Stored Value

Select this option to update a stored value. Select the ellipsis to open the
Stored Value Manager, and then select an existing stored value, or create a
new one.

If you select a stored value that contains User-specific values (or if you use
this action to update a stored value with a User-specific value), the following
warning appears: This stored value has a different value for each User. The
value set here will only apply to the current User.

If the User-specific value is not remembered between sessions, you will see
the following additional warning: Also, this value will be reset to the default
value when the application is restarted.

Clear User-specific
Values and Restore the
Stored Value to Its
Default Value

Select this check box to remove any values a User has defined specifically for
their own use and restore the stored value to its default value.

This option is only available if a stored value that contains User-specific
values is selected.
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Option Description

Based on Scope and
Value

Select this option to have the action make a selection based on a specified
scope and Token Value. Then, select the scope in the drop-down list. Select
the Selector button to open the Token menu and select a token that holds the
appropriate name or ID.

Variable Select this option to define unique variables.

Variable

Provide a name for the variable. This is the name that is shown in the Token
tree for other actions within the One-Step Action.

Tip: When you provide a variable name, the Variable is automatically
selected.

To rename the variable, select Rename. Type the new name, and select OK.

Data Type
Select a Data Type (example: text, number, date/time, logical, JSON/JSON
array, XML/XML Collection). If you use XML or JSON data types, the defined
value (below) must use the appropriate JSON or XML syntax.

New Value

Value that will update a variable or stored value. A value cannot be defined if
this action is used to clear User-specific values and return stored values to
their default values.

Provide text. Select Selector to insert tokens (example: fields, system
functions, prompts, expressions, stored values, metrics, and counters) directly
into the text.

After Replacing Tokens,
Evaluate the Result as a
Calculation

Select this check box to have the value of the variable or stored value treated
as a simple expression that returns a calculated result rather than a string.

Note: This is a powerful feature with almost endless possibilities. For
best results, follow the guidelines below.

4. Update Stored Value and Variable actions:

Option Description

Update another Stored

Value or Variable 

Adds another Update action to either create a new variable, update
an existing variable or stored value, etc.

Remove this Update action
Removes the selected Update action.

Note: The variable may still persist if it is referenced in
other places in the One-Step Action.

Edit the condition for when

this update occurs 

Edits the condition for the selected Update action. While the entire
Update Stored Values or Variables action (sub-action) may run, if
the condition is false for a specific Update action, then that update
will not occur.
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Option Description

Move the update up in the

execution order 
Moves the selected update up in the execution order.

Move the update down in

the execution order 
Moves the selected update down in the execution order.

5. Define Annotation properties.

6. Select Save.

Any variables that are not referenced when the One-Step Action is closed are removed.

Variable or Stored Value Treated as an Expression Guidelines

• When you create an expression, use a Token to refer to the values. Tokens are typically selected
from the Token tree, but you can enter specific values or Tokens if necessary.

• Enclose string Tokens and string values with single quotation marks (example: 'Incident.Status' =
'Closed').

• Any Tokens that contain non-alphanumeric characters, start with a digit, or match any of the
following reserved words require special handling:

◦ And

◦ Between

◦ Child

◦ False

◦ In

◦ Is

◦ Like

◦ Not

◦ Null

◦ Or

◦ Parent

◦ True

• If a Token meets any of the above conditions, it must be enclosed in either square brackets or back
quotes. For example, Token# must be written as either:

◦ [Token#]:Total * [Token#]

◦ `Token#`:Total * `Token#`

• If a Token enclosed in square brackets contains any square brackets or backslashes within its
name, then you must insert a backslash before the brackets or backslashes. If a Token is enclosed
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in back quotes, then it cannot contain any back quotes within its name. For example, a Token
named Token[]\ would be written as either:

◦ Total * [Token[\]\\]

◦ Total * `Token[]\`

• You can use User-defined values within expressions and compare them to Token values.
◦ Enclose string values in single quotation marks (example: 'StringToken' = 'John'). If a value

includes a single quotation character within its name, then you must insert another single
quotation mark before the character.

◦ Number Tokens do not need to be enclosed in quotation marks (example: NumberToken <=
50.00). You can use scientific notation in numeric values. Only periods can be used as decimal
separators to separate the integer part from the fractional part of a number. Commas and
other characters are not supported as decimal separators or as thousand separators
(example: ten-thousand and five tenths should be entered as 10000.5).

◦ Enclose date values within pound signs (example: #DateToken# < #01/31/82#).

• You can concatenate expressions using Boolean AND, OR, and NOT operators.Use parentheses to
group clauses and force precedence (the AND operator has precedence over other operators). For
example: (‘StringTokenLastName’ = 'Smith' OR ‘StringTokenLastName’ = 'Jones') AND
‘StringTokenFirstName’ = 'John'

• The following operators are allowed in comparison expressions:
◦ <

◦ >

◦ <=

◦ >=

◦ <>

◦ =

◦ IN

◦ LIKE

• The following arithmetic operators can be used in expressions:
◦ + (addition)

◦ - (subtraction)

◦ * (multiplication)

◦ / (division)

◦ % (modulus)

• The following functions can be used in expressions:

Convert

Description Converts an expression to a specified .NET Framework type

Syntax Convert(expression,type)
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Arguments
expression: The expression to convert

type: The .NET Framework type to which the value will be converted.

Example Convert('StringTokenValue,' 'System.Int32')

Exceptions

◦ Boolean can be converted to and from Byte, SByte, Int16, Int32, Int64,
UInt16, UInt64, String, and itself only.

◦ Char can converted to and from Int32, UInt32, String, and itself only.

◦ DateTime can be converted to and from String and itself only.

◦ TimeSpan can be converted to and from String and itself only.

IIF

Description Retrieves one of two values depending on the result of a logical calculation.

Syntax IIF(expr, truepart, falsepart)

Arguments

expr: The expression to evaluate.

truepart: The value to return if the expression is true.

falsepart: The value to return if the expression is false.

Example IIF(TotalTokenName>1000, 'expensive', 'dear')
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Define Actions Using XML Collections and JSON
Arrays

One-Step™ Actions include options for iterating through XML Collections and JSON Arrays and extracting
portions of repeating data. Refer to these tasks and code samples when defining Actions using variables
of type XML Collection or JSON Array.

See also Webhook Modifier Examples.

Note: XPATH version 1.0 is supported; XPATH version 2.0 is not supported.

CSM 2022.3 Features 1211

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_modifier_examples


Task XML Example JSON Example Notes

Create a variable that
contains XML or JSON code.
This is the XML or JSON
variable.

<Remarks>
  <Remark>
    <Sequence>1</Sequ
ence>
    <QualifierId>RAIL
</QualifierId>
    <Text>CHICAGO</Te
xt>
  </Remark>
  <Remark>
    <Sequence>2</Sequ
ence>
    <QualifierId>RAIL
</QualifierId>
    <Text>CHICAGO</Te
xt>
  </Remark>
  <Remark>
    <Sequence>3</Sequ
ence>
    <QualifierId>DEST
</QualifierId>
    <Text>CALL 24 HR
S B4.</Text>
  </Remark>
</Remarks>

{ "node": 
  [ 
     { "key1": "Val
ue1"}, 
     { "key2": "Val
ue2"},
     { "key3": "Val
ue3"}
  ]  
}

Usually, this is
accomplished by calling
a Web Service and
saving the result as a
variable.
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Task XML Example JSON Example Notes

Create another variable to
hold the XML Collection or
JSON Array. This is the
collection variable. Give the
variable the correct data type.

XML Collection JSON Array

An XML Collection is a
block of XML code that
contains a common tag.
In this example, the
common tag is the
Remark tag.

A JSON Array is a block
of JSON code contained
in square brackets that
is the value of a JSON
property. It typically
contains a comma-
delimited list of elements
that are strings,
numbers, objects,
arrays, booleans or null.
In this example, the
JSON property
containing the array is
"node" and the array
members are objects
with key-value pairs.
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Task XML Example JSON Example Notes

Set the content of the
collection variable as the XML
or JSON variable. Use the
applicable modifier to select
the XML Collection or JSON
Array element.

XPath = "//Remark"

<XPathSearchResult>
  <Remark>
    <Sequence>1</Sequ
ence>
    <QualifierId>RAIL
</QualifierId>
    <Text>CHICAGO</Te
xt>
  </Remark>
  <Remark>
    <Sequence>2</Sequ
ence>
    <QualifierId>RAIL
</QualifierId>
    <Text>CHICAGO</Te
xt>
  </Remark>
  <Remark>
    <Sequence>3</Sequ
ence>
    <QualifierId>DEST
</QualifierId>
    <Text>CALL 24 HR
S B4.</Text>
  </Remark>
</XPathSearchResult>

Find Array ("node")

[ 
     { "key1": "Val
ue1"}, 
     { "key2": "Val
ue2"},
     { "key3": "Val
ue3"}
] 

In this example, the
XPath modifer selects a
collection of Remark
elements in the XML
Collection.

The Find Array ("node")
modifier selects the
JSON Array that is
associated with the
property "node." For
more complex JSON
objects, consider using
JSONPath expressions.

Remember:
XML Collections
and JSON
Arrays are 0-
indexed. If you
add modifiers to
extract specific
items from
collections, use
Index(0) to
specify the first
item.
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Task XML Example JSON Example Notes

Add a Step Through
Collection Action to the One-
Step Editor and specify the
variable name, example: Item.

<Remark><Sequence>1</
Sequence>
<QualifierId>RAIL</Qu
alifierId>
<Text>CHICAGO</Text><
/Remark>

{ "key1": "Value1"}

Related concepts
JSON Modifiers
Define the Annotations for a One-Step Action
Related tasks
Define a Step Through Collection Action

CSM 2022.3 Features 1215

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fmodifiers%2Fjson_modifiers.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fone-steps%2Fdefine_the_annotations_for_a_onestep.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fone-steps%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fone-steps%2Fdefine_a_step_through_collection_action_for_a_one-step.html


Action Attachments

Use the arrow next to the attachments button  to select the type of attachment:

• Attachment Manager: Adds Attachments from the Attachment Manager.

• Browse: Adds files from a computer directory as attachments.

• Custom: Opens the Custom Filename Builder and provides the name of the file (using text and/or
Tokens) to attach to the e-mail.

• From Records: Opens the Define Rules for Attachments window and selects criteria for which
Business Object Attachments to include in the e-mail. This is useful if the Action is run against
records that contain multiple Attachments.

Note: File Attachment rights control the Attachment operations that can be performed in
CSM.

Option Description

All Attachments/Files Includes all Attachments/files from the selected Business Object/directory.

First
Includes the first defined number of Attachments/files from the selected
Business Object/directory. Then, provide a number or use the up/down
arrows to increase/decrease the number.

Last

Includes the last defined number of Attachments/files from the selected
Business Object/directory. Then, provide a number or use the up/down
arrows to increase/decrease the number. If First or Last is selected,
Attachments/files are sorted in alphabetical order if they are from a
directory, and by the order of appearance on the Business Object's
Attachment Bar if they are from a Business Object.

Include Attachment/File
Includes Attachments/files based on file masks (include Attachments/files
that contain certain characters, words, file extensions, etc.). Specify the file
masks, using semicolons to separate each mask.

Exclude Attachment/File
Excludes Attachments/files based on file masks (include Attachments/files
that contain certain characters, words, file extensions, etc.). Specify the file
masks, using semicolons to separate each mask.

Minimum Size
Includes Attachments/files that are of a minimum defined size, and then
provide a number or use the up/down arrows to increase/decrease the
number. In the drop-down, select kilobyte or megabyte.

Maximum Size
Includes Attachments/files that are of a maximum defined size, and then
provide a number or use the up/down arrows to increase/decrease the
number. In the drop-down, select kilobyte or megabyte.
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Define the Annotations for a One-Step Action
Annotations enable you to to communicate the function and purpose of a One-Step. You can define
Annotations for each Action in a One-Step Action.

To define annotation properties for a One-Step Action:

1. Select an Action on the Designer Board.

2. Select the Annotations page.

3. Provide information for the two text fields.

Option Description

Annotation title (shown in tooltip) This information is shown as a tooltip when a User hovers over an
action.

Annotation Describes the purpose and operation of the One-Step Action. This
is an informational field only, it does not show in the UI.
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Update a Business Object with Content from a File
Edit or update a Business Object by using a One-Step™ Action to access the content of a file.

The Content from a File token is only available for One-Step Actions and can be used in any One-Step
Action that requires content. For example, you can set a One-Step Action to prompts users for a file
containing content to be imported. This content can be read and used within the context of the One-Step
Action.

The following example explains how to configure a One-Step Action to access a file to update a Business
Object record.

To configure the Update A Business Object Action:

1. Open the One-Step Editor, and then create or edit a One-Step Action.
2. Add an Update a Business Object Action to the Designer Board.
3. Configure the Action as needed. See Define an Update a Business Object Action for more

information.
4. On the Fields page, select the field to update.
5. Select the Template radio button, and then select the Template Selector or right-click in the

Template field to open the Token Selector.
6. Select Content from File > New File.

The Read file properties dialog box opens.
7. To use the same file every time the One-Step Action is run:

a. Select Static Filename, and then navigate to the file.
b. Select the file type you want the One-Step Action to accept from the Format drop-down menu.

Options are CSV, HTML, text, rich text format, and XML.
c. Optionally, select the Reload file if name changes and Reload file contents when file

changes options to automatically reload the file and file contents. These options cannot be
used with a Trusted Agent.

d. Select Use Trusted Agents, and then select a Trusted Agent group. This option may be
required for SaaS customers. See Configure One-Step Actions for Trusted Agent.

8. To enable users to choose the file to run:
a. Select Prompt for File.
b. Enter the text in the Caption field that users will see when they run the One-Step Action. You

can also right-click to open the System Function context menu so you can include a variable.
c. Select the file type you want the One-Step Action to accept from the Format drop-down menu.

Options are CSV, HTML, text, rich text format, and XML.
9. Click OK.

10. Save theOne-Step Action.

Related tasks
Configure One-Step Actions for Trusted Agent
SaaS One-Step Action Check
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Configuring One-Step Actions
One-Step™ Action Security rights are configured in CSM Administrator.

See One-Step Action Security Rights.
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Troubleshooting One-Step Actions
This section outlines potential issues that might occur while using One-Step™ Actions and how to rectify
these issues. If you have an issue that is not included, contact Cherwell Support for assistance.
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Resolving "Session Has Expired" Issues
Find a solution for resolving "Session has expired" issues with Step Through Children Actions in the
Browser Client.

Step Through Children Actions Fail with Error
One-Step Actions may fail when they are run in the Browser Client if they contain Step Through Children
Actions that delete records. When this occurs, Users receive this error:

This row has been removed from a table and does not have any data. BeginEdit() will allow creation of
new data in this row.

Followed by this message:

Your session has expired.

Add a Refresh Command to the End of the One-Step Action

1. Edit the One-Step Action that is failing.
2. Double-click the Step Through Children graphic.
3. Drag an Execute a Command Action to the end of the Step Through Children set of Actions.
4. On the General page for the Execute a Command Action, select Specific Command.
5. Click the ellipses icon, and then navigate to the System>Edit folder.
6. Select the Refresh command.
7. Click OK.
8. Save the One-Step Action.
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Action Blocks
Use Action Blocks to build sets of Actions you can reuse in other One-Step™ Actions across your CSM
Business Objects.

Use the One-Step Action Block Manager to create, edit, and reuse Action Blocks. You can assign an
Action Block to a category so it is available in the One-Step Editor toolbox for use in other One-Step™
Actions.

In the One-Step Action Block Manager, you can right-click on an Action Block and select Visualization to
see a graphical view of its dependencies. Action Blocks are blue, One-Step Actions are yellow, decision
blocks are grey, and recursions are red.

Related concepts
Action Block Security Rights
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Open the Action Block Manager
Open the Action Block Manager from the CSM Desktop Client, the CSM Browser Client, or CSM
Administrator.

To open the Action Block Manager:

• In the CSM Desktop Client or Browser Client menu bar, select One-Step > One-Step Action
Blocks.

• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > One-Step
Action Blocks.
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Action Block Email Templates
Action Block email templates provide administrators with reusable templates for Incidents, Problems, and
Change Requests. Use these templates to maintain consistent email styling (fonts, spacing, and overall
layout).

Action Block email templates are stored in the Action Block Manager under the Global folder.

• Approvals Email Template: Use to send an email to request approval of a Change Request or
expense.

• Assigned To Email Template: Use to send an email to notify a technician that an Incident, Problem,
or Change Request has been assigned to them.

• Confirmation Email Template: Use to send an email to the customer as a confirmation that their
Incident, Problem, or Change Request has been received.

• Resolved Email Template: Use to send an email to the customer to notify them that their Incident,
Problem, or Change Request has been resolved.

• Generic Email Template: Use to send a generic email regarding an Incident, Problem, or Change
Request.

Related concepts
Open the Action Block Manager
About Approvals
Using Action Blocks
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Create an Action Block
Create and edit Action Blocks from the Desktop Client or CSM Administrator.

To create an Action Block:

1. Open the Action Block Manager.
2. Select the Create New button.
3. In the Create a New Action Block window, provide a name and description.

The One-Step Action Block Editor opens.
4. On the General page, the Name and General Description fields will auto-populate.
5. Select Execute Post Steps if One-Step fails to continue the post steps despite a One-Step Action

failure.
6. (Optional) Set a category for the Action Block. Select Display in designer toolbox if you want the

Action Block to appear in the One-Step editor toolbox under its category title.

Note: You need appropriate permissions to create categories or add Action Blocks to
existing categories. Be selective about assigning categories to Action Blocks, as the toolbox
can quickly get cluttered.

7. Select the Options button.

Option Description

Availability Select a scope. If you already selected a
scope at the beginning, this is auto-filled with
your selection.

Association
If applicable, select a more filtered scope
(example: A particular team). <Automatic>
applies scope based on login. If not
applicable, this option is disabled.

Custom Image Upload a custom image if desired.

8. Use the Parameters page to add any parameters you want to use in the Action Block. Parameters
can be used to pass information from the Action Block to a One-Step Action in the Action Block, or
from a One-Step Action to the Action Block. You can use parameters for input and output.

Important: If you modify an Action Block parameter that isn't a default value, you must edit all
One-Step Actions that use that Action Block. Use the Find Dependencies function to find the One-
Step Actions you need to edit.

Related concepts
Action Blocks
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Action Block Security Rights
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Using Action Blocks
Edit, create, and run Action Blocks from the Desktop Client and CSM Administrator.

If an Action Block is assigned a category, it will appear in the One-Step designer toolbox. Uncategorized
Action Blocks are available by selecting the Run an action block Action under Advanced Actions in the
designer toolbox.
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Prompts
A Prompt is a display window that requires users to provide information before proceeding with a process or
Action (example: Specify the reason for putting an Incident into Pending status).
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About Prompts
Use a Prompt to provide information, such as:

• Name of an Incident owner.

• Start date and end date to search for Change Requests within a certain date range.

• Comments on a Knowledge Article.

Prompts can be used in:

• Query Comparison Clauses to prompt Users to select a value to search.

• One-Step™ Actions to prompt Users for more information before proceeding with the One-Step
Action.

• Expressions to prompt Users to specify a value as part of an Expression.

There are two types of Prompts:
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• Stored Prompts can be used multiple times.

• Custom Prompts, also known as inline Prompts, are only used where they are created and are not
stored in the Prompts Manager.

There are two ways to obtain Prompt values to be used with REST API:

• The Prompt ID button on the bottom of the Define Prompt dialog box, as seen in the previous
image. The Prompt ID button provides only the Prompt ID.

• The Prompt Info button on the bottom of the first node of the One-Step Editor. The Prompt Info
button provides the necessary Prompt Values for all Prompts in the One-Step Action properly
formatted in JSON.

CSM also provides several OOTB Prompts. Use these Prompts as-is or create new Prompts.
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Prompts Good to Know
Use these tips for helpful information on Prompts.

• You can determine how Prompts are displayed to users. For example, you can:
◦ Have the Prompt display a list of values from a Business Object and field. When the Prompt

appears, users select a value from the list.

◦ Display the Prompt in a variety of ways, such as with a simple text box or in a separate grid.

◦ Have the Prompt read a XML or JSON collection and display the values in a web service
lookup table grid from an entire row or from selected fields in the collection. For more
information, see Web Service Lookup Example.

• In the CSM Desktop Client, Prompts that use a text box contain a spell check. Any misspelled words
in the Prompt's text box will be underlined in red. Users can right-click on an underlined word to see
spelling suggestions or add the word to the dictionary. Spell checking in Prompts works for any
language for which a dictionary is installed.

◦ In the CSM Browser Client, spell check is handled by your browser. In most browsers, it can
be turned on or off in the browser settings or preferences.
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Using Prompts
Users can either view Prompts or enter data into a Prompt.
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View a Prompt
You can view Prompts from Token Selector or the Prompts Manager.
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Enter Data into a Prompt
Use Prompts to provide additional information when working with records, running searches, and
performing various other operations in CSM.

What a Prompt looks like, the type of information you can enter, and whether you can select from a list of
values or type your own value depend on what was specified when the Prompt was created.

Traditional Prompt Window

• Click the drop-down arrow to select from a list of values, or click the Ellipses button to open a Quick
Selector window (displays Results Grid). Select a value.

Note: In some Prompts, both the drop-down arrow and the Ellipses button might be
available. However, some Prompts might only have one or the other available.

• Provide a value to the Prompt field (if allowed).

Grid
In some cases, a Prompt might directly display Results Grid grouped by Business Object Fields. Select a
value from the list.

Simple List
In some cases, a Prompt might directly display a list of values in a simple list of values from a Business
Object field. Select a value from the list.

Web Service Lookup Table Grid
Select a value from the grid.

Number Prompt

• Use the up/down arrows to increase/decrease the number in the Prompt field.

• Provide a number in the Prompt field.

Date/Time Prompt
From the Windows clients (CSM Desktop Client and CSM Administrator):

• In a Date/Time Prompt in the CSM Desktop Client, click the Date Selector button to open a
calendar and select a date, and then place your cursor next to the hours or minutes and type a time
(in HH:MM format). Or, place your cursor next to the month, day, or year and type the date (in
MM/DD/YYYY format) and time (in HH:MM format).
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• In a Date only Prompt, click the Date Selector button to open a calendar and select a date. Or,
place your cursor over the month, day, or year and type a date (in MM/DD/YYYY).

• In a Time only Prompt, place your cursor next the hours, minutes, or AM/PM and then use the up/
down arrows to increase/decrease the time and toggle between AM and PM. Or, place your cursor
next to the hours or minutes and type a time.

From the web applications (CSM Browser Client and Portal):

• In a Date/Time Prompt, click the Date Selector and Time Selector to select a date and time. Or,
place your cursor next to the month, day, or year and type the date (in MM/DD/YYYY format) and
time (in HH:MM format).

• In a Date only Prompt, click the Date Selector button to open a calendar and select a date. Or,
place your cursor over the month, day, or year and type a date (in MM/DD/YYYY).

• In a Time only Prompt, click the Time Selector to select a time and AM/PM. Or, place your cursor
next to the hours or minutes and type a time and AM/PM.

Logical Prompt
Click the drop-down arrow, and then select True or False.
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Managing Prompts
Use the Prompts Manager to complete general CSM Item Manager operations for Stored Prompts.

There are several ways to open the Prompts Manager.
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Open the Prompts Manager
Open the Prompts Manager from CSM Administrator, the CSM Desktop Client, or the CSM Browser
Client.

Open the Prompts Manager in the following ways:

• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > Prompts.

• Anywhere the Token Selector is available, expand Prompts > Browse. The Token Selector is
available for Query Builders, One-Step™ Actions, and Expressions. For more information, see
Query Builders, Define Actions for a One-Step Action, and About Expressions.

Note: Existing Prompts can be accessed from the CSM Browser Client, but new Prompts
can only be created from the CSM Desktop Client or CSM Administrator.
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Create a Prompt
There are two ways to create Prompts:

• Stored Prompts are created using the Prompts Manager.

• Inline Prompts are created from the Token Selector as you work with Query Builders, One-Step
Action, and Expressions.

Creating a Stored Prompt from the Prompts Manager
To create a Stored Prompt from the Prompt Manager:

1. Open the Prompts Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association, if applicable.

4. Select Create New.

5. Define these properties for the Prompt as they apply:
◦ General properties

◦ Value List (Text Prompts only)

◦ Constraints (Text Prompts only)

◦ List Display Options (Text Prompts only)

6. Select Save.6.

Creating an Inline Prompt from the Token Selector
To create a Prompt from the Token Selector:

1. Select the Selector button to expand the Token Selector.

2. Expand Prompts, and then select New Custom Prompt.
3. Define these properties for the Prompt as they apply:

◦ General properties

◦ Value List (Text Prompts only)

◦ Constraints (Text Prompts only)

◦ List Display Options (Text Prompts only)
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Define Properties for a Prompt
To define properties for a Prompt:

1. Define general properties for the Prompt.

Option Description

Name Provide a display name for the Prompt. This
name is displayed in the Token tree under the
Prompts category.

Prompt Provide the informational text that is displayed
in the Prompt window when it pops up.

Prompt Type Select one of these types:
◦ Text: Requests text information from

Users, who can type a word or phrase
into the Prompt window.

Select the Multiline check box to allow
Users to enter more than one line of text
in the Prompt window.

◦ Number: Requests a numeric value from
Users.

◦ Date/Time: Requests a date and time
from Users. Users can select date values
from a calendar.

◦ Logical: Requests Users to select True
or False from a drop-down menu.

◦ Date: Requests a date from Users. Users
can select values from a calendar.

◦ Time: Requests a time from Users.
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Option Description

Default Values
Select the Value option for the following default
Prompt values:

◦ Text: Provide a word or phrase to use as
the default value.

◦ Number: Provide a number or use the up/
down arrows to increase or decrease the
default number by whole numbers.

◦ Date/Time: Select the Date Selector
button to access the Calendar and select
a default date. Then, select the time and
type a default time (highlight the hour and
type a number, and then highlight the
seconds and type a number). You can
also type the date into the field.

◦ Logical: Select True or False as the
default value.

◦ Date: Select the Date Selector button to
access the Calendar and select a default
date. You can also type the date into the
field.

◦ Time: Provide a default time to the field or
use the up/down arrows to increase or
decrease the time (highlight the hour and
type a number or use the up/down
arrows, and then highlight the seconds
and type a number or use the up/down
arrows).

Select the Expression radio button for the
following default Prompt values:

◦ Use the drop-down list to select an
Expression.

◦ Select the ellipsis button to open the
Expression Manager.

◦ Select the Custom Expression button to
use a Custom Expression.

2. Optionally, for Text Prompts, you can:
◦ Define the Value List for Prompt.
◦ Define Constraints.
◦ Define List Display Options.

3. Select the Re-prompt on Each Occurrence check box to re-prompt the User each time this Prompt
is encountered.
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Note: This option is for One-Step Actions, especially if a One-Step Action contains a Go To
Action that returns to an Action that includes a Prompt. If this box is checked, the User is
prompted each time the One-Step Action executes an Action (or returns to an Action) with
the same Prompt. This option is not available for values listed from a collection.

4. Select Save.
The Prompt shows up in the Token tree under the Prompt category and can be used in other places
where the Token tree is available.
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Define the Value List for a Prompt (Text Prompts
Only)

To define a list of values that Users can select in the Prompt:

1. In the Value List drop-down, define whether to display a list of values that a User can select from in
the Prompt window:

Option Description

None Select this option to have no list of values
displayed for the User (User must type a
word or phrase into the Prompt).

List Values from a Table and Field Select this option to have a list of values
displayed from a Business Object and field
you select.

List Values from a Collection Select this option to have values displayed
from an XML or JSON collection in a web
service lookup table. Then, select a
collection (example: A result from a web
service call saved as a variable). You can
use all fields from the collection, or select
(and order) specific fields to display. The
prompt can return an entire row of JSON or
XML, or a value from a single field that can
be stored for later use. See the web service
lookup example for more information.

Important: The selected collection
must be a JSON or XML data type.

Valid Values for a Field Select this option to have a list of valid
values displayed from a field in the
associated Business Object (example:
Incident).

Note: This option is only available if
the context of the Prompt (example:
One-Step Action, Query, or
Expression) is associated with a
Business Object.

2. If you select List Values from a Table and Field, select the Business Object that contains the
fields with the values a User can select from in the Prompt window from the Table drop-down. You
can choose to see Lookup Tables or all tables in the list.
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Note: You can only select a table if you choose List Values from a Table and Field from
the Value List drop-down. If you select Valid Values for a Field, the Business Object
associated with the Prompt's context (example: One-Step Action, Query, or Expression) is
shown. To change the table, you must change the Business Object association for the One-
Step Action, Query, or Expression where the Prompt is being used.

3. In the Field drop-down, select the Business Object Field that contains the values the User can
select from in the Prompt.

4. Select the User Can Only Choose Values from the List check box to prevent any values that are
not in the list from being used in the Prompt. If not selected, Users can type any value into the
Prompt.

5. Select the Return Value from Different Field check box to have the Prompt return values from a
field other than the one selected in the Field drop-down. Then, select the Field in the drop-down.

Note: This option is available only if you select List Values from a Table and Field in the
Value List drop-down, and select User Can Only Choose Values from the List.
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Define Constraints (Text Prompts Only)
For Text Prompts (excluding values listed from a collection), you can optionally define a list of constraints
or filters to limit the values in a Prompt.

1. Select Add to add a constraint or filter.

2. Select a field in the Business Object you are currently working with.

3. Select an operator (example: Equals).

4. Value: Select a value for the field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

5. Select OK.

6. Add additional constraints as necessary.
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Define List Display Options (Text Prompts Only)
For text Prompts in which List Values from a Table and Field is selected in the Value List drop-down
menu, define how to display the list of values.

Option Description

Auto

Select this option in the drop-down menu to have the
system choose the best option for displaying the list of
values. The options are an Ellipses button and a drop-
down button.

• The Ellipses button is most often displayed in the
Prompt window. This means that the system has
found the Business Object (selected from the Table
drop-down menu). The Ellipses button opens a
window that displays a list of values in a grid. The
values are grouped by the Business Object field
(selected from the Field drop-down menu) and then
by the Fields in the Business Object's default Grid.
See About Grids.

• The drop-down button is displayed if the Business
Object definition can be cached or if the Business
Object field (selected from the Field drop-down
menu) has the TreatAsCacheableForPrompt general
attribute (defined on the Advanced Properties page
of the Field Properties window). The drop-down
button displays the list of cached values for the
Business Object field. For large text fields, select the
Include Large Text Fields in Cache check box on the
Advanced Properties page. Caching is required to
quickly lookup the value for prompts. See Define
Advanced Properties for a Business Object.

Display a Simple Text Box Select this option to display the Prompt window where
Users can type values into a text field.

Display List of Values in a Combo

Select this option to display the Prompt window where
Users can type values into a text field, or select from a list
of values in a drop-down. The drop-down shows values
from the selected Business Object field (in the Field drop-
down).

Show Open Button

Select the check box to show an Ellipses button that
Users can click in the Prompt window to open a separate
Quick Selector window, which displays the list of values
as a grid.
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Option Description

Display List of Values in a Grid

Select this option to have the list of values displayed in a
grid grouped by the selected Business Object field (from
the Field drop-down menu), and then by the fields in the
Business Object's default Grid. If you select this option,
the Prompt bypasses the Prompt window and immediately
navigates the User to the grid, where they can select a
value from the list.

Note: The default Grid for a Business Object is
configured using the Grid Editor in CSM
Administrator. The ability to configure the Grid
depends on the Grid's grouping properties. See
Grid Editor.

Display List of Values in a Simple List

Select this option to display a list of values in a list that
only shows values from the selected Business Object
field. If you select this option, the Prompt bypasses the
Prompt window and immediately navigates the User to the
list of values.
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Configuring Prompts
Prompts Security rights are configured in CSM Administrator. See Prompts Security Rights.
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Web Service Lookup Example
CSM Prompts can read an XML or JSON collection and display the values in a lookup table grid from an
entire row or from selected fields in the collection. This allows users to easily select and use information
from third-party web service calls.

Overview
For example, create a One-Step™ Action that calls a web service, stores the JSON result in a variable,
and then uses the result to create a web service lookup table from which users can select a value. The
values returned from web service and web service lookup results can be parsed to populate Business
Object fields, make additional web service calls, or used as a Token in other actions.

This example uses the Edmunds Vehicle API web service. The API and any data from it were used in
accordance with the Edmunds Vehicle API Terms of Service for purposes of this example only.

To create a web service lookup:

1. Run a One-Step Action (from a button or link).

2. Enter a 4-digit year into the first Prompt.
The web service returns a web service lookup table with a list of vehicle makes and models for the
specified year.

3. Select a vehicle make and model from the web service lookup table.
The selected make, model, and year are passed back to the web service to find available styles for
the vehicle.

4. Select a style for the specified vehicle make, model, and year.
Use the value returned from this selection to populate Business Object fields, make additional web
service calls, or create a Token for use in other actions.

The configuration for this workflow is in the following sections.

Set Up a Web Service
Set up a web service that returns a list of vehicle makes, models, and styles:

1. On the General page, define a name, URL, and service type for the web service.
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2. Define web service methods for makes and styles.

Important: If the web service is configured to return results as JSON or XML, ensure that
JSON or XML is selected as the result type in the web service methods.
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The Makes method will return a list of vehicle makes and models by year. The API Key parameter is
set to the key value required to access the API site.
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The Get Styles method will return a list of styles for a vehicle by make, model, and year.
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Call the Web Service Using a One-Step Action

1. Create a One-Step Action.

2. Add a Call a Web Service Action that calls the Edmunds Vehicle API and returns a list of vehicle
makes and models by year (the user will be prompted to enter a year).

3. In the step details, select the General page and define a name for the action (example: Select a
make and model).
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a. Select the Edmunds Vehicle API web service created in the previous step.

b. Select the Store result as check box to store the result of the web service call as a variable.
Provide a name for the variable (example: Select make and model result).

4. Select the Method page and in the Method drop-down list, select Makes.
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a. Select year (Endpoint parameter).

Note: The parameters are based on those defined for the web service methods when
the web service was set up. The API Key parameter is set to the key value required to
access the API site.

b. Select the Set Value option and then right-click in the Value field (or select the Token
selector) to insert a new Prompt. .

c. Create a Prompt that asks users to enter a four-digit year.
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When the One-Step Action runs, and the user enters a year into the Prompt, the value of the
year is passed as a parameter to the Edmunds Vehicle API web service. The web service
returns (as JSON) a list of makes and models by year, which is stored in the Select make and
model result variable.

Display Results in a Web Service Lookup
Use an Update a Variable or Stored Value Action with a Prompt to display vehicle makes, models, and
year (selected in the first prompt) from the web service call in a web service lookup table, and then store
the user's selection in a variable.

1. Add an Update a Variable or Stored Value Action to the One-Step Action and define a name for
the Action (example: Update Selected Make and Model).
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a. Select the Variable option, and define a name for the variable (example: Selected Make and
Model). Select JSON as the Data Type.

b. In the New Value field, right-click or select the Token selector to insert a new Prompt.

c. Create a Prompt that displays the makes, models, and year (selected in the first Prompt) from
the web service call in a web service lookup table. Ensure the Prompt type is text. The
collection to step through must be a JSON or XML data type.

Important: To display selected fields (example: make, model, and year) in the web
service lookup, you must use the exact names of the columns in the JSON returned
from the web service. If you are unsure of the exact names, you can select the Use all
fields from collection check box to have a list of all columns returned and reference
the exact column names to specify only those you want to display in the web service
lookup table.
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When the One-Step Action runs, the Prompt will display the web service lookup table with the
specified fields.
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Because the Return entire row as JSON option was selected when the Prompt was created,
the entire row of JSON will be returned as the result when the user selects a row in the web
service lookup table. The result is stored in the Selected Make and Model variable.

{
"makes.id": "200000081",
"makes.name": "BMW",
"makes.niceName": "bmw",
"models.id": "BMW_3_Series",
"models.name": "3 Series",
"models.niceName": "3-series",
"years.id": "200468552",
"years.year": "2014"
}

Obtain Vehicle Styles from Web Service
Use another Call a Web Service Action to return a list of styles for the vehicle make and model selected in
the previous section (stored in the Selected Make and Model variable).

1. Add another Call a Web Service Action to the One-Step Action.
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2. In the step details, select the General page and Define a name for the Action (example: Get Vehicle
Details).

a. Select the Edmunds Vehicle API web service.

b. Select the Store Result As check box to store the result of the web service call as a variable.
Provide a name for the variable (example: Get Vehicle Details result).

3. Select the Method page and in the drop-down list, select Get Styles.
a. For each parameter (make, model, and year):

i. Select the Set Value option.

ii. Right-click in the Set Value field or select the Token selector to insert the Selected Make
and Model variable (from the previous Update a Variable or Stored Value Action).

iii. Right-click the variable for each parameter and add modifiers to return the desired
values from the web service.
Make parameter: Obtain the makes.name value from the JSON result based on the
user's selection in the web service lookup table.

Model parameter: Obtain models.name value from the JSON result based on the user's
selection in the web service lookup table.

Year parameter: Obtain years.year value from the JSON result based on the user's
selection in the web service lookup table.

Display Vehicle Styles in a Web Service Lookup
After defining the Action to call the web service for a list of vehicle styles, you can have the results
displayed in a web service lookup and show the user's selection in a pop-up window.

1. Add a Show a Popup Action to the One-Step Action.
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a. In the Contents area, right-click or select the Token selector to insert a new Prompt.

b. Create a Prompt that displays a list of style ids and names for the previously selected make
and model in a web service lookup table.
When the action runs, the Prompt will display a web service lookup table with the specified
fields.

Because the Return value from single field option was selected when the Prompt was
created, a single styles.name value will be displayed in the pop-up window when the user
selects a row from the web service lookup table.
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This value can be used to populate Business Object fields, make additional web service calls,
or create a Token for use in other actions.

Related concepts
About Prompts
Set Up a Web Service
Create/Edit a One-Step Action
Create a Prompt
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Queues
A Queue is a mechanism for routing issues to a particular person or group so the most qualified person can
start working on the issue right away.
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About Queues
Use Queues to inform Users, Teams, or the entire organization about what to complete by placing all their
assigned records in a defined location. Queues are especially beneficial for large organizations (75 to 100
Users) because they efficiently organize multiple records.

CSM allows you to create and define the following types of Queues:

• User Queues: Queues for specific people (example: Tom is an expert on printers, so all printer
Incidents are assigned to his Queue).

• Team Queues: Queues for teams, so that the first available Team member is assigned the next
record in the Queue.

• Global Queues: Queues that are available to all Users in your CSM system.

Access common Queue functionality from the:

1. CSM Desktop Client Queue pane.

2. CSM Desktop Client menu bar.

CSM provides several OOTB Queues. Use these Queues as-is, edit them, or create your own using the
Queue Manager.
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Queues Good to Know
Use Queues good to know for useful information.

• A Queue is typically identified by the Queue icon .

• Each Queue can only hold a single type of record (example: Incident, Problem, Change).

• Queues behave a bit differently in the CSM Browser Client.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator(Security > Edit Security Groups).

Related concepts
CSM Browser Client
Queues Security Rights
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Using Queues
When working with Queues, users can view Queues, and add, remove, and check out records from a
Queue.
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View a Queue
A Queue can be viewed from CSM Administrator, the CSM Desktop Client, and the CSM Browser Client.

• Available Queues (based on security rights): Use the Queue Manager.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), select the Queue link
(example: 2nd Level).

• From the CSM Desktop Client menu bar: Tools > Queues > Queue Manager.
• From the CSM Browser Client menu bar: Searches > Queues > Queue Manager.

Related concepts
Open the Queue Manager
Queue Pane
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Queue Pane
The Queue pane is located in the CSM Desktop Client Task Pane and provides users with access to
common Queue operations.

Note: If the Task Pane is not visible in the CSM Desktop Client Main window, select the horizontal
Pin icon on the Task Pane tab to display the pane.
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Use the Queue pane (accessed within the CSM Desktop Client Task Pane) to complete the following
operations:
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• Define Queue pane preferences

• Add records to a Queue

• Check out records from a Queue

• Open the Queue Manager

Related concepts
Define Queue Pane Preferences
Add a Record to a Queue
Check Out a Record from a Queue
Open the Queue Manager
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Define Queue Pane Preferences
Use the Edit Queue Pane Setup window to define Queue pane preferences, such as:

• General preferences: Which Queues are displayed in the Queue pane and how.

• User Queue preferences: If User Queues are displayed in the Queue pane and how.

Good to know:

• CSM automatically creates a primary User Queue for each User for each Business Object in the
system (Incident, Problem, Change, etc.). This allows records to be assigned to Users without
having to manually create each Queue, though Users can also create additional Queues for each
Business Object, and can also rename or otherwise customize these automatic Queues.

• If your organization does not use User Queues, you can keep the current default preferences.

To define Queue Pane preferences:

1. Right-click in the Queue pane (accessed within the CSM Desktop Client Task Pane), and then
select Queue Pane Setup.

2. Define general Queue pane properties:
a. Click the General page.

b. Define general Queue preferences:
i. Show Current Record Status: Select this check box to display the Queue status of the

current record (example: On 2nd Level Queue).

ii. Queues Displayed without Scrolling: Specify the number of Queues to display on the
Queues pane before a scroll bar becomes visible.

Note: Displaying multiple Queues without a scroll bar decreases the space
allowed for other Task Pane items.

iii. Queues to display: Select the Queues to display in the Queue pane.

◦ Add/Remove buttons: Use these buttons to add or remove Queues from the Queue
pane.

Note: When you click the Add button, the Queue Manager opens giving you the
option to select an existing Queue or create a new Queue.

◦ Arrow buttons: Use these buttons to control the order in which Queues are displayed in
the Queue pane.

◦ Queue is only shown if it has items: Select this check box to display the selected
Queue only if it contains records.

3. Define User Queue preferences.
a. Click the User Queues page.

b. Define User Queue preferences:
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i. Show User Queues that Contain Items: Select this check box to display User Queues
in the Queue pane that contain at least one item (example: If Henri's Incident Queue has
at least one item, it would be displayed in the Queue pane).

ii. Position in Queue list: Select the position of User Queues (Above Other Queues or
Below Other Queues) relative to other Queues in the Queue pane.

iii. Which User Queues are Shown?: Select an option to limit User Queues displayed in
the Queue pane.

◦ Primary Business Object Only: Select this radio button to display only the User Queue
for the primary Business Object with which you are assigned to work. This Object is set
based on the current view, and can be modified by the system administrator (example:
Henri's Incident Queue).

◦ All Business Objects: Select this radio button to display User Queues for all Business
Objects that support Queues.

◦ Selected Business Objects: Select this radio button to display only User Queues for a
selected Business Object. Click Add to select the Business Object.

4. Select OK.4.
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Add a Record to a Queue
You can add a record to a Queue directly from a Business Object record.

To add a record to a Queue:

1. Open a record.

2. Do one of the following:
◦ From the CSM Desktop Client menu bar, click Tools>Queues>Current Record>Add to

Queue.

◦ From the Queue pane (accessed within the CSM Desktop Client Task Pane), click the Add to
Queue button next to the desired Queue.

◦ From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click and
select Add Current Record to Queue.

◦ On your keyboard, press CTRL+Q.

a. Select the Queue for which you want to add the record. Options include:
◦ Leave the selected Queue as-is.

◦ From the drop-down, select a recently added Queue.

◦ Click the Ellipses button to open the Queue Manager, and then select an existing Queue
or create a new Queue.

◦ Select the User Queue radio button and select the Team and User in the drop-downs.

b. (Optional) Provide custom text for the Queue History Journal record.

3. Select OK.3.

The record is added to the Queue.
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Remove a Record from a Queue
You can remove a record from a Queue from the CSM Desktop Client main window.

To remove a record from a Queue:

• From an open Queue, right-click a record, and then select Queues>Remove from [Queue Name]
Queue.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click the On
[Queue Name] Queue text and select Remove from Queue.

Related concepts
Queue Pane
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Check Out a Record from a Queue
You can check out a record from a Queue from the CSM Desktop Client main window.

Good to know:

• When a record is checked out to a user from a Queue, all users who view the Queue status can see
that the user is the Queue owner of the record. This prevents multiple users from attempting to work
on the same record at the same time. Depending on your system settings, you might only be
allowed to check one record out at a time.

• The record pulled from the Queue is based on the configuration of that Queue (example: Based on
highest priority). The record will never be a record that is already checked out to another user. This
is an effective method of work distribution, because each user has the ability to select the next
record, which will automatically retrieve the appropriate record based on order.

A record can be checked out from a Queue several ways:

• From the Queue Manager menu bar, select Queues > Check out next record.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), select the Check
Record Out from Queue button .

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click the On
[Queue Name] Queue text and select Check out current record.

Related concepts
Queue Pane
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Manage Queues
Use the Queue Manager to manage Queues.

Use the Queue Manager to:

• View a Queue.

• Create a Queue.

• Add a Queue to the Queue pane.

• Open a Queue as a Group.

• Open a Queue as a Specific Group.

• Edit a Queue.

• Delete a Queue.

• Search for a Queue.

• Organize Queues.

• Copy a Queue.

CSM 2022.3 Features 1275

CSM 2022.3 Features



• Import/export a Queue.

• Find Queue dependencies.

• Pin a Queue.

Related concepts
Open the Queue Manager
View a Queue
Manage Queues
Using CSM Item Managers
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Open the Queue Manager
Open the Queue Manager from CSM Administrator, the CSM Desktop Client, and the CSM Browser
Client.

To open the Queue Manager:

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), select the Queue
button.

• From the CSM Desktop Client menu bar, select Tools > Queues > Queue Manager.
• From the CSM Browser Client, select Searches > Queue Manager.
• From the Blueprint Editor menu bar, select Managers > Queues.

• From the mApp Editor menu bar, select Managers > Queues.

Related concepts
Queue Pane
Blueprint Editor Menu Bar
mApp Editor Menu Bar
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Create a Queue
Use the Queue Properties window (accessed from within the Queue Manager) to create a Queue.

When you create a Queue, you define:

• General properties: Name, description, Queued Object (example: Incident), Priority Field, and
Queue checkout order.

• Behavior properties: Queue limits, behavior, and record ownership transfers.

• History properties: Queue History Journal settings.

To create a Queue:

1. Open the Queue Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association, if applicable.3.

4. Select Create New.

5. Define the following:
a. General properties.

b. Behavior properties.

c. History properties.

6. Select Save.6.

Related concepts
Open the Queue Manager
Define General Properties for a Queue
Define Behavior Properties for a Queue
Define History Properties for a Queue
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Define General Properties for a Queue
Use the General page in the Queue properties window (accessed from within the Queue Manager) to
define general properties for Queues.

When you define general properties, you define:

• Name

• Description

• Queued Object

• Priority field

• Queue checkout order

To define general properties for a Queue:

1. Open the Queue Manager.

2. Select Create New.

3. Select the General page.

4. Define general properties:
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

c. Queued Object:

Select the type of record that can be placed in the Queue from the drop-down list.

d. Queue Items are Prioritized:

Select this check box to specify the default order in which the items should be removed from
the Queue. Then, select the Field and whether to retrieve records in ascending or descending
order based on the prioritization (example: Select Incident Priority so that Priority 1 Incidents
are retrieved before Priority 2).

Note: If prioritization is not specified, then records are retrieved based on order of
creation.

e. Queue Checkout Order:
Select the order of items checked out from a Queue:

◦ Oldest First: Check out the oldest records in the list first.

◦ Newest First: Check out the newest records in the list first.
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◦ Manual: Check out a record based on user selection (user can check out any record in
the Queue).

Note: This selection removes the option to retrieve the next record from the
Queue. If Queue items are prioritized, the records are retrieved based on the
defined priority. If records have the same priority, the Oldest/Newest value is
applied.

5. Select Save.5.

Related concepts
Open the Queue Manager
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Define Behavior Properties for a Queue
Use the Behavior page (accessed from within the Queue Manager) to define behavior properties for
Queues.

When you define behaviors, you define:

• Queue limits

• Queue behavior

• Record ownership transfers

Good to know:

While a record is suspended in a Queue, it is not automatically checked out when a user selects the Next
Available record from the Queue.

To define behavior properties for a Queue:

1. Open the Queue Manager.

2. Select Create New.

3. Select the Behavior page.

4. Define Queue limits (number based or time based):
◦ Limit User to [Number] records checked out at a time: Select this check box to limit the

number of records that a user can check out of a Queue at one time.

◦ Limit checkout time to [Number] [Timeframe]: Select this check box to limit on the amount
of time a user can keep a record checked out from a Queue (when the specified time passes,
the record is automatically shown as not checked out). Then,

a. Define Queue behaviors (select all that apply):
◦ Allow items to be suspended from a Queue: Select this check box to allow records to

be suspended until the user removes the suspension.

◦ Checking out an item removes it from the Queue: Select this check box to remove a
record from the Queue when it is checked out.

Note: This option is recommended for users who retrieve the record and
complete the work in a single operation.

◦ Automatically refresh count on Task Pane: Select this check box to automatically
update the display of the total number of records in the Queue.

◦ Part of Queue Group: Select this check box to have the Queue belong to a specific
Queue Group, then select the Queue Group from the drop-down list. If necessary, select
the Ellipses to open the Queue Group Manager, which allows you to create a new
Queue Group.

◦ Automatically remove [Business Object] from Queue when [Final State]: Select this
check box to remove the Business Object from the Queue when the lifecycle of the
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Business Object is complete (example: If an Incident is closed, it is automatically be
removed from the Queue).

Note: This option is only available if the Business Object has a lifecycle.

Important: For CSM 10.2.0 or later versions, use the Business Object
Lifecycle Editor to add a lifecycle to a Business Object. See: Open the
Lifecycle Editor.

b. Define record ownership transfers (select all that apply):
◦ When record put on Queue: Select this check box to automatically change the owner

of a record to a specific user or team when the record is placed on the Queue (example:
The Networking Team owns the Networking Queue).

◦ When record checked out from Queue: Select this check box to automatically change
the owner of the record to the user who checked out the record.

5. Select Save.5.

Related concepts
Open the Queue Manager
About Queue Groups
About Business Object Lifecycles
Open the Lifecycle Editor
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Define History Properties for a Queue
Use the History page (accessed from within the Queue Manager) to define Queue History Journal
settings.

When you define history properties, you define settings for the following operations:

• Add to Queue
• Check out/Check in
• Reassign
• Suspend/Unsuspend
• Remove

Good to know:

• Queue History Journal settings for default user Queues can also be set using CSM Administrator
(Settings > Edit User Queue Settings).

• Queue History Journal options are only available if the Business Object supports History, which is
configured using CSM Administrator (Create a New Blueprint > Business Object > Edit Business
Object > Bus Ob Properties button > History Page).

To define history properties for a Queue:

1. Open the Queue Manager.

2. Select Create New.

3. Select the History page.

4. Define Queue History Journal properties:
a. Set History options for Queue operations (Add to Queue, Check Out, Check In, Reassign,

Suspend, Unsuspend, Remove).

Select one of the following options from the corresponding drop-down:

◦ Auto-generate: Select this option to automatically create a Queue History Journal
record containing default text when the action takes place.

◦ No History: Select this option to create no Queue History Journal record when the
action takes place.

◦ Optional: Select this option to prompt the user to add notes to the Queue History
Journal record when the action takes place. It also allows the user to select not to create
a Queue History Journal record.

◦ Prompt: Select this option to prompt the user to add notes to the Queue History Journal
record when the action takes place, but does not allow the user to cancel the Queue
History record.
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Note: Canceling the prompt cancels the entire Queue operation. If a record is
added to a Queue using an automated process (example: Automation Process),
the Optional and Prompt options add History, but use default text.

5. Select Save.5.

Related concepts
Open the Queue Manager
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Add a Queue to the Queue Pane
Add a Queue to the Queue pane using the Queue Manager.

To add a Queue to the Queue pane:

1. Open the Queue Manager.

2. Right-click a Queue and select Add Queue to Queue Pane.

3. Select OK.3.

Related concepts
Queue Pane
Open the Queue Manager
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Open Queue as a Group
Use the Queue Manager to open a Queue as a group.

To open a Queue as a group:

1. Open the Queue Manager.

2. Select a Queue.

3. Select Queues on the Queue Manager menu bar, and then select Open Queue as Group from the
drop-down.

The Queue records open as a list in the CSM Desktop Client Main Pane.

Related concepts
Open the Queue Manager
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Open Queue as a Specific Group
Open a group containing a subset of the records in a Queue using the Queue Manager.

To open a list of specific records in a Queue:

1. Open the Queue Manager.

2. Select a Queue.

3. Select Queues on the Queue Manager menu bar, and then select Open Special from the drop-
down.

4. Select the type of group that you want to open:
◦ Available records in the Queue: Open all records in the Queue that are not checked out to

anyone and are not in a suspended state.

◦ Records checked out to you from the Queue: Open all records in the Queue that are
currently checked out to the current user.

◦ All records checked out of the Queue: Open all records in the Queue that are checked out
by any users.

◦ Records that are suspended in the Queue: Open a group of all records in the Queue that
are in a suspended state.

The records open in the CSM Desktop Client Main Pane.

Related concepts
Open the Queue Manager
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Configure Queues
Use CSM Administrator to configure Queues.

To configure Queues:

1. Configure Queue security rights: Configure who can access Queue functionality.

2. Add Queue support to a Business Object: Define if users should be allowed to add a specific type of
Business Object record to Queues.

3. Define Queue settings based on Business Object lifecycle: Define how Business Object records are
added to or removed from Queues based on lifecycle states.

Important: For CSM 10.2.0 or later versions, use the Business Object Lifecycle Editor to
add a lifecycle to a Business Object. See: Open the Lifecycle Editor.

4. Specify Queue history placement: Define which Business Object to use for tracking when records
are added to or removed from a Queue.

5. Define default user Queue history settings: Define Queue History Journal records to track Queue
operations (example: Add to Queue, check in, check out, reassign, suspend, unsuspend, remove).

6. Transfer ownership to user when record is placed in a user Queue: Define if users can transfer
record ownership to a specific user when a record is placed in a user Queue.

Related concepts
Queues Security Rights
Define General Properties for a Business Object
Define Additional Business Object Properties
Configure Global User Queue Settings
About Business Object Lifecycles
Open the Lifecycle Editor
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About Queue Groups
Use Queue Groups to prevent records from being placed in more than one Queue at the same time when
users have multiple Queues.

If a record is assigned to one of the Queues in the group, it will automatically be removed from any other
Queue in the group; however, the record can still be placed on other Queues that are not members of the
group.

The following figure shows a Queue Group created for the 2nd Level Queue and New Request Queue,
which are both associated with the Incident Business Object. Since an Incident could be added to either
Queue based on the specified fields within the record, the Queue Group prevents the record from being
placed in both the 2nd Level Queue and the New Request Queue.

Edit existing Queues or create your own using the Queue Group Manager.

Related tasks
Create a Queue Group
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Queue Groups Good to Know
Use Queue Groups good to know for useful information.

• Queue Groups prevent a record from being in more than one Queue at the same time.

• To be added to a Queue Group, Queues must have a Queued Object that matches the Queue
Group Business Object association.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups).

Related concepts
About Queue Groups
Security Rights
Queues Security Rights
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View Queue Groups
View Queue Groups from the CSM Desktop Client.

To view Queue Groups:

• From the CSM Desktop Client menu bar, select Tools > Queues > Queue Manager > Queues >
Queue Group.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click and select
Queue Manager > Queues > Queue Group.

Related concepts
Queue Pane
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Manage Queue Groups
Manage Queue Groups from the Queue Group Manager.

Use the Queue Group Manager to complete general CSM Item Manager operations for Queue Groups,
including:

• Create a Queue Group.

• Edit a Queue Group.

• Delete a Queue Group.

• Search for a Queue Group.

• Organize Queue Groups.

• Copy a Queue Group.

• Import/export a Queue Group.

Related concepts
Using CSM Item Managers
Related tasks
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Create a Queue Group
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Open the Queue Group Manager
Open the Queue Group Manager from the CSM Desktop Client.

To open the Queue Group Manager:

• From the CSM Desktop Client menu bar, select Tools > Queues > Queue Manager > Queues >
Queue Group.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click and select
Queue Manager > Queues > Queue Group.

Related concepts
Queue Pane
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Create a Queue Group
Use the Queue Group Manager to create Queue Groups.

Users can create Queues Groups to meet the specific needs of their company.

The Queues that you add to the group must have a Queued Object that matches the Queue Group
Business Object association.

To create a Queue Group:

1. Open the Queue Group Manager.
2. Select a scope and subfolder (if needed).
3. Select a Business Object association.
4. Select Create New.
5. Define general properties:

a. Provide a display name to use within CSM (search this property in CSM Item Managers).
b. Provide a description to use within CSM (search this property in CSM Item Managers).

6. Select Add.
7. Select the Queue that you want to add to the Queue Group.
8. Select OK.

The Queue displays in the Queue Group window.
9. Add additional Queues to the Queue Group.

10. Select OK.

Related concepts
Open the Queue Group Manager
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Record Locking
Record locking is the ability to prevent record editing (or warn that a record is locked) so multiple users do not
make simultaneous changes to the same record. Read-only access is still allowed.
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About Record Locking
Use record locking to:

• Prevent data conflicts.

• Prevent access to unsaved/uncommitted edits.

The record locking interface and behaviors vary depending on your system's record locking configuration
(settings and security rights), who is viewing the locked record (lock holder or another User trying to
access the locked record), and the CSM client (Desktop Client, Browser Client, or Portal).

Depending on the configuration:

• Record locking can be either:
◦ Enforced: Prevents Users from editing a record when it is locked by another User (the lock

holder).

◦ Informational: Warns Users when a record is currently being edited by another User so that
Users do not attempt to edit the same record.

• A record can be locked either:
◦ Automatically (implicitly): When a User attempts to edit a record.

◦ Manually (explicitly): When a User clicks the Unlocked button on the CSM Desktop Client
toolbar or CSM Browser Client toolbar.

• A record can be unlocked either:
◦ Automatically: When the lock holder saves an edit, when the lock holder logs out of his

session, or after a configured expiration. Lock holders can be given the option to renew a lock
before it expires.

◦ Manually: When the lock holder clicks the Locked By You button on the CSM Desktop Client
toolbar or CSM Browser Client toolbar.

Tip: A User can manage (view and unlock) all his User locks (records locked by him) using the
Record Locking Manager in the CSM Desktop Client (Edit>User Locks). A system
administrator can manage (view and unlock) Global locks (all locked records for all Users)
using the Record Locking Manager in CSM Administrator (CSM Admin>Settings>Global Lock
Manager).

• A lock can expire and can be renewed before expiration.

Record locking is enabled and configured in CSM Administrator. Global locks are managed (viewed and
unlocked) using the Record Locking Manager in CSM Administrator. With security rights, Users can
alsoview and unlock their own locked records in the CSM Desktop Client.
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Record Locking Good to Know
• Only Major Objects can be locked.

• When a parent record is locked, its entire form is locked, including any child records in the
Arrangement; however, child records can still be changed from another location or through a
different process (example: A User can update a related Task, etc.).

• If two Users simultaneously edit the same record (example: Informational lock allows a User to edit
the record even if another User is currently editing it, or a non-participating entity, such as an
Automation Process, One-Step Action, Scheduler, or mobile client, edits a record while it is locked),
the User will be given the option to reload or merge simultaneous edits.

• By default, a One-Step Action honors the record locking behavior of the record on which it is used.
For example, if Incident is configured to lock records, and a One-Step Action is run to update the
active Incident record (the record is open or selected in the Grid), the One-Step Action will attempt
to lock the record.

◦ A One-Step Action will attempt to lock the active record when the specific Action to update a
record executes (including Actions that update or create child records).

◦ One-step Actions running against a group of records (such as a Search Group), honor the
record locking configuration only on the active record. For any other records in the group,
record locking is bypassed.

◦ If a One-Step Action Action acquires a lock, the lock is released based on the Business
Object's record locking configuration (example: If the Business Object is configured to
automatically release locks upon save and the One-Step Action Action saves the record, then
the lock is released when the One-Step Action saves the record).

◦ If a One-Step Action attempts to lock a record that is locked by another User, a warning
appears stating that the record is already locked, and One-Step Action execution fails. If
record locking is informational, One-Step Action execution only fails if the maximum number of
locks is exceeded.

◦ If the One-Step Action is run against a group of records, and attempts to lock records that are
already locked by other Users, a warning appears stating which records were already locked
and could not be updated; however, the One-Step Action will update the remaining records in
the group.

Note: A One-Step Action that updates a Business Object can also be configured to
explicitly acquire a lock before running to ensure that the active record is locked prior
to One-Step Action execution, not just when a specific Action to update a record is
being executed. Acquiring a lock prior to One-Step Action execution ensures that the
One-Step Action will not fail if a particular Action cannot acquire a lock. If a One-Step
Action is configured to acquire a lock prior to execution, it can also be configured to
release the lock after the entire One-Step Action finishes executing.

• In the Browser client, automatic record locking notifications are not available, so Renew is not an
option. Users are given the option to reload or merge only if they attempt to save changes to an
already changed (and saved) locked record (example: Allowed with informational locking and or a
non-participating entity).
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• The Scheduler, Automation Processes, and Users making use of the CSM Web Service do not
participate in record locking, meaning they neither lock a record nor see locks on a record. This
means that if one of these entities needs to edit a locked record, it will be able to do so. In the event
that simultaneous edits are made to a record, CSM will give Users the option to merge changes.

• By default, the Customer Portal does not participate in record locking, meaning Customers never
lock a record or "see" a lock on a record. If the Portal is explicitly configured to participate (in
enforced locking), it silently participates, meaning the Customer automatically acquires and releases
locks (so that Users are prevented from editing). The only time a Customer receives a locking
message is if she attempts to edit a record locked by another User. In this situation, the changed
record is automatically reloaded if the Customer attempts to edit the record after the User unlocks
the record.
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Using Record Locking
Users can manually lock and unlock records.
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Manually Lock a Record
Use the Unlocked button on the CSM toolbar on theDesktop Client and Browser Client to manually lock a
record.

Good to know:

• Some systems are configured to automatically lock a record when you start editing it (implicit
locking).

• If your system is configured to explicitly lock a record, you need to manually lock the record before
you can edit the record.

To manually lock a record:

1. Open a record (example: Incident).

2. On the CSM Desktop Client toolbar or CSM Browser Client toolbar, click the Unlocked button.

Tip: You can also click Edit>Unlocked from the CSM Desktop Client menu bar.

To the lock holder (User who locked the record):

◦ The Record Locking button toggles to the Locked By You button so that the User can
manually unlock the record, if needed.

To any User who tries to edit the locked record:

◦ The locked record can be viewed but not updated

Note: If record locking is configured to be informational (rather than enforced), the
record is editable but the User is warned that another User has the record locked. If
two Users simultaneously edit the same record, CSM gives the User the option to
merge the edits.

◦ The Locked By User button indicates that the record is locked by another User (lock holder).
A tooltip indicates whom has the record locked, when it was locked, and when the lock will
expire.

3. The lock holder edits the record.

When locked, several scenarios are possible, depending on the record locking configuration
(settings and security rights):

◦ If record locking is configured to have a lock renewal period (example: 3 minutes), the lock
holder has the option to renew the record lock before it expires.

◦ If record locking is configured to automatically unlock the record after a save, the record will be
automatically unlocked after the lock holder saves the record. The record holder can then
either leave the record or re-lock the record to continue editing.

◦ If record locking is not configured to automatically unlock the record after a save, the lock
holder can manually unlock the record:
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◦ By clicking the Locked By You button on the toolbar.

◦ Using the Record Locking Manager in the CSM Desktop Client.

◦ If the lock holder does not manually unlock the record, the record will be automatically
unlocked when:

◦ The lock expires (if configured).

◦ The lock holder logs out of her session (if configured).

Tip: A system administrator can manage (view/unlock) Global locks (all locked records
for all Users) using the Record Locking Manager in CSM Administrator (CSM
Admin>Settings>Global Lock Manager).
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Manually Unlock a Locked Record
Use the Locked By You button on the CSM toolbar (Desktop Client and Browser Client) to manually
unlock a locked record.

Good to know:

• Some systems are configured to automatically unlock a record: 1) When the lock holder saves an
edit, 2) when the lock holder logs out of his session, or 3) after a configured expiration.

To manually unlock a locked record:

1. On the CSM Desktop Client toolbar or CSM Browser Client toolbar, click the Locked By You button.

Tip: You can also click Edit>Locked By You from the CSM Desktop Client menu bar.

CSM unlocks the record.

To the lock holder (User who locked the record):

◦ The Record Locking button toggles to the Unlocked button so that the User can manually re-
lock the record, if needed).

To any User who was viewing the locked record:

◦ The Record Locking button toggles to the Unlocked button.

◦ If the record was edited by the lock holder, any Users viewing a locked record are given the
option to reload the record if saved edits are detected.

Note: In the Desktop Client, change notifications (reload and merge) can be
configured to be automatic or optional upon an attempt to edit. In the Browser client,
automatic notifications are not available, so Users are given the option to reload and
merge only if they attempt to edit a locked record.

◦ The locked record becomes editable again (enforced record locking only).
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Managing Record Locking
Locked records are managed using the Record Locking Manager.

• Users can manage (view or unlock) all records they lock using the Record Locking Manager in the
CSM Desktop Client (Edit>User Locks).

• A system administrator can manage (view or unlock) Global locks (all locked records for all Users)
using the Record Locking Manager in CSM Administrator (CSM Admin>Settings>Global Lock
Manager).

Note: When on a record, a lock-holder can use the Record Locking button on the CSM
Desktop Client toolbar or CSM Browser Client menu bar to manually lock or unlock the
record.
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Use the Record Locking Manager
Use the Locked Record Manager to:

• View a list of locked records (as a Grid): Shows where the record was locked (example Desktop
Client), who locked the record (record holder), what time the record was locked, and when the lock
will expire (if configured).

• Filter locked records: Filter the list by selecting a CSM Application (example: Desktop Client,
Browser Client, etc.), Locked By (Global Locks only), and/or Lock Type (example: Major Objects).
Clear the filter by clicking Reset Filter.

• Sort the list by clicking the Sorting arrows.

• Unlock all or selected locked records.

• Refresh the list.

• Export or print the Grid list.

To open the User Locks Record Locking Manager (CSM Desktop Client):

• From the CSM Desktop Client menu bar, click Edit>User Locks.

To open the Global Locks Record Locking Manager (CSM Administrator):

• In the CSM Administrator main window, click the Settings category, and then click the Global Lock
Manager task.

When the Record Locking Manager is opened in CSM Administrator, it displays Global locks (all locked
records for all Users). When the Record Locking Manager is opened from the CSM Desktop Client, it
displays User locks (all locked records for the logged-in User).

Note: The Record Locking Manager is not available in the CSM Browser Client or CSM Portal.
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View and Manually Unlock All User Locks
Users can manage (view/unlock) all records they lock using the Record Locking Manager in the CSM
Desktop Client (Edit>User Locks).

To view all User locks:

1. From the CSM Desktop Client menu bar, click Edit>User Locks.

The Record Locking Manager opens, displaying a Results Grid of all records locked by you
(CurrentUser).

2. Then:
◦ Filter the Grid list (by selecting an Application and Lock Type).

◦ Sort the Grid list by clicking the Sorting arrows.

◦ Refresh the Grid list by clicking the Refresh button.

◦ Print an export the Grid by right-clicking in the window.

3. Click Close to close the Manager.

To unlock all User locks:

1. From the CSM Desktop Client menu bar, click Edit>User Locks.

The Record Locking Manager opens, displaying a Results Grid all records locked by you
(CurrentUser).

2. Click the Select All button to select all records.

3. Click the Unlock Selected Records button.

4. Click Close to close the Manager.
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View and Manually Unlock All Global Locks
A system administrator can manage (view/unlock) Global locks (all locked records for all Users) using the
Record Locking Manager in CSM Administrator (CSM Admin>Settings>Global Lock Manager).

To view all Global locks:

1. In the CSM Administrator main window, click the Settings category, and then click the Global Lock
Manager task.

2. Then:
◦ Filter the Grid list (by selecting an Application and Lock Type).

◦ Sort the Grid list by clicking the Sorting arrows.

◦ Refresh the Grid list by clicking the Refresh button.

◦ Print an export the Grid by right-clicking in the window.

To manually unlock all Global locks:

1. In the CSM Administrator main window, click the Settings category, and then click the Global Lock
Manager task.

2. Click Select All to select all records.

3. Click Unlock Selected Records.
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Configuring Record Locking
Complete the following procedures to configure record locking. All configuration procedures are
completed in CSM Administrator.

To configure record locking:

1. Configure record locking security rights.

2. Enable record locking: Record locking is enabled by default for first-time installations.

3. Configure global Record Locking settings: Configure global record locking settings (default settings
for all Business Objects).

4. Define Record Locking settings for a specific Business Object: Define record locking settings on a
per Business Object basis (these override the Global record locking settings on a per Business
Object basis).
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Enable Record Locking
Record locking is enabled by default in the CSM starter database. Use the Locking page in the System
Settings window in CSM Administrator to enable record locking.

To enable record locking:

1. In the CSM Administrator main window, click the Settings category, and then click the Edit System
Settings task.

2. Click the Locking page.

3. Select the Enable Record Locking check box.

4. Click OK.
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Troubleshooting Record Locking
If the CSM Desktop Client stops responding, manually release record locks using the Record Locking
Manager or wait until the system automatically releases the license based on defined inactivity settings
(configured under CSM Administrator>Security>Licensing>If Client Stops Responding,Auto-
Release License and/or CSM Administrator>Security>Edit Security Settings>Desktop
Client>Logout inactive Users from Cherwell Client). Browser and Mobile Clients automatically log out
Users/Customers after a period of inactivity based on Browser application settings and IIS configuration.
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Reporting
A Report is an aggregation of CSM data that meets defined criteria presented in an exportable, paginated
format.

While other CSM tools, such as Dashboards and Widgets, display real-time data convenient for
immediate use, Reports are used to format and export large amounts of data in the system at a particular
point in time. Some of the criteria used to select data can be entered each time a Report is run. This
allows a Report to be reused to generate data for different time intervals. Reports can also be scheduled
to automatically run at specific times.
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About Reporting
Reports are created using the Cherwell Report Writer™, which is available through the Report Wizard.

Reports are modified using the Report Designer, and typically run through the Report Manager.

Reports can also be run using a command-driven widget on a dashboard or using a One-Step Action.

Report examples include:

• My open Incidents by category

• Past month Incidents by priority

• Past year service trends

The following report shows the duration of Incidents occurring over the past year, sorted by priority, and
displayed in descending order as color-coded alert bars.
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Report Alternatives
In addition to Reports, CSM provides a variety of tools to help summarize data and analyze metrics.
These tools include:

1. Dashboards/Widgets: Dashboards can display summary information through data-driven Widgets
(such as Chart, Gauge, and Matrix Widgets).

a. See Dashboards for more information on creating and using Dashboards.

b. See Dashboard Drill-Down for more information on accessing the information displayed in
specific Widgets, and Using Grids for information on printing and exporting this data.

2. Search Groups: Saved Searches can be used to locate one or more records that meet specific
criteria.

a. See Using Grids for information on sorting, filtering, and grouping the results, as well as
printing and exporting this data.

3. Visualizations: Visualizations can be used to view, print, or export the relationships between
Configuration Items (CIs), personnel, and other related records.

4. Exported Grids: You can export Grids that contain various types of data to multiple formats, such
as .csv and Excel.
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Reporting Good to Know
• After a Report is open in the Preview window, Users cannot navigate back to the CSM Main window

without first closing the Preview window. It is recommended that you have two (2) instances of CSM
open (example: opening CSM again) to easily jump between the Report Preview and CSM.

• Dashboards can provide summary information in the form of data-driven Widgets, and can also run
Reports in the form of command-driven Widgets.

• Some CSM features may behave differently in the CSM Browser Client. For more information, see
Browser Client documentation.
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Tour the Report Suite
There are three main tools used in the Reporting process:

1. The Report Wizard helps you build new Reports using data from Cherwell Report Writer, SQL
Reporting Services, or Crystal Reports.

2. The Report Designer allows you to determine the contents and appearance of Reports.

3. The Report Preview window displays a preview of a Report after it has been created; from here, you
can print or export a Report for distribution.

In addition, the Report Runner allows a User to use the Report Manager to design and run Reports
without a full CSM license.

These tools are accessed through the Report Manager.

Related concepts
Report Alternatives
Creating Reports
Designing Reports
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Report Wizard
The Cherwell Report Wizard walks you through creating a new Report using the Cherwell Report Writer,
which is designed to use existing Cherwell Saved Searches. The Report Wizard allows you to quickly
build a report that you can later modify using the Report Designer.

The Report Wizard also allows you to create references to external reports.

To open the Report Wizard:

1. Open the Report Manager.

2. Click the Create New button.

The Report Wizard opens.

For more information, see Creating a New Report Using the Report Wizard.
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Report Designer
The Report Designer allows you to configure the appearance, layout, and format of Reports after you use
the Cherwell Report Wizard.

In the Report Designer, bands organize groups of data Controls. Each Control represents an area of the
Report that will be populated with data when the Report is run. From here, you can modify many details of
the control, from font attributes, to colors, to data limitations.

Note: When the Report Designer is open, you cannot work in the CSM Desktop Client unless a
second instance of CSM is open. To open a new CSM Desktop Client instance, on the main
menu, select File>New Window. This will allow you to look at Cherwell data while you are
designing your Report.
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1. Menu bar

2. Action toolbar

3. Format toolbar

4. Layout toolbar

5. Zoom toolbar

6. Control toolbar

7. View toolbar

8. Main pane
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9. Explorer pane and Field List panes

10. Property Grid

11. Group and Sort pane
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Report Bands
The Report Designer uses bands to organize information.

There are different types of bands in the Report Designer.

1. Page Header Band (Top Margin)

Defines text that is printed at the top of each page. This includes page header text and page
numbers (if included in the header) defined on the Report Title, Header, and Footer page of the
Report Wizard.

2. Report Title Band
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Defines the title of a Report. If a chart was added using the Report Wizard, the chart is also included
in this band so that it prints once at the beginning of the Report. However, a chart can also go on
other bands, depending on where they need to be printed in the Report.

3. Column Header Band
Holds the column headings for the rows of data that are displayed in the Report.

Tip: If you delete the Column Header band and want to add it later, use a Page Header
band.

4. Group Header Band

Used to group results by Fields. If the Report is grouped by multiple Fields in the Report Wizard, the
Report will have multiple group header bands.

5. Detail Band

Holds the rows of data that will be output for the Report.

6. Detail Report Band

Used within Reports to show data for related Business Objects. For more information, refer to
Adding Relationships to Reports Using Detail Report Bands.

7. Group Footer Band

Ends the band when a Report is grouped by a particular Field.

8. Page Footer Band (Bottom Margin)

The Page Footer band is printed at the bottom of each page of the Report. This includes page footer
text and page numbers (if included in the footer) defined on the Report Title, Header, and Footer
page of the Report Wizard.
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Report Runner
The Report Runner is a stand-alone tool that allows Users to use the Report Manager, Report Wizard,
and Report Designer without consuming a CSM license.

The Report Runner requires a login, but can be installed without installing the full CSM Desktop Client.
This allows Users who have no need to enter information into CSM to work with Reports.

To open the Cherwell Report Runner:

1. In Program Files, go to Cherwell Service Management>Tools>Report Runner.
2. Select the database to use to run Reports.

3. Log in to the Cherwell Report Writer.

The Report Manager opens.
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Creating Reports
You can use the Report Wizard to create Reports in two primary ways:

• Create a New Report

• Link an External Report to CSM
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Opening the Report Wizard
The Cherwell Report Wizard helps you quickly and easily create a new Report using Cherwell Report
Writer.

You can use the Report Wizard to link a Report created using an external tool, such as SQL Reporting
Services or Crystal Reports, to CSM. Creating a link to an external Report enables the Report to be run
from a Dashboard/Widget, a One-Step™ Action, or the Reports Manager.

You can modify a CSM Report created in the Wizard at any time using the Report Designer. Reports
created using external tools must be edited with those tools; however, as long as they remain in the same
location, they do not require further maintenance in CSM.

To open the Report Wizard:

1. Open the Report Manager.

2. Select a scope folder or subfolder from the Manager Tree.

3. Select a Business Object association, if applicable.3.

4. Select the Create New button.
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Creating a New Report Using the Report Wizard
You can use the Cherwell Report Wizard to creating a new Report step by step using the Cherwell Report
Writer. You can modify a Report created using the Wizard at any time using the Report Designer.

To create a new Report:

1. Open the Report Wizard.

2. Select a Reporting tool: Select Cherwell Report Writer to create a new CSM Report.

3. Select a Business Object and Saved Search: Define the data set to use.

4. Select Fields for the Report: Select the specific information Fields to display (example: Incident
Category, Priority, Status).

5. Create calculated Fields (optional): Add custom Fields using string manipulation, math calculations,
and date/time functions.

6. Select the Fields to sort the Report: Specify one or more Fields (including calculated Fields) to
determine how the data will be sorted.

7. Set up the Fields to group the Report data: Specify one or more Fields to use to group data
(example: Group by Incident Subcategory).

8. Pick a date/time format for grouping Fields: Define the display format (DD/MM/YY, MM/DD/YY, etc.)
for Fields grouped using a date/time Field.

9. Define the Report title, set up page headers and footers, and select a chart (the chart is optional).

10. If you select a chart, define the chart characteristics.

11. Click Finish to run the Report and open the Report Designer.
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Select a Reporting Tool in the Report Wizard
The Select Reporting Tool page of the Report Wizard) allows you to:

• Create a new Report using the Cherwell Report Writer.

• Link to an existing Report created using SQL Reporting Services, Crystal Reports, or another tool.

To define the Reporting Tool:

1. Select one of the following tools:
◦ Cherwell Report Writer:

Create a new Report using CSM’s built-in Report Writer, designed to use existing CSM Saved
Searches and Calculated Fields. The Report Writer uses the Report Designer interface and
does not require writing any Crystal or SQL statements.

◦ SQL Reporting Services:

Create a link in CSM to an existing report created using SQL Reporting Services.

◦ Crystal Reports:

Create a link in CSM to an existing report created using Crystal Reports.

◦ Other:

Create a link in CSM to an existing report created using a reporting tool not listed.

2. Click Next to open the Business Object and Saved Search page if you have selected Cherwell
Report Writer, or the Report Location page if you have selected SQL Reporting Services, Crystal
Reports, or Other.

CSM 2022.3 Features 1327

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=specify_report_location


Select a Business Object and Saved Search in the
Report Wizard

The Business Object and Saved Search page of the Report Wizard allows you to select the Business
Object (example: Incident) and Saved Search (example: My Open Incidents) to use as a data set for the
Report.

You can select only one Business Object and Saved Search per Report. You can change the Saved
Search used by the Report later, but you cannot change the associated Business Object. For more
information, refer to Editing Report Properties.

You can add data from any Business Objects related to this primary Business Object to the Report. For
example, a Report on Incident Business Objects can also contain the data from the Journal Business
Objects associated with each Incident. More information on Related Business Objects is provided in the
next step of the Wizard, Select Fields for the Report in the Report Wizard.

To set the Business Object and Data for the Report:

1. Select a Business Object from the Business Object drop-down menu.

2. Select a method of retrieving data for the selected Business Object:
◦ Saved Search (recommended): Pulls only the Business Object records that fit a defined

search. For example, if the system contains all Incidents that have occurred in the last three
years, but you only want to report on Incidents that are currently open, you can select the
Open Incidents Saved Search. See About Saved Searches for more information.

◦ All records (not recommended): Pulls all records of the Business Object from the database.
This option becomes increasingly resource intensive as the selected database grows, resulting
in large sets of Report data that take extensive time to process.

3. Click Next to open the Select Fields for Report page.
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Select Fields for the Report in the Report Wizard
The Select Fields for Report page of the Report Wizard enables you to select display Fields for the
Report. The Fields list shows the Business Object selected for the Report, as well as all of its related
Business Objects.

Fields from Business Objects related to the main Business Object (example: Journal Fields related to
Incident) are added to a Detail Report band.

To select Fields to display in your Report:

1. Locate the Field you want to display in the Report in the Fields list.

2. Double-click the Field or use the Move Right arrow to add it to the Selected Fields list.

Note: You must select at least one Field, but to prevent columns from overlapping, do not
select more than seven fields.

3. Click the Up/Down arrows to change the order in which the Fields are displayed.

4. Click Next to open the Create Calculated Fields for Reports page.
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Create Calculated Fields for Reports in the Report
Wizard

The Create Calculated Fields for Reports page in the Report Wizard allows you to optionally add
existing or create new Calculated Fields to include in the Report.

Use Calculated Fields to calculate values based on the data in each row. You can perform string
manipulation, math calculations, and Date/Time functions that use Calendars, such as your company’s
Business Hours.

Note: There are multiple options for using Calculated Fields with Reports. For more information,
see Defining Calculated Fields for a Report .

To add a Calculated Field available only in this Report:

1. Click Add.

2. Specify a Name for the Calculated Field. Note that names cannot contain spaces.

3. Select the Business Object to associate with the Calculated Field.

4. From the Data Type drop-down list, select one of the four data types recognized by the Report
Designer:

◦ Date/Time:

A Date/Time data type allows you to build an Expression to perform date/time calculations
(example: Calculate a fifteen minute warning for an SLA).

◦ Logical:

A Logical data type allows you to build an Expression to use one or more conditions to return a
true or false value (example: Incident.Status does not equal Closed).

◦ Number:

A Number data type allows you to build an Expression to perform mathematical calculations
using a string of Fields and mathematical symbols (example: Calculate the total cost of a
Labor Cost Item by multiplying the work hours by the monetary rate).

◦ Text:

A Text data type allows you to build an Expression to display a string of Tokens and text
(example: Return either "Open" or "Closed," depending on the status of a record).

5. Select the Expression:
◦ Stored Expression:

Click the Ellipses button to select an existing Cherwell Expression. See Expressions for more
on Expressions.
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◦ Custom Expression:
Click the Expression button to create a custom Expression. For more information, see the
Define Expression topic for the Data Type selected:

◦ Date/Time

◦ Logical

◦ Number

◦ Text

Example
To add a Custom Expression:

1. Click the Expression button.

2. Select the Incidents Closed On1st Call Field in the drop-down arrow  (Incident
Fields>Statistics>Closed on 1st Call).

3. When the Field is in place, right-click the Field.

4. In the drop-down, click Modifiers.
The Modify/Format Value window opens.

5. Select Format for the Modifier.

6. Specify Yes as the value to display when the logical Field is true.

7. Specify No as the value to display for false.

8. Select OK.8.
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Select Sort Fields in the Report Wizard
The Select Sort Fields page of the Report Wizard allows you to specify Fields to use to sort and display
Report data. You can select any Field related to the primary Business Object for the Report.

To select sort Fields:

1. Locate the Field you want to sort Report rows by in the Fields list.

2. Double-click the Field or use the Move Right arrow to add it to the Sort Fields list.

3. Use the arrows to add, remove, and reorder Fields.

The example above will display Incidents sorted first by Incident ID, then Priority, then Status.

Tip: To display results in order of Incident ID, select CreatedDateTime as the sort Field.
Because IncidentID is a text Field, the sort order does not display as expected (1, 2, 3, etc).
Instead, results are ordered as follows: 1, 11, 111, 2, etc. Because records are created in
ascending order, CreatedDateTime will display results in the expected order.

4. Select the Show Bookmarks box to display a list of Field values in the Document Map of the
Report Designer so that a User can click on a value to jump to that group of the Report.

5. Click Next to open the Set up Report Grouping page.
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Set up Report Grouping in the Report Wizard
The Set up Report Grouping page of the Report Wizard allows you select Fields to use to Group data
rows. Each Group you add also adds a Group Header and Footer.

The Group Header is used to label the data included in the Group (example: Subcategory).

By default, the Group Footer includes a Count of the total number of matching records in the Group
(example: Two Incidents listed in the Subcategory). You can use standard and custom metrics to
customize this Field (example: Configure this Field to show the Average value of the Group).

To select Fields to use to Group data:

1. Locate the Field you want to Group Report rows by in the Fields list.

2. Double-click the Field or use the Move Right arrow  to add it to the Group Fields list.

3. Use the arrows to add, remove, and reorder Group Fields.

4. Click Next.

If you use a Date/Time field to group Report data, the Pick a Date/Time Format for Grouping Fields
page opens. Otherwise, the Set Report Title, Header, and Footer page opens.
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Pick a Date/Time Format for Grouping Fields in the
Report Wizard

If you use a Date/Time field to group Report data, use the Pick a Date/Time Format for Grouping Fields
page (accessed from within the Report Wizard) to group results by a specific time period. Example:
Organize the number of incoming Incidents by the day of the week so you can adjust staffing needs
based on the incoming rate.

To select a date/time format for the Field grouping:

1. Select a Date/Time Field to group the Report by on the Set up Report Grouping page.

2. Select the Apply Format to [Grouped Field] check box, and then select a format radio button:
◦ Group by Date

◦ Group by Year

◦ Group by Month

◦ Group by Day of Week

◦ Group by Hour of the Day

◦ Group by Hour and Minute

3. Click Next to open the Set Report Title, Header, and Footer page.

CSM 2022.3 Features 1334

CSM 2022.3 Features



Set Report Title, Header, and Footer in the Report
Wizard

The Set Report Title, Header, and Footer page of the Report Wizard allows you to define the Report title
and how page Header/Footer bands appear on the Report. You can also select a Report Style and
(optionally) a Chart.

To set the Report title, page header, and page footer:

1. Specify the Report title used to identify the Report in the Report Manager and appear at the top of
the Report.

2. Specify the Report Style that defines the colors, lines, and alignment used in the Report. For more
information, see About Report Styles.

3. (Optional) Select a Chart. By default, the chart is added to the Report title band, but you can move
and modify the chart later in the Report Designer. For more information, see Modifying Charts in the
Report Designer.

4. Select the Page Number check box to add page numbers to the Report.
◦ Set the Location: Top, Middle, Bottom.

◦ Set the Position: Left, Centered, Right.

5. Select the Page Header check box to add a header to each page of the Report.
◦ Specify the header Text.
◦ Set the Position: Left, Centered, Right.

6. Select the Page Footer check box to add a footer to each page of the Report.
◦ Specify the footer Text.
◦ Set the Position: Left, Centered, Right.

7. If you selected a Chart, click Next to go to the Add a Chart to the Report page.

8. If no Chart is included, click Finish.
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Add a Chart to the Report in the Report Wizard
The Add a Chart to the Report page in Report Wizard allows you to create a chart for the Report if you
selected a chart to include on the Set Report Title, Header, and Footer page.

To add a chart to the Report:

1. Select a Chart Type.

2. Specify the chart Title.

3. Specify the X-axis Title.

4. Select the X-axis Field. This is the Business Object Field that will be displayed along the X-axis.

5. Specify the Y-axis Title
6. Select the Y-axis Field. This is the Business Object Field that will be displayed along the Y-axis

Note: The values available for the Y-axis depend upon the argument for the X-axis. Some Y-
axis values are limited to values related to the X-axis argument selected so that the chart will
show meaningful data.

7. Click Finish to run the Report and open the Report Designer.

For information about modifying or adding charts to your Report after you run the Report Wizard, refer to
Working with Charts in Reports .
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Link an External Report to CSM Using the Report
Wizard

You can use the Report Wizard to link a Report created using an external tool, such as SQL Reporting
Services or Crystal Reports, to CSM. This enables the Report to be run from a Dashboard/Widget, a One-
Step, or the Reports Manager. Reports created using external tools must be edited with those tools;
however, as long as they remain in the same location, they do not require further maintenance in CSM.

Important: You must have SQL-level permissions to connection to the Crystal/SQL Database
before you can link to an external Report in CSM. CSM creates a shell with Fields and saves the
file so that it can be accessed through Crystal Reports/SQL Reporting Services, where the report
service pulls the data in and can be designed from Crystal/SQL designer.

To link to an external Report:

1. Open the Report Wizard.

2. Click Next.
3. Complete the following Report Wizard steps:

a. Select a Reporting tool: Select among Crystal Reports, SQL Reports, or Other to link to an
external Report.

b. Specify a Report Location: Select the location of the external Report and define a name and
description to use in Cherwell.

c. Click Finish to run the Report.
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Specify a Report Location in the Report Wizard
The Specify Location page of the Report Wizard allows you to link an external report to CSM by
specifying its location and giving it a name and description to use inside CSM. This step is omitted when
you are creating a new Report using the Cherwell Report Writer.

To specify the location of an external Report:

1. Provide a name and description for the Report.

2. Manually enter or browse to the location of the Report. Include the server name in the file path to
ensure the report can be accessed by all Users.

3. Click Finish to save the reference to the Report in CSM. Modify the Report as needed using the
tools selected.
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Report on Groups with Relationships with
Themselves

Produce a report showing self-relationship data (where a Business Object has a relationship with itself)
between Group Objects and Group Leader Objects. For example, a report showing data for a
Configuration Item (CI) for Software License which has a relationship with another CI for Computer.

This example uses CMDB Group Objects but you can use this method for reporting on any Group
Business Objects that have upstream or downstream relationships with themselves.

Prerequisite: An existing report with the association of Config - Software License.

To report on groups that have self-relationship data:

1. Log in to the Desktop Client.
2. Select Tools > Reports > Report Manager.
3. Change the Association to Config - Software License.
4. Edit the report you created earlier with the association of Config - Software License.

The Report Designer opens.

5. In the Report Explorer tab area, right-click Detail_Band > Insert Detail Report and select from
any of the following options to include as a Detail Report:

◦ Join Via CI links Upstream CIs
◦ Join Via CI links Downstream CIs
◦ Join Via Configuration Item Group Links Configuration Item Group
◦ Join Via Configuration Item Links Configuration Items

Important: The options shown, when inserting a Detail Report, will differ depending on the
Business Object and its relationships or associations.
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6. From the Field List, expand the relationship you used for the Detail Report.
7. Drag fields relevant to the relationship to your Detail Report band, and then format the fields.

8. Select Save.
9. Close the Report Designer.
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10. Run the report.
Data from the related objects is included in the report.

Related concepts
Adding Relationships to Reports Using Detail Report Bands
Formatting a Field
CMDB Reports
Create/Edit a Relationship
Convert to a Group Business Object
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Designing Reports
At any point, you can use the Report Designer to modify the appearance or content of a Report.

To open the Report designer:

1. Open the Report Manager.

2. Right-click the Report you want to modify, and then select Design Report.
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Opening the Report Designer
The Report Designer can be opened several ways:

• When you create a new Report from the Report Wizard, the Report Designer automatically opens.

• To modify an existing Report, from the Report Manager, right-click the Report, and then select
Design Report.
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Working with Bands in Reports
You can add and remove items in the bands to modify the content of a Report.

A selected band is highlighted in blue; unselected bands are gray in the Report Designer.

When a band is selected, you can:

• Reorder bands

Right-click a band and select Move Up or Move Down from the context menu.

• Resize a band

Hold your mouse cursor at the edge of the band until the sizing handles (vertical arrow) appear.
Click and drag the band to resize it.

• Modify the band appearance, behavior, data, design, and layout properties

Use the Properties Grid in the right pane. If this pane has been closed, right-click the band and
select Properties to reopen it.

• Perform tasks for a band

A smart tag  appears on the top border. Click the arrow to open a menu of tasks available for the
band.
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Adding Fields to a Report
A Field in a Report is a data item obtained from the Business Object selected when the Report is created.
Fields can come from the original Business Object, a related Business Object, or be calculated from
Business Object data.

You can add Fields to all Report bands and are represented by the Field icon ( ) in the upper right
corner.

Note: If you add a Field to the Report Header, it will show the value of that field for the first record
found in the data set.

To add Fields to a band in the Report Designer:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Locate the band for which you would like to add a Field.

3. Resize or drag the existing Fields to create space for the new Field.

4. From the Field List, locate the Business Object related to the Report, then expand the list of Fields.

5. Drag a Field from the Field List to the band. You can select Fields from the primary Business
Object and from its defined Relationships.

Note: If you select a Field unrelated to the Business Object, the data results will be empty.

Alternatively, you can drag a new Field on top of an existing Field; this will replace the Field's
contents while retaining the formatting of the original Field.

6. Click the smart tag  to view and edit the Field's properties. Properties include:

Property Description

Text

Holds label display text for Fields not bound to Data Fields. For example, the
Report Wizard creates labels for the Column band. Use the Text box to modify
these labels.

When used in a Header or Footer band, enter the text label you want to appear
in the Report Output. For Fields in Detail bands, leave this Field blank to
populate it with Report data.

Data Binding Associates a CSM data Field to the label.

Format String
Click the ellipsis to access the Format String Editor. From here, you can select
a uniform format for all data in the Field to be displayed. Choose Date/Time,
Number, Percent, Currency, Special, or General.

CSM 2022.3 Features 1345

CSM 2022.3 Features



Property Description

Summary
Running

Click the ellipsis to access the Summary Editor and add calculations, such as
counts, to your Report. For more information, refer to Adding a count to a
Report Group.

Angle Specifies an angle to rotate text to; this allows labels to be displayed diagonally,
which occupies less horizontal space bu more vertical space.

Formatting
Rules

Select this option to open the Formatting Rules Editor. From here, you can
change the appearance of result rows based on their contents. For example,
formatting rules can be used to hide the band under certain conditions.

Auto Width Enables automatic resizing of the Field depending on the contents of the Report
Details.

Can Grow Allows the Field to take up more space when output is generated, if necessary
due to data length.

Can Shrink Allows the Field to take up less space when output is generated, if possible due
to data length.

Multiline Allows Field to use more than one line.

Word Wrap Allows Field to continue to a new line without manually inserting a line break.

Tip: For more information, refer to Formatting a Field.
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Formatting a Field
The Report Wizard automatically adds labels to bands based on selections you make when you create
your Report. To modify these labels or add labels to new bands, use the Report Designer.

To add labels to Report bands:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select a band.

3. From the Field List, drag one or more Fields to the band. For more information, refer to Adding
Fields to a Report .

4. Click the smart tag  at the top right corner of a Field.

5. From the Label Tasks window, select options to format your label. For example:
◦ Click the ellipses to the right of the Format String box, select the General tab, and then add a

Prefix for the Field. Example: add Category: to clearly indicate the Field's purpose.

◦ Change the angle to display the label vertically rather than horizontally.

◦ Select the Summary Running box, and then add a calculation for the Field. Be sure to select
an option that matches the band you add a summary to. For example, if you add a Summary
for a Group Header, select the Group option, and then select Running Summary from the
Summary Function list. This ensures that the calculation applies to the selected band.
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Changing Styles for Bands
When the Cherwell Report Wizard creates a Report, it automatically sets the style for each Report band. If
you add additional bands to your Report in the Report Designer, you need to set their style by line.

To change the style settings of a Report in the Report Designer:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. In the Property Grid drop-down, select the band whose style needs to change.

3. Change the Style to the appropriate band type.
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The Detail Band has Even Style, Odd Style, and Style. If your style is set to have a different look for
even/odd rows, the EvenRowStyle and OddRowStyle is used. Otherwise, the RowDataStyle is used.

4. Click a row to open the drop-down menu to change the style.

For example, to change the Foreground Color, click the row, and then select a color in the drop-
down.

Changes in style in the Report Designer are made automatically upon selection, and you can see the
results as you make changes.
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Adding Relationships to Reports Using Detail
Report Bands

A Detail Report band is used within a Report to show data for related Business Objects. For example, if
you are creating a Report of recent Incidents, you can add a Detail Report band to show information on
the Task associated with the Incidents in the Report.

To add a Detail Report band to a Report:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Right-click in any white space in the Report.

3. Hover the cursor over Insert Detail Report.
4. Select the Relationship to include as a Detail Report.

5. From the Field List, expand the Relationship you used for the Detail Report.

6. Drag Fields relevant to the Relationship to your Detail Report band, and then format the Fields. For
more information, see Formatting a Field.

7. Select View>Preview and review your changes. This example shows a Task owned by the Incident.
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Changing the Visibility of a Band in a Report
A Report band can be set to visible or invisible. Invisible bands will not be printed or exported to output.

For example, you can make a band invisible to temporarily omit data from the Report output without
removing the content from the Designer. This is useful if you have not finished refining the contents of a
band but still want to generate a Report, or if a band is temporarily irrelevant to Report recipients.

To change the visibility of bands:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select the band you want to make visible or invisible.

3. In the Property Grid, locate the Visible property under Behavior in the Property Grid.

4. Select Yes to make the band visible; select No to make it invisible.
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Modifying Page Number Properties
By default, Report page numbering is added to the bottom of each new Report.

The default format is to show the current page number and total number of pages, with pagination starting
at the first page of the Report (Page 1 of n). This is shown as Page {0} of {1}.

You can modify the page numbering properties as needed for your Report. For example, you can:

• Change the information you include in the Page Number area.

• Change the start page number.

• Modify page number format.

To modify Report page number properties:

1. In the Report Manager, right-click a Report, and then select Design Report.

2. Select the Page Number box at the bottom of the Report, and then click the smart tag  at the top
of the box.

3. Use the Page Info Task window to modify:
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Property Description

Page Information

Determines the data that is shown in the Page
Number area.

By default, Current of Total" Page Numbers is
selected. You can choose:

◦ None: Removes page numbering.

◦ Page Number: Show the current page
number only.

◦ Page Number (Roman, Lowercase)

◦ Page Number (Roman, Uppercase)

◦ Current Date and Time: Shows the current
date and time instead of a page number.

◦ User Name: shows the current machine
user instead of a page number.

Note: Depending on your selection, be
sure to also modify the format so it
matches the page information setting.

Start Page Number Determines the page used to start page count.

Format

Changes display properties. By default, Page is
set at the prefix and of {1} is set as the suffix.
Change the properties to match your Page
Information selection.

4. Use the Page Number property grid to modify additional page number settings, such as text
alignment, layout, and more.
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Working with Groups in Reports
The Report Designer uses Groups to organize Report Results. Groups also enable you to summarize
data for each Group.

For example, you can group results by Team ownership to show the number of Incidents owned by each
Team.
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Adding a Group Using the Report Designer
When you add a Group from the Report Wizard, certain elements are automatically added to your Group:

• Header with display labels set

• A Footer with display labels set

• A Count based on each Field you select for grouping (added to the footer)

When you add Groups through the Report Designer, you must manually add these items. You can also
use the Report Designer to modified the Group elements that are automatically added by the Report
Wizard.

The following steps explain how to use the Report Designer to add the elements that are automatically
provided by the Report Wizard.

To add a Group using the Report Designer:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select the band to which you want to add a Group, and then click Add a Group.

3. From the list that opens, click the Field you want to Group results by.

Example: select Incident>Call Source to group Incidents by source.

4. In the Group and Sort pane, select or clear the Show Header and Show Footer check boxes,
depending on your needs.

5. Use the Property Grid settings to format the Group Header band. This property is not shown in the
Report output, but changing it helps organize the Report in the Report Designer.

Example: In the Design area, change the name of the band to Call_Source.
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6. From the Field List in the right pane, select a Field for the group and drag it to the Group Header
band.

Example: Incident>Call_Source.

For more information, refer to Adding Fields to a Report .

7. Add a prefix to the Field. For more information, refer to Formatting a Field.

8. Use the Format toolbar to format the display Field as needed.

Example: change the font and font size.

9. Add a count to the Group, following the steps in Adding a Count to a Report Group.
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Adding a Count to a Report Group
You can use the Report Designer to create Counts for groups of results. For example, you can group
Incidents by Team ownership and then add a Count to calculate the number of Incidents owned per Team.

To add a Count to a Report Group:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select the band to add the Group to, and then click the Add a Group button.

3. From the list of Fields that opens, select the Field you want to Group results by.

Example: Select Owned_by_Team.

4. From the Field List pane, drag the Fields you want to display as labels on to the Group Header
band. Also, add the Field you want to use to count the number of results in the Group.

Example: Drag Owned_by_Team and Incident_ID to the Group Header band.

5. Select the Field you want to use for your Count.

Example: Select Incident_ID.

6. Use the Data area of the Property Grid settings to set the following options:

Option Description

Summary

Expand, and then select:
◦ Running>Group

◦ Function>Count

Text Format String

Select the ellipses to open the Format String
Editor so you can format your label.

Example: Select General, and then provide a
prefix, such as "Total: {0}." Notice the right pane
shows an preview of your label and data.

Ignore null values Select yes to ignore empty values; select no to
include empty values.
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Option Description

Summary Running

Choose to show the summary of results by:
◦ Page:

Shows the count by the number of results
per Report page.

◦ Group:

Shows the count by the number of results
for each Group.

◦ Report:

Shows the count by the number of results in
the entire Report.

◦ None

Hides the count.

Example: Select Group to show the number of
Incidents owned by each Team.

7. Click OK.
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Working with Charts in Reports
You can use the Report Designer to customize properties for the chart’s legend, argument axis (x-axis),
value axis (y-axis), data series, series labels, and diagram area at any time in the Report Designer. You
can also run the Chart Wizard, which allows for complex customization of data and appearance.

Unlike the Report Wizard, the Chart Wizard can be used to modify an existing chart.

Charts provide many options for displaying data in reports. For more information about using charts with
the DevExpress® XtraReports Designer, refer to:

• The DevExpress® Documentation (free).

• The Creating Reports for Summary Analysis course available in the Cherwell Video Learning Library
(subscription-based).

Modifying Charts in the Report Designer
To modify an existing chart:

1. In the Report Manager, right-click a Report, and then select Design Report.

2. To update multiple elements, run the Chart Wizard. Select the chart, select the smart tag , and
then select Run Designer from the Chart Tasks page.

3. To update individual components, select the chart, and then use the Property Grids for each
individual component (legend, axis, labels, diagram).

Adding a New Chart From the Report Designer
You can place charts in any band, but if you place a chart outside of the header or footer band, you must
add a script to switch from one group of data to the next.

To add a new chart:
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1. In the Report Manager, right-click a Report, and then select Design Report.
2. From the control toolbar, drag the Chart icon to the title or footer band.

3. The Chart Wizard opens.

4. Use the Chart Wizard to create a chart. For example:
◦ Select the type of chart to display (bar, line).

◦ Define chart data.

◦ Define chart styling.

◦ Add titles and legends.

Related concepts
Add Scripts to a Report

CSM 2022.3 Features 1360

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Freporting%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Freporting%2Fadd_scripts_to_a_report.html


Add Scripts to a Report
Advanced Users can use the Cherwell Script Wizard to run scripts on a Report for items that are not
included in the Report Designer interface.

There are currently seven scripts available in the Script Wizard:

• Change Field Color Based On Value: This script can be used to set the color of a Field show on
the Detail band, including related Fields. In addition, you can use operators such as Between,
Between Inclusive, Like, and Empty.

• Chart Shown on Detail Report - Limit to Detail Report Data: This script can be used to restrict
the data displayed in a chart on a Detail Report to that of the Detail Report group.

• Chart Shown On Group - Limit to Group Data: This script can be used to restrict the data
displayed in a chart on a Group Header or Footer to that of the Group Header/Footer instead of
using data from the entire Report.

• Drill Down - Hide/Show Detail Report: This script can be used to show or hide the Detail Report
when clicking a particular Field on the Master Report, giving the appearance of drilling down into the
Detail Report from the Master Report.

• Drill Down - Hide/Show Particular Fields: This script can be used to show or hide particular Fields
on the Detail band when clicking the hyperlinked Field. For example, you can initially hide the
Description Field, and then show the Description Field upon clicking Incident_ID.

• (Advanced) Group Summary - Create a Custom Summary: This script can be used to create
three event handlers needed in order to implement custom summary functions.

• Group Summary - Show a Percentage: This script can be used to take the ratio of two Fields from
the Group Summary band and show them as a percentage. For example, if you have Total Incidents
and Incidents Reported by Phone, you can create a third Field that shows Percentage of Incidents
Reported by Phone.

Note: If scripts are disabled for Reports for your CSM system, you may receive an error when you
run a Report that contains a script. See ../../shared/configure_miscellaneous_browser-
portal_settings.xml#D13826.

Adding a Script Using the Script Wizard
Good to know:

• Scripts only show in the Script Wizard if the items they relate to are present in the Report. For
example, chart scripts only become available if there is a chart in the Group Header or Detail Report
band.

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer

2. In the Action toolbar, click the Scripts button.
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The Script Wizard opens.

3. Select a script to add, and then click Next.
4. Define script properties:

a. Change Field Color Based on Value Script.

b. Chart Show on Detail Report - Limit to Detail Report Data Script.

c. Chart Shown on Group - Limit to Group Data Script.

d. Drill Down - Hide/Show Detail Report Script.

e. Drill Down - Hide/Show Particular Fields Script.

f. Group Summary - Show a Percentage Script.

5. Select Finish.5.

Previewing a Script
To preview a Report script:

1. Add the script to the Report.

2. In the View toolbar, click the Preview button to switch the view to Preview.
Results for the applied scripts show in the Report as the User has designed them.

CSM 2022.3 Features 1362

CSM 2022.3 Features



Change Field Color Based on Value Script
The Change Field Color Based on Value script can be used to set the color of a Field show on the Detail
band, including related Fields. For example, you can create a Change Field Color Based on Value script
that changes the Field color to orange so that Incidents with an In Progress status stand out.

Good to know:

• This script is only available for Fields in the Detail Report band. It is not available for Fields in a
Detail Report (example: This script is unavailable for a Detail Report on Journals owned by a
particular Incident; the script can only be run on the Detail band, meaning it can only be run for the
main Incident, not the Incident's Supporting Objects).

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer.

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.
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3. Select the script, and then click Next.

The Change Field Color Based on Value properties window opens.

4. Define the following properties:
a. Band: The band of the Report housing the Field to run the script on (example: Detail_band is

the default Detail band available for this script).

b. Control name: The Field that the script runs on (example: Col4_Status is the Incident Status
field).

Beneath the Control Name drop-down, the Bound Field is described according to the control
selected. For example, if the control is Col4_Status, the bound Field is Incident.Status,
meaning the Status field is the one that the script runs on.

5. Click Add to add a Field to the Values list.

The Colors Based on Field Value window opens.

6. Select an Operator for the Field:
◦ Empty: Finds all instances in the Report where the Field value is empty.

◦ Equals: Finds all instances in the Report where the Field value equals the selected value.

◦ Like: Finds all instances in the Report where the Field value matches the selected value and
its wildcard (example: Jo% finds Joe, John, Jonathan, etc.).

◦ Not empty: Finds all instances in the Report where the Field value is not empty.

◦ Not equal: Finds all instances in the Report where the Field value does not equal the selected
value.

◦ Not like: Finds all instances in the Report where the Field value does not match the selected
value or its wildcards.

7. Define the value (example: "Status" Equals "In Progress").

8. Select a Text color.
9. Select a Background color.

10. Select OK.10.

11. In the Script Wizard, click Finish.
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Chart Shown on Detail Report - Limit to Detail
Report Data Script

The Chart Shown on Detail Report - Limit to Detail Report Data script can be used to restrict the data
displayed in a Chart on a Detail Report to that of the Detail Report group.

Good to know:

• This script is only available for charts located in the Detail Report. Reports without a Detail Report or
a chart in the Detail Report will not have this script as an option in the Script Wizard.

• If there is only one Detail Report present, the band is automatically selected in the Script Wizard.

• If there is only one chart in the Detail Report, the chart is automatically selected in the Script Wizard.
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• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer.

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Chart Shown on Detail Report properties window opens.

4. Define the following properties:
a. Detail Report: The specific Detail Report housing the chart to run the script on (example:

Incident_Owns_Journal_Detail_Report_Band is the Detail Report for Journals linked to
Incidents in the current Report).

b. Band within Detail Report: The specific band within the Detail Report housing the chart to run
the script on (example: Incident_Owns_Journals_Detail_Band2 is the Detail band of the Detail
Report containing the chart).

c. Chart: The chart the script runs on (example: chart 1 is the only available chart in the Detail
Report).

5. Select Finish.5.

A notification window opens informing the User that the script has been added.
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Chart Shown on Group - Limit to Group Data Script
The Chart Shown on Group - Limit to Group Data script can be used to restrict the data displayed in a
chart on a Group Header or Footer to that of the Group instead of using data from the entire Report.

Good to know:

• This script is only available for charts located in the Group Header or Footer bands of the Report.
Reports without a chart in the Group Header or Footer bands do not have this script as an option in
the Script Wizard.

• If there is only one Group Header or Footer, the band is automatically selected in the Script Wizard.

• If there is only one chart in the Group Header or Footer, the chart is automatically selected in the
Script Wizard.

• Added scripts can be viewed in the Scripts tab.
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To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer.

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Chart Show on Group properties window opens.

4. Define the following properties:
a. Band: The band of the Report housing the chart (example:

IncidentDurationInDaysRounded_Group_Header is the Group Header containing the chart).

b. Chart: The chart the script runs on (example: chart2 being the only chart available in the
Group Header band).

5. Select Finish.5.

A notification window opens informing the User that the script has been added.
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Drill Down - Hide/Show Detail Report Script
The Drill Down - Hide/Show Detail Report script can be used to show or hide the Detail Report when
clicking a particular Field on the Master Report, giving the appearance of drilling down into the Detail
Report from that Field. Users can click Fields with hyperlinks to open the Detail Report related to that
Field.

Good to know:
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• This script is only available for Reports that have a Detail Report (a Report featuring linked Major or
Supporting Business Objects) (example: An Incident with Journals Report, Journals being the
Supporting Object).

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer.

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Drill Down - Hide/Show Detail Report properties window opens.

4. Select the Master band (the band that the Field resides in, example: Detail_Band).

5. Select the Hyperlink Field from the drop-down (example: Incident ID).

6. Select the Detail Report to expand when the hyperlinked Field is clicked (if you have more than
one Detail Report).

7. Select Finish.7.

A notification window opens informing the User that the script has been added.
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Drill Down - Hide/Show Particular Fields Script
The Drill Down - Hide/Show Particular Fields script can be used to show or hide particular Fields on the
Detail band when clicking the hyperlinked Field. For example, you can initially hide the Created Date Time
field until you click the Incident Duration in Days field to get an exact time frame for the Incident's
duration.

Good to know:

• This script is only available when there is more than one Field present in the Report.
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• If there are multiple entries in a group (example: Report Fields are grouped by Incident Duration in
Days), clicking the hyperlinked Field to show/hide another Field shows/hides those Fields for the
grouping, not just the one hyperlinked Field (example: Clicking Incident Duration in Days in a
grouping that has three Incidents shows the Created Date Time for all Incidents in that grouping).

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer.

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Drill Down Fields Report script properties window opens.

4. Select the Detail Band (the band that the Field resides in).

5. Select the Hyperlinked Field from the drop-down (example: Incident Duration in Days).

6. Select the Fields to expand when the hyperlinked Field is clicked check boxes (example:
Created Date Time).

Note: Users can click multiple check boxes in this list.

7. Select Finish.7.

A notification window opens informing the User that the script has been added.
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Generating Reports
The following methods can be used to generate Report output:
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Running Reports
Reports can be run from the following locations:

• Run a Report Using the Report Manager

• Run a Report Using Dashboards

• Run a Report Using a One-Step

You can also access a Report you have recently run directly from the Tools>Reports> (Report Name)
menu.

Note: Reports that take over 60 minutes to process will generate an error and fail to complete. In
Reports created using CSM 8.2 and later, Rich Text Fields are omitted, which decreases memory
use and processing time. Rich Text Fields are not normally used in Reports. However, this option
must be manually disabled in Report Properties for Reports created prior to CSM 8.2. For more
information, see Editing Report Properties. Additionally, If a Report is set to return Rich Text
Fields, a warning is logged. These log entries are useful for identifying which Reports have run
with the Retrieve Rich Text Fields option enabled without manually checking the Report
Properties. For information on event logging, see Configure Logging for a CSM Server or Web
Application.
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Run a Report from the Report Manager
To run a Report from the Report Manager in CSM Desktop Client:

1. Open the Report Manager.

2. Select the Report you want to run.

3. Right-click the Report and select one of the following options:
a. Run: Runs the Report and opens the Preview window. Alternatively, double-click the Report.

b. Run Special: Run Special is only available if you open the Report Manager when you have
Saved Search Results or a single record open. You can then:

◦ Run for current record: Run the Report using only the data in the record currently open
in CSM.

◦ Run for current group: Run the Report using only the data in the Saved Search
currently open in CSM.
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Run a Report from a Dashboard
Reports can be run through command-driven widgets (such as the Command Palette or a standard
widget using a link action) located on a dashboard.

To run a report using an existing dashboard:

1. Open a dashboard.
2. Select a Link widget that contains an action that opens a report.

The Report Preview window opens.
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Run a Report from a One-Step
You can create a One-Step Action using the Run a Report Action to run a CSM Report. For example, this
One-Step Action could then be added to an Automation Process to periodically run a Report of all open
Incidents assigned to a specific User.

To define a Run a Report Action for a One-Step Action:

1. Open the One-Step Editor.

2. Add a Run a Report Action to the Designer Board.

3. Define properties for the Run a Report Action as follows:
a. Name: Provide a display name for the Action. This is how the Action will be identified within

CSM.

b. Report: Click the Ellipses button  to open the Report Manager, and then select a Report to
run.

c. Data: In the drop-down, select the data to use for the Report:

Data Source Action

Use Report Criteria
Run the Report exactly as designed
(example: against a particular Search
Group).

Current Record
Run the Report against the active record
(the single record selected in CSM before
running the One-Step Action).
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Data Source Action

Current Group

Run the Report against the current group
of records. For example, run a Quick
Search for all Incidents containing the
word "print," and then execute the One-
Step Action. The search results become
the data for the Report.

4. Select an output option:

Output Output Specific Options
Print

Choose a connected printer from the drop-
down.
Click Settings to open Print Options and
define the number of copies to print and
whether or not to collate them.

Write to File
Enter a filename; click the Selector button

 to insert Tokens (example: Fields,
System Functions, Prompts, Expressions,
Stored Values, Metrics, and Counters)
directly into the filename.

or

Click the Browse button to open the Select
File window and select an existing file.

Note: If an existing filename is entered or
selected, running the One-Step will overwrite
the existing file. If a new file name is entered,
a new file will be created.
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Output Output Specific Options

Select a file format from the Format drop-
down. The following formats are supported:

◦ Adobe PDF

◦ Bitmap

◦ CSV

◦ EMF

◦ Excel

◦ HTML

◦ JPEG

◦ Plain Text

◦ PNG

◦ Rich Text

◦ TIFF

5. Click Save .
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Previewing Reports
Reports open in the Report Preview window when they are run in any of the following ways:

Run a Report Using the Reports Menu

Run a Report Using Dashboards

Run a Report Using a One-Step

From the Report Preview, you can Print a Report, Export a Report, or send a Report by e-mail.
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Printing Reports
There are several ways to print a Report:
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Print a Report from the Report Manager
To print a Report from the Report Manager:

1. Open the Report Manager.

2. Select the Report you want to print.

3. Right-click, and then select Print.
4. Define the device or program to use to print the Report.

Print a Report from Saved Search Results
You can apply a Report to Saved Search results, and then print those results.

To print a Report from Saved Search results:

1. Open the Search Manager.

2. Run a Saved Search.

3. With the results displayed, open the Report Manager.

4. Select a Report, and then right-click.

5. Choose how to print the a Report :
◦ Print for current record: Print the Report using only the data in the record currently selected

or open in CSM.

◦ Print for current group: Print the Report using only the data in the Saved Search currently
open in CSM.
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Print a Report from the Report Preview
To print a Report from the Report Preview window:

1. Open the Report Preview window.

2. Select one of the following options from the File menu or the Preview toolbar:
a. Print...: Opens the Print window, where you can select a printer, number of copies, page

range, and paper source or file path (if printing to a file).

b. Quick Print: Sends the Report directly to the default printer or program.
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Print a Report from a Business Object Record
To print a Report from a Business Object:

1. Open the Business Object record.

2. Click File>Print.

The Print window opens.

3. Select the Printer to use.

Note: Print Options for a Business Object need to be configured in CSM Administrator.

4. Select the Report (example: Memo Style - Incident) you want to print.

5. Specify the number of copies to print.

6. Optionally, select the Run for group check box to run the Report for the Saved Search defined in
the Report rather than limiting it to the single Business Object from which you accessed it.

7. Click OK.
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Exporting Reports
You can export Reports from the Report Manager or the Report Designer.

Reports can be exported to the following file formats:

Report Tool Export Formats

Report Manager

See Export a Report from the Report Manager.

• CED (Cherwell export) - From File menu only.

• CSV

• Excel XML

• HTML

• Images (Bitmap, EMF, JPEG, PNG, TIFF)

• PDF

• RTF

• Text file

• XML

Report Designer (Preview mode)

See Export a Report from the Report Designer

• PDF

• HTML

• MHT

• RTF

• XSL

• XSLX

• CSV

• Text

• Image
◦ BMP

◦ EMF

◦ WMF

◦ GIF

◦ JPEG

◦ TIFF
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Export a Report from the Report Manager
To export a Report as a .CED (Cherwell export) file:

1. Open the Report Manager.

2. Select the Report you want to export.

3. From the File menu, select Export...
4. Enter a File name for the Report.

5. Click Save.

To export a Report from the Report Manager as any other file type (PDF, HTML, MHT, RTF, XLS,
XLSX, CSV, TXT, or Image):

1. Open the Report Manager.

2. Select the Report you want to export.

3. From the Reports menu, select Export To, then select the file type you want to export the Report
as.

4. Enter a File name new for the Report.

5. Click Save.
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Export a Report from the Report Designer
To export a Report from the Report Preview:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Verify that the Report is in Preview mode, and then select Export Document icon on the toolbar.

3. Select an export format.

The Export Options window opens (PDF Export Options are shown below).

4. Define the Export Options for the document.

Note: The Export Options available are different for each exported file type.

5. Click OK.
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Scheduling a Report
Reports can be set to run on a regular, scheduled basis using the Scheduler in the CSM Administrator. To
schedule a Report, you must create a new scheduled item using the Report action.

To schedule a Report:

• See Create a Scheduled Item for information on creating a new scheduled item.

• When you Define Action Properties for a Scheduled Item, select the Report action.

• See Define Report Action Options for more information on defining action options for a scheduled
Report.
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Managing Reports
Reports are created, modified, deleted, and organized in the Report Manager.

Use the Report Manager to complete general CSM Item Manager operations for Reports, including:

• Run a Report

• Create a Report

• Manage Report Styles

• Change or Create Report Styles

• Edit a Report

• Delete a Report

• Search for a Report

• Organize Reports

• Copy a Report

• Import/export a Report

• Find Report dependencies

• Pin a Report.
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Editing Report Properties
Use the Report Manager to edit existing Reports and their properties, including name, description, data
source, and Calculated Fields.

1. Right-click the Report you want to edit in the Report Manager.
2. Select Edit Report Properties.

The Report Properties window opens.
3. Edit the properties as follows:

Option Description

Name Provide a display name to use within CSM.

Description Provide a description to use within CSM.

Retrieve Rich Text Fields Select whether or not to retrieve HTML
subfields with the Report data. Default CSM
Reports do not use the information in these
subfields; disabling this option results in
faster performance.

Data Identify the data source for the Report. For
best results, select a Saved Search. Using a
Saved Search limits Report data to a specific
set of information, resulting in faster
performance and a more precise Report than
using all records. For more information about
Saved Searches, see About Saved
Searches.

Report Culture Select the culture for the Report. In most
cases, this is set to the primary culture for
your system. You can choose a different
culture if Globalization is enabled for your
system and translations are available for the
definitions used by the Report. For more
information, see Using Reports with Multiple
Cultures.

Calculated Fields Create, modify, or delete Calculated Fields
included in the Report. For more information,
refer to Adding Calculated Fields from the
Report Manager.

For more information about Calculated Fields,
see About Saved Searches.
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Open the Report Manager
Open the Report Manager from the CSM Desktop Client, the CSM Browser Client, or CSM Administrator.

There are several ways to open the Report Manager:

• In the CSM Desktop Client menu bar, select Tools > Reports > Report Manager. For more
information, see CSM Desktop Client menu bar.

• In the CSM Browser Client menu bar, select Reports > Report Manager. For more information, see
CSM Browser Client menu bar.

• In the standalone Report Runner outside of CSM. For more information, see Report Runner.

• In the Blueprint or mApp Editor menu bar, in CSMCSM Administrator, select Managers > Reports.
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Report Styles Manager
Use the Report Styles Manager to complete general CSM Item Manager operations for Report Styles.

There are several ways to open the Report Styles Manager:

• In the Report Manager, click Reports>Report Styles from the menu bar.

• While running the Cherwell Report Wizard, on the Set Report Title, Header and Footer page, click

the Ellipses button  to the right of the Report style drop-down menu.
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About Report Styles
A Report Style is use to set fonts, colors, borders, and text alignment for the different areas of a Report
including the title, page header and footer, group header and footer, table column headers, data rows,
Detail Reports, and charts. A Report Style can be defined once, then applied to existing or new Reports to
create a consistent look and feel for a set of individually generated Reports.

An existing Report Style can also be modified once to affect all Reports that use that style. Cherwell
Service Management comes with the following pre-defined Report Styles:

• A Touch of Red

• Black and White

• Blue and Gray

• Blue and Red

• Shades of Blue

• Table - Even and Odd Rows

• Table Style

You can customize these styles and create additional styles using the Report Styles Manager.
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Report Styles Good to Know
• The Style Name is shown at the top of all the Report Style options pages. You can rename the style

on any of these pages.

• The General page opens by default in the Report Styles window.
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Define Report Styles Using the Report Styles
Manager

Use Report Styles to define the following properties:

• General Options: Report Title and Title band font, alignment, color, and lines.

• Page Options: Page Header and Page Footer font, alignment, color, and lines.

• Group Options: Group Header and Group Footer font, alignment, color, and lines.

• Column Headers: Column Header band font, alignment, color, and lines.

• Data Options: Detail band (data row) font, alignment, color, lines, and alternating rows.

• Detail Reports: Group Header and Group Footer font, alignment, color, and lines for Detail Reports
within a Report.

• Charts: Chart font, colors, borders, and legend.

To open the Report Styles properties Window:

1. Open the Report Styles Manager.

2. Select one of the following:
◦ Select File>New to create a new Report Style.

◦ Select a Report Style, right-click, then select Edit to modify an existing Report Style.

The Report Style window opens.
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Modify the Report Style as described in the following sections. You can preview the Report Style at
any time using the View Style, View Master/Detail Style, and View Style with chart buttons in the
lower left.
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Define General Options for Report Styles
Use the General page to define the Report Style name and the font, color, and line rule options for the
Report Title as follows:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click the General page.

3. Enter a Style name (example: Blue and Red). The Style Name is used to identify the Report Style in
the Report Styles Manager.

4. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)

5. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color
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◦ Background color (the color that appears behind the text in the title only)

6. Select the Draw lines check box if you want to add lines around the title:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

7. Click OK to save and close the Report Style, or proceed to Page options.
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Define Page Options for Report Styles
Use the Report Style Page Options page to define the following:

• Page Header: Font, text alignment, color, and lines of the Page Header band.

• Page Footer: Font, text alignment, color, and lines of the Page Footer band.

To define the Page Header and Footer options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Page Options in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)

4. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)
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◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click OK to save and close the Report Style, or proceed to Group Options.
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Define Group Options for Report Styles
Groups are used to organize and display data into sections to make Reports easier to read. Each Group
of data is displayed with a Group Header band and Group Footer band. Use the Report Style Group
Options to define the following:

• Group Header: Font, text alignment, color, and lines of the Group Header band.

• Group Footer: Font, text alignment, color, and lines of the Group Footer band.

To define the Group Header and Footer options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Group Options in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)
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4. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click OK to save and close the Report Style, or proceed to Column Headers.
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Define Column Headers for Report Styles
Use the Column Headers page to define the following:

• Font: Font type, size, and style of the Column Header band of the Report.

• Alignment and Color: Text alignment, color, and background color of the band.

• (Optional) Draw Lines: Add lines to the band.

To define the Column Headers options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a Report Style.

2. Click Column Headers in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)
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4. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click OK to save and close the Report Style, or proceed to Data Options.
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Define Data Options for Report Styles
Use the Data Options page to define the following properties of the data elements displayed in a Report:

• Font: Font type, size, and style of the data rows in the Detail band of the Report.

• Alignment and Color: Text alignment, color, and background color of the band.

• (Optional) Draw Lines: Add lines to the band.

• Use alternating rows: Option for applying different text and color formatting to even and odd rows
within a table.

To define the Data Options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Data Options in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)
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◦ Font style (bold, bold italic, italic, regular)

4. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Select the Use alternating rows check box to alternate data row styles (example: Odd rows have
no color while even rows are blue).

Use this check box to define Alignment, Color, and Line settings for even-numbered rows.

7. Click OK to save and close the Report Style, or proceed to Detail Report Options.
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Define Detail Report Options for Report Styles
Detail Reports are used within Reports to show data for related Business Objects. For example, if you are
creating a Report of recent Incidents, you can add a Detail Report to show information on the Journals
associated with the Incidents in the Report. Use the Detail Report options to define the following.

• Column header font, alignment, color, and lines

• Data font, text alignment, color, and lines of the Group Header band of the Report.

To define the Detail Report options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Group Options in the Report Styles window.

For both the Column Header and Data, define the following:

3. Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)
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◦ Font style (bold, bold italic, italic, regular)

4. Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click View Master/Detail Style to preview an example Report using a Detail Report at any time.

7. Click OK to save and close the Report Style, or proceed to Column Headers.
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Define Chart Options for Report Styles
Use the Charts page to define the following properties of charts used within the Report:

• Font: Font type, size, and style.

• Colors: Text color, background color, and color palette.

• Chart has Border: Border color and width.

• Chart Legend: Font type, size, style, alignment, and text color.

To define the chart properties for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Charts in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)
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◦ Font style (bold, bold italic, italic, regular)

4. Define the Color settings:
◦ Text color

◦ Background color for the chart

◦ Palette: There are many color palette choices in the Palette drop-down menu. When you
select a specific palette, the colors are shown to the right of the drop-down menu.

5. Select the Chart has borders check box to add a border to the chart, then:
◦ Define the Border color.

◦ Define the Border width by specifying a number or clicking the incremental arrows  to
change the border width value.

6. Define the Chart Legend settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 10)

◦ Font style (bold, bold italic, italic, regular)

◦ Legend's vertical and horizontal alignment (middle, bottom, and top right, left, and centered)

◦ Text color

7. Click View Style with chart to preview an example Report containing a chart at any time.

8. Click OK to save and close the Report Style.
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Preview a Report Style From the Report Styles
Manager

You can use the Report Styles Manager to preview a Report Style before applying it to a Report.

To preview a Report Style:

1. Open the Report Styles Manager.

2. Right-click the Report Style you want to preview.

3. Click Edit.
4. Select a way to preview the Report Style from the bottom left of the Report Style window:

a. View Style: preview Style in a sample Report

b. View Master/Detail Style: preview Style in a sample Report including a Detail Report

c. View Style with Chart: preview Style in a sample Report including a Chart
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Apply a Report Style to a Report
Report Styles can be changed for individual Reports in the Report Manager.

To change the Report Style applied to a Report:

1. Open the Report Manager.

2. Right-click a Report.
3. From the context menu, click Change Report Style, then select a style.
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Delete a Report Style
To delete a Report Style using the Report Styles Manager:

1. Open the Report Styles Manager.

2. Select the Report Style you want to delete.

3. Click the Delete icon  on the menu bar, or right-click and select Delete.

4. Click Yes to confirm the deletion, No to cancel, or Find Dependencies to get a list of CSM items
currently using the Report Style.

CSM 2022.3 Features 1415

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=report_styles_manager


Configuring Reports
Complete the following procedures to configure Reports.

To configure Reports:

• Configure Reports security rights: Configure who can access Report functionality.

• Define Print options for a Business Object: Define which printer the Report goes to as well as the
default Report style.

• Define Calculated Fields for Reports: Determine the best option for adding Calculated Fields to a
Report.
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Defining Calculated Fields for a Report
Calculated Fields enable you to calculate values based on the data in each row.

There are multiple ways to create Calculated Fields. After you create a Calculated Field, you can add it to
any band in the Report.

Method Benefits

Using the Report Wizard

Using the Report Manager

• With the Report Wizard, a Calculated Field is
added at Report creation. You can use the
Report Manager to add a Calculated Field
later.

• Uses a new or existing CSM Expression. This
enables you to reference CSM data, such as
Calendars used by Date/Time Expressions.

• The Report engine treats these Fields as
database Fields without having to add a new
Field to the Business Object.

• Calculated data is accurate at the time of
Report Generation.

Using the Report Designer
• Add Calculated Fields to existing Reports.

• Perform mathematical equations that do not
use CSM Expressions.

Adding a pre-defined, stored CSM Field to your
Report.
To do this:

1. Create a Blueprint.

2. Edit the Business Object, and add a Field.

3. Set calculated value on the Field Properties
page.

4. On the Advanced page, clear the Stored in
database and Recalculate after load check
boxes.

• Use the same Calculated Field in multiple
Reports and for other CSM features.

• Calculations on individual records in the Report
are only updated each time a record is saved.

Adding Calculated Fields from the Report Manager
To add a Calculated Field using the Report Manager:

1. Open the Report Manager.

2. Select a Report, right-click, and then select Edit Report Properties.
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3. Click Calculated Fields.

4. Follow these steps:
a. Click Add.

b. Specify a Name for the Calculated Field. Note that names cannot contain spaces.

c. Select the Business Object to associate with the Calculated Field.

d. From the Data Type drop-down list, select one of the four data types recognized by the Report
Designer:

◦ Date/Time:
A Date/Time data type allows you to build an Expression to perform date/time
calculations (example: Calculate a fifteen minute warning for an SLA).

◦ Logical:
A Logical data type allows you to build an Expression to use one or more conditions to
return a true or false value (example: Incident.Status does not equal Closed).

◦ Number:
A Number data type allows you to build an Expression to perform mathematical
calculations using a string of Fields and mathematical symbols (example: Calculate the
total cost of a Labor Cost Item by multiplying the work hours by the monetary rate).

◦ Text:
A Text data type allows you to build an Expression to display a string of Tokens and text
(example: Return either "Open" or "Closed," depending on the status of a record).

e. Select the Expression:
◦ Stored Expression:

Click the Ellipses button to select an existing Cherwell Expression. See Expressions for
more on Expressions.

◦ Custom Expression:
Click the Expression button to create a custom Expression. For more information, see
the Define Expression topic for the Data Type selected:

◦ Date/Time

◦ Logical

◦ Number

◦ Text
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Creating Expressions in the Report Designer
To create expressions for Calculated Fields in the Report Designer:

1. Right-click on the Field List, and then select Add Calculated Field.

2. Select the Calculated Field from the Properties Grid.

3. Click the Ellipses in the Expression box to open the Expression Editor.
4. Use the left column to select a category of available inputs and operations, shown below.

Category Contains

Functions

A list of functions that can be applied to the expression. Select a type (All,
Aggregate, Date-Time, Logical, Math, or String) from the drop down to
limit the functions listed. When using a function, you must supply the
Fields, Parameters, or Constants it requires (example follows).

Operators A list of simple mathematical operands that can be used to manipulate
and compare values.

Fields The Fields (variables) available in the Report, acquired from the Report
Business Object.

Constants True, False, and null values that can be manually added to the
expression that will always stay the same.

Parameters
Variables that represent the values entered by the User when Report is
run. Not present in Reports that do not require Parameters each time they
are run.

5. Select a category, and then select an input from the middle column. A description of the input or
operation appears in the right column. When a function is selected, the values it requires and a
description of what will be returned is displayed.

6. Double-click an input to add it to the expression.

7. Basic operations can also be selected from the bar below the main text box.
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Adding Calculated Fields from the Report Manager
To add a Calculated Field using the Report Manager:

1. Open the Report Manager.

2. Select a Report, right-click, and then select Edit Report Properties.

3. Click Calculated Fields.

4. Follow these steps:
a. Click Add.

b. Specify a Name for the Calculated Field. Note that names cannot contain spaces.

c. Select the Business Object to associate with the Calculated Field.

d. From the Data Type drop-down list, select one of the four data types recognized by the Report
Designer:

◦ Date/Time:

A Date/Time data type allows you to build an Expression to perform date/time
calculations (example: Calculate a fifteen minute warning for an SLA).

◦ Logical:

A Logical data type allows you to build an Expression to use one or more conditions to
return a true or false value (example: Incident.Status does not equal Closed).

◦ Number:

A Number data type allows you to build an Expression to perform mathematical
calculations using a string of Fields and mathematical symbols (example: Calculate the
total cost of a Labor Cost Item by multiplying the work hours by the monetary rate).

◦ Text:

A Text data type allows you to build an Expression to display a string of Tokens and text
(example: Return either "Open" or "Closed," depending on the status of a record).

e. Select the Expression:
◦ Stored Expression:

Click the Ellipses button to select an existing Cherwell Expression. See Expressions for
more on Expressions.

◦ Custom Expression:
Click the Expression button to create a custom Expression. For more information, see
the Define Expression topic for the Data Type selected:

◦ Date/Time

◦ Logical

◦ Number
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◦ Text
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Rich Text
Rich Text is a capability that enables capturing and storing data with embedded images and text
formatting. Formatting capabilities include different fonts, font sizes, styles (bold, italics, underline), and
colors. Some page formatting is also supported, including line spacing and indentation.
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About Rich Text
Use Rich Text in the following areas:

• Large text Fields in Business Object Records (example: Description field in an Incident) and
Journals: Provide and format text and insert images into Fields using Rich Text options in the
Desktop Client, Browser Client, or Portal.

• Knowledge Articles: Create or import Knowledge Articles with embedded screenshots, numbered
lists, and other Rich Text formatting.

• One-Step Actions: Embed Rich Text Fields in One-Step Actions.

• E-mail Messages: Use the E-mail and Event Monitor and Outlook Integration Manager to
automatically import Rich Text from e-mails into Rich Text-enabled Fields in CSM Business Objects.
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Rich Text Good to Know
You can use Rich Text in Business Object Records, Knowledge Articles, One-Step Actions and E-mail
Messages.

• The Rich Text Editor uses a default font based on the following settings, shown in priority order:•
◦ Field properties for a specific field in a Business Object (example: Resolution fields in

Problems).

◦ Default font selected in the Global Rich Text settings.

◦ Default theme form control font.

◦ CSM global system font (not configurable).

• The maximum size of a Rich Text Field is 4 gigabytes (or 2 gigabytes with Unicode, which supports•
double byte languages, such as Chinese). The images are also stored in the Field, with adjustable
size limits as shown below, so the actual size of the data includes the size of images plus the size of
all marked up text. In the database, two Fields (each 4 gigabytes) are actually created, one for the
plain text version of the Field and one for the HTML (Rich Text) version.

• When viewing Rich Text Fields in a Grid in the Desktop Client, a carriage return displays as -->.•
When viewing Rich Text Fields in a Grid in the Browser Client and Portal, a carriage return displays
with no special markup.

• Disable your Grammarly extension if you notice text disappearing unexpectedly from Rich Text•
fields. The text disappears when the Cherwell DLL cleans up invalid HTML added by the Grammarly
extension.

Note: When running a Report, if a plain text field does not show multi-lined text as expected, use
the Report Designer to set the field label property Multiline to Yes. See: Adding Fields to a
Report . If you change a plain text field to Rich Text, existing content in the plain text field is
cleared. Consequently, you must update or recreate all affected reports to ensure that the Rich
Text fields display correctly.
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Using Rich Text
You can use Rich Text in:

• Business Object Fields

• Knowledge Articles

• One-Step Actions that use Rich Text Fields

• E-mails
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Use Rich Text in Business Object Fields
In a rich text-enabled field in a Business Object (example: Incident Description), you can provide and
format text and insert images using rich text options.

Good to know:

• To accommodate rich text and save space, consider combining some fields in your Form design
(example: Combine the Description and Solution/Workaround fields in a Knowledge Article).

• If you copy/paste fully formatted rich text into a Business Object field in the Desktop Client, it might
render differently in the Browser Client. For best results, remove the formatting from the copied text
and paste it into the field as plain text. Then, you can apply formatting using the Rich Text Editor in
CSM.

• Images inserted into rich text fields in the Desktop Client will show up in the Browser Client and
CSM Portal, and vice versa.

Note: When running a Report, if a plain text field does not show multi-lined text as expected, use
the Report Designer to set the field label property Multiline to Yes. See: Adding Fields to a
Report . If you change a plain text field to rich text, existing content in the plain text field is cleared.
Consequently, you must update or recreate all affected reports to ensure that the rich text fields
display correctly.

To access and use rich text:

1. (Desktop Client) Click inside a rich text field, and then press F8.

Tip: You can also access the rich text zoom window by right-clicking and selecting Zoom, or
by selecting the Zoom button.

2. (Browser Client and CSM Portal) Click inside a rich text field, and then select the Toggle Toolbar
button.

3. Format text using either the formatting options in the rich text zoom window (Desktop Client), or in
the Rich Text Editor (Browser Client and CSM Portal).

4. Insert hyperlinks:
a. (Desktop Client) Right-click the rich text field or rich text zoom window, and then select Insert

Hyperlink.

Tip: You can also select Insert > Hyperlink from the rich text zoom window menu bar.

b. (Browser Client and CSM Portal) Select the Insert Hyperlink button in the Rich Text Editor.

c. Provide the hyperlink in the popup window.

Tip: In the Browser Client and CSM Portal, you can provide text and a tooltip for the
hyperlink. The text is a name for the hyperlink that shows as linked text instead of the
URL, and the tooltip is a word or phrase that shows when the mouse pointer hovers
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over the hyperlink. To open the link in a separate window, right-click the link and select
Open Link in New Window.

d. Select OK or Insert.

The hyperlink is inserted into the rich text field.

Tip: You can also copy/paste hyperlinks directly into rich text fields.

5. Insert images:
a. (Desktop Client) Right-click the rich text field or rich text zoom window, and then select

Images > Open Image.

Tip: You can also select Insert > Picture from the rich text zoom window menu bar.

b. (Browser Client and CSM Portal) Select the Insert Image button on the rich text toolbar.

c. Browse to the location of the image you want to insert, select the file, and then select Open.

The image is inserted into the field at the current cursor position, in the default image format
(JPEG or PNG) configured in the Global Rich Text settings in CSM Administrator.

Tip: In the Desktop Client, you can copy images onto the clipboard (Right-click >
Copy or CTRL+C) and paste them into rich text fields (Right-click > Paste or
CTRL+V). (Copy/paste does not work in the Browser Client or CSM Portal.)

6. Resize images:
◦ (Desktop Client) To resize a single image, right-click the image in a rich text field, and then

select one of the following options from the Images category in the context menu:
◦ Full-size Image: Select this option to resize the image to its full size.

◦ Thumbnail Image: Select this option to resize the image to the default thumbnail size
configured in CSM Administrator (the default size is displayed in parentheses next to the
menu selection).

◦ (Desktop Client) To resize all images in a rich text-enabled field, select one of the following
options from the Images category in the context menu:

◦ Resize All Images: Select this option to open a sub-menu, and then resize images to
either Thumbnail Images (default thumbnail size) or Full-Size Images.

◦ Default Image Size: Select this option to open a sub-menu, and then select to size
images as small thumbnails, medium thumbnails, large thumbnails, or full-size images.

Note: You can only set the default image size if the option was enabled in CSM
Administrator (Allow User to Override Image Display Mode is selected in Field
Properties). Selecting a default image size sets the default way that images are
displayed in all fields of the same type for a particular Business Object (example: if you
select small thumbnails as the default image size for an image in an Incident Description
field, all images in all Incident Description fields will be sized as small thumbnails).
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◦ (Browser Client and CSM Portal) In the Rich Text Editor for a Business Object field, select an
image. Select an image size from the size menu in the editor toolbar.

Note: In the Browser Client and CSM Portal, there is no option to resize all images in a rich
text-enabled field. You can only resize one image at a time.

7. View images in a separate window:
◦ (Desktop Client) Double-click an image to open it in the software associated with the file

extension (example: If the image is a JPEG file, it will open in the image viewer that is
associated with JPEG files on the User's computer).

Tip: You can also select Open Image in External Viewer from the Images category in the
context menu.

◦ (Browser Client and CSM Portal) In the Rich Text Editor for a Business Object field, select an
image, and then select View Image. You can then select View in New Tab to open the image
in a new tab in your browser. Alternatively, right-click the image and select Open Image in
New Tab.

8. Select OK in the rich text zoom window (Desktop Client) or Submit in the Rich Text Editor (Browser
Client or CSM Portal) to save your formatting changes.
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Use Rich Text in Knowledge Articles
You can create or import Knowledge Articles with embedded screenshots, numbered lists, and other Rich
Text formatting.

To accommodate Rich Text and save space, consider combining some Fields in the Knowledge Article
Form design (example: Combine the Description and Solution/Workaround fields).

Like in other Business Object Fields, you can open Knowledge Article Rich Text Fields in the Rich Text
Zoom window (select the Zoom button, press F8, or right-click>Zoom).

Note: As part of the CSM Embedded Forms functionality, you can use radio buttons to toggle
between a simple KA Form (with combined Fields) and a Detailed KA Form.

The Portal also supports Rich Text Knowledge Articles. You can view the article content and use the
Toggle Toolbar button to open the Rich Text Editor.

Note: When running a Report, if a plain text field does not show multi-lined text as expected, use
the Report Designer to set the field label property Multiline to Yes. See: Adding Fields to a
Report . If you change a plain text field to Rich Text, existing content in the plain text field is
cleared. Consequently, you must update or recreate all affected reports to ensure that the Rich
Text fields display correctly.
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Create One-Step Actions that Use Rich Text Fields
Rich Text capability can be used in One-Step Actions. For example, you can create One-Step Actions that
send emails with formatted text and embedded images to customers, or that update Incidents with screen
captures and numbered lists.

To create One-Step Actions that use Rich Text, include one or more of the following One-Step
Action actions:

• Send an email: You can specify the format for the message (Rich Text or plain text), use Rich Text
formatting options for text provided in the email body, and/or insert Rich Text Fields into the email
body.

• Write to a file: You can insert Rich Text or insert Rich Text Fields into file contents.

• Create a new Business Object: You can set Fields that can be automatically populated with Rich
Text content (example: Incident Description).

• Create a child Business Object (example: Journals): You can set Fields that can be
automatically populated with Rich Text content (example: Details).

• Update a Business Object: You can set Fields that can be automatically updated with Rich Text
content.

• Print: You can insert Rich Text Fields to print, or use Rich Text for typed contents.

• Send Tweet: You can insert Rich Text or insert Rich Text Fields into Tweet contents.

• Popup: You can insert Rich Text or insert Rich Text Fields into popup contents.

Good to know:

• When you insert Rich Text Fields into One-Step Actions, you can select how images are displayed
when One-Step Actions are executed and fields are populated with rich content. Right-click the
inserted field, and then select Display Images As. Select one of the following options: Small
Thumbnails, Medium Thumbnails, Large Thumbnails, or Full Size.

• If you use a One-Step Action (example: Create Change from Incident) to send the contents of a
Rich Text Field into a plain text Field, the Rich Text formatting and images are stripped out and
reverted to plain text.

• When you run a Report and a plain text field does not show multi-lined text as expected, use the
Report Designer to set the field label property Multiline to Yes. See: Adding Fields to a Report . If
you change a plain text field to Rich Text, existing content in the plain text field is cleared.
Consequently, you must update or recreate all affected Reports to ensure that the Rich Text fields
display correctly.

• If you use a One-Step Action to open a Rich Text Zoom window for a Business Object Field, the
system will not recognize any font selections unless the Field already contains text.
The Rich Text Editor uses a default font based on the following settings, shown in priority order:

◦ Field properties for a specific field in a Business Object (example: Resolution fields in
Problems).

◦ Default font selected in the Global Rich Text settings.

◦ Default theme form control font.
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◦ CSM global system font (not configurable).
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Use Rich Text in E-mails
The E-mail and Event Monitor (EEM) and Outlook Integration Manager automatically import Rich Text
from e-mails into Rich Text-enabled Fields in CSM Business Objects. For example, an e-mail monitor
configured to create Incident records from incoming e-mails can populate Incident Description fields with
rich content (example: Embedded screenshots, etc.) contained in the e-mails.

To ensure that Business Object Fields are populated with rich content from e-mails:

1. Configure Rich Text settings for the E-mail and Event Monitor to ensure that images contained in e-
mails are preserved and attached to Business Objects (no special configuration is required for the
Outlook Integration Manager to use Rich Text).

2. Enable Rich Text on the Business Object Fields that the body of the e-mail is configured to be
moved into.

3. Verify that the Rich Text Fields in Business Objects (example: Incidents) created by the EEM or
Outlook Integration Manager are properly formatted after import.

4. If rich content is imported into a plain text Field, ensure that the Rich Text is properly converted to
plain text.

When you send e-mails from the Desktop Client, Browser Client, or Portal, you have the option to send
them in either Rich Text or plain text format.
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Configuring Rich Text
To configure Rich Text in CSM Administrator:

1. Configure Global Rich Text Settings (System Settings in CSM Administrator): Defines how images
(example: Embedded screenshots) are stored and displayed in Rich Text Fields, including file types
and size limits.

2. Enable specific Business Object Fields to use Rich Text.

3. Define Rich Text settings for the E-mail and Event Monitor (EEM): So that rich content from
incoming e-mails is preserved and attached to Business Objects.
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Enable Rich Text on Business Object Fields
You can define various Rich Text options for Business Object fields.

These options include:

• Image Display: Display images in Fields and in the Rich Text Zoom window.

• Image format and size: Override the global settings for image format (JPEG or PNG) and
maximum size (per image and total for all images).

• Spell check: Enable spell check for a Rich Text Field.

• Default font: Font that applies to all Rich Text-enabled Fields of the same type for a particular
Business Object.

Good to know:

• Global Rich Text settings are configured in the System Settings window in CSM Administrator
(Settings > Edit System Settings> Rich Text page).

• When images in a format other than JPEG or PNG are inserted into a Rich Text Field, they are
converted to the default image format selected for the Field (either JPEG or PNG).

• Image file size increases by as much as 50% when images are embedded and stored with text in a
Rich Text Field. Take this into account when selecting a maximum file size for images.

• Rich Text Fields always have a length of Max Allowed (the maximum number of characters allowed
in a Field).

Note: When running a Report, if a plain text field does not show multi-lined text as expected, use
the Report Designer to set the field label property Multiline to Yes. See: Adding Fields to a
Report .

To enable Rich Text on Business Object Fields:

Note: If you change a plain text field to Rich Text, existing content in the plain text field is cleared.
Consequently, you must update or recreate all affected reports to ensure that the Rich Text fields
display correctly.

1. Open the Business Object Editor.

2. In the Business Object Editor Grid, click inside a Text Field (example: Resolution) for which you
want to enable Rich Text, and then select the Field Properties button.

3. Select the General page.

4. In the Field Properties section, select the Rich Text radio button.

5. Define Rich Text Options for the Field:
a. Form Images Are Displayed As: Select one of the following options in the drop-down to

determine how embedded images are displayed in the Rich Text Field:
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◦ Use Global Setting (default): Select this option to display images according to the global
Rich Text setting (Settings>Edit System Settings>Rich Text page). When this option is
selected, the global setting is displayed in parentheses to the right of the drop-down.

◦ No Image Support

◦ Small Thumbnails

◦ Medium Thumbnails

◦ Large Thumbnails

◦ Full Images

b. Zoomed Images Are Displayed As: Select one of the following options in the drop-down to
determine how embedded images in the Rich Text Field are displayed in the Rich Text Zoom
window:

◦ Use Global Setting (default): Select this option to display images according to the global
Rich Text setting (Settings > Edit System Settings> Rich Text page). When this option
is selected, the global setting is displayed in parentheses to the right of the drop-down.

◦ No Image Support

◦ Small Thumbnails

◦ Medium Thumbnails

◦ Large Thumbnails

◦ Full Images

c. Image Format: Select the image format to use as the default for images embedded in the
Field:

◦ Use Global Setting (default): Select this option to display images according to the global
Rich Text setting for image format (Settings > Edit System Settings> Rich Text page).
The global setting is displayed in parentheses to the right of the drop-down when this
option is selected.

◦ JPEG Format: Select this option to override the default image format so that images are
displayed in the JPEG file format.

◦ PNG Format: Select this option to override the default image format so that images are
displayed in the PNG file format.

d. Override Maximum Size Per Image: Select this check box to deviate from the global Rich
Text setting for the maximum size of a single image embedded into the Field (default is 500
kilobytes).

Note: If the image size exceeds the maximum size, the image will automatically be re-
sized to fit within the maximum size limits.

e. Override Maximum Total Size for Images: Select this check box to deviate from the global
Rich Text setting for the maximum size of all images embedded into the Field (default is 3
megabytes).
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Note: If the total image size exceeds the maximum size, the images will automatically
be re-sized to fit within the maximum size limits.

f. Allow Spell Check: Select this check box to enable spell checking for the Field. This checks
for spelling errors in content that is provided in the Field.

Note: This option is only available if spell checking is enabled in the Business Object's
general properties.

g. Allow User to Override Image Display Mode: Select this check box to give Users filling out
Business Object Forms in the CSM Desktop Client the option to override the defaults for how
Form images and zoomed images are displayed in Rich Text Fields and the Rich Text Zoom
window.

h. Custom Default Font: Select this check box to specify a default font that applies to all Rich
Text-enabled Fields of the same type for a particular Business Object (example: If you select a
default font for the Problem Resolution field, it applies to all Resolution fields in all Problems).

i. Select the Ellipses button to open the Font window, and then select a Font, Font style,
and Size.

ii. Select OK.ii.

When you are designing a Form in the Form Editor, you can select a Font, Font style,
and Size for a Field, which only apply to that Field in a Business Object. However, if you
specified a Custom Default Font, it overrides any font selections made in the Form Editor
for that same Field.

6. Select OK.6.

7. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.
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Define Rich Text Settings for E-mails
Use the Rich Text options in the E-mail and Event Monitor to automatically preserve the rich content
contained in incoming e-mails and attach it to Business Objects. Then, when a Business Object (example:
Incident) is updated with the contents of an e-mail, any screenshots contained in the e-mail will also be
included and attached to the Object.

To define Rich Text settings for e-mails:

1. Open the E-mail and Event Monitoring Manager.

2. Select an E-mail Monitor, and then click the Edit button.

The E-mail Event Monitor window opens.

3. Click the Monitors page.

4. Select an item from the list (example: Update Existing Incident), and then click Edit.

The E-mail Event Monitor - Condition and Action page opens.

5. Click the Actions page. 

6. Define Rich Text options for monitored e-mails:
a. Preserve Inline Images Within E-mail Body: Select this check box to preserve any images

within the body of incoming e-mails with the text of the e-mail. Clear this check box to remove
images from the body of incoming e-mails.

b. Attach Inline Images to <Business Object (example: Incident)>: Select this check box to attach
any images within the body of incoming e-mails to the selected Business Object. Clear this
check box to attach only the text of incoming e-mails to the selected Business Object.

7. Select OK.7.

8. Click Close.

Note: The Outlook Integration also supports Rich Text Fields and imports Rich Text found in
the body of an e-mail into a Rich Text-enabled Field in CSM. It does not require any special
configuration to use Rich Text.

CSM 2022.3 Features 1437

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=about_e-mail_and_event_monitor__02
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_open_e-mail_monitor
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Frich_text%2F..%2Fe-mail%2Fabout_the_cherwell_outlook_add-in.html


Searching
CSM provides an extremely powerful search engine and a host of search tools to help you efficiently and
thoroughly search and filter your CSM data to locate a specific record or a set or records.

• Quick Search: This is a simple, single-use query that quickly displays search results according to
the default sort order of relevancy ranking.

• Knowledge Search: Use the Quick Search Widget or Knowledge Pane to run a search for
Knowledge sources. For more information, see Quick Search Widget or Search for Knowledge
Using the Knowledge Pane.

• Query Builders: Available Query Builders are Stored Query Builder, Quick Search Query Builder,
and Custom Query Builder. There are many OOTB saved searches in the Search Manager to use
and re-purpose to meet your needs. Familiarizing yourself with these OOTB saved searches could
save you time and give you a starting point for searches you may only need to modify.

• Solution Search: CSM Browser Client provides a Solution Search from within a record.

• All Words or Any Words: Searches can be performed in a variety of ways using this logic.

Related concepts
Use All Words/Any Words
About Quick Search
Search Knowledge
Query Builders
Managing Saved Searches
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Searching
CSM provides a variety of search options to help you search and filter your data.

CSM Browser Client provides a variety of search options, including:

• Quick Search: This is a simple, single-use query that quickly displays search results according to
the default sort order of relevancy ranking.

• Saved Searches: Available Query Builders are Stored Query Builder, Quick Search Query Builder,
and Custom Query Builder. There are many OOTB saved searches in the Search Manager to use
and re-purpose to meet your needs.

• Solution Search: CSM Browser Client provides a Solution Search from within a record.

CSM Desktop Client search options and tools include:

1. Quick Search: Use the Quick Search Widget or Quick Search in the Task Pane to run a Quick
Search. For more information, see Quick Search Widget and Quick Search in the Task Pane.

2. Saved Search: Use the Search Manager to view saved searches created in the Query Builders. For
more information, see Managing Saved Searches and Query Builders.

3. Quick Search Query Builder: Use to create a Quick Search query that does not use relevancy
ranking in the search results.

4. Knowledge Pane: Use to search the configured Knowledge sources in your Knowledge Base.
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At the heart of searching are queries, which define criteria for retrieving and displaying data. CSM
provides default saved searches and Query Builders to help you create your own searches.

Related concepts
About Quick Search
About Saved Searches
Quick Search Query Builder
About Knowledge Management
Search Queries
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Hierarchy of Default Settings for Search Results
There is a hierarchy applied to the default settings for search results based on the search tool and user
action taken.

CSM is highly configurable so keep in mind that the defaults described below are default settings.

Hierarchy for Quick Search and Knowledge Search

• Sort By - Relevancy: Relevancy ranking is the default sort order for all new Quick Searches and
Knowledge Searches. When searching all Business Objects from the Quick Search widget, results
are always displayed by relevancy ranking.

• Sort By - (manually selected option): When searching a specific Business Object (Example:
Incident) in Quick Search Widget or Task Pane Quick Search, the Sort by drop-down list defaults
to relevancy, but users can change this selection and/or select a specific column header in the
Search Results grid to change the sort order. These manual selections are only good for the current
search session. When you start a new search session, the Sort By - Relevancy default returns.

• User Selected Defaults: If a user has personalized search preferences not affecting the Sort By
setting, these are used by default.

• Search Defaults set in CSM Administrator: If defaults are defined in CSM Administrator not
affecting the Sort by setting and not affecting the user-selected preferences, these are used by
default.

For more information, see About Quick Search and Search Knowledge.

Hierarchy for Query Builders

• Saved Search Defaults: When using the Query Builders, results are always be returned by using
the search configurations defined in the saved search.

• User Selected Defaults: If a user has personalized search preferences not affecting the saved
search preferences, these are used by default.

• Search Defaults set in CSM Administrator: If defaults are defined in CSM Administrator not
affecting the saved search preferences and not affecting the user-selected preferences, these are
used by default.
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Related concepts
Quick Search Widget
Quick Search in the Task Pane
Configure User Task Pane and Search Control Settings
About Saved Searches
Related tasks
Configuring Search Defaults
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Search Queries
A Query defines the criteria for retrieving specific data, such as find All Incidents.

A Query contains:

• A Grouping Clause: Tells CSM if the Query uses AND (all are true) or OR (any are true) logic.

• One or more additional Clauses (the word or phrase that starts the Query), each comprised of one
or more conditions.

Queries are built using clauses and conditions:

• Clause: A clause combines User specified conditions that are used to narrow the scope of a Query.
CSM provides the following clauses:

◦ Group Clause: A Group Clause is a Query Clause that groups together several Clauses.
When you group Clauses you must decide if all Clauses must be true (AND logic), or if only
one Clause must be true (OR logic), in order to retrieve the record.

◦ Comparison Clause: A Comparison Clause is a Query Clause that finds all records
containing a field with a particular value.

◦ Ownership Clause: An Ownership Clause is a Query Clause that finds records associated
with a particular owner (person or Team).

◦ Related Clause: A Related Clause is a Query Clause that finds Business Objects whose
related Business Object satisfy some of the criteria.

◦ Queue Clause: A Queue Clause is a clause that finds all records that exist or do not exist on
Queues. It also finds records that are available, checked out, and suspended on Queues. For
more information, see About Queues.

• Condition: A condition is a Dynamic Value that adds to the requirements of a Query, which may
consist of one or more of the following:

◦ Fields: A Field is a basic unit of information (example: ID, last name, address, etc.) that is
specific to a Business Object (example: Incident, Problem, Service, Customer, etc.).
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◦ System Functions: A System Function is a built-in placeholder Token that dynamically adds
variable information to a query or string (example: Current User's name). For more
information, see About System Functions.

◦ Prompts: A Prompt is a display window that requires Users to provide information before
proceeding with a process or Action (example: Specify the reason for putting an Incident into
Pending status).

◦ Expressions: An Expression is a combination of explicit values, constants, variables,
operators, and functions that receive input, manipulate the data, and then output the data. In
other words, an Expression interprets a value, and then produces another value as a result
(example: The IncidentDurationInDays Expression calculates the amount of time that elapses
between the time an Incident is created and closed).

◦ Stored Values: A Stored Value is a named entity that stores commonly used information so
that it can be accessed and/or reused from various places in CSM, such as One-Step Actions
and Queries.

◦ Metrics: A Metric is a stored measurement query whose value can be used to measure,
monitor, and predict service desk performance and trends (example: Average time to resolve
Incidents).

◦ Operators: An operator is a word or phrase (equals, greater than, contains) that provides the
necessary information for two values to produce an output. The availability of operators
depends on the type of values you choose for a Search Clause. For more information, see
Operators.

Note: Search Queries are SQL Queries but prior knowledge of SQL is not needed
because CSM converts the searches to the appropriate SQL Queries behind the
scenes.

Related concepts
Define a Group Clause
Define a Comparison Clause
Define an Ownership Clause
Define a Related Clause
Define a Queue Clause
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Fields
A Field is a basic unit of information (ex: ID, last name, address, etc.) that is specific to a Business Object
(ex: Incident, Problem, Service, Customer, etc.). Field options only appear in drop-downs when you are
creating a Comparison Clause.

CSM provides you with multiple Field options, including the Field of the current Business Object (ex:
Incident) along with the Fields from related Business Objects (ex: Change Request, Customer, etc).

Note: If you have security rights, you can use the Field Properties window to set Field properties
such as data type, size, read-only, required, and default value.
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Operators
An operator is a word or phrase (equals, greater than, contains) that provides the necessary information
for two values to produce an output.

The availability of operators depends on the type of values you choose for a Search Clause.

Operator drop-downs appear in CSM when creating a Comparison Clause.

Operators include:

• Equals: Finds records where value in field equals value in far right drop-down list.

• Not equal: Finds records where value in field does not equal value in far right drop-down list.

• Like: Finds records where the value matches the value and its wildcard in the right-most drop-down.
(example: Jo% will find Joe, John, etc.).

Note: Use % as the wildcard character. For example, enter John% to find all records where
the field starts with "John." Do not use the wildcard character at the beginning of the string if
it can be avoided (example: %SON), because the underlying database query will be very
slow.

• Not like: Finds all records that do not match a value and its wildcard.

• Empty: Finds all records where the field value is empty.

• Not empty: Finds all records where the field value is not empty.

• Greater than: Finds all records where the value is greater than the value in the far right drop-down
list.

• Greater or equal: Finds all records where the value is greater than or equal to the value in the far
right drop-down list.

• Less than: Finds all records where the value is less than the value in the far right drop-down list.

• Less or equal: Finds all records where the value is less than or equal to the value in the far right
drop-down list.

• Contains: Does a SQL Server Full-Text search to find records that contain the text in the far right
drop-down list.

You can also use the All Words/Any Words option.

• Is member of team: Use to determine if a particular user's ID is a member of a particular Team's ID.

• Is not member of team: Use to determine if a particular user's ID is not a member of a particular
Team's ID.

Related concepts
Define a Comparison Clause
Use All Words/Any Words
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Use All Words/Any Words
The All Words/Any Words feature allows you to run two types of searches: by all words or by any words.
The results depend on the location in which the function is used.

The All Words/Any Words options appear in the following locations by default:

• Quick Search in the Task Pane

• Quick Search Builder

• Knowledge Search

All Words/Any Words in the Quick Search Builder

Button Action Description

All Words
Search uses all words (AND is used to separate words in search). In Quick
Search Builder, "noise" words ARE NOT included in the search (Example: "the"
and "will").

Any Words Search uses any of the words (OR is used to separate words in search).

All Words/Any Words with the Relevancy ranking in the Quick Search and Knowledge Search

Button Action Description

All Words

Search uses all words (AND is used to separate words in search). With the
Relevancy ranking, "noise" words ARE included in the search (Example: "the"
and "will"). An All Word search is better at finding records where the user is
looking for records containing all of the words in the search string.

Any
Words

Search uses any of the words (OR is used to separate words in search). With the
Relevancy ranking, this option ranks records higher that have more of the search
words. An Any Word search is better at ranking records by those containing the
most instances of any words in the search string.

To hide the All Words/Any Words option, see Hiding the All Words/Any Words Search Option.

Related concepts
Quick Search in the Task Pane
Quick Search Query Builder
About Knowledge Management
Related tasks
Hiding the All Words/Any Words Search Option
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Query Clauses
When you create a Query, you must define one or more clauses. A clause combines User specified
conditions that are used to narrow the scope of a Query. CSM provides the following clause types:

• Comparison Clause: A Comparison Clause is a Query Clause that finds all records containing a
field with a particular value.

• Group Clause: A Group Clause is a Query Clause that groups together several Clauses. When you
group Clauses you must decide if all Clauses must be true (AND logic), or if only one Clause must
be true (OR logic), in order to retrieve the record.

• Ownership Clause: An Ownership Clause is a Query Clause that finds records associated with a
particular owner (person or Team).

• Related Clause: A Related Clause is a Query Clause that finds Business Objects whose related
Business Object satisfy some of the criteria.

• Queue Clause: A Queue Clause is a clause that finds all records that exist or do not exist on
Queues. It also finds records that are available, checked out, and suspended on Queues.
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Define a Comparison Clause
A Comparison Clause is a Query Clause that finds all records containing a field with a particular value.

Use the Query Builder window to create a Comparison Clause.

When you define this type of clause, you define:

• Field: Field for which you want to find a value.

• Operator: Word or phrase (equals, greater than, contains) that provides the necessary information
for two values to produce an output.

• Value: Value for which the clause searches.

Good to know:

• Expressions, Stored Values and system functions appear as folders after the Fields if they are
available.

• Some operators are only shown for particular data types (example: "Like" is only available for text
Fields).

• If the Field is validated, the Legal Values Button  displays on the right of the drop-down list. It
allows you to select from a list of appropriate values.

• If Globalization is enabled for your system, you may be able to choose Lookup Object values from
different cultures.

To create a Comparison Clause:

1. Open a Query Builder.

2. Select New, and then select Comparison Clause.

The Comparison Clause section opens.

3. Select the Field for which you want to find a value (example: Call Source):
a. Select the Down arrow  next to the left-most drop-down list to reveal the list of applicable

Fields.

b. Select a Field from the list.

The value drop-down list (far right drop-down list) automatically populates.

For a join table, select the join table from the drop-down list.

Important: To see the join table option in the drop-down list, you must first define link
options to use a join table under Relationship Properties.

4. Select the Operator drop-down list to reveal applicable operators, and then select an operator.
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5. Provide a value or select the Down arrow next to the far right drop-down list to reveal applicable
options and Tokens, including:

◦ Fields

◦ System Functions

◦ Prompts

◦ Expressions

◦ Stored Values

◦ Metric Values

6. Select a Value from the list (this is the value the search will look for).

The Comparison Clause displays in the Query.

7. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, use the Options button to define additional
options, including availability and icon image.

8. Select Save.8.

Related concepts
Query Builders
Define Link Properties for a Relationship
Fields
About System Functions
Expressions
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Define a Group Clause
A Group Clause is a Query Clause that groups together several Clauses. When you group Clauses you
must decide if all Clauses must be true (AND logic), or if only one Clause must be true (OR logic), in order
to retrieve the record.

Use the Query Builder window to create a Group Clause. When you define this type of clause, you define
a conditional phrase. All of the conditions or at least one of the conditions in the clause must be true of all
returned records

To create a Group Clause:

1. Open a Query Builder.

2. Select New on the Query Builder toolbar, and then select Group Clause.

The Group Clause area displays.

3. Select one of the following phrases to add to the Query:
◦ All of the items in the group must be true.
◦ At least one of the items in the group must be true.

The phrase displays in the Query.

4. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, there is an Options button that allows you
to define additional options, including availability and icon image.

5. Select Save.5.
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Define an Ownership Clause
An Ownership Clause is a Query Clause that finds records associated with a particular owner (person or
Team).

Use the Query Builder window to create an Ownership Clause. When you define this type of clause, you
define:

• Owner: The type of owner (example: User, Team, Customer) and the specific owner (example:
Clair, 1st Level Support, etc.), if applicable.

• Owner's relationship: How the owner is associated with the record (example: Owner is a member
of the Team that owns the record).

Good to know:

• The Ownership Clause section is dynamic. When you select an owner in the drop-down list,
additional options (radio buttons or drop-down menus) display in the Ownership Clause section of
the window. The options allow you to narrow the scope of your Query.

• Not all Business Objects support Team ownership. Business Objects can be set up to support Team
ownership by using the Field Editor to add two Fields that hold the Team name and Team ID.

To create an Ownership Clause:

1. Open a Query Builder.

2. Select New button, and then select Ownership Clause.

3. Select an owner from the Owner is drop-down list.
◦ Current User: The User owns the record or is a member/manager of the Team that owns the

record.

◦ Specific User: Name of the User who owns the record, or is a member/manager of the Team
that owns the record.

◦ Specific Team: Name of the Team that owns the record.

◦ Current Customer: The Customer requested the record or is a member/manager of the
associated Customer Workgroup.

◦ Specific Customer: The specified Customer requested the record or is a member/manager of
the associated Customer Workgroup.

◦ Specific Customer Workgroup: Name of the Customer Workgroup that owns the record.

The Ownership Clause displays in the Query.

4. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, there is an Options button that allows you
to define additional options, including availability and icon image.

5. Select Save.5.
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Define a Related Clause
A Related Clause is a Query Clause that finds Business Objects whose related Business Object satisfy
some of the criteria.

Use the Query Builder window to create a Related Clause. When you define this type of clause, you
define:

• Relationship: Existing CSM Relationship between two Business Objects (example: Incident links
Service).

• Value: Number of Business Object records in the relationship (There are exactly 3 Services).

Good to know:

• For each item with "n", a Record number menu appears that allows the number to be selected.

To create a Related Clause:

1. Open a Query Builder.

2. Select New on the Query Builder toolbar, and then select Related Clause.

3. Select a related Business Object from the Relationship drop-down list.
For a join table, select the join table from the drop-down list.

Important: To see the join table option in the drop-down list, you must first define link
options to use a join table under Relationship Properties. See Define Link Properties for a
Relationship.

4. Select a value in the Contains drop-down list:
◦ All <related business object>
◦ There is at least one <related business object>
◦ There are no <related business object>
◦ There is exactly 1 <related business object>
◦ There is not exactly 1 n <related business object>
◦ There is more than 1 n <related business object>
◦ There is at least 1 n <related business object>
◦ There are less than 1 n <related business object>
◦ There are 0 or 1 n <related business object>

The clause you created displays in the Query.

5. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, there is an Options button that allows you
to define additional options, including availability and icon image.
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6. Select Save.6.
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Define a Queue Clause
A Queue Clause is a clause that finds all records that exist or do not exist on Queues. It also finds records
that are available, checked out, and suspended on Queues. Use the Query Builder window to create a
Queue Clause. When you define this type of clause, you define one of the following Queue types:

• Specific Queue: A Queue Clause containing a Specific Queue finds records on a particular Queue,
such as First Level Support or Hardware.

• User Queue: A Queue Clause containing a User Queue searches records on one of the specialized
Queues that is automatically associated with each User.

• Queue Group: A Queue Clause containing a Queue Group finds records on a set of Queues that
are grouped together.

• Any Queue: A Queue Clause containing a User Queue searches records on one of the specialized
Queues that is automatically associated with each User.

To define a Queue Clause:

1. Open a Query Builder.

2. Select New on the Query Builder toolbar, and then select Queue Clause.

3. Define a Queue:
◦ Specific Queue
◦ User Queue
◦ Queue Group
◦ Any Queue

4. Select Save.4.

Related concepts
Define a Specific Queue
Define a User Queue
Define a Queue Group
Define an Any Queue
Query Builders
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Define a Specific Queue
Use the Queue Clause section of a Query Builder to define a Queue Clause. A Queue Clause containing
a Specific Queue finds records on a particular Queue, such as First Level Support or Hardware. The
Specific Queue section provides you with multiple options to narrow the Query. When you define a
Specific Queue, you define:

• Condition: Queue behavior (example: Record is not on Specific Queue).

• Who: User who checked out the record, if applicable.

• Queue: The specific Queue where the record is located.

To define a Specific Queue:

1. Open a Query Builder.

2. Select New on the Query Builder toolbar, and then select Queue Clause.

3. In the Where drop-down list, select a condition:
◦ Record is on Specific Queue
◦ Record is not on Specific Queue
◦ Record is checked out to Specific Queue
◦ Record is not checked out from Specific Queue
◦ Record is suspended on Specific Queue

Note: If you select Record is checked out to a Specific Queue, select the specific Team
member from Checked out by drop-down list.

4. Select the ellipses button next to Specific Queue to open the Queue Manager, and then select an
existing Queue.

5. Select Save.5.
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Define a User Queue
Use the Queue Clause section of a Query Builder to define a User Queue. A Queue Clause containing a
User Queue searches records on one of the specialized Queues that is automatically associated with
each User. When you define a User Queue, you define:

• Condition: Queue behavior (example: Record is not on User Queue).

• Who: User who checked out the record, if applicable.

• User Queue: Team (example: 1st Level Support) and User (example: Current User).

To define a User Queue:

1. Open a Query Builder.

2. Select New on the Query Builder toolbar, and then select Queue Clause.

The Queue Clause section displays in the Stored Query window.

3. In the Where drop-down list, select a Queue condition:
◦ Record is on Specific Queue
◦ Record is not on Specific Queue
◦ Record is checked out to Specific Queue
◦ Record is not checked out from Specific Queue
◦ Record is suspended on Specific Queue

Note: If you select Record is checked out to a Specific Queue, select the specific
Team member from Checked out by drop-down list.

4. Select a specific User's Queue:
a. In the far left drop-down list, select a Team.

b. In the far right drop-down list, select a User.

5. Select Save.5.
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Define a Queue Group
Use the Queue Clause section of a Query Builder to define a Queue Group. A Queue Clause containing a
Queue Group finds records on a set of Queues that are grouped together. When you define a Queue
Group, you define:

• Where the record is located (example: On a Queue in the group).

• Queue Group where the record is returned from.

Good to know:

• Since Users can manually assign items to Queues, it is helpful to ensure that the same issue cannot
be assigned to more than one Queue. For example, you might assign an Incident to go to a
Hardware Queue as well as a Survey Queue, so you can track the Customer service experience. In
this instance, you can create a Queue Group containing Hardware and Survey. If an Incident is on
the Hardware Queue and then assigned to the Printer Queue, it is automatically removed from the
Hardware Queue. This system prevents two different people from working on the same issue. A
Queue Group makes sure that an item can only be assigned to one of the Queues in the group. The
Queue Group section provides you with multiple ways to narrow your Query.

To define a Queue Group:

1. Open a Query Builder.

2. Select New on the Query Builder toolbar, and then select Queue Clause.

3. In the Where drop-down list, select a condition:
◦ Record is on a Queue in a group
◦ Record is not on a Queue in a group

4. Select the ellipses button to open the Queue Group Manager, and then select an existing Queue
Group.

5. Select Save.5.
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Define an Any Queue
Use the Queue Clause section of a Query Builder to define an Any Queue. A Queue Clause containing
Any Queue searches all records that are (or are not) on any Queue that exists in the system. When you
define an Any Queue, you define:

• Condition: Where the record is located (example: Record is on any Queue).

To define an Any Queue:

1. Open a Query Builder.

2. Select New on the Query Builder toolbar, and then select Queue Clause.

The Queue Clause section displays in the Stored Query window.

3. In the Where drop-down list, select a condition:
◦ Record is on any Queue
◦ Record is not on any Queue

4. Select Save.4.
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Query Builders
A Query Builder allows you to build Queries through the use of one or more independently created
Clauses. Each Query Builder is dynamic and provides specific options based on the purpose of the Query
you are building.

CSM provides Users with three types of Query Builders:

1. Stored Query Builder: The Stored Query Builder allows you to create a Saved Search and save it to
the database as a Saved Search.

2. Quick Search Query Builder: The Quick Search Query Builder allows you to create a Quick Search.

3. Custom Query Builder: The Custom Query Builder allows you to create an exclusive search that
finds all records meeting a unique criteria.

Query Builders can be found in the following locations:

Automation Processes Type of Query Builder

Simple Action/Event Stored Query Builder

Threshold-based
Stored Query Builder

Custom Query Builder

Visual workflow
Stored Query Builder

Custom Query Builder

External Tables Type of Query Builder

Administrator>Database>Import External Data>Filter Stored Query Builder

Knowledge Type of Query Builder

Knowledge Source Stored Query Builder

One-Step Actions Type of Query Builder

Condition Page Stored Query Builder
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Quick Search Type of Query Builder

Quick Search Pane Quick Search Query Builder

Task Pane Quick Search Quick Search Query Builder

Reporting Type of Query Builder

Existing Report Stored Query Builder

Wizard (Saved Search Page) Stored Query Builder

Saved Searches Type of Query Builder

Business Objects Custom Query Builder

Scheduler Type of Query Builder

Portal Credentials Stored Query Builder

Widgets Type of Query Builder

Action Catalog Widget Custom Query Builder

Chart Widget
Stored Query Builder

Custom Query Builder

Filter Widget
Stored Query Builder

Custom Query Builder

Gauge Widget
Stored Query Builder

Custom Query Builder
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Widgets Type of Query Builder

Matrix Widget
Stored Query Builder

Custom Query Builder

Search Results List Widget
Stored Query Builder

Custom Query Builder

Search Widget Custom Query Builder

Related concepts
Stored Query Builder
About Saved Searches
Quick Search Query Builder
Custom Query Builder
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Stored Query Builder
The Stored Query Builder allows you to create a Saved Search and save it to the database as a Saved
Search (saved search). Once the Query is created, Users can easily access it within the database and
run it repeatedly.

Access the Stored Query Builder from multiple locations in CSM.

1. Name/Description: Name and describe the Query, so that you can recognize its function.

2. Search Type: Select the Business Object you want the Query to search.

3. Toolbar: Build the Query using these tools.

4. Clause: Add a Clause (Comparison, Group, Ownership, Related, Queue) to the Query.

5. Query: View the Query as you create it and reorganize the Query as necessary.
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6. Options: Determine who can view the Query and which image identifies it in CSM.

CSM 2022.3 Features 1465

CSM 2022.3 Features



Quick Search Query Builder
The Quick Search Query Builder allows you to create a Quick Search query that does not use Relevancy
ranking in the search results. The Quick Search Query Builder is dynamic and provides specific options
based on the purpose of the Query you are creating.

Access the Quick Search Query Builder from multiple locations in CSM.

The Quick Search Query Builder behaves a bit differently from the regular Quick Search in that it uses the
Query Builder functionality rather than the Quick Search functionality. Additionally, the Quick Search
Builder in the CSM Browser Client behaves differently than the CSM Desktop Client.

The Quick Search Query Builder is composed of the following:

1. Search: Select the type of Business Object you want the Query to search.

2. Toolbar: Build the Query using these tools.

3. Open <Business Object> Only: Select the check box to view records that have not been resolved.

4. Changed: Narrow the timeframe associated with the Query.
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5. Clause: Add a clause (Comparison, Group, Ownership, Related, Queue) to the Query.

6. Query: View the Query as you create it and reorganize the order of the Clauses as necessary.

Related concepts
Query Builders
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Custom Query Builder
The Custom Query Builder allows you to create an exclusive search that finds all records meeting a
unique criteria. The Custom Query Builder is dynamic and provides specific options based on the purpose
of the Query you are creating.

Access the Custom Query Builder from multiple locations in CSM.

1. Toolbar: Build the Query using these tools.

2. Clause: Add a clause (Comparison, Group, Ownership, Related, Queue) to the Query.

3. Query: View the Query as you create it and reorganize the order of the clauses as necessary.
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Query Builder Behaviors and Features
Query behaviors include:

• By default, the first line is a Grouping Clause that states <Business Object> where all of the
following are true, which represents the top level Clause that combines all of the other Clauses
together.

Note: This phrase can be changed to <Business Object> where at least one of the
following is true; however, you must choose one option.

• The current selected Clause is indicated by the Green arrow .
• Data relating to the Clause displays as child items below the Green arrow .

Note: As the Clause changes, the Query changes to represent the function of the Clause.

• Click the Green Up/Down arrows next to the Query to move Clauses within the Query.

• Select a Clause and click the Delete button to remove it from the Query.

The Query Builder toolbars provide the following features:

Action Description

New

Create a new:

• Comparison Clause

• Group Clause

• Ownership Clause

• Related Clause

• Queue Clause

Delete Deletes the selected clause.

Copy Creates a copy of the last created clause and adds it to the last string of
the Query.

Move to parent Moves the Clause to parent (CTRL+HOME).

Move to child Moves the Clause to child (CTRL+END).

Sort results by Chooses a specific value to sort the search results by

Sort in ascending order Sorts the search results in ascending order (1-10, A-Z, etc.).

Sort in descending
order Sorts the search results in descending order (10-1, Z-A, etc.).

Sort with multiple
columns Sorts the search results with multiple columns.
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Action Description

Use All Words Inserts an AND to separate the Clauses, so the search finds all words
entered in the Query.

Use Any Words Inserts an OR to separate the Clauses, so the search finds any of the
words entered Query.
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About Quick Search
Use the Quick Search widget or Quick Search in the Task Pane to run a simple, single-use query that
quickly displays search results according to the default sort order of Relevancy ranking. This means the
records most likely to be relevant to your search string display at the top of the results by default.

Quick Search behaviors include the following:

• Some quick search areas may offer a choice to use All Words or Any Words logic.

• Logical operators (AND/OR/NOT) used in the search (example: 103234 AND 283475) do not
function as operators. If you need specific operator behavior, consider using thestored query builder
to achieve it.

• If a Business Object is not specified in the search, results display in a list according to their
Relevancy ranking.

• If a Business Object is specified in the search (example: Incidents), results display in either a list or
a grid. The default sort order is by Relevancy ranking, but this can be modified in the Sort By drop-
down list.

Related concepts
Quick Search Widget
Quick Search in the Task Pane
Use All Words/Any Words
About Grids
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Quick Searches Good to Know
Use Quick Searches good to know for useful information and recommendations.

• Enable or disable a Business Object and related fields to appear in Quick Search Relevancy results.

• You can view Quick Search results as a list, in a grid, or in card view. Each provide additional
information about the results.

• The Task Pane does not display by default.

• When Search Attachments is selected in the Quick Search widget, the search returns results that
match the text within .txt, .doc, and .xls files and will return any file type with a matching file name.

Note: To include attachment types of .docx and .xlsx, you must install the Microsoft Filter
Pack on the SQL Server machine. Run the following SQL commands:

◦ EXEC sp_fulltext_service 'update_languages';

◦ EXEC sp_fulltext_service 'load_os_resources', 1;

◦ EXEC sp_fulltext_service 'restart_all_fdhosts';

For details on installing the Microsoft Filter Pack, visit the Microsoft website.

Always consider the following:

• The Quick Search Widget is customizable. The system administrator decides if it is displayed, which•
Business Objects can be searched, and what the search options are. Your default search control
(either system or role) is initially set in CSM Administrator by a system administrator; however, if you
have security rights, you can select your own default.

• The Quick Search Query Builder behaves differently from Quick Search. See Quick Search Query•
Builder.

• Security rights control access to CSM functionality and are configured in the Security Group•
Manager in CSM Administrator (Security > Edit Security Groups). See Searches Security Rights.

Related concepts
Quick Search Widget
Quick Search in the Task Pane
Quick Search Results
Configure User Task Pane and Search Control Settings
Related tasks
Configuring Search Defaults
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Quick Search in the Task Pane
Use the Quick Search in the Task Pane to search records for a specific Business Object.

This Quick Search provides the following functionality:

Action Description

Select Business
Object to Search

Select a specific Business Object to search (examples: Incident, Problem,
Vendor) from the drop-down list. At the bottom of this list, you can also select
whether to use the All Words/Any Words feature.

Use Configuring Search Defaults to enabling/disabling Business Objects for
search.

Search (text field) Type or select the search word or phrase. The most recently used searches
appear in a drop-down list.

Go (magnifying
glass icon)

Runs the search. Search results are displayed in a Grid (if they are of the same
type) or a List (if they are of different types). By default, the Search Results
display according to their Relevancy ranking, which means the records most
likely to be relevant to your search string display at the top of the results.

Search Options
(ellipses icon)

When searching a specific Business Object, select the ellipses icon to refine the
search: Changed, Open records only, Relationships, Attachments, Sort By, etc.

Open (records)
only

Limits the search to records (Business Objects) that have not reached their final
state (example: not closed) or final stage in either the legacy lifecycle or the
Business Object Lifecycle Editor. If the Business Object does not have a "final" or
closed state or final stage, this check box does not appear.

Note: The lifecycle and terminology vary depending on the Business
Object and scenario (examples: Unapproved Changes only might
appear when searching Changes, Non-Retired only might appear when
searching Knowledge Articles).
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Action Description

Open Advanced
Editor

Run a refined search of a specific Business Object. A Quick Search window
opens with additional search criteria options.

Note: This type of search is not saved. You need to create a Saved
Search. For more information, see Create a Saved Search.

Changed Limits the search to records that have changed during a specific timeframe.

Relationships
Includes related Business Objects in the search (example: If the search word
appears in a Journal entry, the Incident to which it is attached will be included in
the search results).

Attachments When selected, the search returns results that match the text within .txt, .doc,
and .xls files and will return any file type with a matching file name.

Sort by

Selects the Business Object field (column) to use to sort the search results. By
default, the Search Results display according to their Relevancy ranking, which
means the records most likely to be relevant to your search string display at the
top of the results.

Descending Sort
Order Sorts the results in descending order instead of ascending order.

Related concepts
Quick Searches Good to Know
Use All Words/Any Words
About Quick Search
Quick Search Results
Related tasks
Configuring Search Defaults
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Quick Search Widget
Use the Quick Search Widget to search records for all Business Objects or records for a specific Business
Object. See Quick Searches Good to Know for additional details about this feature.

The Quick Search Widget is located in the top-right corner of the window. There are minor differences in
appearance and functionality between the Quick Search Widget in the CSM Desktop Client and the CSM
Browser Client.

CSM Browser Client Quick Search Widget

The CSM Browser Client Quick Search Widget displays the names of the Business Objects and a
magnifying glass icon to begin the search; whereas, the CSM Desktop Client Quick Search Widget
displays icons and names for the Business Objects and a Go button to begin the search.

CSM Desktop Client Quick Search Widget

The CSM Desktop Client Quick Search Widget displays icons and names for the Business Objects and a
Go button to begin the search; whereas, the CSM Browser Client Quick Search Widget displays names
without icons and a magnifying glass icon to begin the search.
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Using Quick Search
When working with Quick Search, Users can run a single-use query and view results according to their
Relevancy ranking, which means the records most likely to be relevant to your search string will display at
the top of the results. You can run a Quick Search against all records or against records for a specific
Business Object.
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Run a Quick Search Against a Specific Business
Object from the Quick Search Widget

Use the Quick Search Widget to find records relevant to a specific Business Object. See Quick Search
Good to Know for detailed information related to this feature.

To run a Quick Search against a specific Business Object from the Quick Search Widget:

1. In the Quick Search drop-down, select a specific Business Object to search (example: Incident).

2. In the text box, type or select a word or phrase to search for (example: Printing).

3. (Optional) Click the wrench icon to define additional options to refine the search: Changed, Open
records only, Relationships, Attachments, Sort By, etc.

4. Click the magnifying glass icon to run the search.

The Quick Search Results appear in a list or Grid.
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Run a Quick Search Against All Business Objects
in the Quick Search Widget

Use the Quick Search Widget to search records for all Business Objects. See Quick Search Good to
Know for detailed information related to this feature.

To run a Quick Search against all records using the Quick Search Widget:

1. In the Quick Search drop-down, select Quick Search.

2. In the text box, type or select a word or phrase to search for (example: Printing).

3. Click the magnifying glass icon to run the search.

The Quick Search Results appear in a list.
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Run a Quick Search from the Task Pane Quick
Search

Use the Quick Search in the Task Pane to find records relevant to a specific Business Object.

To run a Quick Search in the Task Pane:

1. Click the Search button, and then select a Business Object to search (example: Incident).

2. In the text box, type or select a word or phrase to search for (example: Printing)

3. (Optional) Click the ellipses icon to define additional options to refine the search: Changed, Open
records only, Relationships, Attachments, Sort By, etc.

4. Click the magnifying glass icon to run the search.

The Quick Search Results display in a list or Grid in the Main Pane.

Related concepts
Quick Search in the Task Pane
Quick Searches Good to Know
Quick Search Results
About Grids
CSM Desktop Client Main Pane
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Quick Search Results
When you run a Quick Search, the Search Results display based on All Words or Any Words logic
according to their Relevancy ranking, which means the records most likely to be relevant to your search
string display at the top of the results.

There is a Hierarchy of Default Settings for Search Results. The results can display in one of two views:

• Grid View

• List View

For more information, see Hierarchy of Default Settings for Search Results and About Grids.

Toggle between these two views by selecting View > Results in Grid.

To change the Sort Order:

When searching a specific Business Object (Example: Incident) in Quick Search Widget or Task Pane
Quick Search, the Sort by drop-down list defaults to Relevancy, but the User can change this selection
and/or select a specific column header in the Search Results grid to change the sort order. These manual
selections are only good for the current search session. When you start a new search session, the Sort
By - Relevancy default returns.

Note: If card view is enabled for a Business Object (in a Business Object's properties in CSM
Administrator), the search results for that object are displayed in a web-like list or as medium or
large cards. Toggle between Grid and Card View formats using the Results as Card View option
in the View menu.

Note: You can use the Navigation toolbar to Navigate Search Results. For more information, see
Navigate Search Results.

Related concepts
Using Quick Search
Use All Words/Any Words
Quick Search Widget
Quick Search in the Task Pane
Define Search Results Properties for a Business Object
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About Saved Searches
A saved search finds all records meeting commonly defined criteria (example: Find all My Open
Incidents). Saved searches are meant to be reused and can be accessed from multiple places in CSM.

Examples of saved searches include:

• All Incidents created within the past year.

• All open Requests.

• My open Incidents.

CSM provides several OOTB saved searches. Use these as-is, edit them, or create your own using the
Search Manager.
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Saved Searches Good to Know
Use these tips for helpful information on Saved Searches.

• Display Saved Search results as a list or in the Grid. Each provide additional information about the
results. The order of the results is based on relevance (default); however, you can customize the
sort option.

• Saved Searches behave a bit differently in the CSM Browser Client.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups).

Related concepts
CSM Browser Client
Users Security Rights
Searches Security Rights
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Using Saved Searches
Users can view and run Saved Searches.
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View a Saved Search
A Saved Search can be viewed several ways:

• Use the Search Manager (based on security rights) to view available Saved Searches.

• From an item that uses a Saved Search:
◦ One-Step Action

◦ Dashboard

◦ Query Builders

◦ Widget

◦ Report

Related concepts
About One-Step Actions
Dashboards
Query Builders
About Widgets
About Reporting
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Run a Saved Search
Use the Search Manager to run a Saved Search.

To run a Saved Search using the Search Manager:

1. Open the Search Manager.

2. Select a scope and subfolder (if needed).

3. If applicable, select a more filtered scope (example: A particular team). <Automatic> applies scope3.
based on login. If not applicable, this option is disabled.

4. Double-click the Saved Search.
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Create a Saved Search Using Only Child Object
Criteria

Using a saved search with only child Object criteria, you can create searches that find, for example, ANY
Change Request awaiting approval from yourself or ALL Change Requests awaiting approval.

To create a saved search for any Change Requests with Approvals waiting for your response:

1. Open the Search Manager.

2. Select the Create a New Search button .
The Stored Query window opens.

3. Select Change Request in the Search Type drop-down list.
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4. When you create a Stored Query, a new Comparison Clause appears, focused on the Change
Request Business Object. As you do not need to enter any Change Request criteria for this search,
select the Delete button to remove the Comparison Clause.
The Grouping Clause is left behind as shown below.

5. Select the New button and then select Related Clause from the drop-down list.
6. Select Change Request Owns Approvals from the Relationship drop-down list.
7. Select There is at least one Approval from the Contains drop-down list.
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8. To set the criteria for Approvals that are in Waiting status, select the New button and then select
Comparison Clause from the drop-down list.

9. Expand the Approval fields and select Status. Then complete the right-hand side of the Clause by
selecting Waiting from the drop-down list.
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10. To set the criteria for only Approvals awaiting your response, select the New button and then select
Comparison Clause from the drop-down list.

11. Expand the Approval fields and select Approver ID (NOT Approval ID). Then complete the right-
hand side of the Clause by expanding System Functions and selecting CurrentUserRecordID.
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Note: Approver ID and the System Function for CurrentUserRecordID were selected for this
criteria, or Comparison Clause. Approver Name and the System Function for
CurrentUserDisplayName will work too, but if your name changes, such as by marriage,
using your Record ID for the search will be more accurate.

12. Name your search and save it by selecting OK.
Now you can find ANY change request with a "waiting" approval for yourself.

Creating a search for all Change Requests awaiting Approvals

Creating a similar, and simpler search, can return ALL Change Requests with approval records awaiting
approval:
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Related concepts
Saved Search Results
Using Saved Searches
Managing Saved Searches
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Using Search Data with Third-Party Reporting
Tools

Use the Cherwell REST API to connect to third-party reporting tools to retrieve data from CSM.

Use the Data Connector to pull data from a Saved Search. CSM can connect to:

• Microsoft Power BI Desktop (version 2.84.701.0, August 2020).•

For more information, see Using Power BI and the Data Connector.

• Tableau Desktop (version 2018.3).•

For more information, see Using Tableau and the Web Data Connector.

You can use these products to visualize the data in different ways (reports, dashboards, charts, or
graphs).

Configuring Saved Search and Grid Options
You can make modifications to Saved Searches and Grids that affect how the results of a Saved Search
are displayed in third-party reporting tools. For more information, see:

• Change the Sort Order of a Saved Search

• Grid Options for Third-Party Reporting Tools

Note:
To implement the updated sort order for a Saved Search and refresh the displayed results in a
third-party reporting tool, use the refresh/run update command.

If the Saved Search and Grid modifications are not displayed in the third-party reporting tool, wait
a few seconds and try again.

For information on modifying Grids for a specific third-party reporting tool, see:

• Using Grids with Power BI

• Using Grids with Tableau

Configuring the Cherwell REST API

1. In CSM Administrator, create a new API Client ID to automatically generate a Client Key. For more1.
information, see Obtaining API Client IDs.

The Client Key is used to generate an access token for the REST API. You can also use an existing
Client ID.

You must copy the Client Key to be used as the Client ID when launching a third-party tool.
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2. The base URL for the REST API is populated when you install CSM. If you need to edit it, use2.
Cherwell Server Manager. For more information, see Set the Base URL for the Cherwell REST API.

Note: You cannot generate URLs for Saved Searches from the Search Manager until you
complete this step.

3. Distribute the Client Key and base URL to CSM users who use a third-party reporting tool.

Related concepts
Set the Base URL for the Cherwell REST API
API URL for a Saved Search
Related tasks
Obtaining API Client IDs
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Using Power BI and the Data Connector
You can connect the Power BI® third-party reporting tool to the Cherwell REST API and retrieve data from
CSM using the Power BI Data Connector from Cherwell.

For detailed information on installing and using the Microsoft® Power BI third-party tool, see the Microsoft
documentation at https://docs.microsoft.com/en-us/power-bi/ .

Connecting Power BI and the Data Connector

Important: We recommend you install the August 2020 version (2.84.701.0) of Microsoft Power
BI Desktop and use the included Microsoft certified Cherwell Power BI Data Connector. For more
information, see Using Search Data with Third-Party Reporting Tools.

Alternatively, you can obtain and install the Cherwell Power BI Data Connector via either the CSM
Desktop Client or CSM Browser Client.

Note: Installing the connector from CSM may be useful if you are using a different version of
Power BI that does not include the Cherwell Power BI Data Connector. However, installing the
connector manually means it is not Microsoft certified. Consequently, some additional steps are
required.

To install the connector into Power BI from CSM:

1. Open Power BI Desktop.

2. Select Security, and then under Data Extensions select the Allow any extension to load without
validation or warning option.

3. Close Power BI Desktop and perform one of the following:
◦ From the CSM Desktop Client menu bar, select Searching > Install PowerBI Data◦

Connector. This copies the .mez file (the file type for the Power BI Data Connector) into the
correct folder so it can be used without further configuration.

◦ From the CSM Browser Client menu bar, select Searches > Download PowerBI Data
Connector.
This only downloads the file to the user's machine. You must copy and add this file to the local
path ([Documents]\Power BI Desktop\Custom Connectors) before it is recognized by Power
BI.

You must restart Power BI after this step.

For more information on connector extensibility, see https://docs.microsoft.com/en-us/power-
bi/desktop-connector-extensibility/.

Warning: If you install the Power BI Data Connector from the CSM Desktop Client, any old
connectors associated with CSM are automatically removed. We recommend backing up any old
connectors associated with CSM before completing this step.
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Note: When copied, the .mez file includes "Cherwell" in its file name and, in Power BI, displays a
Cherwell icon to indicate its association with CSM.

Using Power BI and the Data Connector

1. Open Power BI.

2. From the main toolbar, select Get Data > More.

3. Select the Other category, then select the Cherwell Data Connector.

4. Select Connect.4.

The Cherwell pop-up dialog is displayed.

5. Enter the API URL.5.

You can obtain this from the REST API Base URL setting in CSM Administrator. For more
information, see Set the Base URL for the Cherwell REST API.

Note: Only HTTPS API URLs are accepted. Accordingly, you must enable HTTPS for your
Cherwell REST API.

6. Enter a Client ID. For more information, see Obtaining API Client IDs.6.

This is the Client Key. For more information, see Configuring the Cherwell REST API.

7. (Optional) Enter a Locale. For information on using locales, see Using Locales with Power BI .

8. (Optional) Enter a Saved Search URL. For information on using Saved Searches, see Using Saved8.
Searches with Power BI.

9. Select OK.

10. (Optional) If prompted to sign in, select Sign in, and enter your CSM username and password.
Alternatively, if SAML is enabled, enter your SAML credentials. Select Login.

11. Select Connect.

In the Cherwell pop-up dialog, if you:
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• Did not enter a Saved Search URL, data is returned and displayed in a Navigation Table. For more
information, see Using Navigation Tables in Power BI.

• Entered a Saved Search URL, data is returned and displayed using the default Grid for the•
Business Object. You can create tables to view the data.

Warning: For the best experience (improved data formatting and transfer), we recommend only
entering an API URL and not a Saved Search URL.

Sharing Cherwell Reports/Dashboards via Power BI
You can share Cherwell Reports and Dashboards via the Microsoft Power BI cloud service. This lets
users access live versions of the Reports and Dashboards containing regularly refreshed and up-to-date
information (as opposed to information relevant at the time of publishing).

To share Cherwell Reports and Dashboards via the Power BI cloud service you must:

• Have Power BI Desktop installed (for information, see https://powerbi.microsoft.com/en-us/
desktop/).

• Have a Power BI service account (you can create one at https://powerbi.microsoft.com/en-us/).

After completing the above setup steps, you must complete the following tasks in order:

1. Install and set up an on-premises data gateway.

2. Create and publish a Power BI report.

3. Configure the dataset in Power BI.

4. Configure the scheduled refresh settings.

For more information, see below.

Step 1: Install and set up an on-premises gateway

Note: This step is only required if your CSM instance is hosted on-premises and the Cherwell
REST API is not accessible from the public internet.

For the Power BI service to refresh data from the custom connector, you must install an on-premises data
gateway on a machine reachable by the Power BI remote services. For information, see https://
powerbi.microsoft.com/en-us/gateway/.

When you have installed the on-premises data gateway, complete the remaining steps below.

Step 2: Create and publish a Power BI report

1. Complete the steps in Using Power BI and the Data Connector.

2. Publish the report (for more information, see https://docs.microsoft.com/en-us/power-bi/desktop-2.
upload-desktop-files/).

Step 3: Configure the dataset in Power BI
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1. Log in to the Power BI online dashboard at https://app.powerbi.com/.

2. Using your workspace, open your datasets. For more information, see https://2.
docs.microsoft.com/en-us/power-bi/service-datasets-across-workspaces/.

Your datasets are displayed.

3. Open the settings for the relevant dataset.

4. Ensure the gateway connection you previously set up is registered and running. For more
information, see https://powerbi.microsoft.com/en-us/gateway/.

5. Check the data source credentials.5.

Note: If the data source cannot be refreshed owing to invalid credentials, a message is
displayed asking you to update your credentials. If necessary, edit your credentials and sign
in to begin the OAuth login process with the Cherwell REST API. Log in using your CSM
credentials. Alternatively, if SAML is enabled, enter your SAML credentials.

6. To ensure the data source is set up correctly, perform a manual refresh of the report (for more6.
information, see https://docs.microsoft.com/en-us/power-bi/refresh-data/).

Step 4: Configure the scheduled refresh settings
In the Power BI online dashboard, set and apply the appropriate scheduled refresh options. For more
information, see https://docs.microsoft.com/en-us/power-bi/refresh-scheduled-refresh/.

When a scheduled refresh happens, a message is displayed in the dataset settings. You can view a
history of in progress and completed scheduled refreshes.

To avoid authentication issues in Power BI, see Authentication in Power BI .

Note:

• Scheduled refreshes are limited to a minimum of 30 minute intervals. For example, you can
schedule two refreshes for 4:00pm and 4:30pm, but not 4:15pm.

• We recommend you configure two daily schedules at different times of day. This means the•
refresh token will never be more than 1440 mins (24 hours) old before it is replaced.

For security reasons, the maximum scheduled refresh token lifespan for Cherwell REST API
client IDs in CSM is 1440 minutes (24 hours). This is also the default setting.

Power BI lets you schedule refreshes either daily or weekly. Consequently, if you configure a
weekly scheduled refresh, authentication will fail a week later owing to the refresh token
having expired.

Furthermore, Microsoft’s daily scheduled refresh option doesn’t run at an exact time. For
example, a daily scheduled refresh for 6:00 AM might run at 6:03 AM one day and 6:05 AM
the next. Accordingly, even daily scheduled refreshes might encounter issues if the token
expires after exactly 24 hours. Using two daily scheduled refreshes at appropriately different
times should prevent this.
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Using Navigation Tables in Power BI
When configuring the Power BI data connector, in the Cherwell pop-up dialog, if you did not enter a
Saved Search URL, on connecting, data is returned and displayed in a Power BI Navigation Table.

For more information on using Power BI Navigation Tables, see https://docs.microsoft.com/en-us/power-
query/handlingnavigationtables/.

Grids displayed in the Navigation Table are those applicable to the parent association (displayed in
parentheses). There is also a default Grid option (displayed without parentheses).

Grids are maintained in CSM Administrator. For more information, see Grids.

Warning: In a Navigation Table, although you can select check boxes for multiple Grids, only the
most recently selected Grid is displayed in the preview in Power BI.

Using Locales with Power BI
When configuring the Power BI data connector, you can set locales to translate data into different
languages. For example:

You could set the Locale to "de-DE" to translate data into German, or "fr-FR" to translate data into
French, for example.

Note:

• The entered locale must relate to a culture enabled within your CSM instance.

• In Power BI Desktop, you can set a locale. For more information, see https://•
docs.microsoft.com/en-us/power-bi/supported-languages-countries-regions/.

The locales specified in both the Cherwell pop-up dialog and Power BI Desktop must match.
This also applies for any defaults set in Power BI Desktop.

If locales in the Cherwell pop-up dialog and Power BI Desktop do not match, Power BI may
interpret dates incorrectly owing to mismatched localized date formatting.
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On completing the necessary details in the Cherwell pop-up dialog, select OK.

Note:
You may be asked to sign into your organizational account.

Owing to limitations in the Power BI third-party reporting tool, it is not possible to localize the
resulting Cherwell Service Management sign in dialog. Consequently, this sign in dialog is always
displayed in your CSM instance's default language.

On connecting, any data or tables are loaded and displayed in the language relevant to the locale.

Using Saved Searches with Power BI
When configuring the Power BI data connector, you can quickly access required data in the correct format
by using Saved Searches (for more information, see About Saved Searches) and Grids (for more
information, see Grids). For example:

Warning: For the best experience (improved data formatting and transfer), we recommend only
entering an API URL and not a Saved Search URL. You can then select a Saved Search (and a
result Grid to use) from the displayed Navigation Table. For more information on using the Power
BI Navigation Table, see Using Power BI and the Data Connector.

Copy the URL for a Saved Search (for more information, see API URL for a Saved Search). You can then
paste the copied URL into the Saved Search URL field in the Cherwell pop-up dialog.

On completing the necessary details in the Cherwell pop-up dialog, select OK.

Note:

• Only HTTPS Saved Search URLs are accepted. Accordingly, you must enable HTTPS for
your Cherwell REST API.

• You may be asked to sign into your organizational account.•
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Owing to limitations in the Power BI third-party reporting tool, it is not possible to localize the
resulting Cherwell Service Management sign in dialog. Consequently, this sign in dialog is
always displayed in your CSM instance's default language.

On connecting, the Saved Search data is loaded into Power BI and displayed using the default Grid for
the Business Object. You can create tables to view the data, and build reports.

A Power BI Navigation Table is not displayed for Saved Searches. Consequently, we recommend only
entering an API URL in the Cherwell pop-up dialog and using the Power BI Navigation Table. For more
information, see Using Power BI and the Data Connector.

To avoid authentication issues in Power BI, see Using Power BI and the Data Connector.

Using Grids with Power BI
When using the Power BI third-party reporting tool with the Cherwell REST API you can use a Grid to
display details returned by a Saved Search. You can modify the Grid to specify column selection. For
more information, see Grid Options for Third-Party Reporting Tools.

When using the Power BI Data Connector from Cherwell with a Navigation Table (for more information,
see Using Power BI and the Data Connector), you can:

• Create a new Grid (recommended). For more information, see Managing Business Object Grids.

• Personalize an existing Grid (including the default Grid for a Business Object). For more information,
see Grid Persistence.

We recommend you create a new Grid to use with Saved Searches when using Navigation Tables in the
Power BI third-party reporting tool. This lets you select and order Grid columns in a way that applies
across multiple CSM user accounts. This preferred method adheres with our recommended approach for
managing authentication. For more information, see Using Power BI and the Data Connector.

Note:
You can optionally use Saved Searches with the Power BI Data Connector from Cherwell and
modify the default Grid for the relevant Business Object. For more information, see Grid Options
for Third-Party Reporting Tools.

Authentication in Power BI
Due to licensing limitations and to avoid unexpected authentication failures, we recommend you use
separate and unique CSM user accounts when you:

• Author/publish reports.

• Set credentials within the Power BI Online service.

When the Power BI environment executes a scheduled refresh (for more information, see Sharing
Cherwell Reports/Dashboards via Power BI) it makes a request to the Cherwell REST API to refresh the
authentication token it previously received when initially setting up the data source credentials within the
Power BI online service.
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Problems occur if you use the same CSM user account to set up credentials for a data source in the
Power BI online service and subsequently log in to the Cherwell REST API from another location
(example: creating another report in Power BI).

Under these circumstances, the refresh token state associated with the authentication flow present within
the Power BI Service for that CSM user account is invalidated. The scheduled refresh fails with a 400-
based network error containing details related to an OAuth failure.

Note: Because this approach is not specific to a single CSM user account, we recommend
creating a new custom Grid as the preferred method of configuring Grid column selection. For
more information, see Using Grids with Power BI .
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Using Tableau and the Web Data Connector
You can connect the Tableau third-party reporting tool to the Cherwell REST API and retrieve data from
CSM using the Tableau Data Connector from Cherwell.

You must have Tableau installed. For complete details on installation, see the Tableau website (https://
www.tableau.com/support/help/).

Using Tableau and the Web Data Connector

1. Open Tableau.

2. On the main toolbar, select To a Server > More > Web Data Connector.
3. Specify the path to the Cherwell Tableau Web Data Connector, which is available on your Cherwell

REST API server (https://[servername]/CherwellAPI/DataConnector/Tableau).

4. Press Enter on your keyboard.

5. Enter your CSM username and password.

6. Enter the Client ID (API key: this is the Client Key. For more information, see Configuring the6.
Cherwell REST API) and the target search URL.

7. Select Authenticate.

Using Grids with Tableau
When using the Tableau third-party reporting tool with the Cherwell REST API you can use a Grid to
display details returned by a Saved Search. You can modify the Grid to specify the sort order and column
selection.

For the Tableau Data Connector from Cherwell, it is only possible to modify and use the default Grid for
the relevant Business Object. For more information, see Grid Options for Third-Party Reporting Tools.
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API URL for a Saved Search
The REST API URL for a Saved Search can be used with third-party reporting tools.

You can generate URLs for Saved Searches from the Search Manager in the CSM Desktop Client and
the CSM Browser Client.

The API URL for a Saved Search can be copied/created in the following ways:

• In the CSM Desktop Client, open the Search Manager. Select a Saved Search. Right-click and
select Copy API URL to clipboard. From the Search Manager toolbar, you can also select
Searches > Copy API URL to clipboard.

• In the CSM Browser Client, open the Search Manager. Select a Saved Search and select the Copy

API URL to clipboard icon  .

• In CSM Administrator, in the Blueprint Editor, select Managers > Searches. Select a Saved Search.
Right-click and select Copy API URL to clipboard.

• You can manually create the API URL by using one of the following formats:
◦ For Global searches:

https://[Cherwell REST API server]/api/V2/storedsearches/Global/[associated Business Object
name]/[Search name]

◦ For searches in other scopes:

https://[Cherwell REST API server]/api/V2/storedsearches/[scope name] (Example: User)/
[associated Business Object name]/[Search name]/?scopeOwner=[GUID for owning identity]
(Example: the GUID for the User that created the search when scope is User)

Related concepts
Using Search Data with Third-Party Reporting Tools
Open the Search Manager
Set the Base URL for the Cherwell REST API
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Guidelines for Using Third-Party Reporting Tools
What follows is useful information, recommendations, and guidelines for using third-party reporting tools
with the Cherwell REST API.

The time it takes for the Cherwell REST API to respond to the data requested from a third-party reporting
tool depends on a number of factors, including the:

• Complexity of the defined search parameters for the selected Saved Search.

• Number of visible columns being returned for each result record.

• Number of result records being returned.

Complex searches with many fields returned for many records may take some time to execute/return all
results to the third-party reporting tool. In extreme cases, the search data retrieval may timeout if either
the third-party reporting tool or the server are configured with timeouts that are shorter than the time
required to execute the search.

Cherwell recommends that you configure search results to only show the minimum fields needed in the
third-party reporting tool, especially when working with complex searches or any searches that are likely
to return a large number of records.

Note:

• Third-party reporting queries are executed against the CSM database. Running multiple
complex queries simultaneously could cause performance issues and delay the response of
CSM applications.

• The Cherwell REST API endpoint used for third-party reporting Saved Searches has a rate
limiting. This is to manage load on the server. If the same Client makes too many requests in
a short period of time, you may encounter Error Code 429 (Too Many Requests). If this
occurs, wait until your existing requests are complete before making additional data
requests.

Related concepts
Open the Search Manager
Search in the CSM Browser Client
Run a Saved Search
Using Search Data with Third-Party Reporting Tools
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Grid Options for Third-Party Reporting Tools
When using third-party reporting tools with the Cherwell REST API you can use a Grid to display details
returned by a Saved Search. You can modify the Grid to specify column selection.

Warning:

In third-party reporting tools and CSM, Grid settings are specific to the logged in CSM user. For
more information, see Grid Persistence.

Cherwell recommends you have a dedicated CSM user account for each third-party reporting tool
(switching CSM user accounts also switches Grid settings).

Customizing Grid Columns for Saved Searches

Note: If you are using the Power BI data connector, for Cherwell's recommended method for
customizing column selections, see Using Grids with Power BI .

The columns in the third-party reporting tools are the same columns displayed in CSM Desktop Client and
CSM Browser Client when running the same Saved Search for the same CSM user account.

In CSM, you can customize which columns are displayed and the column order on a per user basis. The
per user customizations are used in the third-party reporting tool after refreshing the data.

You can customize columns in both CSM Desktop Client and CSM Browser Client.

Note:
The customizations you make to the columns are stored for the logged in CSM user, using the
default Grid for the Business Object with which the Saved Search is associated.

When logged in to CSM Desktop Client and CSM Browser Client with the same CSM user
account, all views using the default Grid for the Business Object display the customizations.

For example, if you customize the columns for an Incident search (example: All Closed Incidents),
other Saved Searches associated with Incident (example: All Assigned Incidents) and other views
that use the default Incident Grid will also show the customizations.

To customize the grid columns:

1. Open the Search Manager.

2. Run a Saved Search.

3. To view the results in Grid format, in:
◦ CSM Desktop Client, select View > Results in Grid.

◦ CSM Browser Client, select Show Results Grid.

4. To add or remove Grid columns, in:
◦ CSM Desktop Client, right-click the Grid header and select Customize Columns.
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◦ CSM Browser Client, from the Grid menu bar, select Columns and use the Column Selector.

5. To change the order of the columns, move the column header to a new location in the Grid.

6. To close the Search Results and save the Grid customization, select Home.

If you have already pulled the Saved Search into a third-party reporting tool before amending the
displayed columns, to ensure the updated columns are displayed, complete the steps for the relevant
third-party reporting tool below.

Power BI

1. To delete the 'Expanded Column1' entry within the Applied Steps section (right-hand side), select
the X.

2. On the main toolbar, select Refresh Preview.

3. To see the data similar to how it is now displayed in CSM, expand the record column.

Tableau

1. Select Data > New Data Source and create a new data source connection, which will contain
updated data.

2. Import data using the Web Data Connector feature. For more information, see Using Tableau and2.
the Web Data Connector.

After authenticating and executing the query, a data schema is built in Tableau. If data types are
incorrect, you can correct them now.

3. To import the data into Tableau, select Update Now. You can arrange the data as needed.

The new columns are displayed in the third-party reporting tool.

Note:
If the new columns are not displayed, wait a few seconds and try again.

If the new columns are still not displayed, verify that you used the same CSM user account to
configure the columns as you used when configuring the connection to the Data Connector.

CSM 2022.3 Features 1506

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=using_tableau_and_web_data_connector
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=using_tableau_and_web_data_connector


Saved Search Results
When you run a Saved Search, the results appear in the CSM Desktop Client Grid format or in card view
format (if enabled for the Business Object) in the CSM Desktop Client Main Pane.

Notice that the results provide additional information regarding the record. While most Grids can be
customized, the following list provides examples of information that can be included:

• Type: Incident, Problem, Service, etc.

• ID Number: Identification number associated with the record

• Customer Name

• Created Date Time: Date and time of creation

• Status: New, Closed, etc.

• Description: Brief explanation provided by the creator of the record

• Resolve By: Resolution due date and time.

Note: To customize the items displayed in search results: 1) Open CSM Administrator 2)
Create a Blueprint 3) Open the Business Object Editor 4) Navigate to the Search Results
page. The "Link text" section defines the first line of the search results. The "Body text"
section defines the list of fields that make up the remaining lines. The "Includes label" box
should be checked if the field name is displayed along with the value.

Card view can also be enabled on the Search Results page for a Business Object to display search
results in a web-like list or as medium or large cards.

To view a specific record in the Grid, click the link associated with any column of the search result you
want to view.

To view a specific record in card view, select an item from the results list or the title link in a card.

The record opens in the CSM Desktop Client Main Pane.

Note: For information on navigating Search Results, see Navigate Search Results.
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Navigate Search Results
Use the Navigation toolbar to navigate between Search Results. The toolbar becomes active after you run
a search and it can be moved/docked based on your specific needs. By default, the Navigation toolbar is
located on the CSM Desktop Client toolbar:

Note: If the Navigation toolbar is not visible, right-click anywhere in the CSM Desktop Client
toolbar section and select Navigation toolbar in the drop-down.

The Navigation toolbar includes the following buttons:

Action Description

Show results Displays the list or Grid of records that were found.

Show current record Displays the currently selected record.

Go to first record Jumps to the first record in set.

Go to previous record Jumps to the previous record in set.

Got to next record Jumps to the next record in set.

Go to last record Jumps to the final record in set.

Card view results have some additional options available:

• Page navigation: Navigate between pages of results (next/previous or by page number).

• Sorting: Sort results based on Business Object fields in ascending or descending order.

• Card Size: Select an option to change the card view (results list view, medium cards, or large cards).

• Execute Actions: Select and run an Action that was defined for the Business Object. In the Desktop
Client, Actions are available in a context menu when you right-click a card. In the Browser Client
and Portal, Actions are available by clicking the ellipses button on a card.

Note: In the Browser Client and Portal, any images or grouping defined for Actions are not
supported in card view.
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Managing Saved Searches
Saved Searches are managed using the Search Manager.

There are several ways to open the Search Manager.

Use the Search Manager to complete general CSM Item Manager operations for Saved Searches,
including:

• View a Saved Search

• Run a Saved Search

• Create a Saved Search

• Edit a Saved Search

• Delete a Saved Search

• Search for a Saved Search

• Copy a Saved Search

• Organize Saved Searches

• Import/export a Saved Search

• Find Saved Search dependencies
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• Pin a Saved Search

For more information, see Using CSM Item Managers.

Related concepts
Open the Search Manager
CSM Item Manager Main Window (Typical)
Using Saved Searches
Create a Saved Search
Using CSM Item Managers
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Open the Search Manager
Open the Search Manager from the CSM Desktop Client.

To open the Search Manager:

• In the CSM Desktop Client menu bar, select Searching > Search Manager.
• In the CSM Browser Client menu bar, select Searches > Search Manager.
• In the CSM Desktop Client menu bar, select Searching and select a Saved Search from the drop-

down list.

• In the CSM Desktop Client toolbar, right-click and select Customize > Add > Add Action > Add
Search Action.
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Create a Saved Search
Use the Stored Query window (accessed from within the Search Manager) to create a Saved Search.
When you define a Saved Search, you define:

• General properties: Name, description, and Business Object to search.

• Clause.

Good to know:

• A Comparison Clause is typically selected by default. To define a different type of clause, click the
Delete button to remove the Comparison Clause.

To create a Saved Search:

1. Open the Search Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button.

The Stored Query window opens.

4. Define the general properties for the Saved Search:
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

c. Select the Business Object you want to search.

5. Click the New button, and then select the type of Clause you want to create:
◦ Comparison Clause: A Comparison Clause is a Query Clause that finds all records

containing a field with a particular value.

◦ Grouping Clause: A Group Clause is a Query Clause that groups together several Clauses.
When you group Clauses you must decide if all Clauses must be true (AND logic), or if only
one Clause must be true (OR logic), in order to retrieve the record.

◦ Ownership Clause: An Ownership Clause is a Query Clause that finds records associated
with a particular owner (person or Team).

◦ Related Clause: A Related Clause is a Query Clause that finds Business Objects whose
related Business Object satisfy some of the criteria.

◦ Queue Clause: A Queue Clause is a clause that finds all records that exist or do not exist on
Queues. It also finds records that are available, checked out, and suspended on Queues.

6. Add additional clauses to refine your search (optional).
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Note: If you are using the Stored Query Builder, there is an Options button that allows you
to define additional options, including availability and icon image.

Results open in the Grid format in the CSM Desktop Client Main Pane.
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Change the Sort Order of a Saved Search
You can change sort order or results returned by a Saved Search in CSM.

To change the sort order of a Saved Search:

1. In either CSM Desktop Client or CSM Browser Client, open the Search Manager (for more
information, see Open the Search Manager).

2. Right-click a Saved Search and in:
◦ CSM Desktop Client, select Edit.
◦ CSM Browser Client, select the Edit icon.

3. Under the Sort results by drop-down list, select a new sort option.

4. To save the new sort order, select OK.

The new sort order is used.

Note:

Saved Searches are also used in third-party reporting tools. For more information, see Using
Search Data with Third-Party Reporting Tools.

To implement the updated sort order for a Saved Search and refresh the displayed results in a
third-party reporting tool, you must use the refresh/run update command.
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Configuring Search Defaults
Search defaults for Quick Search, Saved Searches, and Solution Search are set in multiple locations in
CSM.

In CSM Administrator, Administrators can configure global search settings, security rights, search widget,
search results lists, All Words/Any Words default, Business Objects and Fields appearing in search
results. In the CSM Desktop Client and CSM Web Applications, users can configure individual search
default preferences. There is a hierarchy of default search results. For more information, see Hierarchy of
Default Settings for Search Results.

To configure search defaults for Quick Search and Saved Searches in CSM Administrator:

• Configure Global Search Settings

• Configure Searches Security Rights

• Configure a Search Widget

• Customizing Search Results Lists

• Hiding the All Words/Any Words Search Option

To enable Business Objects and related Fields in CSM Administrator to appear in Quick Search
Relevancy results:

1. Open CSM Administrator.

2. Create a Blueprint.

3. Select the Business Object you want to enable for Quick Search Relevancy results.

4. Edit the Business Object.

5. Select Bus Ob Properties.

6. Select the Search Results page and select the Show in Quick Search check box. This option
must be selected (enabled) for the Business Object to appear in Quick Search Relevancy results.

7. Select OK to return to the screen displaying the fields for the Business Object.

8. Select the Field you want to enable for Quick Search Relevancy results and select Field
Properties.

9. Select the Include in Full Text Search check box. This option must be selected for the Field to
appear in Quick Search Relevancy results.

10. Repeat for each Business Object and related Field(s) you want to enable (or disable) for Quick
Search Relevancy.

11. Save and Publish the Blueprint.

You can configure your individual search default preferences in CSM Desktop Client and CSM Web
Applications. For more information, see Configure User Task Pane and Search Control Settings.

To configure Solution Search, see Configure Solution Search Workflow.

Related concepts
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Configure Global Search Settings
Searches Security Rights
Create a Search Widget
Related tasks
Customizing Search Results Lists
Hiding the All Words/Any Words Search Option
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Customizing Search Results Lists
To customize the items displayed in Search Results when a list is shown:

1. Open CSM Administrator.
2. Create a Blueprint.
3. Select a Business Object from the Object Manager, and then select Edit Business Object.
4. Select Bus Ob Properties, and then navigate to the Search Results page.
5. Set Link Text or Body Text options as they apply:

◦ "Link text" section defines the first line of the Search Results.
◦ The "Body text" section defines the list of Fields that make up the remaining lines.
◦ The Includes label check box should be selected if the Field name is displayed along with the

value.

For more information, see Define Search Results Properties for a Business Object.
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Hiding the All Words/Any Words Search Option
You can hide the All Words/Any Words toolbar buttons for all Users in a security group.
To remove the All Words/Any Words toolbar buttons:

1. Open CSM Administrator.
2. Click the Security category.
3. Select Edit Security Groups.
4. Select the Rights tab.
5. Select Searches from the Category drop-down.
6. Select the Change Full-Text Search Options item.
7. Clear the Allow check box.
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Stored Values
A Stored Value is a named entity that stores commonly used information so it can be accessed and/or reused
from various places in CSM, such as One-Step™ Actions and Queries.
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About Stored Values
Use a stored value to store information, such as:

• Organization name

• Organization image

• Email addresses

• Email signatures

• Values to toggle on/off integrations (example: Twitter)

• Alert colors

For example, use a stored value to:

• Store an organization name and image and put them on dashboards, forms, and Portal Sites for a
cohesive branding look. Changes you make to the stored values affect all instances in the system.

• Designate the current system as Development or Production. If the system is in a development
environment, you can set the Current System Stored Value to DEV so that emails are sent to test
email accounts rather than to customers. When you are ready to transition the system to a live
environment, set the stored value to Production.

Note: Addresses for email senders and recipients are also set by stored values. See
Configure Test and Production Accounts for detailed procedures about setting these stored
values and transitioning the system.

A stored value can be:

• Text or images
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• Numbers

• Dates/times

• Logical (true/false or on/off)

• Color

Stored values can be used in/on a:

• Query In Comparison Clauses as values to search for in a specified field.

• One-Step Action: In Actions where users can specify values to use in Business Object fields, email
messages, Tweets, temporary filenames, command-line arguments, and URLs.

• Expression: To set values in comparison clauses.

• Dashboard: To set images for widgets.

• Business Object: To set field values and properties and to auto-populate fields.

• Automation Process: To limit records.

• Approvals As values to use in set field actions.

• Constraints: As values to limit what a users sees or can select from in a field, Related Item Selector,
tab in a form arrangement, or prompt).

CSM provides several OOTB stored values to help get you started. Use these as-is, edit them, or create
your own using the Stored Value Manager.

CSM 2022.3 Features 1521

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fsearching%2Fsearch_queries.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fsearching%2Fdefine_a_comparison_clause.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fone-steps%2Fabout_one-steps.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fone-steps%2Fdefine_actions_for_a_one-step.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fexpressions%2Fabout_expressions.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fdashboards%2Fabout_dashboards.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fbusiness_objects%2Fabout_business_objects.html
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=about_automation_processes
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fapprovals%2Fabout_approvals.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fstored_values%2F..%2Fapprovals%2Fdefine_approval_block_action_properties.html


Stored Values Good to Know
Use these tips for helpful information on stored values.

• When creating a stored value or assigning a value to an existing stored value, users can make its
value user-specific. For more information, see Create a Stored Value or Assign a Value to a Stored
Value.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For detailed information, see
Security rights and Configure Stored Value Security Rights.

• In a localized system, Stored Values are language-specific. If you change the value of a stored•
value in the EN Culture, it is not automatically modified in other cultures. Manually update them for
each language.

Alternatively, you can turn off localization for the stored value (Right-Click > Localization > Do not
allow localization). This is also an option for One-Step Actions and expressions.
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Using Stored Values
When working with Stored Values, Users can:

• View a Stored Value.

• Assign values to Stored Values for use in:
◦ Queries: In Comparison Clauses as values to search for in a specified Field.

◦ One-Step Actions: In Actions where Users can specify values to use in Business Object
Fields, e-mail messages, Tweets, temporary filenames, command-line arguments, URLs, etc.

◦ Expressions: To set values in Comparison Clauses.

◦ Dashboards: To set images for Widgets.

◦ Business Objects: To set Field values and properties and to auto-populate Fields.

◦ Automation Processes: To limit records.

◦ Approvals: As values to use in set Field Actions.

◦ Constraints: As values to limit what a Users sees or can select from in a Field, Related Item
Picker, tab in a Form Arrangement, or Prompt.
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View a Stored Value
To view a Stored Value:

• Use the Stored Value Manager to view available Stored Values (based on security rights).

• From a Query, One-Step Action, Expression, etc. that uses Stored Values.

• From the Token Selector.
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Assign a Value to a Stored Value
Use the Stored Value Manager to assign values to Stored Values. The assigned values become the
default values, and are stored so that they can be accessed and reused from various places in CSM.

To assign a value to a Stored Value:

1. Open the Stored Value Manager.

2. Select a Stored Value from a scope (and subfolder, if applicable), and then select Edit.
3. Assign a value to the Stored Value. A Stored Value can be:

◦ Text (or images)
◦ Number
◦ Date/Time
◦ Logical (True/False)
◦ Color

◦ Note: If you are assigning a value to a default Stored Value, Users might need to◦
assign a specific value (this will be stated in the description). See Configuring Stored
Values for more information.

4. (Optional) Select the Value is User-Specific radio button to make the value User-specific. This
means that each User who uses this Stored Value can have a version of the Stored Value, and
update the value to something that is unique to them (using the Update a Variable or Stored Value
Action in a One-Step Action) rather than using the default value.

Note: If you select this radio button without also selecting Remember the User-Specific
Values Between Sessions, any User-specific values are only available for use during a
User's current CSM session. The Stored Value returns to its default value after Users log out
or close their sessions.

5. Select the Remember the User-Specific Value Between Sessions check box to store any User-
specific values so they are available next time Users log in to CSM.

6. Select Save.6.
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Managing Stored Values
Stored Values are managed using the Stored Value Manager.

There are many ways to open the Stored Value Manager.

Use the Stored Value Manager to complete general CSM Item Manager operations for Stored Values,
including:

• View a Stored Value.

• Create a Stored Value.

• Edit a Stored Value.

• Delete a Stored Value.

• Search for a Stored Value.

• Organize a Stored Value.

• Copy a Stored Value.

• Import/export a Stored Value.

• Find Stored Value dependencies.

• Pin a Stored Value.
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Open the Stored Value Manager
Open the Stored Value Manager from CSM Administrator or the CSM Desktop Client.

There are several ways to open the Stored Value Manager:

• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > Stored Values.
For more information, see Blueprint Editor Menu Bar or mApp Editor Menu Bar.

• In an Update a Variable or Stored Value One-Step™ Action, select the ellipsis next to the Stored
Value field. For more information, see Define an Update Variables or Stored Values Action.

• In the Token Selector (available in Query Builders, One-Step Actions, and Expressions), select
Stored Values > Browse. For more information, see Query Builders.

• In the Dashboard Editor, when adding a Stored Value to a Widget Image or an Expression:
◦ Widget Image: Select an image or a Widget, and then select the arrow next to the Image

Selector button (on the Dashboard Editor toolbar) and select From Stored Value.

◦ Expression: In the Token Selector, select Stored Values > Browse.

For more information, see Dashboard Editor and Dashboard Editor toolbar.
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Create a Stored Value
Use the Stored Value window (accessed from within the Stored Value Manager) to create stored values.

When you create a stored value, you define:

• General properties: Name and description.

• Type: Text, Number, Date/Time, Logical, or Color.

• Value: Default value for the stored value.

• Value is user-specific: Options for making the value user-specific.

• Value is protected (excluded from export and mApps): Control whether the value will be
exported or used in mApp® Solutions.

• Advanced options: Availability (scope), association (more filtered scope, if applicable), and image.

To create a stored value:

1. Open the Stored Value Manager.

2. Select a scope and subfolder (if needed).

3. Select Create New .

4. Define general properties:
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

5. Define the Stored Value type and value:
a. Type: In the drop-down list, select the type of stored value (example: Text, Number, Date/

Time, Logical, or Color).

b. Value: Define the value for the stored value based on the type selected:
◦ Text: Provide a word or phrase to use as the value.

◦ Number: Specify a number or use the up/down arrows to increase or decrease the value
by whole numbers.

◦ Date/Time: Select a date (MM/DD/YYYY) and time (HH:MM:SS) by selecting the Date
button . Then, select the time (hours, minutes, or seconds) and use the up/down
arrows to increase or decrease the time.

Tip: Users can also provide numbers to the date/time fields. Select the month, day, or
year in the date field, or the hours, minutes, or seconds in the Time field and type a
number.

◦ Logical: In the drop-down list, select True or False.
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◦ Color: Select Color Selector  to select a color.

6. (Optional) Define whether to make the value user-specific. This means that each user who uses this
stored value can have a "version" of the stored value, and update the value to something that is
unique to them (using the Update a Variable or Stored Value Action in a One-Step™ Action) rather
than using the default value.

◦ Value is user-specific: Select this option to make the value user-specific.

Note: If you select this option without also checking Remember the user specific
value between sessions (below), then any user-specific values are only available for
use during a user's current CSM session. The stored value returns to its default value
after users log out or close their sessions.

◦ Remember the user specific value between sessions: Select this check box to store
any user-specific values so they are available next time users log into CSM.

7. (Optional) Select Value is protected (excluded from export and mApps) if you don't want the
value to be included with a database export or added into a mApp Solution.

8. Define additional options:
a. Select Options.

b. Availability: In the drop-down list, select a scope.

Note: If you already selected a scope at the beginning, this is auto-filled with your selection.

c. Association:

If applicable, select a more filtered scope (example: A particular team). <Automatic> applies
scope based on login. If not applicable, this option is disabled.

d. Custom Image:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

e. Select OK.e.

9. Select Save.9.
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Configuring Stored Values
Complete the following procedures to configure Stored Values. Security rights are configured in CSM
Administrator. Values for the default Stored Values are configured in either CSM Administrator or in the
CSM Desktop Client.

Note: If you are working with multiple cultures using the Globalization feature, be aware that
changing the value in one culture will not automatically change it in all cultures.

To configure Stored Values:

1. Configure Stored Value security rights: Configure who can access Stored Value functionality.

2. Configure values for the default Stored Values (in the Stored Value Manager): CSM ships with
several default Stored Values, including many to help you implement CSM. Use these as-is, edit
them, or create new ones.

◦ Organization Name and Organization Image Stored Values so that Users can personalize
CSM.

◦ Current System Stored Values that allows Users to configure test and production e-mail
accounts and migrate the system from testing to production.

◦ SLA Model Stored Values that define how an SLA is calculated.

◦ Current System Twitter Integration Stored Value that activates (or disables) Twitter buttons on
a Business Object form (ex: Problem).
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System Functions
A System Function is a built-in placeholder Token that dynamically adds variable information to a query or
string (example: Current user's name).
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About System Functions
Use a system function to add variable and dynamic information such as the current user's role.

Examples of system functions include:

• Date/time information (example: current date/time, last modified date/time)

• Current user's information (example: display name, avatar, phone, email, team)

• Current URL information (example: CSM Portal default URL, CSM Browser Client URL)

The following areas use system functions:

• The system

• Queries
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• Emails

• Expressions

CSM provides many system functions.

System Function Returns

APEventsAwaitingEvaluation The number of Automation Processes currently being
considered for running.

APEventsAwaitingProcessing The number of Automation Processes awaiting execution.

AssociatedFieldIsReadOnly()

For expressions used with form controls and field properties,
true if the field is set to read-only. For example, use to change
the border color of a form control when a field is set to read-
only.

AssociatedFieldValue()

Returns the value of a field. Use when a label is linked or
associated with a field to change the label based on how the
associated field has been or not been populated. It can also be
used in other expressions, such as checking the length of
contents of a field.

For example, to set the border color of an empty required form
field to a specific color (example: red), build one expression to
be used on all required fields:

If AssociatedFieldValue() is empty then
[Theme]RequiredControlBorder

AvailableLicenses(): Total number of CSM licenses currently available for use.

BrowserClientURL() URL link to the CSM Browser Client (example: http://
YourServerHere/Access).

ClientTimeZone() Client's time zone.

CurrentCulture() Current user's culture.

CurrentDateTime() The user/client machine current date and time.

CurrentGMTDateTime() Current Greenwich date and time.

CurrentLoginID() Current user's login ID number.

CurrentRoleID() Current user's role ID number.

CurrentRoleName() Current user's role.

CurrentUserAccessToken()

Current user's access token defined on login to the CSM
Browser Client or CSM Portal. This token is useful when
defining the POST Body for a chat widget using a Flyout or
Browser widget.

CurrentUserAccessTokenExpiryUTC()
The date of the current user's access token expiry UTC. This
token is useful when defining the POST Body for a chat widget
using a Flyout or Browser widget.
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System Function Returns

CurrentUserAvatar() Current user's avatar.

CurrentUserCompanyID() Current user's company ID number.

CurrentUserCompanyName() Current user's company name.

CurrentUserDefaultTeamID() Current user's default team ID number.

CurrentUserDefaultTeamName() Current user's default team name.

CurrentUserDepartmentName() Current user's department name.

CurrentUserDisplayName()

Current user's display name. On the CSM Desktop Client, this
returns the value from the UserInfo table. On the CSM Portal,
this returns the value from the Customer-Internal Business
Object.

CurrentUserEmail() Current user's email address.

CurrentUserEmailWithName() Current user's email and name.

CurrentUserLastLanguage() Selected language setting from Windows.

CurrentUserLastLocale() Selected location setting from Windows.

CurrentUserPhone() Current user's phone number.

CurrentUserPortalTimeZoneOffset() Time zone of user's computer.

CurrentUserRecordID() Current user's record ID number.

CurrentUserRefreshToken()

Current user's refresh token defined on refresh in the CSM
Browser Client or CSM Portal. This token is useful when
defining the POST Body for a chat widget using a Flyout or
Browser widget.

CurrentUserSLALevel() Current user's SLA level.

CurrentUserTypeID() ID of the Business Object definition that holds user information
(Typically, ID of the UserInfo Business Object).

CurrentUserWebSite() Current user's website name.

HasBusObRight() Returns a True value if the current user has rights to the
Business Object.

IsEnvironmentDevelopment() Returns a True value if the current system environment is set to
Development.

IsEnvironmentProduction() Returns a True value if the current system environment is set to
Production.

IsEnvironmentTest() Returns a True value if the current system environment is set to
Test.

IsInBrowser() Returns a True value if the current user is logged into the CSM
Browser Client or CSM Portal.

IsInBrowserPortal() Returns a True value if the user is currently operating in the
CSM Portal.
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System Function Returns

IsInBrowserTechnicianClient() Returns a True value if the user is currently operating in the
CSM Browser Client.

LoremIpsum() Use to create records for testing purposes.

NewID() Generates a unique ID (GUID).

PortalURL() URL link to the base URL for the CSM Portal as defined in
Browser Settings in CSM Administrator.

PortalURLDefaultSite() URL link to the default CSM Portal site.

ServerDateTime() Date and time information of the Cherwell Server.

TotalLicenses(): Total number of purchased CSM licenses.

UsedLicenses(): Total number of CSM licenses currently being consumed by
users.

ViewAnonymous()

Set the visibility for an item on a form or dashboard as viewable
by Anonymous users (True) or not viewable by Anonymous
users (False). See Restrict Anonymous User Visibility for a
Form Control or Restrict Anonymous User Visibility for a
Dashboard Widget.

Related concepts
Flyout Widgets
Browser Widgets
Related tasks
System Restore Tool
Configure CSM Web Application Settings (URLs, Timeouts, RSS Feeds)
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About the CurrentCulture System Function
The CurrentCulture System Function contains a User's culture and can be used in Expressions, One-Step
Actions, etc. to handle different languages and to return a string representation of the culture for the
current thread.

The CurrentCulture System Function can be used with or without globalization features.

For example, CurrentCulture can be used to create e-mail templates in different languages. If
CurrentCulture is set to de-DE, then clicking a button or running a One-Step will initiate the German e-
mail template. If CurrentCulture is set to pt-BR, then clicking the same button or running the same One-
Step will initiate the Portuguese e-mail template.

Each Business Object contains a Created Culture Field. When a new instance of a Business Object is
created, the Field is auto-populated using the CurrentCulture System Function.
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Restrict Anonymous User Visibility for a
Dashboard Widget

When a Dashboard has been enabled for Anonymous view, Anonymous Users can be restricted from
viewing specific Widgets on that Dashboard using the ViewAnonymous() System Function.

If a Dashboard is configured to be visible to Anonymous Users, each Widget on the Dashboard is also
enabled to be visible to Anonymous Users. Anonymous Users have view access only. If an Anonymous
User selects an item to execute an action, they are prompted to login. After successful login, the action
runs.

ViewAnonymous() System Function
To restrict a specific Widget from Anonymous view, you can set the ViewAnonymous() System Function to
False for that Widget. If the value is set to False, the Widget is not visible to Anonymous Users.

The ViewAnonymous() System Function can be set as a Boolean Property wherever a System Function
can be accessed (e.g., One-Step Action, Expression, etc.).

You can use the Dashboard Editor and Custom Expression Builder to restrict Anonymous visibility of a
specific Widget.

Restrict Anonymous View of a Widget Using a Custom Expression

1. Open a Dashboard in the Dashboard Editor

2. Select a Widget.
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3. In the Control Visibility drop-down list , select Custom Expression. This opens the Custom
Expression Builder.

4. Type a Name for the Expression.

5. In the first Value field, select System Functions > ViewAnonymous().
6. In the Operator field, select Equals.

7. In the second Value field, select False (not viewable by Anonymous Users).

8. Select OK.
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Restrict Anonymous User Visibility for a Form
Control

When a Form has been enabled for Anonymous view, Anonymous Users can be restricted from viewing
specific controls on that Form using the ViewAnonymous() System Function.

If a Form is configured to be visible to Anonymous Users, each control on the Form is also enabled to be
visible to Anonymous Users. Anonymous Users have view access only. If an Anonymous User selects a
control to execute an action, they are prompted to login. After successful login, the action runs.

ViewAnonymous() System Function
To restrict a specific Form Control from Anonymous view, you can set the ViewAnonymous() System
Function to False for that control. If the value is set to False, the control is not visible to Anonymous
Users.

The ViewAnonymous() System Function can be set as a Boolean Property wherever a System Function
can be accessed (e.g., One-Step Action, Expression, etc.).

You can use the Form Editor (accessed from within a Blueprint in CSM Administrator) and Custom
Expression Builder to restrict Anonymous visibility of a specific Form Control.

Restrict Anonymous View of a Form Control Using a Custom Expression

1. Open the form in Form Editor (accessed from within a Blueprint in CSM Administrator).

2. Select a Control.
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3. On the Form Editor toolbar, select the Control Visibility drop-down list , and then select
Custom Expression. This opens the Custom Expression Builder.

4. Type a Name for the Expression.

5. In the first Value field, select System Functions > ViewAnonymous().
6. In the Operator field, select Equals.

7. In the second Value field, select False (not visible to Anonymous Users).

8. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other
changes.
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Table Management
Table Management is a tool that allows users to quickly manage (add, edit, and delete) values in a Lookup
Object directly from the CSM Desktop Client without the need for a Blueprint.
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About Table Management
• Add a new value: Add a new Department named Accounting. When a value is added to a Lookup

Object in Table Management, the value is added to the database and becomes available in the
appropriate field's drop-down on the Business Object Form.

• Edit an existing value: Change the name of a department from Accounting to Finance. When a
value is changed in a Lookup Object in Table Management, the value is changed in the database
and in the appropriate field's drop-down on the Business Object Form.

• Delete a value: Remove an unused carrier from the Mobile Carrier.

The following figure shows the Table Management interface.

Not all Lookup Objects are (or should be) available in Table Management. Lookup Tables with intricate
relationships should be disabled because editing or deleting their values could have consequences and
should only be performed by system administrators.

Your system administrator controls which Lookup Objects are available in Table Management by enabling/
disabling the functionality in the general properties of a Lookup Object.
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Table Management Interface
The Table Management interface displays Lookup Table values in a Grid. Use the CSM Grid capabilities
(example: Print, export, run an Action, sort, filter, group, size, move/reorder, and add/remove columns) to
display only the data you want and in a way that is meaningful to you. Click a record to view it in detail.

Use the Table Management interface to:

• View Lookup values: View a Grid list of values or a specific value in detail.

• Find a specific Lookup value using filtering and searching options.

• Add, edit, or delete a Lookup Object value.

The Table Management interface can be opened in the CSM Desktop Client or Browser Client.

1. Type: Displays a list of available Lookup Objects. Not all Lookup Objects are or should be available
in Table Management.

2. Show/Hide Search: Shows/hides search and filtering options:
◦ Search: Displays the Lookup Object fields that can be searched using keywords.

◦ Changed: Displays a timeframe filter to refine your search (example: Anytime, Today, Previous
Month, etc.).

3. Record View: Displays a Grid list of existing values in the selected Lookup Object, or a specific
Customer Record.
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Open the Table Management Interface
To open the Table Management interface from the CSM Desktop Client menu bar or CSM Browser Client
menu bar, click Tools>Table Management.

CSM 2022.3 Features 1546

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=csm_desktop_client_menu_bar
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=browser_client_menu_bar
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=browser_client_menu_bar


Table Management Interface Behaviors

Menu Bars and Toolbars
Use the CSM Desktop Client menu bar/toolbar and Browser Client menu bar/toolbar to access Table
Management operations, such as:

• Navigating records.

• Switching between Grid view and Current Record view.

• Adding, editing, and deleting Lookup values.

Context Menu (Desktop Client Only)
Use the Table Management context menu to to quickly access common Table Management operations.

Menu Item Description

Go to Record Displays the selected Lookup Object value.

New Creates a new value for the Lookup Object.

Delete Deletes a value from the Lookup Object.

Print Grid Prints the active Grid.

Export Grid Exports the active Grid to a file.

Record Views
There are two ways to view records in the Table Management interface:

• Grid list: Select the Show Results button on the toolbar to display a Grid list of Lookup values.

• Current record: Select the Show Current Record button on the toolbar to display the selected
Lookup value.

Grid Capabilities
When Lookup values are displayed in Grid view, use the CSM Grid capabilities (example: Print, export,
sort, filter, group, size, move/reorder, and add/remove columns) to display only the data you want and in a
way that is meaningful to you.

Find Lookup Values
Use the filter and search options to find Lookup values.
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Table Management Good to Know
Use these tips for helpful information on Table Management.

• Deleting values might have far-reaching consequences and should only be performed by system
administrators.

• Deleting values is not retroactive; this action removes the value from future forms while leaving it
intact in past forms.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights.
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Using Table Management
When working with Table Management, Users can search for and manage values in Lookup Objects.
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View Values in a Lookup Object
To view for a value in a Lookup Object:

1. Open the Table Management Interface.

2. In the Type drop-down, select a Lookup Object (example: Mobile Carrier).
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Search for a Value in a Lookup Object
Use the Search/filter feature in the Table Management interface to:

• Search for a specific value in a Lookup Object. Blank finds all values. Search any field (Grid
column), if more than one exists.

• Limit the search to values changed during a specific timeframe (example: Anytime (all), Today,
Within Last 1 Week).

To search for a value in a Lookup Object:

1. Open the Table Management Interface.

2. In the Type drop-down, select a Lookup Object (example: Mobile Carrier).

3. Click the Show Search button.

The Search and Changed options open.

4. In the Search box, provide the value to search for (example: Lost My Call Inc). If more than one
column exists, Search any column in the Grid.

5. In the Changed drop-down, select a timeframe to limit the search (example: Anytime (all), Today, or
Within Last 1 Week).

6. Click the Go button to initiate the search.

Filtered results are listed in the search results Grid.
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Add a Value to a Lookup Object
Use Table Management to quickly add a value to a Lookup Object directly from the CSM Desktop Client
or Browser Client (example: Add a new Department named Accounting). When a value is added to a
Lookup Object in Table Management, the value is added to the database and becomes available in the
appropriate field's drop-down on the Business Object Form.

To add a value to a Lookup Object:

1. Open the Table Management Interface.

2. In the Type drop-down, select a Lookup Object (example: Department).

3. On the toolbar (Desktop Client or Browser), click the New button.

Tip: You can also right-click in the Grid, and then select New.

A new record opens with a cursor positioned and blinking in the appropriate field.

4. Provide a value to add to the Field (example: Accounting).

5. Click Save.

6. On the toolbar, click the Show Results button to view the new value in the Lookup Object.

The new value is now available in the database and in the appropriate field's drop-down on the
Business Object Form.
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Edit a Value in a Lookup Object
Use Table Management to quickly edit a value in a Lookup Object directly from the CSM Desktop Client
(example: Change the name of a department from Accounting to Finance). When a value is changed in a
Lookup Object in Table Management, the value is changed in the database and in the appropriate field's
drop-down on the Business Object Form.

To edit an existing value in a Lookup Object:

1. Open the Table Management Interface.

2. In the Type drop-down, select a Lookup Object (example: Department).

3. Double-click the value to edit.

The current record opens with the value to be edited highlighted.

4. Make changes (example: Change Accounting to Finance).

5. Click Save.

6. On the toolbar, click the Show Results button to view the changed value.

The new value is now available in the database and in the appropriate field's drop-down is on the
Business Object Form.
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Delete a Value from a Lookup Object
Use Table Management to quickly delete a value in a Lookup Object directly from the CSM Desktop Client
(example: remove an unused Mobile Carrier).

CAUTION: Some Lookup Objects have intricate relationships in CSM (example: Status,
Relationship, Upstream Relationship, or Phase Set), so deleting values might have far-reaching
consequences and should only be performed by system administrators.

To delete a value from a Lookup Object:

1. Open the Table Management Interface.

2. In the Type drop-down, select a Lookup Object (example: Mobile Carrier).

3. Right-click the value to delete, and then click Delete.

4. Click Yes to confirm the delete.

The value is removed from the Lookup Object and is no longer available in the field's drop-down.

5. Click Save.
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Configuring Table Management
Table Management security rights are configured in CSM Administrator. See Configure Application
security rights.
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Themes
A theme is a set of colors, fonts and styles that can be used by elements on a dashboard, form, portal
site, or action catalog to give a cohesive look.
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About Themes
Use themes to define properties for the different elements on a dashboard, form, portal site, or action
catalog, such as dashboard background color, form control text colors, portal banner colors and action
catalog menu colors.

When a theme is applied to a dashboard, form, portal site, or action catalog, all applicable elements
inherit those properties.

Each user also has a default dashboard theme, see Dashboard Themes). The default dashboard theme
is initially selected in CSM Administrator, either:

• globally, see Select Default Global Dashboards and Dashboard Themes),

• or by role, see Select Default Role Dashboards and Dashboard Themes).

If users have security rights, they can select default user dashboards and dashboard themes in the CSM
Desktop Client. A dashboard can also be defined to use its own theme. For more information, see:

• Security Rights

• Select Default User Dashboards and Dashboard Themes

CSM provides several OOTB themes. Use these themes as-is, edit them, or create them using the Theme
Manager and the Theme Editor.

Note: There are two versions of the Theme Editor that can open when editing a theme, the
universal Theme Editor and the classic Theme Editor. The editor that opens when you edit an
existing theme depends on which version of the editor the theme was created. This information
describes the functionality of the universal Theme Editor, for help on the classic Theme Editor see
Theme Editor.
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Dashboard Themes
Use dashboard themes to define colors, fonts and styles for different elements on a dashboard, such as
dashboard background color, colors for charts and gauges, and label fonts.

For a detailed list of dashboard-specific universal theme properties, see Dashboard Universal Theme
Properties. For a detailed list of dashboard-specific classic theme properties, see Dashboard Theme
Properties.

Note: Widgets significantly vary by type, so theme properties and how they can be applied also
vary significantly (example: image widgets do not have text). For more information, see About
Widgets.

Select a theme as part of a dashboard's display properties.

If configured, a dashboard theme can be overridden by:

• Widget Theme: Chart, gauge, and matrix widgets can have their own colors and styles and can be
configured to override the dashboard theme. Gauge threshold colors can also override theme alert
colors.

• Global Dashboard Theme: The default dashboard theme selected for the entire system.

• Role Dashboard Theme: The default dashboard theme selected for a role. See Select Default Role
Dashboards and Dashboard Themes.

• User Dashboard Theme: The theme selected by the user (for more information. See Select a User
Dashboard Theme.

• View Theme: A system administrator, or anyone with rights, has the ability to bulk apply a theme,
which essentially resets the default global theme. See Bulk Apply Classic Theme

CSM provides a default theme. Use the default theme as-is, edit it, or create a new theme using the
Theme Manager. See Create a Theme.
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Dashboard Universal Theme Properties
You can define a form theme by associating form elements with backgrounds, borders, text colors and
fonts.

This topic describes dashboard theme properties for a universal theme. If you are working with a classic
theme, use this link to open the previous version of Dashboard Theme Properties.

Note: The associations listed are predefined, any custom associations that you may have added
are not listed. Properties that are not edited or applied retain their default state in your theme.

In the Theme Editor apply the following color associations, fonts and properties as required.

Dashboard Color Associations
Color associations are used to apply a color property to elements in your dashboard. They are added to,
or moved between, color swatches in the Theme Editor Palette Colors section to apply them. See
Working with Theme Editor Palette Colors.

• Backgrounds: Add or drag the background associations to the required background color.•

◦ Chart Background.

◦ Dashboard Background.

◦ Gauge Background.

◦ Widget Background.

• Labels: Add or drag the label associations to the required label text color.•

◦ Widget Label.
• Borders: Add or drag the border associations to the required border color.

◦ Chart Border.
◦ Widget Border.

• Text: Add or drag the text associations to the required text color.
◦ Chart Text.

• Miscellaneous: Add or drag the associations to the required text color.
◦ Gauge Pointer.
◦ Grid Tick.

Dashboard Font Properties
The theme font typeface is applied globally to your dashboard's text associations by selecting a font
typeface from the Theme Font drop-down list.
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Note: Individual font controls are not displayed in the Theme Editor when the Dashboard Preview
is selected.

Dashboard Properties
Only the chart palette property can be set, this sets the color of the bars, lines, etc, in a dashboard chart
or graph.

Select a color from the Chart Palette drop-down list.
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Form Themes
Use form themes to define colors, fonts, and styles for the different elements on a form, such as form
background color and form control label fonts.

For a detailed list of form-specific universal theme properties, see Form Universal Theme Properties. For
a detailed list of form-specific classic theme properties, see Form Theme Properties.

Select a theme as part of a form's properties.

CSM provides a default theme. Use the default theme as-is, edit it, or create a new theme using the
Theme Manager. See Create a Theme.
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Form Universal Theme Properties
You can define a form theme by associating form elements with backgrounds, borders, text colors, fonts
and association override colors.

This topic describes form theme properties for a universal theme. If you are working with a classic theme,
use this link to open the previous version of Form Theme Properties.

Note: The associations listed are predefined, any custom associations that you may have added
are not listed. Properties that are not edited or applied retain their default state in your theme.

In the Theme Editor apply the following color associations, fonts and state overrides as required.

Form Color Associations
Color associations are used to apply a color property to elements in your form. They are added to, or
moved between, color swatches in the Theme Editor Palette Colors section to apply them. See Working
with Theme Editor Palette Colors.

• Backgrounds: Add or drag the background association to the required background color.•

◦ Banner Background.

◦ Control Background.

◦ Ellipse Background.

◦ Form Background.

◦ Primary Button Background.

◦ Rectangle Background.

◦ Secondary Button Background.

• Labels: Add or drag the label associations to the required label text color.•

◦ Control Label.
◦ Link Label.
◦ Ellipse Label.

• Borders: Add or drag the border associations to the required border color.
◦ Banner Border.
◦ Control Border.
◦ Ellipse Border.
◦ Line Border.
◦ Primary Button Border.
◦ Rectangle Border.
◦ Secondary Button Border.
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• Text: Add or drag the text associations to the required text color.
◦ Banner Text.
◦ Control Text.
◦ Page Validation Error Text.
◦ Primary Button Text.
◦ Secondary Button Text.

Form Font Properties
The font controls listed below are the defaults presented when you create a theme. The font typeface and
attributes defined in each font control are applied to the text associations defined in the Theme Editor
palette colors (example: Banner Text, Control Text, etc).

A font control typeface can be applied globally to your form's text associations by selecting Theme Font
in the font control. The theme typeface is set in the Theme Font drop-down list.

To apply a different typeface to a font control, select it in the font control typeface drop-down list. See
Working with Theme Editor Fonts

• Fonts:
◦ Banner.
◦ Label.
◦ Control.
◦ Paragraph.

◦ Primary Button.

◦ Secondary Button
◦ Link Label

Form State Overrides
The color properties associated to your theme elements are overridden by the colors you configure in a
State Override when the element changes state. There are three color properties in a state override. See
Working with Theme Editor State Override

• Text.
• Border.
• Background.
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Portal Themes
Use portal themes to define colors, fonts, and styles for the different elements on a portal site, such as
portal site header title text and portal application bar font color.

Select a theme as part of a portal site's properties.

If a theme is changed, refresh the browser to view the changes.

For a detailed list of portal-specific universal theme properties, see Portal Universal Theme Properties.
For a detailed list of portal-specific classic theme properties, see Portal Theme Properties.

CSM provides a default theme. Use the default theme as-is, edit it, or create a new theme using the
Theme Manager. See Create a Theme.
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Portal Universal Theme Properties
Define a portal theme by associating portal element properties with backgrounds, borders, text colors and
fonts.

This topic describes portal theme properties for a universal theme. If you are working with a classic
theme, use this link to open the previous version of Portal Theme Properties.

Note: The associations listed are predefined, any custom associations that you may have added
are not listed. Properties that are not edited or applied retain their default state in your theme.

In the Theme Editor apply the following color associations, fonts and properties as required.

Portal Color Associations
Color associations are used to apply a color property to elements in your portal. They are added to, or
moved between, color swatches in the Theme Editor Palette Colors section to apply them. See Working
with Theme Editor Palette Colors.

• Backgrounds: Add or drag the background associations to the required background color.•

◦ App Bar Background.

◦ Footer.
◦ Footer Baseline.

◦ Footer Subtitle.

◦ Footer Title.

◦ Grid Header Background.

◦ Grid Row Alt Background.

◦ Grid Row Background.

◦ Grid Row Hover Background.

◦ Grid Row Selected Background.

◦ Header.
◦ Header Baseline.

◦ List Background.

◦ Menu Bar.
◦ Menu Link Background.

◦ Menu Link Hover Background.

◦ Menu List Item Background.

◦ Menu List Item Hover Background.

◦ Portal Background.
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◦ Search Button.

◦ Search Button Hover.
◦ Toolbar Background.

• Borders: Add or drag the border associations to the required border color.
◦ Grid Border.
◦ Grid Header Border.
◦ List Border.
◦ Toolbar Border.

• Text: Add or drag the text associations to the required text color.
◦ App Bar Hover Text.
◦ App Bar Text.
◦ App Bar Hover Text.
◦ Content Description.

◦ Content Header.
◦ Footer Title.

◦ Grid Header Text.
◦ Grid Row Alt Text.
◦ Grid Row Hover Text.
◦ Grid Row Selected Text.
◦ Grid Row Text.
◦ Header Title.

◦ List Header.
◦ List Subtext.
◦ List Text.
◦ Menu Link Hover Text.
◦ Menu Link Text.
◦ Menu List Item Hover Text.
◦ Menu List Item Text.
◦ Search Text Selected.

◦ Toolbar Text.
• Miscellaneous: Add or drag the associations to the required text color.

◦ Search Button Icon.

◦ Search Button Icon Hover.
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Portal Font Properties
The font controls listed are the defaults presented when you create a theme. The font typeface and
attributes defined in each font control are applied to the text associations defined in the Theme Editor
palette colors (example: Header Title, Footer Title, etc).

A font control typeface can be applied globally to your form's text associations by selecting Theme Font
in the font control. The theme typeface is set in the Theme Font drop-down list.

To apply a different typeface to a font control, select it in the font control typeface drop-down list. See
Working with Theme Editor Fonts

• Fonts:
◦ App Bar.
◦ Content Header.
◦ Content Description.

◦ Footer Baseline.

◦ Footer Subtitle.

◦ Footer Title.

◦ Grid Row Header.
◦ Grid Row
◦ Header Baseline.

◦ Header Subtitle.

◦ Header Title.

◦ List.
◦ List Header.
◦ List Header Subtext.
◦ Menu Link.

◦ Toolbar.

CSM 2022.3 Features 1567

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=g2_working_with_theme_editor_fonts


Action Catalog Themes
Use action catalog themes to define colors and styles for the different elements on an action catalog, such
as header background color and link colors.

Select a theme as part of an action catalog's properties.

For a detailed list of action catalog-specific universal theme properties, see Action Catalog Universal
Theme Properties. For a detailed list of action catalog-specific classic theme properties, see Action
Catalog Theme Properties.

CSM provides a default theme. Use the default theme as-is, edit it, or create a new theme using the
Theme Manager. See Create a Theme.
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Action Catalog Universal Theme Properties
You can define an action catalog theme by associating action catalog element properties with
backgrounds, borders, text colors and fonts.

This topic describes action catalog theme properties for a universal theme. If you are working with a
classic theme, use this link to open the previous version of Action Catalog Theme Properties.

Note: The associations listed are predefined, any custom associations that you may have added
are not listed. Properties that are not edited or applied retain their default state in your theme.

In the Theme Editor apply the following color associations, fonts and properties as required.

Action Catalog Color Associations
Color associations are used to apply a color property to elements in your portal. They are added to, or
moved between, color swatches in the Theme Editor Palette Colors section to apply them. See Working
with Theme Editor Palette Colors.

• Backgrounds: Add or drag the background associations to the required background color.•

◦ 1st Level Background.

◦ 2nd Level Background.

◦ 2nd Level Hover Background.

◦ 3rd Level Background.

◦ Background.

◦ Header Background.

• Text: Add or drag the text associations to the required text color.
◦ 1st Level Title.

◦ 2nd Level Title.

◦ 3rd Level Title.

◦ Descriptive Text.
◦ Header Text.
◦ Link Active Text.
◦ Link Disabled Text.
◦ Link Hover Text.
◦ Link Text.

• Border: Add or drag the text associations to the required border color.
◦ Action Catalog Border.
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Action Catalog Font Properties
The theme font typeface is applied globally to your action catalog's text associations by selecting a font
typeface from the Theme Font drop-down list.

Note: Individual font controls are not displayed in the Theme Editor when the Action Catalog
Preview is selected.
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Themes Good to Know
Use these tips for helpful information on themes.

• From version 10.4.0 of CSM onwards, themes can be created and edited using the universal Theme
Editor or the classic Theme Editor. The classic Theme Editor is available only if you have classic
theme types in your system. See Theme Editor for help on the universal Theme Editor, or see
Theme Editor for help on the classic Theme Editor.

• When editing themes, classic themes open in the classic Theme Editor, universal themes open in
the universal Theme Editor.

• You can select either classic themes or universal themes to apply to dashboards (in the Dashboard
Properties editor) or to forms (in the Form Editor).

Note: When a universal theme is selected you cannot revert to a classic theme.

• Pin items to a pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM.

• A theme is selected as part of a dashboard's display properties, a form's theme property, a portal
site's display properties, or an action catalog's display properties.

• A system administrator can apply or reset a global theme for all classic dashboard and form themes.
See Bulk Apply Classic Theme.

Note: this applies to classic themes only, you can not bulk apply a universal theme.

• Bulk apply theme is a one-time operation. After resetting the theme, the Theme to Use field is
cleared.

• If a role or user dashboard theme is selected, or if a dashboard or form has a specific theme
applied, those themes override the global theme.

• Security rights control access to CSM functionality and are configured from the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For detailed information, see
Theme Security Rights.
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Using Themes
Users can work with themes in various ways using the Theme Manager, CSM Browser Client, CSM
Desktop Client, or CSM Administrator.

When working with themes, users can:

• View a theme.

• Select a user dashboard or form theme.

View a Theme
Use the Theme Manager to view the available themes (based on security rights).

Select a Theme

• On the CSM Administrator:
◦ To select a user dashboard theme: Open the Dashboard Manager, and then select a

dashboard to open in the Dashboard Editor from where you can select a theme. See Select a
User Dashboard Theme.

◦ To select a form theme: Open or create a Blueprint, and then select a form to edit in the Form
Editor from where you can select a theme. See Select a Form Theme.

• On the CSM Browser Client dashboard toolbar, select the Themes button .

• On a CSM Desktop Client dashboard, right-click and select User Themes.•

Note: The context menu is not available if the Dashboard property Allow User's chosen
theme to override Dashboard theme check box is cleared.

◦ The default dashboard theme is listed at the top.

◦ The currently selected theme is selected.
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Open the Theme Manager
Open the Theme Manager from the CSM Administrator.

To open the Theme Manager:

• In CSM Administrator, from the Blueprint or mApp Editor menu bar, select Managers > Themes.
See Blueprint Editor Menu Bar or mApp Editor Menu Bar.
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Chart Widget Color Palette Manager
Use the Color Palette Manager to edit existing chart widget color palettes or create custom chart color
palettes for CSM Desktop Client and CSM Browser Client dashboards.

Note: The Color Palette Manager contains chart widget color palettes that are edited in the chart
widget Color Palette Editor, universal theme color palettes are edited in the universal Theme
Editor.

To open the Color Palette Manager:

1. In CSM Administrator, create a new Blueprint.

2. Select Managers > Dashboards > Color Palette Manager.

The Color Palette Manager opens.

3. From the manager, you can edit chart color palettes or create custom chart color palettes. See
Create Custom Chart Widget Color Palettes.
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Chart Widget Color Palette Editor
Use the chart widget Color Palette Editor to create custom chart widget color palettes for CSM Desktop
Client and CSM Browser Client dashboards.

Chart widget color palettes are system specific, allowing custom chart widget color palettes to be viewed
system-wide.

1 Properties pane: Displays the colors in the selected chart widget color palette. Choose up to 16
colors and their default or custom names complete the fields.

2
Color fields: A color selector button is located in each of the 16 color fields. Choose from default
colors or use RGB color codes to choose custom colors. In CSM, RGB color codes display as ARGB
codes.

3 Sample chart widgets: The sample chart widgets provide a preview of how color palette changes are
displayed across the different chart widgets available in CSM. See Chart Widgets.
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Configure Chart Widget Color Palette Security
Groups

To create or edit chart widget color palettes, a user must be a part of a security group that has theme
management enabled.

Use the Rights tab in the Security Group Manager to assign chart widget color palette View, Edit, Delete,
or Create rights to users.

To assign Color Palette security rights to users:

1. In CSM Administrator, select the Security category.

2. Select Edit security groups.2.

The Security Group Manager opens.

3. Select the Rights tab.

4. From the Group drop-down list, select a security group (example: Admin).

5. From the Category drop-down list, select Themes. Theme Management is the only available
security right for the themes category.

6. Select one or more check boxes to affect users in the selected security group:6.

◦ View: View all color palette options in the Color Pattern Manager.
◦ Add: Add new color palette to the system.

◦ Edit: Edit existing color palettes.

◦ Delete: Delete custom color palettes.

Note: If a user is not part of a security group with access to color palettes and the Color
Palette Manager, the option is disabled in CSM Desktop Client (Desktop Client Toolbar >
Dashboards > Color Palette Manager).

7. Repeat steps 4 to 6 for all desired security groups.

8. Close the Security Group Manager.

CSM 2022.3 Features 1576

CSM 2022.3 Features



Create Custom Chart Widget Color Palettes
Chart widget color palettes are visible in CSM Desktop Client and CSM Browser Client dashboards.

Edit Color Palettes
All chart widget color palettes in the Color Palette Manager can be modified, copied, or deleted.

To edit a color palette:

1. In CSM Administrator, select Create a new Blueprint.
2. Select Managers > Dashboards > Color Palette Manager.2.

The Color Palette Manager opens.

3. In the Color Palette Manager, select a default color palette (example: Berry).

4. Select Edit.4.

The Color Palette Editor opens. Color properties for the default color palette display in the left
pane, and sample widgets display in the main pane.

Note: You may need to expand the left pane by dragging its border to the right in order to
view the color properties.

5. Select a default Color Field.5.

The Color Selector opens. Default colors are listed by name, but a standard RGB color picker is
also available for custom colors.

6. Select a New Color to add to the default color palette (example: Sienna).

7. (Optional): Repeat steps 5-6.

8. Select Save.

9. Publish the Blueprint. See Publish a Blueprint.

Create Custom Color Palettes
Create custom chart widget color palettes to align with corporate colors, or to differentiate between
departments.

To create a custom color palette:

1. In CSM Administrator, select Create a new Blueprint.
2. Select Managers > Dashboards > Color Palette Manager.2.

The Color Palette Manager opens.

3. Select New.

4. Provide a name for the color palette and select OK.4.

The Color Palette Editor opens, displaying the default bright color palette in the 16 color fields.
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Note: You may need to expand the left pane by dragging its border to the right in order to
view the color properties.

Important: The bright color palette is not visible in the Color Palette Manager. However, it
is the default color palette if none are chosen and the default colors for new, custom color
palettes.

5. Select a Color Field.5.

The Color Selector opens. Default colors are listed by name, but a standard RGB color picker is
also available for custom colors.

6. Select a Color.6.

The field is completed with the name or RGB code of the selected color (example: Magenta or
Custom RGB 255, 192, 64, 0).

7. Repeat Steps 4-6 for up to 16 colors.

Tip: If fewer than 16 colors are desired, change a sample color to Transparent.

8. Select Save.

9. Publish the Blueprint. See Publish a Blueprint.

Change Color Palettes
Make limited changes and switch color palettes from a dashboard.

To switch color palettes from the Desktop Client:

1. In CSM Desktop Client, from the toolbar, select Dashboards > Color Palette Manager.
2. Select a color palette.

3. Select OK.3.

The dashboard color palette updates.

Note: If changes are not visible, select Help > Reload definitions from the toolbar. If
changes are still not visible, ensure that the Blueprint was published.
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Assign a Color Palette to a Chart Widget
Users can assign color palettes to chart widgets in the Widget Manager or Theme Editor.

Apply custom color palettes or change the default color palette of Chart Widgets.

Assigning a Color Palette to a Chart Widget in the Widget Manager
Publish a Blueprint to assign a color palette to chart widgets:

1. In CSM Administrator, select Create a new Blueprint.
2. Select Managers > Dashboards > Widget Manager. The Widget Manager opens.

3. Select the chart widget and then select Edit .
The Widget Editor opens.

4. Select Display from the Options pane.

5. Select a color palette from the color palette drop-down (example: Bright or Custom).

6. Select OK.

7. Repeat Steps 3-6 for any additional widgets.

8. Publish the Blueprint.

Assigning a Color Palette to a Chart Widget in the Theme Manager

Note: There are two versions of the Theme Editor, the universal Theme Editor and the classic
Theme Editor. The editor that opens when you edit an existing theme depends on which version of
the editor the theme was created.

Publish a Blueprint to assign a color palette to chart widgets:

Classic Theme Editor

1. In the CSM Administrator, select Create a new Blueprint.
2. Select Managers > Themes. The Theme Manager opens.

3. Select a classic theme.

4. Select Edit .
The classic Theme Editor opens.

5. Select Dashboards from the Property Areas drop-down list.

6. Select the Dashboard widget chart palette field from the Charts section.

7. Choose a color palette from the drop-down list (example: Berry or a custom color palette).

8. Select Save.
The classic Theme Editor closes.

9. Close the Theme Manager.
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10. Publish the Blueprint.

Universal Theme Editor

1. In the CSM Administrator, select Create a new Blueprint.
2. Select Managers > Themes. The Theme Manager opens.

3. Select a universal theme.

4. Select Edit .
The universal Theme Editor opens.

5. Select Dashboard Preview from the Preview drop-down list.

6. In Dashboard Properties, select a color palette from the Chart Palette drop-down list (example:
Berry or a custom color palette).

7. Select Save.
The universal Theme Editor closes.

8. Close the Theme Manager.
9. Publish the Blueprint.
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Managing Themes
Themes are managed using the Theme Manager and the Theme Editor.

Tip: Good design is important. Before creating a dashboard, see Design a Theme.

Use the Theme Manager to:

• Create a theme. For more information, see Create a Theme.

• Edit a theme. For more information, see Edit a Theme.

• Delete a theme. For more information, see Delete a CSM Item.

• Bulk apply a classic theme. For more information, see Bulk Apply Classic Theme.

• Search for a theme. For more information, see Search in a CSM Item Manager.

• Organize themes. For more information, see Organize CSM Manager Items.

• Copy a theme. For more information, see Copy a CSM Item.

• Import/export a theme. For more information, see Import/Export a CSM Item.

• Find theme dependencies. For more information, see Find CSM Item Dependencies.

• Pin a theme. For more information, see Pin a CSM Item.

See Open the Theme Manager.

Use the Theme Editor to define theme properties (example: Colors, styles, and so on). For more
information, see Theme Editor.
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Theme Editor
The Theme Editor is a tool within the Theme Manager that enables you to define colors, fonts, images,
and styles for a theme.

Use the Theme Editor to define colors, fonts, images, and styles for:

• Dashboards.

• Forms: alert colors and controls.

• Portal Sites: header, footer and grids.

• Action Catalogs.

There are two versions of the Theme Editor that can open when editing a theme, the universal Theme
Editor and the classic Theme Editor. The editor that opens when you edit an existing theme depends on
which version of the editor the theme was created in. This topic describes the universal Theme Editor, for
help on the classic Theme Editor, see Classic Theme Editor.

Tip: The Theme Editor opens automatically when you create a new theme in the Theme Manager,
see Create a Theme.

The universal Theme Editor is split into two panes, the Theme pane where you edit your theme, and a
Preview pane where you can see the changes you have applied.

Theme Pane
The Theme pane contains sections in which you define the various elements of your theme. The sections
displayed depend on the item you have open in the Preview pane, for example a form, dashboard, portal
or action catalog.

Palette
Colors:

Displayed for all themes and contains a series of color swatches in which you define a color
and associations.

Each element present on your theme has specific named associations; when added to a
swatch the color defined in the swatch is applied to the theme element.

Associations displayed in color swatches can be filtered, which is useful when a large number
of associations are displayed and you want view only the ones you are working with.

See Working with Theme Editor Palette Colors.
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Fonts:

Displayed for all themes and contains font controls for all text elements in your theme.

The Theme Font drop-down list applies the font you select to an entire theme. When you
select a font in the Theme Font drop-down, it changes the fonts in all of the element font
controls (in which the theme font is defined) to the font you selected.

Font control dialogs are used to define a font that you want to apply to individual text elements
in a theme. You can also add new font types to apply to text elements.

Note: For the Dashboard Preview and Action Catalog Preview only the theme font is
displayed, the font control dialogs are not displayed.

See Working with Theme Editor Fonts.

State
Override:

Overrides the associated colors applied to an element in the Color Palette when the element
changes state (example: when it is disabled or changed to read-only). Each State Override
swatch contains three colors, which apply to an element's text, border and background. State
overrides are displayed for the Form Preview only.

Each swatch is named to identify the element types to which it applies.

You can edit the colors for each swatch present in this section.

See Working with Theme Editor State Override.

Dashboard
Properties:

Applies the color selected in the drop-down list to the Chart Palette in a dashboard. Dashboard
Properties is displayed for the Dashboard Preview only.

Preview Pane
In the Preview pane you can preview the theme applied to a form, dashboard, portal site, or action
catalog. Any changes you apply in the Theme pane are immediately displayed in the Preview pane.

The sections displayed in the Theme pane are dependent on the item you are previewing.

Related concepts
Open the Theme Editor
Preview a Theme
Working with Theme Editor Palette Colors
Working with Theme Editor Fonts
Working with Theme Editor State Override
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Open the Theme Editor
The Theme Editor can be opened in several ways from within the Theme Manager.

To open the Theme Editor:

1. Open the Theme Manager:
a. Open a Blueprint.
b. Select Managers > Themes.

2. In the Theme Manager select an existing theme to edit, and then do one of the following:
◦ Right-click > Edit.
◦ Select File > Edit.

◦ Select the Edit button .

Note: There are two versions of the Theme Editor that can open when editing a theme, the
universal Theme Editor and the classic Theme Editor. The editor that opens when you edit an
existing theme is dependent on which version of the editor the theme was created in. For help on
the classic Theme Editor, see Classic Theme Editor.
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Preview a Theme
Use the Preview pane of the universal Theme Editor to view the design of a theme and any changes you
make to a theme.

The Preview pane displays your form, dashboard, portal and action catalog content so you can visualize
the changes you apply.

Any changes you make in the Theme Editor (example: color association, font) are displayed in the
Preview pane.

To preview a theme:

1. Open a theme in the Theme Editor.
2. Select the preview in the Preview pane drop-down list, this can be:

◦ Form Preview.

◦ Dashboard Preview.

◦ Portal Preview.

◦ Action Catalog Preview.

3. If you edit a theme, ensure that you select Save in the Preview pane to save your changes.

Tip: When you select Save the Theme Editor closes.

Related concepts
Open the Theme Editor
Working with Theme Editor Palette Colors
Working with Theme Editor Fonts
Working with Theme Editor State Override
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Working with Theme Editor Palette Colors
Color schemes you want to use in the design of your themes can be added, edited and applied in the
Palette Colors section of the universal Theme Editor.

The Palette Colors section contains a set of pre-defined color swatches. In this section you can both add
and delete custom swatches. The color defined in a swatch is applied to your theme's content by adding
an association to the swatch.

You can add and remove custom colors and associations in the Palette Colors area. You cannot delete
predefined swatches.

Note: Fully transparent colors are displayed as white, and opaque colors are displayed as a solid
color when associated with some form control backgrounds in the CSM Desktop Client and CSM
Administrator. See Select a Background, Foreground, and Border Color for a Control.

Note: Chart widget palette colors are created and edited in the chart widget Color Palette Editor.
For more information, see Chart Widget Color Palette Editor.

Add a New Palette Color

1. Select Add Color (or select Alt+C).
The New Color dialog box opens.

Note: The New Color dialog box contains the Color Selector feature, see About the Color
Selector for information on using this feature.

2. Enter a name for the new swatch in the Name field.

Note: If you enter a name that is unavailable, the Name field border appears red and the
Apply button is disabled. You must enter a name that is not already in use.

3. Use the Color Selector to define the new color.

4. Select Apply.
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You can now apply associations using the new color swatch or add custom associations. See Apply an
Association and Working with Theme Editor Palette Colors.

Edit a Palette Color

1. Hover the mouse pointer over the color in the existing swatch that you want to edit and select Edit.
The New Color dialog box opens.

Note: The New Color dialog box contains the Color Selector feature, see About the Color
Selector for information on using this feature.

2. Use the Color Selector to define the new color.

3. Select Apply.

Delete a Palette Color
Only custom color swatches can be deleted, you cannot delete a default color swatch.

A swatch containing an existing association cannot be deleted, you must first either re-assign the
association to another color swatch or delete the association (custom associations only). The warning
below is displayed if the swatch contains an existing association.
Cannot delete color due to existing associations: <association name>

1. Select the ellipsis on the swatch.

Note: The ellipsis is only visible on custom swatches, not on default swatches. You cannot
delete a default swatch.

2. Select Delete Swatch.

Apply an Association
An association is used to apply a color to a theme's content, such as text boxes, labels, buttons and
borders.

1. Hover the mouse pointer over the Association container in the swatch you want to edit and select
Edit.
The Associations dialog box opens.

2. Select the associations that you want the color to apply to.

Note: If an association is already listed in another swatch this action removes it and applies
it to the swatch you are editing.

3. Select Apply.

You can also drag and drop associations between swatches.
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The associations you selected appear in the swatch and the color is applied to the associated content in
your theme.

Add a Custom Association
You can add a custom association to your theme design if it is not already listed in the Associations
dialog box list.

Note: The Add Association function is not available when Portal Preview or Action Catalog
Preview are selected in the Preview pane.

1. Select Add Association in the Palette Colors section (or select Alt+A).
The New Association dialog box opens.

2. Enter a name for the association in the Association Name field.

Note: If you enter a name that is unavailable, the Name field border appears red and the
Apply button is disabled. You must enter a name that is not already in use.

3. Select the color swatch that you want to add the association from the Palette Color drop-down list.

4. Select the color type from the Color Type drop-down list.

5. Select Apply.

You can now apply the custom association to a swatch, see Apply an Association.

Delete a Custom Association
You can delete custom associations only, default associations cannot be deleted.

Note: The Delete Association function is not available when Portal Preview or Action Catalog
Preview are selected in the Preview pane.

1. Select Delete Associations in the Palette Colors section (or select Alt+D).
The Delete Color Associations dialog box opens.

2. Select the association you want to delete.

Tip: You can select more than one association to delete.

The Warning below is displayed.
Any controls using the selected color associations will revert to their
default status.

3. Select Continue to delete the association.

CSM 2022.3 Features 1588

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=g2_working_with_palette_colors


Filter Associations
You can filter the associations that are visible in color swatches. This is useful when you have a large
number of associations and want to find a specific association or view only the associations you want to
work with.

1. Type an association name in the Filter Associations field, there are several options:
◦ Enter a unique part of the name of an association to display only that association.

Note: This only works if the association name contains a unique string of characters or
words not used in other associations, in this case enter the unique string or word only
to display the association. Where a string or word is not unique, all other associations
containing that string or word are displayed.

◦ Enter part of the name common to more than one association - this displays all associations
with the word in their name (example: If you enter 'Control', any associations with 'Control' in
their name are displayed).

Related concepts
Preview a Theme
Design a Theme
Create a Theme
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Working with Theme Editor Fonts
Use the font controls in the universal Theme Editor to apply fonts, edit existing fonts and add new fonts.

Fonts are displayed for all text elements in your theme that are present in form, dashboard, portal and
action catalog previews. For the Dashboard Preview and Action Catalog Preview, only the Theme Font
section is displayed.

Theme Font
The font you select from Theme Font drop-down list is applied to all theme elements that have the theme
font defined in the their Font control. You can change the font for all of these elements by selecting a
different font typeface in the Theme Font drop-down list.

1. Select the Theme Font drop-down list.

2. Select the font you want to apply.

Font Controls
You can edit fonts applied to the individual elements of a theme (example: a banner, label, button text).
The element that each font applies to is named in each Font control. You can also add new (custom) fonts
to apply to theme text elements.

To change a font:

1. Select the font drop-down list in the Font Control.
2. Select the font to apply to the theme element.

To edit a font:

1. Size: select the font Size drop-down and select the size you want to apply.

2. Style: select the Bold, Underline or Italic button.

3. Horizontal alignment: Select the Left, Center or Right alignment button.

4. Vertical alignment: Select the Top, Middle or Bottom alignment button.

To add a new (custom) font:

Note: New font types can only be added with Form Preview selected.

1. Select Add Font Type (or select Alt+T).
The New Font Type dialog box opens.

2. Enter a name for the font type in the New Font Type dialog box.

Note: If you enter a name that is unavailable, the Name field border appears red and the
Apply button is disabled. You must enter a name that is not already in use.
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3. Select Apply.

4. Edit the font attributes if required.

The new font type can be applied to a text element by selecting it in the Font Association drop-down in
the Form Editor.
To delete a custom font:

1. Select the ellipsis on the Font Control.

Note: The ellipsis is only visible on custom fonts, not on default fonts. You cannot delete a
default font.

2. Select Delete Font Type.
The Warning below is displayed:
Any controls using this font type will revert to their default states.

3. Select Continue to delete the font type.

Related concepts
Preview a Theme
Design a Theme
Create a Theme
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Working with Theme Editor State Override
You can override the associated colors in the Color Palette for any element to which override colors can
be applied.

Note: You cannot add or delete State Override swatches.

State Override is displayed for forms only.

The colors in the Color Palette that are associated to elements in your theme are overridden by the colors
you configure in a State Override swatch when the element changes state.

Each State Override swatch contains three colors that are applied to an element's text, border and
background.

There are five permanent color swatches in the State Override section, these are:

• Required for Save: Applies to any element in your form that must contain content (such as text) or
requires an action to enable save.

• Disabled: Applies to specific elements on your form that are disabled, such as a drop-down list or
control text.

• Disabled Button: Applies to form buttons that are disabled.

• Disabled Link: Applies to link labels that are disabled.

• Read-Only: Applies to text content that is (or is changed to) read-only.

Edit State Override Colors
To edit a State Override color swatch:

1. Hover the cursor over the swatch and select Edit.
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The Color Edit dialog box opens.

2. Hover the cursor over a color you want to change and select Edit.
The State Override Color dialog box opens.

Note: The State Override Color dialog box contains the Color Selector feature, see About
the Color Selector.

3. Use the Color Selector to define the new color.

4. Select Apply.
Any changes you apply are displayed in the Form Preview.

Related concepts
Preview a Theme
Design a Theme
Create a Theme
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Design a Theme
Good theme design is important. Before creating a theme, there are several things you should consider.

Colors and Styles
Consider the following color and style theme properties when designing a theme.

• Each theme property is named and intended for a specific element on a dashboard, form, portal or
action catalog. When the element is added, the elements defined colors, styles, and fonts are
applied by default (example: form control colors, border style, and fonts are automatically applied to
a control when the control is added to a form).

◦ Manually apply a different color or style to most elements, if needed. The key is to use theme
colors, and to apply colors and styles consistently.

◦ If a non-theme color (example: system, web, or RGB) is applied, the element does not change
to another theme color when applying a different theme.

• Contrast is important, so we recommend considering the background and label colors first. If
background colors are dark, use lighter label and accent colors. If background colors are light, use
darker label and accent colors.

• Colors should not irritate. When selecting a color, consider:
◦ Accessibility (example: Color blindness).

◦ Translation (example: What does a color mean in another locale?).

◦ Browser capabilities (example: Do browsers consistently display the color?).

◦ Science (example: What feeling or response does the color evoke?).

• Transparent is a color option. Use transparent on backgrounds and borders when a color is not
needed.

Widgets
Widgets significantly vary by type, see About Widgets. Consequently, theme properties and how they can
be applied also significantly vary:

• By default, widget labels inherit their font from the default system font. Font size, style, and
alignment must be manually applied.

• Chart, gauge, and matrix widgets can have their own colors and styles and can be defined to
override theme colors. For more information, see Chart Widgets, Gauge Widgets, and Create a
Matrix Widget, respectively.

• Theme alert colors are automatically applied to gauge threshold (for more information, see Define•
Thresholds for a Gauge Widget). For example: Low, Medium, and High.

Override theme alert colors if necessary, or apply theme alert colors to other elements (example:
Alert colors are often used in expressions to conditionally change a widget's background or label
color).

• Image, button, filter, and search widgets do not support backgrounds; therefore, no background
color or style can be applied. For more information, see Filter Widgets and Search Widgets.
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• Image widgets do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• By default, text gauge widgets have a transparent background. To manually add a background,
right-click the widget, select a background style, and then select a background color and border
color.

• The Rich Text Editor uses a default font based on the following settings, shown in priority order:•
◦ Field properties for a specific field in a Business Object (example: Resolution fields in

Problems).

◦ Default font selected in the Global Rich Text settings.

◦ Default theme form control font.

◦ CSM global system font (not configurable).
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Create a Theme
Use the Theme Editor to create or edit a theme to apply to a dashboard, form, portal or action catalog.

When creating a theme, define:

• Dashboard theme properties: backgrounds, charts, widgets, gauges and text.

• Form theme properties: backgrounds, borders, text and state override colors.

• Portal theme properties: app bar, content, lists, menus, toolbar, text and miscellaneous items.

• Action catalog theme properties: background, borders, headers, and text.

Tip: Use the theme preview to test the font, color, and style combinations.

Create a Theme

1. Open the Theme Manager.

2. Select Create New .
The New Theme dialog opens.

3. Provide a display name to use within CSM (search this property in CSM Item Managers).3.

4. Select OK.
The Theme Editor opens so you can define the properties for your theme. See Theme Editor and
the following information depending on which feature you want to apply your theme:

◦ Form: See Form Universal Theme Properties.

◦ Dashboard: See Dashboard Universal Theme Properties.

◦ Portal: See Portal Universal Theme Properties.

◦ Action Catalog: See Action Catalog Universal Theme Properties.

5. Select Save in the Theme Editor to save your theme.

Note: When you select Save the Theme Editor closes.

Edit a Theme

Note: There are two versions of the Theme Editor, the universal Theme Editor and the classic
Theme Editor. The editor that opens when you edit an existing theme is dependent on which
version of the editor the theme was created in. This information describes the functionality of the
universal Theme Editor, for help on the classic Theme Editor see Classic Theme Editor.

1. Open the Theme Manager.

2. Select a theme, and then select Edit .2.
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Tip: You can also select File > Edit or right-click and select Edit.

The theme opens in the Theme Editor.
3. Make the necessary changes. See Theme Editor.

4. Select Save in the Theme Editor to save your theme.

Note: When you select Save the Theme Editor closes.

Note: To rename a theme, right-click a theme in the Theme Manager, and then select Rename.
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Bulk Apply Classic Theme
Use the Bulk Apply Classic Theme option in the Theme Manager to bulk apply a global classic theme for
selected items (dashboards and/or forms) in a selected view.

Note: Bulk Apply Classic Theme is only available for classic themes. You cannot bulk apply a
universal theme.

To bulk apply a classic theme:

1. In the CSM Administrator Menu bar, select Managers > Themes.

2. In the Theme Manager Menu bar, select Themes > Bulk Apply Classic Theme .2.

The Bulk Apply Theme dialog opens.

3. Define the following:
◦ View: Select the view for which to reset the global theme (example: Default or Portal).

◦ Theme to Use: Select the theme to apply to all selected items (dashboards and/or forms).

◦ Change Theme On: Select this check box to apply the theme to the selected item (dashboard
and/or form) in that view. For example, you may want to reset all dashboards to a new theme
but keep using the existing theme for forms.

4. Select OK.4.
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Configuring Themes
Complete the following procedures to configure themes. Configuration procedures are completed in CSM
Administrator. Users who have rights to select a default theme can perform this task in the CSM Desktop
Client.

To configure Themes:

1. Theme Security Rights.

2. Select Default Dashboards and Dashboard Themes.
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Tokens
A token is a dynamic value that controls how information (example: Text, colors, numbers, measurements) is
interpreted and displayed throughout the system. Defined values can be used while designing forms,
dashboards, Automation Processes, One-Step™ Actions, and fields.
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About Tokens
A token is a dynamic value that controls how information (example: Text, colors, numbers,
measurements) is interpreted and displayed throughout the system. Defined values can be used while
designing forms, dashboards, Automation Processes, One-Step ActionsOne-Step™ Actions, and fields.

Token features include:

• Counters: A counter is a token that automatically increases a defined initial value (number) by a
defined increment. Counters can be used while designing forms, dashboards, Automation
Processes, expressions, and One-Step Actions.

• Prompts: A prompt is a display window that requires users to provide information before proceeding
with a process or Action (example: Specify the reason for putting an Incident into Pending status).

• Stored Values: A stored value is a named entity that stores commonly used information so that it
can be accessed and/or reused from various places in CSM, such as One-Step Actions and queries.

• System Functions: A system function is a built-in placeholder token that dynamically adds variable
information to a query or string (example: Current user's name).
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Additionally, expressions, metrics, and fields can be used as tokens for One-Step Actions and other
expressions, though they are not limited to token functionality.

Some tokens can be reformatted using modifiers and formats that change the visual format or calculated
value of the token in a One-Step Action or expression. For example, a Date/Time field in a One-Step
Action can be modified to display only the date without the time stamp for ease of use. For more
information on applying a modifier or format, refer to the modifiers or formats documentation.

The easiest way to access tokens is through the Token Selector.

CSM provides several OOTB tokens. Use these tokens as-is, edit them, or create new tokens.

Related concepts
Expressions
About Metrics
About Fields
Related tasks
Format a Token
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Token Selector
Use the Token Selector to complete the following token operations:

• View: View a list of available or Most Recently Used (MRU) tokens that can be expanded using the
Expand button.

• Add: Add an existing token by selecting the token once.

• Browse: Opens the applicable Manager (if available).

• New: Creates a new token (if available).

The Token Selector looks like this:
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Open the Token Selector
To open the Token Selector:

1. In an expression: When you create an expression.

2. One-Step™ Action: When you define the conditions for a One-Step Action or Action in the One-Step
Action window.
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3. In a search query: When you build a search query.

Related concepts
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About One-Step Actions
Define General Properties for a One-Step Action
Search Queries
Related tasks
Create an Expression
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Token Context Menu
Use the token context menu to perform the following operations:

• Delete: Select Delete to remove a token.

Note: This does not remove the token from the system, only from the item using that token.

• Properties: Opens the token's properties to edit the token (if applicable).

• Modifiers: Opens the modifiers window to modify the format or value of the token (if applicable).

To open the token context menu:

1. Open a One-Step™ Action or expression.

2. Right-click on a Token.

Tip: Tokens in One-Step Actions or expressions have a gray box around them so they are
easily identified.

Related concepts
About One-Step Actions
Expressions
Modify/Format Value Window

CSM 2022.3 Features 1607

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Ftokens%2F..%2Fmodifiers%2Fmodify-format_value_window.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Ftokens%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fone-steps%2Fabout_one-steps.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Ftokens%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fexpressions%2Fabout_expressions.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Ftokens%2F..%2F..%2F..%2Fcontent%2Fsuite_features%2Fmodifiers%2Fmodify-format_value_window.html


Constraints and Operators
When you use tokens, there are a few smaller functions that can affect how certain tokens (example:
prompts, expressions) work.

These include:

• Constraints: A constraint is a limit or filter on what a user can see or select from in a field, Related
Item Picker, tab in a form arrangement, or prompt.

• Operators: An operator is a word or phrase (equals, greater than, contains) that provides the
necessary information for two values to produce an output. The availability of operators depends on
the type of values you choose for a search clause.

Related concepts
About Fields
Form Arrangements
About Prompts
Constraints
Operators
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Constraints
A constraint is a limit or filter on what a user can see or select from in a field, Related Item Picker, tab in a
form arrangement, or prompt.

Unlike a search filter, constraints are settings for specific items on a form or prompt.

For example, users can constrain:

• Fields on a form that are specific to a certain team (example: Employee information displaying only
for the HR Team).

• Values in a selector control to show only customers from a particular region/office, or display only
computers that are available/active/assigned to someone.

• If the Knowledge Article tab shows in the form arrangement for a given Problem only when there is
an associated Knowledge Article.

• A prompt that shows Incident Categories that are visible in the Customer Portal.

Constraints contain three key components: Field (what is being constrained), Operator (how it is being
constrained), and Value (what it is being constrained to).

In the example above, Incident Category.Visible in Portal is the field that the prompt constraint is set on.
Equals is the operator, so only an Incident Category that is visible in the Portal triggers the prompt. True is
the value, so if an Incident Category is visible in the Portal, the prompt runs. To make the prompt run
when an Incident Category is not visible in the Portal, set the value to False.

There are several types of constraints:

• Field constraints: Limits placed on fields.

• Value constraints: Limits place on values in selectors.

• Form arrangement constraints: Limits placed on items within a form arrangement.

• Prompt constraints: Limits placed on prompts (example: When a prompt runs).

Related concepts
About Fields
Form Arrangements
About Prompts
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Tokens Good to Know
Use these tips for helpful information on tokens.

• The following features can be used as tokens while not being limited strictly to token functionality:
◦ Expressions

◦ Metrics

◦ Fields

For more information, see About expressions, About metrics, and About fields.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights.

Before using tokens, users need security rights for the following:

◦ Counters

◦ Expressions

◦ Stored Values

For more information, see Security rights reference.

Related concepts
Expressions
About Metrics
About Fields
Security Rights
Security Rights Reference
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Using Tokens
Users can view, create, and format tokens.
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View a Token
View a token in the following ways:

• Available tokens (based on security rights): Use the Token Selector.

• Counters: From the Counter Manager, or from an expression or query that uses the Counter Metric.

• Expressions: From the Expression Manager, or from an item that uses an expression (example:
Image, background, text).

• Prompts: From an expression, One-Step™ Action, or query that uses a prompt, or when executing
an Action (example: Select an SLA User on an Incident form) that has an associated prompt.

• Stored Values: From the Stored Value Manager, or from a query, One-Step Action, or expression,
that uses stored values.

• System Functions: From the Token Selector.

Related concepts
Query Builders
Expressions
Token Selector
About One-Step Actions
About Actions
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Add an Existing Token
Each type of token has specific conditions under which it can be applied.

For example, formats can only be applied to fields. However, tokens can generally be added using the
Token Selector.

To apply an existing token:

1. Open the Token Selector.
2. Select Expand to display available values for the desired token.

The Most Recently Used (MRU) tokens are displayed, as well as a Browse option for tokens that
have their own managers.

3. Select the Token once to add the token, or select Browse to open a manager (if applicable).

Related tasks
Open the Token Selector
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Format a Token
You can reformat some tokens using modifiers and formats that change the visual format or calculated
value of the token in a One-Step™ Action or expression.

For example, a Date/Time field in a One-Step Action can be modified to display only the date without the
time stamp for ease of use.

• A modifier is a token element that changes the visual format or calculated value of a token in a One-
Step Action or expression.

• A format is a token formula that controls how characters and digits are displayed in a text field
(example: When and where to include hyphens, parentheses, spaces, capitalization, etc.).

To apply a modifier to a token in a One-Step Action or expression:

1. Right-click a token in a One-Step Action or expression.
2. From the context menu, select Modifiers.
3. Select a Modifier from the list to edit an existing modifier. To create a new modifier, select Create

New.
4. Select OK.

To apply a format to a token:

5. Open the Properties window for the field to add a format:
a. In CSM Administrator, create a Blueprint.
b. In the Object Manager, double-click the Business Object that contains the field.
c. Double-click the Field.

The Field Properties window opens.

6. Select the General tab.
7. Select the Format check box.
8. Select the format to apply:

◦ Select the ellipsis to open the Stored Format Manager, where you can select an existing
format (stored format) or create a stored format. Stored formats can be used over and over in
numerous places.

◦ Select Custom Format to open the Custom Format window, where you can create a custom
format to use only for this scenario. A custom format has many of the same properties as a
stored format, only it does not have a name or description, and is not managed through the
Stored Format Manager.

9. Select OK.

Related concepts
About Modifiers
About Formats
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About Tokens
Expressions
About One-Step Actions
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Use a Content from File Token
Content from file tokens are one of a range of tokens available within CSM

A Content from File token provides access to the content of a file in a One-Step™ Action. Once accessed,
the content can be used in many different ways.

Note: The Content from File token can only be used in a One-Step Action.

The Content from File token can be configured to use a Trusted Agent, but only for static files and not
when users are prompted for a file. SaaS customers may be required to use this configuration. See
Update a Business Object with Content from a File for an example of how to configure a One-Step Action
using the Content from File token.

Related concepts
About CSM Administrator
Related tasks
Update a Business Object with Content from a File
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Use a Counter Token
Counters are one of a range of tokens available within CSM.

A counter is a token that automatically increases a defined initial value (number) by a defined increment.
Counters can be used while designing forms, dashboards, Automation Processes, expressions, and One-
Step™ Actions,.

When you work with counters, you can:

• View a counter.

• Add a counter to a stored expression.

• Add a counter to a custom expression.

• Create, reset, or change a counter.

Before working with counters, you must first configure counters in CSM Administrator:

• Configure counter security rights: Configure who can access counter functionality.

• Reset or change a default counter: CSM ships with several default counters, including Record
Identifier Counters on each default form. Ensure that record ID counters are appropriate on specific
forms.

Related concepts
Counters
Counter Security Rights
Create, Reset, or Change a Counter
Reset a Record ID Counter
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Use a Prompt Token
Prompts are one of a range of tokens available within CSM.

A prompt is a display window that requires users to provide information before proceeding with a process
or Action (example: Specify the reason for putting an Incident into Pending status).

When you work with prompts, you can:

• View a prompt.

• Enter data into a prompt.

• Create a prompt.
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Use a Stored Value Token
Stored values are one of a range of tokens available within CSM.

A stored value is a named entity that stores commonly used information so that it can be accessed and/or
reused from various places in CSM, such as One-Step ActionsOne-Step™ Actions, and queries.

When working with stored values, users can:

• View a stored value.

• Assign values to stored values.

• Create a stored value.

Before working with stored values, users must first configure stored values in CSM Administrator:

• Configure stored value security rights: Configure who can access stored value functionality.

• Configure values for the default stored values (in the Stored Value Manager): CSM ships with
several default stored values, including many to help you implement CSM. Use these as-is, edit
them, or create new ones.

Related concepts
Create a Stored Value
Stored Values Security Rights
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Use a System Function Token
A System Function is a built-in placeholder token that dynamically adds variable information to a query or
string (example: Current user's name).
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Manage Tokens
Manage tokens using the Token Selector and the token context menu.

Use these tools to:

• Apply an existing token.

• Create a new token.

Some tokens are managed using a Manager (example: Counter Manager). These include:

• Counters

• Expressions

• Stored values

Related concepts
Managing Counters
Manage Expressions
Managing Stored Values
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Create a Token Using the Token Selector
In some cases, tokens can be created using the Token Selector.

For example, you can create a new prompt in a One-Step™ Action that sends an email to a customer
about a password reset.

To create a new token using the Token Selector:

1. Open the Token Selector.
2. Select Expand to expand the list for the token.
3. Select New [Token].

The Define Properties window for the token opens.
4. Define the properties for the new token.
5. Select OK.

Related concepts
Token Selector
Related tasks
Open the Token Selector
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Twitter
CSM integrates with Twitter™ so users can send and receive text Tweets directly from and in CSM.
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Integrating CSM with Twitter

Overview
With the Twitter integration, Users can:

• Send a Tweet from CSM to Customers notifying them that a resolution was developed for a Problem
(more specifically, creating a Send a Tweet One-Step™ Action Action to send the Tweet when a
button is clicked on a form).

• Display a Tweet on a Dashboard (ex: Live Twitter™ Feed on your IT Dashboard).

The Twitter™ integration is built into CSM, both in the interface (through a dedicated Twitter Account
Manager, Twitter Widget, and Send a Tweet One-Step™ Action Action) and in the OOTB content (Tweet
buttons on the Problem form). Users only need to create a CSM Twitter Account to link to a registered
Twitter Account, and then build the Dashboards, One-Step Actions, and forms/buttons to use the tweets.
A default Twitter Stored Value is also provided to enable/disable Tweet buttons on forms.

Related Reading

• Twitter Account Manager

• Create a CSM Twitter Account

• Twitter Feed Widgets

• Create a Twitter Feed Widget

• Define a Send Tweet Action for a One-Step Action

Steps to Integrate
Perform these steps to integrate CSM with Twitter:

1. Sign up for a Twitter Account: http://www.twitter.com.

2. Create a CSM Twitter Account: When creating this account, it actually creates a link to an existing
registered Twitter Account.

3. (Optional) Create a Twitter Feed Widget to display a Tweet (Twitter feed) on a Dashboard.

4. (Optional) Add buttons to forms and Dashboards to send a Tweet directly from a form or Dashboard
(using a Send a Tweet One-Step Action).
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Managing Twitter Accounts
Metrics are managed in CSM using the Twitter Account Manager. Use this tool to:

• View a Twitter Account.

• Create a Twitter Account.

• Edit a Twitter Account.

• Delete a Twitter Account.

• Search for a Twitter Account.

• Organize Twitter Accounts.

• Copy a Twitter Account.

• Import/export a Twitter Account.

• Find Twitter Account dependencies.
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Twitter Account Manager
Use the Twitter Account Manager to complete general Item Manager operations for Twitter Accounts.

There are several ways to open the Twitter Account Manager.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

5. Main Pane:
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Displays items by view (icon, list, or details [grid]) and lists search results when a search is run.

Note:

System is the only available scope. Create subfolders underneath this scope to organize items.
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Open the Twitter Account Manager
To open the Twitter Account Manager:

• In the CSM Administrator main window, click the Browser and Mobile category, and then click the
Twitter Account Manager task.

• From a Twitter Feed Widget, right-click and select Widget Properties.

• From the Blueprint Editor menu bar, click Managers > Twitter Account Manager.
• From the mApp Editor menu bar, click Managers > Twitter Account Manager.
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Create a CSM Twitter Account
For CSM to integrate with Twitter, create a CSM Twitter account. This account creates a link to an existing
registered Twitter account.

You must provide:

• Name for the account within CSM.

• A description.

• Existing Twitter account to link to.

• Pin to access the existing Twitter account.

To create a CSM Twitter account:

1. Open the Twitter Account Manager.

2. Click the Create New button .

3. Define the link to the Twitter Account:
◦ Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

Tip: This name does not need to match the Twitter Account.

◦ Description:
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Provide a description to use within CSM (search this property in CSM Item Managers).

4. Click Sign in to Twitter via Browser.

A Twitter authorization site opens to allow CSM to access the Twitter Account (the default browser
launches and passes some Cherwell-specific information to Twitter).

5. Provide the Twitter credentials.

Note: This step can be skipped if the Twitter Account is set up to be remembered on the
current computer.
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6. Click Authorize app. Write down or copy the pin and close the window.

7. In the Edit Twitter Account window, provide the authorization pin provided by Twitter.

8. Click Authorize.

9. Click Close.

The account is authorized and the Revalidate account button appears on the Edit Twitter Account.

Note: If using Twitter buttons on a form (example: Problem), the buttons must also be
activated using the Stored Value Manager.
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Visualizations
A Visualization is an interactive graphical representation of related data, represented as a relationship chain
with colored nodes (boxes) and links (arrows). Defined alerts can also be added to indicate potential risk.
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About Visualizations
Use Visualizations to graphically view any type of relationship in CSM.

Examples include:

• Relationships between Configuration Items (CIs) to assess potential risks for an Incident or Change.

• Relationships between personnel (example: Executive, manager, technician).

• Relationships between Service Level Agreements (SLAs), Operational Level Agreements (OLAs),
Configuration Items, Underpinning Contracts, and Services.

The following example Visualization is a Configuration Map that shows relational data for an Incident:

Some possible uses of Visualizations include:

• Configuration map.
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• Organizational chart.

• Change sources (Incidents and Problems that feed a Change).

A Visualization always starts from a single primary object and shows other objects related to that object
(and objects related to those objects, and so forth). The lines (links) between objects represent
relationships (possibly multiple Relationships) and the color of the links indicates a set or chain of
associated relationships.

There are a number of different ways that Visualizations can be laid out to show data appropriately. Also,
if an object is in an alert state (example: If a server is down), the object node can be configured to appear
in a different color.

Each user has a designated default Visualization, which displays when the user presses Shift+F7 in the
Desktop Client. The default Config Visualization is initially selected in CSM Administrator, Globally or by
Role. Access available Visualizations using the Visualization Manager.

Visualizations can be exported into PDF, SVG, or Viso (.vsdx) files.

CSM provides several OOTB Visualizations to help visualize common business flows. Use these
Visualizations as-is, edit them, or create your own using the Visualization Manager.

CSM 2022.3 Features 1634

CSM 2022.3 Features



Primary Object
Visualizations always have a single primary object that is the core of the data. After the first level of
children is loaded, those children might load additional children, etc. The first issue, however, is
determining the primary object.

A Visualization can be set to always use a specific object as its center. This might make sense for an
organizational chart, where you always want the CEO to be at the top, or if you want to monitor a
particular cluster of servers. If a Visualization is tied to a specific primary object, when the Visualization is
displayed, that object will always be primary.

You can identify the primary object in the diagram by the fact that it is somewhat larger than all of the
other nodes. Also, its public ID is shown in the Search box at the top of the screen. The following figure
shows an example of a Vendor as a primary Visualization object.

For non-specific Visualizations, CSM tries to determine the best starting primary object based on the
record that was active in the system when the Visualization was run. It looks for an appropriate object in
the following ways:

• If the active record in the system is appropriate for the Visualization, it will be used. For example, if
you are currently looking at a Computer CI, and the Visualization is for CIs, then that Computer will
be used.

• If the active record in the system has a Relationship tagged as the Configuration Item Relationship,
and the Visualization is for CIs, then the current record in that Relationship will be used.
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• If the active record in the system has a Relationship tagged as the Customer Relationship, and the
Visualization is for customer data, then the current record in that Relationship will be used.

• If the active record has any Relationship that points to the type of data represented by the
Visualization, then the current record in that Relationship will be used.

• Finally, if no active record can be found, the Visualization will be displayed with no current record.
You will have to use the Search option to find a record. This works like any Related Item Picker. You
can type any appropriate terms into the search box, or you can click on the search icon to display a
list of available records.

Note: You are not locked into only that record. You can always search for a different record
to be the primary object using the Search control in the top bar. Alternatively, if the object
that you would like to be primary is already somewhere in the existing Visualization, you can
right-click on that object and select Visualize to make it primary.
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Link Chains
Link chains are chains of Relationships that tie together objects. For example, suppose you want to see
all of the Knowledge Articles that might relate to a particular Change Request. You might have a chain
that looks like this:

• Change Request

• Problems (via Change Request links Problems)

• Incidents (via Problems link Incidents)

• Knowledge Articles (via Incidents use Knowledge Articles)

The item in parentheses is the Relationship. The first item in the chain is always the main object for the
Visualization. After that, you can choose any objects that relate to Change Requests. Once the Problem
object has been chosen, you can then choose objects related to Problems, etc.

When you add the various items in the chain, you can decide whether or not the intermediate objects
should be displayed. For example, the Visualization could show all of the Problems and Incidents, or
could just show all of the Knowledge Articles linked directly to the Change. For more information, see
Defining a Visualization Link Chain.
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Tour a Visualization
The Visualization window shows Visualizations.

Here, you can:

1. Search: Execute a search for an alternative primary object either using the text box or the Related
Item Picker.

2. Adjust Layout and Controls: Select the graphical display option and which Visualizations are
displayed, their size, and how their data is refreshed.

3. View the Main Pane: View Visualizations.

4. View the Aerial Pane: View an overview of the entire Visualization diagram and the portion that is
currently visible. Drag the white box around to change the portion of the Visualization that is shown
in the main view.

5. Use the legend: Control which links and nodes are displayed in the main Visualization pane.
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◦ Link chains (the arrows that link objects within the Visualization) are the primary way that
nodes are related to one another in a Visualization and are made up of one or more
Relationships. The link chains in a particular Visualization are part of its definition, including
the color to use for the links. You can hide or show the nodes and links that make up a link
chain by using the check box next to the link chain in the legend. The figure below shows a
Visualization with links checked and unchecked in an Annealing layout.

◦ Nodes show what color is associated with each type of node in the Visualization. There are
several ways that a color can be determined:

◦ Alert Color: The alert color is part of the Visualization definition. Only Visualizations that
have alerts defined will show this option in the legend. Note that, if alerts are defined, the
Alert node will show in the legend even if no objects are in an alert state.

◦ Associated Color: An administrator can associate a color with a Business Object (In the
Business Object properties, on the Advanced page within a Blueprint). If a color is
associated with a Business Object, then that color will be used.

◦ Automatically Assigned: If there is no other option, the system will automatically assign
a color to each type of node. Note that there is no guarantee that the same color will be
assigned to the same type of objects on future runs.
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Visualizations Good to Know
• Visualizations are dynamic; however, data must be refreshed in order for some changes made to

Visualization objects in order to get the most up-to-date Visualization possible. See the Visualization
Main Pane documentation for more information.

• Visualizations behave differently in the CSM Browser Client. For more information, refer to Browser
Client Visualizations.
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Using Visualizations
Users can Visualizations, modify their layout, and more.
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View a Visualization
To view a Visualization:

• Default Config Visualization:
◦ In the CSM Desktop Client, press SHIFT+F7.

◦ From the Desktop Client menu bar, click Tools>Visualizations>Config Visualization.

• From a record:

◦ Click the Visualization icon  (ex: View impacted CIs on an Incident record).

• Available Visualizations: Use the Visualization Manager.

• MRU Visualizations:
◦ From the Desktop Client menu bar, click Tools>Visualizations, and then select a

Visualization from the MRU list (listed below the line in the menu).

◦ From the Browser Client menu bar, click Visualizations, and then select a Visualization from
the MRU list (listed below the line in the menu).
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Change the Visualization Layout
Visualizations support a number of different layouts that might be more or less appropriate depending on
the type of data being displayed. The default layout used for a particular Visualization is set by the creator
of the Visualization. Unless the option is disabled by that creator, you can change between the various
layouts to find one that seems most appropriate:

• Annealing: Nodes are arranged using a simulated annealing graph, which uses random
associations to try and arrange the data in the most appropriate way.

• Circular: Nodes are arranged in a circle.

• Clustered: Nodes are arranged using a force-directed layout, as with Spring, but groups of nodes
that seem related are separated out slightly.

• Grid: Nodes are arranged into a Grid.

• Layered: Nodes are arranged in layers, keeping connected nodes as close together as possible.

• Orthogonal: Nodes are arranged horizontally and vertically, attempting to avoid overlaps.

• Spring: Nodes are arranged using a force-directed layout that attempts to keep link lengths
between groups of node to a similar length.

• Topological: Nodes are arranged in a row with as few back-links as possible.

• Tree: Nodes are arranged in a tree, with parents having children. This is a good layout to use if you
will never have nodes that point back to other points in the tree.

To change the Visualization layout:

1. View a Visualization.

2. Use the drop-down menu to select the type of layout.

3. Click the Rearrange Layout button  to refresh the Main pane using the selected layout.
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View Information about a Visualization Node
In addition to the visual queues of the node (color, node name, alert status, etc.), you can view
information about a Visualization node using:

• Tooltips.

• Quick View.

To view information about a Visualization Node:

1. View a Visualization.

2. Do one of the following:
◦ Hover over a node to see tooltips for the record. The field information is based on Search

results settings for the node's Business Object. For details, refer to Configuring Visualization
Tooltips.

◦ Double-click or right-click a node to open a quick-view window of the record.
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Search for a Specific Record in the Visualization
Window

Use the Search box/Related Item Selector in the Visualization window to search through records (ex:
Incident number, Vendor, configuration items, etc.).

To execute a search within the Visualization window:

1. View a Visualization.

2. In the Search box, provide text to search for (example: Incident 10106). If the Visualization was
launched from a record, this is auto-populated.

3. To select records related to your search, click Related Item Picker.

The Related Item Picker opens in a new window.

4. Select a record to highlight it.

5. Click OK.

6. To open the record specified in the search bar, click the Go to Record  button.
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Go to a Record from the Visualization
You can view a record directly from a Visualization.

Go to a record from a Visualization:

1. View a Visualization.

2. Do one of the following:
◦ Double-click a node to open the record.

◦ (Desktop Client only) Right-click a node to open the context menu, then select either:
◦ Go to record: This option closes the Visualization and makes the selected record the

main record.

◦ Go to record in new window: This options closes the Visualization and takes you to the
selected record, but instead of doing so in the current window, it opens a new window, so
as not to disturb your current record.
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Show/Hide Visualization Links and Nodes
Each Visualization has a list of links and nodes that can appear, which are determined when the
Visualization is created. To hide or show these items, use the check boxes in the Legends area of the
Visualization window:

To show/hide Visualization links and nodes:

1. View a Visualization.

2. Do one of the following:
◦ To show a link or node, check the item.

◦ To hide a link or node, uncheck the item.

Note: If you have security rights, you can add, edit, or delete the links and nodes that
appear in the Legends area. For more information, see Create a Visualization.
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Managing Visualizations
Visualizations are managed in CSM using the Visualization Manager.

There are several ways to open the Visualization Manager.

Use the Visualization Manager to complete general CSM Item Manager operations for Visualizations,
including:

• View a list of available Visualizations.

• Create a Visualization.

• Edit a Visualization.

• Delete a Visualization.

• Search for a Visualization.

• Organize Visualizations.

• Copy a Visualization.

• Import/export a Visualization.
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• Find Visualization dependencies.

• Pin a Visualization.
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Open the Visualization Manager
Open the Visualization Manager from the CSM Desktop Client, the CSM Browser Client, or CSM
Administrator.

To open the Visualization Manager:

• In the CSM Desktop Client menu bar, select Tools > Visualization > Visualization Manager. For
more information, see CSM Desktop Client menu bar.

• In the Browser Client menu bar, select Visualizations > Visualization Manager. For more
information, see Browser Client menu bar

• In CSM Administrator, from the Blueprint or mApp Editor menu bar, select Managers >
Visualization Manager. For more information, see Blueprint Editor menu bar or mApp Editor menu
bar.
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Create a Visualization
Use the Visualization Properties window (accessed from within the Visualization Manager) to create or
edit a Visualization.

To create a Visualization:

1. Open the Visualization Manager.

2. Optional: Select a scope and subfolder.

3. Select Create New .

The Visualization Properties window opens.

4. Define the following properties:
◦ General:

Name, Description, Layout, etc.

◦ Links:

Links chains (Relationships) that appear on the Visualization.

◦ Alerts:

Alert conditions to make particular nodes stand out on the Visualization. As well as being a
different color, alert text shows up in the title and on the tooltip for the node.

5. Select Save.5.
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Define General Visualization Properties
To define general properties for a Visualization:

1. Open the Visualization Manager.

2. Optional: Select a scope and subfolder.

3. Select Create New .

The Visualization properties window opens.

4. Select the General page.

5. Define general properties:
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

c. Object Type:

Select the Business Object to display in the Visualization (example: Task, Incident, Vendor,
etc). After you select and save a Business Object, you cannot change this value.

Note: The list is normally limited to major and supporting objects, but if you want to see all
objects in the system, select Show all to include lookup tables.

d. Layout:

Select the default layout (way to arrange nodes on a Visualization).

e. Allow other layouts:

Select this box to allow Users to select different layouts when they view the Visualization.

f. Tie to specific record:

Select this box to tie the Visualization to a specific Business Object rather than record
currently being edited. Then, search for an appropriate record to be the primary object of your
Visualizations.

Note: Normally, when you run a Visualization, it determines the primary object for the
display based on the record currently being edited by the user. However, there are
times when you always want a particular object to be the primary object for a
Visualization. For example, to see the status of a server farm, you might choose a
controlling server that is related to all of the server farm machines.
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6. Select Save.6.
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Define a Visualization Link Chain
Use the Links page to define:

• Which Link Chains are displayed on a Visualization.

• Order in which Links Nodes are displayed on the Visualization window legend.

To define a Visualization Link Chain:

1. Open the Visualization Manager.

2. Optional: Select a scope and subfolder.

3. Select Create New .

The Visualization Properties window opens.

4. Select the Links page.

5. Define which Link Chains to display on the Visualization:
a. Select Add.

The Edit Link Chain window opens.

b. Define general properties:

Property Description

Name Provide a name for the link.

Link Color Select a color for the link.

Show this link chain by default

Select this check box to make the chain visible
by default. If you clear this check box, the item
is still displayed on the Visualization legend,
but no data is retrieved until the user explicitly
selects the check box next to it.

c. Select Add, and then select a Business Object to add to the Relationship link chain. A list of
all available objects that are related to the last entry in the list appears.

Example: If we started with Change Requests, we would see only Relationships related to
Changes. After we choose the Relationship to Problems, we would see Problem
Relationships, and so forth.

After you select a Relationship, the Link Member window opens.

Note: When you first open this window, it has only one item, the name of the main
object for the Visualization. In the example above, we have already added one
Relationship.
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d. Specify details of the Business Object in the Link Chain:
◦ Show text on link:

Select this check box to always display text on the Visualization’s link line in the
Visualization. For example, you might put in text like "Depends on" or "Uses."

◦ Show join reason on link:

(Only available if the Relationship uses a join table and has join reasons enabled). Select
this check box to display the join reason on the link line.

◦ Filter, Limit to Type:

Select this check box to limit the displayed nodes to just a single type (if the Relationship
is to a group). For example, when displaying Configuration Items, you could select to
only show Computers.

◦ Filter, Limit by join reason:

(Only available if the Relationship uses a join table and has join reasons enabled). Select
this check box to limit the displayed nodes to ones that have a particular join reason.

◦ Filter, Limit Expression:

Select this check box to limit to use an Expression to limit the records. Only children that
meet the Expression condition will be displayed.

◦ Show this object on Visualization:

Normally, when you put an object into the Visualization, you want nodes to be displayed
for all children. However, you might want the intermediate object to be ignored, and the
children of the "hidden" node be displayed as though they linked directly to the parent.
With the Change/Knowledge Article example, we would turn off this check box for
Problems and Incidents.

e. Select OK.e.

6. Repeat last link object:

If the parent and the child of the last item in the chain both point to the same type of object (in the
example, Configuration Item), then you can make the Visualization extend the chain via the last
Relationship multiple times. This has the same result as adding the Configuration Item (via CI links
Upstream Items) multiple times into the list.

Example: You have a configuration item A with upstream configuration items B, C and D. If B also
has upstream items E and F, and F has upstream items G and H, all of these would be shown. If you
didn’t repeat, you would just see A, B, C and D.

If the last Relationship in the chain does not have the same parent/child, the repeat option is
disabled.
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7. Suppress links between an object and itself:

Select this check box to ignore Relationships that point directly to themselves. If this check box is
cleared, links are shown via short arrows that go from and to the same object.

Example: If configuration item A had a Relationship to configuration item A, that would not be
shown.

8. Select Save.8.
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Define a Visualization Alert
Use the Alerts page (accessed within the Visualization Properties window) to define:

• Alert color.

• Alert condition: To make particular nodes stand out on the Visualization.

As well as being a different color, alert text shows up in the title and on the tooltip for the node.

To define a Visualization alert:

1. Open the Visualization Manager.

2. Optional: Select a scope and subfolder.

3. Select Create New .

The Visualization Properties window opens.

4. Select the Alerts page.

5. Select the color to indicate that a Business Object is in an alert state. The same alert color is used
for all alert conditions.

6. Define the alert conditions for different types of Business Object. You can only define one alert
condition for each type of Business Object.

a. Select Add to add a new alert condition.

The Edit Alert window opens.

b. Alert on Object: Select the Business Object on which to set an alert. Note that the list lets you
select Business Objects that might not necessarily show up on the Visualization.

c. Alert Condition: Define the alert condition, using either:
◦ Custom Expression:

Select the Custom Expression button to open the Custom Expression Builder, and then
create a custom Expression specifically for this scenario.

◦ Stored Expression:

Select the ellipses button to open the Expression Manager, and then select an existing
stored Expression or create a new stored Expression. Stored Expressions can be reused
in numerous places in CSM.

d. (Optional) Alert Text:

Provide the text to appear in the title and tooltip for nodes in the alert status.

Tip: As well as static text, you can also insert Field values, etc., into the Alert Text by right-
clicking in the Alert Text control, or by clicking the arrow button to the right of the control. For
example, you might insert the Date/Time when the system went down.

CSM 2022.3 Features 1657

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=scope
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fvisualizations%2F..%2Fexpressions%2Fcreate_an_expression.html


e. Select OK.e.

7. Select Save.7.
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Configuring Visualizations
Configure Visualizations with the following tasks:

• Configure Visualizations security rights.

• Select a default global Visualization.

• Select a default Role Visualization.

• Configure Visualization tooltips.
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Select a Default Global Visualization
Use the System Settings window in CSM Administrator to select the default Global Visualization.

Good to know:

• Default Role Visualizations override the Global default Visualization.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default config Global Visualization:

1. Open the System Settings window (CSM Administrator>Settings>Edit System Settings).

2. Click Dashboards, etc.

The Dashboards, Calendars, and Visualizations page opens.

3. Click the Visualization button  to the right of the default Visualization.

4. Select a Visualization to be the default. Be sure to select a Visualization that everyone can access
(Global scope).

5. Select OK.5.
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Select a Default Role Visualization
Use the Role Manager in CSM Administrator to select the default Role Visualization.

Good to know:

• If no default Role Calendar is selected, the Global default is used.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default Role Visualization:

1. Open the Role Manager.

2. Click the Role for which you want to select a default Visualization.

The Role Profile appears in the Manager window.

3. Select the default Role Visualization:
a. Use default: Select this radio button to use the default Global Visualization.

b. Visualization: Select this radio button to use a default Role Visualization. Then, click the

Visualization button  to open the Visualization Manager, where you can select an existing
Visualization or create a new Visualization to use as the default. Be sure to select a
Visualization that everyone in that Role can access.

4. Click Save.
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Configuring Visualization Tooltips
Users can hover over a Visualization node to get more information about the record:

• Alert text, if applicable

• Public ID

• Field information based on Search results settings for the node's Business Object.

To see which field information is used for Visualization tooltips:

1. Open the CSM Administrator.

2. Create a Blueprint.

3. Open the Business Object Editor for a specific Business Object.

4. Open the Search Results page.

5. The fields selected for these options are used for Visualization tooltips:
◦ Link text: List of fields

◦ Body text: List of fields

CAUTION: If you modify the fields for Visualization tooltips, your change also applies to Search
results.
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Widgets
A Widget is a mechanism that displays information about a Dashboard or Portal Site. Example Widget types
include: Chart, Gauge, and Button.

CSM 2022.3 Features 1663

CSM 2022.3 Features



About Widgets
A widget is a mechanism that displays information about a dashboard or Portal Site. Example widget
types include chart, gauge, and button.

CSM widgets are either:

• Data-driven: Displays CSM or external data (example: Action Catalog, browser, chart, gauge,
matrix, search control, search result, Twitter feed, or RSS feed).

• Standard: Enhances design and functionality (example: button, image, link, text, or shape). Buttons
and Links can execute a single Action (example: Run an Action).

CSM provides a variety of highly configurable widget types:

Icon Widget Description

Data-Driven Widgets

Action Catalog Displays a self-building and dynamic catalog of executable Actions.

Browser Displays a website or HTML Page.

Chart
Displays a data graph. This can be a bar, column, doughnut, line, pie,
pipeline, or scatter chart (or combination). The icon varies depending on
the type of chart.

Command Palette Displays a list of executable Actions.

Filter Filters other widget data by date, lookup table, or query.

Flyout Displays an HTML page or website that can be collapsed to a tab.

Gauge
Displays a single value and optional range data as a graph. Styles include
linear (horizontal, vertical, and thermometer), numeric (digital and
mechanical), speedometer, and text.

Matrix Displays data from various queries, broken up into rows and columns.

RSS Feed Displays the latest items from an RSS feed.

Search Displays a search control that can be used to run a Quick Search or a
saved search.

Search Results
List Displays the results of a search, either as a list of links or in a grid.

Twitter Feed Displays entries from a Twitter account or search.
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Icon Widget Description

Standard Widgets (Shapes, etc.)

Button Button that is capable of executing a single Action when clicked (example:
Run an Action).

Image Custom image used to enhance the appearance/usability of a dashboard.

Link Underlined text that is capable of executing a single Action when clicked
(example: Run an Action).

Text
Text that identifies or enhances other dashboard elements (example: The
dashboard itself, area, widget, or group of widgets). A text widget is
technically a gauge widget.

NA Shape Various shapes (ellipses, rectangles, and tabs) that organize other widgets
and enhance the appearance/usability of the dashboard.

Tab Group Display plain or rich text in a tabbed format.

CSM provides a variety of OOTB widgets designed to display data on a dashboard or Portal Site. Use
these widgets as-is, edit them, or create your own using the Widget Manager.
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Action Catalog Widgets
Action Catalog widgets are used in the CSM Portal to display a self-building and dynamic list (catalog) of
executable Actions.

Use the Action Catalog widget to build a dynamic Service Catalog that is organized by category and
service, and is capable of executing Actions that:

• Create categorized Incident and Service Request records.

• Create tasks.

• Send emails.

• Launch Document Repositories.

• Etc.

Action Catalog widgets can be used in the CSM Portal on a dashboard or as a stand-alone widget. They
are not intended for use in the CSM Desktop Client or CSM Browser Client.

Actions are displayed as links and can be hierarchically grouped in drill-down levels.

The Action Catalog style (list, rounded list, columns, rounded columns, or metro) controls the fonts,
colors, and layout. Images can be added to enhance navigation and visual experience. Styles are based
on Cascading Style Sheets (CSS) and can vary the functionality of the Action Catalog (example: The
metro style can display only three levels in a hierarchy; some styles cannot display an image next to the
highest level).

The following figure shows an example Service Catalog that can be displayed in a CSM Portal. The
example Service Catalog lists Actions (example: One-Time Conference Setup and Request Account) and
hierarchically groups them by category (example: Equipment Request or Video/Audio Conferencing) and
service (example: Conferencing/Presentation). When a customer clicks an Action hyperlink, an Action
executes (example: Request Account creates an Incident record and categorizes it as a Request). The
Action Catalog's theme (example: Metro Blue) controls the fonts, colors, block layout, etc.
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Good to know:

• The OOTB Service Catalog widget cannot be embedded in a dashboard; it is a stand-alone widget.

• An Action Catalog widget is built in levels from the bottom up, starting with Actions. Each level can
have:

◦ Images (except the highest).

◦ Description.

◦ Ascending or descending sort order.

◦ Go To button  to navigate directly to a record.

◦ Options for displaying items:
◦ Display all items no matter how many there are.

◦ Make the customer drill down to see the items.

◦ Display a set number of items, and then a More button for displaying more.

◦ Each level can be shown or hidden.

• Each item in a level can be enabled or disabled.

• Click the Preview button at any time to view the catalog as you build/design it. You can even drill-
down into the groups to see how Actions are hierarchically organized.

• See Dashboard Editor Behaviors for tips on working with widgets on dashboards.
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Related concepts
Create an Action Catalog Widget
About Widgets
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Browser Widgets
A Browser Widget displays an HTML Page or website.

Use a Browser Widget to display or perform a variety of options, including displaying a website or an
HTML page and/or sending a POST request to a URL. See Browser Widget Properties and Create a
Browser Widget.

Examples for using Browser Widgets include:

• Display your company website.

• Display a specific website accessed often (troubleshooting, forum, etc.).

• Display a custom CSM-built HTML Page for an IT or HR department.

• A website utilizing tokens.

• Send a POST request to a URL. Store and use the data from a POST response.

The following figure shows an example Browser Widget.

Good to know:

• A Browser Widget is highly configurable; define the website or HTML Page to display, and the
refresh rate.

• Refresh executes only when a Widget is active and being displayed. If you leave a dashboard and•
come back to it, the data will be automatically refreshed and the refresh timer will start over.

CSM 2022.3 Features 1669

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=browser_widget_properties
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_browser_widget
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=create_a_browser_widget
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=about_html_pages


• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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Chart Widgets
A Chart Widget displays one or more data series as a data graph.

Use a Chart Widget to display:

• Number of records created today.

• Number of Incidents by status or department.

• Mean Time to Resolve (MTTR) by priority.

• Number of open and resolved Incidents this week.

• Workload by Team.

The following figure shows several example Chart Widgets.
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CSM provides the following types of charts:

Chart Type Description Example

Bar
A bar chart is a chart with horizontally-plotted bars (categories) with lengths
proportional to the values that they represent. Use a bar chart to compare
values.

Column
A column chart is a chart with vertically-plotted bars (categories) with
columns proportional to the values that they represent. Use a column chart
to compare values.
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Chart Type Description Example

Line A line chart is a chart that displays information as a series of data points
connected by straight line segments. Use a line chart to track patterns.

Scatter
A scatter chart is a chart that plots two axes of data points (an x-axis and y-
axis) as a set of points scattered on a graph. Use a scatter chart to track
correlations within an interval.

Doughnut

A doughnut chart is a circular chart with a hole in the center that is divided
into sectors (often called slices), each of which represents a proportion to a
whole. The size of each slice is determined by the series value as a
percentage of the total of all values.

Pie
A pie chart is a circular chart that is divided into sectors (often called slices),
each of which represents a proportion to a whole. The size of a slice is
determined by the series value as a percentage of the total of all values.

Pipeline
A pipeline chart is a funnel chart that displays values as progressively
decreasing proportions. The size of the area is determined by the series
value as a percentage of the total of all values.

Good to know:

• A Chart Widget is highly configurable. You can define general properties (example: Title, refresh
rate, and filter exclusion), data series properties (example: Chart type, Business Object association,
data to include, values for the x- and y-axes, grouping options, custom colors, combine values
(clustered, stacked, or stacked 100), analysis formulas, and drill-down behaviors), x- and y-axes
properties, legend properties, and display properties (example: Labels, grid lines, tooltips, color
palette for items in the chart).

• By default, a Chart Widget acquires its font, colors, background style, and border style from the
defined Dashboard Theme; define your own properties, if needed.

• Series combinations must be valid. Bar, doughnut, pie, and pipeline series should be the only data
series in their Chart Widget. Column, line, and scatter can be combined in any way or number but
you cannot mix field types (date, number, or text). For more information about data series, see
Define a Series for a Chart Widget.

• Bar and column series can be stacked (series atop each other). For more information about
stacking, see Stacked Bar/Column Charts.

• Typically, on a Chart Widget, the x-axis is the horizontal axis and the y-axis is the vertical axis. On
bar charts, the axes are opposite.

• Bar, column, line, and scatter work the same way, differing only in the way the data is presented. Pie
and doughnut are also similar. Pipeline charts are unique.

• A preview of the Widget (with randomly generated data) is available at the top of the window. Use•
this to preview your Widget as you build it.

• Refresh executes only when a Widget is active and being displayed. If you leave a dashboard and•
come back to it, the data will be automatically refreshed and the refresh timer will start over.
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• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh.

• For more information about Chart Widgets, refer to the Modifying Chart Widgets course available in
the Cherwell Video Learning Library (subscription-based).

Related concepts
Dashboard Themes
Dashboard Refresh
Dashboards
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Stacked Bar/Column Charts
A Stacked Bar/Column Chart is a chart that stacks multiple data series on a single horizontal or vertical
bar. The size of each data segment is determined by the series value plotted on a common (discrete) axis
value. Use a stacked bar/column chart to compare amounts by category. Examples include:

• Number of Problems by Team stacked on common Date bars (example: Q1, Q2, Q3, and Q4).

• Number of Incidents by category stacked on common Date bars (April, May, June, etc.).

• Number of priority 1-3 Incidents stacked on common status bars (example: Assigned, Closed, In
progress, etc.).

CSM provides two types of stacked bar/column charts:

• Stacked: Data segment is proportional to its value (therefore, stacks will likely appear staggered or
uneven).

• Stacked 100: Data segments total 100% (therefore, all stacks will be the same height).

Stacked Stacked 100

Multiple stacks are also supported. For example, you can stack series 1 and 2 on a common stack (stack
group 1), and series 3 and 4 on another stack (stack group 2), if needed.

Good to Know:
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• Column series can be stacked in any number of stacks at a single x-value.

• Column series, stacked or not, can still be combined with other series types (example: Line and
scatter).

• Bar series can be stacked in any number of stacks at a single x-value.

• The stacking modes are Clustered (no stacking – default), Stacked, and Stacked100.

• Bars/Columns using the Stacked100 combine mode option must be associated with a y-axis such
that all series associated with that axis use the Stacked100 combine mode.

• Formulas cannot apply to stacked series. Because the origin of the stacked points are not at the x-
axis, stacked series points are not drawn at their actual Cartesian coordinates.

• When a series is grouped, all resulting series use the combine mode as specified for the original
series. For example, if you define a single series as stacked, all the series resulting from the
grouping will be stacked in the same group.

• Stacking is not supported for a continuous numeric x-axis (column and bar). No combine mode
options will be shown for that scenario.

• Point labels will not be shown for stacked points, but will continue to be shown for clustered points.
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Command Palette Widgets
A Command Palette Widget displays a list of one or more executable Actions that can:

• Run a Command, One-Step Action, Report, or Search.

• Display a CSM Item, such as an Action Catalog, Calendar, Dashboard, Document Repository,
HTML Page, or Visualization.

A Command Palette Widget can have:

• A single Action (ex: Run a One-Step Action, run a report, display another Dashboard, etc.).

• Several ungrouped Actions.

• A group of similar Actions organized by folders.

The following figure shows an example Command Palette Widget with a group of Actions organized by
folder.

Good to know:

• A Command Palette Widget is highly configurable; define which Actions to execute and how to
group the Actions.

• By default, a Command Palette Widget acquires its text, color, background style, and border style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• To execute a single Action, drag a button or link from the "Shapes, etc." section of the Widgets tree
in the Dashboard Editor, then right-click the button or link and select Widget Properties from the
context menu. The window opens, allowing you to select a single Action.

• A Button or Link Widget (Shape Widget) can also be used to execute a single Action.
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Filter Widgets
A Filter Widget filters other Widgets (Chart, Gauge, and Matrix) by:

• Date: Filters data by date range (ex: All, Today, Yesterday, Within last 1 week/month/quarter/
year, custom range, etc.).

A Date Filter Widget uses a drop-down to show the filtering options.

• Lookup table values: Filters data by a value in a lookup table (example: Filter Incidents by
Status—Assigned, Closed, In Progress, Assigned, New, etc.).

A Lookup Table Widget uses a drop-down to show the filtering options.

• Query: Filters data using a defined Query (example: My Incidents—Incidents owned by me).

A Query Filter Widget uses a toggle button to turn the filter on/off.

Good to know:

• A Filter Widget is highly configurable; define the Business Object to filter and the filtering option
(example: Date, Lookup value, or Query).

• A Filter Widget must be associated with the same Business Object as the Widget(s) it limits
(example: If the Filter Widget is going to limit Incidents, the Widget must be associated to the
Incident Business Object). A Date/Time filter is the only exception; it can filter Widgets associated
with other Business Objects (example: Problem).

• You can combine filters on a Dashboard (example: Filter by date, status, and User); however, you
can have only one Date/Time filter per Business Object type. If you add multiple Date/Time filters,
only the value from one will be used.

• Consider the criteria you are using to filter your individual Dashboard Widgets before you add a
Filter Widget to a Dashboard. For example, if you are using a Saved Search or Date Range to filter
a Widget to a specific date range, consider how a Date/Time Filter (essentially a second filter) on a
Dashboard might conflict with that.

• A Filter Widget does not support a background; therefore, no color or style can be applied.
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Flyout Widgets
A Flyout Widget is similar to the Browser Widget in that it displays an HTML Page or website, but it also
has the ability to be collapsed to a tab.

Use a Flyout Widget to display a website, send a POST request to a URL, and store and use the data
from a POST response. See Flyout Widget Properties and Create a Flyout Widget.

Examples for using Flyout Widgets include:

• Create a chat window and collapse to a tab when not needed.

• Display a website and collapse to a tab when not needed.

• Display a custom CSM-built HTML Page and collapse to a tab when not needed.

• Send a POST request to a URL. Store and use the data from a POST response.
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Gauge Widgets
A Gauge Widget displays a single data point, possibly with some range data. Use a Gauge Widget to
display the:

• Number of Incidents Opened/Closed today (Text).

• Number of Incidents assigned to me (Text).

• Number of Open Priority 1 Incidents (Thermometer).

• Customer Experience rating (Speedometer).

The following figure shows an example of Gauge Widgets on a Dashboard.

CSM provides several types of gauges:

Gauge Type Example

Horizontal Linear

Numeric (Digital or Mechanical)

Speedometer (Angle, Rectangular, Round, Round Rectangular)
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Gauge Type Example

Text

Thermometer Linear

Vertical Linear

Good to know:

• A Gauge Widget is highly configurable; define general properties (example: Gauge type, title,
Business Object association, refresh rate, and filter exclusion), data to include, values to display,
scale options, threshold options, text and number formats, drill-down behaviors, and display
properties.

• A preview of the Widget (with randomly generated data) is available at the top of the window. Use•
this to preview your Widget as you build it.

• Refresh executes only when a Widget is active and being displayed. If you leave a dashboard and•
come back to it, the data will be automatically refreshed and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.

• By default, gauge colors (banner, labels, face, grid line/tick, and threshold) and style (flat, chrome, or
none) come from the defined Dashboard Theme; however you can override some of the properties.
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Matrix Widgets
A Matrix Widget displays data from various Search Queries that are broken up into rows and columns.
Use a Matrix Widget to show by fiscal year or quarter, the number of:

• Incidents

• Problems

• Changes.

Each row can be:

• A time period (example: A row for each month of the year).

• A particular value (example: Each supported category).

Each column can be:

• Determined by a Query (example: The number of Incidents closed in the specified month or for the
specified category).

• Calculated based on other columns.

• A specialized display column for presenting data (a rating could show stars to represent a value, or
a value bar could show how close to target a value approached).

Data can be pulled from multiple Business Objects and can be shown side-by-side.

The following figure shows an example Matrix Widget.

Good to know:

• A Matrix Widget is highly configurable; define general properties (example: Title, associated
Business Object, refresh rate, drill-down, and filter exclusions), rows, columns, and appearance.
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• By default, a Matrix Widget acquires its text, color, border style, and background style properties
from the defined Dashboard Theme; however, you can define your own properties, if needed.

• Refresh executes only when a Widget is active and being displayed. If you leave a dashboard and•
come back to it, the data will be automatically refreshed and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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RSS Feed Widgets
A Really Simple Syndication (RSS) Feed Widget displays frequently updated information, such as news
or blog entries, from a particular feed. The Widget can also launch a One-Step Action so that you can act
on a feed (example: Create an Incident from a feed or send an e-mail about the feed). One-Step Action
Actions are displayed on the context menu (the right-click menu) for each item.

The following figure shows an example RSS Feed Widget.

Good to know:

• An RSS Feed Widget is highly configurable; define the RSS feed to display in the Widget, the
maximum number of feeds to display, whether or not to display images, the color of the links, the
refresh rate, and an optional One-Step Action to initiate from the Widget.

• By default, an RSS Feed Widget acquires its text, color, background style, and border style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• In most browsers, you can right-click the RSS feed icon  and select Copy Link Location or
Copy Link to copy the URL onto your clipboard. You can then paste it into the RSS Feed URI text
box in the RSS Widget window. A number of technical tools also expose RSS feeds in various ways
(including CSM).

• In order to initiate a One-Step Action from an RSS Feed Widget, the One-Step Action must have
access to the contents of the feed. This is done by adding the RSS Item Tokens to the Conditions
page of the One-Step Action. For example, when you add the RSS Item Tokens, you can then e-
mail details contained in the feed. Refer to the One-Step Action documentation for more information.

• Refresh executes only when a Widget is active and being displayed. If you leave a dashboard and•
come back to it, the data will be automatically refreshed and the refresh timer will start over.
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• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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Search Results List Widgets
A Search Results List Widget displays a list of records (as links or in a Grid) that meets a search criteria.
Use a Search Results List Widget to display a list of:

• My open Incidents

• My Team's Tasks

• Announcements

Good to know:

• A Search Results List Widget is highly configurable; define the general properties (example: Title
and Business Object association), display properties (example: Grid or as clickable links), search
criteria (ex: Saved Search or a custom Search Query), date range, and refresh rate.

• By default, a Search Results List Widget acquires its text, color, border style, and background style
properties from the defined Dashboard Theme. However, you can define your own properties, if
needed.

• You can select multiple results and use a One-Step™ Action to make changes to those records at
the same time.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A dashboard's refresh properties determine whether or not to use the dashboard's scheduled
refresh instead and/or allow its Widgets to refresh themselves in addition to the dashboard's
scheduled refresh. See Dashboard Refresh in the Dashboards documentation.

• Refresh executes only when a Widget is active and being displayed. If you leave a dashboard and•
come back to it, the data will be automatically refreshed and the refresh timer will start over.
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Search Widgets
A Search Widget displays a Search Control that can be used to run the following types of searches:

• Quick Search: A Quick Search is a simple query that quickly finds all records containing a specific
word or phrase (example: Show all records whose description contains the word "phone"). Search
options, such as record type, status, etc., are typically predefined to simplify the search, and vary
depending on the purpose and location of the search. Quick Search is a Full-Text Search, so it
searches all fields that have Full-Text search enabled (even those that are not specified) and finds
similar words, as well.

• Specific Search: Quick Search that quickly finds all records of a specific type that contain a specific
word or phrase (example: Show all Incident records that contain the word printer). Options are
predefined for each record type to simplify the search but can be changed when searching.

Note: A Search Widget can be used on a Dashboard or on a menu bar.

The following figure shows an example Search Widget that might appear on a Dashboard, on the CSM
Desktop Client menu bar, or in the Portal.

Good to know:

• A Search Widget is highly configurable; define which type of Search can be run from the Widget
(example: Quick Search, Specific Search, or both), a default Search, and Search behaviors
(example: Business Object to search, watermark, and/or logic, sort, and filters).

• The OOTB Search Widget is the CSM Search Control, located in the upper right corner of the CSM
Main window.

• A Search Widget does not support a background; therefore, no color or style can be applied when
the Widget is added to a Dashboard.
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Twitter Feed Widgets
A Twitter Feed Widget displays entries from a Twitter account or search. The Widget can also launch a
One-Step Action so that you can act on a feed (example: Create an Incident from a feed or send an e-
mail about the feed). One-Step Action Actions are displayed on the context menu (the right-click menu)
for each item.

The following figure shows an example Twitter Feed Widget.

Good to know:

• A Twitter Widget is highly configurable; define the Twitter account to display, what to display in the
feed (example: User's Tweets or Search Results), the maximum number of Tweets to display, the
color of the links, the refresh rate, and an optional One-Step Action to initiate from the Widget.

• By default, a Twitter Feed Widget acquires its text, color, border style, and background style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• Prior to CSM 4.60, it was possible to subscribe to a Twitter feed or search without providing a Twitter
account. However, Twitter no longer allows anonymous access to feeds. Any anonymous Twitter
Widgets will now display an error. Twitter has delayed enforcing this rule, so anonymous Twitter
Widgets might have continued to operate, but CSM has been updated to use the new Twitter API to
avoid all Twitter Widget failures when Twitter finally ends support for their old API.

• Before a Twitter Widget can be used, you must integrate CSM with Twitter by creating a CSM
Twitter account that links to a registered Twitter account.

• A feed can show the contents of a particular account or the results of a search term, such as
references to a particular hashtag (see Twitter’s site for details on various supported search
options).
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• Because Twitter is a world-wide service, ensure that the searches make sense for your company
("Cherwell," for example, also brings up numerous references to the area and river in England from
which we get our name!).

• To initiate a One-Step Action from a Twitter Feed Widget, the One-Step Action must have access to
the contents of the feed. This is done by adding the Tweet Tokens to the Conditions page of the
One-Step Action. For example, when you add the Tweet Tokens, you can then e-mail details
contained in the Tweet. For more information about defining Send Tweet Actions, refer to the One-
Step Action documentation.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.

• Actions on Twitter Widgets are not supported in the CSM Browser Client.

CSM 2022.3 Features 1689

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fone-steps%2Fdefine_a_send_a_tweet_action_for_a_one-step.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fone-steps%2Fabout_one-steps.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fone-steps%2Fabout_one-steps.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fdashboards%2Fdashboard_refresh.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fdashboards%2Fabout_dashboards.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fdashboards%2Fabout_dashboards.html


Tab Group Widgets
Add a set of tabs to a Dashboard using a Tab Group Widget.

The tabs can contain plain text or rich text to display formatted text, images, hyperlinks, and more. For
example, use Tab Group Widgets for HR and Facilities Dashboards. Add a tab for each benefit type
(health, dental, pet insurance) or for each facilities contact (building supervisor, maintenance contractor,
custodian).

Good to know:

• Each Tab Group can have an unrestricted number of tabs.

• Tab Groups do not inherit theme formatting.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.
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Standard Widgets
A Standard Widget is a Widget that enhances the appearance and usability of a Dashboard. CSM
provides the following Standard Widgets:

• Button: Executes a single Action when clicked (example: Run a Report, send an e-mail, create a
new Incident, etc.).

• Image: Displays a custom image (example: Company logo, employee photos, icons to indicate
breached SLAs, etc.).

• Link: Executes a single Action when clicked (example: Drill down into another Dashboard, open the
Dashboard Manager, etc.).

• Text: A "floating" Widget that textually identifies or enhances other Dashboard elements (example:
The Dashboard itself, area, Widget, group of Widgets, etc.).

• Shapes (Ellipse, Rectangle, Rounded Rectangle, Tab, and Rounded Tab): Widgets that can be
used to organize other Widgets to enhance the usability/appearance of a Dashboard.

Good to know:

• Standard Widgets are highly configurable and vary by type.

• A Text Widget is technically a Gauge Widget.

• Button and Link Widgets can execute a single Action.
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• By default, most Shape Widgets acquire their text, colors, border style, and background style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• Image Widgets do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• By default, Text Gauge Widgets have a transparent background. To manually add a background,
right-click the Widget, select a background style, and then select a background color and border
color.
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Widgets Good to Know
Use these tips for helpful information on Widgets.

• Pin items to a Pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM. For more information, see Pin a CSM Item.

• CSM provides a number of OOTB Widgets, designed to display data on a Dashboard or Portal Site.
For more information see About Dashboards or Portal Sites. Use these OOTB Widgets as-is, edit
them, or create your own using the Widget Manager.

• A Dashboard Theme controls the colors and styles of the Dashboard and its Widgets, and gives the
Dashboard a cohesive look. The Dashboard Theme is defined as part of the Dashboard's Display
properties but can be overridden at a Global, Role, user, or Widget level. For more information, see
Dashboard Themes.

• For tips on working with Widgets on Dashboards, see Dashboard Editor Behaviors.

• Consider using folders to organize your Widgets. For example, organize your Widgets by Type
(Search Widgets) or Automation Process (Incident Widgets). For more information, see Organize
CSM Manager Items.

• Be descriptive with Widget names so that you can easily identify/sort/search for them in CSM. For
example, consider including in your naming convention the type of Widget or where/how it is used.

• Select the Info button at the bottom of the property page to view the Widget's name, scope, and
folder.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights and Configure Dashboard Security Rights.

• Any widget that is covered by a Flyout Widget when the Flyout Widget is expanded must be in a
layer that is in front of the Flyout Widget. If the Flyout Widget layer is in front of another widget, the
widget behind the Flyout Widget will be inaccessible even when the Flyout Widget is collapsed. For
information about widget positions, see Layer a Widget.
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Using Widgets
When working with Widgets, Users can:

• View a Widget.

• Interact with Widgets on a Dashboard (refer to Using Dashboards).

CSM 2022.3 Features 1694

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fdashboards%2Fusing_dashboards.html


View a Widget
To View a Widget:

• Available Widgets (based on security rights): Use the Widget Manager.

• On a Dashboard.

• Stand-alone Widget in the Portal.
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Managing Widgets
Widgets are managed using the Widget Manager.

There are several ways to open the Widget Manager.

Use the Widget Manager to complete general Item Manager operations for Widgets, including:

• View a Widget.

• Create the following types of Widgets:
◦ Create a Widget (general).

◦ Create an Action Catalog Widget.

◦ Create a Browser Widget.

◦ Create a Chart Widget.

◦ Create a Command Palette Widget.

◦ Create a Filter Widget.

◦ Create a Flyout Widget
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◦ Create a Gauge Widget.

◦ Create a Matrix Widget.

◦ Create an RSS Feed Widget.

◦ Create a Search Widget.

◦ Create a Search Results List Widget.

◦ Create a Twitter Feed Widget.

◦ Create a Tab Group Widget.

◦ Create a Shape Widget.

• Edit a Widget.

• Delete a Widget.

• Search for a Widget.

• Organize Widgets.

• Copy a Widget.

• Import/export a Widget.

• Find Widget dependencies.

• Pin a Widget.

Note: After you create a Widget, use the Dashboard Editor to add the Widget to a
Dashboard, and then define how a Widget looks and behaves on the Dashboard.
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Open the Widget Manager
There are several ways to open the Widget Manager:

• From the CSM Desktop menu bar, click Dashboards>Widget Manager.
• From the Widget Tree in the Dashboard Editor, right-click>Widget Manager.
• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Dashboards>Widget

Manager.
• From within the Site Manager in CSM Administrator.
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Create a Widget (General)
Use the various Widget Property windows (accessed from within the Widget Manager) to create Widgets.
The Property windows vary depending on the type of Widget.

To create a Widget (general):

1. Open the Widget Manager.

2. Select a scope and subfolder (if needed).

3. Select Create New .

The Widget Properties window varies depending on the type of Widget selected in the drop-down
list.

4. Define general properties:
◦ Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

◦ Type:

Select the type of Widget and then define its properties:

◦ Action Catalog

◦ Browser

◦ Chart

◦ Command Palette

◦ Filter

◦ Gauge

◦ Matrix

◦ Search Results List

◦ Twitter Feed

◦ RSS Feed

◦ Search

◦ Tab Group

5. Select Save.5.

Note: After you create a Widget, use the Dashboard Editor to add the Widget to a
Dashboard, and then define how a Widget looks and behaves on the Dashboard. You can
also create Widgets from within the Dashboard Editor.
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Create an Action Catalog Widget
Action Catalog Widgets are used in the CSM Portal to display a self-building and dynamic list (catalog) of
executable Actions. For example, you can create Action Catalog Widget to build a dynamic Service
Catalog that is organized by Category and Service.

Use the Action Catalog Widget Properties window (accessed from within the Widget Manager) to create
an Action Catalog Widget.

To create an Action Catalog Widget:

1. Create a Widget.

2. In the Type drop-down list, select Action Catalog.

3. Define the following properties:
◦ General: Title, image, and description.

◦ Actions: Which Actions to list in the catalog (example: All Services).

◦ Display: How and when the catalog Actions displays (example: Style, text, images, expression
to enable/disable Actions).

◦ (Optional) Groups: How the catalog Actions will be hierarchically grouped, and how the groups
will look and behave (example: By category and subcategory).

4. Select Save.4.

Related concepts
Action Catalog Widgets
About Widgets
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Define General Properties for an Action Catalog
Widget

Use the General page (accessed from within the Action Catalog Widget Properties window) to define
the general properties for an Action Catalog Widget. The Action Catalog Properties window is accessed
from within the Widget Manager when you create or edit an Action Catalog Widget.

Use the General page (accessed from within the Action Catalog Widget Properties window) to define the
following general properties for an Action Catalog Widget:

Note: The Action Catalog Properties window is accessed from within the Widget Manager when
you create or edit an Action Catalog Widget.

• Image: To display inside the Widget bounding box. You can also add an image above the Widget
(header area).

• Title: To display inside the Widget bounding box. You can also add a label above the Widget
(header area).

• Description: To display below the title.

• Allow Anonymous Access to Action Catalog in the Portal:

If selected, the Action Catalog (OOTB Example: Service Catalog) is viewable to Anonymous Users
when they click on a link to the Action Catalog from a Dashboard, Menu link, or Button. For
additional configuration requirements for Anonymous access, see Enable Anonymous Views for the
Service Catalog.

If not selected, the Action Catalog is not viewable to Anonymous Users when they click a link to the
Action Catalog from a Dashboard, Menu link, or Button. This occurs even if the associated Business
Object(s) are configured to allow Anonymous access.

To define general properties for an Action Catalog Widget:

Example: The following procedures demonstrate how to build an example Service Catalog. The example
Service Catalog is named Service Catalog and displays a globe and a description.

1. Create a Widget.

2. In the Type drop-down, select Action Catalog.

3. Click the General page.
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4. Define general properties:
a. Image button:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.
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The image is shown inside the Widget bounding box, next to the Action Catalog's title (ex: A
Globe).

b. Title:

Provide a title to display at the top of the Widget inside the Widget bounding box. The font,
style, and color are inherited from the Action Catalog's style (defined on the Display page).

c. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

d. Allow Anonymous Access to Action Catalog in the Portal:

Select this check box if the Action Catalog should be viewable to Anonymous Users when they
click on a link to the Action Catalog from a Dashboard, Menu link, or Button.

Note: For additional configuration requirements for Anonymous access, see Enable
Anonymous Views for the Service Catalog.

5. Select OK.5.

Related concepts
Create an Action Catalog Widget
Define Actions for an Action Catalog Widget
Define Grouping Properties for an Action Catalog Widget
Related tasks
Define Display Properties for an Action Catalog Widget
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Define Actions for an Action Catalog Widget
Use the Actions page (accessed from within the Action Catalog Widget Properties window) to define
Actions and sort order for an Action Catalog widget.

• Action: Which Actions are listed in an Action Catalog widget. Actions come from Action fields. An
Action field is configured to hold Actions (example: "Action Command" or "Action Name" hold
properties are set on the field). Each Action value can execute the same default Action (example:
"Create Incident and set prioritization") or each value can have its own unique Action. See Action
Catalog Widgets.

• Sort Order: The order in which Actions are listed in an Action Catalog widget. Actions are sorted by
the values in a selected field (example: Subcategory), either ascending (1-10, A-Z) or descending
(10-1, Z-A).

Access the Action Catalog Properties window from within the Widget Manager when you create or
edit an Action Catalog widget.

For example, the Service Catalog lists Actions from the Incident Subcategory Business Object. The
Subcategory Business Object's Action Command field is configured to hold the Service Actions (One-
Time Conference Setup and Request Account). All values execute the same default Action (Create
Incident and set categorization) but you could define a unique Action in Table Management. Actions are
sorted alphabetically from A-Z by Subcategory (Action) name.

To define Actions for an Action Catalog widget:

1. Create a widget.

2. In the Type drop-down list, select Action Catalog.

3. Select the Actions page, and then select the Business Object that contains the Actions to execute
from the widget (example: Incident Subcategory contains all the Service Actions).

Only Business Objects that contain Action fields and are appropriate for an Action Catalog are
listed. See Create Action Fields.

4. (Optional) To limit the Business Object Actions by some criteria (example:
IncidentSubCategory.Service equals Printing to show only Printing Actions), select the Limit action

records using query check box. Select the Custom Query button  to open the Custom Query
Builder, and then create a custom search query to use only for this scenario. See Custom Query
Builder.

5. Select the Actions to execute from the Action Catalog:

Note: CSM automatically selects the first Action field it finds in the selected Business Object.
If you manually select a non-Action field, you must configure the field to be an Action field by
adding the Action Command or Action Command Name Hold property.

a. Action field: Select the Action field that contains the Actions to execute (example: Action
Command field). Each field value appears as a hyperlink that executes a defined Action, either
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a default Action (set below) or a unique Action (set in table management). See About Table
Management.

To define a unique Action, locate the value in table management (Tools > Table
Management), and then select an Action to execute.

b. Default action: Select the ellipsis button  to open the One-Step™ Action Manager, and
then select a default One-Step Action to execute for all hyperlinks or if there is no Action in the
Action field (example: "Create Incident and set categorization"). You can also create a new
One-Step Action. See Create/Edit a One-Step Action.

6. To add a sort order for the Actions:

Sorts, as described here, can only be added when the Style on the Widget Display page is set to
Cards with Search or Cards with Search v2.

a. Sorts: Select the Add Sort button  to add a new sort for an Action.

b. Sort order Field: Select the field to use to sort the Actions (example: Sort Actions
alphabetically from A-Z by Subcategory).
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c. Select the Sort in Descending Order button  to toggle the sort order between ascending

(1-10, A-Z) and descending (10-1, Z-A). A non-active icon  indicates ascending order; an

active icon  indicates descending order.

d. Select the Edit button  to change the sort name, sort field or to toggle the sort order.

e. Select the Delete button to delete a sort.

f. Select the Up or Down buttons to change the order in which the sorts are listed in the Portal.

The top sort option in the list in the dialog is the default sort. The sort direction is shown by an arrow
in the Portal next to each sort.

The Up and Down buttons have nothing to do with the precedence of one sort over another as only
one sort can be used at a time.

Sorts are only shown in the Portal if there are more than one.

7. To add one or more filters for the Actions:

Filters, as described here, can only be added when the Style on the Widget Display page is set to
Cards with Search or Cards with Search v2.

a. Filters: Select the Add Filter button  to add a new filter for an Action, and then give the
new filter a name.

b. To create a filter with a saved search, select the Custom Query button  to open the
Custom Query Builder.
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The stored query search button  is disabled when Show in Search Manager is disabled
for the current Business Object.

c. Select the Edit button  to change the filter name, or edit your custom query for your
saved search.

d. Select the Delete button to delete a filter.

e. Select the Up or Down buttons to change the order in which the filters are listed in the Portal.

You can create a maximum of 10 filters.

8. Select OK.8.

9. Publish the Blueprint to see your changes reflected in the Portal site. See Publish a Blueprint.

Related concepts
Create an Action Catalog Widget
Define General Properties for an Action Catalog Widget
Define Grouping Properties for an Action Catalog Widget
Related tasks
Define Display Properties for an Action Catalog Widget
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Define Display Properties for an Action Catalog
Widget

Use the Display page accessed from within the Action Catalog Widget Properties window to define the
display properties for an Action Catalog widget, including a Service Catalog widget.

To define display properties for an Action Catalog widget:

1. Create a widget, and then:
◦ In the Type drop-down list, select Action Catalog.
◦ Select the Display page.

2. From the Style drop-down list, select a style for the Action Catalog.
Styles are based on Cascading Style Sheets (CSS) and can vary the functionality of the Action
Catalog. For example, the metro style can display only three levels in a hierarchy.

3.
4. Select a Theme for the Action Catalog.

Themes vary by color (example: A/C forest, A/C orange, earth tones).
5. In the Fields Holding Display Text area, select the mandatory text to display in the Action

hyperlink:
◦ Title text: Select the field to provide the text that displays in the hyperlink (example:

Subcategory).
◦ Descriptive text: Select the field to provide a description of the Action. The descriptive text

displays directly under the hyperlink.
6. If you select the Cards with Search or Cards with Search v2 style, you can optionally select the

Always show items as cards check box. You can then select text for the Subtitle, Rating, and
Footer fields. These three fields are text fields and Rating has no search ranking calculations
associated with it.
The following figure shows an example of all 5 text fields in use:

1. Title text

2. Subtitle

3. Rating

4. Description

5. Footer
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Note: If you preview a Cards with Search style, you see a static example of the layout,
rather than a true preview of your live data.

7. Optionally, select the Show image next to each command check box to display an image next to
each Action hyperlink, and then select one of these options:

◦ Field with image: Select this option to display an image from a field, and then select the field
that contains the image from the list.

◦ Expression: Select this option to use a stored or custom expression to conditionally provide
the image (example: If Subcategory equals Submit Incident, display a green check mark). See
About Expressions and Create an Expression.

The figure below shows two Cards. The first one has Show image next to each command
selected and the second one has Show image next to each command cleared.
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8. Optionally, select the Use an expression to enable/disable actions check box, and then select a
stored or custom expression. For example, you can disable Actions for users in a specific security
role.

9. Select OK.

Related concepts
Create an Action Catalog Widget
Define General Properties for an Action Catalog Widget
Define Actions for an Action Catalog Widget
Define Grouping Properties for an Action Catalog Widget
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Define Grouping Properties for an Action Catalog
Widget

Use the Groups page (accessed from within the Action Catalog Widget Properties window) to define
how Actions will be grouped in an Action Catalog Widget.

Grouping properties include:

• How Actions are hierarchically grouped into levels in an Action Catalog.

• How the groups look and behave.

Note: The Action Catalog Properties window is accessed from within the Widget Manager
when you create or edit an Action Catalog Widget.

Good to know:

• Actions can be hierarchically grouped by another Field in the Business Object (example: In a
Service Catalog, group Actions under Category [Equipment Request and Video/Audio
Conferencing], and Categories under Service [Conferencing/Presentation]).

• Action Catalogs are built in levels from the bottom up, starting with Actions. If the Action is grouped

by a validated Field (identified by a white check mark in a green circle ), you can add another
level above the Action group.

To define grouping properties for an Action Catalog Widget:

1. Create a Widget.

2. In the Type drop-down, select Action Catalog.

3. Click the Groups page.

4. Group your Actions:
a. Groups box: Click the Actions to group (example: Incident Subcategory actions).

b. Group by: Select this check box to dynamically add the name of your Actions group.

c. Group by Field drop-down: Select the Field to use to group the Actions (example: Group
Actions by Category):

Note: If you select a validated Field (identified by a white check mark in a green circle

), you can add another group above the Action group.

A Grouped by line is added to the Groups box showing which Field is used to group the
Actions. The Actions group shifts down. The Display Options button is disabled because you
already defined display options for your Actions.

5. (Optional) Add another group above the Action group:
a. Groups box: Select the group you just added.
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The Group by check box dynamically adds the name of the group.

b. Group by: Select this check box to group by the above group (example: Group Name).

c. Group by Field: Select the Field to use to group the newest group (example: Group Category
by Service):

Another Grouped by line is added to the Groups box showing which Field is used to group the
newest group. The Display Options button is now enabled so that you can define display options for
the group.

6. (Optional) Continue to add groups.

7. Select OK.7.

Note: The Metro style supports only three levels (groups).

Related concepts
Create an Action Catalog Widget
Define General Properties for an Action Catalog Widget
Define Actions for an Action Catalog Widget
Related tasks
Define Display Properties for an Action Catalog Widget
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Define Display Properties for an Action Catalog
Group

Use the Group Display Options window to define how the group levels will look and behave in an Action
Catalog.

Display properties include:

• General properties: Display name, description, and order.

• Image: Image to display next to each item.

• Visibility: When to show/hide the items.

• Allow drill-down: Whether or not to allow drill-down into the items.

To define display properties for an Action Catalog group:

1. On the Action Catalog Groups page, click the Display Option button.

2. Define general properties for the group:
a. Name: Select the Field to provide the display text (hyperlink). Typically, this is the Field you

used to group items, although you can use a unique display Field.

b. (Optional) Description: Select the Field to provide a description of the group. The descriptive
text displays directly under the hyperlink.

c. Order By: Select the Field to use to sort the Group items (example: Sort Categories

alphabetically from A-Z by Category name). Click the Sort in Descending Order button 
to toggle the sort order between ascending (1-10, A-Z, etc.) and descending (10-1, Z-A, etc.).

A non-active icon  indicates ascending order; an active icon  indicates descending
order.

3. (Optional) Select the images to display next to the group's display text:
a. Show image next to each command: Select this check box to display an image next to each

group's display text, and then select the images:
◦ Field with image: Select this radio button to display an image from a Field, and then

select the Field that contains the image.

◦ Expression: Select this radio button to use an Expression to provide the image (example:
If Category equals Network, display a picture of a Server), and then define the
Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager,
and then select an existing stored Expression or create a new stored Expression.
Stored Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the
Custom Expression Builder, and then create a custom Expression specifically for
this scenario.
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4. (Optional) Define Expressions for showing/hiding and enabling/disabling Group items (example:
Disable/enable Actions based on Security Role) using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored Expressions
can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

5. Define drill-down options for the group:
a. Allow Drill Down: Select this check box to enable drill-down into the group. When drill-down is

enabled, the display text becomes a hyperlink that drills down into the items grouped beneath
it.

b. If drill down is enabled, select the drill-down behavior. You can select from the following:
◦ User must drill-down to see items in this group: Select this radio button to hide all

grouped items, only displaying the items when the hyperlink is clicked.

◦ All group items will be shown even if not drilled-down: Select this radio button to display
all the grouped items below the group's display.

◦ Max items to show without drilling down: Select this radio button to display a defined
number of grouped items before drilling down, and then provide a number.

c. Drill down style: Select a drill-down style. Default uses the Widget's style.

6. Define quick-view options:
a. Allow quick view of Incident Category in a popup window: Select this check box to enable

Quick View for the group. When enabled, the Go To button  appears next to the group
and, when clicked, pops up additional information.

7. Select OK.7.

Related concepts
Create an Action Catalog Widget
Define Grouping Properties for an Action Catalog Widget
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Create a Browser Widget
Use the Browser Widget Properties window in the Widget Manager to create a Browser Widget.

1. Create a Widget.
2. In the Type drop-down list, select Browser.

The Browser Widget Properties fields appear. See Browser Widget Properties for more specific
information about each field.

3. Select one of the following and configure the related properties:
◦ HTML page: Select this option to display a specific HTML page. Browse to select an existing

HTML page or create a new HTML page in the HTML Page Editor.
◦ Web Site: Select this option to display a website, utilize tokens, and/or send a POST request

to a URL.

URL: Type the URL of the website.

POST: To send a pre-load POST to a website, select the Execute POST before widget load
check box, type a POST URL and a POST Body that can execute a POST request upon
loading or refreshing. Right-click on any of these text fields or select the drop-down arrow next
to the field to specify a token on the URL. The token can reference Stored Values, System
Functions, and Custom Expressions.

Store Response: To store and use the data from a POST response in a Stored Value, select
Store Response and select an existing Stored Value or create a new Stored Value in the
Stored Value Manager.

4. If applicable, select the Refresh check box to refresh the content of the Widget according to a
defined time period, and then provide the refresh timeframe (every x hours or minutes).

5. Select Save.
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Browser Widget Properties
The Browser Widget Properties window allows you to define the display (HTML page or website) and
specific properties of a Browser Widget.

Properties Description

HTML page

Select this option to display a specific HTML page. Browse to select an existing
HTML page or create a new HTML page. See HTML Page Editor.

2-tier connection: When using a 2-tier connection, a CSM login window opens.
Type your User name and Password to open the HTML Page Editor.

Web Site

Select this option to display a website, utilize tokens, and/or send a POST
request to a URL.

Note: You can store and use data from a POST response. To do this,
the User's Security Group must have permissions to Edit Stored Values.

• URL

Type the URL of the website.

Tokens: The URL can include data tokens that allow the server to deliver more
sophisticated and customized information. Right-click the field or select the drop-
down arrow next to the field to specify a token on the URL. The token can
reference Stored Values, System Functions, and Custom Expressions.

Note: When using the CTRL + Click keyboard shortcut on the URL, it
follows the link, but any associated tokens will be dropped.

• Execute POST before
widget load

This check box must be selected to send a pre-load POST to a website.

When selected the pre-load POST is configured to execute, the POST URL field
is enabled and required, and POST Body field is enabled but not required.

When disabled, the POST URL and POST Body fields are disabled and the pre-
load POST does not execute.
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Properties Description

• POST URL

Type a POST URL that can execute a POST request upon loading or refreshing.
This field is enabled and required when the Execute POST before widget load
check box is selected.

Tokens: The Post URL can include data tokens that allow the server to deliver
more sophisticated and customized information. Right-click the field or select the
drop-down arrow next to the field to specify a token on the URL. The token can
reference Stored Values, System Functions, and Custom Expressions.

If the POST fails, it will fail silently and an error will be logged.

• POST Body

Type a POST Body that will send to the POST URL upon loading or refreshing.
This field is enabled when the Execute POST before widget load check box is
selected.

Tokens: The Post Body can include data tokens that allow the server to deliver
more sophisticated and customized information. Right-click the field or select the
drop-down arrow next to the field to specify a token on the URL. The token can
reference Stored Values, System Functions, and Custom Expressions.

If the POST fails, it will fail silently and an error will be logged.

• Store Result
Select this option to store and use the data from a POST response in a Stored
Value. Browse to select an existing Stored Value or create a new Stored Value.
Incoming data must be valid JSON or XML. See Managing Stored Values.

Refresh

Select this check box to refresh the content according to a defined time period,
and then provide the refresh timeframe (every x hours or minutes). Use refresh
on Widgets where the data is likely to change.

Refresh executes only when a Widget is active and being displayed. If you leave
a dashboard and come back to it, the data will be automatically refreshed and the
refresh timer will start over.

See Browser Widgets and Create a Browser Widget for additional information.
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Create a Chart Widget
Use the Chart Widget Properties window (accessed from within the Widget Manager) to create a Chart
Widget.

To create a Chart Widget:

1. Create a Widget.

2. In the Type drop-down list, select Chart.
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3. Define the following properties:
◦ General: Default title, refresh, and exclude from filter properties.

◦ Series: Define one or multiple data series to display in the Chart Widget, and the properties for
each series.
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◦ X-Axis: How the x-axis looks and behaves (example: Value type and units, and label, indexing,
and value display options).

◦ X-Axis Sorting: How x-axis values are sorted (example: By type, label, query, Lookup Table,
etc.).

◦ Y-Axes: How one or more y-axes look and behave (example: Labels and scale; the scale can
be calculated or fixed).

◦ Legends: How the legend looks and behaves (example: Visibility, docking, and alignment).

◦ Display: How the chart itself looks and behaves (example: Items to show, color palette,
animation, and Dashboard Theme color/style overrides.
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Define General Properties for a Chart Widget
Use the top portion of the Chart Widget Properties window (accessed from within the Widget Manager) to
define the following general properties for a Chart Widget.

• Default title:

Title to display above the Widget to identify it on a Dashboard.

• Refresh:

How often to automatically refresh the Widget (example: Every 5 minutes).

• Exclude from Filter:

Excludes the Widget from being filtered by any and all Dashboard filters (In other words, ignores any
Dashboard filter). Typically, this is selected if the Widget has its own defined Date/Time filter.

Good to know:

• A preview of the Widget (with randomly generated data) is available at the top of the window. Use•
this to preview your Widget as you build it.

• Refresh executes only when a Widget is active and being displayed. If you leave a dashboard and•
come back to it, the data will be automatically refreshed and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.

To define general properties for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Define general properties:

Note: These properties apply to the Chart Widget in general. Data series properties are
defined for each individual series.

a. Default Title:

Provide the title to display above the widget. The font, style, and color is inherited from the
dashboard on which this widget resides.
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Note: You can change this title (Controls text box) when you put the Widget on a
Dashboard; however, the title is not dynamic so changes will not be pushed back to
this field. Likewise, if you later change this title in Widget Properties, the changes will
NOT be pushed out to all the places it resides on Dashboards. For more formatting
flexibility, use a "floating" Text Widget to display a label or title for a Widget.

b. Refresh Every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

c. Exclude From Filter:

Select this check box to exclude the Widget from being filtered by any filter (Filter Widget)
being used on a Dashboard. (Dashboard filters limit multiple Widgets/data series at once).
Typically, this is selected if the Widget has its own Date/Time filter.

4. Select OK.4.
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Define a Series for a Chart Widget
Use the Series page (in the Chart Widget Properties window) to define the data series to display on a
Chart Widget. You can define one or multiple series:

• Single Series: Allows you to track one data point (example: Number of Incidents by status).

• Multiple series: Allows you to compare values so that you can detect and forecast patterns. For
example:

◦ Mean Time to Resolve Incidents (MTTR vs. Resolved/Closed Incidents).

◦ Mean Time To Resolve Incidents by Priority (P1 vs. P2 vs. P3, etc.).

◦ Trending by Business Object (Number of Incidents, Problems, Changes, and Requests).

Note: The Chart Widget Properties window is accessed from within the Widget
Manager when you create or edit a Chart Widget.

Good to know:
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• You must have at least one series in a Chart Widget (CSM creates one by default).

• Doughnut, Pie, and Pipeline charts contain only one series.

• Bar, Column, Line or Scatter charts can contain multiple series, and can be combined in any way or
number; however, you cannot mix field types. The x-axis can be only dates, or numbers, or text
strings, not a combination.

• Bar and column series can be clustered (side-by-side) or stacked (series atop one another). For
detailed information about stacking, see Stacked Bar Charts.

• The series has a preview with sample data; however, it is a preview of that data series only. The
Widget preview shows all defined series.

• Data series names are listed in reverse order, with the first created data series on top of all the

others. Use the arrow buttons   to change series order.

• To create a new series, click the New button .

• To edit an existing series, click the series, and then click the Edit button . Each series can have
its own individual set of properties.

To define a series for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the Series page.

CSM automatically creates a series (you must have at least one).

4. To create a new series, click the New button . To edit an existing series, click the series, and then

click the Edit button .

5. Define general series properties:
a. Name: Provide a display name to use in CSM. This is displayed on the legends and axes.

b. Series Type: Select a Chart Type:
◦ Bar

◦ Column

◦ Doughnut

◦ Line

◦ Pie

◦ Pipeline

◦ Scatter

c. Business Object: Select the Business Object whose data you want to include in the series.
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Tip: Only one type of Business Object can be selected. The drop-down displays only
Major Business Objects. To display all Business Objects, select the Show All check
box.

d. Show in Legend: Select this check box to display the name of the series in the Chart Widget
legend.

e. Combine Mode (Bar and Column series only): Select how to draw the data series bars/
columns (select one):

◦ Clustered: Draw bars/columns side-by-side on a common x or y-axis.

◦ Stacked: Stack data series atop one another on a shared x or y axis; the size of each
data segment is proportional to its value (bars/columns will likely appear staggered or
uneven).

◦ Stacked 100: Stack data series atop one another so that the data series total 100% of
the bar/column (bars/columns will be the same height).

f. Stack Group: Select the group key on which to stack the series (example: Stack series 1-2 on
stack group 1, stack series 3-4 are on stack 2).

6. Define options for the different Chart Types (series options vary by Chart Type):
◦ Define options for a Bar, Column, Line, or Scatter Chart Widget.

◦ Define options for a Pie/Doughnut Chart Widget.

◦ Define options for a Pipeline Chart Widget.

7. Select OK.7.
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Define Options for a Bar, Column, Line, or Scatter
Chart Widget

Define the following options for a Bar, Column, Line, or Scatter Chart Widget series. Each series can have
its own individual set of properties:

• Criteria: Data/records to include in the chart (example: Open Incidents). Data is located/filtered
using a saved Search Query (Saved Search) or a custom Search Query.

• X-Axis: Values for the x-axis (example: Dates, Statuses, Priorities, etc.).

• Y-Axis: Values for the y-axis (example: Number of Records, Function, or Duration).

• Grouping: When and how values are grouped (ex: Multiple priority bars are grouped by date).

• Custom Colors: Custom colors for the parts of the chart (example: Bars, columns, line/scatter
points). These override the default Dashboard Theme colors.

• Combine Values: When and how to combine negligible values.

• Analysis: Analysis formulas (example: Forecasting/trend lines).

• Drill-Down: Drill-down behavior (ex: Go to a Record List, Execute a command, or Go to a
Dashboard).

• Point Label Format: Format text and numbers for point labels on a chart series. Formatting options
vary by category (Number, Currency, Percentage, or Custom).

• Display: How to display point label and tooltip values on a chart series (overrides point label
formatting options).

CSM 2022.3 Features 1726

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fsearching%2Fabout_search_groups.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fsearching%2Fcustom_query_builder.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2F..%2Fshared%2Fdashboard_themes.html
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_point_label_formats_for_a_bar_column_line_or_scatter_chart_widget
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=define_display_options_for_a_bar-_column-_line-_or_scatter_chart_widget


Define Criteria (Data) for a Bar, Column, Line, or
Scatter Chart Widget

Use the Criteria page (accessed from within the Chart Series window) to define which data/records to
include in the Chart Widget series (ex: Open Incidents). Properties include:

• Search Criteria: Data to include in the chart series (ex: All Incidents). Data is located/filtered using a
saved Search Query (Saved Search) or a custom Search Query.

• Date Range: Timeframe for the Search Query (ex: Any Time (default), Within Last 1 Year, User-
selectable, etc.). If a Date Range Widget filter is defined, you must select the Exclude from Filter
check box so that the Widget filter overrides any and all Dashboard filters. If a User-selectable
Widget filter is defined, the Widget filter automatically overrides any and all Dashboard filters.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Anytime is the default date range and does not limit the Widget to any range. Use Anytime when
you will be using a Dashboard filter to globally filter all Widgets on a Dashboard.

• Field used for date range is usually when a record was created or modified but can be based on any
Date/Time field.

To define data for a chart series:

1. Create a Chart Widget

2. In the Chart Series window, click the Criteria page.
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3. Define the search criteria (data to include in the chart series—ex: All Incidents). Data is located
using one the following options:

◦ Saved Search Query: Click the Ellipses button  to open the Search Manager, and then
select an existing Saved Search (saved Search Query) or create a Saved Search. Saved
Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

4. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (ex: Anytime or Previous Year), or click the New button to define a
new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.
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b. Field used for date range: Select the Field to use to give the range perspective (ex:
LastModDateTime gives Previous Year perspective).

5. Select OK.5.
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Define the X-Axis Values for a Bar, Column, Line, or
Scatter Chart Widget

Use the X-Axis page (accessed from within the Chart Series window) to define the values to display on
the x-axis of a bar, column, line, or scatter chart widget.

Properties include:

• Field name: Field whose values will be displayed in the chart as bars, columns, lines, or scatter
points (example: Status values—New, Assigned, In Progress, etc.).

Note: In column, line, and scatter charts, the x-axis is the horizontal axis. In bar charts, the
x-axis is the vertical axis because the bars go across the chart.

• Lookup Sorting: The Lookup Table and field values to use for sorting x-axis values.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a chart widget, and then add a series.

To define the x-axis values for a bar, column, line, or scatter chart:

1. Create a Chart Widget.
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2. In the Chart Series window, select the X-Axis page.

3. Define the values to display on the x-axis:
a. Field name: Select the Field whose values will be displayed in the chart as bars, columns,

lines, or scatter points (example: Status values—New, Assigned, In Progress, etc.).

Tip: The available fields are limited by value type (  Date/Time,  Number,  Text,
and  Logical). If the field you want is not available, change the x-axis x-value type on
the Widget Properties X-Axis page.

b. Use Foreign Key: You can enable the use of a foreign key on the drill-down of the value. When
you drill down into a single value in a chart widget, it displays a record list. Enabling the use of
foreign key lookup ensures the use of the validation ID property, so results return matching
records created in all cultures. The check box is only visible and applicable to fields that are
configured for globalization and validated against a localized lookup table.

4. Define lookup sorting properties for the x-axis values:
a. Lookup Table: Select a Lookup Table to use to sort x-axis values for the series.

b. Source Field: Select a source field from the Lookup Table. Only fields that are of the same
type as the field name selection are shown.

c. Target Field: Select a target field from the Lookup Table. Only fields that are of the same type
specified in the x-axis sorting options are shown.

Note: If a value from a source field matches the x-value of a point on the series, the
value from the target field for that record is used. Otherwise, the x-value is used as-is.

5. Select OK.5.
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Define the Y-Axis Values for a Bar, Column, Line, or
Scatter Chart Widget

Use the Y-Axis page (accessed from within the Chart Series window) to define the values to display on
the y-axis of a Bar, Column, Line, or Scatter Chart Widget. Values can be based on:

• The number of records.

• A calculated function (average, maximum, minimum, or total): For example, an average customer
satisfaction rating.

• A calculated duration (average, maximum, minimum, or total based on an amount of time): For
example, the average amount of time that Incidents (meeting your criteria) take to resolve each day.

Note: In Column, Line, and Scatter charts, the y-axis is the vertical axis. In Bar charts, the y-
axis is the horizontal axis because the bars go across the Chart.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define the y-axis values for a Bar, Column, Line, or Scatter Chart:
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1. Create a Chart Widget.

2. In the Chart Series window, click the Y-Axis page.

3. Define the values to display on the y-axis. Values can be:
◦ Number of records: Select this radio button to display the number of records that match the

criteria (example: 15 Open Incidents).

◦ Function: Select this radio button to display a value that calculates an average, maximum,
minimum, or total value based on a selected Field, and then select the function and Field
(example: Display the average cost of Incidents that meet the criteria; Function = Average and
Field = Cost).

◦ Duration function: Select this radio button to calculate a value based on an amount of time,
and then select the Start/End Fields and the units (duration) (example: Display the average
amount of time that Incidents (meeting your criteria) take to resolve each day (example: Start
Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days).

4. Axis Type: Associate the data series with an axis, either:
◦ Primary (default): Select this radio button to associate the data series with the y-axis to the left

of the chart.

◦ Secondary: Select this radio button to associate the data series with the y-axis on the right of
the chart.

Tip: Use a secondary axis when you have two or more data series with ranges that are
very different in magnitude and you want to display details of both (example: Data
series 1 has values ranging from 0 to 5; data series 2 has values ranging from 0 to
2000). Displaying them on the same y-axis would mean data series 1 would look flat.

5. Select OK.5.
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Define How Values are Grouped for a Bar, Column,
Line, or Scatter Chart Widget

Use the Grouping page (accessed from within the Chart Series window) to define when and how values
are grouped in a Bar, Column, Line, or Scatter Chart Widget. Use this data to further break down your
main field and to view patterns. For example, group:

• Category by status: Displays a bar, column, line, or point for each status within each category.

• Status by owner: Displays a bar, column, line, or point for each owner within a status.

• Status by priority: Displays a bar, column, line, or point for each priority within a status.

The following figures show Incident by Status column charts, ungrouped and then grouped by priority:

Column Chart - Incidents by Status Grouped Column Chart - Incidents by Status, Grouped
by Priority

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a series.

Good to know:

• Use grouping on simpler charts. Grouping values on multi-series charts and stacked charts can
clutter the data.

To define how values are grouped for a Bar, Column, Line, or Scatter Chart Widget:

1. Create a Chart Widget.

2.

3. Define how values are grouped:
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a. Group by: Select this check box to enable grouping.

b. Field: Select the Field to use to group values (example: Priority).

c. Units (date/time Fields only): Select the date/time unit to display.

4. Select OK.4.
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Define a Custom Color for an X-Value in a Bar,
Column, Line, or Scatter Chart Widget

Use the Custom Colors page (accessed from within the Chart Series window) to define a custom color for
a specific x-value on a Bar, Column, Line, or Scatter Chart Widget (example: Make Reopened Incidents
(Status=Reopened) red to signify a higher priority). The x-value is represented by a bar in a bar chart, a
column in a column chart, and a point in a line or scatter chart.

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a Series.

Good to know:

• By default, bar/column/point colors come from the Chart Color Palette defined in a Dashboard
Theme; selecting a custom color overrides the Dashboard Theme palette.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).

To define a custom color for an x-value in a Bar, Column, Line, or Scatter Chart Widget:

1. Create a Chart Widget.

2.

3. Define a custom color for an x-value:
a. Click the Create New button .

b. Provide the value for which you want to select a custom color (example: "Reopened").

c. Click the Color Selector button  to open the Color Selector, and then select a color:
◦ System:
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Set of colors provided by your operating system. System colors can vary greatly
depending on the operating system and browser used to view the color.

◦ Web:

Set of named web-safe colors.

◦ Custom:

Customized red, green, blue (RGB) colors.

d. Select OK.d.

Tip: Click the Edit button to change a selected color; click the Delete button to remove
a selected color from the list

e. Show a different color for each value: Select this check box to show a different color for each
value. If you do not define custom colors for each value, colors are assigned to each value
based on the Chart Color Palette.

Note: For Bar and Column Charts that do not use grouping, the default behavior is for
every bar/column to be the same color.

4. Select OK.4.
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Define How Values are Combined for a Bar,
Column, Line, or Scatter Chart Widget

Use the Combine Values page (accessed from within the Chart Series window) to define when and how to
combine negligible values (values so small that they can be ignored) in a Bar, Column, Line or Scatter
Chart Widget. This is useful to remove noise values from a chart that just confuse the real data.
Properties include:

• Combine Negligible Numbers: Enables combining negligible values.

• Values: Values to combine (example: Less or Equal to 1).

• What to do with combined values: Hide (disregard) the values or combine them into a category in
the chart (example: Other).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define how values are combined for a Bar, Column, Line, or Scatter Chart Widget:

1. Create a Chart Widget.

2. In the Chart Series window, click the Combine Values page.

3. Define the rules for combining negligible values:
a. Combine negligible values: Select this check box to enable combining negligible values.

b. Values: Select the threshold (operator and quantity) for combining the values (example: Less
than a defined quantity of 1).

c. Specify what to do with the negligible values, either:
◦ Hide these values: Select this radio button to hide (disregard) the values (they are not

included in the chart).

◦ Combine into category: Select this radio button to combine the negligible values into a
named category, and then provide a label for the category (example: "Other").

4. Select OK.4.
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Define Analysis for a Column, Line, or Scatter
Chart Widget

Use the Analysis page (accessed from within the Chart Series window) to define Analysis formulas
(example: Forecasting/trend lines) for a Column, Line, or Scatter Chart Widget. Formulas include:

• Trend Lines: A Trend Line is a straight line that connects two or more points on a chart to indicate a
pattern. Use a Trend Line on your Column, Line, or Scatter Chart Widgets to analyze trends so that
you can more accurately forecast and implement mitigation strategies. For example, use a Trend
Line to display/predict a pattern for:

◦ Number of Incidents that your Service Desk logs.

◦ How long it takes to resolve P1 Incidents.

◦ How many planned and unplanned changes affect your organization.

Note: You can also add an error range above and below the Trend Line.

The following figures show a Chart Widget with a Trend Line, with and without a calculated error
range.

 

Trend Lines are highly configurable, so you define:

◦ Whether or not to display a Trend Line.

◦ Whether or not to display an error range above and below a Trend Line.

◦ Whether or not to display the Trend Line and error range in the Chart Widget legend.

◦ Colors for the Trend Line, error range border, and error range background.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:
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• Trend Lines are available only on Column, Line, and Scatter Charts.

• Trend Lines can be added for one or more series in a chart.

• Forecasting formulas (example: Trend Lines) are not available when individual values are plotted
next to one another in a chart.

• Formulas cannot apply to stacked series. Because the origin of the stacked points are not at the x-
axis, stacked series points are not drawn at their actual Cartesian coordinates.

To define Analysis for a Column, Line, or Chart Widget:

1. Create a Chart Widget.

2. In the Chart Series window, click the Analysis page.

3. Define the formula to use for analyzing the data in the Chart Widget. Currently, Forecasting (Trend
Lines) is the only option.

4. Define the analysis parameters:
a. Regression Type: Select the type of regression for the Trend Line. Currently, only Linear is

supported.

b. Show Approximation Error: Select this check box to display an error range above and below
the Trend Line.

c. Show Approximation in Legend: Select this check box to display the Trend Line (labeled
"Approx") in the Chart Widget legend.

d. Show Error Range in Legend: Select this check box to display the error range (labeled "Error"
in the Chart Widget legend).

5. Define colors for Trend Lines and error ranges (Appearance area):
a. Approximation Line Color: Select a color for the Trend Line.

b. Error Range Border Color: Select a color for the border (top and bottom) of the error range.

c. Error Range Background Color: Select a color for the background (area between the top and
bottom border) of the error range.

6. Select OK.6.
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Define Drill-Down for a Bar, Column, Line, or
Scatter Chart Widget

Use the Drill-Down Properties page (accessed from within the Chart Series window) to define drill-down
behaviors for a series in a Chart Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command/Action (ex: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step Action, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (ex: A Dashboard dedicated to the
Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (ex: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Chart series:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Drill-Down page.
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3. Define a drill-down option for the chart:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Then, click the Ellipses button  to open the Action Manager, where you can select the
command to execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Then, click

the Ellipses button  to open the Dashboard Manager where you can select an existing
Dashboard or create a new Dashboard.

4. Select OK.4.
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Define Point Label Formats for a Bar, Column, Line,
or Scatter Chart Widget

Use the Point Label Format page (accessed from within the Chart Series window) to define formatting
options for point labels on a chart series. Formatting options vary by category (Number, Currency,
Percentage, or Custom) for a series in a Chart Widget. Each series can have its own individual set of
formatting properties, which include:

• Number: Define decimal places and enable 1000 separator, negative sign, and leading zeros.

• Currency: Define decimal places and symbol.

• Percentage: Define decimal places.

• Custom: Define a custom format string.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define point label formats for a Chart Widget:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Point Label Format page.

3. Select a category (select one).

4. Define the following number properties (properties vary by category):
◦ Decimal Places: Specify the number of decimal places to display to the right of a decimal point

(example: 5.0 has one decimal place, 5.00 has two decimal places). Zero (0) indicates a whole
number (no decimal place).

◦ Use 1000 Separator: Select this check box to add a separator (example: Comma) when a
number value reaches 1000. Separators vary depending on locale (example: USA, Europe,
etc.).

◦ Show Leading Zeroes: Select this check box to display zeroes (if any) before a decimal place
(example: 0.7 has a leading zero).

◦ Show Negative Sign: Select this check box to display a negative sign (when applicable) before
a number string (ex: -5.0).

◦ Currency Symbol: By locale (example: English, United States).

◦ Custom: Define a custom format or use an existing one (example:
0,0.00,#.##0,0%,0.00%,0.00E+00, ##0.0E+0).

5. Select OK.5.
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Define Display Properties for a Bar, Column, Line,
or Scatter Chart Widget

Use the Display page (accessed from within the Chart Series window) to display point label and tooltip
values in the Chart Widget series (ex: Open Incidents).

Good to know:

• Each series can have its own individual display properties.

• Settings defined on this page will override point label format options.

To define display properties for a chart series:

1. Create a Chart Widget.

2. In the Chart Series window, click the Display page.

3. Select a display option:
◦ Show point label number values as a percentage of the series total: Select this check box to

use as point labels the Y values as a percentage of the total of all Y values for the chart series.

◦ Show point label number values as a percentage of the series total: Select this check box to
use as tooltips the Y values as a percentage of the total of all Y values for the chart series.

4. Select OK.4.
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Define Options for a Doughnut/Pie Chart Widget
Define the following for a Doughnut/Pie Chart Widget:

• Criteria: Data/records to include in the chart. Data is located/filtered using a saved Search Query
(Search Group) or a custom Search Query.

• Slices: Slices to display in the chart.

• Size of Slices: Size of the slices in the chart.

• Custom Colors: Custom colors for specific slices in a chart. These override the default Dashboard
Theme colors.

• Combine Values: When and how to combine negligible values.

• Drill-Down: Drill-down behavior (example: Go to a Record List, Execute a command, or Go to a
Dashboard).
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Define Criteria (Data) for a Doughnut/Pie Chart
Widget

Use the Criteria page (accessed from within the Chart Series window) to define which data/records to
include in the Chart Widget series (example: Open Incidents). Properties include:

• Search Criteria: Data to include in the chart series (example: All Incidents). Data is located/filtered
using a saved Search Query (Saved Search) or a custom Search Query.

• Date Range: Timeframe for the Search Query (example: Any Time (default), Within Last 1 Year,
User-selectable, etc.). If a Date Range Widget filter is defined, you must select the Exclude from
Filter check box so that the Widget filter overrides any and all Dashboard filters. If a User-selectable
Widget filter is defined, the Widget filter automatically overrides any and all Dashboard filters.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Anytime is the default date range and does not limit the Widget to any range. Use Anytime when
you will be using a Dashboard filter to globally filter all Widgets on a Dashboard.

• Field used for date range is usually when a record was created or modified but can be based on any
Date/Time field.

To define data for a chart series:

1. Create a Chart Widget.

2. In the Chart Series window, click the Criteria page.

3. Define the search criteria (data to include in the chart series—example: All Incidents). Data is
located using one the following options:

◦ Saved Search Query: Click the Ellipses button  to open the Search Manager, and then
select an existing Saved Search (saved Search Query) or create a Saved Search. Saved
Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

4. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (example: Anytime or Previous Year), or click the New button to
define a new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.
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b. Field used for date range: Select the Field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).

5. Select OK.5.
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Define Slices for a Doughnut/Pie Chart Widget
Use the Slices page (accessed from within the Chart Series window) to define the values to display in
the Doughnut/Pie Chart Widget. Each value will be a slice.

Properties include:

• Field Name: Field whose values will be displayed as slice in the pie chart (example: Status Field—
values might be New, Assigned, In Progress, etc.).

• Lookup Sorting: The Lookup Table and field values to use for sorting the values of slices.

 

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a chart widget, and then add a series.

To define slices for a doughnut/pie chart widget:

1. Create a Chart Widget.

2. In the Chart Series window, select the Slices page.

3. Select the field and values to display as slices:
a. Field name: Select the field whose values will be displayed as slices in the doughnut/pie chart

(example: Status values—New, Assigned, In Progress, etc.). Available fields are limited to the
widget's selected field type (example: Date/Time, Number, Text, or Logical).

b. Use Foreign Key: You can enable the use of a foreign key on the drill-down of the value. When
you drill down into a single value in a chart widget, it displays a record list. Enabling the use of
foreign key lookup ensures the use of the validation ID property, so results return matching
records created in all cultures. The check box is only visible and applicable to fields that are
configured for globalization and validated against a localized lookup table.

CSM 2022.3 Features 1748

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=chart_widgets


4. Define lookup sorting properties for the values of the slices:
a. Lookup Table: Select a Lookup Table to use to sort values for the series.

b. Source Field: Select a source field from the Lookup Table. Only fields that are of the same
type as the field name selection are shown.

c. Target Field: Select a target field from the Lookup Table. Only fields that are of the same type
specified in the x-axis sorting options are shown.

Note: If a value from a source field matches the value of a slice in the series, the value
from the target field for that record is used. Otherwise, the slice value is used as-is.

5. Select OK.5.
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Define the Size of Slices for a Doughnut/Pie Chart
Widget

Use the Size of Slices page (accessed from within the Chart Series window) to define how the slices are
proportioned in the Doughnut/Pie Chart Widget (that is, the percentage of the circle that each slice takes
up). Slice size can be based on:

• Number of Records.

• Function: Calculated average, maximum, minimum, or total (example: Average customer
satisfaction rating).

• Duration: Calculated average, maximum, minimum, or total based on an amount of time (example:
Average amount of time that Incidents take to resolve each day).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define the size of slices for a Doughnut/Pie Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Size of Slices page.

3. Define how the slices will be proportioned, either by:
a. Number of records: Select this radio button to proportion each slice as a percentage of the

total number of records that meet the criteria (example: Open Incidents are 25% of the
Incident records).

b. Function: Select this radio button to proportion each slice as a calculated function (average,
maximum, minimum, or total value) based on a selected Field, and then select the function
and Field (example: Display the average cost of Incidents that meet the criteria; function =
average and Field = Cost).

c. Duration function: Select this radio button to proportion the slices as a calculated percentage
based on an amount of time, and then select the Start/End Fields and the units (duration)
(example: Display the average amount of time that Incidents take to resolve each day
(example: Start Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days)).

4. Select OK.4.
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Define a Custom Color for a Slice in a
Doughnut/Pie Chart Widget

Use the Custom Colors page (accessed from within the Chart Series window) to define a custom color for
a specific slice (value) in a Doughnut/Chart Widget (example: Make reopened Incidents
(Status=Reopened) red to signify a higher priority).

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a Series.

Good to know:

• By default, slice colors come from the Chart Color Palette defined in a Dashboard Theme; selecting
a custom color overrides the Dashboard Theme palette.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).

To define a custom color for a slice in a Doughnut/Pie Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Custom Colors page.

3. Define a custom color for a slice:
a. Click the Create New button .

b. Provide the value (represented as slice) for which you want to select a custom color (example:
"Reopened").

c. Click the Color Selector button  to open the Color Selector, and then select a color:
◦ System:
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Set of colors provided by your operating system. System colors can vary greatly
depending on the operating system and browser used to view the color.

◦ Web:

Set of named web-safe colors.

◦ Custom:

Customized red, green, blue (RGB) colors.

d. Select OK.d.

Note: Click the Edit button  to change a selected color; click the Delete button  to
remove a selected color from the list

e. Show a different color for each value: Not applicable for pie/doughnut charts. By default, each
slice is assigned a different color.

4. Select OK.4.
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Define How Values are Combined for a
Doughnut/Pie Chart Widget

Use the Combine Values page (accessed from within the Chart Series window) to define when and how to
combine negligible values (values so small that they can be ignored) in a Doughnut/Pie Chart Widget.
This is useful to remove noise values from a chart that just confuse the real data. Properties include:

• Combine Negligible Numbers: Enables combining negligible values.

• Values: Values to combine (example: Less or Equal to 1).

• What to do with combined values: Hide (disregard) the values or combine them into a category in
the chart (example: Other).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define how values are combined for a Doughnut/Pie Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Combine Values page.

3. Define the rules for combining negligible values:
a. Combine negligible values: Select this check box to combine negligible values.

b. Values: Select the threshold (value and quantity) for combining the values (example: Less
than a defined quantity).

c. Specify what to do with the negligible values:
◦ Hide these values.

◦ Combine into category: Select this check box to combine the negligible values into a
defined category (example: Other), and then provide a label for the category.

4. Select OK.4.
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Define Drill-Down for a Doughnut/Pie Chart Widget
Use the Drill-Down Properties page (accessed from within the Chart Series window) to define drill-down
behaviors for a series in a Chart Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command/Action (example: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step Action, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (example: A Dashboard dedicated to
the Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (example: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Chart series:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Drill-Down page.

3. Define a drill-down option for the chart:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Then, click the Ellipses button  to open the Action Manager, where you can select the
command to execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Then, click

the Ellipses button  to open the Dashboard Manager, where you can select an existing
Dashboard or create a new Dashboard.
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4. Select OK.4.
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Define Criteria (Data) for a Pipeline Chart Widget
Use the Criteria page (accessed from within the Chart Series window) to define which data/records to
include in the Chart Widget series (example: Open Incidents). Properties include:

• Search Criteria: Data to include in the chart series (example: All Incidents). Data is located/filtered
using a saved Search Query (Saved Search) or a custom Search Query.

• Date Range: Timeframe for the Search Query (example: Any Time (default), Within Last 1 Year,
User-selectable, etc.). If a Date Range Widget filter is defined, you must select the Exclude from
Filter check box so that the Widget filter overrides any and all Dashboard filters. If a User-selectable
Widget filter is defined, the Widget filter automatically overrides any and all Dashboard filters.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Anytime is the default date range and does not limit the Widget to any range. Use Anytime when
you will be using a Dashboard filter to globally filter all Widgets on a Dashboard.

• Field used for date range is usually when a record was created or modified but can be based on any
Date/Time field.

To define data for a chart series:

1. Create a Chart Widget

2. In the Chart Series window, click the Criteria page.

3. Define the search criteria (data to include in the chart series—example: All Incidents). Data is
located using one the following options:

◦ Saved Search Query: Click the Ellipses button  to open the Search Manager, and then
select an existing Saved Search (saved Search Query) or create a Saved Search. Saved
Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

4. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (example: Anytime or Previous Year), or click the New button to
define a new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.

b. Field used for date range: Select the Field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).
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5. Select OK.5.
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Define Slices for a Pipeline Chart Widget
Use the Slices page (accessed from within the Chart Series window) to define the values to display in
the Pipeline Chart Widget. Each value will be a slice.

Properties include:

• Slice: Field whose values will be displayed as slice in the pipeline (example: Status field—values
might be New, Assigned, In Progress, etc.).

• Display:
◦ What labels to display on the slices (name, percent, value).

◦ Where to put the labels (On slices or on side). In the Browser Client, labels can only be placed
on slices.

◦ How to format the labels (Dash before side labels, color side labels, space between slices, and
number of decimals spaces to display in the values. This will be used for both values and
percentages.

Note: The Chart Series window is accessed from within the Widget Manager when
you create or edit a chart widget, and then add a series.

To define slices for a pipeline chart widget:

1. Create a chart widget.

2. In the Chart Series window, select the Slices page.

3. Select the values to display as slices:
a. Field Name: Select the field whose values will be displayed as slices in the pipeline (example:

Status field—values might be New, Assigned, In Progress, etc.).
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Note: If the field you select is validated, the information automatically populates the List of
Slices information.

b. Use Foreign Key: You can enable the use of a foreign key on the drill-down of the value. When
you drill down into a single value in a chart widget, it displays a record list. Enabling the use of
foreign key lookup ensures the use of the validation ID property, so results return matching
records created in all cultures. The check box is only visible and applicable to fields that are
configured for globalization and validated against a localized lookup table.

c. List of Slices: Select the Business Object/field that supplies the values to the above field
(Typically, this is a Lookup Object/field):

i. Business Object: Select the Lookup Object that supplies all the possible values for the
above field (example: Incident Status).

ii. Value Field: Select the Lookup field (Field in the above Lookup Object) that supplies the
values (example: Status).

iii. Order By: Select the field to use to order the values in the pipelines, as well as an
ascending (example: 0-10, A-Z) or descending (10-0, Z-A) order.

Note: Rarely will the alphabetical order match the order in which the values
should appear in the pipeline, unless you prefix the values with numbers or
letters (example: For status, you would likely want lifecycle order, not
alphabetical order); therefore, it is common to define a field that contains a
sequence number purely for controlling the order (example: Status Order).

d. Show all values, even if no data: Select this check box to display a slice even if there is no
data for it (example: There are no Incidents). The default behavior is to not display a slice if
there are no values for it.

4. Define display options for the slices and values:
◦ Labels on slices: Select this check box to display the values as labels inside each slice. You

can display the name, percentage, and/or actual value.

◦ Labels on side: Select this check box to display the values as labels on the right side of each
slice. You can display the name, percentage, and/or actual value.

◦ Dash before side labels: Select this check box to include an em dash before the side values.

◦ Color side labels: Select this check box to make the side value text the same color as the slice
it represents.

◦ Space between slices: Select this check box to add a small space between the slices.

◦ Decimals: Specify the number of decimals spaces to display in the values. This is used for
both values and percentages.

5. Select OK.5.
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Define Options for a Pipeline Chart Widget
Define the following for a Pipeline Chart Widget:

• Criteria: Data/records to include in the chart. Data is located/filtered using a saved Search Query
(Search Group) or a custom Search Query.

• Slices: Slices to display in the pipeline chart.

• Size of Slices: Size of the slices in the pipeline chart.

• Custom Colors: Color of the slices in the pipeline chart. These override the default Dashboard
Theme colors.

• Drill-Down: Drill-down behavior (example: Go to a Record List, Execute a command, or Go to a
Dashboard).
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Define the Size of Slices for a Pipeline Chart
Widget

Use the Size of Slices page (accessed from within the Chart Series window) to define how the slices are
proportioned in the Pipeline Chart Widget (that is, the percentage of the pipeline that each slice takes up).
Slice size can be based on:

• Number of Records.

• Function: Calculated average, maximum, minimum, or total (ex: Average customer satisfaction
rating).

• Duration: Calculated average, maximum, minimum, or total based on an amount of time (example:
Average amount of time that Incidents take to resolve each day).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define the size of slices for a Pipeline Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Size of Slices page.

3. Define how the slices will be proportioned, either by:
◦ Number of records: Select this radio button to proportion each slice as a percentage of the

total number of records that meet the criteria (example: Open Incidents are 25% of the
Incident records).

◦ Function: Select this radio button to proportion each slice as a calculated function (average,
maximum, minimum, or total value) based on a selected Field, and then select the function
and Field (example: Display the average cost of Incidents that meet the criteria; function =
average and Field = Cost).

◦ Duration function: Select this radio button to proportion the slices as a calculated percentage
based on an amount of time, and then select the Start/End Fields and the units (duration)
(example: Display the average amount of time that Incidents take to resolve each day (ex:
Start Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days).

4. Select OK.4.
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Define a Custom Color for a Slice in a Pipeline
Chart Widget

Use the Custom Colors page (accessed from within the Chart Series window) to define a custom color for
a slice (value) in a Pipeline Chart Widget (ex: Make reopened Incidents (Status=Reopened) red to signify
a higher priority).

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a Series.

Good to know:

• By default, slice colors come from the Chart Color Palette defined in a Dashboard Theme; selecting
a custom color overrides the Dashboard Theme palette.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).

To define a custom color for a slice in a Pipeline Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Custom Colors page.

3. Define a custom color for a slice:
a. Click the Create New button .

4. Select the value (represented as slice) for which you want to select a custom color (example:
"Reopened").

a. Click the Color Selector button  to open the Color Selector, and then select a color:
◦ System:
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Set of colors provided by your operating system. System colors can vary greatly
depending on the operating system and browser used to view the color.

◦ Web:

Set of named web-safe colors.

◦ Custom:

Customized red, green, blue (RGB) colors.

b. Select OK.b.

Note: Click the Edit button  to change a selected color; click the Delete button  to
remove a selected color from the list

c. Show a different color for each value: Not applicable for a pipeline chart. By default, each slice
is assigned a different color.

5. Select OK.5.
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Define Drill-Down for a Pipeline Chart Widget
Use the Drill-Down Properties page (accessed from within the Chart Series window) to define drill-down
behaviors for a series in a Chart Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command/Action (example: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step Action, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (example: A Dashboard dedicated to
the Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (example: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Chart series:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Drill-Down page.

3. Define a drill-down option for the chart:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Then, click the Ellipses button  to open the Action Manager, where you can select the
command to execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Then, click

the Ellipses button  to open the Dashboard Manager, where you can select an existing
Dashboard or create a new Dashboard.

4. Select OK.4.
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Define an X-Axis for a Chart Widget
Use the X-Axis page (accessed from within the Chart Widget Properties window) to define how an x-axis
looks and behaves in a Chart Widget. Properties include:

• Value Type: Date/Time, Number, Text, or Logical (True/False).

• Value Units (Date/Time value only): Days, Weeks, Months, Quarters, Years, Hours, Minutes, or
Seconds.

• Label: Text to display on the x-axis.

Doughnut and Pie Charts only:

• Label Location: Where to place the labels on a Doughnut/Pie Chart (ex: Inside the slice, Outside
the slice with a line connector, Outside Near the slice aligned in columns with a line connector).

Inside Outside Outside Near

Date/Time and Number values only:

• Axis Represents: Timeline or Numeric Sequence, with values distributed over time/number
line: Distributes data points in order on a continuous timeline or numeric sequence (ex: Earliest to
latest date for Date/Time values and 1-100 for Number values). For example, the following figures
show Column, Line, and Scatter Charts that plot on a timeline (May through November) the # of
Incidents and the # of Requests Resolved on First Call each month. Months with no data points (ex:
August through October) ARE included in the timeline (x-axis).
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Timeline on Column Chart Timeline on Line Chart

  

Timeline on Scatter Chart

• Individual values, with data points next to one another: Plots Individual data points next to one
another with time or numbers for reference. For example, the following figures show Column, Line,
and Scatter Charts that plot the # of Incidents and the # of Requests resolved on First Call, with the
month for reference. Note that months with no data (ex: Aug through October) are NOT included in
the x-axis. Also note that a line is not drawn from one point to the next point in a series when there
is a "missing" x-value between the points (ex: When two or more series do not have the same
number of points, such as FCR Request not having a July data point).
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Individual Values on Column Chart Individual Values on Line Chart

  

Individual Values on Scatter Chart

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• You can have multiple data series in a chart but all series must be the same Value Type (ex: All
Date/Time).

• The x-axis values themselves are defined as part of the series (see Define a Series for a Chart
Widget).

• In Column, Line, and Scatter Charts, the x-axis is the horizontal axis. In Bar Charts, the x-axis is the
vertical axis because the bars go across the chart.
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• Forecasting formulas (ex: Trend Lines) are not available when individual values are plotted next to
one another in a chart.

• Prior to CSM 4.6, all charts plotted individual values on the x-axis (timeline was not available).

To define an x-axis for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the x-axis page.
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4. Define the following properties:
a. X-Value Type: Select the type of data to display on the x-axis (you can have multiple data

series but all series must be the same type of data):
◦ DateTime

◦ Number

◦ Text

◦ Logical (True/False)
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b. X-Value Units (Date/Time value only): Select the date/time units (ticks) to display on the x-
axis (ex: Days, Weeks, Months, Quarters, Years, Hours, Minutes, or Seconds).

c. Label: Provide the text to display on the x-axis.

Tip: Typically, the x-axis is labeled with the name of the Field whose data it displays.

d. Show Label for All Items: Select this check box to display a label for every tick on the x-axis.
Otherwise, the chart only displays labels for some ticks to save space.

e. Label Location (Doughnut/Pie Chart only): Select where to place the labels on a Doughnut/Pie
Chart (ex: Inside, Outside, Outside Near).

f. Axis represents (Date/Time and Number values only): Select one option:
◦ Timeline or Numeric Sequence, with values distributed over time: Select this radio

button to distribute data points in order on a continuous timeline or numeric sequence
(ex: Earliest to latest date for Date/Time values and 1-100 for Number values).

◦ Individual values, with data points next to one another: Select this radio button to
plot individual data points next to one another with time or numbers for reference.

g. Enable Custom Category Placement: Select this check box to enable the placement of one
axis value at either the start or end of the x-axis:

◦ Category Value: Provide the text of the axis label of the category that you want to match.

◦ Placement: In the drop-down, select where on the x-axis to place the category value
(either Start or End).

Note: Custom Category Placement can be enabled for all charts except pie,
doughnut, and pipeline, and does not work for continuous numeric or date/time
axes.

5. Select OK.5.
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Define X-Axis Sorting Options for a Chart Widget
Use the X-Axis Sorting page (accessed from within the Chart Widget Properties window) to define how
to sort values on the x-axis of a chart widget.

To define x-axis sorting options for a chart widget:

1. Create a Widget

2. In the Type menu, select Chart.
3. Select the x-axis Sorting page.

4. Define the sort order:
◦ Ascending (example: 0-10, A-Z)

◦ Descending (example: 10-0, Z-A)

5. Define the sorting method:
◦ Sort Based on X-Axis Type: Select this radio button to sort x-axis values based on the x-value

of each point (example: If the x-axis field is a number, the points are sorted in numerical
order).

◦ Sort Based on X-Axis Labels: Select this radio button to sort x-axis values in alphabetical order
based on the labels of the x-axis points.

◦ Use Query Sorting: Select this radio button to sort x-axis values based on the query properties
defined in the series criteria (the search query used to retrieve data). Because sorting is done
as part of the query, results are based on the table field type being sorted. This only applies to
single series charts to avoid sort order conflicts between two series.

◦ Sort by Y Value: Select this radio button to sort x-axis values based on their corresponding y
values. You can select a number by which to limit the results and show either the top N results
or the bottom N results.

Note: This option is only available for charts with single, non-grouped series.

◦ Sort by Lookup Value: Select this radio button to sort x-axis values using values from a Lookup
Table and fields. The Lookup Table is selected in the specific x-axis settings for the chart
series. The Lookup Target field type (example: Text, Date/Time, Number) is based on the
target field selected in the specific x-axis settings for the chart series.

Note: If no specific x-axis sorting settings are defined for a series, the raw x-values are used
(same as when sorting based on x-axis type). Sorting is based on the type of sort fields
(example: Text, Number, etc.), and the sort field types for each series must match.

6. Select OK.6.
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Define Y-Axes for a Chart Widget
Use the Y-Axes page (accessed from within the Chart Widget Properties window) to define how one or
more y-axes look and behave in a chart widget.

A chart widget can have two y-axes:

• Primary Y-axis (Y1): Left side of chart.

• Secondary Y-axis (Y2): Right side of chart. A secondary y-axis can distinguish the types of mixed
data (from different series) being compared against a common category (x-axis). For example, when
comparing two series of data against a common time period (x-axis), use a primary y-axis for a
series that uses Number of Incidents as its unit of measure, and a secondary y-axis for a series that
uses an Average Customer Satisfaction (rating) as its unit of measure.

The following figure shows a chart that plots two series of data against a common time period. Two
y-axes are used to distinguish the different units of measure (# of Incidents and Average Customer
Sat).

Properties for each axis include:

• Label: Text to display on the y-axis.

• Automatic Scaling: Whether to automatically calculate or manually specify ("fix") the scale values on
the y-axis. If you manually specify the scale values, you must provide a minimum and maximum
value.

Note: The Chart Widget Properties window is accessed from within the Widget Manager
when you create or edit a Chart Widget.

CSM 2022.3 Features 1773

CSM 2022.3 Features

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=chart_widgets


Good to know:

• A secondary y-axis is optional.

• Scale values on the y-axes can be automatically calculated or "fixed."

• The y-axis values themselves are defined as part of the series (see Define a Series for a Chart
Widget).

To define one or more y-axes for a chart widget:

1. Create a Widget

2. In the Type field, select Chart.
3. Select the Y-Axes page.

4. Define the following properties for your primary and secondary y-axes:
a. Label: Provide the text to display on the y-axis.

b. Use automatic scaling: Select this check box to automatically calculate the scale values on the
y-axis. Clear this box to manually define or "fix" the axis, and then define the fixed minimum
and maximum scale values for the axis.

Note: A fixed scale makes sense when you have a clear idea of your range. For
example, if you are showing percentages, and the highest current value is 10%, when
automatically scaled, 10% will be the maximum value, and will appear to fill the entire
chart, when really you want to see that 10% is only a small fraction of the expected
value.

5. Select OK.5.
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Define a Legend for a Chart Widget
Use the Legend page (accessed from within the Chart Widget Properties window) to define how a legend
looks and behaves on a Chart Widget. Properties include:

• Show Legend: Shows/hides a legend.

• Docking: Top, Left, Right, or Bottom, and aligned Near, Center, or Far.

• Alignment: Near, Center, or Far.

• Wrapping: Enable or disable wrapping of legend text.

• Constraint legend width: Set the maximum width of legend item text.

Note: The Chart Widget Properties window is accessed from within the Widget Manager when
you create or edit a Chart Widget.

To define the legend for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the Legend page.

4. Define properties:
a. Show Legend:

Select this check box to display a legend on the chart. The legend identifies the series on the
chart; the text is defined in the Series Name field (Series window).

b. Docking:
Select a docking option for the legend:

◦ Top

◦ Left
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◦ Right

◦ Bottom

c. Alignment:
Select an alignment option for the legend:

◦ Near

◦ Center

◦ Far

5. Wrap Legend Items:

Select this check box to wrap text for legend items to improve readability. Legend items are
arranged in columns and ordered from top to bottom, then left to right.

Legend items are added to fill approximately half of the chart's width (left to right docking) or height
(top or bottom docking). Remaining legend items can be viewed by clicking the ellipses at the
bottom of the legend.

6. Constrain Legend Width

Select this check box to control the width of legend text, and then specify the maximum legend item
width in pixels.

Note: The Wrap Legend Items and Constrain Legend Width options do not apply to
Pipeline charts.

7. Select OK.7.
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Define Display Properties for a Chart Widget
Use the Display page (accessed from within the Chart Widget Properties window) to define how a Chart
Widget looks and behaves. Properties include:

• Items to Display: X-axis labels, Y-axis labels, grid lines, and tooltips.

• Color Palette: Colors to use for the items in the chart. By default, these colors are defined in the
Dashboard Theme; however, you can override the default palette.

• Allow Animation: Paints the chart items as they display (example: Columns grow to the values).
Note that chart widgets might paint differently in the Browser Client.

• Show Point Labels: Whether to show Y-axis values and/or X-axis labels on each chart point.

• Advanced options:
◦ Override Dashboard Theme colors.

◦ Override the Dashboard style.

Note: The Chart Widget Properties window is accessed from within the Widget
Manager when you create or edit a Chart Widget.

Good to Know:

• By default, chart colors (banner, labels, and bars/columns/lines/slices) and style (flat, chrome, or
none) come from the defined Dashboard Theme; however, you can override some of the properties.

• Whether to show point labels is defined for the entire chart. However, specific point label formatting
options are defined at the series level. Each series can have its own individual set of formatting
properties.

• Typically, the Advanced options are used to maintain "legacy" Dashboard themes and styles (these
are themes and styles that were created prior to CSM 5.00 and its Theme Manager). Ideally you
want to create and use Dashboard Themes that are created with 5.00+ capabilities. For more
information about Dashboard colors and styles, see Dashboard Themes. Overriding the Dashboard
Theme colors/styles affects your Chart Color Palette colors (i.e., the colors that appear on your bars,
columns, lines, and slices).

To define the Display properties for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the Display page.

4. Define properties for the chart legend:
a. Items to display: Select one or more items to display on the chart (not all items apply for all

chart types):
◦ X-axis labels.

◦ Y-axis labels.

◦ Grid lines.
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◦ Tooltips.

b. Color Palette: Select the color palette to use for the items (example: Bars, columns, and
slices) in the chart. By default, these colors are defined in the Dashboard Theme; however,
you can override the default palette.

c. Allow animation: Select this check box to paint the chart items as they display (example:
Columns grow to the values).

d. Show point labels: Select this check box to have labels displayed next to each point on the
chart. In the drop-down, select an option:

i. Show Value: Show Y-values.

ii. Show Label & Value: Show Y-values along with the X-axis labels.

iii. Show Label: Show X-axis labels.

e. Advanced Options:
i. Override Dashboard Theme Colors: Select this check box to override the colors from the

defined Dashboard Theme with the colors from another Theme, and then select the
Theme that will override the default Theme, either:

◦ From Legacy Theme: Select a legacy Theme from previous versions of CSM.

◦ From Specific Theme: Select another defined Dashboard Theme.

ii. Override Dashboard Styles: Select this check box to override the defined Dashboard
Theme's style (Chrome, Flat, or Legacy) with another Theme style, and then select the
Theme style that will override the default Theme:

◦ Legacy

◦ Flat

◦ Chrome

5. Select OK.5.
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Create a Command Palette Widget
Use the Command Palette Widget Properties window (accessed from within the Widget Manager) to
create a Command Palette Widget.

To create a Command Palette Widget:

1. Create a Widget.

2. In the Type drop-down list, select Command palette.

3. To add a group of Actions:
a. Select Add group.

A New group is added to the list.

b. Name:

Provide a name for the group.

c. Image:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

d. Highlight the group, and then start adding single commands to it (see next step).

4. To add a single Action:
a. Select Add command.

The Action Manager opens, listing the available Actions, organized by category and scope.

b. Select a category, then a scope, then an Action.

Tip: Select the plus sign (+) next to a category to expand it, then navigate through the
scopes to locate the item you want. If the item does not yet exist, select the
"category" button (at the bottom of the window) to launch the item's Manager. From
the Manager, you can create a new item.

c. Select Save.
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Create a Filter Widget
Use the Filter Widget Properties window (accessed from within the Widget Manager) to create a Filter
Widget.

To create a Date Filter Widget:

1. Create a Widget.

2. In the Type drop-down list, select Filter.
3. Select the Business Object whose data you want to filter (example: Incident). Only one type of

Business Object can be selected. The drop-down list displays only Major Business Objects. To
display all Business Objects, select the Show All check box.

4. Define a Date Filter:
a. Select the Filter by Date radio button.

b. Ranges: Select this button to open the Multiple Date Ranges window, and then select one or
more date ranges (example: Any time, Today, Within last 1 week, etc.) to display in the drop-
down list. If you select multiple data ranges, select a default range (example: Any time) to
display in the filter when the Widget first appears.

c. Filter Field: Select the date/time Field whose value limits the Widget (example: Created Date
Time would limit records to created Any Time, created Today, created within the last 1 week,
etc.; Modified Date Time would limit records to modified Any Time, modified Today, modified
within the last 1 week).

d. Hide Date Filters For Other Widgets On Dashboard: Select this check box to hide any other
date-filtered Widgets on the Dashboard so that this Filter Widget controls the date range.

e. If Widget Has a Date/time Filter, Use Its Field (even If Different Business Object Type):
Select this check box to allow a Widget with its own Date/Time filter to use its defined filtering
field instead of the Dashboard filtering field (example: Dashboard filter uses Created Date
Time but individual Widget uses Modified Date Time).

5. Select Save.

To create a Lookup Table Filter Widget:

1. Create a Widget

2. In the Type drop-down list, select Filter.
3. Select the Business Object whose data you want to filter (example: Incident). Only one type of

Business Object can be selected. The drop-down list displays only Major Business Objects. To
display all Business Objects, select the Show All check box.

4. Define the lookup values to display in the filter (example: Filter Incidents by status):
a. Select the Filter by Lookup Table radio button.

b. Define the following:
i. Filter Field: Select the Field in the Business Object from which to retrieve values

(example: Status).

ii. Lookup and Field:
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Select the Lookup table and field that supply all the possible values (example: For
Incident, it might be the Status field in the Incident Status Lookup table, with Status
values like New, In Progress, Assigned, etc.).

iii. Order by:

Select the field to use to order the values, as well as an ascending or descending order.
Rarely will the alphabetical order match the order in which the values should appear in
your item, unless you prefix the values with numbers or letters (example: For status, you
would likely want lifecycle order, not alphabetical order); therefore, it is common to define
a field that contains a sequence number purely for controlling the order (example: Status
Order).

5. Select Save.

To create a Query Filter Widget:

1. Create a Widget

2. In the Type drop-down list, select Filter.
3. Select the Business Object whose data you want to filter (example: Incident). Only one type of

Business Object can be selected. The drop-down displays only Major Business Objects. To display
all Business Objects, select the Show All check box.

4. Define a Query Filter (example: Show Incidents owned by me):
a. Select the Filter by Query radio button.

b. Define the Query using one of the following options:

◦ Select the ellipses button  to open the Search Manager, and then select an existing
Saved Search or create a Saved Search. Saved Searches can be used over and over in
numerous places.

◦ Select Custom Query  to open the Custom Query Builder, and then create a
custom Search Query to use only for this scenario.

CSM 2022.3 Features 1781

CSM 2022.3 Features

https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fbusiness_objects%2Fabout_business_objects.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fsearching%2Fabout_search_groups.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fsearching%2Fcreate_a_search_group.html
https://help.cherwell.com/bundle/csm_features_2022_3_help_only/page/content%2Fsuite_features%2Fwidgets%2F..%2Fsearching%2Fcustom_query_builder.html


5. Select Save.5.

Tip: A Query filter uses a button to toggle the filter on/off  on a
Dashboard. Use the Dashboard Editor to define how the button looks and behaves on the
Dashboard (example: Text, colors, visibility, etc.).
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Create a Flyout Widget
Use the Flyout Widget Properties window in the Widget Manager to create a Flyout Widget.

Note: Any widget that is covered by a Flyout Widget when the Flyout Widget is expanded must be
in a layer that is in front of the Flyout Widget. If the Flyout Widget layer is in front of another
widget, the widget behind the Flyout Widget will be inaccessible even when the Flyout Widget is
collapsed. For information about widget positions, see Layer a Widget.

1. Create a Widget.
2. In the Type drop-down list, select Flyout.

The Flyout Widget Properties fields appear. See Flyout Widget Properties for more specific
information about each field.

3. Select the applicable Tab Settings.
◦ Tab Text: Type the text that will display on the tab.
◦ Tab Size: Type the size of the tab in pixels.
◦ Tab Color: Select the color of the tab.
◦ Drop Shadow on Tab: Select this option if you want to display a drop shadow on the tab.
◦ Tab Position: Select the side of the widget on which the tab will appear. The widget expands

in the direction of the tab and collapses away from the tab.
4. Select HTML page or Web Site and configure the related properties:

◦ HTML page: Select this option to display a specific HTML page. Browse to select an existing
HTML page or create a new HTML page in the HTML Page Editor.

◦ Web Site: Select this option to display a website, utilize tokens, and/or send a POST request
to a URL.

URL: Type the URL of the website.

Refresh every: Select this check box to refresh the content of the Widget according to the
defined time period, and then provide the refresh timeframe (every x hours or minutes).

POST: To send a pre-load POST to a website, select the Execute POST before widget load
check box, type a POST URL and a POST Body that can execute a POST request upon
loading or refreshing. Right-click on any of these text fields or select the drop-down arrow next
to the field to specify a token on the URL. The token can reference Stored Values, System
Functions, and Custom Expressions.

Store Response: To store and use the data from a POST response in a Stored Value, select
Store Response and select an existing Stored Value or create a new Stored Value in the
Stored Value Manager.

5. Select OK.
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Flyout Widget Properties
The Flyout Widget Properties window allows you to define the display (HTML page or website) and
specific properties of a collapsible Flyout Widget. When collapsed, it appears as a tab on the Dashboard.

Properties Description

Tab Text Type the text that will display on the collapsed tab.

Tab Size Type the size of the collapsed tab in pixels.

Tab Color Select the color of the tab.

Drop Shadow on Tab Select this option if you want to display a drop shadow on the tab.
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Properties Description

Tab Position

Select the side of the widget on which the tab will appear. The widget expands in
the direction of the tab and collapses away from the tab.
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Properties Description

HTML page

Select this option to display a specific HTML page. Browse to select an existing
HTML page or create a new HTML page. See HTML Page Editor.

2-tier connection: When using a 2-tier connection, a CSM login window opens.
Type your User name and Password to open the HTML Page Editor.

Web Site

Select this option to display a website, utilize tokens, and/or send a POST request
to a URL.

Note: You can store and use data from a POST response. To do this, the
User's Security Group must have permissions to Edit Stored Values.

• URL

Type the URL of the website.

Tokens: The URL can include data tokens that allow the server to deliver more
sophisticated and customized information. Right-click the field or select the drop-
down arrow next to the field to specify a token on the URL. The token can
reference Stored Values, System Functions, and Custom Expressions.

Note: When using the CTRL + Click keyboard shortcut on the URL, it
follows the link, but any associated tokens will be dropped.

• Execute POST before
widget load

This check box must be selected to send a pre-load POST to a website.

When selected the pre-load POST is configured to execute, the POST URL field
is enabled and required, and POST Body field is enabled but not required.

When disabled, the POST URL and POST Body fields are disabled and the pre-
load POST does not execute.

• POST URL

Type a POST URL that can execute a POST request upon loading or refreshing.
This field is enabled and required when the Execute POST before widget load
check box is selected.

Tokens: The Post URL can include data tokens that allow the server to deliver
more sophisticated and customized information. Right-click the field or select the
drop-down arrow next to the field to specify a token on the URL. The token can
reference Stored Values, System Functions, and Custom Expressions.

If the POST fails, it will fail silently and an error will be logged.
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Properties Description

• POST Body

Type a POST Body that will send to the POST URL upon loading or refreshing.
This field is enabled when the Execute POST before widget load check box is
selected.

Tokens: The Post Body can include data tokens that allow the server to deliver
more sophisticated and customized information. Right-click the field or select the
drop-down arrow next to the field to specify a token on the URL. The token can
reference Stored Values, System Functions, and Custom Expressions.

If the POST fails, it will fail silently and an error will be logged.

• Store Result
Select this option to store and use the data from a POST response in a Stored
Value. Browse to select an existing Stored Value or create a new Stored Value.
Incoming data must be valid JSON or XML. See Managing Stored Values.

Refresh

Select this check box to refresh the content according to a defined time period,
and then provide the refresh timeframe (every x hours or minutes). Use refresh on
Widgets where the data is likely to change.

Refresh executes only when a Widget is active and being displayed. If you leave a
dashboard and come back to it, the data will be automatically refreshed and the
refresh timer will start over.

See Flyout Widgets and Create a Flyout Widget for additional information.
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Create a Gauge Widget
Use the Gauge Widget Properties window (accessed from within the Widget Manager) to create a
Gauge Widget.

To create a Gauge Widget:

1. Create a Widget.

2. In the Type drop-down list, select Gauge.

The Gauge Widget Properties window opens, displaying several pages (Criteria, Values,
Properties, Thresholds/Numbers, Drill-Down, and Display). Text and Numeric gauges display the
Number Properties page; all other Widgets display the Thresholds page.
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3. Define general properties:
a. Gauge Type: Select the type of gauge:

◦ Horizontal (Linear)

◦ Numeric (Digital or Mechanical)
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◦ Speedometer (Angle, Rectangular, Round, Round Rectangular)

◦ Text

◦ Thermometer (Linear)

◦ Vertical (Linear)

b. Default Title:

Provide the title to display above the widget. The font, style, and color is inherited from the
dashboard on which this widget resides.

Note: You can change this title (Controls text box) when you put the Widget on a Dashboard;
however, the title is not dynamic so changes are not pushed back to this field. Likewise, if you
later change this title in Widget Properties, the changes are NOT pushed out to all the places it
resides on Dashboards. For more formatting flexibility, use a "floating" Text Widget to display a
label or title for a Widget.

c. Business Object:

Select the Business Object whose data to include in the gauge (example: Incident data).
Only one type of Business Object can be selected. The drop-down list displays only Major
Business Objects. To display all Business Objects, select the Show All check box.

d. Select this check box to refresh the content according to a defined time period, and thend.
provide the refresh timeframe (every x hours or minutes).

e. Exclude From Filters:

Select this check box to exclude the Widget from being filtered by any filter (Filter Widget)
being used on a Dashboard. (Dashboard filters limit multiple Widgets/data series at once).
Typically, this is selected if the Widget has its own Date/Time filter.

4. Define the following properties:
◦ Criteria: Data/records to include in the gauge (example: Open Incidents). Data is located/

filtered using a saved Search Query (Saved Search) or a custom Search Query.

◦ Values: Value to display in the gauge (example: Number of records, Function, Duration, or
Metric).

◦ Properties (Scale): Minimum/maximum values to use for the gauge's scale, as well as scale
orientation and direction.

◦ Threshold: Thresholds/threshold colors for the gauge (example: Start, Middle, and End
ranges).

-or-

◦ Number: Text and number formats for the gauge (example: Decimals, leading zeroes, etc.).

◦ Drill-Down: Drill-down behavior (example: Go to a Record List, Execute a command, or Go to
a Dashboard).

◦ Display: Enable animation, and color and style overrides.
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5. Select Save.
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Define Criteria (Data) for a Gauge Widget
Use the Criteria page (accessed within the Gauge Widget Properties window) to define which data/
records to include in a Gauge Widget (example: Open Incidents). Properties include:

• Search criteria: Data to include in the gauge (example: Open Incidents). Data is located using a
saved Search Query (Saved Search) or a custom Search Query.

• Date range: Timeframe for the Search Query (example: Any Time, Within Last 1 Year, User-
selectable, etc.).

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

Good to know:

• If you use a Metric value, do not define any criteria; the Metric has the criteria built in.

To define data for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Criteria page.

4. Define the search criteria (what to include in the gauge—example: Open Incidents). Data is located/
filtered using one the following options:

◦ Saved Search Query: Click the Ellipses button  to open the Search Manager, and then
select an existing Saved Search (saved Search Query) or create a Saved Search. Saved
Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

5. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (example: Anytime or Previous Year), or click the New button to
define a new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.

b. Field used for date range: Select the Field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).

6. Select OK.6.
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Define a Value for a Gauge Widget
Use the Values page (accessed within the Gauge Widget Properties window) to define the value to
display in a Gauge Widget. Values can be based on:

• Number of records.

• Function: Calculated average, maximum, minimum, or total (ex: Average customer satisfaction
rating).

• Duration: Calculated average, maximum, minimum, or total based on an amount of time (ex:
Average amount of time that Incidents take to resolve each day).

• Metric: Metric value, either simple Query or calculated.

• Secondary value: Value calculated using a secondary value (ex: What percentage of Incidents are
P1 (P1 Incidents/All Incidents x 100 = WHAT%)). If you had 70 Incidents and 43 were closed, your
P1 percentage would be 61.4%.

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

Good to know:

• A Metric is a reusable measurement query that can be used in place of the other calculated values
(ex: Function, Duration, Calculated value). For more information, refer to the Metrics documentation.

To define a value for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Values page.
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4. Define the value to display in the gauge. A value can be:
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◦ Number of records: Select this option to display the number of records that match the criteria
(ex: 15 Open Incidents).

◦ Function: Select this option to display a value that calculates an average, maximum, minimum,
or total value based on a selected Field, and then select the function and Field (ex: Average
customer satisfaction rating).

◦ Duration Function: Select this option to display a value that is calculated based on an amount
of time (ex: Average amount of time that Incidents take to resolve each day), and then select
the Start/End Fields and the units (duration).

Example: Display the average amount of time that Incidents take to resolve each day (ex:
Start Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days).

Note: A percent gauge is calculated by [Value]/[Secondary Value] * 100. If you are defining a
percent gauge, define the numerator (value) here and the denominator (secondary value) in
the next step. For example, for the calculation P1 Incidents/All Incidents x 100 = WHAT%,
define P1 Incidents here.

◦ Metric: Select this option to use a Metric value, and then select an existing CSM Metric in the
drop-down; or, click the Metric button to launch the Metric Manager, and then create a Metric.

Note: If you select a Metric, the Metric Properties window pops up, prompting you to
select which value you would like to retrieve for use in the gauge. The value can be
retrieved from the local cache or from the database. You can also access the Metric
Properties window by pressing the Metric icon . For more information about Metrics
and caching, refer to the Metrics documentation.

5. (Optional) Define a secondary value to use for a calculation:

Note: The calculation for a percentage is (Criteria) / (Secondary Criteria) * 100. If you want a
percentage of Open Incidents out of all Incidents, your Criteria would be Open Incidents and
your Secondary Criteria would be All Incidents.

a. Use Secondary Value to Calculate Final Result: Select this check box to display a calculated
value on the Widget, and then define how to calculate the value by selecting an option in the
drop-down (currently, percentage is the only option).

The Secondary Criteria and Secondary Values pages appear in the Options list.
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b. Define the secondary criteria/value to use in the calculation.

6. Select OK.6.
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Define a Scale for a Gauge Widget
Use the Properties page (accessed within the Gauge Widget Properties window) to define the scale for a
Gauge Widget. Properties include:

• Minimum and maximum scale values.

• Auto-raise value: Enables the gauge to automatically raise the maximum scale value if the value
exceeds this limit.

• Logarithmic scale (Linear, Speedometer, and Thermometer gauges only): Use a logarithmic scale to
use intervals corresponding to orders of magnitude rather than a standard linear scale. This is
helpful when the data covers an exceedingly large range of values.

• Display properties for the gauge and scale (example: Text alignment, Horizontal orientation, and
scale direction).

To define a scale for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Properties page.

4. Define the scale for the gauge:
a. Minimum/Maximum values: Define the minimum and maximum values for the gauge's scale

(example: 1-99). Some scales are physical (example: Thermometer and Speedometer
displays); on Text and Numeric gauges, min/max values represent the limit of legal values
(example: Min and max number of records to display on a Text gauge).

Note: Numeric gauges display an error if the value is out of range. Other gauges "top out."

b. Auto-Raise Value: Select this check box to enable the gauge to automatically raise the
maximum if its values exceed this limit.

c. Logarithmic scale: Select this check box to define the scale using intervals corresponding to
orders of magnitude rather than a standard linear scale. This is helpful when the data covers
an exceedingly large range of values.

5. Define display properties for the gauge and scale (these vary by the type of gauge):
a. Text Alignment (Text gauge only): Select the alignment for the scale, with respect to the

Widget's bounding box (example: Bottom Center).

b. Flip the horizontal orientation (Angle Speedometers only): Select this check box to flip the
angle of the speedometer so that it opens to the left (flipped) instead of the right (default).

c. Reverse the scale direction (Angle Speedometers only): Select this check box to flip the scale
so that it displays values from maximum-to-minimum (reversed; example: 5-1) rather than
minimum-to-maximum (default; example: 1-5).

6. Select OK.6.
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Define Thresholds for a Gauge Widget

Note: Linear, Speedometer, and Thermometer gauges display the Thresholds page. Text and
Numeric gauges display the Number Properties page.

Use the Thresholds page (accessed within the Gauge Widget Properties window) to define boundaries
that visually alert you through color changes if Gauge Widget values cross a defined threshold. For
example, set up thresholds to alert you when:

• Too many Incidents accumulate in the new Queue.

• An initial response time is too long.

• Actions/tasks required for an incident are not being completed.

• Sales figures are about to cross the goal mark.

• Customer survey ratings fall below an acceptable rating.

Threshold properties include:

• Start Range.

• Middle Range.

• End Range.

• Theme color overrides.

• Use of solid colors.

Good to know:

• On Desktop Client Dashboards, thresholds are purely visual.

• On Browser Client Dashboards, thresholds display only start and end ranges.

• When Widgets are used in Cherwell Mobile, the thresholds are used to determine if a gauge is in an
alert state.

• If you want Actions to take place based on thresholds, you can define threshold-based Automation
Processes. For more information, refer to the Automation Processes documentation.

• Stay within your scale (example: If min is 0 and max is 100, a threshold of 150 would be outside
your scale) and take into consideration the direction of the scale (max-to-min or min-to-max).

• By default, threshold colors come from the defined Dashboard Theme; however you can override
the colors and use a Web or Custom color instead.

Note: Gauge items vary by gauge type (example: Thermometer ticks are different than
speedometer ticks). Also note that the Dashboard styles (Legacy, Flat, and Chrome) affect
how the colors are applied.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).
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Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

To define thresholds for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Thresholds page.

4. Enable using thresholds on the gauge:
a. Use thresholds: Select this check box to use thresholds, and then define the ranges

(following).

5. Define one or more threshold ranges/colors:
a. Start range: Specify the low threshold. On a gradient, this starts your low zone (example:

Green zone).

b. Middle range: Specify the middle threshold. On a gradient, this is the middle of your middle
zone (example: Orange zone).

c. End range: Specify your high threshold. On a gradient, this is the highest value of your high
zone (example: Red zone).

Note: By default, threshold colors come from the defined Dashboard Theme colors;
however, you can override the colors and use Web or Custom colors instead. To
override the colors, select the Override theme default value check box, and then
click the Color Selector button to select a different color.

d. Use solid colors: Select this check box to show more distinct color changes, rather than a
gradual gradient.

6. Select OK.6.
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Define Number Properties for a Gauge Widget

Note: Text and Numeric gauges display the Number Properties page. Linear, Speedometer, and
Thermometer gauges display the Thresholds page.

Use the Number Properties page (accessed within the Gauge Widget Properties window) to define how to
format text and numbers in a Gauge Widget. Formatting options vary by category (Number, Currency,
Percentage, or Custom):

• Number: Define decimal places and enable 1000 separator, negative sign, and leading zeros.

• Currency: Define decimal places and symbol.

• Percentage: Define decimal places.

• Custom: Define a custom format string.

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

To define number properties for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Number Properties page.

4. Select a category (select one).

5. Define the following number properties (properties vary by category):
◦ Decimal Places: Specify the number of decimal places to display to the right of a decimal point

(example: 5.0 has one decimal place, 5.00 has two decimal places). Zero (0) indicates a whole
number (no decimal place).

◦ Use 1000 Separator: Select this check box to add a separator (example: Comma) when a
number value reaches 1000. Separators vary depending on locale (example: USA, Europe,
etc.).

◦ Show Leading Zeroes: Select this check box to display zeroes (if any) before a decimal place
(example: 0.7 has a leading zero).

◦ Show Negative Sign: Select this check box to display a negative sign (when applicable) before
a number string (example: -5.0).

◦ Currency Symbol: By locale (example: English, United States).

◦ Custom: Define a custom format or use an existing one (example:
0,0.00,#.##0,0%,0.00%,0.00E+00, ##0.0E+0).

6. Select OK.6.
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Define Drill-Down for a Gauge Widget
Use the Drill-Down Properties page (accessed within the Gauge Widget Properties window) to define drill-
down behaviors for a Gauge Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (example: Print, export, run an Action, sort, filter, group, size, move/reorder, and add/
remove columns) to display only the data you want and in a way that is meaningful to you. Click a
record to view it in detail.

• Execute a command: Drill-down executes a command/Action (example: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step Action, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (example: A Dashboard dedicated to
the Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (example: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Drill-Down page.

4. Define a drill-down option for the gauge:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Click the Ellipses button  to open the Action Manager, and then select the command to
execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Click the

Ellipses button  to open the Dashboard Manager, and then select an existing Dashboard
or create a new Dashboard.
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5. Select OK.5.
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Define Display Properties for a Gauge Widget
Use the Display page (accessed within the Gauge Widget Properties window) to:

• Allow animation: Paints the gauge items as they display (example: Thermometer grows to its value).
Note that chart widgets might paint differently in the Browser Client.

• Define advanced options:
◦ Override Dashboard Theme colors.

◦ Override the Dashboard style.

Note: The Gauge Widget Properties window is accessed from within the Widget
Manager when you create or edit a Gauge Widget.

Good to know:

• By default, gauge colors (banner, labels, face, grid line/tick, and threshold) and style (flat, chrome, or
none) come from the defined Dashboard Theme; however, you can override some of the properties.

• Typically, the Advanced options are used to maintain legacy Dashboard themes and styles (these
are themes and styles that were created prior to CSM 5.00 and its Theme Manager). Ideally you
want to create and use Dashboard Themes that are created with 5.00+ capabilities. For more
information about Dashboard colors and styles, see Dashboard Themes. Overriding the Dashboard
Theme colors and styles affects your Threshold colors.

To define display properties for a Gauge Widget:

1. Create a Widget.

2. In the Type drop-down, select Gauge.

3. Click the Display page.

4. Define the following display options:
a. Allow Animation: Select this check box to paint the gauge items as they display (example:

Thermometer grows to its value).

b. Advanced Options:
i. Override Dashboard Theme Colors: Select this check box to override the colors from the

defined Dashboard Theme with the colors from another Theme, and then select the
Theme that will override the default Theme, either:

◦ From Legacy Theme: Select a legacy Theme from previous versions of CSM.

◦ From Specific Theme: Select another defined Dashboard Theme.

ii. Override Dashboard Styles: Select this check box to override the defined Dashboard
Theme's style (Chrome, Flat, or Legacy) with another Theme style, and then select the
Theme style that will override the default Theme:

◦ Legacy

◦ Flat

◦ Chrome
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5. Select OK.5.
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Create a Matrix Widget
Use the Matrix Widget Properties window (accessed from within the Widget Manager) to create a Matrix
Widget.

To create a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down list, select Matrix.

3. Define general properties:
a. Default title:

Provide the title to display above the widget. The font, style, and color is inherited from the
dashboard on which this widget resides.

Note: You can change this title (Controls text box) when you put the Widget on a Dashboard;
however, the title is not dynamic so changes are not pushed back to this field. Likewise, if you
later change this title in Widget Properties, the changes are NOT pushed out to all the places it
resides on Dashboards. For more formatting flexibility, use a "floating" Text Widget to display a
label or title for a Widget.

b. Default Business Object:

Select the Business Object whose data you want to include on the Widget (example:
Incident).

Only one type of Business Object can be selected. The drop-down list displays only Major
Business Objects. To display all Business Objects, select the Show All check box.

c. Refresh Every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

d. Allow Drill Down:

Select this check box to allow users to double-click the widget and be taken to data
represented by that widget.

Only certain cells in a Matrix support drill-down.

e. Exclude From filters:

Select this check box to exclude the Widget from being filtered by any filter (Filter Widget)
being used on a Dashboard. (Dashboard filters limit multiple Widgets/data series at once).
Typically, this is selected if the Widget has its own Date/Time filter.

4. Define the following properties:
◦ Rows: Rows for the Matrix Widget.

◦ Columns: Columns for the Matrix Widget.
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◦ Appearance: How the Matrix looks (colors, fonts, etc.).

5. Select Save.5.
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Define Rows for a Matrix Widget
Use the Rows page (accessed from within the Matrix Widget Properties window) to define how the rows
look and behave on a Matrix Widget. Properties include:

• Where to get the data for the rows, either:
◦ List of Rows Come From a Field: Rows come from values in a Field (example: A row for each

status).

◦ List of Rows are Based on Date: Bases rows on periods within a date range (example: If your
range is a year, and your periods are months, you will have a row for each month of the
specified year).

• Totaling/averaging options:
◦ Total Row: Adds a row to total other rows in the matrix.

◦ Average Row: Adds a row to average other rows in the matrix.

• Visibility: When to hide the row (example: Use an Expression to hide the row when the values are
negligible).

• Field for List of Rows: Business Object and Field that provide the values for the row. You can also
define sorting (Sort By field and ascending/descending) and a limiting Expression.

• Limit Values by Date: Limit values to a specific date range (example: All, Today, Yesterday, Within
last 1 week/month/quarter/year, custom range, etc.).

Note: The Matrix Widget Properties window is accessed from within the Widget Manager
when you create or edit a Matrix Widget.

To define rows that come from a Field for a Matrix Widget:

1. Create a Widget..

2. In the Type drop-down, select Matrix.

3. Click the Rows page.

4. Select the List of Rows come from a Field radio button.

Note: When you select List of rows come from a Field, you specify the Lookup table that will
provide the values to display. For example, if you want a row for each status, you might
select the Status field from the Incident Status Lookup table. You are not limited to Lookup
tables; however, performance will be better if you select a cacheable Lookup table rather
than the Status field from the Incident Business Object.

5. Define totaling/averaging options:
a. Total Row: Select this check box to add a row to total other rows in the matrix.

b. Average Row: Select this check box to add a row to average other rows in the matrix.

6. Define visibility:
a. Define an Expression to conditionally hide a row, using either:
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◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

7. Define the values for the row:
a. Business Object/Field:

Select the Lookup table and field that supply all the possible values (example: For Incident, it
might be the Status field in the Incident Status Lookup table, with Status values like New, In
Progress, Assigned, etc.).

b. Order By:

Select the field to use to order the values, as well as an ascending or descending order. Rarely
will the alphabetical order match the order in which the values should appear in your item,
unless you prefix the values with numbers or letters (example: For status, you would likely
want lifecycle order, not alphabetical order); therefore, it is common to define a field that
contains a sequence number purely for controlling the order (example: Status Order).

c. Limit Rows:

Define a Saved Search or Custom Query to limit the rows (example: Limit the rows to only
those where the Department = Network Support).

8. Limit values by date:

Note: This does not affect the list of rows; instead, it adds an additional criteria to the data in
each column. If you select to set up a User selectable option, then a small drop-down is
displayed to show the various options.

a. Provide a date range limit for your data, using either:
◦ Range: Select this radio button to use a single date range to limit the data. Then, select

the date range (example: Any time, Today, etc.), or click New to open the Custom Date
Range window where you can define a custom date range.

◦ User-Selectable: Select this radio button to display a drop-down list on the matrix so that

Users can select how to limit the data. Then, click the Ellipses button  to open the
Multiple Date Ranges window, where you can select one or more date ranges to
include in the drop-down.

b. Field Used for Date Range: Select the Field to use to give the range perspective (example:
"LastModDateTime" gives "Previous Year" perspective).

9. Select OK.9.

To define rows that are based on a date for a Matrix Widget:
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1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Rows page.

4. Select the List of Rows are Based on Date radio button.

5. Define totaling/averaging options:
a. Total Row: Select this check box to add a row to total other rows in the matrix.

b. Average Row: Select this check box to add a row to average other rows in the matrix.

6. Define visibility:
a. Define an Expression to conditionally hide a row, using either:

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

7. Define the date range:
a. Provide a date range limit for your data, using either:

◦ Range: Select this radio button to use a single date range to limit the data. Then, select
the date range (example: Any time, Today, etc.), or click New to open the Custom Date
Range window, where you can define a custom date range.

◦ User-Selectable: Select this radio button to display a drop-down list on the matrix so that

Users can select how to limit the data. Then, click the Ellipses button  to open the
Multiple Date Ranges window, where you can select one or more date ranges to
include in the drop-down.

Note: This option works differently for date-based rows. Instead of limiting the data that
is pulled, it modifies the rows that are displayed (example: If you allow the User to select
between Last Year, This Year, and Next Year, the rows change to show the months from
the specified year).

b. Break Range Into Periods: Select the range covered by each row. If your date range does not
contain complete periods (example: You select monthly, but have a range that starts halfway
through a month), the date range automatically expands to make up complete periods.

8. Select OK.8.
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Define Columns for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how the columns look and
behave on a Matrix Widget. You can define the following types of columns:

• Numeric column: Query-based column that determines the number of records available for each
row that fit the specified query.

• Calculated column: Lets you do math against other columns (example: Add up two other column’s
values).

• Image column: Displays an appropriate image based on an Expression (example: If Incidents
Closed > 10, show a smiley face).

• Text column: Displays text based on an Expression (example: If Open Incidents > 0, show Out of
Compliance).

• Value bar column: Shows a bar whose width represents a value (example: Show a bar comparing
the number of changes approved each month).

• Ratings column: Shows a number of images based on a value (example: Show a star for each
Incident closed by a technician).

Note: The Matrix Widget Properties window is accessed from within the Widget Manager
when you create or edit a Matrix Widget.

CSM 2022.3 Features 1810

CSM 2022.3 Features



Define a Numeric Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a numeric column looks
and behaves on a Matrix Widget.

A numeric column is a query-based column whose data is retrieved and then split out among the different
rows. For example, if you have a row for each support Incident category, you can have a numeric column
that counts the number of Incidents for Software, Hardware, Network Support, etc. You might have
another column that limits the records returned to Open Incidents only and another for Closed Incidents
only, etc.

The display of a numeric column is simply a number. Numeric columns are the only ones that support
drill-down (because other columns are all calculated in some way, there is no reasonable way to know
what data to show when drilling down).

To define a numeric column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Numeric Column.

5. Define general properties:
a. Title: Provide a title for the column.

b. Fixed Width: Select this check box to specify a fixed width for the column. Then, specify the
width, in pixels. If not selected, the column width adjusts to the Widget width.

c. Visible: Select this check box to display the title of the column in the matrix.

6. Define the records to include in the column:
a. Click the Search page.

b. Define the records to include:
i. Business Object: Select the Business Object whose data you want to display in the

columns. This defaults to the same set for the Widget as a whole; however, you can
have different columns pulled from different Business Objects (so one matrix could show
data from Incidents, Problems, and Changes side-by-side).

ii. Field to Use to Split Business Objects Between Rows: Select the Field in the source
Business Object that contains the matching value for each row. For example, if you have
a row for each category (pulled from the Incident Category table), specify the Field in
your Business Object that contains Categories.

iii. Search Criteria: Define a Search Query to locate the records to include on the Widget
(example: In a Closed column, show Closed incidents). You have two options:

◦ Click the Ellipses button  to open the Search Manager, and then select an
existing Saved Search or create a Saved Search. Saved Searches can be used
over and over in numerous places.
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◦ Click the Custom Query button  to open the Custom Query Builder, and then
create a custom Search Query to use only for this scenario.

iv. Field Used for Date Range: Select the Field to use if there is a date filter applied to the
matrix. By default, this will be the same Field set on the Rows page of the main matrix
setup, but because Business Objects other than the primary can be displayed, the
behavior might be different from column to column. This is not used when you have rows
based on date. In that situation, the Field used to split records between rows will be a
date field for that purpose.

7. Define the values to display in the column:
a.

b. Define the value to display. A value can be:
◦ Number of records: Select this option to display the number of records that match the

criteria (example: 15 Open Incidents).

◦ Function: Select this option to display a value that calculates an average, maximum,
minimum, or total value based on a selected Field, and then select the function and
Field (example: Average cost for each row).

◦ Duration Function: Select this option to display a value that is calculated based on an
amount of time (example: Average amount of time that Incidents take to resolve each
day), and then select the Start/End Fields and the units (duration).

◦ Metric: Select this option to use a Metric value, and then select an existing CSM Metric
in the drop-down; or, click the Metric button to launch the Metric Manager, and then
create a Metric.

8. Define the format for the column:
a.

b. Define formatting options:
i. Format: Select a format for the number (example: Number, Percent, Currency/locale

symbol).

ii. Decimal places: Specify the number of decimal places to show for each value.

iii. Text Position: Select how to align the value in the column (example: Centered, left-
justified, or right-justified).

iv. Color Text: Select this check box to define an Expression to conditionally change the
color of the text (example: If the value is negative, show it as red). You cannot use a
Stored Expression here because regular Stored Expressions do not have access to
column values.

9. Select OK.9.
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Define a Calculate Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a calculated column looks
and behaves on a Matrix Widget.

A calculated column displays a calculated value that is determined by executing a calculation against
other columns in the Matrix (example: Add up open and closed Incidents for a grand total).

The following figure shows an example of how a Matrix Widget uses a calculated column on a Dashboard.

Good to know:

• Calculated columns are calculated after all numeric columns have been retrieved.

• Calculated columns cannot query themselves.

To define a calculated column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Calculated column.

5. Define how the value in the column will be calculated:
a. Click the Calculated Value page.

b. Click the Selector button , and then select the Tokens (System Functions, Expressions,
Stored Values, Metrics, and/or Counters) and math operators to build the calculation.

6. Define the format for the column:
a. Click the Format page.

b. Define formatting options:
i. Format: Select a format for the number (example: Number, Percent, Currency/locale

symbol).

ii. Decimal places: Specify the number of decimal places to show for each value.

iii. Text Position: Select how to align the value in the column (example: Centered, left-
justified, or right-justified).

iv. Color Text: Select this check box to define an Expression that controls the color of the
text (example: If the value is negative, show it as red. You cannot use stored
Expressions here because regular stored Expressions do not have access to column
values).
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7. Select OK.7.
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Define an Image Column for a Matrix Widget
Use the Columns page in the Matrix Widget Properties window to define how an image column looks
and behaves on a Matrix widget.

An image column displays a conditional image based on a defined expression. For example, display a
green checkmark if your overall customer satisfaction rating is 4 or 5, and a warning icon if it is below 4.

The following figure shows an example of how a Matrix widget uses an image column on a dashboard.
You can use a value from another column in your expression. In this example, the value in the Overall
column (Numeric Column) determines which image to display in the Good or Bad column.

To define an image column for a Matrix Widget:

1. Create a widget.
2. In the Type drop-down, select Matrix.
3. Select the Columns page.
4. Select Add > Image column.
5. Define image properties:

◦ Specify the Image Width and Image Height, in pixels. Consider proportion when specifying
the size. For example, for a square graphic, adjust the size and width by the same
measurement to avoid distortion. To help, CSM provides several graphics, organized by pixel
size.

◦ Select the Image to use or define an expression to conditionally determine the image.
6. Select OK.
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Define a Text Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a text column looks and
behaves on a Matrix Widget.

A text column displays conditional text based on a defined Expression. For example, display the word
GOOD if your overall customer satisfaction rating is 4 or 5, and the word BAD if it is below 4. You can also
conditionally change the color of the text based on an Expression.

The following figure shows an example of how a Matrix Widget uses a text column on a Dashboard.

Note: You can use a value from another column in your Expression. In the above example, the
value in the Overall column (numeric column) determines the text to display in the Good or Bad
column.

To define a text column for a Matrix Widget:

1. Create a Widget

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Text column.

5. Define text properties:

a. Text: Click the Custom Expression button  to open the Custom Expression Builder, and
then create the Expression to determine the text to display.

b. Color Text: Select this check box to change the color of the text based on an Expression. Click

the Custom Expression button  to open the Custom Expression Builder, and then create
the Expression to determine when to change the text color.

6. Select OK.6.
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Define a Value Bar Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a value bar column looks
and behaves on a Matrix Widget.

A value bar column displays a bar whose width represents a value. For example, display a value bar
comparing the number of changes approved for each row.

Good to know:

• Calculated columns are calculated after all numeric columns have been retrieved.

• Calculated columns cannot query themselves.

To define a value bar column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Calculated column.
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5. Define how the value will be calculated:
a. Click the Calculated Value page.

b. Click the Selector button , and then select the Tokens (System Functions, Expressions,
Stored Values, Metrics, and/or Counters) and math operators to build the calculation.

6. Define how the value bar looks:
a. Click the Value-Line page.
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b. Define the width of the value bar, either:
◦ Set Complete Line Based on Largest Value: Select this radio button to auto-determine

the maximum width; the width of the value bars is based on the largest value of any row.
For example, if the Hardware category has a value of 10, which is the largest, then the
value bar for Hardware category will fill the entire width, and all other bars will be a
percentage of that width.

◦ Set Specific Threshold: Select this radio button to specify a maximum width. You can
then select the following options:

◦ Show Values That Exceed the Threshold: Select this check box to show overages
on the value bar (values that are greater than the specified threshold). Overages

CSM 2022.3 Features 1820

CSM 2022.3 Features



can be displayed in a different color (see Overage Color below). If not selected,
value bars that exceed the maximum width appear cut off.

◦ Draw a Line to Indicate the Threshold Position: Select this check box to draw a
short vertical line to indicate the specific threshold to make it easier to see.

c. Draw a Border Around the Value Bar: Select this check box to draw a box around the whole
value bar. If not selected, the value bar is free-floating.

d. Define the colors of the value bar:
i. Bar Color: Select the primary color for the value bar.

ii. Bar Color Expression: Select this check box to use an Expression to conditionally
change the color of the value bar. Then, define the Expression.

iii. Overage Color: Select this check box to use a specific color for overages (bars that
exceed the maximum width). Then, select a color.

iv. Overage Expression: Select this check box to use an Expression to conditionally change
the color of the overage. Then, define the Expression.

v. Use Solid Colors: Select this option to use a solid color on the value bar. By default,
values bars are drawn using gradients, darkening towards the bar color as they get
longer.

e. Fixed Height: Select this check box to use a fixed height for the value bar. Then, specify the
height. By default, the value bar takes up a calculated percentage of the available space for
the row.

7. Select OK.7.
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Define a Ratings Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a ratings column looks and
behaves on a Matrix Widget.

A ratings column shows a number of images based on a value. For example, you could show a star for
each Incident closed by a technician.

Good to know:

• Calculated columns are calculated after all numeric columns have been retrieved.

• Calculated columns cannot query themselves.

To define a ratings column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Calculated column.

5. Define how the rating will be calculated:
a. Click the Calculated Value page.

b. Click the Selector button , and then select the Tokens (System Functions, Expressions,
Stored Values, Metrics, and/or Counters) and math operators to build the calculation.

6. Define how the ratings column will look:
a.

b. Define the following:
◦ Image Width:

Specify the width of the image for display.

◦ Image Height:

Specify the height of the image for display.

◦ Image:

Select the image to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Select the Image Expression check box to use an Expression to change the

image based on conditions. Then, click the Custom Expression button  to
open the Custom Expression Builder and create a custom Expression. If no special
condition applies, then the default image is used.

◦ Maximum rating:
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Select this check box to impose a cap on the number of images to show, and then
specify the maximum number.

◦ Show partial ratings:

Select this check box to show fractions of values (example: 2 ½ stars).

◦ Stretch image:

By default, a new version of the image is shown for each value, so the value 10 would be
represented by 10 stars. However, you can instead have the rating column stretch out a
single version of the image based on the rating. This can be effective with certain images
that stretch well, but might look odd with other images.

7. Select OK.7.
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Define Appearance for a Matrix Widget
Use the Appearance page (in the Matrix Widget Properties window) to define how the Matrix Widget looks
and behaves, including:

• Custom font and font color.

• Highlighting alternate rows.

• Fixed row height.

• Show/hide column headers.

To define appearance for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Appearance page.
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4. Define the appearance properties:
a. Custom content font: Select this check box to use a specific font for text displayed on the

Matrix. (If not selected, the Widget uses the Theme font currently applied to the Dashboard on
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which the Matrix appears). Click the Ellipses button  to open the Font window, and then
select a Font, Style, and Size.

b. Custom font color: Select this check box to use a custom color to use for all text (that is not
otherwise overridden by Expressions on a per-column basis). Click the Color Selector button

 to open the Color Selector, and then select a color:
◦ System:

Set of colors provided by your operating system. System colors can vary greatly
depending on the operating system and browser used to view the color.

◦ Web:

Set of named web-safe colors.

◦ Custom:

Customized red, green, blue (RGB) colors.

c. Highlight alternate rows: Select this check box to add a color to every other row so that rows
can be differentiated from one another. Then, select the color for the alternate row.

d. Fixed row height: Select this check box to use a specific row height. Then, provide the row
height, in pixels. By default, the height of rows is based on content and available space.

e. Show column headers: Select this check box to display the name of each column above that
column. If unselected, headers will not be displayed.

5. Select OK.5.
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Create an RSS Feed Widget
Use the RSS Feed Widget Properties window (accessed from within the Widget Manager) to create an
RSS Feed Widget.

To create an RSS Feed Widget:

1. Create a Widget.

2. Define the feed to show on the RSS Feed Widget:
a. RSS Feed URI: Provide the URI for the RSS feed.

Tip: In most browsers, you can right-click the RSS feed icon  and select Copy Link
Location or Copy Link to copy the URL onto your clipboard. You can then paste it into the
RSS Feed URI text box in the RSS Feed Widget Properties window. A number of technical
tools also expose RSS feeds in various ways (including CSM).

3. Specify the maximum number of entries to show:
a. Max Items to Show: Provide a number. Most sites already limit the number of entries

exposed from a feed, but you can enforce a stricter limit.

4. Specify whether or not to show images in the feed:
a. Display Image from Description if present: Select this check box to show the first found

image included with each entry. If this box is cleared, images are suppressed (to save space
or to make the entries display more quickly).

5. Specify a custom link color to use in the Widget:
a. Custom link color: Select this check box to use an alternate color for Twitter links (by default,

links in the title and the body of each Tweet use the system-defined color for links. However,
depending on the rest of your color selections, these links might be hard to read). Select the
Color Selector button  to open the Color Selector, and then select a color:

◦ Web:

Set of named web-safe colors.

◦ Custom:

Customized red, green, blue (RGB) colors.

6. Define how often to refresh the Widget:
a. Refresh every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

7. Select one or more One-Step Actions to initiate from the Widget (Create actions area):
a. Select Add to launch the One-Step Action Manager, and then select one or more existing

One-Steps, or create a new One-Step Action.

b. Select Save.b.
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Tip: Select Remove to remove a selected One-Step Action from the list. Use the Up/Down
arrows to reorder the One-Step Actions in the list.

8. Select Save.8.
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Create a Search Widget
Use the Search Widget Properties window (accessed from within the Widget Manager) to create a
search widget.

To create a search widget:

1. Create a widget.

2. In the Type drop-down list, select Search.

3. Define general properties for the search widget:
a. Title: This field is not used for a search widget. A title can be defined, but is not displayed on

the widget.

4. Define which type of search is available (can be run) from the widget.
a. Select one option:

◦ Quick Search: Select this option to allow a quick search to be run from the widget
(allows users to search multiple Business Objects for all applicable records that contain
specific words or phrases).

◦ Specific search: Select this option to allow a specific search to be run from the widget
(allows users to search one Business Object for all applicable records that contain
specific words or phrases).

◦ Both: Select this option to allow both a quick search and a specific search to be run from
the widget.

b. If both types of searches are available in the widget, select a default search (either quick or
specific).

5. Render Mode: Choose from Default or Simple options. The simple option has no drop-down list for
selecting saved searches. To set a border around the search bar, set a background style first and
then the border option will appear. For example, the simple option can look like this in the Portal:

Note: The simple option of the search widget cannot currently be rendered in the Dashboard
Editor.

6. Define options for quick search (if used on widget):
a. In the Options area, select the Quick Search page.

b. Custom Watermark Text: Select this check box to include a watermark inside the Search
Control's box, and then provide the text to display (example: "Type search words here").

c. Select the items (Business Objects) to include in the search, and then define search options
for each: For each item, select Add, and then select a Business Object (or Document
Repository) to include in the search.
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i. Define the following search options for each Business Object:i.

Note: Document Repository options are limited to applicable options.

◦ Name: Auto-fills with the name of the Business Object/Doc Repository.

◦ Custom Watermark: Select this check box to include a watermark inside the
widget's search box. Provide the watermark text to display (example: "Search
Incident").

◦ Search For Any/All Words: Select whether to use any (OR) or all (AND) logic in
the search.

◦ Open [records] Only: Select this check box to limit the search to records that
have not reached their final state (example: Not closed).

Note: The lifecycle and terminology vary depending on the Business Object
and scenario (example: "Unapproved Changes" is a lifecycle state for
Change, and therefore is only available when searching Changes). If the
Business Object does not have a "final" or closed state, the check box is
not available.

◦ Changed: Select a timeframe to limit the search (example: Any time).

◦ Sort By: Select the Business Object Field (column) to use to sort the search

results. Select Sort in Descending Order  to toggle the sort order between

ascending and descending order. A non-active icon  indicates ascending

order; an active icon  indicates descending order.

◦ Search Related: Select this check box to include related Business Objects in the
search (example: If the search word appears in a journal entry, the Incident to
which it is attached will be included in the search results).

Note: In order to be included in the search, both the related Business
Object and the relationship must be enabled for full text search (example:
Select the Include in Full Text Search check box on the Business Object
Properties window in a Blueprint (Search Results page) and the When
Searching <bus ob> Include <related bus ob> in Full Text Search
check box on the Relationship Properties window (General page)).

◦ Search Attachments: Select this check box to include attachments in the search.

Note: Attachments must be imported and attached to Business Objects in
order to be searched. For example, if an Incident has an attached Word
document that contains the search words, that Incident is included in the
search results.
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◦ Limit Results: Select this check box to limits the results using defined criteria
(example: Show only Incidents created within the last year). Select Query to define
a Query that limits the search results.

◦ Default to Limited: Always selected.

◦ Limit Display Text: Provide the text to display above the search results so that
users know how the data was filtered.

7. Define options for the specific search (if used on widget):
a. In the Options area, select the Specific Search page.

b. Define specific search options:
◦ Include All Of The Items Available In Quick Search As Individual Specific Options:

Select this check box to include the Business Objects that were defined on the Quick
Search page. Each of these objects will be available in a drop-down list on the widget
and can be selected and searched individually.

◦ Include All Standard Options Available To User As Specific Options: Select this
check box to include all Business Objects with quick search enabled (Show in Quick
Search is checked on the Search Results page in the Business Object's properties
window in a Blueprint). Each of these objects will be available in a drop-down list on the
widget and can be selected and searched individually.

c. Select the items (Business Objects) to include in the search, and then define search options
for each (same as on the Quick Search page).

8. Select Save.8.
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Create a Search Results List Widget
Use the Search Results List Widget Properties window (accessed from within the Widget Manager) to
create a search results list widget.

To create a search results list widget:

1. Create a Widget.

2. In the Type drop-down list, select Search Results List.
3. Define general properties:

a. Default title:

Provide the title to display above the widget. The font, style, and color is inherited from the
dashboard on which this widget resides.

Note: You can change this title (Controls text box) when you put the widget on a
dashboard; however, the title is not dynamic so changes are not pushed back to this
field. Likewise, if you later change this title in Widget Properties, the changes are
NOT pushed out to all the places it occurs on dashboards. For more formatting
flexibility, use a "floating" text widget to display a label or title for a widget.

b. Business Object:

Select the Business Object to search (example: Incident). Only one type of Business Object
can be selected. The drop-down list displays only Major Business Objects. To display all
Business Objects, select the Show All check box.

4. Define display properties:
a. Specify how to display the search results (grid or clickable links):

◦ Show Results in a Grid: Select this option to display the search results in a grid, and
then define:

◦ Custom Grid:

Select this check box to display a custom grid, rather than the system
administrator-defined default grid.

Note: The system administrator has defined multiple grids for the selected
Business Object. If no grid is selected, the system administrator-selected
default grid for the Business Object is used.

◦ Default to Showing Grouping:

Select this check box to automatically show grid grouping functionality in the
search results list widget.

◦ Allow User to Show/Hide Grouping Options:
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Select this check box to allow users to enable grid grouping in the search results
list widgets if it is not automatically enabled.

◦ Allow Drill-Down:

Select this check box to allow users to double-click the widget and be taken to data
represented by that widget.

◦ Show Results as Links: Select this option to display each search result as a clickable
link and to also set options for separator width and color.

◦ Separator Color: Select this option to set the color of the separator to be
transparent using a pre-set color, or by setting a custom color with an Alpha of 0
(using the RGBA color model).

◦ Separator Width: Select this option to set the width of the separator between
results in your results list. Choose from No Border or 1/2/3/4 pixels wide.

b. Limit Results: Select this check box to limit the number of results in the search results list
widget to a specified number, and then specify the number.

5. Define the search criteria (what to search for - example: Open Incidents). Data is located/filtered
using one the following options:

◦ Saved Search Query: Select the ellipsis  to open the Search Manager, and then select an
existing saved search (saved Search Query) or create a saved search. Saved searches can
be used over and over in numerous places.

◦ Custom Search Query: Select Custom Query  to open the Custom Query Builder, and
then create a custom search query to use only for this scenario.

6. Define a timeframe for the search query (Date Range area):
a. Select a range option, either:

◦ Range: Select this option to define a date range for the query, and then select an
existing time frame (example: Anytime or Previous Year), or select New to define a new
time frame.

◦ User Selectable: Select this option to allow the user/customer to select the date range

from a drop-down list. Then, select the ellipsis  to open the Multiple Date Ranges
window and select the Allowed date ranges to include in the drop-down list.

b. Field used for date range: Select the field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).

7. Define how often to refresh the widget:
a. Refresh every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

8. Select Save.8.
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Create a Twitter Feed Widget
Use the Twitter Feed Widget Properties window (accessed from within the Widget Manager) to create a
Twitter Feed Widget.

To create a Twitter Feed Widget:

1. Create a Widget.

2. In the Type drop-down list, select Twitter Feed.

3. Select the CSM Twitter account to use:

a. Account: Select the ellipses button  to open the Twitter Account Manager, and then select
an existing Twitter Account or create a new Twitter Account.

4. Specify the Tweets to show on the Widget, either:
◦ Show user’s Tweets: Select this radio button to display all the Tweets from the named Twitter

Account. If you select this option, you can also specify whether or not you want to include
Retweets. A Retweet is a Tweet from a different user that the current user re-transmits from
within their own account to their own followers.

◦ Show Search results: Select this radio button to display all Tweets that meet the specified
criteria, and then specify the criteria. The criteria can be simple words, hashtags, or any other
supported Twitter search.

5. Specify the maximum number of Tweets to show:
a. Max Tweet to Show: Provide a number.

6. Specify a custom link color to use in the Widget:
a. Custom link color: Select this check box to use an alternate color for Twitter links (by default,

links in the title and the body of each Tweet use the system-defined color for links. However,
depending on the rest of your color selections, these links might be hard to read). Select Color
Selector  to open the Color Selector, and then select a link color, either:

◦ Web:

Set of named web-safe colors.

◦ Custom:

Customized red, green, blue (RGB) colors.

7. Define how often to refresh the Widget:
a. Refresh every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

8. Select one or more One-Step Actions to initiate from the Widget (Create actions area):
a. Select Add to launch the One-Step Action Manager, and then select one or more existing

One-Steps, or create a new One-Step Action.

b. Select OK.b.
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Tips: Select the Edit button to Edit a One-Step Actions in the list; select the Remove button to
remove a selected One-Step Action from the list. Use the Up/Down arrows to reorder the One-
Step Actions in the list.

9. Select Save.9.
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Create a Shape Widget
Shape Widgets are not named and saved; they are simply dragged onto a Dashboard and customized for
that particular Dashboard. For detailed information, refer to Add a Shape Widget to a Dashboard.
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Create a Tab Group Widget
Use the Tab Group Properties window (accessed from within the Widget Manager) to create a Tab
Group Widget.

To create a Tab Group Widget:

1. Create a Widget.
2. Select a Tab Position to indicate where the tabs will be oriented on the Widget.
3. Create, populate, and arrange tabs in the Tabs section.

a. Use the New Tab and Delete Tab buttons to create and delete your tabs. Create at least one
tab in order to save the Widget.

b. Enter a name in the Tab Name field.
c. Select a Content Type of Plain Text or Rich Text.
d. Enter display content in the Content Pane. To enter Rich Text content, select the Rich Text

Zoom icon .
4. Select Save.
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Configuring Widgets
Widget security rights are configured in CSM Administrator. See Dashboard Security Rights.
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